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Intr duction

Welcome to Mastering Unreal Technology: The Art of Level Design.
You're going to take an exciting journey through the rich world uf

game design, using the UnreaJ Engine. This book is dedicated to the

aesthetic aspects of game design, such as level design creation, char

acter development, and static mesh design. On the other hand, this
book does nOl c:over many game design 10pies from th<, program

mer's perspective. meaning there isn't much emphasis on program

ming the Unreal Engine through its native programming language.

UnrealScript.

Who Is This Book For?
This book has been designed for a wide range of people. actually.

The first group is aspiring mod makers or fledgling game designers.

This book is also aimed at anyone who has ever wondered exactly

what kind of work goes into making his or her favorite game.

Beyond garners, however. this book can be a great resource for tho...e

in lhe fields of architecture or coostruction visualization. With the

Unreal Engine, you can offer your clients real-time fiythroughs and

simulations that they can view and explore. How to apply the Unreal

Technology that drives today's cutting-edge games is limited only by
your imagination.
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How to Use This Book
This book is designed to be read from start to finish, although this isn't necessarily the best way

for everyone to complete this book. You'll find that each chapter has a robust selection of infor

mation about each relative topic; however, the book has been designed to be flexible enough so

that you can start with the areas of game design that interest you the most.

\\!hatever your motive, this book is your resource, so use it as you will. However, keep in mind

that game design is an interconnected field, in that many of its aspects are directly connected to

each other. You might not want to be a level designer or static mesh constructor, but you'll make

yourself far more valuable to a prospective employer (or mod team) by knowing about each field

of game design.

How This Book Is Organized
Part I: The Unreal Universe

This first part of the book focuses on a general introduction to level design for the Unreal Engine

with its native editing system, UnrealEd. rt begins with a brief history of Unreal and quickly

moves on to a thorough introduction to how the Unreal Engine functions.

From there, Part I walks you through creating your first Unreal LeveL You see how to carve your

own environments into the Unreal world, how to texture and light them, a nd how to add the ele·

ments that make them aesthetically pleasing and still fun to play. The topics covered include cre·
ating indoor and vast outdoor environments, creating and controlling your level's physics

through the use of volumes, and generating a variety of lighting effects. Part I wraps up with an

in-depth look at material and texture creation and how to create interactive level elements, such

as moving doors and controllJble elevators.

Part II: Advanced Design Techniques

Part II opens the doors to more high-eod features of the Unreal Engine. Beginning with an intro

duction to working with real-time particle systems and effects, Part II aJso brings you face to face

with the Karma physics engine, explaining how it can be used to create realistic simulations based

on the laws of physics_ Next, the chapter covers the techniques for controlling the behavior of

Un reaI's arl j ficiilJlyin telligent pIa yers, known as ,. bots:'

Part n then moves on to cover Matinee, UnrealEd's integrated system for creating in-game cine

matics-animated clips and fUms-with the game engine. Next, Part II discusses how to create

scripted in-g6me sequences to create exciting events that pull players deeper ioto the action. This

part closes with a look at optimizing your levels to keep gameplay as fast as possible, while pulling

as much power as you can hom the engine.
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Part III: External Design

Part III introduces you to creating3D game elements with Alias's Maya. This part begins with an

introduction to Maya from the beginner's perspective. You're quickly brought up to speed on nav

igating the software, learning techniques [or polygon modeling, creating static meshes [or use as

decorative elements in your levels, and preparing your models for the application of texture.

Next, Part nr explains techniques [or creating full character models. This part then covers how

you can turn that model into a digital puppet so that it can be ani mated and eventually used as a

playable character in your Unreal game.

Special Features
This book contains a series of in-depth tutorials, outlining each major concept introduced. To

assist you in following these tutorials, the book includes a CD packed with all the necessary assets,

the Unreal Runtime Engine demo, and Maya Personal Learning Edition 5.0. The book also

includes an appendix that serves as a user's guide for UnrealEd and another that lists the perti

nent properties for Unreal's most important in-game assets.
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Cha te

Unreal Technology:
The Big Picture

This chapter is intended to give you a broad overview of Unreal

Technology as a whole, with a discussion of UnreaJ's history, the

Unreal [ngin~ and its wmponents, the various assets that make up

a modern Unreal-based game, ilnd how aU these assets and <.Olnpo

nents are brought together 10 give yOll a quality real-time experi

ence. In this chapter, you also learn about some of the tools you

need to creale your own content for Unreal and some general points

10 keep ill mind when creating content. However, this chapter does

not go deeply into technical details of creating assets; this topic is

discussed in fliture chapters.
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1 Unreal and Its History
The saying goc~ thai the Roman Empire wasn'l buil! in ;\ d;p,r, i1nd neither was Unreal. The fol

lowing sect ions show .1 ti Illeli nc of Unreal hislory and ...omt: uf lhe most important momen l5 in
ils <Jevelopmcnt $0 that yOll Gill see what it look to get th)s lilr.

Date: Tune 1998

Event: Unreal is launched \'~Ih il warm welcome from the PC gaming community. [1's the first game
to ever lise the Unreal Engine Jnd is ar~uably one of the best-looking, games released at that time.
The game's lush emiron ments and bt,lU1if\11 ~rarh iC5 lake garners by storm. Who ca n forget that first
encounter wilJl the Skaarj? The game also had a robust rnultiplaycr mode thaI could be played against

arlifici.1Jly intt:lligenl "bots," player, controlled by the computer rather thJJl by human players.

The g,mw's dewlopment L1id the found;llion for the Unrc;l[ Engine. Its modular design aUowed

Epic. or its licensees, [0 l:a~i1y <:u$tomiz~ P;lrts or the engine wIthout needing 10 rewrite the enlire

program. The gamt also made it possible for mod m,lkers (those who edit pre-ex..isling games) to
lDsert their own UnrealScripts 10 enhJnce and customize their gaming o ...perienccs.

FIGURE 1.1 UnrAalls rel~ased in 199B and Is an Immense success.
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Date: November 1999

Event: Unreal Tournament IS

launched on the PC and paned to

the Sony PlayStation 2 and Sega

Dreamcast console gaming sys
tems. The game was originally

intended 10 be an expansion pack
for the original Unreal. Focused

on multiplayer gamepl'ly, it aLso
offered an intense single-player

gaming experience by imple

menting some (If the most

advanced bot AI ever to be used

in a game. Unreal Tournament

was also backward-compatible

with maps from the original

Unreal.

DatI.': March-July 2001

Event: The Unreal Developer

Network (VON) websiu goes

online, giving the world a cenn-a I

IOQlion (or finding documenta

tion and tutorials (or content cre

alion llnd other aspects of the

Unreal Engine. To th'$ day,

Ijcen~e('s and mod makers use the

sHe regularly, and it remains one

of the most respected resources

(or information on the Vnreal

Engine and its development:

I1ttp://WoWI_udn.epicgames.com

FIGURE 1.2 Unreal Tournament 15 released In 1999 and is
ported to multiple platforms.

~UNREAl developeI network

FIGURE 1.3 The UDN logo.

Date: September 2002

Event: U\1 I'ea I Championship is launched on the Xbox, followed closely by Unreal Tournament

2003 on the Pc. Both games (ocus mainly on muJtipla)'cr gamcplay, with Unreal Championship

b£'ing one of the flagship games for the de:but o( the Microsoft Xbox Live! broadband online sys·
tem. Digital Ex! rernes assists Epic with contenl creal ion (or the g~mes.
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The new Unreal games sport a wide variety of new

engine features, including the implementation of pow

erful particle systems, terrains, and the Karma physics

engine. The gamt' also includes Matinct', an embedded

system tOr generating in-game movies and cutscenes.

Finally. the revolutionary static mesh is introduced,

which allows levels to be populated with more geo

metric detail than had ever been seen before. whije

maintaining extremely fast gamepJay and animation

frame rates.

Date~ February 2003

Event: Unreal 2: The Awakening is launched. It's the

first Unreal game to focus on single-player gJming

since the release of the original, almost five years

earlier. The game pushes the limits of the Unreal

Engine even further. showing an unprecedented

amount of omerceo detail in a fast-p<lced game with

a deep plot and intriguing nonplayer characters

(NPCs). The game also supports the us/' of stat ~c

meshes, lerrains, the Matinee movie system, the

Karma physics <'ngioe. matenals. and particles and

was supplemented by the Golem animation system

frOill Legend Enlcrtainm<'nt.

Date: March 2004

Event: Unreal lournament 2004 is released. This

game marks yet another leap in the gaming experi

ence that Unreal players have come to expect. With

the new Onslaught g2me type ,mel the introduction

of vehicles, players are no longer limited to simple

levels. They now have vast terrains. skies, ~nd even

outer space.

Date: The Present

Event: <Your Name Here> begms J. qLlest into the

world of game design. This date is sure to be marked

as one of the most significant dares in the history of

the Unreal Technology, as on this day, one of the

greatest game designers ever look his or her first

FIGURE 1.4 Unreal Championship
is released for the Xbox in 2002.

FIGURE 1.5 Unreal 2: The Awakening
is released in 2003.
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steps toward changing the way the world wit! look at

gaming in the (-uture, using the Unreal Engine as the

preferred medium,

The Unreal Engine I?I

Thb section introduces you to the components that

make up the Unreal Engine. So what eXKtly is the

Unreal Engine? If you were to <15k a bona-tide Unreal

programmer that question, you'd likely get bombarded

with a barrage of technical terminology, c1escriptions

of code, and all sorts of details that wodd confuse

someone who had never worked w!th the engine, The

intl"nt of this section is to put into und~Tstandable

I<'nns precisely whal the Unreal Engine and all iiS com

ponents are doing so lhat you undf'rstand how it

affects and controls the many elements of your g.lme.

Introduction to the Unreal Engine

I~
,"-

. ,...... !
-~- ..

_If.. "".

FIGURE 1.6 Unreal Tournament 2004,
released in March 2004.
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I
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The Urueal Engine is J system that sorts through level

maps, textures, static meshes, and other .lrtistie
aspects of a game and combines them flUidly into a

seamless, interactive masterpiece. Of course, that's a

simple way to describe a complex system. Severa) ele

menls compose the Unreal Engine, sl1ch '1.1 the graph

ics engine, the sound engine, and the physics engine,

and each element functions independently of the oth-

ers. AlIlhese independent systems tie into a single core FIGURE 1.7 Unreal Engine flow.
engine, allowing them to work together in synchro-

nized harmony. These separate parts. along with the core, form what's called the Unreal Engine.

FIGU HE 1. 7 shows how data maps to the elements of the Unreal engine.

The Components

The following subsections introduce you to each component of the Unreal Engine. slarting with

the graphics engine, which controls what yOll see, and the sound engine, which contro.ls what you

hear. From there, you learn abOllt the Unreal Engine's physics engine, Karma, which is used to

create dynamic simulations in the game based on physical laws such as gravity. friction, and more.

Next is the input manager, which reads all input from the user or player and translates it into

commands sent to the core and to the Unreal Engine's netvvork infrastructure.
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The graphics engine transforms data into images.

1
The Graphics Engine

The grophlcs engine in the

Unreal Engine- is the compo

nent that makes it possible to

sec what's going on in the
ganle. It's responsible for what :,: , .,

you actually see on your com-

puter ~creefl or television. In

Unreal Tournament 2004, as a

garne character is running

aaoss a room blasting every-
Figure 1.8

thing in sight, it's the graphics

engine thaI produces the images of what the ehJr

aCler is doing in its surrounding environment.

Without the grzphics engine, that same scene

would simply exist as a series of attributes, such as

the character's health, location in the world, any

items he or she might be carrying, and more. 1n

their simplest form, these values are just a Jist of
numbers. N.lturally, lists of numbers could make

for an un in teTesting gillnr. Fortunately, Ihe graph,

ics engine is capable of reading all lhis data and

inst:lrltly transtlling it lI1to something you can

~ctu;llly see onscrccn, ;lllowing for reid-time

visualization (see FIGURE 1.8).

--+-1 Un(eal Engine I--+-

Slill draws :h,s aroa
cliel\lhoughthe

wall,s blocking I~is

area frem the
player's '/H'W.

Beyond ,iust govfrning whJt's displqed onscreen, FIGURE 1.9 Draw calculation.

The graphics engine is also responsible for a wide

variery of behind-Ille-scenes tasks tor controlling what aspects of a level the engine is rendering

(calculating), YOli might be surprised TO kno\\.' that the graphiCS engine is also responsible for

more than what you see; it handles elements that other objects occlude, o! hide.

I3y' def,wlt, the graphics engine renders ('verything within a player's field of view. Say, for exam

ple, that you have a map composed of two rooms, which are separated by a wall with no doors or

windows. Now say rhat a player is looking directly at the wall that divides these rooms. Obviously,

players cannot see the next room because the wall is blocking their VIew, but is the gn!phics

engi ne still rendering that second room? The answer is yes. In fact, the graphics engine is render

rng all polygons th2t would fall in the field of view, except for polygom that would form the hack
of the wall you're looking at (see FIGURE 1,9). This rendering is based all Binary Space Partition

(BSP) calculalion, which is covered in detail in ChaptrT 4, "Advanced Brush Tedmiqut>s."
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NaturaUy, because the graphics engine, by default, renders occluded objects, )'our levels would
become noticeably sIO\\,'er and less efficient as they become larger and more dctaiJed. Level

designers can remedy this problem by implementing a set of techniques that tell the graphics
engine when to render various parts of the level and when to exclude them. These techniques are
covered in detail in Chapter 15, "Level Optim ization (Zonulg) and Distribution,"

The Sound Engine

As game technology has progressed, sounds have played a more vital role in detlning the game
experience. Gone are the days when sounds were a series of e1e<:tronic beeps backed up by simple
MIDI music. Today, players are so accustomed to hearing every aurall1llance of a game that it's
easy to take full-Oedged sound for granted, Games are filled to Ihe brim with high-quality sound
effects, from actionlrcaction sOtmds, such as buHflS ,iring, rockets exploding, and tires screech
ing, to ambient noises, such <IS falling r,lin, humming mOlors, dnd howling wind. Modern games

also incorporate a soundtrack of beautifully orchestrated music, which can accentuate a particu
lar mood during parts of a game.

The sound engine is what makes all these effecrs possible. The engine combines all your built-in
sound effects and ambient noises, and then re-creates them as accurateiy as possible with the
audio hardware installed on yom computer. The best par! is that the sound engine is so well
designed that it has become one of the,jmpJest aspects of Ihe Unreal Engine. AU you have 10 do
is create YOllr sound dfee:ts, compose your musIc, set a few properties, and then tell the engine
where and when to play your sound.

The PhysIcs Engine

One of the most exciting ways to add realism 10 a
game is by simulating real-world physics. In the real
world. when you push an object ilnd knock it over,

you see a reactioil based on lhe laws of physics. The
object bounces and rolls, or even knocks something
else over. You can simulate these events 111 Unreal

through the physics engine, which handles all calce
lations for real-time physics.

Unreal's native physics engine, called Karma or

sometimes toe M{l[Ji Engine, is what handles these

reactionary forces III the game. It enables you to cre
ate faUing objects that respond accurately on impact;
reactive obstacles, such as springboards and swing
ing lights; and even the rag-doll effects you see when
a pll1yer dies in the game (see FIGURE 1.10). Beyond

,~
mathE'ngine

FIGURE 1.10 Rag dolls responding to
motion from an outside force.
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this, it also controls thL: physics behind any vehicle in the game, automating how its shocks
function or even how its tires slide.

The Input Manager

To Jctllally have a game, yot) need some sort of interaction. Jf you can't control what you see
onscreen, you might as well be watching television. This is whfre the inptlt manager comes in.
This engine component reads all Inpllt from the mouse, the keyboard, the joystick, the gamepad,

and so forth, It then communicates information to other puts of the system that change a corre
sponding aspect of the g,101e. for example, when you move the mouse to the left, your player
looks to the left; if you click the left mouse button, the player fires its we<!pon.

h'ha t the input mJna~er actually does is set d series of properties that are sent to the graphics
engine, wh len then rellecrs this information to the user by displJying different parts of the level,
making it possible to see a \V~'apon's trajectory, for example, At the same lime, information is also
sent to the sound engi ne to play the correct sound effect when, for example, a weapon is flred. AJI
this commllnication bet'A'een the input manager and the other components happens quickly-so
quickly, In fact, that yOll almost never notice a delay. The input manager is so flexible that game
developers can alter it completely so that they have full control over what types of properties are

changed through a player's input dcvic.es.

Network Infrastructure

The Unreal Engine includes a well-developed network infrastructure that facilitates a client-server
relationship. During networked garYleplay. client computers (usually the players' computers)
communicate with another compute~ that acts as a server, This computer can be a dedicated

server, which means the host computer isn't actually being used to play the game, or it can be a
,erver computer that's also running a client which allows SOmeone at the host machine to join
the g.ame. As you play the game, only the information needed to represent your characters' activ
Ilies and the immediate response of their envirollmem is sent across the network, keeping net
work speeds and gGme response times running at optimum levels.

Over the yeats, this system has been optimiud ~o th"t it stiJJ runs impressively fast, even on slower
networks. It also allows trtmendou~ ,t mOll lJ t.'> of data to be exchanged quickly between clients and
the server to help accommodate newer h31ileS wjth more players. The infrastructure can also be
customized to facu itate :lerwork play of m2ny types of games, including first-person shooters,
role-playing games (RPGs), racing games, or anything else you might want to create.

The UnrealScrlpt Interpreter

UnrealScript, one of the most n:'lolulionary aspects of the Unreal Engine, is an ob,iect-oriented
programmi ng 1;lllguage similar In s)'ntax to C++ that provides access to almost every component

of the Unre21 Engine. UnrealScript makes 2dditions and customizations to the Unreal Engine
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easy. The best part of the language, however, is that despite its fGlSe of use, it retains immense

power, so few, if any, modifications could be made to the engine's actual source code that

couldn't be done with UnrealScript (see FIGURE 1.11).

JI Und,ka leading~I
le.:JilChog.:UcP'lI9.

Unreal Eng ina I

FIGURE 1.12
The game loop.

r@oA1--~I'I~~zJ,""""lp' L&.1oO:~ P'.tI.,,&rN&I"r,(j).

Te:d=~e-otace(TeJ('. ~"'A". str"9(il':f(l..Badl(rg_~I~n)_

i
al~&

T6x1= ....

FIGURE 1.11 Un realScript interpreter.

Overview of Component Interaction

Now that you know [he components of the Unreal Engine, you're ready 10 take a brief look at

what's going on under the hood of the Unreal Engine, so to speak.

At the core of most games you'll find what's referred to as a game loop.

This part of the program constantly repeals itself throughout the game to

ensure that everything is updated correctly (see FIGU RE 1.12). \'\Tithin

this loop, checks (such as yes or no questions) are made to see whether a

player has jumped, fired h is weapon, lost his health, and so forth. In addi

tion to these checks, many game loops include common tasks, such as

redrawing the screen, playing sounds, or even sending and receiving

information across the network. Game loops give you a linear-based sys

tem with a simple series of checks, which means every aspect has the same

priority so that all tasks are always addressed in the same order the pro

grammers originally set.

The Unreal Engine uses a game loop, but is also an event-driven system. This means the game

contains a queue that holds a series of events, wh ieh components of the engine need to

address. These events are created by many important game elements, such as input from a

player when a key is pressed or when engine components try to communicate with one

another. So how does the core engine know the order in which to handle these events? Each

event is given a certain priority, and events with higher priorities are processed before events

with lower priorities.
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Events

FlmGun
Play Sound
Move Player

Event-based system.FIGURE 1.13

To make the event process more clear, take a look at

an example. At any particular moment during game

play, the queue is filled with a variety of different
events and tasks, each with different prioriry levels.
'Nhen a player shoots a gun, events are generated,
and several tasks, sudl as shooting a projectile and

playing a gunfire sound, are sent into lhe queue. Of
lhese tasks, firing a projeclil\" obviously hilS the

higher priority because it dearly affens gameplay,
The gunfire sound, in con!rasl, hardly affeds game

play at all. In fact, if the sound weren't played, no
other parts of the game would be affected. Therefore, the Unreal Engine fires the projectile first and
then plays the sound. The central idea of an event-based system is that the engine processes the most
critical activities before going on to the less important ones (see FIGURE .1.13).

1

The Components in Action

Now that ~'ou have an understanding of this event-based system, it's time to take a look at what
all these components are doing while the game is running. When you start Unreal, all the indi

vidual components arC' initialized. It's much like the process of starting your car and letting it
warm up: the car hasn't gone anywhere yet, but it's ready for the driver to put it in gear, press the
gas pedal, or any other event a car can handle, In the case of Unreal, initialization is where the

game usuaUy begins.

Sound Engine

Physics Engine

Graphics Engine

Unreal $cript
Interpmtar

FIGU REI,14 Component interaction.

FIGURE 1.14 shows how different parts of the engine
communicate with the engine core, At startup, the
engine core has initialized the graphics engine, the
sound engine, the phys~cs engine, Jnd the UnrealScnpt
interpreter. As this happens, the core engine begins
sending commands to each component. Some compo
nents, such as the physics engine, even send responses
back to the engine core so that everything is kept in

sync. Now that dl the engine components have been
initialized. the user interface is displayed aoci the engine
awaits input from the user.

When the user starts a game, a level is loaded that contains several types of assets, such as tex

tures, sounds, static meshes, animations, and scripts. The information for each asset is routed to
the proper engine component. Then, when gameplay begins, the message queue comes alive with
hundreds of events. At this point, the core starts to route information between the djfferent com
ponents for handling, based on the priority of eJch event sent tu the queue. The script interpreter,
for example, takes all the scripts needed in the level, processes them when required, and, in turn,
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sends that information to the engine core, so appropriate commands can then be sent to the other

system components.

The following is a numerical listing of this process, with each step written both in general terms

and in language describing how it would apply to Unreal Tournament 2004:

1. Game initialization (starting Unreal Tournament 2004)

3. The core engine initializes all system components.

b. Components begin to send information back to the core for synchronization.

c. Game is ready for user input.

2. Game launch (choosing and starting a level)

a. A map is loaded, containing all game assets and their corresponding properties.

b. Each asset's information is routed to its respective engine component. For example,

sounds are sent to the sound engine and textures to the graphics engine.

3. Gameplay (artistic use of the Shock Rifle, Flak Cannon, Rocket Launcher, and so on)

d. Each component sends events and t,1sks to the message queue.

b. Unreal's game loop runs, evaluating each event by priority and performing the tasks

with highest priority first.

Engineering New Worlds 'with the Unreal Engine
Now that you know what components go into actually running the game and what happens to

them as the game runs, yOll should have a better understanding of exaclly how the Unreal Engine

works. From here, you're ready to begin creating your own virtual worlds for use in your games,

mods, and other projects. Remember that the Unreal Engine is an open-ended system that can

accommodate the needs of nearly any real-time project. Although, at its heart, the system has

been developed for games, its power and flexibility make it a perfect tool for many tasks, includ

ing the visualization industry.

Imagine going to a meeting where you're trying to get a bid on a building contract. A competing

company has brought a nice prerendered flythrough of its project. You, on the other hand, have

put together a beautiful tlythrollgh using the Unreal Engine. Your presentation can now be in two

parts: a Matinee movie in which you use Unreal to playa prerecorded flythrough, and the oppor

tunity for your potential client to use the computer to fly around the building. "Which project

would you find more impressive?

Game Assets

Nearly all the data Unreal lIses is stored in a series of packages. You can think of a package

as a collection of data, such as texture information, static meshes, animations, and so on
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NOTE
Although Unreal packages come With several different
file extensions, the extension itself-. ukx, for exam·
ple--doesn'l control the type of data in Ihe package.
All packages are essentially stored in the same for·
mal, and the different extensioos merely make it pos
sible to determine tile types of assets in each package
more easily.

FIGURE 1.15 These are the type of assets
found in packages with the standard tile extensions.

Maps

Maps, or levels, are the one major asset type
not stored in packages. They are the enviroll
ments in which your game will take place (sec FIGURE 1.16). Technically speaking, a map is a

collection of many game elements, as mentioned earlier. Artistically, however, a map is a medium
you can use to evoke different feelings or moods in your players and enhance their gaming expe
riences. There can never be enough planning for a good map. Don't be afraid to share your ideas
for a !evel with other members of your team or the onl ine cornmun ity, You'll definitely b("llrfit
(rom the experience, opinions, and ideas of others who eventuaUy play your level.

(see FIGURE 1.15), Typically, packages ue
separated by the kind of information they
contain. For example, one p;;ckage holds sta
tic mesh("s, another package holds textures,
and so fonh, Keep in mind that not all game

assets are stored In packages. Levels, for
example, are stored in maps. In the next few

sections, YOLl take" look at some of rhese
assets and see hO\\I the Unreal Engine uses
them.

1

FIGURE 1,16 Ascreenshot of the map Gael from Unreal Tournament 2004.

A map wfltams many elements, or assets) aU of which are nec~ssary 10 mnvey the visual effect you
waflt wd to make sure your map is both playable and enjoyable. Some of these elements include
textures to "color" the surfaces of your level, static meshes to add the major physical detail) and

sound eff~(ts, including ambient noises (see FIGURE 1.17). The map inserts these assets into your
level by referencing them from their corresponding package$. For example, if you delete a texture
packcge !luI a specifi( map uses) those textures don'l appear the next time me map is played.
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Textures

Texturrs come in p;lckages In.1t, by default,

are denoud by thc t':\1C1Jsion . u tx. You call

think of le1.1urts as "painl" or "stickers'" that

cover lhc surfaces in your lTlar~ (:>1:'1::

FIGURE 1,18). Textures arc gCllcralcd in

an external ~nftware p.lCkag<.:, .\ ltd l ;IS

Photoshop or UPaint. You can gt'l textures

from a variety of sources: Thc)" can be cre

ated from scratch, retrieved from J di[;iLll

photograph, or Hcquired with d scanner. Pm

example, s.... y you need a Glrpel tc:xtllrc for

tnc Ooor 01 Y(lUr map. You could dntw one,

you could take a snapshot of one with yoW"

digilal camer,1, or you could even place a

piece o( carpeting on a fl.llbcd S":ilnncr.
FIGURE 1.17 Assets used in 3 level.

FIGU RE 1.18 Different kInds of textures, one generated in Photoshop and Ule other Laken from a
digital camera.

SoundS

Like Uxlurcs. ~()lJn.tij arc crcatrd in an external.softwan: appllC3.lion or mighl come from audio

files you already have. Sounds ill a map arc played in rCSp()ll~c 10 spe.:di.c events in your levd, such
3S firing a weapon or opening a door. Some sou nds, sUl:h ~~ ambient noises, play when a charac.

ter is within a urwin rJn~e. The sounds included with most UnrcAl Engine--based g<lmes are

stored in a packJge wilh the extension. uax.

Don't (orget to wnsider music when dcvclopmg sounds (or your m2p. Modern games are cine

malic and reflect much of rbe movie-going experience. You un usc music [0 creale a feeling of
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~llspense, intcnsil}', un'ad, victory, and Illuch morc. 1\11 hOLlgh music might not be ne(ess.J.ry for

what you 113\,(' in mind, J lllusical ,core can definitely aud dr~ Ill" and excitement 10 JUSt about

any game or project.

Static Meshes

Srali( mcsIJ,'s arc highl), optimiled polygollJI models imported into your game from cxternal3D

pJckdges, such as ;vLlya or 3ds max. They enable ynu to cre.ate nu mel'O us instances oC a single

polygonal nll'sh in your map" with virtually no more overhead (frame raIl" loss) than if Y'ou had

inserted oniy a singk copy. h)r example, a m.lp with SO copies of a stalic mE:~ would run just as

fast as another nLlp that only hJ.d one copy. 'Your ll1aps GJ.n include any kind of objccl yO\! need

ch:lirs, shelves, doors, 5t,tirs, pictures, and W Ofl. rn modern games, staric meshes are also used for

larger objects, sllch as Stct ions or buildings, ,1I1d stat ion~rr vehicles, such as a wrecked ~ utomo

bile. St.ltic meshes .He ~Jved in l_)acbges. with the file extcmion . usx. FIGURE 1.19 demon

strate, how compllter perform;HJCc drops with the incre;}sc of ~1;lIie meshes in your leyel.

:'f./:ill'll 1 .sl1llJe~~ t\a.s <';l.u.:,.ur $YXl p.sYfI. T"IiIs QI'tIIP"1 t<1I ~.~, dmf~ on"]'QtIl ~'!d6.1 card, cpu. l}1r.

I-I(ty~ 11'\0 ~"Sj 11(/W1)I lt~ "'.".. t\o"'l l~lliW'" Itu:!J N-~_
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FIGURE 1.19 Perlormance graph.

Still Ie llleshes playa vitJ I role in gil mc erc;!! ion, ;J~ they arc the In,lin soufa o( physical de lailln fae/'

111811y maps in modeTil Unreal Engine-based games. mch as Limea! TOllmamcnt 2004, would look

quite barrcll if you removtcl ~II the st.nic meshes. HO\\'el'er, you must remember thaI stalic meshes

are intended 10 bl' imlJnec(!- or wpied, numcrous t ime$ throughout your map. Therefore, if you
constructed a lllap with thousands of different stdtie meshes, you would quickly lose the benefit of

their ;lrchiteClurc.ln this sit llJt ion, it's best 10 coll"idc-f sl.llic meshes ;IS d dlCwral ion for demenLS th.:lt

typicaU\' appear sl:v('r~l (illlt's in your ll1<lp.
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Animation Packages

B,pedMale

BJpedFemale

Animation Package

Animallon ~,Mesh

NighlMale

MercMale

EgyplMaJe

MercFemale

Animation packages, denoted with a .ukx file extension, store information for all animated assets

in Unreal. They include a wide variety of game elements. such as characters, vehicles, and

weapons. Animation packages store two St'parate files for each of these elements: the textured
model and the object's animation. The package contains these two files so that yOll can apply

different animations to separate models. For example, in many games, several different charac

ters move in precisely the same man·
ner becalls\, the same animation file

can be applied to many characters.

Reusi ng animation mes saves
tremendous amounts o[ time because

the nnmber of separate animations

for game characters can bl' huge.

Many characters in UT2004 have a
IOtal of more than 80 different ani

mations for their walking. running.
jumping. swimming, and taunting FIGURE" 1.20 Animation package.
animation cycles.

The Tools

You now know the different types of assets the Unreal Engine uses. This section discusses t]1e

tools, or software applications, you need to creale these assets. As mentioned, many of the assets

needed for your maps must be created with external software, and this section discusses some of

these applications. Keep in mind that this discussion is not an aU-inclusive Jist; many different

applications could be used to create some of these assets. The programs discussed here are men
tioned only as suggestions, but you're more than welcome to use others.

UnrealEd

Un rea lEd is the primary system [or creating or controlling all the content for your project.

It's capable of creating maps for your projects, importing content, and managing asset pack

ages. Ir's <llso the only program you can use to open and examine the contents of an Unreal

package.

You can't use UnreaJEd, huwever, to creale 3D content, such as static meshes or character mod·

e1s, paint custom textures, or record sound effects. For this reason, you have to incorporate third·

party software packages, such as those listed in .the folluwing sections, to generate content that

might not be available with the Unreal Runtime Engine, included wilh this book.



Although UCC is an important application tor generat
I iog Unreal content, much of its use involves program

ming and UnrealScript. As such, it's not covered in this
book.

1

22 Chapter 1 Unreal Technology: The Big PIcture

FIGURE 1.21 The UnrealEd user interface.

ucc
The Unreal execution environmel1l (UCC) is a I NOTE
command-line program that allows for low

level package editing. With it, you can change

package settings that arc unavailable in

UnrealEd, sucn as whether dala in the pack

age can be downlo2.dcd from server to client.

It's capable of compressing and decompressing ftles, compiling packages, exporting data from

packages, and many more tasks. lts most common function is compiling Unreal Script.

3D Applications

For just about any project, game-related or otherwise, you need a 3D application of some sort to

create custom content. A wide variety of 3D applications, from many different vendors, are on the

market. Maya, from Alias, and 3ds max, from Discreet, are two of the most popular applications

for 3D game content development. You can find out more about these programs and download

tdat versions at WMV. alias. com and WW'lI. diScreet. COfl\.
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FIGURE 1.22 3D applications.

Using a 3D appJicatiop. can be difficult at first. If you need help, yOll can find two exceUent l>ources
of online tr"ining at www. 3Dbuzz. com ,1Od www. Mas tenngUnreal. com. Al these siles, you can
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find a w~de varie-ty of free downloadable tutorials for many of today's hottest 3D applications,

including Maya and 3ds max.

FIGURE 1.23 Online training websites.
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NOTE
No matter wht'll 3D application y6U go lor, make sure I

you can find the correct plug-Ins '0 e~(\ort you r data I
_JInto 3 formal thol UnrealEd can read.

Paint Programs

GJIYJCS such 3S UT2004 include <l robU.'il

library of texture packages, bu I evenluJ11y

you'll probablr wa rll to (ceall;' your own. To
do this, you need \0 usc a separale 2D p:JJ 1\1

program, sud1 n.'i Adobe PhOloshop Or Corel Pil;ntcr. Bolh <lppli(;llions give you a wide range o(

flexibility whell designing the look of your game Js..'ets, You might also nted '0 use a 3D paint
appuc.lliol'l, such as Deep Paint) D or Deep ChancIer by !{Ig}lt Ht'lllisphere. A special Unr~aJ

based version of DC'(p Character. known as UPain" i.s included with UT2004. With th~se pro·
grams. you (,;lfl import:l 3D model so that you can pain! directly on its SUrfllCt'.

FIGURE 1.24 The UPaln1 user Interface.

Sound Programs

Because you (<In', record audio in UnrealEd. you need an external sound composition program
'0 product you r own "ou nd efftct5 or musIC rOT your games. Many different programs enable you
'0 do this, such ;15 Sonic Foundry's Sound Forge iHld Twelve Tone Sysrems' Cakewalk, \Vhen
choosing;t program, keep In mind that you I1ced to be able to edit the sound's waveform so that
you Gm remove Jny sligh, pauses that h~ppen berare a sound effect and any dead lime after the
iludiQ in (he file. Also. rem<:mbcr thilt Unrc31 i!acpts only '''./AV (. wav) files for sound effects and
OGe Vorbis (, ogg) files for musk.
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~-............. ....,. ,c_~=.""".,;;;;;;.- jI.IlIlf.f,,¢p!--

--------------------------.-----------_._---------------

FIGURE J..25 Sound programs.
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Summary
Vou should now have a better idea of what's involved in creating a project using the Unreal

Engine. You have learned how Unreal has developed and grown, what the Unreal Engine i~ wha1

components it encompasses, and how it works. Vou have also seen the many assets that one needed

when crt'aring real-time content for Unreal and Some of the cools you need when generating these
assets.

A.t this point, you're probably eager to stan creating your own conlent . .Before you do that, how

ever, you need to review some guidelines for t.a.J.cing on any large-scaJe project involving the
Unreal Engine. Chapler 2 introduces the fundamental concepts behind game development and

offers some strategies. to make your project rim more smoothly and come logethe1" more quickJy.





Chapter

The Process of Game
Development

At this point, you should have a good idea of what componenrs <lnd

assets you need to produce for your game or projed. So now you might
be asking "How do I go about acquiring all this new content?" In that

respect, you're lucky because this book is designed to tell you how (0

construct each maior asset to complete your game. However, even after

you have learned how 10 produce all your material, you might still ask

yourself the infinitely more difficult question "Where do I begin?"

This chapter presents a basic schedule ;md planning system for game

conlent development. YOli are more than welcome to use it as a

framework for your development process, or you can design your

own based on YOlJr specific needs and your project's requirements.

Much of \\lhat's presented in this ch<lpter is designed for first-time
developers who might need some guid.lnt-e in developing their game.

Everyone has a different workflow, so be sure to use the methods that

work best (or you, especially if you already have experience in the

field of game development.
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Building Your Foundation: Before Production
You need to consider many factors before you jump into game development. Jf you're a gamer,

try to think of the number of people you've heard say "Hey, I've got a great idea for a game!"

Sometimes, the ideas really are good. You might have heard one or two that would make $Uccess-

2 ful games. Perhaps you've even had such an idea yourself.

Just thinking of a good idea, however, is not enough in the game development world, The best

ideas out there will probably never see the light of day. What you need is a detailed plan of action

in which you've considered all the possibilities and pitfalls you might encounter throughout the

course of the project. Creating this plan can seem overwhelming at first, but with enough time,

effort, and phmning, just about anything can be accomplished in the game world.

In the following sections, you get a taste of some guidelines you need to keep in mind to turn a

good idea for a game or project into a reality. The sections in this chapter are designed to guide

inexperienced game developers and to paint a complete picture of the game development process.

Developing Your Idea

You might want to develop your idea after you have formed a team, but usually it's better to have

a solid idea and plan of attack in place when you approach prospective team members. Make sure

you think your idea through to its end. The morc you know about your project, the easier it is to

select your team, Take into account the volume of assets you need to create versus the timeframe

in which you need to finish them, This factor helps you decide how large your team needs to be.

If your plan is a small-scal~ one that doesn't require a team, getting insight and feedback on your

idea from others who understand games or game madding is still a good idea.

Your idea should be as original as possible to set it apart {rom other games in the genre. The game

design world is a competiti~'e environment, where new games always try to outdo the old. Game

graphics have become more sophisticated, but this factor isn't always enough to attract cus

tomers. You have to come up with a way to make the game fun and playable, regardless of its

graphics. Try to come up with something that hasn't been done before in a game, or at least put

a new spin on a popular game element. The following example has been divided into three sec

tions: the story. the player's perspective, and the pitch.

The Story:

Many games have some sort of plot or story to help push the auion along. Even though the game

doesn't yet exist, a story is an important part of your idea because it helps yOIl determine the type

of assets your game is going to need. The following paragraphs outline all opening story from a

yet· to-be-developed game called Eternal Exodus: The raJl of the Creators,

Project:

Single-player first-person shooter/space flight game (some multipJayer elements)
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Eternal Exodus: The Fall of the Creators

Plot Introduction:
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It is the year 2359. Humans have destroyed their

homeworld of Terra through overmining and

pollution. They have since escaped to the stars

and established numerous colonies across their

native galaxy. They have scoured deep space in

vain searching (or planets as abundant in

resources as their (allen home planet. As their

industry devours whatever materials they find on

their travels, the corporations driving those

industries have become ultimately powerful,

superseding or supplanting all governments and

regulations. The most powerful of these corpora

tions is the Lathius TransGalactic Corp., which

holds a monopoly on all interspace travel.

From the decadence of society has risen a rela

tively small but quickly growing resistance

movement known as Fidus Terrenus. This

activist militia (ocuses on the belief that

humanity is destined to be more lhan interstel·

lar parasitl"s and that what's happening to colo

nial planets is the highest atrocity. The Fidus

Terrenus have been known to engage in anti

corporate activities, and most corporate gov

ernments have officially labeled them as

terrorists.

FIGURE 2.1

FIGURE 2.2

FIGURE 2.3

Eternal Exodus; Fall of tile Creators.

Corporate buildings, circa 2359.

Lathius TransGalactic Interceptor ship.

During a skirmish between an FT fighter group

and a Lathius deep-space gas mining fleet, a

large disruption happened. Two small ships of

unknown design entered the fray, quickly

destroying all other craft in the engagement.

One of the FT ships was able to send om a dis

tress signal that included an incomplete scan of

one of these ships.

FIGURE 2.4 Fidus Terrenus troops.
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Days lal cr, a massive signal was lraasmit'(ed to
virrually every T"rr:lJ\ colony. The signal's force

w~s so inlense thaI only Ihe most powerful
fc<:(jving stations were able 10 monilOc it with

OUI ovcrloading. TI\e trans1l1issio 11 was trans

laled via supercompuler wilhin jusl a few

hours, sugg~sling !.hal Ihe source of the trans

mi.ssioo wanled il 10 be underSlood quickly.

The message was simple but enigmatic: "We

come to put an end to Ihal which we have
begun:'

The Player's Perspective

After you hav~ a slory. drafting OUI how your

plJyas .lrc exposed 10 the plot lhroughout

galllcplay is a good idea. This slep can be a 1)\I)e

difflcu It to ll.lil down. 50 take your 1ime. Also;
dOll't be 1<.\0 surprised If your lde~ is (orad 10

~I<].,pt In changt's tnar arise as your ga me is
developed. This dra{[ doesn't need to include

<-,,1'lT)' slllgle lev"" and nuance of your game, but

il should give your development staff an idea of
how the game will prog,rt:ss. The following sec
lions give' you lin overview of how players e-xpe
riencc the slory of (his make-beJjeve game.

--- - ..

FIGURE 2.5 Ships trom l1lthlus
TransGslactlc snd Rdus Terrenus.

FIBURE 2.6 Receiving station where the
origlnal message was intercept~.

Overview of Game Plot from the
Player's Perspective

The bdnle begins I ... ith Ihe player known as lace
Dcbroix. conlTolling lhe main character. lace is
a (ontracted escort fighte-r pilot and corporate
bodyguard for some middle-to-upper manage
lTlCflt o( Lathios TransGalaetic. The message

from the ~lien race, who call themselves "The
Crc3IOrs.... \va5 received months ago, and several

of the outlying Tenan colonies have been

<Ic~lrnyed.

FIGURE 2.7
station.

Control room of the receiving
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The first few missions of the game include the

player acting out the role of corporate body

guard, in space and on foot. ft's a time of tur

moil, and smuggling, looting, and piracy are

running rampant. Basically, players will have

their hands full completing each lask.

Eventually, Fidus Terrenus approaches Jace,

asking him to abandon the corporation. The

player can accept or refuse, and this decision
determines (he neX! several missions. If the

pUlyer chooses to join Fidus Terrenus, Jace will

have to complete such wks as smuggling runs

and skirmish assaullS against corporate estab·
lishments. If, on the other hand, (he player

sticks with the corporation, Jace will combat

the FT, trying 10 cut their supply lioes and end
their reign of terror over the colonies.

Either way. the Creators' threat eventuaUy

spreads 10 the player's location, and a rnas.,jve

battle ensue-:> between The Creators and the
planet's colonia! inhabitants_ Battle is on foot at
first and thlm in space, as Jace tries 10 escape the

planet and avoid the imminent doom brought

On by the Creators- The only hype~pace·capa

bJe t ransp0rl belongs to fidus Tc:-nenus, and
Jace i.s (orced to join their ranks i( he wants to

survive.

FIGURE 2.8

FIGURE 2.9

Terrenus.

Player character lace Dela roix. .

Jace approached by Fidus

Jact is then laken to FT headquarlers. where he

finds out that a plan has been put into motion
to retaliate against the Creators. At first, the
plan requires capturing some of the Creators'

ground (orces, an exceptionally difficult task, 3.S

they have a tendency to self-destruct when

deCeated or overcome_ Jace helps with these

missions and cventuaUy leads an assault to cap

ture a Cr<:ator ship. During these missions,
Creator (~(hnology is lIsed to create new

weapons and defenses_

FIGURE 2_10 The battle begins, and the
player Is rlghtln the middle of It
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The IT then learns thaI the Creators are a race

of beings who found a rare kind of planet,

which soon became Terra, and spawned

mankind as an experiment, losing contact soon

after developing a race now known as the

Egyptians. During the next several thousand

years, mankind achieved space travel, destroyed

its homeworld, and began to spread like a virus

across the stars. Mankind became the Creators'

greatest failure, so the Creators have come to

destroy mankind once and for all and put an

end to their "experiment."

The IT also discovers that the Creators know of

a planet similar to Terra, which is accessible

only through an unstable wormhole. The

remainder of the game consists of missions

revolving around running from the Creators,

getting the remnants of Ihe FT 10 this planet,

and destroying the wormhole, effectively

removing the threat of extinction. The game

ends with a sequence in which players find out

that the Crealors actually crealed the wormhole

leading to this planet. This discovery suggests

that the FT might have an encounter with them

in the future, should the Creators choose to

construct another wormhole.

FIGURE 2.11 Jace meets the leader of
Fidus Terrenus, Shelia Sorenson.

FIGURE 2.12 Planet exploding as a result
of the Creators' attack.

The game has multiplayer aspects as well,

including ground-based skirmish levels, such as

FT forces fighting Lathius battle squads_ Space

fights with ships are also included, which could

be team based or free-far-all. Finally, the multi

player aspect could include a cooperative mode

so that at leasl two players could move through

the single-player campaign.

The Pitch:

If your game or project is more than just a

hobby, the pitch is the most important part of FI GU RE 2.13 Space shot of wormhole.
your plan. To convince others to be involved in
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production, you ne,ed to persuade them (at least on some level) 10 participate. You neeo 10 (orm

a sales pitch (0 help people get as fired up about your idea as you are, Developing a pilch IS also

a good time to figure out whether your idea is a good onc. Keep in mind that if you on'! seU
someone on your game's concept, you probably won', be able to sell :myolle the final result.

Remember that not everyone shares your ideas of what's cool or exciting, Your pitch needs'o prt':

sent the project in such a way that most people can see W)IY your idea is marketable,

Gathertng the Team

Gathering your team is a more important step than many people realize, I( you hil\'e ever tried 10

work with a group of people to accomplish a goal, you know exactly how imporl ant this step is.

Working with a group to finish a project is often like trying to order a pin.a ,hal ~(L,fie5 !;'Very·

one. You have to take into account personal schedules, emergencies, obligations, and other day

to-day stuff that pops up (or people who live in the reaJ world. The foUowing seClions explain

what (actors you should consider when trying to get a team logelher.

Know Who You Need on Your Team

Take some time to figure out exactly what kind ofjobs are necessary to com plete your project. [l'S

pointless to seek out team members until you have done this step, Remember, however, that when

working with a small group. often team member., can fill more Ihan one role. On the other hand,

if your project has complex tasks, such as eJ(lcnSlVe modeling. you might need 10 sign on more

than one person to complete those tasks.

The (oUowing list describes some possible positions for memb~~o( your team:

~ Concept 07'ti.Sl-This person pro-

vides a11 the drawings and sketches

needed for your project. such as

characters. weapons, vehicles, and

map layouts. For example, the ear
lier sections in this chapter about

the story fot Eternal Exodus
included several pieces of what
couJd be considered concept art.

Naturally. concept artists o&!d to

exhibit exceptional skill at creating

20 art based 00 ideas and

descriptions. Having a good

design sense, too, is 3 turo~tldous

h~Jp 10 enhancing th~ final look

and feel o( the game') elements.
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.. Level designer-You need someone on your

team who knows how to design and create

maps for your game or project. That's

where the level designer comes in. This

team member should have a thorough

knowledge of UnrealEd as well as what can

and cannot be done in a game map. Level

designers need to have a good overalJ

understanding of game design, such as
what look is popular in today's games and

what will look best for your specific idea.

They also need a good aesthetic sense of

interior design for placing lighting, deco

rating levels, and making certain that the

overall look of each map is consistent

throughout the game.

.. Modeler-This learn member converts the

concept artist's 20 artwork into 3D assets

that can be imported into your game.

Typically, modelers' work needs to be re!3

tively low in polygon wunr, depending on

the amount of physical det;lil your project

needs. Modelers need to be famili<Jr with

the polygonal modeling tools in your cho

sen 3D package and should be ready to

work closely with concept artists to make

sure their work foUows the original designs.

Modelers must also stay in dose contact

wilh level designers so that they're modeling

aU the necessary static meshes for each map.

.. Texture art;st-The tactile look of your

game elements are left to the texlure artist,

who is the team member responsible for

making sure your project's objects seem to

be made of the correct materials and have

appropriate colors and shading. Texture

artists must have extensive knowledge of

20 computer art applications, such as

Photoshop, and know where to find

sources of real-world textures.

FIGURE 2.15 Wireframe image of a level.

FIGURE 2.16 Vehicle and character
wireframes.

FI GURE 2.17 Assau It rifle textu reo
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• CrtDrure >ellJp tech'IlClan-Th 15 team
membC'r is responsible {or crewllg the

control s~lem that (urns your character
models Into digital puppelS that (he 31l1

mator can (ater set 10 move. Creature

setup lec.hnicitlns need 10 have 3 thor

ough unoerslanding of charaoer rigging
leduliques in the jD pac:kagc you have

decided 10 use (or the projecl, .such <lS

Maya or 3ds max. Often, especially on

smaller le<lms, this person doubles as an

animator.

• Allimolor-When motion is needed, the
animator is the one to call. The animator FJ GU If E 2_18 Bones for a game character.

not only understands animation meth-
ods in your selected 3D animation SOhW3n\ but also has a thorough knowledge of (he

way objects move, especially their timing. [( l he animator isn't doing the creature setup,

you should make sure the creature setup lechnician 2nd animator work together closely
so tlrat there are no conflicting ideil5 aboul how control sy~tems ~hould be designed .

.. Pragrammerlcader-'n'15 team member k.'1.0\\l5 how Unre"IScript works and how to lise it
to integrate /hi" necessary functionality into the game or project. (n most cases, progrJm

mers also undcrstanrl many o( the fundamental concepts that drive lhc Unreal £nginc, SO

don'l be afraid to go to Ihem (M advice on your id.::a. Good programmers should also

unde~land [he c..apabiJities of rht UnreaJScripllanguagc 50 that Ihey (.;In judge the

difficulry-m tvt:n the pllssibility-o( iT1tcgrating.a new idea inco the system.

.. Projul mannger-This person JOtsn'1 lIsuaUy crcate any o( Ihe game's elcmenLS, but sl ill

plays a vital role by making sure each part o{ the project is being completed on lime ~nd

any internal problems are solved. In many uses, this (cam member migi'll ru rn Qut 10 be
you- 1(, hOhlCVtr, you don't feel comfortAble.-' WIth or capable of keeping your wor~r5 on

scheduJe. you should probably consider finding £Oroeone else {or Ihe job. If)'ou have

someone olher .han yourself in this posilion, make sure you st;ly in close COnl:!C/ with

him or her I nroughout the projeci 50 'hat you're informed o( the projecl's progress.

• Web designer-The wt'b designer can be any member of the team who has C"Yperiel\Cf' in
creating web pages, bUI you might W~ nl 10 bring in il person dedicated strictly 10 de-sign

ing a site 3nd kaping it maintained and updated. Get other online game community sites

and forums 10 men/ion your game or project so that people check out your s!le and gel

e'Ccired abOUl ils rcle3se. Promoring your project is an important aspec.t of its 5uc..:ess. An

ea!:'f way 10 get your game nOliad is 10 design a web page Ihat informs the public about

your project and offers updates on the prllgress: of iL~ developmenl.
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Choose the Right People

Find recruits who are reliable and hard-working. This advice cannot be emphasized enough. You

need pfOple for your project who are just as serious as you are about seeing it through to the end.

Don't be afraid to reject potential team members who don't seem as though they can stick with

2 tht" pfojfet. If you don't think someone is cut out for the project, be honest and explain why you

feel that way. Your honesty might even provoke him or her into "proving you wrong" by working

h,ud and becoming a strong member of the team.

Find people who enjoy working on jobs such as your project and are willing 10 dedicate time to

it. Remember that a lot of people think game design is cool and wllJ jump at the chance to get

involved, but they might not realize the tremendous amount of time and work involved. You need

to find team members who understand the difficulties ahead and are willing to work through

them.

Know Their Capabilities

Don't add wmeone to the leam as an animator unless you know this person can animate well.

Ask to sec references or past work. Depending on the professional level of your project, you might

request a formal resume, demo reel, or documentation of previous related work. Ask people who

have worked with your potential team member in the past so that you have a better idea what to

expect of his or hfr work and attitude. At the very least, make sure you know whether this person

is capable of the work and ski)) level needed for the project.

Define the Roles Clearly

Many problems tbat happen in a team occm when the boundaries between different team mem

bers' roles blur. This can happen when Jines of authority aren't clearly drawn or when your team

hasn't been thoroughly informed about the I;lsks for which tht'y are responsible. Head these prob

lems off before they occur by letting people know ahead of time who their supervisor is supposed

to be, whether it's you or someone else. Don't a))ow team members to step on each other's toes.

For instance, i{your animator is spending time editing a character model that your modeler said

was finalized, you have a problem that needs to be addressed immediately.

Make Sure They Are Willing to Listen

There's no point in adding a t('am member who doesn't listen to directions. Make certain your

workers resped authority, are willing to listen to whomever is in charge of their work, and follow

the instructions given to them. At the same time, don', bring in team members who can't accept

criticism of their work from yOIl or other leam members. Acknowledging problems is the first

step in repairing them, and if one of your workers can't tolerate being told lhat he or she has done

something wrong, you might want to reconsider keeping this person on the project.
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Compatibility Is Important

Choose team members who can work well with others and have a positive attitude toward the

project. In a perfect world, even people who don't see eye-to-eye can still work together. fn real

ity, however, this isn't always the case. If a team member's attitude is detrimental to the rest of the

team, that person should go. Of course, you can't make ali your team members like each other,

but you can let popular opinion help you with decisions. For instance, if a potential team mem

ber just can't get along with most of your group, make sure this person is working closely with

those who can tolerate him or her, or perhaps just drop this person from your team.

Honesty Is Still the Best Policy

Be honest with people from the start. Jfyou know the schedule will be tough, let your team mem

bers know when they sign on. If team members aren't working up to your standards, tell them

immediately, but remember to be fair in your criticism of their work. Fairness and honesty go a .

long way toward preventing conflicts. Your honesty can help your team members trust you and

place more value on your opinions.

Keep Personal Schedules in Mind

Make sure you know what personal obligations your team members have. For example, if a team

member must attend a weekly meeting, make sure to fit your schedule around that meeting, if pos

sible. At the same time, remember that you can't have an effective team if everyone needs time off at

different points throughout the week. Be sure you speak with your entire team and find a schedule

that everyone can agree on. Note that finding a workable schedule isn't always as simple as it seems.

Compensating Team Members

Not everyone on your team can work for free. To anyone who has worked for a company or cor

poration, this statement seems obvious, but the subject of compensation seldom comes up with

nonprofessional projects, games, or mods, as self-promotion or recognition from the game com

munity is quite often the goal. However, you might have a team member who can't donate his or

her time to your project but would be a tremendous asset to production. For example, you might

know a professional programmer who could cut your coding time in half, so you might want to

make that person's involvement in your project worth his while. Whatever the case, be sure that

you carefully weigh costs versus benefits when compensating your team members.

Refining Your Ideas with the Team

Now that you have signed people on to help you achieve your vision, you should meet with them

and gather feedback on your project. Take advantage of your increased base of ideas. There's a

good chance that a team member will think of something new, and its implementation couJd

prove worthwhile. At the same time, be open to the possibility that some aspects of your plan
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might not flow as well as you thought, and be wil/ing to accept opinions and feedback on what to

do. AJso, meet with team members individuaIJy and hear what they have in mind for their part of

the project. For example, you might want to speak with your concept artist to see how he or she

envisions the characters and objects in your project, or make sure your level designer has a clear

idea of your project's look.

Generate a printout or an email that covers your idea in its entirety and give each team member

a copy. After they read it, encourage them to write down ideas they think would enhance the orig

inal concept. You can then share these ideas with the group and come to a consensus on whether

to include them. Having these meetings is also a good way to find out whether your team is capa

ble of completing every aspect of the project or you need to bring in additional help.

Creating a Production Schedule

Few things are more discouraging to a project's participants than falling off schedule. Keep in.

mind that during production, delays are bound to happen, and you and your team should be

ready to strive to maintain the set schedule. During the project. remember to make the most of

your project manager's skills to keep your team's progress on time.

How do you set up a workable schedule for your project? It takes close communication between

you and your team members to make sure they know exactly what they need to do and the order

in which to do it. They also need to let you know how fast they can complete each task. With that

knowledge, it's much easier for team members to have a schedule they're able to maintain with

out undue pressure.

Scheduling is not a quick process, so don't rush it. Creating an individual schedule for each team

member is probably a good ldea; this schedule should state specific details for each task the per

son needs to do and outline precisely when the task should be completed. You should base this

schedule on the team member's capabilities and availability.

After you have created these individual schedules, you should bring them together to form a mas

ter schedule. Team members can refer to this generalized schedule at any time to check on the

progress of other departments, without having to see the specific details of each task to be

completed.

Beginning Construction: During Production
Now that you know exactly what's going to happen during your production and when each task

is going to take place, it's time to get to work! Production is a process that you should find ful

filling and rewarding. Nevertheless, you will probably encounter a variety of problems during

your project. Although the intention of this chapter is not to cover every possible problem, a few

situations that commonly arise are discussed as well as how you might go about solving or react

ing to them.
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Maintaining tho Schedule

After production has officially begun, the schedule is of maxmmm importance, Make sure your

project manager follows the progress of all team members or departments and keeps everyone on

schedule (or as close to it as possible), Often this job can be quite challenging for your project

manager, so be sure to offer advice or try to help as much as you can.

The project manager needs to keep team morale in mind, too, Remember the difference between

constructive and destructive criticism: Constructive criticism points out problems yet encourages

team members to keep trying to improve, Destructive criticism only shames, alienates, insults,

and, in the end, drives your team members away from the project. For example, telling a team

member that his recent work isn't up to his usual high standard and could improve with some

extra effort goes much farther than simply calling his work "a pathetic excuse for game content."

Sometimes there's a fine line between these two types of criticism, so try to keep team members'

overall morale in mind when criticizing their work, but remember to stay honest at all times. This

guideline is especially important for team members who 3fe volunteering their time because only

their morale and enthusiasm will keep them from leaving your team.

Dealing with Delays

Remember that delays happen. They can occur for a variety of reasons, from personal crises to

software issues, The key is not to let delays bring you or your team down. Try to get back on

schedule, or if that isn't possible, form a new schedule that takes your delay into account.

However you deal with a delay, make sure you inform the public, regardless of the disappoint

ment this announcement might generate. In the game development world, delays are common,

but this doesn't mean they should be taken lightly, A project with zero delays is probably never

going to happen, but a project with too many delays can lose the interest of an eager public.

Bringing It Together

After you have enough project assets completed, it's time to integrate them into a functional

game, This task is usually the work of the level designer and the coder, as they have the clearest

idea of how the Unreal Engine works. This step includes developing the functionality of game

assets and making sure all assets work correctly when combined. They also need to ascertain how

the game, mod, OT project plays when it's finished.

The Unreal Engine is extremely powerful and capable, but you might still need it to perform tasks

it doesn't do in an existing game, such as UT2004. If you're experimenting with the Unreal

Engine. you'll find that even simple functionality, such as weapon firing and behavior, needs to

be added to the system's code for use in your project. Your programmer needs to establish this

functionality even hefore asset~ are put into place in the project.

For example. when playing a first-person shooter game, one of the simplest functions is firing a

weapon, When playing, you press a button, your Shock Ritle fires an energy beam, and the beam
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strikes something and causes damage. This sequence sounds simple from a player's perspective.

but internally. a lot of things are going on. First. an UnrealScript weapon script is making a caJl

to J weapon-firing script, which then initiates a projectile script. As the projectlJe script runs, it

keeps track of whether the fired projectile strikes something. If it docs, it implements the damage

function of the object being hit. which responds by taking note of what type of projectile just hit

it and how much damage the object suffered as a result.

Sound complex? That's just a small taste of the kind of functionality needed to make a game

behave properly. On top of thaI, there's the behavior of bots and vehicles and how physks work

in your level-the list goes on and on. Don't be surprised if integration takes a while or if certain

aspects need to be reworked into the project during the development process.

Testing and Acquiring Feedback
After you have integrated enough of the game that it's playable, it's a good time to begin testing.

In nearly all professional projects, testing begins long before the project is completed. The process

is fairly simple: Hiive someone play the game, knowing which parts have been completed and

which haven't, and make sure those completed elements are working correctly. You can get the

whole team involved in this process, or if they are too busy, call in some extra help. Usually, little

effort is needed to convince a fellow gamer to play-test a new game. Testing typically comes in two

phases: alpha testing and beta testing. The following sections describe each phase and explain

how this testing (an be used to help finish your project and maintain its quality.

Internal Testing: Alpha

Alpha testing is usually done in house, among the team members. Depending on the size of your

staff, however. you might need to recruit outside testers. Your testers should be aware of how the

project development process is progressing and precisely which elements have and have not been

fully implemented. Tn most cases, you don't want to release an alpha edition of your software to

the public because you're sure to get plagued with a barrage of emails from people who have no

idea how your game is being created. Make sure security is tight for your <jlpha testing phase, and

ensure that your team members aren't revealing it to the web community.

Say, for example, that someone leaked your game's alpha version onto the Internet. At this point

in your production. you have integrated player mobility and weapon functionality for only 2 of

your 26 weapons. In addition, none of your vehicles have been programmed completely, so try

ing to enter one of them causes the game to crash because of the incomplete code. When alpha

testers play the game, they know ahead of time exactly whdt they can and cannot do, so a game

crash isn't a problem for them. The general public, on the other hand, won't be able to under~

stand your project's current limitations. If they see your incomplete game, they could start gen

erating bad publicity (or YOllr project based on their judgment of an incomplete game.
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Alpha testing is a good way to coUect data, make changes to your project, tweal< functionality, and

streamline the various aspects of your game. Eventually, you have each element of your project fully
integrated and working correctly. Then you're ready to move on to the next level, beta testing.

External Testing: Beta

Beta testing essentially works the same as alpha testing, but it's performed on an almost complete

project. In most cases, you won't want to release your beta version to the public either. Your beta

version will eventually become the finalized game or project, so you don't want it to be freely

downloaded before the official release.

Be careful who you choose as a beta tester. Security is always a concern. Also, it's not enough for

beta testers to just be garners. They also need to be jnterested in helping you with your project by

looking for problems that garners could find, such as "holes" in the maps, nonfunctioning ele

ments, and incompatibility with certain hardware or software. Also, make sure your beta testers,

are prompt with their feedback and aren't just taking advantage of you to play your new game.

In many cases, you should take applications for your beta testers. An application doesn't need to

be formal, but it should ask potential lesters what kind of experience they've had with beta test

ing, what kind of games they like to play, and what kind of computer they have. This last ques

tion can be important because you want to mak(; sure your game or project is tf'sted across a wide

variely of platforms and video cards.

Remodeling and Closing: Ending Production
You've built your game and are in the middle of the final tests, gelting ready to release your pro

ject. At this phase, you should be wrapping up your beta testing, getting your web designer to start

promoting the launch date, and finalizing all parts of the project. BlI t what do you do with all this

beta test data and, more important, when do you quit beta testing?

What to Do with Beta Test Info

The purpose of beta testing is to get feedback from a larger base of users to find and fix any non

functional aspects of your game or project. Collect as much data as you can from your testers and

cross-reference it wilh other testers to see what Ihe biggest problems are. Use this data 10 fix your

game's most important problems. Processing all this data is a major task, and you will likely want

to get your entire learn involved. In the end, much of the repair work will probably fall on the

level designer and the programmer, so try to keep them from getting tied up with other tasks.

Feedback from your beta testers is vital to finishing your project. You need to know what kind of

video cards your game supports, what kind of drivers are needed) and so on. This feedback can

also help you discover and repair the small (but still important) problems that arise in most game

development. Beta testers can often tell you where loopholes are in your project.
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For instance, SitY your map has a section guarded by fWO massive creatures, and it's supposed to

bt' difficult for players to pass. As it turns out, in a previous part of the map, players can drive a

tank ancl, with just the right driving skills, drive it all the way to where the two monsters wait.

Players can then use the tank's cannon and eradicate the monsters with practically no effort,

thereby avoiding a challenge that's been carefulJy crafted for them. Avoiding obstacles in this
manner isn't cheating, really. It's just a section of your map that needs to be tweaked. With your

testers' feedback, you need to edit the map so that perhaps a large obstacle prevents the tank from

being used on the monsters. You need to remedy as many of these problems as possible.

Keep in mind that your project willlikeiy go through several beta versions. After you finish repair

ing many of the problems that come up, make a new version available to your testers to help

narrow down the number of problems even more before the project is released.

When to Stop Beta Testing

Remember that a game ca n be like a work of arl. Often, it's difficult to tell exactly when it's fin

ished. When deciding whether your project is finished, you need to lake a few factors into
ac(ounl. First, take a look at the kind of fet>dback coming in from your beta testers_ The number

of severe issues should be winding down. More important, remember your schedule! Don't go

too far off schedule during the tweaking process.

Keep in mind, too, that most games (excl uding console-based games fo r systems such as the Xbox
or PlayStation) aren't released in what most garners might consider to be a fully completed state.

Despite developers' valiant efforts, bugs or glitches can often slip by the testing process and wind

up in the final game. This is the reason that many games offer patches and post-release fixes for
problems. You want to make sure your game is as c1c3I1 as you can make it and that no errors exist

that could hinder or cripple gameplay. Realistically, however, it's likely that you won't be able to

think of everything before the project is released.

Finalizing and Releasing

Congratulations! You've made it through the course of production, and now it's time to make

your project available to customers. This time could prove tu be busy, depending on the size of

your project. At this point, your game could "go gold," which means it's being manufactured on

CD, or your mod or project could be made available for download to the online community. Your

project is officially finished, but the work isn't over for the entire crew. You still need to support

your game by creating and releasing game patches for any technical problems that come up. Plus,

you want to continue promoting your game to the community!
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Summary
This chapter has covered many different topics to consider before launching into a major gaming

project. AJthough it's a given that some of your projects might be so small that you don't need to

use all the techniques and ideas presented here, eventllallyyou might want to try your hand at a pro

ject with a larger scale. AJso, this chapter has been designed to give you a better idea of some of the

work that goes into even the simplest games. At this point, you should have a better understanding

of the hurdles that await those who want to take on a serious game development project.





Chapter

Creating Your First
Level with UnrealEd

This chapter ll1lrodllCi!& you to Unre<llhi, the de~·dopment ~pplica·

tion includ~d with UI"\I(;dl Tournament 2004 WT2004). You begin

with an explal"l3rion of whal Un re-aLEd is and an overllic\v of the
fundamental C()octpL~ that di ffeccnti~le Unre;llUl (,om other level
design pacbg<:<s. By the end or the chapter, you ~hocld have a solid
uI,derstanding of the UnYealEd usrr interface. rhe anatomy of all
UMcal level, and the skills required 10 construct simple custom
levels_ fiGURE 3 ..1 sho\\ls a complc{("d Unreal level.
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FIGURE 3.1 An Unreal level.

What Is UnrealEd?
UnrealEd is the primary application level designers use to create Unreal levels. Originally intro

duced in 1998, UnrealEd was the first game editor to give users real-time feedback. Its most dis

tinguishing {actor was that the Unreal Engine was directly integrated into Unreal Ed, so level

designers could instantly see exactly what their levels would look like during gameplay without

needing to actually start the game. Before this innovation, level designers were forced to construct

their levels primarily with two-dimensional views. The only three-dimensional view offered in

level editors was merely an interpretation of what Ihe level would probably look like in the game.

Then the level editor converted this interpretation jnto a playable level, a process typically known

as "compiling," just so thai level designers could lest it Ollt. Compiling made level creation tedious

because the process could easiJy take minutes, hours, or even days, in extreme cases.

The Subtractive Method of Level Creation

Another aspect of Unreal£d that separated it from the crowd was the manner in which its levels

were developed. Before the introduction of UnreaJ£d, game levels were created in much the same

way that architectural structures are constructed in the real world: creating a floor first, then

adding walls, and finally installing a ceiling. Even a simple cube-shaped room required creating
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and placing no less than six polygonal objects. You could think of this method as an additIve way

of creating enclosed areas, much like building a box from sheets of plywood. This means that

objects were added into the empty void of the game's world to create a level. During this process,

level designers had to be extremely careful to make sure each piece was aligned correctly to

remove any gaps between the wall and the floor, at a corner where two wall sections met, and so

OIL If these gaps remained, players could see "outside" the level, resulting in a graphics error

known as the Hall of Mirrors (HOM) effect.

Levels used to be constructed this way because older games were composed of levels that existed

within a void of empty space. In essence, levels floated in an infinitely open volume, like a vaClllUTI.

This is why, in some older games, it's sometimes possible to "fall off the level" and watch yOUI char

acter seem to fall forever as the game level recedes into the distance above your character.

The advent of Unreal changed all this by reversing the empty void situation. Instead of a game

world that was an infinite vacuum, Unreal levels were created within a world of infinite solid

mass. The creation method was turned into a subtractive one ralher than the additive methods

used in the past. Essentially, all Unreal levels begin by subtracting volume from the game world's

solid mass, much like carving a box-shaped room out of the cenler of a mountain. This method

has two distinct advantages over the additive approach. First, the speed of level creation increases

dramatically. For instance, creating a simple cube-shaped room with the additive approach means

the level designer would need to create six separate objects to serve as the floor, walls, and ceiling

and make sure that all objects were perfectly aligned with each other. With Unreal's new subtrac

tive approach, you could create the same cube-shaped room in a single step by subtracting a sin

gle cube from the game world, without worrying about how the sides are aligned.

The second advantage is the reduced risk of the HOM effect because walls require no alignment

to work as a level. From the player's perspective, the difference between the two methods is zero.

Think about it: The inside of a box looks exactly the same, whether it's in deep space or 20 miles

underground.

The subtractive method for level creation does not, however, mean you can't add more details

to your leveL In Unreal Ed, you can subtract matter and add it back in. Essentially, you always

begin level creation in Unreal by subtracting

the basic shapes and areas of your level from

the world's infinite mass, and then adding

various types of detail. For more "open

range" levels, such as outdoor environ

ments. yOll can begin level creation by sub

tracting an enormous box or cylinder, and

then adding the rest of your detail, such as

terrain, back in.

f
"- ------,
NOTE .
Producing HOM effects is still possible in Unreal. I
Typically, this HOM effect happens if you create a sim· !
pie box-shaped room in UnrealEd, and then add a
texture containing an alpha channel (in other words, a
texture with some transparency) to' one wall, such as
a grate-like texture. When you look at that wall during
gameplay, voila! You get a stomach-churning version
of the HOM effect. Techniques for texture application
are COl/ered in "Adding Textures;' later in this chapter.
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Rebuilding

During level creation in UnrealEd, often you need to update the changes you make to the level's

base geometry. This process is known as rebuilding. Essentially, rebuilding compiles all the shapes

you have added and subtracted to form a playable level. At the same time, it generates the neces

sary light maps for your level, which creates areas of light and shadow within your level based on

the location of your light Actors. Fortunately, this process is many times faster than the old-fash

ioned method of compiling.

So technically, what is UnrealEd doing when it rebuilds your levels? First, it checks the location of

all Binary Space Partitioning (BSP; discussed in depth in Chapler 4, "Advanced Brush

Techniques") brushes in the level. After calculating the position of all brushes, UnrealEd uses

those brushes to construct the level's geometry. From there, it calculates the properties of lights
in your level, such as location, intensity, and color, and uses them to generate light maps for the

surfaces of the level's geometry. Finally, it recalculates any navigation paths that have been built

for bots in your leveL Light maps and lighting techniques are discussed in Chapter 7, "Lighting in

Unreal." Bot paths and AI navigation 3re discussed in Chapter 12, "Advanced Bot/AI Navigation."

Although these tasks sound high in calculation difficulty, UnrealEd is capable of performing them
quickly. even in larger levels. You can also speed up the process even morc by rebuilding only the

necessary aspects of your leveL For example. say you've adjusted some lights in your level and

need only your light maps recalculated. You can select the Rebuild Lights or even Rebuild

Changed Lights option.

The Anatomy of an Unreal Level
At this point, you're probably eager to jump in and create your first level. Before you dive in, how

ever, you need d basic understanding of the types of objects you generally find in a level. Many
different objects can exist in <I level, but they can be classified into one of two categories: world

geometry or Actors.

World Geometry

You can think of world geometry as the shell of your leveL World geometry is what creates the sub

tracted spaces inside the solid mass of the Unreal world. Without this geometry in place, only the

solid mass would remain; your level would be more like a cavern that has yet to be dug out than

an actual level. The subtracted space that forms your level is known as world geometry, or con

structive solid geometry (eSC). The only steps needed to complete a functional level are subtract

ing space, adding a Player Start, and placing a light (provided you'd like to see the level, of course).

Naturally, [or most of your levels, you then add some mass back into the subtracted areas.

So how is world geometry actually created? Everything in a level can be classified as world geom

etry or an Actor. World geometry is created through a series of CSG operations using special
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Actors known as SSP brushes. These brushes are used to define a specific volume lhat needs to

be a•. dcct or SlIbtracred from the level. Although BSP brushes are technically classified as Actors.

their cJose relationship to world geometry makes disCLlssing them in this section more logical.

Several types of BSP brushes are available in UnrealEd, The two most commonly used are the

additive' (Ifld subtractive brushes. As Iheir name implies. level desigllers use these brushrs to

cefine WhL'fL' mass is (0 be added 10 or subtracted from the Unreal world. For example. when

you create a subaactivc BSP brush, the area of that brush is removed from Unreal's solid mass.

UnrealE<! then processes these added and subtr<1cted areas during rebuilding to produce world

geometry. FIGURE 3.2 show~ d level with only the world geometry visible. Latl'f in this

chapter, you see how to crear~ and me these brushes, but fint, you neE'd to learn about otht"f

Actors.

FIGURE 3.2 A level showing only the world geometry.

Actors

After your \~orld geometry is estabiished, every other object placed in your level (or already there

by default) is an Actor. Actors can be brushes, triggers. pl~yers,lights, and anything else in your

level thilt's not wodd geometry. As you've learned, world geometry forms the: basic she!! 01 r'our

leve!' ObvioLJsly. a propn level wnsiSIS of more th~Hl ,lust ~ series of \vaLk This leaves you with a
long list of objecrs [hat faU into the category of Actors, Actors lhemselves, however, can be c1assi

tied into rwo subcategories: placeable and non-placeable.



Placeable Actors Versus Non-placeable Actors

M:my types o( Actors are classified as piaullble, mch as Player Stan positions, teleporurs, lights,
jump pads, and movers. With placeable Actors, a level designer must manually add them into a
leve! and then set properTies to conHol their behavior and make them perform as desired. For
example, a level designer wOLlld add a teleponer to a level at the precise position where he needs
it to appeu and then set parameters to control the teleponer's destination (where it sends play
ers who enler it). Similarly, level designers must place a Player SIan in a spl"Clfic location to con
lrol ex..acL1)' where a player spawns inco the level.

3 Pl2ceablc Actors are always visible in UnrcalEd. Each type o( Actor has a differenl viSLlal repre

sen La, ion, 0 r icon, drawn in the viewporls. For instance, lights in Unreal Ed are represented as
Iigh I bllib icons :lnd player starls are displaye.d as joystick icons; static meshes. on the other hand,
3re dispLayed by using the mesh's acrual geometry. FIGURE 3.3 shows examples of icons and a

Sialic mesh.

•Path Node

)C(Jt\1

J.
Pllye r SIlrt

Non-pwceable Actors. conver£ely,
aren't intended to be placed inlo

.) level manually du ring its cre
ation. EX31T1pb include weapon
projectiles; the ga me's heads-up
displ.ay (KUD); game types,
which control lhe rules of the
game; and MUIators, which
change various aspecls o( game-
play. Think about it: Projectiles. FIGURE 3.3 Examples of icons and a slB!tc mesh In
such as rockets or laser&, are Unreal Ed .

objec15 crealed while the game is taking place. M such, they spawn [mo a level only when a player
Ii res a weapon. As sooo as a projectile strikes its target, that projectile's purpose has bfen served, and
II U5uaUy ceases to exist. Because there's no reason f()rlevel desig.ne~ 10 place these objects inlo thei r
leve Is duri.ng rons! ruction, Unrea1Ed doesn't flag weapon projectiles as plauab1e.

All Actors used by the Unreal Engine are derived from Unrea ISc.r ipl, so yo u can eX2m ine and ill'er
any Actor's functionality in the Unrl"aJ Engine. This capability is evidence of the Unreal
Technology's fleribility. In many cradic iona.l games, mosc non-placeable Aclor types are hard
coded into the game, \"hich means mod makers are se~erely limited In ,heir :IbiJily 10 modify or
customize that aspect of the game.

Some Assembly Required

As. mentioned in Chapler I, "UnreaJ Technology: The Big PiClufe," a successful level has many

aspects. Crealing world geometry is jusl the first step. From there, you need to populate your levels
I.'.;!h stalic meshes and apply textures to the sllrfaa: of your world geometry. You might also wanl

to add anima led elements, scripts. sound, and music.
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A Quick Tour Around the User Interface
In this section, you take a brief look at the UnrealEd user interface (UI). This overview is general,

not a button-by-bu tton exploration of the program. For more in-depth details on each part of

UnrealEd, see Appendix A, "The UnrealEd Manua!."

The Main Menu Bar

UnrealEd's main menu bar, located at the top of the application window, provides nearly all the

functionality available in other parts of the UI in a typical drop-down format. This functionality

ranges from standard-issue commands, such as opening, saving, and importing files. to adjusting

the program's viewports, controlling the rebuilding process, and more.

The Toolbar

The toolbar, located directly beneath the main menu bar, includes a series of icons for many of the

common tasks you need to perform during level design. These tasks include opening and saving files,

opening browsers, rebuilding certain aspects of your level, and running Unreal to play-test your level.

The Toolbox

The toolbox, a vertical tool bar on the left side of the UnrealEd window, gives you access to a wide

variety of functions used frequently during level creation. These functions include adjusting the

camera's mode, editing BSP brushes, adding or subtracting mass, adding special Actors, and

much more. The toolbox is divided into six collapsible sections to optimize space, so only the

tools you need at the moment are visible.

The Viewports

The viewports are IU<ely the most crucial aspect of UnrealEd, as they give you a "window" into the

level you're building. Viewports come in two distinct flavors: perspective and orthographic.

Perspective viewports provide a three-dimensional senSe of depth, and orthographic viewports

are two-dimensional, like a set of blueprints, YOll can toggle a variety of modes, such as

Wireframe, Textures Only, and Dynamic Lighting, for the perspective viewport, based on which

part of the level you're focusing on at the moment.

The Console Bar'

The console bar at the bottom of the Unreal Ed window offers such features as access to a com

mand line, which can be used to enter commands to the Unreal Engine. You can also use the con

sole bar to adjust the snapping and grid size of your viewports and to scale Actors within the level.

The Browsers

Several different browsers are available in UnrealEd to give you many of the game assets needed

for a game level (see FIGURE 3.4). Each asset type has a separate browser: Texture, Actor Classes,
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Mesh, Animation, Static Mesh,

Prefab, Group, Sound, and

Music. You can find more

ioformation on these browsers

in Appendix A.

Property Windows

Several types of property win

dows are available in UnrealEd.

They are used to control vari

ous parameters (or objects.

They are used to control vari

ous parameters for objects. The

following sections give you an

overview o( some of the most
important property windows.

fiGURE 3.4 Along the top of the Texture browser are tabs for
access to oth'er available browsers in UnrealEd.
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Actor Properties

The Ador Propertie~ window in UnrealEd is available

through a variety of means. including using the main
menu or merely double-clicking the object. This win

dow is fundamentally the same for each Actor, but dis
plays a different set of properties corresponding to the

type of Actor that's selected. For example, the Camera

Properties window &bows a different list of properties

than the ones that would be listed for a static mesh (see
FIGURE 3.5). Each properly window is arranged in

collapsible sections so that you don't have to scroll

throllgh pages of properties.

Surface Properties

Thc Surface Properties window enables you to change
severa] aspects that affect what the surfaces of your lev

els look like in the game (see FIGURE 3.6). For exam

ple, you can select a wall in your \rve) and adjust how

textures are placed on it. These adjustments might

include the texturc's rotation, scale, and tiling. You can
also change a surface's flags, which handle any special

properties the surface might have. and control the res

olution of light maps on the surface.

FIGURE 3.5
window.

The Camera Properties
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LubeOu~der - -

Build Options

You use the Build Options dialog box to change
options for the rebuilding process (see FIGURE 3.6).

(n this dialog box. you have a high degree of control

over how to generate the BSP of your level. how to cre

ate light maps, which Actors should be considered in
the rebuilding process, and more.

Properties for Primitives

You use the Properties window for primitives
to change the dimensional properties of a BSP
brush before its shape is added to or sub·
tracted from your level (see FIGURE 3.7).

You can access this window b~' right-clicking
any primitive object icon in the toolbox. The
windows name and the avallclble properties

vary depending on which primitive object you

selet"ted. For example, for a cube. the window FIGURE 3.8 The Surface Properties window.
is called CubeBuilder, and its properties would
include width, height, and breadth.

Working in 3D Space
FIGURE 3.7
cube.

Primitive options for a

The Unreal Engine is designed to power today's
hottest 3D games. so creating levels with this engine
requires working in three-dimensional space 10 con
struct a 3D world.

2D Versus 3D

You can think of a two-dimensional system as a sim·
pie grid. A 20 grid. such as latitude alld longitude,
funs in two separate directions, meaning that these

grids have two axes (pronounced ax-eez). One axis
runs horizontally, or from side to side. The second axis
runs vertically, or up and down. On sl2--ndard grids.
the horizontal axis is known as the X-axis, and the ver·

tical a:xis is known as the Y-axis. Therefore, you could
pinpoint the pusition of any part of the grid by using
two numbers: a value for X and a value for Y.

o¢on ISt~t I

~ID"''''' ~~~
flf;lli~

Lr Jlntlfl<ilUdVi

, .
::::oJ r DiiIcI7

[ S..~ ... 8Mpr

FIGURE 3.8 The Build Options dialog
box.
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A three-dimensional grid, on the other hand) adds a new

value to YOllr coordinates. To picture a 3D grid. imagine

placing a 2D grid on the ground and standing on it. The

Y-axis would run forward and backward. the X-axis

would run left and right. aad a new axis, the Z-axis, would

fun lip and down, Locating a single position in 3D space

requires three values: X. Y, and Z. If a 20 grid looks like a

plane, such as a piece of paper, a 3D grid looks like a cube.

FIGURE 3.9 is a representation of a 3D grid.

When working in UnrealEd, you can imagine that you're

within a massive 3D grid, As you position objects in the

world, you give them coordinates based on this 3D world,
meaning they have position values for X, Y, and Z. FIGURE 3.9 A 3D grid,

Positive and Negative Directions

Now that you're familiar with the three axes of 2. 3D world, you need to Jearn about positive and

negative directions. \Nhen working in 3D space. technically there's no up. down, left, right, for·

ward, and backward. The center of a 3D grid. including in UnrealEd, is called the origin, and its

coordinates in 3D space are uro for X, Y, and Z (often written as 0)0)0). When you move away

from the origin, you can go left, right. forward. backward, up. or down. This means every axis has

(wo directions, which Jre considered to be positive and negative.

IJll<JgiJlt: Lhal yuu'le ~laJl(hJlg at the urigin uf Ul\realE<.J':, .~D grid and looking t10W/l the Y-axh. The

foUowing liST designates rhe positive and negative directions ior each axis (see FIGURE 3.10):

~ Along the X-axis

Positive =0 left

Negative = right

~ Along the Y-axis

Positive = forward

Negative == backward

~ Along the Z-axis

Positive = up

Negative = down

FIGURE 3.10 A 3D grid with positive and negative directions.



NOTE
When working in Unreal Tournament 2004, your level
size is limited to 524,288 Unreal units in X. '{J and Z,
That averages out to about six miles in eJl:h direc·
tion, or 216 cubic miles.

Working In 3D Space 57

10 the lower-left corner of the 3D viewport in lJnrealEd, yo\.! can see an icon. that shows the

th ree axial directions, This icon displays three lines, one for each axis, with <l letter at the end of

each line signifying which axis it represents. The lines point in the positiv.:: direction of each axis.

With these conceprs in mind, yOll shollid have a betler understanding of precisely where each of

your Actors exists in the Unreal world.

Creating Your First Room
Now that you have taken a quick look at

UnreaJEd and the anatomy of? level, it's time

to get busy! In this section, you use UnrealEd

to con,truct a simple level that you can load

and explore. Tim simpie level gives you some

hanos-on experience at creating leveb with LJnreal£d and a base of knowledge to e.'lpand on in

future tutorial::;. As you go 1!:"lfOLIgh this chapter, the Ievc-l gradual.1)· bc;;omcs more complex, lIntil

you finally wind up with a space fighter hangar for 2 ;;ci-fi level (see FIGURE 3.11). When you're

finished, you can load the level into the UE2 Runtime Engine included with this book or into

Unreal Tournament 2004, depending on which editor you use to construct the level. Please nOle
that leve s created with the Unreal Runtime Engine aren't compatible with Unreal Tournament

2004, and vice versa.

FIGURE 3.11 The completed hangar.
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Subtracting Out Space: How Tall?

Before you begin creating the mass of your Unreal level by subtracting and adding shapes, you

need to establish a size perspective. Al first, you might ask "How large should my rooms be?" or

"How big is my player?" Few Ihings are as frustrating as spending hours designing the perfect

level, only 10 discover that your character is ant-sized ur so monstrous that it can't pass through

allY doors,

The Technicalities of Scale

If you want to get technical about where a

player can and cannot go by default, you

must consider two vital properties:

Coll is ionHeight and Co llis ionRad lUS,

Essentially, these properties define a cylin

dricaJly shaped volume around your

player (see FIGURE 3.12), This volume

is used to calculate any collisions your

player might have with its surrounding

environment. These are the default set

tings for these properties:

CollisionAadius: 25

CollisionHe ight: 44

~L

The!>e settings don't mean, however, that

a player could pass through a doorway FIGURE 3.12 A collision cylinder surrounding a
that was 25 units wide and 44 units tall. character.

Remember that the CollisionRadius

property defines the radius for a cylinder, meaning that it must be doubled to achieve that cylinder's

width, or diameter. On top of that, you need to add at least 2 units to the cylinder's diameter to cre

ate an opening wide enough for a character to pass through. Using this method, a character could

pass through a door or corridor, provided it was at least 52 units wide (25 x 2 + 2). Keep in mind,

however, that a width of 52 units is just enough (or one character, and even that amollot is tight.

The CollisionHeight property works in a similar manner. At a glance, you might think that if
your CollisionHeight is 44 units, and your ceiling is 46 units tall, your character could easily

pass through the room. Unfortunately, this is not so. The height of your room must be twice the

CollisionHeight, plus at least 2 units. This means thai at a GollisionHeight of 44 units, your

ceiling would need to be al least 90 units tall for a character 10 pass Ihrough the room, Like

GollisionRadius, even this amount would mean that space is tight. When using

CollisionHeight or CollisionRadius, a good rule of rhumb is to double Ihe property's value,

and add al leas! 5 units,
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The Aesthetics of Scale

YOll need to wnsider another factor when determining the sizto of your levels: how big it should

look. Obviously, a large room looks more ominous than a small one, but what do you Ileed to

know to make objects seem to be the proper size? There's a formula you can use (or Unreal Engine
models that you can even translate to your own games or projects.

First, cote tbat most characters in U1'2004 are modeled to the following parameters

(see FIGURE 3.13):

Height when standing: 96 Units

Height when crouching: 64 units

C(ooch~ng

96 unU8

64 vnU!li

FIGU HE 3.13 A character in the crouching and standing positions.

Given, these parameters have a small range of Oexibility, but in genera! you can assume these
heights are standard. Incid~ntally, this means you can use these parameters when judging the

height of your ceilings, and you'll never have a probkm with lJT2004 characters.

So if you assume (hat a chara<..tcr is 96 units taU in Unreal, and that it would be 6 feet tall in the
real world, use the following formula;

96.;. 6:= 16

This formula shows you that 16 Unreal units are equal to one fOol in the real world. All you have
done is divide the number of Unreal units by the character's assumed height in the rcal world.
Now you have a mean, of converting real-world measurements to Unreal units. So if you had (0



create a computer desk for an Unreal level, and you knew it was 3.5 feet tall, you could use the

following equation to convert it to Unreal units:

3.5 >< 16 '" 56 units

There's a catch, however. You must keep one exception in mind, especially when building levels
for Unreal Tournament 2004. Objects in UT2004 are bulky. Take the Unreal character Gorge, for
example. If you saw Gorge in the real world, and he was about 6 feet tall, he would also be about
4 feet wide! Remember this factor when trying to judge the size of your levels and meshes, and

3 make them a bit oversized. A general rule of thumb is to take the size of the object in feet, multi
ply it by 16, and then add 10%.

When playing Unreal Tournament 2004, you might want to consider some other scales. As you
play the game, you often find yOUIseif jumping and dodging quite a lot. For your convenience,

you can refer to the foUowing list of some jump and dodge distances to help you out. Note that
these distances are aU under standard gravity conditions and are approximate values:

Jump heIght: 64 units

Double-jump height: 132 units

DOdge distance: 320 units

Dodge·jump distance: 720 units

Using the GrId to Manage Scale

The drag grid in UnrealEd is one of the most important factors when creating a level. All your
Actors, especially ESP brushes, should always be placed exactly on the grid lines, In fact, this rule

is so important that UnrealEd automatically snaps Actors to the drag grid by default. The term
snap or snapping simply means the program allows you to place an object into the level only if its
location is bJseo precisely on the grid. As you begin building levels in UnrealEd, you'lJ see how
snapping works as you begin to move objects around the viewporls, Instead of being able to drag
an object smoothly from one side of the scene to another, your object seems to jump from one

grid intersection to another. This is the result of snapping and is an essential part of keeping your
levels precise in measurement and free from SSP errors, such as the HOM effect.

However, you do have control over how and whether snapping occurs. At the bottom of the
UnrealEd window, in the console bar, is the Drag Grid Size combo box where you can adjust

the grid's resolution to control the number of possible points that can be snapped to on the

grid, thereby controlling the snap's precision (see FIGURE 3.14). For example, at a Drag Grid
Size of 16, you can move an object only in increments of 16 units. At a Drag Grid Size of 64,

the object snaps in increments of 64. You can set this resolution as high as 4096 units and as
low as 1 unit.



FIGURE 3.14 Drag grid.

You can deactivate snapping if you like, but this isn't recommended. Snapping is important

because of the high possibility of errors when positioning objects by hand. Creating your level's

world geometry is a precision process. UnrealEd calculates which areas of your level have open

subtracted space or solid space, based on the location of a series of BSP brushes. If these brushes

aren't aligned properly, a few serious errors can result For example, say you have created two sub

tractive brushes, and you need them to be aligned together, or touching, so that they resutt in a

single open space. If they aren't snapped together precisely, you wiU have problems. If they 3re

overlapping, you could end up with BSP errors, such as the HOM effect, at the seam where they

overlap. If there's any space between them, no maller how small, you'U have a very thin waU

between the cwo rooms. Aligning these objects by hand is difficult and pointlessly tedious; for this

reason, you should never switch off the drag grid,

The drag grid is also important when placing static meshes in your level. Many static meshes are

desig.'1ed to act as walkways or sectional level components that are placed end to end so that they

appear to be a single unit. For example, you might have a 32-unit static mesh pipe section that

you cowd place on your level's wall. If you positioned several instances, or copies, of this static

mesh, one directly afrer the other, one long pipe would seem to run along the wall, as long as you

positioned each section accurately. You could try to position these sections yourself, making sure

each one was moved only 32 units, not 32.01, lor instance, If you're looking (or fast results, this

61
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CreatIng Your First Room

get rid of it completely, but yOLl can set it to a cube with dimensions 0(, say, 0.1 for width, height,

and breadth to make it almost disappear.

63

Subtractive Brushes

Subtractive brushes ,)Te covered hefore additive brushes because

dley are almosl alwJys lhe first kind of brush yotl Cfe(ltc in your

levels. As mentioned, these brushes carve out an area from the

solid mass of the L:nreal world, givmg your plJyer a space to

move around (see fiGURE 3.16). To creatc a subtractive

brush, fint sclect a primitive shape for the Builder brush, and

tben click the Subtract button in the toolbox. The result is a new

brush with the samr shilpe 2.$ t!l(" Bui!dt'r hrush. but it's dis

played ill a yellow wircframe instead of red. You can also see that

the shape the Builder brush ddined has now been turned into a

"room" in the UnrealEd Perspective viewport. Furthermore, the
sides (If this new subtracted shape have il telClure applied to each

side, which is th~ default !c::xture or the most recently selected

texture from the Texture browser.

FIGURE 3.16
room.

A subtracted

Additive Brushes

vVnen you need some mass added back inlO your levels. fl'ach

for additive brushes. To create an add itive brush, first seleLl a

primitive shape and size for the Builder brush, and then click

the Add button in the toolbox. The addirive brush, which is

the same size and shape as the Builder brush, is displaye-d in

the viewport with a blue wireframe. You use additive brushes

often when cre2ting willb, stairs, and raised area.'> in floors.

FIGURE 3.17 shows il cube added to il subr racted room.

Working with Brushes

FIGURE 3.17 A subtracted
room with a cube added In the
middle.

vVhen working with RS? brushc::s III UnrealEd, you ,~hould

always keep some worktlow guiddinc$ in mind. First is the loca
lion o( each brush's pivot. The pivot can best be described as a

brush"" center of movement (sc<': FIGURE 3.1.8). When you're snapping to the grid, this pIvot

determines the point at which the brush sn::.ps. The pivot is also used as a point of rotation. for

example, say yOLi have a cllbe-shaped brush with its pivot precisely- at the center oCtile cube, T(

you rotate the brush, yOll ,"'ould see the cube appeal to spin In place. However, you can relocate

the cuoc's pivot, even place it Otltside the brush. If you rot~ted the cube again with its pivot moved

far to lhe left, the cube would seem to move in a circle because its pivot is the point of rOlation.
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Brush order is anot her important (actor
in level constfllctiOl) Say you've con

structed a level of a multistory building.

You beg'llll by subtracting a massive cube

to represent the area outside your buud-

" Pivol.'lng, and then created the building from a ::..J
senes of additive brushes within this sub-

tracted area. After you're done, you realize

that a cylinder, rather than a cuoe, would
have been a more appropriate shape for FIGURE 3.18 The effect Df changing the pivot's

location.your first subtraction. Your firsl impulse is

to delete Ihe existing cube and create a Iarge cylindrical subtractive brush that completely sur

rounds your buil ding. The problem is Ihat alier you rebuild and play- Lest the leveL you find the

entire building gone. This happens because Ihe brushes are created in the wrong order. ThinK

about il: [( the last operalion you perform is a massive subtraclion, then all the additive brushes

within Ihat subtraction would be removed. However, you can change the order in which each

brush is calculated. If you tell UnrealEd to calculate the enormous cylindrical subtraction first, Ihe

buiJd ing would slill exist in the game bec3use Unreal wo Llld subtracl the large cylindrical area

before it calculaled the pans of the building, not vice versa. To change a brush's order. righi-dick

the brush, and choose Order from the conlext menu. You Ihen see commands [or calculaling a

brush first or last or (or swapping its brush order with another selected brush.

Navigation in UnrulEd

V\i'hen UnrealEd first starts, Camera Movement mode (the default mooe) is enabled in the toolbox..

Although moving the. Glmera in other modes is possible, this mode enables rou to move Actors

rather than rotate or sc.a1e them. You will probably use this mode for most of your work in UnreaJEd.

The Camera Movement mode icon toggles the 'viewport so that you c.an move only the camera.

Vielvport navigation in UnreaJEd is fairly straightforward. bLlt might lake some getting used to if
you come from oth er 3D appl ica lions. Also, the nav iga ti on co ntIO Is work diffe renII} -de pend ing

on whether you're in a perspective or orthographic view. lf you're completely new to Unreal.&!.

you would do well 10 practice with them until their use becomes second nalure.

Perspective vie'.';-port controls:

~ Holding down the left. mouse button (LMB) whlle moving the mouse forward and back

moves the camera (orward and back. Moving 10 the left and right whlle holding down the

LMB tums the camera left and right. The effect is similar '0 driving the camera around

like a car.

). Holding down the right mouse button (RMB) while mO'vi.ng the. mouse enables you to

rotate the camera, much like the way yOll turn your head. Left and right movements
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rotate the camera in those directions, and mOViJlg the mouse forward and back rotates

the camera up and down, respectively.

~ Holding down the LMB and RMB simultaneously facilitates camera panning. As you

move the mouse left and right, the camera seems to slide or strafe in those directions.

,v(oving the mouse forward and back pans the camera up and down.

orlhog ra ph ic viewport co ntrol~:

~ Holding down the LMB or RMB causes the camera to pan around the scene. This metbod

moves the cameril along the same plane as the viewport.

.. Holding down the LMB and RMB together enables you to zoom In to and out of a viewport.

Moving Actors

Jn thi~ section, you're going to examine how you can move Actors arollnd your kvels in UnrealEd.
For example, you'll move the Builder brush arO\lnd in lhe level so that you can see how to move

and rotate Actors.

In TUTORIAL 3.:1, you see how to move and rotate the Builder brush. Keep in mind that these

techniques can be lIsed to manipulate any placeable Actor:

TUTORIAL 3. : Positioning Brushes and Actors in 2D and 3D

L In the toolbox, click the Cube Icon. Select the BUilder brush in the Top view
(see FIGURE 3.19).

FIGURE 3.19 CUbe-shaped Builder brush.
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2. Holding down the etrl key. drag the Builder brush with the LMB. Notice that the Builder

brush moves with you. snapping to the increments of the current Drag Grid Size setting.

Also note that If you check the Side View, the brush hasn't moved up or down in the Z-axIs.
You can move objects only in the X- and Y-axes in the Top view.

NOTE
Rotation is influenced by tlie rotation grid, which
enables you to snap to precise angles. This featu re,
which makes rotation easy. is on by default. If you
want to switch it off, liowever, click the Toggle
Rotation Grid icon in the console bar.

3, USing the same technique, move the BUilder brush in the Side view. Again, you're moving

only in the Y- and Z-axes, Similarly, when you're moving the Builder brush in the Front View,
movement is allowed only in X and Z.

4. In the Top view. press etrl and d«~g left

and right while holding down the RMB,
The Builder brush rotates perpendicularly
to the camera (see FIGURE 3.20). The

same holds true for the other two 2D
viewports.

3

FIGURE 3.20 A rotated Builder brush,

5. Now see how movement works in the
3D View. Navigate the view so that you

can see the entire Builder brush, and
then press Ctrl and drag with the LMB.

The brush moves along the X-axis.

NOTE
You cannot rolate Actors in the 30 view unless you
have activated Actor Rotate mode in the toolbox. Also,
all rotations are lost if you build a new primitive brush.
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6. Try dragging while holding down Ctrl and the RMB. and then With Cut and LM8+RM8, The
movement you see can be described as follows:

elfl and LMB: X·axis

elrl and RMB: V-axis

Ctrl and LMB+RMB: Z-a.xis

END TUTORIAL 3.1

Creating Your First Map
Now that you know alllhcse important aspects of level des.ign, ii's time 10 do some real level con
struction. The foUowing tutorials introduce you. to a varlely of funa.ament.aJ concepts and 'asks

that ),ou need to understand before you're ready to compldc yo or own levels. You']I begin ~jmply

by subtracting out a box-shaped room, and then "paint" \t will, teXTUre, add some lights, and ~o

on from there. FIGURE 3.21 shows the completed level yoo wiU end up wiLh after completing

the tutoriaJs in this chapter.

67

FIGURE 3.21 A complated level.
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Subtracting the First Room

TUTORIAL 3.2 show, you what you need to know to create your first open space from Unreal's

world of infinite solid mass:

TUTORIAL 3.2: SUbtracting a Simple Room

FIGURE 3.22 Dimension settings
in the CubeBuilder dialog box.

Height: 384

Width: 636

Breadth: 1024

4. Click the Subtract button in the toolbox. You

have JUSt created the first subtracted space of
your map (see FIGURE 3.23).

1. SW~t UnrealEd, and begin a new scene by choosing File> New from the menu.

2. You need to define the shape and size of your BUilder brush so that you can create a sub
tractive brush of the correct dimensions. Open the CubeBUIlder dialog box by right·clicking

on the Cube primitive Iii1 in the CSG section of the toolbox.

3. In the CubeBuilder dialog box. enter the following

settings (see fiGURE 3.22]. and then click the Build

button. When yOll do. you'll notice that you can see

the Builder brush as a red cube of the dimensions

you selected. You can then close this dialog box.

3

FIGURE 3.23 A subtracted room.

END TUTORIAL 3.2
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Adding Textures

Right now, the textures on your room's surfaces look rather bland because they're covered with
the default texture, If you don't se!c-ct a texture lTom the Texture browser before adding or sub·

tracting mass in your map, Ihe surfilces of the resulting brush are covered with the default tex
nIre. i\ greenish bubbly surface. Selecting a teX1ure from the Texture browser before adding or

subtrawng IS a good Idea_ If you forgel to do this. you can stiU change those textures by using the
Texture browser.

'To open the Texture br0wser, cli<.k

ils icon on the toolbar of the
UnrealEd window. You can use this

browser to view textures included

in texture packages and to hlter the

numher or displayed packages by
~electing spt'cific groups (sec
FIGURE 3.24). You can find OLlt

more about the menus and fea

(ures of the TeXI,me browser in

Appendix A.

TUTORIAL 3.3 demonstrates how

to sel~ct textures for the wall:>.

(loor, and ceding of your room.

Th<> textures you need are slored in FIGURE 3.24 The Texture browser.
a package, so first you need [0 load

that pJ<:k,lge.

TUTORIAL 3.3: Texturing the Room
=------------------------

1. Notice that If yeu click on any surfaces In your room, they turn hlue to lnclicate th8y

are selected. Before you begin texturing. make sure no surfaces are selected (see
FIGURE 3.25). If a surface IS selected, clicl< It again to deselect it.

2. Open the Texture browser using the method deSCribed at the beginning of thiS section.

3. From the browser's menu bar, choose File;;. Open and select the Chapter3_ tex. utx file

(see FIGURE 3.26). ThiS package contains several textures, dIVided into the following

groups: Base, Ceilings, Floors, Wall, and Glass. You can sWltcll between these groups by

using the drop-down list next to lh(' All button Clil:k the All button to see all textures Irl

the packcge. regardless of what group they're In_
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- . - - ----

3

FIGURE 3.25 The room before teJ:turing.

4. Click the list arrow next to

the Add button. select the
Walls group, and cliCk the

Wa IlPane 11 texture. The

selected texture isn't applied
to any surfaces In the level
because no surfaces are

selected.

5. Select the four walls in the

room by Ctrl-clicking each
one In the 3D viewport.

6. Click the wa 11 Pane 11 texture
agClin in the Texture browser.
Notice that the texture is

then applied to all walls (see

fiGURE 3.27).

7. In the 3D viewport, select

the floor surface.

FIGURE 3.26
file loaded.

The Texture browser with the Chapter:). utx

8. In the Texture browser. select the Floors group and click the floor2b texture

(see FIGURE 3.28).



FIGURE 3,27 Walls with the WallPane11 texture applied.

FIGURE 3.28 The floor texture applied.

9. Use the methods In steps 7 and 8 to select the ceiling surlace and apply the Ceiling 1
texture (see FIGURE 3.29),

71
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4. The wall appears to have tiles. but the

alignment is still off because the tiles

at the edges at each surface look cut

off. To fix thiS problem. in the Surface

Properties window, select the Pal'll
RoVScaie lab (see FIGURE 3.31).

5. As you can see, the textures need to

be moved vertically to align correctly

with the floor and ceIling. With all tour
walls stili selected. click the Pan v 64
button four times. You can see the
textures move downward 64 units

each time you cliCk the button. Four
clicks should make everything align

With the top and bonom of the walls.

6. You're almost finIshed, but you can

see that the two short walls need
theIr textures aligned horizontally. Go
ahead and select these two walls
now.

7. Click the Pan U 64 button four times.
The walls should then be aligned cor

rectly (see FlGU RE 3.32).

Creating Your First Map

FIGURE 3.31 Pan/Rot/Scale tab of the Surface
Properties window.

NOTE
You can pan In V In a downward dIrectIon simply by
clicking any of the incremental buttons. Pressing
Shift while clicking pans the texture back up. This is,
of course, in relation to the surface you're facing.

NOTE
If all four walls are stjIJ selected, you can simply Ctrl·
clid< the two longer walts, thereby deselecting them.

73

FIGURE 3.32 Correctly aligned walls.
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8. For the ceiling and floor alignments. the following are (he recommer.ded alignment num

bers. Using the technique demonstrated earlier in thIs tutorial, see if yoo can get every

thing aligned correctly. FIGURE 3.33 shows an example.

Floor

Alignment: Planar

UTile: 8.0

VTile: B.O

Ceiling

Alignment: Planar

UTile: 2.0

VIile: 2.0

3

FIGURE 3.33 Correctly aligned floor and ceiling.

END TUTORIAL 3.4

Making the Level Functional

Lights. ~.~ )'011 n1 ight imagi.n.c, are essentia I to your levels. Lightless game levels lool< much Iike a

room with lhe ligll1S lUrned off. Obviously, playing a lightless game would be quire diffIcult.

Lights -are used not only to aUow players (0 see your level, but also to creale m?od, add color, and

con tTO I the dra m.lt i( "feeI~ of each area 0 ( l.h e rna p. Jn Ihe folIo wi ng tutor jaJ, you make you r level

playable b~' learning hOI" to p13ce lights and rebuild the level to generate light maps (or creating

areas of light and shJJow.



Creating Your FIrst Map

Before you rall jump in and ilcwally run around this map in the game, you need to add a few
missing items. The first Item, as mentioned, is a light sourcr of some kind. The second is a Player
Start Actor, which gives your map a point of entry (or any characters Ihat want to play it. Finally,
you must rebuild (he level to calculate its world geometry and generate the light maps that make
surfaces seem to be illuminated.

TUTORIAL 3.5: Making the Level Functional

75

Forgetting to reboild before testing a level often
results in your cha racters dying as soon as they enter
the game! If you fUn into this problem, be sure to
rebuild your level's geometry.

1. First, add a light. Right-cltck on the
center of the ceiling surface in the 3D
viewport. and choose Add Light Here
from the context menu. A light bulb
Icon is displayed to represent the
light's position (see FIGURE 3.34).

CAUTION 1

I

I___--------l

FIGURE 3.34 Newly created light.

2. At first, you probably won't see much change in the level. To see what the light will look
like in the room. you must rebuild the level. Click the Rebuild All button I; on the toolbar.

You can see some dim lighting with Quile realistic softened shadows in the corners
(see FIGURE 3.35). The lighting conditions in the room are affected by several things:

Light position

Light settings (hrightness and
color)

Number of lights in the room

Object placement and the shad·
ows created by those objects
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FIGURE 3.35 Room wi1tlllghtlng,

3. With the light selected, click the ACIor

Propenies tJutton II 011 the toolbar or

double-click the light's icon.

4. In Ihe Light Properties dialog box, e)(pand the

Lighleolor section and set the

Ll.ght8r ightness pr~rty to 128 (see

FIGURE 3.36). You'll nolice the room gel
brlghter,oot this Isn '( an accurale representa

lion of the new value. To see an accurate repre
sentall(:m, you need to rebuild the level again,
Do so JlQW.

5. Now It'S ((me 1o add a Player Starl. Rlghl-ellck
Ol'l the floor surface, somewhere near its cel'l[er,

ol'ld choose Add Player Start Here from Ihe
menu.

A Joystick icon is displayed to represent where
the player starts (see FIGURE 3.37). When

you click the icon. an arrow indicates U1e
direction the player wlil be facing when he or
she spaW(\S into the map,

FIGURE 3.36 The Light Properties
dialog box.
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FIGURE 3.37 A Player Start icon with visible arrow.

6, Time to playl There's no need to rebuild a level after adding a Player Start. You can simply

click the Play Map! button on t!le toolbar and check out your new level (see FIGURE
3.38). Congratulations! You've finished a basIc levell

7. When you're finished plaYing, press the

tilde H key to close the console. Clnd type

exit. This immediately closes the game

and sends you back to your desktop.

FIGURE 3.38 A completed level.

END UTORIAL 3.5

- - -- -------...,
NOTE

Yoo r.an also click the Boild Lights botton or tlle Build
Changed lights button on the toolbar for the same effect.



TIP
By making the dimensions of your rooms divisible by
16, you won'I have 10 make changes to the grid as
often, and proper snapping is much easier 10 achieve.

3
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Expanding the Level: Creating Objects and Adding
Lights
You've compkted a basic room, but obvioLisly it's not enough to make for an exciting level. You

need to enhance and build on what you have so far and change it into a level rich with detail. To
begin, you add a window to the control room, followed by a hangar room beyond it. Next, you
add a hallway that leads from the hangar to the conlro] room.

The Window and Hangar

In TUTORIAL 3.6, you create the window that leads from tile existing conlrol room into the

hangar, which has yet to be created.

TUTORIAL 3.6: Creating a Window

1. Create G Cube BUilder brush and enter the follOWing property settings in the CubeBullder

dialog hox:

Height: 256

Width: .16

Breadth: 1024

2. In the Top VieWport, pOSition the 8uilder hrush so that its bottom edge aligns with the top
edge of the control room (see FIGURE 3.39). Notice how this alignment seems ImpOSSI

ble because of snapping? You need to lower U1e Drag Grid Size settmg for this to work.
Set Drag Grid Size to 2 in the console bar.

FIGURE 3.39 Top view showing the alignment of brushes.
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3. In the Side viewport, posItion the Builder brush so that its lOP aligns with the top of the
control room (see FIGURE 3.40).

,

FIGURE 3.40 SIde view showing the alignment of brushes.

4. Before subtracting the space. select a texture. Open the Texture browser and select the
Base 1 texture from the Base group of the Chapter3_tex.utv package.

5. Subtract the space for the window

and rebuild the map as you did for the
first room. You have created a reces

Sion In the wall, which will soon act
as a window into the hangar (see
FIGURE 3.41).

NOTE
If necess3/y, you can temporarily set Omg Grid Size
back to 16, which should make It easier to center the
new hangar brush in the control room, and then reset

I it to 2 so that you can snap against the window.

6. Next, you need to SUbtract the space for the hanga~. Create a Cube BUilder brush and

enter the following property settings in the CubeBuilder dialog box;

Height: 1152

Width: 2048

Breadth: 3072

7. As you did earlier. align the Builder brush in the Top viewport so that the bottom edge is
aligned with the top edge of the window brush. Make sure to keep the center of the

Builder brush aligned with tt'te center of the control room, as shown In FIGURE 3.42,
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8. In the Side Viewport, align the BUilder

brush so that the top edge aligns with

the window and the control roorll
brush's top edge,

9. Subtract the space for the hangar (see
FIGURE 3.43).

TIP
If yuu can't soap a brush tu the grid. you can force
snap the brush to the active grin Sllnings by
Gtrl+RMB-clicking on any vertex of the brush. This
method force-snaps the entire brush back to the
grid, based on the nearest grid intersection to the
vertex you clicked.

FIGURE 3.43 3D view of newly subtracted tlanger.

10. Rebuila the level. As you might have expected. the hangar IS dark. You need to aod some
Hghts so that you can see into the hangar. You'll do this in the next tutorial.

11. Choose File> Save from the main menu, and name the file myHangar . u t2.

END TUTORIAL 3.6

fn TUTORIA L 3.7. you see how to duplicate Actors to quickly crc,He a series of lights. instead of

adding each one individually. Keep in mind that the duplic-ation methods discussed in this 111\0

rial can be IIscd on any Actor.
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TUTORIAL 3.7: Lighting the Hangar

1. In the Perspective viewport, navigate the camera into the hCngar. It's currently a bit dark
and rather difi'tcult to see what's going on. To helo you see what you're doing, you can
switch the viewport to a Textured Only mode by clicking the icon of that name on the
30 viewport's toolbar, This mode Illuminates all surfaces ot the level evenly, removing any
shadows that might be hampering your visibility.

2. f~ight-click anywhere Or) the ceiling suriace and choose Add Light Here (see FIGURE 3.44).

NOTE
The scale of the light bulb icons has been Increased
so that you can see the lights better.

3

FIGURE 3.44 The hanger with one light

3. Because this roorn IS so big, move the ligllt halfway down to the floor to get adequate
lighting (see FIGURE 3.45).

4. Now you need to duplicate the light twice. With the light selected. press Ctrl+W to copy
the light. The new light is automatically selected. Notice that the new light is slightly offset
from the first, makIng it easier 10 discern the original from the copy_

5. Usmg the same technique, make one
more copy of the light and posItion the
new lights so that they form a vertIcal
straight line along the left Side of lre
hangar brush In the Top viewport. Sr~e

the image in FIGURE 3.46 if YOu
need help,
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FIGURE 3.46 The hanger with one light in the center of the room.

FIGURE 3.46 Top view of the three lights.
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6. Select all three lights. Press Ctrl+W and move the new lights to the center of the room.
Notice hOW the three lights move as one unit. Finally. duplicate the three lights again and

POSition them near Ihe right-hand wall. FIGURE 3.47 ShowS a top view of the nine lights.

FIGURE 3.47 fop view of the nine lights.

7. Rebuild the level and change the Perspective viewport back to DynamiG ug, ting moae so

that you can see what type of illumination is in the hangar area (see FIGURE 3.48).

Keep 11) mind that any lights you add to the level at this stage are only temporary, intended to

glV€~ you a general Idea of baSIC iJiumination. You'll replace these lights atter you nave added all

tne light fixtures. If it helps, think of them as work lights.
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FIGURE 3.48 3D view of the properly lit hangar.

END TUTORIAL 3.7

TUTORIAL 3.8: Creating the Passageway That Connects the Hangar to the Control
Room

1. Create a Cube Builder brush with the following settings:

Height: 256

Wldlh: 656

Breadth: 256

NOTE
Moving the brush in this WilY creates a 32·unit gap
between rhis new hallway and the hangar, You'll deal
with that gap momentarily.

2. Position the brush in the Top viewport so that it's aligned with the control room at the top
and 16 grid spaces (with Gnd Size set to 2) over from th~ left side (see FIGURE 3.49).

3. In the Side viewport, make sure the lap of the hallway IS aligned to the top of the olher

rooms (see FIGURE 3.50).
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4. Subtract the space to form the hallway (see FIGURE 3.51). You con't need to rebuild at
this stage, but you can if you like,

FIGURE 3.51 3D view of subtracted passageway.

5. To connect the hallway to the hangar. you're gOing to create an Indented section that later
serves as an elevator shaft, To do this. first create a Cube Builder brush with the following
settings:

HeIght: 1152

Width: 16

Breadth: 256

6, Position the brush in the Top view so that it's aligned against the top edge of the newly
created halfway (see FIGURE 3.52). Make slIre it's also aligned with the bottom of the
hangar's floor in the Side view. It should perfectly fit the 32·unit gap mentioned earlier.
This gap serves as an indentation in the hangar wall to make it easier to add an elevator
later (see FIGURE 3.53).
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FIGURE 3.52 Top view of the BUilder brush.

"'" COOl I

FIGURE 3.53 3D view of the Builder brush,
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7. Subtract the space for Ihe elevator shaft. Add a couple of lights in the hallway and rebuild

the level. '(our room s!lould look similar to FIGURE 3.54.

FIGURE 3.54 3D view of the hallway with lights..

B. To attach the hallway to the control room. you need to subtract two more sections. Create
another Cube Builder brush with the {ollowing sellings:

Height: 256

Width: 256

Breadth: 672

9. Align the brush at the bottom of the first hallway brush in the Top view so that it creates a
9G-degree turn in the Milway. FIGURE 3.55 shows the 3D. view of (his brush.

10. SUbtract the space for thc connecting hallway.

11. Create one final Cube Builder brush with the follOWing settings:

Height: 256

Width: 384

Breadth: 256

12. Align the brush SO that it's nush with the end of the last hallway and nush WIt" the cOrltrol

room (see FIGURE 3.56).
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.13. Subtract the space. Add some lights in the hallway and rebuilCl the level. You should have

something similar to FIGURE 3.57.

FIGURE 3.67 3D view of hallways and the control room.

14. Ne"t. you add a window between the control room (lnd the eastem hallway (see
FIGURE 3.58). Create a CLlDe BUIlder brush with the following settings:

Height: 128

Width: 596

Breadth: 32

FICJRE 3.59 shows the 3D view of the subtracted windoYl.

91
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FIGURE 3.58 3D Yiew of the window Builder brush.

FIGURE 3.59 3D view of Ule subtracted window.

EN TUTORIAL 3.8
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Excellent work! After rebuilding, you will have all the map's world geometry i.n pl.ace and be ready

to place the static meshes in the level. Save your work.

Adding Detail: Static Meshes
At the moment, your level still looks a lirue boring. To make II more a(tTactive, you're going to add

some static meshes. The first sratic meshes you add 5e(Ve a pr.lctic.al purpose: (0 create a bridge

across the contfol foom and it window/observation deck in the conuol room to look alit into the

hangar. You then add st4irs in the "pit" of the control room as weU 3S rails to keep people from Calling
off and hurting themselves. Before you do that, however, have a look a\ the Stat ic Me~he.s browser.

The Static Mesh Browser

To open the Static Mesh browser, click its icon iii on thc loolbar or choose Vicw :> Show SUllie

Mesh Browser from the menu. This browser has a layoul ~irnilar to the Texlure browser (see

FI GURE 3.60). You can choose from any packages that might be loaded as well as groups Ivllh in

il package. On the left is a Ilsi of all static mesht:s in your selected grou p, and in the cenler is il

large viewport that you can navigate in the same m~nner as \he ?>D "Iewp<lrl in Unrl'alEd.

You can open packages of static meshes in this browser, seleci a grOllp, choose a specific mesh,

and navigate around it. You can also edit the te;<turts on a Slal ic mesh. and sa"'e your changes to

a new or existing package. After you have selected a stat ic mesh, righl- cUck atlY'yhere in your level
and choose Add Static Mesh: Some.Suwc-/'vfesh. The i(oliciud words are the name or Ihe stalic

mesh you have selecled in the browser. For more inCofTTI,llio(\ on the Slatic Mesh brOlyser and irs
functionality. be sure to refer 10 Appendix A.

._~
FIGURE 3.60 The Static Mesh browser.
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Placing Static Meshes

In the next section, you're going to take a Jook at placing static meshes in your map. Later, after

you have a clearer idea of how to add static meshes, you try more advanced techniques on your

own to add some decorative static meshes for completing the map.

Adding the Control Room Window

TUTORIAL 3.9 shows you how \0 add a window to your control room,

TUTORIAL 3.9: Adding the Control Room Window

1. Open the Static Mesh browser and load the Cllapter3_sm. usx package by choosing File>

Open from the browser menu,

2. Change the group to FrameWork and select the Control_.Room static mesh (see

FIGURE 3.61). ',Iou use this static mesh to cover the window from the control room Into

the hangar.

FIGURE 3.61 The Control_Room static mesh.

3. Right-cllck anywhere in your level (it's

best to do it close to where the static
mesh is going to be placed) and

choose Add Static Mesh to place the

new FrameWork mesh in your level.

TIP ----1
A Drag Grid Size of 32 makes the alignment in step ,
4 much easier. Remember that aligning any Actors,
Including static meshes, Is easier If you always use
the highest possible Drng Grid Size settings.

4. Align the static mesh so that it fills in the large window in the control room. It should be
aligned with the hangar's wall and ceiling and completely cover the Window into the control

room, FIGURE 3.62 and 3.63 show the 3D view of the FrameWork static mesh from
inside and outside the control room. respectively.
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FIGURE 3.62 3D view of the FrameWork static mesh from inside the control room.

FIGURE 3.63 3D view of the FrameWork static mesh from outside the control room.

END TUTORIAL 3.9
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AddIng the Bridge

YOli need a bridge crossing the ~pit" or work ilrea of the control room. However, the static mesh

you select at first is too large to fit if yOll simply copy it. You need to adjust its scaJe by using the

DrawSc31e3D tool.

TUTORIA 3.10: Adding the Bridge

1. In the Static Mesh browser, select Walkway1 (see FIGURE 3.64).

1'!tlc.a .... ~T[...

1'-1-....1-1---1-1 I.......... '
:~.~mII

FIGURE 3.64 Walkway1 static mesh.

2. Right-elick In the 3D viewport to add the static mesh to the map.

3. Set the DrawScale3D Y (found in the console bar) value to 0,50. You should enter thiS
number In the second text box. The three numbers displayed in thiS area correspond to X,
Y, and Z, from left to right (see FIGURE 3.65).

4. POSition the static mesh on the end with the control room. It should be centered on the
control room and aligned with the edge of the window in the Top and Side views (see
FIGURE 3.66). Adjust your Drag Grid Size setting accordingly. FIGURE 3.67 shows the
3D view of the first piece of the bridge.
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FIGURE 3.65 DrawScale3D settings.

1.:00: Q!(oJ. l'

FIGU RE 3.66 Top view of the frrst piece of the bridge.
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5. Press Ctrl+W to duplicate the sraric mesh walkway. Move the new copy back so that It
aligns with the other walkway mesh (see FIGURE 3.68).

'cnx '1.).1) I

FIGURE 3.68 Top view of the second piece of the bridge.
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8. Duplicate the walkway lhree more urnes, and align each one With Its predecessor. The fifth

static mesh might eve/lap slightly into the 'MOil, but this Is acoeolatl!e (see FIGURE 3.69).

7. In tne Stotit Mesh browser. selecllhe Railing! mesh (see FIGURE 3.70).

FIGURE 3.69 3D view of the entire bridge.

FIGURE 3.70 Railing! stallc mesh.
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8. Add ,Jrld align the Railmgl static mesh, and then duplicale II until you have two railings on

each side of the bridge and one on each side of the control window (see FIGURE 3.71).

You need to add a total of SIX static meshes 10 the level. Be sure to leave some spacing
at the beginning of the walkway for the stairs, which are added next.

FIGU RE 3.71 Four railings for the bridge.

9. Add the Stairsl static mesh 10 the level. Align the mest\ so that you can climb down from
the walkway Just as you enter Ihe door. Duplicate the stairs, rotate them 180 degrees, and

position them or. the opposite side of the walkway, as shown in FIGURE 3.72.

10. As before, rebUild all your lighting and play·test the level. Make sure your meshes not only

appear to be positioned well, but also serve their designated functions.
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FIGURE 3.72 Stairs added to the walkway.

END TUTORIAL 3.10

Decorating with Static Meshes

You have nOh' placed all (he functional static mt~he-s in your level. but ol'crall it's sliJJ dull. You

need 10 lldd more sratic meshes to fill the level with physical de.IJ.~. HClwever, instead of stepping

Ihrough placing what could be hundreds or instances of st3tic meshes, you have !.he opponunity
to pracLice .....·hat you've lea rned by completing the room on your own. FIQURE 3.73 shows I ...hal

this mom is inlended to look like, with some additional ob)ects. Read over the foJlowing seCllons,

examine the coUeclion of sr.atic meshes in Ihc Cl'lapt er3_sm. U$X package, and have fun!

Control Room Treatment

The conlrol room consi.sls of:l bridge-like walkway that extends ~ver a bay filled wilh comp\l!ers

and monitoring equipment. These compu'ers should Ix undem~th the bridge and along the
\\'alls_ HO\Il('\'t'r, they should be positioned so (hat Lhe.re's:I clear pa.s.s.age betwee.n the !wo sides o(

the I'll. The LQn(roJ roOfl1. needs seveT"al monitors and $Creens. to help keep Irack of information

being Stnt 10 if from the hangar.

BccJ.u~e th( hangar mIght Il~ed (0 deprt~surize in an emt'rgmcy, you need to add some s()rl of

heavy vmnJati()n equipment (0 move large quantities of )lir CJuickJy so Ihal ,he control room e[lvi

roomei'll isn't compromised. Along Ine wall opposile tht: holHw<lY window, you should add some
pip£wClrk and braces 10 help sUf>pon seclions of the ceiling- You need (0 odd light (LX/ures an (he
c.c'ihng, too. FIGURE 3.74 shows ,he complelcd control room,
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FIGURE 3.73 Completed level.

FIGURE 3.74 A completed version of the contro I room.



Completion Challenge

Beneath the waJ.kw<lY across the control room, you should add a staircase that moves down and away
from th~ direction of the hangar into a smaller rOom. This room homes the main electronics of the
control room's computer systems. It needs a power core, several transistor units, and a main Cpu.

FIGURE 3.75 shows you some ideas for finishing Ihe room, Feel frce to experiment, and build
the map in your own image. Be patient-level design is not a quick process. \J\'hen you're finished,
rebuild and play-test tht map. Congratulations! You have just finished your first Unreal map.

FIGURE 3.75 The Control room with more decorative static meshes,

Summary
This chapter has covered navigation in thrce-dimensional space, how to create and manipulate

your Actors, how to usc SSP brushes, and how to subtract spaces from the Unreal world.

You havc also learned how to use brushes to create world geometry, place textures ooto the sur
faces of that geometry, and add lighting and practical and decorative static meshes to yom level.

With the skills you have learned, you can now create II wide variety of levels in toe Unreal Engine.
In Chapter 4, "Advanced Brush Teconique~:' you karn more about BSP brushes and their
advanced functions,





Cater

Advanced BrlJsh
Techniques

By now, you shou.ld have a general underslandlr'lg of 0011I Binary

SpacC' Partitioning (SSP) brushes are created and used In level

design. In this ,hapter, you suppknlenl that knowledge by le~rnmg

th~ fundamental theory behind BSP Jod a varit>ly o( advanced ken·

niqucs you can use to take fuU ad"'31IlJ.ge o( how SSP works. This

ehaprer also (OWn (nterseCl and De-Intersect brushes and the 2D

Sh.1pc Editor, which is an invaluable tool (or lhose witholJt access to

a 3D application, such ~s Maya or 3ds max. Nexl, you tram how to

save the brus"es you Creille (or future use and how to expon your

brushes from Ul'lreaLEd.

This chapter's cowrage (ocuses on helping you understand how lhe

geometry o( your levels works so thaI you can make your levels

operatt more efficient.ly <lnd complete them Ul a more limely f~sh·

ion. For c-xample, \lIhcn bl,ilding objects in your levels (Tom ESP

brushes. you Ciln use jusl simp!e brushe~ and primilives, hUI lhi~
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method could create unnecessary detail in

your level. For example, say you wanted to

create a pillar with crossbeam supports

coming out of iI, as in FIGURE 4.1.

For this example, a cylinder primitive was

used for the central pillar and added to the

level with an additive hrush. for the cross

beams, you could simply make them with

::sdditive brushes as well so that they inter

sect not only with each other, but also with

the central pillar. FIGURE 4.2 shows the

effect in the Top viewport.

This method might seem fO work, but it's

actually creating unnecessary geometry,

which could eventually result in BSP

errors, such as a Hall of Mirrors (HOM)

effect. The problem is that the lines inside

the cylinder shouldn't exist because sera·

rate pieces of world geometry shouldn't be

allowed to pas.~ through each other. To flx

tbis, you can perform an action called

intersection, which modifies the Builder

brush so that the additive geometry of the

crossbeams doesn't pass through the cylin

der. Intersection is discussed more in "The

Intersect Tool;' later in this chapter, but if

you performed this action on both cross

beams, the result would look similar £0

FIGURE 4.3.

This technique might look more visually

complex, but it's actually easier for Ihe

compUler to calculate because of the natu re

of BSP. The next section discusses the fun

damental workings of BSP, how the Unreal

Engine uses it 10 control how BSP brushes

are llsed, and how the world geometry sur

faces in your levels are rendered.

FIGURE 4.1 Room with central pillar and
crossbeams.

/ - r--.
I 1
"-~l/

I I
FIGURE 4.2 Crossbeams created with simple
additive brushes.

FIGURE 4.3 Crossbeams are made by using an
intersection before creating the additive geometry.
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When you start combining brushes in complex situations, you might get results that seem strange

at first. such as the cuts in the crossbeams of the example in the previous section. These cuts are

caused by ESP. After you understand how BSP works, the purpose behind these cuts and divisions

will be clear. Please keep in mind that the theory behind BSP can be difficult to understand at

first, so don't get frustrated if it takes a few tries to fully grasp. After you understand how the

graphics engine uses BSP, you'll have a much better handle on what's going on behind the scenes

of your maps and levels.

Polygons

Before you go any further, however, take a quick look at polygons, as they are the basis for why

BSP calculations tal<e place on three edges. AU polygons in Unreal are triangles, and every poly- ,

gon has a positive and a negative side that you can think of as the front (the positive side) and

back (the negative side). "Positive" and "negative" in this context, however, aren't relative terrl1s

based on a viewer's perspective. The positive and negative sides of a polygon are constant, regard

less of the angle from which you're seeing the polygon. A good analogy is describing the sides of

a polygon as the head and tail sides of a coin. No matter how you flip a coin or move around it,

the head and tail sides are constant in relation to the coin.

The front and back of a polygon are significant for two reasons. First, they are used in creating

BSP trees, which are described in the next section. Second, the graphics engine doesn't draw the

negative side of a polygon. Therefore, ifyou're looking at a wall with no depth (a simple 2D plane)

in Unreal, you could look at it only if you were facing its positive side. As soon as you move

around behind the wall and try to look at it, it's no longer visible because you're Jooking at the

negative side of the polygon that makes lip that wall. The reason you can actually see both sides

of a wall when in the game is that the wall has thickness. After you add thickness to a plane, it

effectively becomes a cube, which has six faces. When you're looking at the back of a wall in an

Unreal map, you're actually looking at the positive side of a polygon on the back of a cube. Note:

You can force the rendering engine to draw the negative side of a polygon by placing a two-sided

material on it. Materials are discussed in Chapter 8, "Creating Materials in Unreal."

SSP Trees

Now that you understand what polygons are, you can learn how BSP calculations are made by

creating BSP trees. A BSP tree is nothing more than a method of arranging polygons so tbat the

graphics engine draws them in the right order.

Draw Order

The order in which the graphics engine draws polygons is vital to what rendered scenes look like.

Imagine standing at the end of a hallway, with three walls dividing it, as shown in FIGURE 4.4.



108
- -- - - -- --- -------------

When you're trying \0 see the end of the hall, Wall 1 blocks your view, and you can't see WaU 2 or

Wall 3. This problem happens in the real world because of occlusion-one object blocking the

VifW of another.

In a graphics engine, however, this problem occurs because of the order in which polygons are

drawn. In Unreal, polygons are drawn from far to near, meaning that the polygon farthest away

from the player is drawn first. then the next closest, then the next closest, and so 00. The effect is

the same as placing several stickers on a

piece of paper, overlapping them one atop

the other. The last sticker you place is the

one in "front," and the first sticker placed is

in the "rear" If polygons arc drawn in the

incorrect order, it's extremely difficult to

teU which surfaces are nearest to you and
which ones are farther away in the game. FIGURE 4.4 Occlusion that blocks the view of

Wall 3.
In FIGURE 4.5, you can see the results of

draw order and how they apply to the

example of Walls 1, 2, and 3. On the left is

the result of incorrect draw order, meaning

that the nearest wall was drawn first. The

draw order in that case is Wall 1, then Wall

2, and then Wall 3. On the right is the same

scene drawn in the correct order, starting
wilh the filrthest wall first: Wall 3, then

FIGU RE 4,5 Correct and incorrect draw order.
Wall 2, and then Wall 1.

4

Tree CreatIon

The graphics engine uses BSP trees to determine the order in which these walls, or polygons, are

drawn. The BSP tree is formed by an algorithm, which begins by designating a single polygon as

a point of reference. This polygon. called the origin polygon, goes at the top of the tree. The algo

rithm then moves on to the next polygon it finds <lnd pldces it in the tree beneath the first poly

gon. If the second polygon is on the same side as the front (positive side) of the origin polygon,

this new polygon is placed, say, on the right side of the tree. If the polygon is on the same side as

the back (negative side) of the origin polygon, it's ~laced on the left side of the tree. The next poly

gon is placed below the second, using the same system to determine whether it's placed to that

polygon's right or left.

At the same time this calculation is going on, the engine is checking to see where cuts need to be

made in the BSP. This is done by testing whether a polygon would cut into any other polygons if

you extended it to infinity. If it does, the polygon being cut would technically exist on both sides
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of the first polygon. This makes it impossi

ble to dete,mine on which side of the BSP

tree to place it. Therefore, that polygon is

going to be split in half. Those two new

polygons are then processed. with the half
on t he positive side going on the right side

of the tree and the half on the negative side

going on the left side of the tree. The algo

rithm then continues this pattern until it

has accountt'd for every polygon in the

level. The resulting shape is a tapered net

work, with the origin polygon at the top,

forming a tree-like shape.

To see how tree creation works, take a sim

ple two-dimensional level, shown in

FIGURE 4.6, and create a BSP tree for it.

Each polygon, or line, is given a name. The
little lines protruding from each polygon

line are called the normals. They designate
the polygon's positive and negative sides:

The side with the normal protruding from

it is considered positive.

Start by picking a line to be the Oflgtn

polygon. For this example, use line A, and

start by processing the positive side. B is

the only polygon on the positive side of A,
so place it on the right side of the tree (see

FIGURE 4.7).

B

FIGURE 4.6
with lines.

FIGURE '4.7
tree.

FIGURE 4.8
tree.
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F

A

A two-dimensional level represented

First step in constructing the BSP

Second step in constructing the BSP

Two polygons are on the negative side of A. For this simple demonstration, it doesn't matter
which polygon you choose, so begin with F, which is on the negative side of A. This means it's

placed on the left side of the tree (see FIGURE 4.8).

Jf you extended line F to infinity, it would intersect H. Technical1y, this means H is not placed

on the positive Of negative side of F, so you have to split H into HI and H2,Now HI is on the

positive side of F and H2 is on the negative side. When yOll place them under the tree, they

both go underneath F, with Hl on the right and H2 on the left. FIGURE 4.9 shows the final
BSP tree.
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Now tha I this I reI" has been ere-

A

FIGURE 4,9 Final asp tree along wi'th the 20 level where
line H is flOW splil

dl~d, lile l';ld plti<-s t ngi lJe can U1>e

it as a diagram of the polygon's

relationships to each other based

on their relation (0 the origin

polygon. This diagram can then

be used to determine in which

order pofygons should be drawn.
Here's how it 1V0rks: rf the pl.ayer

IS looking at the origin pDlygon

and i15 positive side is facing

away {rom the player, meaning

the player is facing the negative

side, the engine 1V0uid go down

the right side of the Iree. Think

abou t it: You've already estab

lished that all polygons on the

positIve side o( the origin are placed on the right side of the DSP tree. Therefore. if the positive

side of the origin is pointed away from the player, all polygons on Ihe right side of the BSP tree

must be on the opposite side of the origin polygon. (rom the player's perspective.

As ~'ol.! move down the right side or the tree, you're effectively moving away from the player.
When you reach the end of the "branch," you're at the farthest polygon /Tom where the playtr is

standing. The graphics engine then draws these polygons, staning al the end Qf this branch and

moving back up to the top, aU the way to the origin polygon. The result is that all the polygons

are drawn in the correct order, with the farlhest polygon (rom the pla>'er being drawn first and

the ne.aresl polygon being drawn las\. Thi.~ causes the polygons closes I to the player to appear to
be in front o( the potygons that are (arther away.

Perhaps the best part of this algorithm, however, is 1hat it's calculated before the game is even

played, which speeds the game Up. dramatically during runtime, Note, loo, that BSP can also be

used as a method for deLennining whether the graphics eJlgine eveD calculates polygons com

pletely outside the player's view, This method, however, is an unreliable way to gauge whether to

render polygons. To S{)lve this problem, level designers Gan implement portals and zones 10 dCler

mine wh2t parts oC a level are calculated and what parts are not. These techniques are covered in

Chapler 15, "level Optimiz.ation (Zoning) 2nd Distribution,"



Brushes from Other Brushes
When creating your If'vr!s, at times you

need brushes with special shapes that you

can't produce by using simple primitives.

Say. (or instance. lhal you need a half
sphere brush. The primitive brushes have

no sel ting (or this shapr.. but often. you can

achiew unusual sh,ipes by basing your

brush on geometry already in the level.

The (oHowing sections explain a pair of

tools in UnrealEd called Tntersec\ and De

Intersect. These tools perform s!,ecial

operations on your Builder brush to create

new brushes based on existing level geom-
etry. Cre~ting brushes with these tools

helps keep your world geometry efficient

and prevent BSP errors. FIGURE 4.10

The Intersect Tool

The Intersect tool removes all areas o(

your Builder brush that are not inside solid

geometry. The following figures demon

strate how this tool works. Before intersec·

tlon. you would have what's shown in
FIGURE 4.10.

After intersection you would get what's

shown in FIGURE 4.11.

Your Builder brush is now a quarter-cylin
der. Keep in mind that your Builder brush

h;lS been modified. nothing else. At this

point, you're ready to create an additive or

subtractive brush to build geometry based

on the new shape. To see what happens FIGURE 4.11

when you use the Intersect tool, try it out

on a simple box-shaped room.

Brushes from Other Brushes III

Sub:r""lOO Area

Before intersection.

Subl,aCled Alea

After intersection.
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TUTORIAL 4.1: Using the Intersect Tool

1. Start UnrealEd and choose File>
New from the main menu.

2. Create a Cube brush with the
following settings, and subtract
it from the world:

Height: 256

Width: 256

Breadth: 256

3. Move the Builder brush so thaI it
overlaps the top-fight corner of thIS
newly subtracted cube, as shown
In FIGURE 4.12.

4. If you subtracted the BUilder
brush from the world at this pOint,
you would have two subtractive
brushes overlapping, This can
lead to BSP errors such as the
HOM effect, Instead, click the
Intersect button in the toolbox
(see FIGURE 4.13).

5. Notice that the Builder brush has
changed its shape dramatically. It
now represents the result of Ihe
Intersect operation. Subtract the
Builder brush from the world, and
you'll have much more efficient
world geometry than you would by
simply subtracting the original
cube.

END TUTORIAL 4.1

FIGURE 4.12 Top view of the Builder
brush positioned over the top-right corner of the
subtracted cube.

,-,-_.

FIGURE 4.13 Top view of tne Builder brush
after an intersection with the subtracted cube.

Intersections can also be used in more complex situations, such as subtracting a corridor into a

curved surface while maintaining proper geometry. Remember that llsing this tool is always bet

ter than having two BSP brushes overlap each other.
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The De-Intersect Tool

Think of the De-Intersect tool as the
opposite of the Intasect rool. As with
intersecting, the operation ('dit5 the shape

of the BlIilder brush_ However, the result

ing shape is calculated by removing the

Mea of the Builder brush that's Inside solid

geometry and leaving the rest. Using the

previous example, yOll would begin

FIGURE 4.14.

After using the De-Intersect 1001, you SuOuaetodil<oe

would have what's shown in FIGURE

4.15. FIGURE 4.14 Before deinterseeting.

To better understand how the De-!ntersect
tool works, use it to create a half-cylinder

in TUTORIAL 4.2.

FIGURE 4.15 After deintersecting.

TUTORIAL 4.2: Using the De-Intersect Tool

1. Start UnrealEd and choose File> New from the main menu.

2. Create a cylinder with the following properties:

Height: 512

OuterRadius: 256

SIdes: 16

3. Subtract this brush from the world.
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4. Now create a cube with the following properties:

Height: 512

Width: 512

Breadth: 512

5. Place this new cube brush over half the cylinder, as shown in I=IGURE 4.16.

FIG URE 4 ..16 Top view of cube brush over half the cylinder.

6. Click the De·lntersect button. You should now have a perfect half·cylinder brush with a
radius of 256 (see FIGU RE 4.17)_
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• An edge is a line between lWO vertices. For example, the lines between the corners of a

polygonal cube are classified as edges .

• A face is a surface stretched between three or more edges. for a cube. it's one entire side

of the cube.

Vertex Editing

Vertex Editing mode III enables you to move the vertices of a polygon object around in space.

Doing this changes the shape of your brush and makes it possible to create shapes that would be

difficult. if not impossible. to create with the Intersect or De-Intersect tools. The following tuto

rial shows how you can use Vertex Editing mode to drastically alter the shape of your brushes,

without needing to create extra brushes for intersection operations.

TUTORIAL 4.3: Vertex Editing in UnrealEd

1. Starl UnrealEd and choose File> New from the main menu.

2. Create a cube with the following properties, and subtract it from the level:

Height; 256

Width: 256

Breadth: 256

3. Move your Builder brush out of the way, and select the remaming subtractive brush. Make
sure you select it in an orthographic view so that you 8ren't just selecting the surlaces.

4. Click the Vertex Editing button in the toolbox.

S. Hold down the Alt key, and in the Top view, click the vertex at the upper-right comer of the
box, Note that you can select vertices only III the ortnographlc views. Keep In mind that
this operation has actually selected two vertices: one on top of the cube and another on
the bottom (see FIGURE 4.:19).

6. While holding down the Ctrl key. drag with the LMB and notice how the vertex IS moved
around the viewport. changing the brush shape (see FIGURE 4.20). You can also see the
anginal POSition of the vertex designated by a small point.

7, You can also select multiple vertices in Vertex Editing mode. Holding down the Clrl and Alt
keys, drag With the LMB to draw a box around all the vertices on the left side of the brush.

8. Move these vertrces while holding down the Ctrl key. Experim~nt and see what sort of
interestmg shapes you can make. just from starting with a Simple cube.
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FIGURE 4.19 Top view of the two vertices selected.

FIGURE 4.20 Top view of the defonned (altered) shape.

END TUTORIAL 4.3



Face Dragging

Face Drag mode enables you to manipulate
entire (aces of your brush to reshape it. It

works similarly to Vertex Editing mode, but
enables you to quickly select a face that con
tains multiple vertices.

To use Face Drag mode, simply move the
mouse pointer near an edge and drag the
mouse as shown in FIGURE 4.21.

NOTE
At the time of this writing, Face Drag mode loses func
tionality when more than one brush is added to the

1''''1. """'. YO" '" "" Vert" Ed"" m"',. ,,'select all the vertices surrounding a face,
_________________----.J

4

Brush Clipping (2D and 3D)

Brush Clipping mode II enables you to •

split a brush by using a plane. You (an use
this tool in two modes: 20 and 3D. FIGURE 4.21 Using Face Drag mode.

Clipping a brush in 20 is similar to placing a ruler on a piece of paper and using a razor blade to

cut along the ruler. Clipping in 3D is like cutting a log with a chainsaw. In both cases, you can
keep both of the resulting pieces or keep only one.

Brush dipping is done by creating clipping markers, which are points in space that designate the
plane at which the clip wiU occur. Placing two markers creates a 2D clip; adding a third marker
results in a 3D clip. To see how these methods work, try TUTORIAL 4.4, which uses Brush Clip
mode to add character to an ancient ruin,

TUTORIAL 4.4: Using Brush Clipping

1. Start UmealEd and choose File>
Open from the main menu, Open the
Chapter4 folder from your installa
tion folder, and select
Tutor ia14_04_Start. You'lI see a
level with a Greek·style ruin that,
frankly, is In excellent shape for a
ruin (see FIGURE 4.22). You'll use
the BrUSh Clipping tools to clip a
column of thiS temple so that you
can add some character to It.

2. Open the Texture browser. In the
Chapter4.utx package, find and click
the base08AL texture. This texture
will be applied to new faces during
a clip,

FI GURE 4.22 A level with a Greek-style ruin.
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3. In the Top viewport, select the column in the lower-right corner (see FIGURE 4.23). The
column is an addItive Semi-Solid brush. (This brush type IS covered in "Brush Solidity:
later in this chapter.)

FIGURE 4.23 "TOp view of the selected pillar.

4. Click the Brush Clipping button in the toolbox.

6. Hold down the Ctrl key and right-click in the Side viewport. For this example. you're placing
only two clipping markers to generate a 3D plane thars perpendicular to the Side vIewport
(see FIGURE 4.24).

6. Notice a line between the two clipping markers, which indicates where the column will be
clipped (cut). Think of this line as a cutting laser that slices all the way through your brush.
Another line that's perpendicular to the line connecting the two points is called the clipping

normal. It points to the piece of your brush thaI will be removed when you clip the brUSh.
After placing the clipping markers. you can then use any of the four clipPlrIg commands in
the follOWing list:

.. Clip Selected Brushes ill-This command removes the parI of the brush that's on
the same side of the clipping plane as the clipPing normal.

~ Split Selected Brushes -This command diVIdes the brush along the clipping plane.
but doesn't delete either side.

.. Flip Clippmg Normal -"This command reverses the place the clipping normal on
the opposite side of the clipping plane.

.. Delete Clipping Markers .-This command removes all clipping markers from the level.

III
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Clipping markers

..

If you create your clipping points in a left-to-right
direction, the normals face down. If you create them
right to left, the normals face upward.

NOTE
7. For this example. you want the top of

the column to be removed, not saved.

Therefore, you need the perpendicular

line to be flipped. To do this, the clip

Ping normal must point at the upper

half of the column, If necessary, click

the Flip Clipping Normal button •. It not only flips the clipping normal, but also reverses

the numbering of the two clipping markers.

fIGURE 4.24 Side view of clipping markers.

4

8. Now click the Clip Selected Brushes button , and rebuild your geometry and lighting,

Notice that the top half of the column is gone (see FIGURE 4.25).

9. Next. you clip a second column, but first you need to remove the current clipping markers.

Click the Delete Clipping Markers button in the toolbox,

10. Create two more clipping markers In the Front viewport that clip another column, as shown

in FIGURE 4.28. Make sure the clipping normal POints toward the top of the column

again.

1.1, Instead of clipping the column, however, you're going to use the Split Selected Brushes

command. Spliltmg the brush divides it into two separate brushes along the clipping

plane. Click the Split Selected Brushes button. in the toolbox.



Brush Manipulation 121

FIGURE 4.25 3D view of new column.

FIGURE 4.26 The clipping markers in the Front view.

• l.eutl 'lnO I D:
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12. You now have two halves of the column. Using the skills you learned in Chapter 3,

·Creatlng Your First Level with UnreaIEd:' move and rotate this new brush to place it

somewhere in the level, as shown in NOTE j
FIGURE 4.27. Remember to rebuild
your lighting to see the effect. You can clip the Builder brush, but you can't split it, as

that would result In two Builder brushes.

FIGURE 4.27 Final columns.

END TUTORIAL 4.4

In most cases, 2D clipping in Olle of the orthographic viewports gives you enou&h conl rol 10 ere

ale the shape you need. However, at times you might need more control over the clipping plane.

In these cases, you can use 3D clipping, which is donl' by simply adding a Ihi rd cI ipping marker.

Remember that three point;; in space define a plane. Therefore, you can move the three clipping

markers to adjust the clipping plane's orientation.

In TUTORIAL 4.5, you add more cuts to the Greek rUinS.
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TUTORIAL 4.5: Improving the Look of the Ruins

1. In the Top view, hold down the CUI key and right·click to create three clipping markers,
(arming a triangle between the columns in the lower· right corner of the temple (see
FIGURE 4.28). When you're done creating the third marker, notice that the perpendicular
line seems to disappear. However, what really happens is the normal is now pointing up in
the Z·axis, so you can't see it from the Top viewport. You can see the normal clearly in the
3D view.

FIGURE 4.28 Top view of the three clipping markers.

2. Now move the cliPPing markers In the 3D viewport so that they define a plane that cuts
through the temple's emablature (the series of blocks laid across the top o( the columns)
at an interesting angle (see FIGURE 4,29}. Notice the direction of the normal and how
the clipping plane rotates as you move any 01 the clIPping ('larkers. The three clipping
markers don't need to surround the brush.

3. Select the orush you'll be clipping. In the Top Viewport, it's the right side brush of the
teml1le's entablature. Click the Clip Selected Brushes button, and rebuild your level. You
should get something simila( to FIGURE 4.30.
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FIGURE 4.29 3D view of the three clipping markers.

FIGURE 4.30 3D view of clipped entablature.

4. Save your work as AuinedTemple.

END TUTORIAL 4.5
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You can now create brush clips at any angle you

like, which makes it possible to create more irregu

larly shaped brushes. The clipping tools are

extremely useful for generating interesting brushes

when a simple primitive won't do. Use the skills you

have learned so far to make more cuts in the temple

for a more realistic aged look. If you like, open the
Tutoria14_05_Enhanced. ut2 file and see a fully

ruined temple (see FIGURE 4.31).

FIGURE 4.3.1 Fully ruined temple.

Freehand Polygon Drawing
With the Freehand Polygon Drawing tool, you can create BSP brushes by placing your own ver- 

tices, thereby designating your own custom shape. This tool is simple to use and makes it possi

ble to create irregularly shaped brushes quickly. All you need to do is draw a few vertices in a

connect-the-dots fashion, and then choose the height you need the shape to have. In this section,

you sec how to create an irregular brush with this tool for use in your Greek ruins level.

TUTORIAL 4.6: Using the Freehand Polygon Drawing Tool

1. In the Greek ruins level. click the Freehand Polygon Drawing button .,

2. Make sure the base08AL texture is still selected m the Texture browser,

3. Holding down the Cui key. right-click in the Top viewport somewhere off to the side of the
temple. This action places a vertex in the viewport, which appears as a red cross with a
green circle around it (see FIGURE 4.32).

4. Place at least three vertices in this manner. Notice as you place the second vertex that a
line appears connecting the two vertlces_ You can continue placing vertices as long as you
like. here is no need to close the shape by placing the fmal vertex on the first point (see
FIGURE 4.33). The shape automatically closes when you create the brush.

5. When you're satisfied with the shape. release the Ctrl key. right·c1ICk in the Top viewport.
and choose Create Brush from the context menu.
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FIGURE 4.32 Top view of the newly placed vertex.

FIGURE 4.33 Top view of the shape.

1::.:m lCOCO I
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6. In the Depth dialog box, enter 128
for the depth (256 is the default
value). as shown in FIGURE 4.34.
Click OK when finished. This setting
controls how deep the shape
becomes.

7, Position the new brush on the

ground near the temple, and add It
to the world (see FIGURE 4.35).

FIGURE 4.35 Newly created piece of rubble.

END TUTORIAL 4.6

44:1'101.<_' !O'W.._.~_
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FIGURE 4.34 The Depth dialog box.

As you can see, the Freehand Polygon Drawing tool is a fast and efficient way to create uddly

shaped brushes for your levels. However, be careful not to add too many vertices, which could

make your object unnecessarily complex and result in excessive BSP cuts in your shape.

The 2D Shape Editor
You can use the 2D Shape Editor to create custom 3D brushes from 2D curves. With this 1001, you

can quickly creale lnteresting shapes that would otherwise be impossible with primitives and clip

ping. This section is deSigned to give you a general overview of the 20 Shape Editor, its options,



128 Chapter 4 Advanced Brush Techniques

and its uses. For mOrl' in-depth information on this 1001'S functions, refer 10 Appendix A, "The

UnreaJEd ManuaL"

Since the advent of static meshes, the 20 Shape Editor hasn't been used as otten. Most of the

shapes you can generate with the 20 Shape Editor can easily be created in an external package
and imported as static meshes. The final result of the 2D Shape Editor is to create a BSP brush,

which is perfect jf you're creating a speciaJJy shaped roum. Huwever, static meshes are far more

efficient for decorations. Using the 20 Shape Editor is recommended only for specially shaped
rooms, and use it for decorative brushes only if you don't have a,cC'ss to 3 3D application such as

Maya or 3ds max.

User Interface Overview

4
To access the 2D Shape Editor, choose Tools> 20 Shape Editor from the menu or dick the tri

angle icon on the toolbar. The 20 Shape Editor window includes a single orthographic view, a

toolbar, and a menu bar (see FIGURE 4_36). By default, the current shape is a square, but you
call t'dil this shape by moving and adding vertices and then perform one of the available opera

tions to wnvert it into a 3D brush for use in your level. The next two sections give you an

overview of the user interface for the 20 Shape Editor.

Menu and Toolbar

At the top of the 20 Shape Editor win
dow is the mellu bar, which gives you

access to all operations that c~n be per·

forrnt'd on the current shape. Many of

the common commands used in the
editur are a(so Jvailable on the toolbar,

which gives you fast single-click access
to operations such as rotating, tlip

ping. scaling, and adding and remov

ing vertices. The toolbar also has

buttons for operations to cOllvert your
20 shape into a 3D brush. You can use

both the menu bar and toolbar to save

and open your ~hapes for later reuse or
editing.

FIGURE 4.36 2D Shape Editor window.

Viewport

Navigating the viewport is as simple as dragging with the RMB. The response is similar to navi
gation in UnrealEd's orthographic viewports. Note that dragging doesn't move the shape around;
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it merely pans the camera. To zoom in and out, use the magnifying glass icons 011 the toolbar, or

choose View> Zoom In or Zoom Out from the menu.

Right-clicking in the viewport gives you access to several commands that arc available in the Edit

menu. This context menu also includes the Set Origin command, which relocates your shape's
origin to the position where you click the mouse button. (The imporlance of the origin is
explained shortly in the "Components" section.

Shape Editing

Now that you have a basic knowledge of the 2D Shape Editor's interface, you can learn how to
edit the shape and create objects. The first step is understanding the components that make up
each shape. The following sections familiarize you with the shape components and how they can

he used to alter and customize your shape.

Components

The small white boxes at the corners of the default square are vertices, ",..hieh form the founda

tion of your shape. When you connect these vertices. you see black lines to indicate the shape's
edges. When you select a vertex. its corresponding edge becomes thicker, meaning that it's also
selected.

fIGURE 4.37 20 Shape Editor components.

At the cenrer of the shape are two small squares. They might be difficult to sec at first because
they are right on top of each other. The orange square is your shape's center point. This square
is actually just a handle used to relo
cale your shape. It always slays in the
exact center. You can dick and drag on

it to move your object around the
viewport. You on have multiple
shapes in this viewport at once, and
rhest' center points makr moving them
much e.lsin.

Just behind this ora ngc- square is a green
square, which is your shape's origin. No
matter how many shapt's are available in
your viewport, you can havt' only one

origln_ The origin serves as a reference
point for revolving, discusst'd in
Tutorial '1.1 0, later in this chapter.
FIGURE 4.37 shows the components
of the 2D Shape Editor.
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Moving and Adding Detail

You can edIt a shape's look by simply clicking and dragging tht' vertices around with the LMB.

However, you'll quickJy notice that the default square doesn't allow you 10 make anything espe
cially interesting. To create d more complex shape, you have to add more vertices.

To add vertices, first selecr rhe vertex for a specific edge. For example, when you dick the vertex
at the upper-right corner of the default square, the edge on the right side of the square is high

lighted. To add a new vertex, you need to split this edge. There are several ways to do this:

~ Choose Edit> Split Side from the menu.

~ Press Ctr1+I.

~ Right-click on the vertex, and choose Split Side.

TUTORIAL 4.7: Using the 2D Shape Editor

1. Open the 2D Shape Editor by

using its toolbar button •.

2. In the 20 Shape Editor's view
port. click the vertex at the
upper'rlght comer of the

default square shape (see
FIGURE 4.38).

3. USing the LMB. drag the
vertex around the viewport to
change the shape's look (see
FIGURE 4.39). Notice that

the orange center point relo
cates to stay at the center of
the object

4. Right-click the selected vertex.
and choose Split Side from the
context menu. Note the new
vertex that appears (see
FIGURE 4.40).

FIGU RE 4.38 Upper-right vertex selected in tile
2D Shape Editor,

Now you have another vertex thaI you can use to edit the shape. You can add as many vertices

as you like, but remember thaI you should keep your detail level as low as possible.
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FIGURE 4.39 The upper-right vertex moved. FIGURE 4.40 2D Shape Editor showing the
split side.

END TUTORIAL 4.7

Bezler Segments

One advantage of the 20 Shape Editor is that

you can use it to crcate curved shapes (see

FIGURE 4.41). By default. each edge) or seg

ment, comes together Ul a "corner." This means

your segments are limar. You can change them

to Bezier segments to create a smooth curvalure.

However, keep in mind that the result of the 2D

shape is a 3D brush. As mentioned earlier,

brushes dre made of polygons. and as a rule, a

polygon cannot be curved. Bec;luse of this, the

curved line you see when using Bezier segments

is actually made up of severa) smaller segments.

You can change the numbfr of segments that

creare your curvature, thrrfby controlling how

smooth the curve looks. Keep in mind that FIGURE 4.41 Bezier segments.

adding more segments requires more calcula-

tion, and you should always keep your detail

level a~ low as Fossible.
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TUTORIAL 4.8: Creating Bezler Segments

1. Open the 2D Shape Editor by using its

toolbar hutton.

2, Select a vertex/edge, and choose Edit

> Segment> Belier. You tan also use
the rlght·c1ick menu in the viewport. The

new blue boxes that appear are the
Bezier handles (see FIGURE 4.42).

3. Click and drag the Bezief handles

around the viewport, noting the

change in the segment's shape
(see FIGURE 4.43).

4. Next. you need to adjust the segment's

detail level. First. adjust your Bezier
handles to point in opposite directions

to form an S-curve. as shown in
FIGURE 4.44.

5. Right-click on the vertex, and cnoose

Segment> Detatl Level> 20. Notice

that the segment seems to have much

smoother curvature.

6. You can also set the detail lever to a

custom setting. Right·click on the seg·

ment again, and choose Segment>
Detail Level> Custom. In the Detail
Level diolog box. enter a value of 6, as
shown in FIGURE 4.45, and click OK.

Notice that the curve of the segment is

now made of SIX separate lines.

NOTE
At the time of this writing, you must take care not
to close any windows in the 2D Shape Editor (such
as the Detail Le~el dla log box) by clicking the Close
button in the upper-right C1lmer. Doi ng so locks tile
20 Shape Editor, and you ha~e to restart it by click
ing its button on the toolbar. You will also lose your r

work if you haven 't sa~ed it. Make sure you click
the OK button instead.

FIGURE 4.42 Segment converted to a Bezief
segment.

FIGURE 4.43 Modified Bezier segment.
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FIGURE 4.47 Archway created by Bezier
segments.

D

_--::-_-"i<XlS ',<-'__:--::==~

1. Open the 2D Shape Editor.

2. Select the vertex in the upper·left

corner of the default square. and

set the segment type to Bezier.

3. Using the skills you have learned so

far, set the detail level to 5, and

adjust the handles to form a curve

across the top of the shape. This

action creates a wmdowpane with

basic curvature without getting too

detailed.

4. Move both Bezier handles straight
up, and make sure they are directly

across from each other. The result
is a nice arch at the top of the win·

dow. Refer to FIGURE 4.47 if you

need help.

5. Click the Create a Sheet button

on the 2D Shape Editor tool bar.

Leave the aXIs set to Y, as shown In

FIGURE 4.48, and click OK. In the
UnrealEd vlewports, you can see

your arched windowpane appear as
a plane. You can then create an

additive brush from this plane.

TUTORIAL 4.9: Creating a
Windowpane

FIGURE 4.48 Sheet options.

END TUTORIAL 4.9

One of the most Llseful options available in the 20 Shape Editor is the Revolve process. This

process converts yom 20 shape into a 3D brush by revolving it dround the pivot. A Revolve is per

fect for creating cyJind rically ~hapcd objeLls, such as columns and silos.
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TUTORIAL 4.10: Revolving with the 2D Shape Editor

NOTE
When using the 20 Shape Editor, the V-axis points up. In
the UnrealEd viewport. the Z-axis points up. Keep that in
mind WIlen selecting the axis for the Re~ol\le process.

QI$Ii1 ......, ~{,... v

FIGURE 4.49 Half-silo shape.
----------------'

Axis: AXIS_Y

For more information on these
settings, see Appendix A.

3. Next, check the origin, For revolving purposes,
the origin must always be placed on the left·
most or rightmost side o( the shape. Right
click the leftmost segment of the shape, and
choose Set Origm to plilce the ongm directly
on the shape's left side.

4. Click the Revolved Shape button on the tool·
bar. In the dialog box that opens. you will
choose the following attributes:

Sides: 12

SidesPer360: 12

1. Open the 2D Shape Editor.

2. Using the 5kills you have learned, create the
half-silo shape shown in FIGURE 4.49.

5. Click OK. You now have a rounded silo shape in your 3D viewport (see FIGURE 4.50).

You can subtract it from your level to produce an mterestingly shaped room,

FIGURE 4.50 3D ~iew of subtracted silo.

END TUTORIAL 4.10



NOTE
Vou COIn Illaoe only BMP Illes In lhe 2D Shape Editor
as Images.4
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Using the 20 Shape Editor to Create a Simple Level

Ahhough slaltC meshc~ might h,we replacrd much of the 20 Sh;lpe Edilor's capabilities, this 1001

does enable )'ou 10 create a basic one-~Iory level quickly. Using a technique similar to creating an
archilect's Ooor plan, you can use the 2D Shape Editor's Extrude process to create 3 basic level.
The foUowing sections expldin how 10 usc tJli~ pro<.e~s co quickly visualize a \evers layout.

Room

To cTeale Ihe basic space of youT level, you'r~ going to dT,)W a shape sim~ar to a (loor plan, and
then exrrud~ ir upward. In Ihis example. you crelle this (lOOT plan from scratch. You can create.a
Ooor plan based on an aC1u.u image, such as a
sel of blueprints, if you l.ik~. To do lhis.
choose File> Image> Open From Disk (rom

the menu 10 VI;ICc the selected jmage \.11 Lhe

background of the 20 Shape Editor.

TUTORIAL 4.11: Creating a level with the 20 Shape Editor

1. Open the 20 Shape Editor.

2. Choo:.;,__ Ldil ;.. Grid 0> 6-4 from Ihe

menu to set th current grid Size to 64
units per grid space. With the setting
thiS high. making a level !<lrge enough

for you 10 navigate .... 111 be easier.

3. Using the skills you have learned so
far, create a shape simIlar to the one
in FIGURE 4.51. You can deVIate
from thiS example il you want, but tTy

10 have at Icast one curved wall. In

this example, the Bezle; segments'

delall level is set to 4.

4. WIlen you're satisfied with the shape
of your floor plan, choose Fire> Save
from the menu. Save the Shape as

level.2ds and click OK.
FIGURE 4.51 Level shape.

Unlike revolving a shape, when you'Je extruding 8

shape, ltIe Z-axis points upward.

5. Next, you extrude the Shape to create

a 3D brush. Click the Extrude bunon
on lhe 20 Snape EdiIOr'S lcolbar. and
sel the following annblJtes:

Depth: 256

A:xis: AXIS_Z

NOTE - -



The 20 Shape Editor
- - - -- - - - ---

6. Select a texture, subtract the brush, and place a few lights. FIGURE 4.52 shows an
example of where the lights have been placed.

FIGURE 4.52 Light positions in the level.

7. Rebuild and play-test the new level.

END TUTORIAL 4.11

Although this method of level creation is fast, notice in the Top view that it results in some

strange BSP cuts. This problem isn't serious in this example, but it could become severe with a

more complex shape. Keep in mind that this method is best suited for prototyping a level quickly

rather than making a large series of aligned brushes.

Pillars

137

The 2D Shape Editor really shines in creating

objects stich as pillars. With its Bezief con

trols, you can create beautiful columnar

shapes that can be revolved easily. In this

example, you create some pillars to place in

the trapezoid21 room you <.reated at the end

of the level.

NOTE
As mentioned at the beginning of this section, static
meshes have almost completely replaced the 20
Shape Editor. When addIng decorations such as pillars
to your level, using static meshes is far more efficient
than SSP brushes. For more information on how to
create static meshes, lurn to Chapter 2O. "Slatic
Meshes."
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TUTORIAL 4.12: Creating a Column

1. Open the 20 Shape Editor, and set the

grid size to 16.

2. Create a half-column shape similar to the

one shown in FIGURE 4.53. Remember

that your room is 256 units tall. and con·

struct your shape accordingly.

3. When finished. save your shape as
p lllar , 2ds.

4. Revolve the shape using the follOWing

settmgs:

Sides: 12

SidesPer360: 12

AXIS: Y_Axis

5. Add the brush to your level, making sure

you align it with the floor and ceilmg (see

FIGURE 4.54).

FIGURE 4.53 Column shape.

FIGURE 4.54 30 view of pillar.

6. Rebuild and test the map.

7. When you're finished, eXit Unreal. and save the map as TestMap1.

END TUTORIAL 4.12
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Brush Solidity
Earlier in chis chapter, you learned about the impor/allce. of BSP and BSP CUll;, Now iI's time (0

see how brush solidity On ,If(ect your level's SSP cuts, (n Unrc31, brushes (nn be created wilh

three different level.. of solidi ty: Sohd, Semi -$olld, :lnd Non-Solid. The folJol"ing sections explain

thes.: sDlidity levels and hoI\' Ihc)' ;!ffcCl the makeup of your maps. Each brush Iype is avnilable as

a Spf'Cial brush, Ivhieh you can add by clicking the Add Special DUIlOfl, For more information Ofl

lhe Special brushe-s not men,iMed here, refer to Appendix A,

Solid Brushes

Solid urw/'es arc the standard brush used iu UllIe.1J. If you have been doing lhe lutorials in this

book up 10 this pL.inl, y()U have used nothing bUI Solid brushes. Solid brushes h;lVe Ihe following

main propenies:

• $C\ud brushes blnck pl:Jyers and projeCliles In the game. This means you can'l run lluough

them or shoot through Ihem.

• Solid brushes can he addilive or subtractive.

• Solid brushes create BSP cuts in their surround i J1g world geometry.

O( Ihc ,hree propenies, me third is the most important. When you place.a Solid brush )nlO a level

so Ihilt it's louching aDother Solid brush, both bruslles exhibit BSP I:ULs. Take a look at an exam

ple of lhi~ phenomenon in (he follOWIng lutona!.

TUTORIAL 4.13: Creating BSP Cuts with Solid Brushes
. ---------------------

1.. Start a new level by choosing File" New from the UnrealEd mam m~nu.

2. Create a 256x256x256 cube, ar.d subtract it from the world, Add a light (or good
measure, and rebuild the level.

3. Switch to Zone/Portal mode il'o tne 3D viewport (keyboard shOl1.C<.Jt: Aht-2). lhls mode

shOws you all the BSP cUls In your level. At the time o( Ihls wrillng, BSP Cuts mode is
non(unctlMal, so you must use Zone/Portal mode to view cuts jn your SSP.

Take a moment to look 8mund the room in the 3D viewpon (see FIGURE 4.66), Nolice

that each (ace of the room IS a COI1SlSlenl shade of blue, which indicates that lhese (aces

currefllly have no SSP cuts.

4. Create B new cube wlt:h dimenSions 128x128x128, and align II wilh the n()()( in lhe Side
viewport. Add It to your level. Although the effecl is Immediate, go ahead and rebuIld your

geometry

NotICe thai the room's noor now has dlSllnct diVIsions With different shades o( blue (see

FIGURE 4.56). These divisions are BSP cuts in your (evel's world gMmetry. For this

cube, they are rathe, minor, Take 8 look al what happens In 'he next slep when you add a

mOle complex shape.
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FIGURE 4.55 3D view in Zone/Portal mode of the subtracted cube.

FIGURE 4.56 The floor shows the di....isions because of the SSP cuts.



Brush Solidity l41

5. Select the added cube brush and delete It- In Its place, add a cylmder with the following

settings:

Height: 128

OuterRadius: 32

Sides: 12

NOTE
Make sure the cylinder Is aligned with the ground.

6. As soon as you add the brush, you'll see the pattern of cuts created on the level's floor. In

the Top viewport. select this <Iddltlve brush, and move it to one side of the level. Duplicate
the cylinder, and move the duplicate to the opposite side o( the level.

7. Rebuild your geometry, and look iJt the complex cuts cre<.lted on the floor of your level (see
FIOURE 4.57).

FIGURE 4.57 Pattern of cuts caused by the two cylinders.

8. Save your scene when finished.

END TUTORIAL 4.13

These Cllis are adding precious calculation time to your level without helping to add any physi

cal detail. To keep your levels as efficient as possible, you want to avoid this problem by using a

Semi -Sol id brush, di~cuss~d in the next sen ion.
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Seml-5olld Brushes

With Semi-Solid brushes, you on place brushes into a level wirhout adding any BSP cuts to the
surrounding world geometry. This is a tremendous benefit when adding decorations to your lev
els, such as pillars, beams, Jnd light fIXtures. The following is a list of the key attributes of Semi

solid brushes:

• Semi-Solid brushes block players and projectiles, just as Solid brushes do.

.. Semi-Solids (dn only be additive, never subtractive.

.. Semi-Solids don't lcave BSP cuts in their surrounding world geometry.

4

The following tutorial shows you an example of how these brushes affecl their surrounding envi
ronment. In this example, you add a pair of cylinders to a cube room, as you did in the previous

tutorial.

TUTORIAL 4.14: Using Semi-Solid Brushes

• fJo9<
Pr.r. IR.g..W~MI1 :::J~'F.:;;;=:=~=;j
r Af/W<iOt!l s~

r POlloi r Sdid

r '.111'" r. SeaS'oI<J
r IrMltlo Ir Non-5~
r r"",sldooj

Height: 128

OuterRadius: 32

Sides: 12

1. Open the level you saved at the end of Tutorial 4.13, and delete the two cylinders. If you
don't have this level, create a 256><256><256 cube, select a texture, and subtract the cube
from the level. Add a light and rebuild your geometry.

2. Create a cylinder with the following
settings:

FIGURE 4_58 The Add Special dialog box.3. Align the cylinder with the floor, and

click the Add SpeCial button.

4. In the Add SpeCial dialog box shown in FIGURE 4.58, select the Semi-Solid option
button, and click OK.

5. Change the 3D viewport mode to Zone/Portal, and notice there are no SSP cuts on the
noor of your level (see FIGURE 4.59)_

6. Save your level.



NOTE
Be careful not to let your Semi-Solid brushes overlap
or touell other semi-Solid or Non-Solid brushes, as
BSP errors could result.

Brush Solidity IA3

FIGURE 4.59 No cuts were made because a Semi-Solid brush was used.

END TUTORIAL 4.14

Because Semi·Solid brushes don't disturb their surrounding world geometry, they are perfect for
decorative additions \0 yOClf level. However, you should be careful that you don't use them to
replace static meshes, For eX<lmple, say you need il room lined wIth columns, You could make a
pillar with lhe 2D Shape Editor as you did earlier in thIs chapter, and Ihen make a series of SemI
Solid brushes from it. However, creating the
piilar ip. an external 3D package and import
ing it as a static mesh is f2f more efficient.

Non-5olid Brushes

With Non-Solid brushes, you can crealt' It'W'l geometry that bc'hal't's similarly to .\ hologram. A
player can see iI, but ran't collide with it. Non-Solids lan be used anywhere you need to see geom
etry, but not touch it. Their practical uses 2r(' sllght Iy limited {or aesthetic purposes, but they are
used heavily when oplimizing your level. Anti-portals and level optimization are disclJssed in
Chapter 15, "Level Optimization (Zoning) and Distribution."

On th" other hand, you can use Non-Solid brushes to make devious traps and hidden passages.
When you rebuild a Non-Solid, it still creates a light map. During gameplay, your Non-Solid
brush is indistinguishable from Solid brushes until a player rurlS into it or tries to shoot it. The

following tutorial shows you an exampie.
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TUTORIAL 4.15: Using Non-Solid Brushes

1, Opell the level saved at the end of Tutorial 4,14, and delete the cylinder. If you don't have
this level, create a 256x256x256 cube. select a texture, and subtract the cube from the
level. Adr1 a light, and rebuild your geometry,

2, Create a cylinder With the following settings:

l'leight: 128

OuterRadius: 32

Sides: 12

3. Align the cylinder with the floor. aM click the Add Special button.

4. in the Add Special dialog box. select the Non-Solid option button, and click OK.

5, First. notice that the floor stili has no SSP cuts. Rebuild the level. add a Player Start Actor,
and test it out by trying to run Into the cylinder.

END TUTORiAl 4.15

The cylinder looks normal, but yOll can't colJid~' with it, nor can your projectiles bounce off it.

Non-Solid brushes are a great way to hide objects and passages in your levels.

Saving Brushes (u3d Files)

U$ing the techniques explained so far in this chapter, you can create BSP brushes that you want
to save for later use. Underthe Brush menu of UnrealEd's main menu, you'll find the Open Brush
and Save Brush As commands.

TUTORIAL 4.16: Saving Brushes

1. Open the 2D Shape Editor, and open the plllar .2ds file you saved II) Tutorial 4,12. If you
don't have thiS file, Simply create an interesti~g shape of your own.

2. Revolve the shape to create a pillar·like brush.

3, With the Builder brUsh selected (it should currently look like a p!ltar), choose Brush> Save
Brush As from UnrealEd's main menu_

4. Save the brush as pillarBrush, u3d. and click OK.

5. Click the Cube primitive to change the Builder brush into a cube.
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6. From the main menu, choose Brush> Open Brush. Click the pilla rBrush. u3d file you
just saved, and click Open. Notice that the Builder brush transforms back into your original
pillar shape.

This technique is quite useful when you want to create archives of your most frequently used
brushes.

END TUTORIAL 4.16

Importing;Exporting Brushes
At times, you might want to edit a brush you have made in UnrealEd with an external 3D pack

age. Alternatively, you might need to import an object that yOll modeled in a 3D package into

UnrealEd. You can do this with UnreaJEd's Import and Export brush functionality. These import

and export processes have been demonstrated in the following tutorial, assuming that you don't

have a 3D package at your disposal.

TUTORIAL 4.17: Importing and Exporting Brushes

1. Open the pillarBrush. u3d file saved in Tutorial 4,16.

5. From the main menu, choose Brush> Import, and select the pillarExport file you just
created Click Open, and click OK in the Import Brush dialog box. Watch the Builder brush
change back into a pillar.

rNOTE

I
The available import types are t3d, dxf, asc, and ase.
The available export types are t3d and obj.

2. With the brush selected, choose Brush> Export from the UnrealEd main menu.

3. Save the brush as plllarExport. t3d.
Be sure to change the file type to the

t3d format.

4. Click the Cube primitIve to change the
Builder brush into a cube.

END TUTORIAL 4.17

Summary
This chapter has covered the theory behind BSP and explained several techniques you can use to

make your levels more efficient, You have learned several methods for creating specially shaped

brushes to add more detail to your levels, especially if you do not have access to static meshes. You

should now be ready to create a variety of different environments while making the most out of

the different brushes. Practice the tutorials in this chapter so that you can more easily identify

which brush to use in different situations. Remember that brushes form the foundation of your

levels, and the more you know about how to use them, the more efficient your levels wiJl be.





Cha ter

Terrain

Thus far, the content of this book has focused on the construction

ot interior-based, or indoor levels. The Unreal Engine, however,

does not restrict you to having only tightly endosed levels. In fact,

many of today's hottest Unreal· based games, including UT2004,

also cover vast landscClpes. In this chapter, we will discuss UnrealEd's

powerful terrain generation system, and how it can be used to cre

at/' your own open- ranged landscap~s, both native and alien.

We will begin with a general discussion of exactly what terrain is,

induc.ling the compolJ~nts involved in its creation. We wlll then look

at tJ,e Terrain Editing dialog, which encompasses the suite of tools

us('d for working with terrain. When you have a basic understand

ing of terrain and the tools used to develop it, we willlTlove on to a

series of tutorials, which will take you through creation of your own

terrains. We will discuss how these terrains can be edited with

UnrealEd's conventional system. From there, we wiU begin painting

textures on our terrain, in order to give the look of dirt, rock, and

grasses. We willthf:o demonstrate how you can use decoration lay
ers to enhance the look of your terrains by adding decorations such

as trees, grasses, rocks, or any static mesh object.
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What Is Terrain?
By definition, terrain is.1n area of land or a parlicular geographic area. Within UnrcalEd, this is
really only (he beg(nnin~, as Ihere are sevcral componenls lnal <Ill come together 10 generale the
landscape you see in-game, Al ilS hearl, lerrain i5 a highly lesseJlaled pie(c of geomctry. meaning
tha I it is ma de up 0 f hund reds if not Ibousands of p<llygons. Th e gc 0 met ry's shape is dri lie n by J

height map, More speclncally, lhe Z-axis location of each of Ihe gC6mei ry's veri ices is detined by
either an 8· or 16-bil grayscale image.
Darker shades will define lower elevations
of the Icrrai n, whereas brighta shade-s will
create higher elevalions. rn FIGURE 5.1,

you see a simpllCied height map,

dem6nstraling ho\v li ght aod dark areas FIG URE5.1 2D Texture used as a height map,
can denne eleva I ions,

The Components of Terrain
As mentioned earlier, (errai n consists of several components. In this seclion, we wi II loJ ke a close

look at each of «he AClors required to create terrain and how the di((erenl ..&Sels of Ihe game .are
used in conj unct io n wilh Inese Actors to give us rich Ian dsc.apes for uS<: in ou r levels.

Terrsin Zoning with the Zonelnfo Actor

The (i rsl C6m pone nt required is Ihe ZoneInfo Aclor. This AGlor i,~ w.ponsible for dell nlng, or 20n·

lng, lne area in which lenai n can ex.isL If you \\Iere 10 altempl (0 acate terrain in an area Iha.l had
nOl been properly zoned, you \liQuId not see il OIl aU. \.Vhen adding lhe Zoneln{o Actor into sub·
tracled space, aII connect ing subtraclions win also be co nSldered zoned. Th is allows our lerrain
10 OO\\' Ihrough multiple subtracted spaces Ihal are aD canne<:lcd togethcr without using mwti·
pie Zone! n(o AClors.

With lhe Zonelnfo AClor, only a single properly adjuslmen.( is required (or lerrain 16 eDsI: Ihe

bTerr21n property, Selling Ibis properl)' 10 True creales a zone rh.al is condilioned 10 con lain and
re ndcr {errai n,

The Zondn(o Actor offers a few (eatures thaI work well when designing outdoor scenes, One o(

the mOSI importanl (ealUf(~-S is the ability to creale and conlrol distance fog. Allhoul}1. there are
many things to underSland alxlut zones, not every aspecl of the Actor will be discus,~ed in This
chaple r, Rather, we wlll focus only on those propcflies Iha tare peninen I to terrai n an d landscape
crl.'a IIon , uter in the book, we C6ver in greater detail the concepts behind roning as well as the
bendlts of proper loning.



Using the Terrainlnfo Actor

After the ZoneInfo Actor has been added to the level, the designer can proceed with the creation

of the terrain. Generating the terrain geometry is done through the TerrainInfo Actor. It is this

Actor that references the various texture maps used to define the way the terrain will look. The

Actor also houses all of the properties used to define specific attributes of the terrain that will be

rendered at runtime. One can easily say that the Terrainlnfo Actor is the heart of the terrain sys

tem. Multiple Terrainlnfo Actors can be added into a level, even into the same zone. This can be

helpful in creating effects like a cave-type ceiling above the ground, in which you would need one

terrain object to act as the cave floor, and another to form the ceiling.

The textures used by the Terrainlnfo Actor can be divided into three categories: the Height Map

and Layer textures, and DecoLayer textures.

Controlling Terrain with the Height Map

The Height Map texture is arguably the most important texture, as it is used to define the eleva

tion and (ontom of the terrain through the variation of grayscale colors. As mentioned earlier,

dark areas of the height map will create valleys, whereas lighter areas will become hills. It should

be noted, however, that this system works on a pixel-to-vertex level, meaning that the color of a

single pixel will change the height of one vertex on the terrain's geometry. Without a height map,

the rendering engine would not be able to draw the terrain at all. Conversely, using a height map

of a single solid color would result in a flat terratD, as there would be no differentiation to cause

elevation changes.

When creating a height map externally, one important thing to keep in mind is the final file for

mat in whtch the texture will be saved. Three formats are accepted by the terrain system:

~ 8-bit grayscale

~ 16-bit grayscale-The map type generated by UnrealEd

• The Alpha channel of a 32-bit image

If you plan on using the Terrain Editing dialog to interactively paint the textures used to drive the

height, you will need to use the G16 format. This is not a problem when the texture is created

from the Terrain Editing dialog, but importing textures from other applications requires a bit

more planning. If the format is not G16, the editing tools will not function.

Height ma ps play another important role with terrain; they determine the terrain's physical

dimensions in X and Y. There is a formula that can be used to find what the size will be:

Resolution X * Terrain Scale X - Terrain Scale X

Resolution Y * Terrain Scale Y - Terrain Scale Y
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The default scale for a terrain is 64 in all axes. Therefore a height map of J28 x 128 would result

in the following:

Width: 128 *' 64 - 64 = 8128

Breadth: 128 • 64 - 64 '" 8128

Although this equation may seem strange in that the terrain sGlle is subtracted after the resolu
tion and scale are multiplied. this is how the terrain generation system will internally calculate the
size of your terrai II.

Layers

~
1

•
1

•

--

Layers blend to form the final terrain.

D

ROB

NOTE
About the lijyer's (Ilpha format The actual textu re
Information for the alpha is an S·bit graySCale image.
This can be by itself as a PB texture, or the alpha chan
nel of an RGBA8 texture. The Terrain Editing dialog will
create an RGBA8.

FIGURE 5.2

Although the height map determines the shape of the lerrain. it does not have any effect on the

terrain's surface appearance, such as its color. Control of tbe visual aspects of terrain is handled

by layers, which provide the look of dirt,

rock. grass, and so on. The TerrainInfo
Altor ca[l have a maximum of 32 layers,

each with its own texture, assigned to the
terrain. Each layer in the Terrainlnfo Actor
contains two texture maps, the first being

the color map that will be: visible on the
surface. and the second being an alpha
map, which controls the transparency and
blending from one texture to another. As

textures are added, they are stacked on top

of one another. If the alpha map associated

with the new layer added is completely

white, nothing below that layer is visible.

Alpha maps control how textures blend
togethn from layer to l<lyer.

\\'hen defining a new layer from the
Terrain Editing dialog, two things happen:
First, a seleued texture is assigned to sup·
ply the layer with color. Second, a new tex

lure is created in which all color
information will be ignored, and which
wiJI only be used for its alpha channel.lt is
this alpha channel that will determine how
llle created. layer blends with the Silbsc
quent layers beneath it (see FIGURE 5.2).

5



DecoLayers

Finally, lhl' decoration layer (DecoLayer)

textures are used to drive the placement

oC decoration objects on the terrain,

such a~ blades of grass, trees, and shrubs.

These objtcls will consist of static

meshes, whose physica.l and location

data will be based on a series of texture

m:lps. There are three types of texture

maps associated with a Decolayer: the

denslty map. the coJor map, and the

scale rnJp. We will cover how each of

these components is used to drive the

decorations "cross the terrain Jater in
this chapter. FIGURE 5.3 shows how

each of thl'se rnaps is used to control the
density, color, and scale of the static

meshes used within the DecoLaycr.

Col",

Layers

-
1

~
1

~.
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FIGURE 5.3 The construction of a Decolayer.

Altering Terrain with the Terrain Editing Dialog
As mentioned before, textures playa large role in the creation of terrain. from defining our ter

rain's physical contours to controlling how the visible surface textures such as dirt, grass, and rock

blend together to give the final look. We also usc textures to define the location and density of ter
ra in decorations such as trees, shrubs, rocks, and S0 on.

You can go about the creatio!l and manipulation of these lex.tures in two ways; by the Ilse of exter·

nal painting applications such as Photoshop and Paint Shop Pro. or through UnrealEd's built-in

T('rrain Editing dialog, Allhough it is possibie to create all of your terrain without the use of the

editor, the process is not nearly dS intuitlve, as you will not see the results of your work immedi

ately. In order to expedite the terrain creation process, the Terrain Editing dialog provides a suite

of lools lhat mJl<e creating, selecting. and painting these textures both fast and easy. Without

these tools, ~he level designers would find themselves repeatedly jumping from their painting

appliG3tion into UnrealEd, in order to view any tweaks or changes made to their textures.

The Terrain Editing dialog provides four primary functions:

~ Creation and fl'IJnipuJalion of height maps

~ Assignment and blending control of texture layers

~ Assignment and manipulation of DecoLayers

~ Automatic terrain generation
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FIGURE 5.4 shows the Terrain Editing

dialog, which you can access by

clicking the Terrain Editing icon from

the toolbox.

The dialog is divided into two key areas:

Tools ilnd Miscellaneous. In the Tools

panel, we have lIccess to a suite of tools

used for terrain editing as well as a way

to control which textures we are editing,

whether they are for the height map, one

of the texture layers, or DecoLayers. The

Miscellaneous panel provides a me.:!ns

(or automatic terrain generation.
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FIGURE 5.4 Terrain Editing dialog.
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Throughout this chapter. we will explore aU of the features and tools available in the Terrain Editing

dialog. We wiU also take a look at creating terrain without this editor, using Adobe Photoshop.

In TUTORIALS 5.1 and 5.2, we will walk you through the steps required 10 create simple ter

rain. Vve wiU begin with the crealion of a large room. From there we will add the Zonelnfo Actor

and de<;ignate the room as a place where terrain can exist. \Vhen the room has been properly
flagged to allow terrain, we will then use the Terrain Editing tools to create a simple flat surface.

TUTORIAL 5.1: Preparing an Area for Terrain

1. In UnrealEd, start a new level and
load the Ch5_Terram texture pack

age into tne Texture browser.

~. Select the MossWalis texture.

3. Subtract a cube with the following
dimensions:

Height: 4096

Width: 8128

Breadth: 8128

4. From the Actor Class browser,
choose Actor> Info> Zonelnfo (see
FIGURE 5.5).

5. In the Top viewport, (ight-cllck near
the middle of the level and select
Add Zonelnfo Here from the context
menu (see FIGURE 5.6)_
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FIGURE 5.5 Zonelnfo selected in the Actor Class
browser.
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6. Open the Properties dialog for the Zonelnfo by double-clicking the Actors icon.

7. In the Zonelnfo property section. set bTerrainZone to True (see FIGURE 5.7).

8. Save your map.

FIGU RE 5.6 The Zonelnfo ieDn prepares the zone
to handle terrain.

END TUTORIAL 5.1

.~

FIGURE 5.7 Setting the bTerrainZone
property of the Zonelnfo Actor.

You now have a zone that has been conditioned to render terrain. You will not see the terrain at

this point as it has yet to be created. In TUTORIAL 5.2, we will see how a Terrainlnfo Actor is

llsed to create the terrain.

We will creatl' two imponant components of terrain: the Terrainlnfo A<.tor and its associated

height map. As mentioned previously, there are two ways to go about this; you can create the

Terr2inlnfo Actor manually through the Actor Class browser and then assign a height map that

you created in Photoshop, or you can use the Terrain Editing dialog to create both the Actor and

map in a single step. In TUTORIAL 5.2, we wiU use the Terrain Editing dialog.

TUTORIAL 5.2: Creating a Basic Terrain Using the Terrain Editing Dialog

1. Open the file saved in TUTORIAL 5.1. ContinUing from where we left oN, switch to TerraIn
Editing mode by clicking the Terrain it-on II in the toolbox. This WIll open the Terrain
Editing aialog (see FIGURE 5.8).

2. Click the New button [Q] located in the lower-left corner of the Terrain Editmg dialog.
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FIGURE 5.8 Terrain Editing dialog showing no
height map.

FIGU RE 5.9 New Terrain dialog allows you to set
parameters for your terrain.

FIG URE 5.10 Terrain Editing dialog after creating
the new terrain.
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3. In the New Terrain dialog, set the
following parameters (see
FIGURE 5.9):

Package: mylevel

Group: Heightmaps

Name: Heightmapl

XSize: 128

YSize: 128

Click OK. Two things are created:
the Terrainlnfo Actor and the associ-
ated height map. The new height
map has a resolution of 128 x 128
pixels and is being stored within the
level. FIGURE 5.10 shows how the
Terrain Editing dialog will appear
once you have completed this step.

4. With the exception of the Terrainlnfo
Actor appeanng in the viewport. it
appears that nothing has happened.
Rebuild the level. The level should
go dark because there are no lights
in the scene. In the 3D viewport.
switch to the Textured view (flO

lighting) by cliCking the 1.1 Icon.

5. In the 3D viewport. you wIll notice
that a new type of cursor moves
under your mouse. This is the
Terrain Editing tool. At the moment
you cannot see any terrain. This is
because we must have at least one
texture layer created. Without a tex-
ture, the terrain appears Invisible.

6. In the Texture browser, select the
Dirt texture.

7. In the Terrain Editing dialog, make
sure Heightmap1 is selected (it will
be highlighted with a dull green) and
then click the layers tab,

8. Select the first Undefined slot (see
FIGURE 5.11); you will see a small
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FiGURE 5.12 New Layer dialog.

FIGU RE 5.11 First Undefined slot selected.

Click OK.

highlight appear around the unde

fined layer when you select It.

9. Click the New button, [n the New

Layer properties dialog. set the fol
lowing settings (see FIGURE 5.12):

Package: rnyLevel

Group: TerrainLayers

Name: OirtLayerl

AlphaHeight: 128

AlphaWidth: 128

AlphaFill: Set the color to white.

UScale: 8

VScale: 8

10. You have now created basic terrain
(see FIGURE 5.13). OtMously, it is

not the most exciting landscape in the

world. but you can add a player start

and a light or two, and then rebuild

and run the game. You'd have no prob

lem running around on the terrain.

FIGURE 5.13 You can now see the terrain with the dirt texture applied.

END TUTORIAL 5.2
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Now that we have terrain in our level, it's time to see if we can make il a little more visually interest
ing. To give the terrain a more appealing look, we will need to vary its altitude. This is done by edit

ing the height map_ There are two main ways that we can go about this; we can either use the tools in
the Terrain Editing dialog, or we can use the Terrain Generation feature that is built into the editor.

The Terrain Generator is a great way to quickly create randomized terrain. Although the terrain's
contour is rdndom, the designer does have a level of control over what is generated. The Select tool

can be used to specify a certain area to randomize, or you can simply have the generator ran
domize the entire terrain plane. Furthermore, control over the peaks and valleys is provided
through the Steps and Strength settings. In its simplest form, you can think of Steps as a way to
control the number of hills, whereas the Strength setting controls the magnitude, or steepness, of

the hills being generated. Higher Strength values will produce steeper hills, whereas lower values

can be used 10 produce more of a rolling hills effect.

In TUTORIAL 5.3, you will use the Terrain Generator to give you a quick starting point with your
terrain.

TUTORIAL 5.3: Using the Terrain Generator

;..:--;--:- • ~ (.l ,t"OIi.
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FIGURE 5.15 Terrain Generation section.

FIGURE 5.14 The Select tool selected from the
Tools list.

2. Make sure you are still lr\ Terrain
Editing mode and select the Select
tool (see FIGURE S.14}. You are
not required to use this tool, but it
must be selected before the Terrain
Generator Will work.

3. Highlight the Helghtmap and click

the Mise tab al the top of the
dialog.

4. Set the follOWing options in the
Terrain Generation section (see
FIGURE 5.15):

Steps: 5

Strength: 40

Check the Use Entire Heightmap
option.

1, You can continue from the end of
the last tutorial, or open the file
Tutoria15 03 Start.ut~

5
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s. Click Build. Your terrain will now
have a random set of hills and val·
leys, as shown In FIGURE 6.16.

8. Conlinue to adjust the Steps and
Strength settings and rebuild the ter·
rain until you achieve an interesting
look.

7. Save the map.

FIGURE 5.16 Wireframe view of the results from
the Terrain Generator.

END TUTORIAL 5.3

Lighting Terrains with Sunlight
vl/hm you are creating terrain, lighting plays an important role in making things look realistic.
Without shadowing, varying elevations of your terrain wiJJ be difficult to distinguish. Here you

see our current level, and it is very hJrd to make oul what is going on. To correct this, we will add

a Sunlight Acror.

Until now we have only worked with lights lhat appear to come from a specific point in space,
such as the standard Light Actor. If we were to light our terrain with this approach, it would be
difficult to simulate the rype of light effects one ~ees when outdoors. In Ihe real world. our sun
(and moon fOf thaI mattrr) is so large and so far away that by thf' lime the light reaches us. the
light rays appear to be parallel to one another. Think about it-the next time you are standing in

a parking lot during the day, look at the shadows cast by the light posts. Even though the light
posts are separated by some distance, their shadows are all pointing in the same direction, mean

ing that they are in paralJel to one anolher.

In Unreal, we can reproduce this effect with the Sunlight A,ctor. This Actor wiH produce parallel

rays of light appearing to come from infinitely far away. The effect is very similar to the lighting
effect provided by the sun on a clear day. In TUTORIAL 5.4, we will lake a look at how 10 set up
a Sunlight Actor as well as how to make it illuminate our rather washed-alit landscape.

TUTORIAL 5.4: Adding Sunlight

1. You can continue from the end of the la5t tutOrial. or open the file
Tutoria15_04_Start.ut2.

2. In the Aclor Class browser, choose Actor> light> Sunlight.

3. In the 3D viewport. rlght-elick on the cedil1g of your level al1d select Add Sunlight Here from
the context menu (see FIGURE 6.17).
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4. Rebuild the level and switch the 30

viewport bac\< to the Dynamic

Lighting mOde so lhat you can see
the effects 01 the light on the ter

rain. After you have done this. you
will notice lhal everything is black: it

appear~ that the light had no eHect

at all. Remember, Ihis type of lii!hr
is not emihed from the point 01 the

Actor. To make the light work prop

erly. we will need to nag the ceiling

as a Fake Backdrop. This will cause
the light to appear (1S if it were Cl>ffi

jng in through the c i1ing of the

level.

FIGURE 6.17 Sunlight Actor plate(1 in the
level. The sunlight is viewed without the textured
background to make it easiel to SC!e,

IPoniIlcllS~1 ~I sw. I
r
rT....
rs u
ru

FIGURE 6.18 Set tile Fake Backdrop option in
the Surface Properties dialog.

FIGURE 5.19 The terrain has a much more
natural feel after the Sunlight Actor is added.

7. Click the Lock 10 Selecled AClor
icon In the 3D viewport. Clic~

the Sunlight Actor in the 3D view.

The camera has now been snapped

to the sunlight, and ClS you
move/rotate your camera VIew in

the 3D viewport, It Will move/rotate
the sunlight w,th you. Because the
light seems to originate from infi
nitely far <May. the location of the

Sunlighl Actor is irrelevant. All you
will need to do is find the best rOla·

lion of the light. You will neeCl 10

rebuild the lighting 10 see the
effects of the new onentatlon. When

you ale satisfied with the placement

Ii. In your 3D viewpolt. select the cell·

il'lg. Press F5 to open the Surface
Properlu~s dialog (s e FIGURE
6.18). Check the Fake Backdrop

option and close the dialog.

8. Rebuild the level once mOle. This

time YOll should see light some·
where. Most likely you will need to
orient the hgllt. This can be done
quickly by using the LOCk to
Selected Actor mode.

5



of the sunlight, click the Lock to
Selected Actor icon again to release
the light's constraint. FIGURE 5.19
shows the result of the Sunlight Actor
on the terrain's surface.

END TUTORIAL 5.4

L1~htlng Terrains with Sunlight

TIP
You may find it necessary to open the properties for
the sunlight and set light Brightness to a higher value,
such as 100. This will boost the contrast between the
areas of light and shadow.
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You will notice that light does not reach all of the terrain. The only way to make this happen

through manipulation of the light's orientation would be to point it straight down, which

would result in a sort of high-noon effect, eliminating virtually all of our terrain's shadows.

Instead, we will later turn the side walls into fake backdrops as well. This will create a much bet

ter distribution of light. However, we still have a small problem. Our terrain appears to be lit

by a Slln, and yet it exists indoors. To make the level appear more realistic, we will need a sky'

from which our sunlight can shine. In the next section, we will take a look at how we can cre

ate a sky for our level.

The Skybox
With the ability to create vast outdoor areas with terrain, we must naturally be able to compli

ment them with realistic-looking skies. Without a sky, we would simply have an outdoor area

that was enclosed in a box, which would obviously look out of place. Unfortunately, the sub

tractive nature of the Unreal Engine prevents us from making infinitely open skies. We can,

however, fake the effect of an open sky using what is called a skybox. 10 this next section we are

. going to take a look at skyboxes, the setups used to create the illusion of open skies. We will

begin with a discussion of what a skybox is and how it works. From there we will move into a

tutorial that will step you through adding a skybox: to our terrain level.

What Are Skyboxes?

A skybox is nothing mOTe than subtracted space (generally a box) that is separated from the rest

of the level. The objective of the skybox is to create the illusion of objects, such as douds, suns,

moons, and so on, off in the far distance. The illusion that these objects are so far away becomes

apparent as you navigate around the level. The objects viewed in the skybox look stationary, sim

ilar to the way stars seem to stay stiU as you drive around in a car. Skyboxes are great for creating

cloudy skies, night scenes, or even futuristic space scenes.
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A skybox can be set up in various ways,

depending on the workflow preferred by
the level designer or dependent on a spe
cific look that yOll arc trying to achieve (see
FIGURE 5.20). The most common sky
box is the shape of a box, but occasionally
you wiJJ find cylinders and even spheres
used to house the sky environment.

How Does a Skybox Work?

As mentioned earlier. a skybox is an area

subtracted from the level that is isolated
FIGURE 5.20 Skybox example.

from the rest of the map. So, how does a
player see this sky if it is completely separated from the level? This is done through the use of a
SkyZoneInfo Actor, which must be added near the center of the skybox. This Actor is responsible for
causing the skybox to render around the entire level. Of course by default the players would not see

5 the walls of the skybox because the level walls are blocking their view, and the skybox itself is detached
from thl' levl'1. 811t, with UnrealEd, we h;1ve the ability to flag a wall 3S a "fake backdrop." Doing this
caIlses the rend ering engine to not render th is wall. If the waU is not rendered, we will see the skybox.

An interesting way to visualize this is to picture your entire level fitting into the SkyZoneInfo Actor.
This would result in the skybox completely encompassing the level. Any surface flagged as a fake
backdrop would not render, resulting in the player seeing out into the skybox. In our case, the ceil
ing was previously flagged as a fake backdrop so that we could have our sunlight illuminate our level
from that surface. But after we add a skybox into the level, we will no longer see the texture on our
ceiling. Instead, that surface will basically vanish, resulting in the player seeing out into the skybox.
Because the SkyZonelnfo is a stationary Actor, when the player moves, the sky remains in place, giv
ing tbe illusion that it is quite vast and some distance away, which is exaclly the effect we're chasing.

Throughout the design of a level, textures play an enormous role. This is no different with skyboxes.

Skyboxes can be textured with any image you see fit, in order to give the visual effect you are after.
In most cases. you will find some sort of open sky or ollter space texture. Working with textures on
a skybox, however, can be a bit tricky. Jf the skybox is not properly textured, seams can result, mean
ing that the player would be able to see that the sky was actually a large box overhead. This quickJy

breaks the illusion of a massive skyline. Numerous methods have been developed to help keep the
seams from showing. The following are some of the more common methods employed;

~ Create five leXLUres that fit together seamlessly on a box (see FIGURE 5.21). The sixth
texture (the floor texture) is not necessary in most cases JS the players should never see
the floor of the skybox (otherwise, they'd have to see through the ground). After applying
these textures to the skybox, the designer carefully aligns the textures so that the transi
tion from surface to surface is seamless.
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II
FIGURE 5.21 The Inside of a skybox, along with the six images used to decorate the sides of the
skybox cube.

• A cylindl'r static mesh is used to surround the SkyZonelnto with J texture. The texture
applied to the cylinder is a gradient that is affecting transparency. This makes the sky

app<:.lr to be fading out, thereby fakIng the look of a distant horizon (see FIGURE 5.22).

.. Texture only the ceiling, and then surround the SkyZoneInfo with static mesh objects

such J$ mountains, buildings to create a cityscape, and so on (see FIGU R E 3.23). The
idea is that the plilyer should not be able to see the sides of the skybox.

FIGURE 5.22 The gradient of
transparency on the cylinder.

FIGURE 5.23 Static meshes of mountains or
cliffs can be placed in the skybox around the
Zonelnfo Actor to create the illusion that your level
is surrounded by massive and distant landforms.

.. Place a Terrainlnfo Actor in the skybox and create hills/mountains in such a way that the

outer walls are blocked by the terrain (see FIGURE 5.24). This is the approach we wiJl

be using in our tutorial.

.. Finally, and this method can be added with any of the other methods presented in this
Hst Enable diwlOce fog! By applying (og in the skybox, we can have the walls of the sky

box hidden by the fog (see FIGURE 5.25). This generally gives a nice result, and we will

also be using it in our tutorial.
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FIGURE 5.24 The result of placing a
Terrai nl nfo actor into the skybox, creati ng a
second terrain within the skybox. The effect is
like a large range of mountains surrounding
the level.

FIGURE 5.25 This figure shows how fog can
be used to obscure distant areas of the skybox,

5

Skyboxes can be further enhanced by using sheets textured with materials of panning clouds. This

provides the player with the illusion of a more dynamic environment as the skies are seen to move

above them. In TUTORIAL 5.5, we will add a skybox to our level.

TUTORIAL 5.5: Enhancing the Look of Our Terrain by Adding a Skybox

1. You may continue (rom the end of
the last tutorial, or you can open the
file TutorialS_0S_Start. ut2.

2. Open the Textures browser and
select the texture Skyl from the Sky
group.

3. Subtract a cube from the level that
is in no way connected to the area
you have been working on (see
FIGURE 5,26), Use the following

dimensions:

Height: 2048

Width: 4096

Breadth: 4096

FIGURE 5.26 The newly subtracted skybox.
Notice how it does flot connect with the main level.

4. Select all of the walls In the skybox With the exception of the ceiling.' Apply the texture
named Blac\< from the sky group (see FIGURE 5.27). ThiS setup will keep us from having
to deal with seams caused by misaligned textures.
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FIGU RE 5..27 The walls and the floor have been assigned Ule Black texture.

5. Select the ceiling surface and open the
Surface properties dialog (see
fiGURE 5.28). From the Alignment

tab. select Face aligrlment and set the
UTile and VTile options to 2. Click the
Align button.

TIP
You mey need 10 pan the lemJre If you are able to see
a visible seam due to tha WIng.

FIGURE 5.28 The sky text\Jre has been tiled twIce for a better appeafllnC8.
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8. Now it is time for us to add thB SkyZonelnfo Actor, Open the Actor Class browser and

choose Actor> Info> Zonelnfo > SkyZonelnfo. In the Top viewport. right·click in the center

of the SkybOx and add the Aclor. In the perspective viewport (or a side view). move the
SkyZonelnfo up so that it is approximately somewhere in the middle of Ihe box (see

FIGURE 5.29).

FIGURE 5.29 The SkyZonelnfo Actor has been added to the skybox.
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7. So that our players are able to see

the gkybox, we will need to light it.

After all, the box is completely sepa·

rate from our main level, 50 there is

no way for lighting to seep into it.
lighting can make or break a skyoox,
and the objective of this lesson is

not to turn you into an expert lighting
artist. Using the techniques you

learned in Chapter 3, "Creating Your

First Level With UnreaIEd," add about
eight lights to the skybox. The trick is FIGURE 5.30 The skybox after adding numerous
to space the lights out enough to ere- lights.

ate an evenly lit sky. Varying the color and brightness of the lights will result in a more

dynamiC and interesting sky. After adding the lights, do not forget to rebulkl geometry and
lights (see FIGURE 5.30),

8. In your perspective viewport, navigate back to the main area of the level (where your ter·

rain IS). At this point you will not see any of the skybox. Fortunately. we can see the

effects of a skybox without gOing into game. You can right-click on the toolbar across the
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perspective vleWf)ort and choose

View> Show Backdrop or yO\.1 could

use the hotkey K (see FIGURES
5.31 and 5.32).

9. Although we do have a functional

skybox, obviously the results are not

extremely convincing. We need to

devise a way of hiding the black

walls. In our case, we will use a
combination of two techniQues: dis

tance fog and a secondary terrain

system. Select the SkyZonelnfo

Actor and open its properties, Set

Zonelnfo> bOistanceFog to True.

Expand the ZoneLight property cate

gory and set the (oliowing settings:

DistanceFogColor (R: 125. G:

176, B: 185)

DistanceFogEno: 1575

OistanceFogStart: 400

You can also move the SkyZoneln(o

Actor closer to the ceiling in the sky·

box. This will also help Improve the

effect (see FIGURE 5.33).

FIGURE 5.31 The main level with Show
Backdrop turned off.

FIGURE 5.32 The main level with Show
Backdrop turned on.

FIGURE 5.33 The effects of the skybox after adding fog and adjusting the SkyZonelnfo Actor's
height.
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10. The skyboX is starting to take
shape, but what about the wdlls?
And we still have the hard shadows
created by two of the walls. Select
the four walls around your level and
flag them as Hike Backdrops Just as
you did with the ceiling, Rebuild the
leveL FIGURE 5.34 shows the
result.

11. Save your level.

END TUTORIAL 5.5
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FIGURE 5.34 The outerwalis have been flagged
as Fake Backdrops.

5

We are still left with the problem of seeing walls at the edges of OUt' level. Most often, you will find that
level designers will simply add some sort of obstruction to block the player from seeing the walls
housing the terrain. These objects can be cliff walls, rock piles, bu iJdi ngs, and 50 on. CJ refu] placement
of these objecl~ can do a great job of hiding the fact that lhe player is ill lhe outer edge of the leveL

With our level, we will use a similar approach, bUI inslead of using stalic meshes or textures to fake
an ongoing landscape, we wilJ use a secondary terrain that is placed in our skybox. For this to
work, we will need to make the remaining walls around our level into fake backdrops. By doing
this, we will not only create the illusion of our terrain going on inlo the distance, but we will even
out the lighting caused by the sunhght. We wIl] be creatmg thIS backdrop dunng thIS chapter, but
first, we need to take a look at the tools available to us to control the look of terrain,

A Closer Look at Terrain Editing
At this point, you know just the basics: You can make terrain, place a texture on il, and create a
lighl and environment for it. Now, we need to see how we can customize, alter, and bring out the
full potential of our virtual landscapes. To do this, we will need to access the lerrain Editing tools,
located within the Terrain Editing dialog.

The Terrain Editing dialog offers a wide range of tools for developing terrain. Th.e effects caused by
these tools vary depending on what you are manipulating, be it the shape of the terrain itself (height
map), the color of the terrain (text ure layers), or the objects scattered across it (DecoLayer5).

Before we start, a word of warning: Although Un realEd's terrain editing system is extremely pow~

erful and easy to use, it is always possible to make a simple mistake, Unfortunately, UnrealEd's
undo functionality is not always dependable. YOll could see very unpredictable results, and its use
fulness when painting is limited. Because of this, it is recommended to save often when working
with terrain.
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FIGURE 5.35 The Terrain Editing dialog.
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Terrain Editing User Interface

We've already taken a glance at the Terrain

Editing dialog, so now let's have a more in

depth look at ilS functionality, as it is truly
the center of the terrain control system. In

this section, you will be introduced to the
{ull user inlerfJCe of the Terrain Editing

dialog for the purposes of shaping and tex

turing our landscape. Later, we will discuss

how to apply and control DecoLayers to

scatter collections of static meshes across
the surface of your terrain. FIGURE 5.35

shows the Terrain Editing dialog.

Earlier in the chapter, we covered the Terrain Generation system, which makes up the main func
tionality of the Miscellaneous tab. We will fOCllS on the Tools tab, and take a look at the
capabilities found therein.

The Tabs

We will begin at the bottom of the window, with the three tabs for Terrain, Layers, and

Decorations. These are some of the most important areas of the window, as they allow you to
select which area you want to edit. One of the biggest problems beginners have when working

with terrain is that you must remember to have the item you are editing selected in this window

before any changes wiU take place. For example, if you want to alter the height JIlap of your ter·
rain, you must select that height map in this window before the brush wiU have any efkct. The

same goes for texture layers. You mllst have the text ure you want to edit selected before the tools
will affect it at all. Through these tabs, you will be able to sort through and select any of the ele

ments of your terrain.

The TerraIns Tab

The lerrains tab allows you to sort through the height maps of the various Terrainlnfo Actors

that yOll have available in your level. At the bottom of the tab, you will see a button that allows
you to create new Terrainlnfo Actors, in case you need more than On<' area of terrain in your level.

For I'xample you may have one terrain that is lhe floor of a cave, and another for the cave's ceil

ing_ Keep in mind, though, that you can only have one height map per "Ierrainlnfo Actor.

lust abov~ lhis, you wi.U see a list of all of the TerrainInfo Actors in your scene. You can use this
list to select a specific Terrainlnfo for editing. Keep in mind, though, that this Jist does not always

update; if you delete a Terrainlnfo Actor from your level, and then try to select that Actor from
the jist, UnreaiEd will Likely crash.
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As you select each Terrainlnfo. you witl see its Height Map tcxtu re to the right of the list. This is

the texture that you are editing to control the physical shape of the terrain. The texture begins as

a !lat grey. Darker areas on the texture will denote depressions in the landscape, whereas lighter

areas will create rises. When you use the Painting tool to change the shape of your terrain, a tech

nique covered later in this chapter. il is this texture that you are actually updating. Keep in mind
that in order to adjust the shape of your texture wilh the Painting 1001, you will need to have this

tclCture selected, meaning that you must actually click on it to highlight it. Note; To select this tex

ture, you wiU usually need to click on the top of the bar 10 the right of the Terrain Info list.

The Layers Tab

Next to the Terrains tab, you will see the Layers tab, which is where you can add, select, and

arrange your texture layers. Be aware that this list is evaluated from the top down, meaning that

the lowest layer of the terrain is actually at the top of the list. Therefore, if you were to place a

grass texture beneath a dirt texture in the Jist, your terrain would be completely covered in grass,
and your dirt wouJd be invisible.

To edit a teXture, you must have that texture selected in this tab. You can onJy edit the texture that

5 you currently have selected. As with the height map in the Terrains tab, selecting the texture usuaUy
requires that you dick on the top of the appropriate bar, We'll be discussing texture editing shortly.

To the right of the texture layer list, you will see three buttons. The IIrst is the New button, which

allows you to create new texture layers. The Delete button will obviously remove unwanted tex

ture layers, whereas the Duplicate button will copy an existing layer into the next slot down.

Below these three buttons you will see three smaller buttons. The first two allow you to rearrange

the position of a texture in the texture layer list. For example, you can select a texture and dick

the Up arrow ill, and the texture will swap places with the lexture directly above it. The Down

arrow (±], conversely, wilJ swap the texture with the layer directly underneath the selected layer.
The third button is the Grid Options button 13l, which opens a drop-down list that gives you

access to a grid for speCific layers. This grid allows you to more easily see where textures are visi

ble on a terrain. For example. your grass texture may be so sparse that it is hard to see where you
painted it. If, however, you switch on the grid for the grass texture layer. you will see a bright white

grid on all Meas of rhe terrain where the grass texlUre is at ;111 visible. This is a great guide to see

where textures have been placed on your terrain.

The Editing Tools

At the top left of Ihe window, we see the Tools group. This contains a list of 11 tools that will allow

you to edit an aspect of terrain in some way. Not all of Ihe tools work with aJJ terrain components,

though some wiU work with more than one. For example, Ihe Painting tool will work with height

milps, allowing you to edit the elevation of a certain area of terrain. However, it functions differ

rnlly for textures, in that it aUows you to control the value of your alpha channel 10 show one tex

ture through another.



We will present these tools to you not in the order in which they are listed, but rather in the order

of an efficient terrain workilow. We will begin by shaping our height map, while demonstrating

aU of the tools that affect and control the shape of terrain. Next, we will move on to placing tex

ture on om terrain, dIscussing each of the necessary tools (or controlling the placement and look

of our texture layers. Later, in a separate section, you will be introduced to the creation and con

trol of DecoLayers, in order to add static mesh decorations to your terrain such as grass, rocks,

debris, and so 00.

The Brush

The Options group in the Terrain
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FIGURE 5.36
Editor.

Before we begin, we need to discuss the Terrain Editing brush (not to be confused with a BSP

brush). Most of the tools available through the Terrain Editing dialog are represented by a brush

that appears on the su rface of the terrain, which can only be seen when the Terrain Editing mode

is active. It appears as lWO circles, an inner and an outer, at the location of the mouse. The inner

circle applies the full strength of the tool.

determined by the designer, to the [errain.

The effect drops off between the inner and

outer circles. At the center of the brush you

wiJJ see a red dot, indicating the brush's

center. FIGURE 5.36 shows the option

group in the Terrain Editor.

Inner and Outer Radius

The Inner and Outer Radius sliders determine the size of the brush. It is within the inner radius

that the ma..'Cirnum strength for the selected tool is applied. The effect of the selected tool dimin

ishes bttwem the inner radius and the outfr radius to an effect of zero when the outer radius is

achieved.

Lock Icon

Clicking the Lock icon will cause the Inner radius setting to become Jacked. It will retain its off

set from the outer radius. When the outer radius is adjusted, the inner radius will move in tan

dem automatically. \Vhen the inner radius reaches a value of one, it will remain there as the outer

radius value continues to fall. but the tool will remember the offset so that when the outer radius

value increases past the amount of the offset, the in ner radius will begin to move again.

Per Tool

The Per Tool check box will allow the level designer to give each tool a different brush setting.

Each option set in the Tool Options section will be independent for each tool. If Per Tool is turned

off, the glob'll tool options will be used. The Per Tool settings dfe not lost when the option is

turned 0[1. Vv'hen Per Tool is enabled again, the old individual setting will still be valid.
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Strength

The Strength option is used to determine the amount of effect a particular tool will have. Not all

tools will use the Strength option. The Strength setting is a percentage value ranging from 0 to

100%. The value 0( this strength is applied to the inner radius of the brush.

Adjust

The Adjust option is a multiplier value added only to the Painting and Noise tools. By default this

is set to a value of 32. Increasing this value will make your paint strokes and noise values much

more dramatic. Be aware tnat extreme values can cause this tool to behave wildly. and usually

result in undesired effecls.

Ignore Invisible Quads

The Ignore Invisible Quads option is a setting reserved for DecoLayers.lls purpose is to prevent

static meshes from being scattered across invisible quads. For example, yOll may need to make an

area of your terrain invisible in order to carve a cave or bunker into it. Jfyou had a DecoLayer of

grass across most of the terrain, you wouldn't want it to be on the area of a cave entrance, as il

5 would appear to be floating in air. In such cases, you would want chis option 10 be activated.

Mirror

The Mirror option offers J drop-down that allows you to choose an axis (or pair of a..xes) across

which to mirror the brush. This is especially useful when trying 10 make a symmetrical area, per

haps for a CapTure the Flag map. You can mirror across the X or Y axes, or you may mirror across

both, which will result in four brushes, all working in double symmetry_

Height Map EditIng Tools

To begin, let's take a look at how we can control the shape of our terrain by adjusting our height

map. The Terrain Editing dialog offers several tools that allow us to physically alter our terrain's

surface in a variety of ways. This section describes all of the tools you can use to edit your height

map, along with a description of how they work. Remember that in order to make any of these

lools work, you must physically select the height map you want to edit in the Terrains tab.

Vertex Editing

The -tex Editing tool allows you 10 adjust youT height map by physically selecting and moving

groups'of vertices either up or down. Raising a selection will lighten that area of the height map,

whereas lowering a selection will darken it. Along with this tool comes the ability to use Soft

Selection. ;\1} option located in the Soft Selection group, found in the upper-right corner of the

Terrain Editing dialog (see FIGURE 5.37). Within thi~ group is a check box that allows you to

switch on Automatic soft selection.



The Vertex Editing tool always works ,vith

some level of soft selection. The Automatic
check box sjmp!~' offers you a way (0 auto
mat ically expand a soft selection by click
ing a second ,Hea. While Automatic is
deactiv2ted. the behavior of vertex selec

tion is as follows: Ctrl+clicking the surface

will allow yOll to make a selection oi ver

tices, based on the inner and outer radii of
your brush (see FIGURE 5.38). Vertices

that fall within the inner radius of the
brush will receive the stre;lgth value found

under the Strength percentage. Any selec

tions that are made aher the first will only
3dd individua I vertices to the selection.

FIGURE 5.37 Soft Selection group.

CAUTION
When adding individual vertices to the Vertex Editing
tool, you must be extremely careful that you do not

move the mouse at all 3S you click subsequent ver
tices. The slightest motion will cause UnrealEd to cre
ate a new soft selection, essentially starting you over
from square one!

__ rooT
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FIGURE 5.38 Image showing selected vertices.

If you ~clivat~ the Automatic check box for soft selection. any subsequent selections you make

will expand the radius of zlJ previous selections made. For example. if you Ctrl+cJick on an area
a{ the terrain. you will have a single soft seJecl ioo. based on the side of your inner and ouler radii.

If you then Ctrl+click an area outside the current selection, the radius of the original selection
will expand to include the second click (see FIGURE 5.39).
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5
FIGURE 5.39 Image showing a second selection added. Note that the first selection has now
expanded because Automatic was tumed on.

TIP

NOTE
Keep In mind that making multiple selections with the
Automatic check box. enabled can cause long calcula
tion times, as UnrealEd determines exactly which ver
tices shou Id be Included In the selection.

Altllough it Is possible to select vertices without hold
ing down the Ctrl key, doing so is far more reliable, as
the slightest mouse movement while not holding Ctrl
will cause the came/a to mO'o'e.

After you have made- a vertex selection, you

can then move the sd<'Cted vertices either up

or down by holding thf Or! kfy and both

the lell ilnd right mouse buttons, and then

moving the mouse up or down (see

FIGURE 5.40). The motion will be based

on the amount of falloff of your selection.

You can see this falloff in the viewport by

looking at the color-coded vertices. White

vertices will receive 100% of the motion of

the mouse, whereas black vertices receive

virtually none. All shades of grey in between

will receive varying ievels of strength, resulting in a softened effect as you move the vertices up

and down. This is a great way to create perfectly circular hills or pits in your terrain, or to have

fluid control over moving an entire area up or down.
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FIGURE 5.40 While you hold down the left. and right mouse bulions. you can move the selected
vertices up or down as seen here.

The Select Tool

This lool is primaY~y used for lne Terrain Generator. You will make a sq uared ~e1ectiQn on

your tcrrJ!n, ,md the Terrai.n Generator will r~buiJd only the terrain witllin the selection (see
FIGURE 5.41 i. If, however, you have the Us<: Enlire HeightMap option checked in me Te.rrain
GeneCi1tor, the t:ntire landscape will be rebuiJl, regardless of the selection.

FIGURE 5.4.1 You can see a selected area that is beIng edIted by Ule Terrain Genetator.
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Painting

Thl' is the primary 1001 for heighl map editing. This is a vcry intuitive tool thaI allows ),ou 10 r:aise

and IOll'cr are;)s of the lerr.lin just by pJinling Ihe brush across Ihem. Its use is vcry sim pic. Merely

selcct .l 51 rengt h and brush size. and perhaps S~'I your Adjust valu~ (or fine control. As you hold

dowll etrl Jnd kfl-dr,lg .Kross the surf;\~ of Ihc lerra in. you will raise the terrain wherever you

paint. Dragging ,,,ilh I he right mouse button while hold ing the Ctrl key will lower the ferroin, so

thai )OU are creating dcpr~ions in the sur(<\cc. Remember Ihat il is usuaUy best to leave your

slfeng1h reblively low, and Jdd your brush strokes slowly, one 3tOP the other, 10 create your /in.al
terrain. You can aLso use Ihe mirror option with this 1001 to keep your painted strokes symmetri

cal across .1 given ;1"X..iS or ;L\:es. FIGU HE 5.42 shows a terrain object that is being edited through

painting.

FIGURE 5.42 You can see an area 01 tetTllln that Is being edited us.lng the Paint tool.

Smoothing

1'hi' 1001 allows yOll to t;lke out any harsh contrasts in your height map. This, in effect, smooths

OUI your lerrJin by r~lllovi..llg harsh edges (see FIGURE 6.43). This is (l perfecttooJ to make your

('rrJin look less j.lggeJ, ('specia.lIy when .ldding features such as rolJing hill$. Technically, Ihc tool

is I<lkillg the lowest point aver'lge of 1he graysc;l.le pixel values wilhi n Ihe r:ldills of the bru$h. You

wiJJ usually want the sirengih value 10 be relatively low whell u$ing this tool, as il is easy to "melt"

awa~' the detail thai yOIl havt been working on.
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FIGURE 5.43 The area painted in was once a sharp point, but has now been smoothed out.

Noise

The Noise tool applies a noise value to your height map, which has the effect of creating parches
of "lumpy" <\reas of terrain. A grayscale noise appears to be a patchy conglomeration of dark and
light are"s. When this is added to an existing height map, the result is a closely placed group of
raised and lowered areas. Use of noise combined with low-strength smoothing can result in very
realistic terra in features (see FIGURE 5.44).

-1-1

FIGURE 5.44 Noise has now been added to the hill.
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Ratten

The FlJllen IDOl, as it s name suggests, allows you lO thuen Qut an area. ihis is especially useI\J I

(or carving roads and olller such landmarks out o( your terrain. [t c.an also be used to creale

plateau5. m~·!;'l:>, and bunes in yvu r terrain. JIS use is rem:lrkably simple. JUSI move Ihe mouse over

.10 nr~il that is the deSIred hei~hl vf your new Oanened area, and thetl C!rl+Jeft-dr<lg 10 pain!. All

of the terrain within thc OUlcr radius of tht: bru~h will he (ort:eu flilt al Ihc selected elevation (see

FIGURE 5.46).

FIGURE 5.45 Tlle hili has b~n flattened and more ridges created with the Flatten tool.

Visibllit~

The Visibility toolaUow5 you to show or hide quads of Ih(' terrain (see FIGURE 6.48). ThIS is
especially useful when you need to open holes in your terrain, such as for a Qlve or bunker'rype

building. When a quad is m:lrked as invisible, it will no longer detect collisions with a player.

meaning th31 a pl.1ycr c.an (all through it.
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FIGURE 5.46 The Visibility tool was used to cuI this opening Into tile terrain.

Edge Turn

Til" Edge Term tool allows you to modify the topoloSY of your lerrajn by nipping lhe triangle
ed~l" of J. qU..ld. Terrain gcoli1Clry is compDsed of a series o( (our·sided polygons. or quads. each
divided inlo two right triangle~. The direc.tion or the tci.ang.le edge dclCrmines bow the surface
will bend. You (..Ill USc Ihis tool to flip the triangle edges of quads 11'1 your lerrain so that it IS

deforming proptrly. It works in a paintbrush (ashion, changing the edge of (aces that you paint
Ovt'r. FIGURES 5.47 Jnd 5.48 show the result of u.sing (hl' Edge lurn 1001.

Applying the Terrain Editing TOO'A

Now th.ll we have l~ken;1 closer lMk at the tditor ~nd the tools ,lV;lilable (or ~h ...pjng terrain, ii'S

time to (urn t)ur ~(I('1ltion back to rhe I~rr~in wf've heeo cruring in (his chapter. UnlU now, rhe

only thing We h,IVt· done 10 our lerrai,) was 10 usc Ihe Terrain Gene fa [Or 10 give some life 10 the
landscape. Although the ~cneratorcan be ~ great way 10 produce a ~t~f1 ing point, it does nOt gwe
us the .lb$olu\e contrnl needed to sculpt the l<lndsc.<lpes we need (or O~r gJmes. simulations, and
~o on. TUTORIAL 5.6 wiU (ocus on using the 10(.)15 we have discussed 10 sltaplC' our terrain.
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5 FIGURE 5.47 Before using Edge Tum.

FIGURE 5.48 After using Edge Turn.
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TUTORIAL 5.6: Shaping Your Own Landscapes

1. Open the file Tutaria15_06_Star-t .ut2. You will see the terrain g,'\(j skyboJ: we completed

earlier with the Terrain Generator. We will now rebuIld our terrain by hand. To make the

most of our heig/1t map, we will push down aM pull up detail to create a range of moun

tains separating two bases.

2. To begin, we will Oanen out the entire terrain. The fastest w<JoI to do Ihis is to cnoase the
Select tool from the list. and then sWitch over 10 Ihe MiscellaneouS lab. In the Terrain

GeneraHon group, ertler a Steps varue of 1. and a Slrengl.h value 01 1. Check Use Entire

Heightmap, and click the Build button. Rebuild the lighting when finished 10 remove any

unwanted shadows.

3. We first need to build the oUler hills thai Will prevent the player (rom seeing the edge of

the terw;n, We're doing thiS to pfevent (he player from running oN Ihe edge of t.he map.
Later, you will be able to suPOlement lhese hills with blocking volumes. which are inVisible

brushes thaI ....,ilI behave like walls. pteventing the player from gening 10 the top of these
hills. You WIll learn mote aboVl volumes in Chapler 6. ~WorkingWith Volumes:

TIP
When finished, you may want to set the Mirror bacll to
NDne, In order to add some asymmetry to your map.

AdjuSl: 32

Mirror: 'X'(

To start. sere<:t the height map in the Terrain layer. and then choose the Painting tool. Set

the following settings for your brush:

Inner Radius: 330

Outer RadiUS: 684

Sllenglh: 44

We're selling the MIrror value to XY so that each stroke is copied across the X and Yaxes
(see FIGURE 5.49). This means Ihat you can paint eech of the comers of the map, and
your strokes will be mlrrored_

Paint aroun<:l the edges at your map 10 create the hills that will surround your terrain.

4. We're going (0 create a setup that Will allow lor two bases. one on each corner of the

map_ Make sure lhat Mirror is set (0 None, 8nd use the Paint tool to create two

depreSSions at opposite corners of the map (see FIGURE 6.50).
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FIGURE 5.49 Painting with mirror set to 'XY.
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FIGURE 5.50 Sinking two areas In the terrain for bases.

5. SelecT the Flatten tool. Move the brush over one of the lower areas of one of the depres·
Sions. Ctrl+left-drag to flatten the entire depression to that elevation, as shown 10

FIGURE 5.51. Be careful that you do not cui lao far mto the hills behind the base area.
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FIGURE 6.51 Flatten the two base areas.

You call also choose higher areas arou lid the base,

such <IS in the surrounding hillS, and use the Flatten
tool to create perfect areas to place turrets.

6. Now, using the Painting tool, create a sefles of hills and mountains in the middle of the map,

Adjust the Inner and outer brush radII as necessary. Remember that If you keep your brush
too small. your hills will be very tight, which Will not look natural. Also, don't be shy about
acljustlng the strengHl, It is almost

always better to use lower-strength

strOkes and layer your strokes on top of

one another, Use FIGURE 5.52 if you

need help.

1~1,-,"1

FIGURE 6.62 Using the Paint tool to add mountains into the scene.



l82 Chapter 6 Terrain

While mo.dellng your terraIn, Iry III hNlglne 00w you
could use your terrain tor are.as suc.h as hlddBn bases,
pow&r-up areas, special defense areas, and so OIL

Also, walch your geography very closely to make sure
that it Slays useful. If you want Yllur characters to tJ.e
llble to climb to the top of a hill, make sure Its skl-pe
Is not 100 steep 10 prevent climbing,

Outer RadiUS: 102

select lhe Ranen tool. Move the brush

lO an area that is Just above the level of

one 01 your bases. and begin using the

tool to carve in a road. Lead the road around the fnnge of the level, just inside the surround

mg movn\311'1S. Pause (rorn time to time to create a raised or iOY.ered area from which to con
tlOve the road. This WIll keep your road from being perleetty flat from one end to the other.

7. LeI's creale some roads (or our map to TIP
COi'lr'leCI one Mse to the other. We will

keep tnese relatively small. Use the fol·

lowing senings 01"1 the brush for now:

Have fun wilh this step. Basically, you WIll need two roads, each connecting one base to

the other, as shown in FIGURE 6.63. Aside (rom that, you're free to create your own

paths through the hills, or anything you like, 8e careful not to destroy too much of tfle

lartdscape you've created,

FIGURE 6.63 Using the ~atten tool to cut roadways into our terraIn. The roads have been painted
here to make viewing easier.

8. SWitch to the Srnoothil'lg tool. set the strength to a relatively low percentage. and smoolh

out the areas or sharp cliffs on either Side of the roads. You will also want to smooth OUl

any places where the road changed elevation. in order to create a "ramp· from one level

to the other. While you're at il, you can also smooth out any areas around your bases that

are a little too sharp.

It could help to swrtch to a wireframe and see how things are looking. We are trying to

aVOid hClVir'lg polygons that are stretched too far. as shown in FIGURE 5.54.
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FIGURE 5.54 Before smoothing. Notice how far the polygons are being stretched?

After smoothing. you will notice that the triangles are more appropriately spread across
the surface, making it easier to see the texture across It, as in FIGURE 5.$5.

FIGURE 5.55 After smoothing. We now have more detail on the sides.

9. Make any tweaks and adjustments you like until you are satisfied with the look of the
level, When flrllshed. be SLIre to save your level. You may find it handy (0 play-test the level
to make sure that areas you create are accessible and will work properly for your ideas.

END TUTORIA.L 5.8
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Now that our terrain is created and WI' have a Skybox in place, we can make the surrounding

environment mu(h mort interesting by adding a second t~rrain system into the skybox in

TUTORIAL 5.7.

TUTORIAL 5.1: Adding Terrain to The Skybox

.1. Continue from the last tutoda I. or open the file Tu t 01'ia15_07_Start. Ut 2. We will now

supplement our skybox and add a little mort'! character to our level by creating a second
terrain system inside the skybox. This will produce the illusion that our level is surrounded
by vast mountains far out in the distance.

2. Double-dick the Search For Actor icon. In the search line, start typmg SkyZonelnfo until

the Actor list is filtered down to Ihe SkyZonelnfo Actor. When you see it in the list, double
click it. and Click the Close button.

5

This will select the SkyZonelnfo Actor and move the camera to its position. Open the prop
erties window. Expand the Zonelnfo category, and set bTerrainZone to True. This will

allow a Terralnlnfo Actor 10 be placed and terrain to be visible in the skybox.

3, In the Terrain Editing dialog, go to the Terrains tab and click the New Terrain bUlton. In the
New Terrain dialog. input the following:

Package: myLevel

Group: Heightmaps

Name: HeightMap2

Xsize: 128

YSlle: 128

ThiS Will create a flew Terrainlnfo Actor at the position of the camera, which should be near
the center of the skybox.

4. Right now. Ihe terrain IS too big. Open the properties for the new Terrainlnfo Actor that
was created in the skybox. Expand the Terrainlnfo category, and go to the TerrainSca1e
property. Set the X and Y values to 32. This should cause the terrain to tit nicely into the
skybox.

5. Using the skills that you have learned, place the same texture used on the original terrain
onto the new terrain, Rehuild as necessary. When finished. use the height-map editing
tools to pull up some mountains on the outsides of the terrain_ Leave the middle area
sunken down like a valley.

e. Move the camera Into the main area of the level and press the K key to view the skybox.
You should be able to see your new terrain surrounding your level. If necessary. move the
SkyZonelnfo Actor down lower to make the mountains surrounding the level appear taller.
Keep In mind that you may also need to relight the skybox terrain, as It is not affected by
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the Sunlight Actor. Also, be aware

that if you pull the mountains up so

that they cover any of the lights that
were in the skybox, those lights will

no longer be visible, resulting in a
darker sky. To alleviate this problem,
reposition the lights as necessary.

7. Test and tweak the results until you
are satisfied (see FIGURE 5.56).

Keep in mind that your skybox ter

rain may not be visible from some of

the lower areas of your level. When

finished, save your map.

END TUTORIA 5.1

Terrainlnfo Properties

FIGURE 5.56 Through anotller Terrainlnfo Actor,
we've added mountains into our skybox,

There are several properties for Terrainlnfo Actors that will come in handy when controlllng the

shape and behavior of your terrain. TABLE 5.1 describes each of these properties.

TABLE 5.1 Terrainlnfo Properties

bkCollisionHalfRes Typically, Karma uses the actual triangles of your terrain as the collision

mesh. Setting this property to True Will cause the number of triangles

to be divided by two for the collision mesh, resulting in simpler (read

(aster) colliSions.

DecoLayerOffset This property will offset your Decolayer meshes from the surface of the
terrain. If the AlignToTerrain property (found under Decolayers) is set

to 0, the meshes will simply offset by movmg up the number of units

specified In the DecoLayerOftset properly, If AlignToTerrain is set to
1, the meshes will offset in a direction perpendicular to the direction of

the triangle upon which the mesh was placed.

DecoLayers See Table 5.3, later In this chapter.

Inverted Terrain is viewed from one side only. Setting this property to true will

invert the terrain such that yOll can only see it if you were standing

below it. This is an excellent way to add in rocky ceilings as if you were

in some sort of natural underground cavern,

layers See Table 5.2, later in this chapter.

TerrainMap This is the Height Map texture, This is the texture responsible for

determining the altitudes of the terrain.
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TABLE 5.1 Continued

Terra i nSc ale This prope rty allows you to control the three·dime nSlona I scale of the
terrain.

TerrainSectorSize This is mainly used for optimization. As terrain stops rendering. it will dis
appear segments at a time. For example. If you set this to 16, the terrain
will be divided into sectors that are 16 quads by 16 quads.

VertexLigh t Map This allows you to specify your own light map texture for your terrain.

Texture Layer Editing Tools
In this section, we wiU describe the tools that can be used for texture layer editing. Some of these
tools were already Llsed (or height map editing, but will function differently after we select a tex
ture layer. Always remember thdt for J.ny of the~e tools to functiun, you mmt have the textu re layer
you want to edit selected in the La)'ers tab.

5 Painting

j

-

-

Aloha

Alpn.

RGB

RGB

FIGURE 5.57 Image showing how the alphas work
by allowing you to show one texture through another,
such as Showing a dirt texture through a layer of snow.strates how this process works.

This tool is really only effective when you have more than one texture layer. If you add a new texture
IJ.yer \vith al} Al phaF i 11 value of black, you will not see the new texture at all, as a black value denotes

complete' transparency. You can then paint the texture onto speclllc areilS of the terrain using this tool.
When painting texture onto your landsUlpe,
you are actually editing the AJpha dlJ,nneJ

of the texture. Ctr1+left-dragging will paint
white areas onto the Alpha channel, making

your topmost texture visible only on the
areas >!Oll are painting. CtrJ+right-dragging
will remove value from the alpha channel
(similar to painting black, if you prefer),
which resuJts in removing or erasing the
top-most tenure. For example, let's say that
yOll have a single dirt texture all across your
terrain. You then add a new texture layer
with a snow texture, but set the AlphaFill

property to black. You won't see the Sl10W

anywhere, but as you Ctrl+lefr-drag with
the Pa.lIJting tool, you will add snow to the
areas you paint. You could then Ctrl+right
drag over the snow, and "erase" it away, back
to the dirt texture. FIGURE 5.57 demon-
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AfterBefore

Smoothing is another tool that works for tex

ture layers as well as height maps. In this case,

its runction is very simllar. This will smooth.

OUI the values between Meas of your alph<l
channel, which., in effect, smooths out distri- FIGURE 5.58 Left: Before smoothing.
bution of i\ texture (see FIGURE 5.58). For Right: After smoothing.

exampl~, if you have painted on a texture, JJJd Lhe contrasl from on(' texture to another is very

sharp, J'OU could easuy use the Smoolhing lool to soften the edgfs between the MO visible texTUn:s.

Smoothing

Noise

The Noise tool works for teA1ure layers similar
to the WilY it ~vorks for herg.ht maps, However,

rather than making raised and lowered

patches of elevation, it creates areas of light

Gnd dark areaS in your alpha channel. making
your topmost texture vJsible only in patches.

It is d grea I tool to (rea te spa rst' areas of grass

or stone on your terrain (see FIGURE; 5.59).

Before After

FIGURE 5.59 Left: Before noise is applied.
Right: After noise is applied.

lex Pan

This tool aHaws yOtl to 2djust the position of textures on your terrain in the U and V direction. First,

'lOll must select the texture in your layers tab that you want to adjust. Next, hoJd the CtrJ key, and

then dqg with on/' of the HJOu~e bunons. Dragging with the left mouse w~1 move the texture in the
U di reel ion, whereas dragging with the righ t mouse bu tton will move the textu re in the V direction.

After

Left: Terrai n before texture is rotated.
Right: Terrain after texture is rotated,

Before

Tex Rotate

The Tex Rotate tool, as you might imagine,
allows you 10 rorate the selected text ure.

This is In excellent tool for adjusting the

look of texlures on specific surfaces. The
pJVot of texture rotation wlH be the origin FIGURE 5.60

of your level (0,0,0). The tool works in a
similar fashion to the other tools available

in the 'Terra in Ed iting ddog. Holding Ctrl and dragging with either mouse button wjll cause the

!I'Xlul't" to rolate, Dragging 10 the left will CJuse a counterclockwise rotation, whereas moving to

the right \-','ill cause a clockwise rot2.tion (see FIGURE 6.80).
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Tex Scale

This tool allows you to scale your texture in the

U and V directions. This is very handy when

trying to gel your texture to line up without it

being apparent that the texmre is tiling across

your terrain. Holding Ctr! and left-dragging

will scale the tcxtnre in U, whereas right-drag

ging will cause the texture to scale In the V
direction (see FIGURE 6.61).

Editing Terrain Texture

Before

FIGURE 5.61

..

After

Left: Terrain before texture is seal ed.
Right: Terra in after textu re is scaled.

Now th3t yOll know the tools involved in editing terrain texture, you are re<ldy to try your hand
at texturing your own terrain. Tn this section, y'ou will create and edit textores on a terrain sys

tem, as well as have a look at the properties for trxture layers. To begin, TUTORIAL 5.8 intro

duces you to creating and editing a basic texture on your terrain.

TUTORIAL 5.8~ Texturing Your Terrain

1. ConUnue from the last tutorial, or open the file 1 utor i a15_08_Star t . ut 2. We wi II now

add sOme texture layers. Before you start, make sure that TerralnlnfoO IS selected in the
Terrains tab, so that you are painting on the proper terrain. Make sure the Texture browser
is open, and that the Ch5_ terrain package is open.

In this tutorial, we will be bringing the texture of our terrain to life. We currently have a
Simple dirt-like texture applied to the entire terrain. just for construction purposes. We will

add more layers to this to create Cl complete texture system.

In this case, we will be going for a very cold feeling level. It IS always a good idea to get
t:ln idea of the type of terrain you're making, be it desert, Jungle, tundra. or other types.
Our terrain will have harsh rocks, a little moss. and snow-capped peaks, gIVIng the feel

that the environment is not quite freezing, but very cold, We will supplement this effect by

altering the fog color to accentuate the feel of the environment.

2. In the Texture browser, from the Ch5_Terrain package, select the Rocks texture. Go to the
Terrain Editing dialog. Make sure that TerramlnfoO IS selected In the Terrains tab. In the
layers tab, click on the Undefined slot beneath the DirtLayer1 texture that you added ear

lier, venfying that it is selected_ The slot must be selected in order to create the new tex·
ture, Click the New button, and enter the follOWing settings into the dialog:

Package: myLeveI

Group: TerramLayers

Name: Rocks

AlphaHeight: 128

AlphaWidth: 128

AlphaFIII: Set color to White

UScale: 8

VScale: 8



When you create a new layer, the texture that was selected in the Texture browser is

applIed to the terrain. A new texture is also created, which is an RGBA8. The alpha chan

nel of this new texture will be used to control the blending between this texture and the

texture directly above It in the Layer list.

You will 81S0 notice that we set the alpha color to wl1lte. This will make our new layer com·

pletely opcque, meanmg that we Will not be able to see our original texture at all. We will

then use a subtractive painting methOd to blend back to the original dirt layer. This is not

unlike "cutting holes" to reveal our onginal texture.

3. Select the Painting tool, and mBke sure (hat the Rocks layer IS selected in the layers tab. '

Dragging With the ngnt mouse button while holdmg the Ctrl key, remove the rock texture in

the areas of your roads. You will probably want to set your strength to a moderately low level,

and use multiple strokes to carve away the rock texture. Use additive and subtractive strokes

to create areas of soft blending between the dirt and lOck layers, in ord~r to keep the con

trast from one texture to the next from being too harsh (see FIGURE 5.82). Don't be afraid

to cut away from the rock very lightly all throughout the map, Just so that the terrain doesn't

feel lJnhalanced,

, ~f •• ~-J

1'1.', ••

l' ,.1 ~. J

.' ,

FIGU HE 5.62 Blending so that you can see a mixture of dirt and rock.

4. Now, go back to the layers tab, and select the next Undefined layer. Select the MossWalis

texture in the Texture browser. Click the New button, and enter the following values into

the dialog:

Package: myLevel

Group: TerramLayers

Name; Grass

AlphaHelght: 128

AlphaWldtr.: 128

AlphaF\II: Set color to Black

UScale: 8

VScale: 8



TIP
You can create soft blending Quickly by first usjng the
Noise tool, and then follow up with the Smoothing
tool.
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This time, our AlphaFill color IS set to black, meaning that the texture itself is invisible

when created. We wi II then paint it on In an additive fashion.

Naturally, grass should only appear on relatively level areas that are not trod on very

much. ThiS pretty much rules out roads and steep slopes. though you may want to lightly

border your roads with some of the texture. As before. you can achieve a very nice bal·
anced look by setting the strength of

the brush very low and addmg soft

spots of the grass texture across the
level (see FIGURE 5.63). You could
also use the oise tool With a very low
strength to help with this effect.

FIGURE 5.63 Blending in grass.

6. In the Texture browser, select the SnowRocks texture. Select the next Undefined layer. and
click the New button. Use the following settings:

Package: myLevel

Group: TerrainLayers

Name: Snow

AlphaHelght: :128

AlphaWidth: 128

AlphaFill: Set color to Black.

UScale: B

VScale: B

Using the same techniques you've used lhUS far, add the snow to the peaks of the hills on

your map, arid also softer patches of It <'0 areas throughout your map (see FIGURE 5.64).
Remember that the terrain needs to appear cold, A light dustmg of this texture will m<lke

the environment look much more harsh. so don't hesitate lo patch It lightly in places.
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FIGURE 5.64 Adding snow to the top of the moum,alns.

6. With that, the texture is basically
done. Feel free to take a while to
sift bacK through the iayers making
tweaks and adjustments. When fin·
ished, apply the same techniques to
create texture layers for the terrain
In the skybox, as in FIGURE 5.65.
Save your map when finished.

FIGURE 5.65 Adding soo... to the skybox
mountains for 8 more balanced look.

END TUTORIAL 6.8

When '''or1<ing wilh terrain. you may notice some prob[~m~ where leXIurn are stretching, such
as on cliff cdg<:s. This problem can be alleviated by creating a new lelrture blyer, painting onl 0 Ihe
probkm <lrC<lS, and adjusting a singlt' propeny of £hI? layer. In the properties window of Ihe
Terrainlnfo you're work:ing on, you will see the Terrainlnfo c.llegory. Within, you wjjl 5ee )hc
l.1yers array, where you will nnd Layers 0 through 31. You will need 10 expan d the proper e\Olmen I

for the layer you just created.

That dement will havt a properry ca.lltd Ihc Tex tureMapAx LS. Th\S properly allows you Lo change
tht projection plane o( the rexture. For example, if the surfa(e you ar~ trying 10 (LX is near to being
paraUe! to the x.z plane, you \~'ould W3,)l to sct Illis properlY 10 TEXl.\APAXIS_XZ.
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layers have :I variety of properties that can be used to control their behavior and appearance.

TABLE 5.2 describes each of these proprrties.

TABLE 5.2 layer Properties

[OJ - [311 These are the 32 indexes for your texture layers.

AlphaMap This is the texture map that controls the blending of the texture layer.

KFnctlon This property is currently not implemented.

KRestL tut ion This property IS currently not implemented.

LayerRotatlOn Pitch/Roll/Yaw: This property attempts to rotate the texture in 3D space,
based on Unreal rotallOn units.

Textul'e This is the visible texture that will be applied to the terrain surface.

TextuI'eMapAx.l.S This IS the plane upon which the texture Will be projected. Useful to
prevent texture stretching on sheer faces such as cliffs.

5

lextureRotatlon

UPan

UScale

VPan

VScale

DecoLayers

This rotates the texlure in Yaw,

This pans the texture in the U direction.

This scales the texture in the U direction.

This pans the texture in the V direction.

This scales the texture in the V direction,

Now that you have seen how to create, edit, and texture terrain, let's take a look at how we can

add objeus such as blades of grass, trees, and rocks. In Unreal, thesf' objects are referred to as

terrain decorations. Adding these objects is

done within the terrain editing system

through the usc of DecoLayers.

DecoLayers Me ,imilar to texture layers in

lhat they are represented in a Jist fashion,

bUI in the case of DecoLlyers, each layer

represents an object (static mesh) being

used for decoral ion. Also, unlike texture

layers, you can have as many decoration

layers as yOll need, rather than being lim

ited to just 32. FIGURE 5.66 shows a

grass static mesh IIsed (or a De('oLayer. FIGURE 5.66 Grass is a common decoration
that is often found scattered across terrain.
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Colo<

DensIty

FIGURE 5.67 Create an image that shows how
the three maps affect the decorations.

When you are adding a decoration layer.

there are a total of tour components that

drive what the player will see: the static

mesh, the density map. rhe color map, and

the scale map, The static mesh is a given;

this is the object the current layer repre

sents and is what will be displayed on the
rerrain. The density map is one of several

controlling {"cton that determine where

and !low closely these objects are scattered

across the terrain. The color map gives the
level designer an extra level of control over
the color of the slatic rn<,she& being added.

and the scale map allows an unprece

dented level of control over the scale of the
objects in each of its ind ividual axes (see
FIGURE 5.67).

The densir)' map is used ro drive the con

centration oC static meshes on the layer.

Anywhere th?t the layer's color is black.
there wil! be flO static meshes. Wherever

the texl ure conta ins tbe color white. you

will have the max.imum number of static

meshes. You the'n have other methods of

controlhng this density, including the DensityMultiplier property and a property that controls
the max.imum number of meshes per quad. A quad, in this case, refers to the geometric area

between four vertices. Alrhough these rwo properti~s will be discussed in detail later in this chap
tcr, for now, you can viwalize the density control of sratic meshes in a DecoLayer with the fol

lowing equation:

grayscale value (0 - 255) x DensityMultiplier value x MaxPerQuad = Final Density

The Color Map texture allows us to combine colors with our static mesh objects being added to

the terrain. This provides us with a method to override the static mesh's default color when

adding them to the terrain. This is an exceptionally powerful feature when it becomes necessary

to alter static mesh colors in specific areas of the terrain, For instance, a color map can be used to

alter the color of grass in specific areas to produce the effect uf grass that has been burned by a
fire or even dried out to a color of brown.

The Scale Map provides a way of scaling the associated static meshes in specifIC areas. Through

rhe llse of the map. we not only control where the scaling occurs. but in which axis and by how
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much. The color black has no effect on scale, whereas the colors red, green, and blue will cause

static meshes in the region of that color to be scaled in the X, Y, or Z axis respectively. Naturally,
any of the gray shades between black and white will result in a uniform scaling of the mesh.

There are two ways to add a Decolayer: manually through the Terrainlofo Actor's properties, or
by clicking the New button while on the Decorations tab. Either way will require the setting of
various properr ies before any static meshes will be seen on the terrain, In the following tutorials,
both of these methods will be discussed, along with the various properties that need to be set in
order for the DecoLayer to function properly.

An lnteresling L\Ct about DecoLayers is that once crealed, they do not automatically genera Ie a
density map. Without this map, the static meshes of the DecoLayer will oot display 00 the surface

of the terrain. We could go iolo an eX1ernal image editing package such as Adobe Photoshop and
create a grayscale texture to be used as the texture OlJp. However, there is a clever workaround we
can use that not only allows us to work completely in UnrealEd, but also gives us the ability to use
lhe teX1ure editing tools such as the Painting tool to edit the density map,

Here's a brief overview of how this works: \Ve will create an extra texture layer on our terrain,
which we ",'ill hide from sight by moving it to the top of the layer Jist. This will hide the texture
behind our completely opaque base texture, meaning that the texture we use is irrelevant. We will
then usc the RGHA8 grayscale texture that is used to control this new layer's blending as our den
sity map, This means that we can edit the density map using the Painting, Smoothing, and Noise
tools if we want, allowing for a much more intuitive way to control the density map. In
TUTORIAL 5.9, we will use these methods to create decorations on our terrain,

TUTORIAL 5.9: Adding Decorations Through DecoLayers

1. Continue from the last lutorial, or open the file Tutoria15_09_Start. ut2. You should
have <l completely seulpted and textured (main, ready for decoration meshes.

2. Open the Static Mesh browser and load the Ch5_TerrainSM package. Locate and select
the Grossi static mesh,

3. From the Terrain Editing dialog, verify that the TerrainlnfoO is selected. Switch to the
Decorations tab and click the New button. This will create the first Decolayer,

4. Rlght·click on the new DecoLayer and select Set Static Mesh from Current from the con
text menu. Now we have a static mesh associated with this layer_ Notice that we cannot
currently see any copies of the static mesh. ThiS is because the OecoLayer currently has
no density map. We will now create a new texture layer and use its blending texture as a
density map.

5. Switch to the layers tab, In the Texture browser. select any texture from the Ch5_Terrain
package. As mentioned earlier. the texture is irrelevant, but the new RGBA8 texture that
gets generated will become very important Create a new layer in the first Undefined slot



uSing the following settings (see

FIGURE 5.66):

Package: myLevel

Group: DecoLayers

Name: DecoLayer1_Grass

AlphaHeig~lt: 128

AlphaWldth: 128

AlphaFIII: Black (This w~1I prevent

any static meshes from appear·

109 ali the [erram.)

U and VScale have no effect.
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FIGURE 5.68 Creating a new texture layer.

r--. ""l-I

FIGURE 5.69 The teid:ure layers that will be used for
the Decolayers should be moved to the lop of the stack to
prevent them from rendering their associated textures.

6. Select the new Decolayer1_Grass

layer that has been added to the
Layers stack'and use the Up Arrow

icon to the right to move thiS layer

tu HIe very top of the staclc The

layer should now appear above

Dirtlayerl In the stack and will not

render on the landscape because

of the opaque alpha channel on the

Dirtlayerl (see FIGURE 5.69).

7. in the Textures brows!:!r, switch over

to the mylevel package. Select the

DecoLayerl_Grass texture (see

FIGURE 5.70). This IS the RGBAB
texture that was created to control

the blending of the texture layer.
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8. In the Terram EditIng dialog, SWitch back to Ule Decorations tab. Right-click on the

DecoLayer and select Set Density Texture from Current. We now have a texture that will

drive the placement of objects (grass in thiS case) on our terrain.

9. Now that we have a texture assigned, you would think that we could begin Painting grass onto

our terrain, but there IS still one more thing that must be set; the Min and Max

FadeoutRadWs. These two properties determll1e tlOW far we can see decorations before ttlay

begin 10 fade out and then finally disappear. This IS In effect for both the editor and In·game.

Use Search for Actors and select the Terralnlnfo Actor to whlr,h you have added the Decolayer.

Expand the Terrainlnfo calegory, and then locate and expand the OecoLayers property. Within,

you Will see index (OJ. and underneath thiS you Will ftnd the fadeoutRadlUS. Set the following:

Max: 5000

Min: 1000

ThiS me~ns that you WIll be able to sep, the grass objects for 1000 units. Between 1000

and 5000 units the grass will simply fade out. This value WOUld change based on the size
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of your level and how far you would be able to see across it. Now that we have a texture Ifl

place and have adjusted the appropriate properties. we are ready to pa,nt.

... ~ i_ .... ..,~·1'iP.lItl"
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FIGURE 5.70 Selecting the new RGBA8 files that will be used as the density map.

10. Switch back to the Layers tab and select the DecoLayerl_Grass layer. Select the PaInting

tool, adjust the Inner and Outer RanlUS settings, and palot some grass on the terrain (see

fiGURE 5.71). You may want to pcllnt the grass In areas that you have added green to In

TUTORIAL 5.8. Use the left mouse to add grass, right mouse to remove grass.
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FJ GURES _71 Painting static meshes on the terra in.

END TUTORIAL 5.9
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TUTOR IAt 5.10 assumes that you have access to Adobe Photoshop. If you do not, virtually any

image editing SO[lwarc should work as well, though the process will not be the same.

TUTORIAL 5.10: Using Color Maps to Adjust DecoLayer Colors

1. Continue from the last tutorial, or open the file Tutol'J_a15_10_Start .l)t2. You might
notice that the grass is still very green for a cola, snowy area. We will correct trle colors of
the grass with a color map.

2. Maximize the top viewport in UnrealEd. Right-click on an empty area in the viewport's tool
bar, and from the context menu, choose View> Show Terralr., Alternatively. press the T
key. You will now see a bird's-eye view of your terrain, Notice that all of the grass that you
scattered across the terrain is displayed as white patches. We will use this 10 our advan
tage as we cleate our color map (see FIGURE 5.72).

FIGURE 6.72 Using the Top view to generate a reference image for creating our color map.

FIG URES. 73 Creating the new color map in Photoshop.

3. Press Shift+Print Screen. This
will copy the image of the screen
to the clipboard so that you can
paste it into another program
such as Photoshop.

4. Launch Adobe Photoshop, and
choose file> New. Verify that
the pixel dimensions of the new
document match the current res
olution or your monitor. Also ver
ify that the mode is set to RG B
Color (see FIGURE 5.73)_ Click
OK when done_

Nome li'ilililiii
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5. Press Ctrl+V to paste the screen-captured Image onto your new document. Wher. this IS

done. select the Crop tool. At the top of the w,ndow, set the Crop width and height to 128

px. Putting the "px" at the end will verify that the crop will be measured In pixels. Drag a

selectiorl around the terrairl image from the top vie\v, and use the tlandles to make sure

that the crop selection is right against the image of the terraIn (see FIGURE 5.74).

FIGURE 5.74 Cropping out the appropriate area.

Press E0ter when done,

6. The Image now consists of just the

top view of the terrain, which hGs

been resized to 128 x 128 pixels,

the same size as our other texture

maps (see FIGURE 5.75). Now.

create d new layer for the document.

arld name the layer Color.

7, Make sure the co lor laye r is

selected. Set your foreground color

to any shade you like. and use the

Paintbrush tool to paint your

selected color when=ver the white

DecoLayer meshes appear. For real

istic dead grass, you wculd probably

want a yellowish-brown, but for test

ing and demonstration purposes,

you can use any color at all (see
FIGURE 5.76),

FIGURE 5.15 The image has now been cropped
and resized to 128 x 128.



When this text\Jre is added back as the color
map. the hue information will be added to our
static meshes in a special way. White areas of
the texture will not affect the meshes at all.
Grey areas wi 1\ darken the meshes, and any
color you paint will be added to the existing
color or the mesh.

8. Setect layer 1, and set your fore

ground color to White_ Choose Edit

> Fill. and set Use to Foreground

Color and Blending Mode to Normal.

Click OK when done_ Your paint

strokes should now appear to be

on a white background. as in
FIGURE 5.77.

NOTE -I
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FIGURE 5.76 Painting our color map using the
image as a reference.

9. Save the file as a 32·bit Targa,

under the name ColorMap. tga.

10. Back In UnrealEd. go to the Texture

browser. and import the texture into

the myLevel package. under the

group OecoLayers. Set the name to

ColorMap. Uncheck the Generate

MipMaps check box. Click OK when

done, and select the new texture

from the browser.

11. In the Terrain Editing dIalog. go to

the Decorations tab, right-click on

the DecoLayer, and choose Set

Color Texture (rom Current from the

context menu that appears.

i2. Seve your work and lest your map.

Notice that the colors of your Color

Map texture have been applied to

the corresponding static meshes,

This IS a great way to recolor

Decolayer meshes to add realism.

or to help designate areas such as

the blue and red bases.

END TUTORIAL 5.1()

FIGURE 5.77 Now that Hie background has been
flooded, we ale ready to save.

NOTE
If you don't immediately see the results of the color map In

the viewport. you can open the properties of the Terrainlnfo
Actor. expand the Terrainlnfo category, and p-xpand the

I Oecolayers category. Expand index (01. and click the Use
I button on the ColorMap property.
'--------------------------'



FIGURE 5.78 Adding the brush that our interior
space will be carved out from.
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Our terrain is almost finished. As c final addition to our terrain, we will add an underground
structure into oLlr level. This will require that we create a hole in our terrain through which play
ers can move from the surface and into the SlruCiUre. TUTORIAL 5.11 will introduce the meth

ods necessary to do this.

TUTORIAL 5.11: Carving Bases into Terrain

1. Continue from the last tutorial, or open the file Tutor ia15_11_Start. ut2. We will now

create an additive SSP-based structure into the terrain, To do this, w€'; will Mve to create a
"hole" In our terram.

In order to create any sort of base in our terrain, we must add mass back into the sub·

tracted space of our level. As you recall, the world of Unreal is a space of mass. from

Which you carve out areas with SSP brushes. Any sort of structures you want to create

within these subtracted areas must then be added back in through the use of an additive

brush. In this case, we will be adding a brush into our level, and then subtracting from that

brush to form an open room that is accessible from the surface of our terrain,

2. Create an additive brush with dimen·
sions of 512 x 1024 x 1024 in the

flattened area of one of your bases.

Use a concrete texture, such as the

one included in the Ch5_Terrain

package. Move the brush up so that

it slightly protrudes from the terrain,

as in FIGURE 5.78. Edit the ter
ruin's height map if necessary.

3. Create a new subtractive brush with

dimensions of 448 x 960 x 960.
This should be placed in the exact

middle of HIe additive brush. ThiS
can be verified in the front, side,

and top viewports,

4. Our hollowed cube now needs an entrance. Create a new subtractive brush with dimen

sIons of 32 x 128 x 128, Place thiS in the thickness between the additive and subtractive

brushes, at the top. Rebuild your geometry. You shOuld now have a box-like room carved
II1to the additive brush with a small squared opening. Note: You will not currently be able

to see completely into the room, as the terrain IS in the way, To fiX this, we will now hide

the faces of the terrain that protrude into the room,

5. Open the Terrain Editing dialog. Select TerrainlnfoO in the Terrains tab, and select the

Visibility tool. Set your brush size to a small value, and paint with Ctrl+right mouse

to remove the Quads of the terrain geometry that are in the way of the hOle (see
FIGURE 5.79).
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f------~

-----j

FIGURE 5.79 The Visibility tool is used to cut away terrain revealing our doorway into the new
room.

6. Place a light In your new bunker to
illuminate it. Edll lhe shape of your

bunker to blend properly Into YOlJr

new terrain. for example to fix areas
where the terrain seems to float
over the top of the blJrtker. You could

then use the Flattert tool to evenly
cover the terrain across the top of

the bunker so that only the hole IS

showing (see FIGURE 5.80),

Generally, Irs a good Idea to sur·

round such holes with static

meshes of doorways. rocks, and so

on in order to cover the areas where
the terrain suddenly ceases to exisl.

END TUTORIAL S.11

There are some properties for DecoLayers

that aUow yOll to affect how yom decorations
appear on the terrain's surface. TABLE 5.3

describes hawaII of the properties inherent

to Decolayers could be csed.

FIGURE 5.80 Static meshes are commonly used
to hide problem areas when hiding terrain.

f NOTE
The actual number of meshes visible on the surface of

your terrain is aChieved with the following formula:

Val!Je of Density Man x OenSltyMultipller x

MaxPerQuao

This is how you keep track of the number of meshes
available on the surface.
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TABLE 5.3 DecoLayer Properties
-'-----------------------------

101 . DecoLLlyers are housed in a dynamic array. Layers are added as

needecl witholJt a given limit to a total number.

5

Al1gnToTerrain

Color~ap

DensityMultlplier

Disregardrerrainllghting

DrawOrder

This property controls the alignment of tile static meshes on the

terrain surface. A value of 0 will result In all static meshes

pOll)ting straight up, wllereas a value of 1 will result In the static

meshes aligning with the normal of the terrain surface upon

which It lVas generateo. This ar. 0 can help prevent meshes that

appear to (loat above !tlC surface in areas where the contour

changes dramatically.

RGBA8 is the required file Iype for this properly. TIle Illap fits

the terrain. rhe idea IS lor It to add color to the static meshes.

For example. If you had Cl pan of Ihe map colored red. any static

mesh in that area would also receive the color red. ThiS IS very

helpful If yOll are looking to mal<c some areas of grass appear

burnt. or even dead, whereas ot!"',er areas me green.

Mm/Max

ThiS properly allowS the ran60mization of how many static

meshes wi!! be viSible. TI,e densily of the !'>tatl(; meshes used

will be determined by the Density Map texture multiplied by this

value. Seillng dlfferel1l numbers for the Min and Max values will

generate a random number between the two.

This property is responsible for controlling whether tile stat"lc

mesh will use the Quad lighting information from the terrain or

will Ignore that Information. If the iliformatlon is ignored (tillS

projjerly is set to 1), the static rlles'l will HPpeClr.

This property :5 used to determine the order in which decora

lions for a given layer are drawn. Options are as lollows:

SORT_BackToFron t: This option Will cause the decorations

furthest away to be drawn first. TI~e closest decorations to the

player's view Will be drawn last. ThiS is the most common sel

ling, as the otner seulngs lend- to lean toward less realistic

results.

SOR r _NaSort: Uses no specific order.

SORT_FrantToBack: This option draws the Opposite of

SORT_BackToFront.
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TABLE 5.3 Continued

FadeoutRadius Min/Max

Determines the pOint at which static mesh decorations begin to

fade out and the point at which they are no longer vislble_ By
default, this property has a Min/Max value of 0, resulting in no

vIsible stalic meshes when painting on the DecoLayer occurs.

A value of 1 will force static meshes to use sunlight.

MaxPerOuad

Ran(lomYaw

ScaleMap

ScaleMultiplier

Seed

This determines the number of static meshes that can exist in a

Quad on the surface. A tYPical value IS 1.

By default, all decoration objects are aligned via rotation in the
same direction (around the Z-axIs). Setting this property to a
value of 1 will cause all of the <Jecoration objects to be ran
domly rotated along the Z-axis This helps to break Lip any tiling

appearance that is caused by the objects being all rotated the

same way.

The ScaleMap is an RGBA8 texture that IS used to determine

the size of the static meshes on a terrain. The size is generated
through the scale of the objects on an individual axis basis. The

red channel will affect the scale of wIdth (X·axis). the green
channel affects the length (Y-aXis), whereas the blue channel will

affect the height (Z-axls)_ The overall scale effect (tinal size) is
determined by the scale map color multiplied by the

Scalel.4ul tipller property settings.

X (Mrn/Max)/Y (Min/Max)/Z (Min/Max)

The ScaleMult iplie, generates a random scale factor for the

X, Y, and Z components of a decoration static mesh, The

designer enters a minimum and maxImum value for each axis_
When the static meshes are rendered, the meshes affected by

the ScaleMap (see ScaleMap in the immediately preceding item)

are then multiplied by the random number generated between
the Min and Max settings of this property. The final result is

then applied to the decoration resulting in the object's final size.

This property IS used to generate the random placement used
for static meshes. Althougn oensity is controlled through other

properties, the placement of static meshes within the deslg.

nated areas IS randomly generated. If the density IS correct but

the level deSIgner is not happy with the grouping of the static

meShes. the Seed property can be changed until the desired
look is achieved_
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TABLE 5.3 Continued

ShowOnlnV1SlbleTerrain

ShowOnTerraln

StaticMesh

This property determines whether a decoration will render If It

has been painted onto an area that has been flagged 1r1\/lsible.
Setting this value to 1 will cause the static mesh to render.
which then looks like a floatmg decoration. In most cases, yOu
woula leave this set to False. but effects like spider webs or
vines would require this property set to True.

T is property determines whether the static meshes will display
on the te'rGln, A value of 0 results in all static meshes associ·
ated With thiS Decolayer being I1luden. A value of 1 will make all
static meshes lor th,s DecoLayer VISible.

This property IS used to specify which static mesh will be
rendered for the given DecoLayer.

5
Summary
1n this chapter, we have discussed <1 great variety of techniques to create and cor.trol virtual land

scapes in your Unreal Engine projects. We discussed the general creation ot terrain, the imple

mentation of skyboxes, how to edit the shape of your terrain, and how to change and edit its

texture, We then covered how you can create laY'ers of decoration using groups of static meshe~.

At this point, you should be ready to cre2te a variety of environments for your Unreal worlds,

whether they are indoor or outcioor.
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Working with
Volumes

This chapter explains volumes in Unreal <1nd how to use them.

Volumes are used to bend the rules of (he nalurJI Unreal environ

ment to create such thmgs as water, lava, and slime_ This chapter

starts with <l simple discussion of the CO!i(e'pts ot'hind volumes and

explains how they are designed to work by giving some simple

examples of how to use them in yom U~l'edllevcl,.Next, you then

learn about volume properties, foclising cn the PhysicsVolume.

From there, Ihc chapter branch~s off to show how (Juids are created
and how you can use the FlUldSurf ace 1nfO Actor to create a wavy,

fluid-like surface for your liquid volumes. finally, you see how 10

use volumes to simdale the effect of a c1imbahle ladder in the game.
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Concept of Volumes
As mentioned, you Gm use volumes to create objects such as water, lava, slime, and ladders. To be
precise, a volume is an area that's "aware" of when a player enters or eXtls. \Vithin this volume,
you can chJnge the physical properties of your Unreal worlds, including gravity, terminal veloc
ity, friction, and much more.

By default, a single volume encompasses your entire level: the Detaul tPhysicsVolume. Each time
a new Actor is placed in your level, it's placed within this default volume 2nd remains there until
it enters another volume you have created.

To access the properties of the Def aultPhyslcsVolume, choose Edit> Search for Actors from !.he
main menu. In the Name text box, enter DefaultPhysicsVolL:me. The list of available volumes
narrows down to De f aul tPhys icsVolume0 long before you fLnish entering the text. Double-click

the Actor's name to select it, and open the Actor Properties window by clicking the Actor
Properties icon on the main toolbar. In this window, you could, for example, change the grav
ity of your entire level.

[f you want variation, however, you need to neatf your own volumes by using the Builder brush
to define the boundaries of a volume's area. YOtl don't add or subtract this brush from your level.
lnsleaJ, you click lhe Volume icon II to select the type of volume you want to create. TABLE 6.1

charts the available volumes.

TABLE 6.1 Volume Types

Volume Type

8lockingVolume

Volume

LadderVolume

PhysicsVolume

OefaultPhYSlcsVolume

WaterVolume

SnjplngVolume'"

LavaVolume

Description

Use this volume to create a collision area. Typically, It's an invisible

volume that deflects players but not projectiles.

This basic volume is essentially an area that keeps track of when

players enter or exit, but by default has 00 effect on gameplay.

This volume defmes an area that a player can "climb- like a ladder.

ThiS volume enhances the basic Volume and gives you more control

over the environment.

This default volume encompasses the entire level and is used

wherever a volume IS not defined.

ThiS volume is baSIcally a Phys icsVolume with a series of default

properties that create the effect of entering a mass of water.

You can use thiS volume to set locations where bots actively target

and snipe enemies.

ThiS volume IS simplY a PhysicsVolume with default properties set

to Inflict damage to the player when entermg the area.
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Volume Type

Continued
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Description

XFallingVolume~ ThIS PhysicsVolume hat; default properties geared toward a

bottomless-pit look. This volume kil!s your character when it enters
the area.

LlmitationVolume* This simple volume limits H1e entrance of objects such as
prOJectiles, translocators, and so on.

l1itScanBlocKingvolume* This subset of a Bl0Ckwgvolume blocks proJectiles.

PressureVolume At the time of this Writing, this volume is nonfunctional.

-Denotes that volume is available only In UT2004

FIGURE 6.1 graphs the relationship

of lhe available volumes J.nd shows

how rhey relate to a standard volume.

To create any of lhe~e volumes, simply

define a brush shape, slIch as a cube,

click the Volume icon, and selcct the

type of \'olume you want to use. The

neXl section explains the properties

yOll can change to customize how the
volume behaves when your characters

enter il.

Basic Volumes FIGURE 6.1 Volume relationships.

HI fSCan BIOCjd"~VOI ume

By itself, a basic volume doesn't have much functionality. It's simply <1 IOlll\d<ltion for all the other

volume types to build on. In this basic form, a volume is nothing more than an Acrol" that keeps
[rack of when players enter or exit its area. Volumes GlIl, however, be used to designate a location

with a specific name or be used along with the OecorationList Actor, whi.:h is disClIssed later in

the "OecoList" se~·tion.

Volume Properties

Under the Volume category of a volume's Properties window, you'll find" series of important

properties rhat can be 21tered to change the effect players experience when they enter the volume.

Two properties define your location: Loca t i onName ilnd Loca t lonPr 1.0 ri ty. loca t J.onName- is the

name you give to a particular volume. This property (?on be quite usdul tor tC<lm-based levels

because you can use it to get constant feedback on pbyer locations. Por example, if yOll had two
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bast's in your map, one for filch team, you could

create one massivt' volume Mound each base. For
one of the volumes, yuu could set the LocationName

property to BJse I, and the other could be set to
Base 2. As players entered or exited either base, you
could see their locations on your game's heads-up
display.

Locat lOnPrior i ty is useful when you have two or
more volumes overlapping each other. If a player is
standing in an uea with two intersecting volumes,
the volume with the- highe!" priority is used to desig

nale the plJyer's location, as shown in FIGURE 6.2.

2

•
t

Player

Name: Volume 1
Prfarily; 3

6

Specifying a volume priority is important because a

player can be in only one volume at a time, so only
the properties of the higher priority volume are
applied. A volume'.1 effe(ts are not amplified or

influenced by other volumes when two or more vol

umes are layered or intersecting.

OecoList

A voh\Jne's DecaL 1st property is used with a
Oecoratl.onList A'IOr. Thi~ Actor enables yOll to

creale a group of stati.: meshes that are placed
somewhat randomly within the volume. However,

static meshes are always projected onto the ground.

To use the DeCOl is! property, you simply specify
which Decora t ionLlst Actor the volume will use.
After placing a Decora t wnlls t Actor (choose

Actor> Keypoint > DecorationList from the menu)

in your scene, open its Properties window, wherE'
you'll notice a List category (see FIGURE 6.3). This
category contains the Dp,corat j ons property, which
begins simply as an empty array. When you click the

Add button MX( to Decorations, you see a series of
properties you can <ldiust.

FIGURE 6.2 The player is considered to
be in Volume 1 because that volume has a
higher priority.
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FIGURE 6.3 The DecorationList
Properties window.



The most important property in this lis! is

StaticMesh, which specifies which static mesh

is used for duplication in the volume. The rest

of the properties <lfe explained in TABLE 6.2.

TABLE 6.2 DecorationList Properties

Property Description
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NOTE
The "bOO in many of these properties specifies that the
property holds a Boolean value, meaning it can store
only the values True and False.

NOTE
I II you run Intu a ~itlJalJol1 ill which "Ialie ll1(:she~ aren·t

duplicating, try increasing the size of the level where
the volume eXists. This problem should happen only if
the area containing your vOlume is smaller than the
volume itself,

bAlign This true/false (lor 0) property determines whether static meshes are going
10 be aligned with the ground's curvature.

bRandomPl tch This true/false (lor 0) property determines whether to have random rotation
in the X·axis.

bRandomAoll ThiS true/false (lor 0) property determines whether to have random rotation
In the Y-axIs.

bRandOmYaw This true/false (1 or 0) property determines whether to have random rotation
ID the Z·axis.

Count rhis propelty contains Min and Max values for setting lhe range of how many
static meshes to place inside the volume.

DrawScale This property contains Min and Max values for generating a random number
within that range. This random number is used to set the OrawScale of
indiVidual static meshes.

TUTORIAL 6.1: Using the DecoList Property

1. Create a 512x512x512 room and subtract it from the world (see FIGURE 6.4). Apply a
simple texture to the room. place a light, and add a Player Start.

2. Create a new brush that's
128x12Bx128 and center it in the
room. FIGURE 6.5 snows thiS new
brush in the Top view. At this point, you

could move the brush to rest on the
floor, bul keeping It above the (Ioor
won't make much difference because
the volume projects static meshes

onto the ground anyway.
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FIGURE 6.4 Newly subtracted room.

6

FIGURE 6.5 Top view of new brush.
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3. Now go to the Volumes icon sel and cliCk

Volume. You won't see a noticeable difference
at this time, but a basic volume has been

created.

4. Move the Builder brush out of the way, and you
can see a grayish-pink cube in its place.

5. Next, open the Aclor Classes browser and click

Actor"'" Keypoint > DecorationList. Place this
Actor in the level and double-click it to open its

Properties Window. Under the List category,

click (he Add button next to the DecoratlOfls
property (see FIGURE 6.8).

6... Next, you need to set the StaticMesh P/'OP-
ellY. Open the Static Mesh browser and load
the Chapter6 package. Under (he Tree group,
select Cone. Back in the Decorationllst
Propen:ies window, select the StaticMesh

properry and click Use (see FIQURE 8.7).

7. To make 211 duplicated ilf\ms the same size.
set the DrawScale property's Min and Max: val.

ues 10 1. Far the Count property. set the Min
value to 10 and the Ma:.: value to 15 so that
the volume creates a range of duplicates (rom

10 to 15.

8. In the volume's Properties Window, go to the

Volume r,ategory an(J select the DeCOLlst

property_ Click the i='md bunon and then click
the DecorationList Actor Icon 1(\ your level (see

FIGUA£ 8.B). Your DecOLlst property IS now

working. RebUild the level and try running It.
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FIGURE 6.6 Add the Decorations
property.

FIGU RE '6.7 SettIng the Stat lcMesl,

property of the Deco ra tionLi st,

NOTE
Keep In mInd that you will not oe able to see the '
effects o( this DecoU st unless you rebuild and run
your level.
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FIGURE 8.8 DecoList in action.

END TUTORIAL 6.1

BlockingVolume

81 (JckingVolumes are essentially just volumes llsed to block certain objects, such as players. You
can think of a BlocKlngVolume as an invisible wall. It has three extra properties in addition to the

basic volume properties: bBlockActors, b81ockZeroEx te ntTraces, and b81ockKarma. These

properties, however, can be left untouched because the BlocklngVolume changes them by default.

TABLE 6.3 describes each of these properties.

TABLE 6.3

Property

BlockingVolume Properties

Description

bBlockActors

bBlcckZeroExtentTraces

bBlockKarma

When set to True, this property "blocks" actors from entering the

volume (default: True).

When set to True. this property 'blocks" projectiles (bullets,
grenades, and so on) from entering the volume (default: False).

When set to True, thiS property "blocks" Karma Actors and
causes them to interact With ,he a lccki ngVolume (default: True).



Basic Volumes 213

It might seem strange that bBlockZeroExtentTraces is set ro False, meaning that the volume

doesn't block projectiles. However, there's a good reason for this default setting. TypicaUy,

BlockingVolumes are used as collision meshes for highly detailed static meshes. You could, for

example, create a simple cylindrical BlockingVolume around a spiked sphere to effectively pre

vent players from running iDto the sphere and getting caught up in the spikes. It would also pre

vent Unreal from having to calculate per-polygon collisions. which is more processor intensive.

However. you still want the projectiles shot at the spiked sphere to have accurate collisions with

it. With bBlockZeroExtentTraces set to False, the BlockingVolume doesn't stop proiectues.

If you want to have the Block ingVolume block projectiles as well, you could simply set

bBlockZeroExtentTraces to True. Aternatively, you could use a second volume to do the trick.

The HitScanBlockingVolume is specifically designed for projectile deflection. It's simply an

extension to the basic BlockingVolume that sets bBlockZeroExtentTraces to True.

Under the BlockingVolume category are three properties unique to BlockingVolumes:

bClampFluld, bClassBlocker, and BlockedClasses. When bClampFluid is set to true,

FluidSurfacelnfo Actors take this BlockingVolume into accouIlt when clamping, or limiting the

action of, fluid surface vertices. This concept is discussed more thoroughly in the

"FluidSu rfaceI nfo" section, later in th is chapter.

The bClassBlocker and BlockedClasses properties work hand in hand. When bClassBlocker

is set to True, aU the classes specified in Bloc kedClasses collide with the BlockingVolume; noth

ing else will. These properties are an excellent way to control the types of collisions you get from

your volume.

TUTORIAL 6.2: Using a BlockingVolume

1. Create a 512x512x512 room and subtract it from the world. Apply a simple texture onto
the room, place a light, and add a player start.

2. Open the Static Mesh browser. and from the Chapter6 package under the BlockingVolume
grouP. select Spikes. Place this static mesh in the middle of the room (see FIGURE'. G.9).

3. If you run the level at this point, all collisions with the Spikes static mesh would be per
polygon, which means calculating the collisions would be slower. More important, it means
the player could easily get "stuck" in the Spikes. Even with only a Single polygon in the
player's path, the player would be held by the Spikes, even though that polygon might be
so small that you can't see it.

4. Therefore, you're going to add a BlockingVolume around this static mesh and remove all
collisions from the Spikes. Start by creating a cylmder With Height set to 64 and
OuterRadius set to 32.
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FIGURE 6.9 Place the Spikes static mesh in the middle of the room.

5. This cylinder \'VIII be slightly smaller tnan the Spikes static 'l1esh. but in this case, that's

good because It allows the player to get closer to the Sp Kes without notiCing the
BlockingVolume, Place tne cylinder around the Spikes, click the Volume icon. and select

810CkingVolume (see FIGURE 6.10).

FIGURE 6.10 Place a BlocklngVolume around the Spikes static mesh.
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6. If you run the level at this poinl, everything would seem to work fine. However. the player

IS still calculating coliisiMS wllh the Spikes, so you need to chat'lge Ihls 10 rem~ve any

excess calculahon ave/head. Open the Properties window for the Spikes slatic mesh and

go to 'he Collision calegory, Sel b81ockNon ZeroE l{ t entT races 10 False to effectively

remove colliSIons between players and thiS slatic mesh. However, leave

oB 10CkZerofxtent Trace S set to True because you want prOjectiles to continue cOlliding
wllh II,

7. Run the level, The player should now be colliding with the Block:\.nQVolume i(lSlead 0' the

Spikes static meSh.

END TUTORIAL 6.2

PhysicsVolume
As mentioned e:lrlier in this eha pIer, PhyS i cSVO lumes arc n

subset of vol umes thal add a variety oC propl"rl ies so Ihal you

(an manjpulal~ the enVironnlcnt's physics within thal 1101·

ume, This volume has two properly categories In addil iOll 10

t he baSIC vol ume prope rl ies: PhyS i c sVol ullle :. nd
VolumeFog. The Volume tab includt's me ~31Yle oprions LIS (or

a basic volume. FIGURE 6.11 shows the PhysicsVolume

Propertie5 wi ndo\lf.

These properties are covered lata in lhis section as they

become relcv:lnt. For now, st:lrt with a look at how to create a

sLippery floor by taking advantage of the GrounclFr lCtlon

properry.

FIGURE 6.11 The PhysicsVolume
Properties window.

TUTORIAL 6.3: Creating a Slippery Floor

1, Open Tutorla16_03_Start. ut2. You're gOIng to make the noor around the pit at the end

of Ihe room slippery. FIGURE 8.12 shows the empty room.

2. Create a cube and set Its Height 10 64, Width 10384, and Breadth to 512. Place it at the

end of the room over the Pit. Click the Volume icon and create a PhysicsVolume (see
FIGURE 6.13).
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FIGURE 6.12 Empty room.

FIGURE 6.13 Pnys1csVO lume covering the hole at the end of the room.
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3. Open the Properties windOw for the PhysicsVolUme. Under the PnysicsVolume category,

you'lI see the GroundFric t ion property_ The default value is 8, which means that after
pressing one of the direction keys and letting go, the player stops immediately, If you

decrease this value, the player starts sliding on the surface more. Set this property to
0.2. Now, after pressing a direction key and letting go, the player wIll continue moving for
a bit. as though sliding on ice,

4, Save lhe leve:l CInd lUll L1le gall Ie. Yuu ::,l1ould nuw have: a slJJJfJery floor.

END TUTORIAL 6.3

All uses of PhysicsVolumes are similar to TUTORIAL 6.3. It's simply a matter of setting a few

properties and knowing exactly what those properties do. TUTORIAL 6.4 shows yOll how to use
the TerminalVeloc1.ty property to prevent a player from suffering excessive damage after a long

drop.

TUTORIAL 6.4: Using the TerminalVelocity Property

1. Open lutoria16_04_Start. ut2. At the moment, the pit at the end of the room, shown in

FIGURE 6.14, can cause serious damage to unsuspecting players who fall into it. To
prevent thiS danger, you'll place a f'hysicsVolume at the very bottom of the Pit to prevent
speeds over a certain rate.

FIGURE 8,14 The pit of ine'Jitable doom.
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2, Create 3 128x256x256 cube and place it on the very bottom of the pit. Create a
PhY5~csVolume (see FIGURE 8 ..15).

6 FIGURE 6.15 Place a PhysicsVolume in the pit.

3, Open the Properties window for the PhysicsVolume and go to the PhysicsVolume category.
Change the TerminalVelocity property to 1000,

4, Rebuild and run the map. Now If players fall into the pit, they don't suffer any damage,

5, Save the map,

END TUTORIAL 6.4

Because you changed only the TerminalVelocl ty property, the area at the very bottom of the pit

still functions properly when a player jumps, dodges, or performs any other common moves.

WaterVolume

A Wate rVol ume is Hsed to <:reate areas that you want to fUl with a fluid of some sort so that play

ers can swi m in that area. It's basically just a Physicsvolume with a few changes to the default

properties. [n (act, changing a Physicsvolume's bWa terVolume property to True makes the vol

ume act like water. TABLE 6.4 shows the properties changrd in a WaterVclume and the purpose

of each.
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TABLE 6.4 WaterVolume Properties

Property Purpose

KExtraAngularOamping

KExtraLinearOamping

PhysicsVolume

bWaterVolume

EntrySound

ExitSound

FluidFrictlon

This property determines the flmollnt of force applied to

decrease the amount of angular movement (rotation) for Karma

Actors while they are in the volume (default: 0.1). *'
This property determmes the amount of force applied to

decrease linear movement for Karma Actors while they are in the

volume. The higher the number. the slower the movement
(defaUlt: 0.8)."

This true/false property determines whether a volume acts like

water (default: True).

This property sets the sound played when entering the volume.

When using a WaterVolume, however, changing this property

makes no difference because a default water sound is used.

This property sets the sound played when leaving a volume. Li\{e

Ent rySound, changing this J)roperty for a Wa te rVol ume makes

no difference.

If bWaterVolume is set to True, this property sets the amount of

hindrance to a player's movement in the water (defaUlt: 2.4).

Settmg thiS value to somewhere between 0 and 0.5 means play
ers can move Basily in the water. The higher tne number. the

harder it is to move around. However. increasing the number to.

say, 60,000 causes some interesting effetts. Movement in that
area becomes inverted: Forward becomes backward, left

becomes right, and so forth.
------------

l

I.

'Karma Actors are discussed In Chapter 11. "The Karma PhYSICS Engine.'

Aside from the properties in TABLE 6.4, another set of properties enables you to produce fog.
Ahhough these properties are available in a regular PhysicsVolume, the discussion of water
makes it a perfect time (0 explain them in detaiL Adding fog Hmits a player's visible range when
inside the volume. This effect can be immensely useful when creating \Vater effects to add murk
iness La the water or to limit a player's view with a fog effect. A blue fog is often used with
Wa t erVolumes.

Under the Volumefog category are four properties: bDistanceFog, DistanceFogColor,

DlstanceFogEnd, and Oist anceFogStart. Setting bOis t anceFog to True activates fog inside

that volume. DlstanceFogColor sets the fog color. DistanceFogStart defines where your fog
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begins based on the distance from your player
in Unreal units. DistanceFogEnd determines

where the fog ends. Everything after the point

set by DistanceFogEnd is pure dense fog with t
the wlor the DistanceFogColor propaly des·

ignates. FIGURE 6.16 demonstrates how

DistanceFogStart and otstanceFogEnd
work.

With that undl.'rstood, now you can try your

hand at creating a simple area of water in

TUTORIAL 6.5.

FIGURE 6.16 This diagram demonstrates
the result of Distance Fog.

TUTORIAL 6.5: Creating Water

1. Open Tutoria16_.05_Start.ut2_

2. Create a cube and set its Height to 512, Width to 256, and Breadth to 128. Using the

Skills you have learned, place a WaterVolume so that it rPosts on the bottom of the pool at

the left (see FIGURE 6.17).

FIGURE 6.17 A WaterVolume in place.
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3. Build and run the level. Although you don't see anyth'ng in the pool at the lett, irs now
filled with water. To make the water visible, you could just place a special Non·Solid brush
at the same location as the Wa terVolulfie and apply a water-like texture to it, but this
method makes the fluid look quite stagnant. That's where the FtuidSurtace I nfo Actor
(discussed in the following section) comes into play.

4. Save the map.

END TUTORIAL 6.5

FluidSurfaceInfo

The F1UldSurtacelnfo Actor is a plane of geometry that has noise deformation applied across

the surface over time, meaning that it's a sheet of triangles that ripple like liquid. You can find it

in the Actor Classes browser under Actor > Info > FluidSurfaceInfo, Because a

i"luidSurfacelnto is simply for decorative purposes, setting it up is quite easy. Simply place the

Actor in yOUT level. set its size, adjust a few properties, and you're done. TUTORIAL 8.8 shows

you how to add a FluidSurfaceln10 to the level you've been working on.

TUTORIAL 6.6: Adding a Surface to the Water

1. Open the Tutoria16_06_Start. ut2 map.

2. Place a FluidSlIrfacelnfo into the map (see FIGURE 6.18).

FIGURE 6.18 30 view of FluidSurTaceInfo,
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3, For your purposes, this FluidSurfaceInfo Actor IS far too big. Open its Properties window

and click the FluidSurfacelnfo tab, To modify its size, change Flu idXSize to 8 and

FluidYSize to 16 (see FIGURE 6.19). 't's a gOOD practice to always make these values

powers of 2. Each grid's size is determined by FluidGridSpacing, which is, by default.
set to 24, Therefore, this grid fills approximately (8·1) x 24, or 168 units. (You subtract

one because the grid size is zero based.) Right now, FluidGridType is set to
FGT_Hexagona 1, which specifies how the indiVidual vertices are arranged, This setting

causes the grid to take up a little more space than your calculClted value. In fact. it would
take up 180 units, which is 168 plus half the FluidGridSpacing selting. Place this on

the lop of the WaterVolume, If you can't see it in the Side view, tum on the Realtime

Preview for a moment. This feature causes some deformation on the FluidSurfacelnfc

so that you can see it 1(\ the viewport.

6

FIGU RE 6.19 FluidSurfaceInfo resized to fit the pool space.

4. Obviously, the default matenal for this surface isn't appropriate, Open the Texture browser

and select AWGlobal.utx > OceanGlass. To apply this texture to the surface, open the

Properlles window for the FluldSurfacelnfo and go to Display" SkIns. Add a new entry

to the list, and click the Use button on index O. You now have a water·like surface that

ripples (see FIGURE 6.20).

5. Rebuild and play the map. When you're done, save the map.
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FIGURE 6.20 The OcearlGlass material applied to the FluiclSurfacelrlfo.

EN TUTORIAL 6.6

The propert ies (or rhe Flu IdSurf ace I nfo are quite daunting at first glance. However, TABLE 6.6

explains tht important properties.

TABLE 6.5 FluidSurfacelnfo Properties

Property Purpose

FluiaColor This property determines the color of the surface in a wireframe view. It
doesn't actually change the surface during gameplay.

FluldHelghtScale

FluidNoiseFrequency

fluidNolSeStrength

FluidSpeed

FluldTlmeScale

This property sets the size of the waves. The larger the number, the
taller the waves.

This property can be thought of as the randomness of the f1uid's
movement. The higher the number, the more "frequent" the ripples are.

This property determines the size or amplitude of the noise. The
amplitude can be anywhere between the Min and Max values.

This property controls the speed of the noise, but also affects the way
in which the noise changes.

This properly also controls the speed of the noise, but it has no erfecl
on the way in which the nOise changes. It Simply controls how fast it
fluctuates.
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FluidSurfaceOscillator

The FlUldSurfaceOscillator Actor is used to add ripples to your FluidSurfaceInfo. You

can find it in the Actors browser under Actor> FluidSurfaceOscillator. To use this Actor, sim

ply place il in \'our level on the FluidSurfaceInfo where you want the ripples to originate.

Then, in the Properties window for your FluidSurfaceOscillator, go to the

FluidSurfaceOsciliator tab. Click the Find button and select the FluidSurfacelnfo you want

to add the ripples to. Now it's just a matter of tweaking a few settings. TABLE 6.6 lists the

properties and their uses.

TAB LE 6.6 Flu idSu rfaceOsc illator Properties

Property Purpose

Fr eq uency This property sets the number of ripples the FluidSu r f aceOs c i 11ator
generates every second.

Phase This property enables you to change the phase of the oscillator. You might want
to give each oscillator influencing the same F luidSurf acel nfo a different
phase to keep the flUids from canceling out each other's motion.

Radius If you consider the oscillator as a pebble being thrown repeatedly into the
FluidSurfaceInfo. this property determines the size of the pebble.

St rength This property controls the amount of force that goes into each ripple.

LavaVolume

A lavaVolume is a PhysicsVolume that behaves like lava. The main difference is that it causes

damage. This volume introduces three properties tbat haven't been covered yet: DamagePerSec,

DamageType,and bPainCauslng.

After you set bPainCausing to True, entering the volume causes a certain amount of damage

every second: this value is controlled by DamagePerSec. The default value is 40, which means 40

units of damage take place every second. You can, however, control the type of damage that's

applied. By default, DamageType is set to FellLava, which means that after a player dies in the

lava, he'll turn into a skeleton and fall into the pit of doom.
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TUTORIAL 6.7: Using a LavaVolume

1. Open Tlltoria16 07 StarC.llt2.

2, Right~IICk lhe WaterVollllne and chOOse POlygons" To Brush, Now the Builder brush IS

Ihe same size as the Wa l erVol ulle 'IOU worked WIth in TU TO RIA LEi, 6. Move the Builder

brush over [he pit althe rigtll, Use [he skills you have learned to create a LavaVolullle

(see FIGURE 6,:21).

FIGU RE 6.21. The Lav aVol ume In place,

J, AI this polnt,lhe lava Should work correclly, Dul you won'l see It. Therefore. you need 10

add a Fllli oSur t ace In t 0 wi Ih a lava teJcture applied \0 It. $elecl Ihe 'Wa ter's

FluidSurfacelnfo. duplicate it. and move 1\ over the pit on ,lie nght. Open the lex(ure

browser and select the Tel'Osctllatorl teX'Cure from the SC_yolcano_lu()( te)(]ure package,

Open lhe PropertIes Window (or the new FluldSurf acel nfo and go to the Display cate
gory Cltck the Use buuon on indel' 0 of the Slc"ins P1<''>~rty (see FItHIAE 8_22)

4. Rebuild the m2p and run It. You should now have damage-caustng lava, When you're done.

save the map.
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FIGURE 6.22 A Magma texture applied to the FluidSurfacelnfo.

END TUTORIAL 6.7

XFallingVolume

The XFall wgVolume is .ilinosr identical to the LavaVolume except that the damage type and amount

of damage per second have changed. This volume kills players when they enter it, so it's usefuJ when
you want to simu.late a pit or similar trap. To use it, just create the volume as you have created all the

other volumes. TABLE 6.7 shows the important properties and their default values.

TABLE 6.7 XFa 11 i ngVo 1ume Properties

Property Default Value

DamagePerSec 100

DamageType cia 55' Fe II'

bPa inCaus 1 ng True
----- -----------------------------

LadderVolume

Jn rna 11)' games, especially singJe-playcl garnes, often you want to have ladders for players to

climb. You can do this easily with the LadderVOlume. After entering the volume, you can "walk"

up and down the ladder by moving forward ~nd b~ckward and jump off the ladder by using the

jump button. Note, ho.....ever, thai going back do..... n the ladder can be hnrd after you're at the top.



PhySlcsVolume ~21

TUTORIAL 8.8: Creating a LadderVolume

1. Ll)8d ttle Tutor.l.a16_0S_S cart, ut 2 map, which contains a tall room wi1h a lit1\e shelter

at the lop (see FIGURE 6.23), ThIs shelter is auesslble only through the currently

nonlunctlonal ladder,

FIGURE 6.23 Room with a ladder.

2. Create a brush and set its Height to

808, Wldlh to 64. and Breadlh to 84.

3. Align this brush with the wall and

ground. Click the Volume Icon, and

create a Ladde ..Vo lUine at lhis loca\lon
(see FIGURE 6.24).

NOTE
For purposes of 'oot nill/lgaUon, a LadoerVo lume
should be 40 units hlghBr then 1M lOP ot Ule area til

be climbed. For mora InfonnaUon OIl bot navigation,
please reler to Chllpler 12. "Advanced Bot/AI
Navigation:

L- .:....- . ...J

4. You've created the ladder. but nOllce lhal an arrow ;s pointing east aul of the

LadoerVolui'le. This arrow needs to be pointing toward Ihe wall. in the direction {he player

would helve to face to climb the ladder.

5. In the Properties window lor the La dde rVo 1Ullle, lOOk under the ladderVolume category lo

find the V/allDir propertY. ThiS property IS used to sel the direction your player needs to

face to chrnb lhe ladder. typlcally toward the wall. In lhis case, you want the arrow to be

pointing nonh. which requires setting Yaw 10 49152. TABLE 6.8 shows the values you
need 10 use for each direction.
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FIGURE 6.24 A Laddervolume placed in the right position.

6 TABLE 8.8 Rotation Settings for the Cardinal Directions

Yaw

4.9152

o
16384

32768

Direction

North

South

East

West

6. Open the Propel1.Jes window for the

LadderVo lUine and go (0 the

LadderVolume category. Set the

WallDir propertY's Yaw to 49152
(North).

NOTE
For more Informatlon on how Un rea I hand les rilla·
tion. p'ea~e refer to Chapter fl, -Creating Ma reria Is
in Unreal:

I _

7, Rebuild and run the map. The ladder should now be working properly. When you're done,

save the map.

END TUTORIAL 6.8
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After rebuilding the map. you might have noticed something rather interesting. You now have two

Au toLadder Actors in your map: one at the top of the ladder and one at the bottom. These Actors

are navigation points created so that bots can use the ladders. If you prefer to create these points

manually, you must set the bAutOPath property of the LadderVolume to False so that it doesn't

automatically generate the AutoLadder Actors. Then you would have to place Ladder Actors

(Actor> NavigationPoint > SmallNavigationPoint > Ladder in the Actor Classes browser) at the

top and bottom of the ladder and make sure they pointed toward the wall, just like the

LadderVolume. Bats would then be able to use the ladder.

You can set two other useful properties for a LadderVolume: ClimbingAnimation and

TopAnimation. ClimbillgAlllmation specifies which animation to use when a player is climbing

up the ladder. TopAnimation speciftes the animation to use when a player reaches the top of the

ladder.

Suml1nary

At this point, you should have a thorough understanding of the properties and uses for a variety

of volume types. Volumes ciln be used to add more character and playability to your levels.

However, as a level designer, you should be careful not to overuse them. As a general rule, vol

umes should be added only when they enhance gameplay or improve your level's look and feel.

Tn Chapter 7, "Lighting in Unreal;' you see how to create and control lights in your Unreal levels.
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Lighting in Unreal

In this chapter, you look at the lights available in Unreal and how

you can LISe them in your projects. This chapter discusses how the

Unreal Engine uses light and creates dark and light areas in your

maps. The properties available to control the look and behavior of

lights are covered as well as special effects that can be applied to your

lights. From there, lighting workflow and the importance of rebuild

ing lighls are explained.

Also, you learn how light affects a variety of surfaces in Unreal,

including world geometry (constructive solid geometry; eSG), sta

tic meshes, Movers, terrain, and more. Advanced lighting effects are

also covered, such as using ambient lighting, how other Actors can

emit light, and how to use a TriggerLight, which is a dynamic light

that can bE.' animated to create a variety of effects. In additioll, this

chaptcr discusses projectors and how to use them in YOllr maps. The

chapter closes with a discussion of some common lighting pitfalls

for beginners.
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Light Concepts
This section covers the fundamental concepts behind Unreal's lighting system. You'll begin by

taking a look at light rnaps and how they are created, and then Jearn the impor ta nee of light place
ment in your levels and how light location influences the look of your light maps.

Ught Maps

One of the key factors in Unre,,1 lighting is the creation of your level's light maps. Essentially, a
light map is a texture placed over all world geometry in your level, which is then blended with
the existi.!1g level texture. This blending between your light maps and level texture can create

some areas that are complelely black and other areas that are so intensely IiI that the texture is
washed Oill. Whenevt'f you rebuild tht' lighting in your level, the light maps are recalculated and
regenerat cd.

When creating light maps, you must remember that they are static, meaning they don't move. You

can use light maps to create very realistic shadows in your levels, but you cannot make tbose shad
ows move as you play. The benefit of this architecture is that all your level's shadows are precal
culated, instead of having to be constantly updated at runtime. This precakulation allows for
beautiful lighting and shadow effects that remain steadfds! while you play the game. Throughout
this chapter, you'll see a variety of ways you Can control the clarity of shadows created with your
light maps and the overJIJ look of the light maps. In FIGURE 7.1, you can see the result or light
maps, with shadows created on the level's walL

FIGURE 7.1 The shadows in this image are precalculated, meaning they are static and never
change.



FIGURE 7.2 Detailed shadows in DM-Gael,
created by static lights.
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Light Placement

Light maps are created based 011 a series of factors; one of the most important is the placement

of lights in your level. As you position lights in your worlds, you must take many things into
account. You must consider the look you're trying to achieve, the textures on the surtaces you're
lighting, the position of surrounding geometry, and what the sh2dows from that geometry will
look like. If your lights are too close to the surface being [it, the light will have an unrealistic dim

ness; if they are too far away, the surface might also be too dim, Make sure you pay special atten
tion to the kinds of lights you're using and how you're adjusting their properties, For example, jf

you're ,rying to create a room with dramatic shadows, you must make sure your lights are placed
at an interesting angle in relation to the scene's geometry. You must also make sure you don't use

too mar.y lights, as this can wash shadows out. At the end of this chapler, in "Common Lighting
Pitfalls," is a series of common problems many beginning lighters make.

Light Classification
Two main kinds of lights are available in Unreal: static lights and dynamic lights. The fundamen
tal difference IS that dynamic lights can be animated, and static lights cannot. The following sub
sections examine both lights, describe how they are used, and explain some rules you must keep
in mind when placing them in your levels.

Static Lights

St3tl( lights, also called normal lights, are

thr main light type used to light your lev
els in Unreal. Only static lights can be used
to create light maps, so all cast shadows in
your level must be created by static lights.
As their name implies, static lights are
intended to be stationary. Even if yOLl

could move a static light's Actor in the
game, the visual effect of its emitted light

would remain unchanged. Even if you
forced a Sl2tic light to animate, its subse
quent shadows would stay stiJJ because
arras of light and shadow in yoor levels are
created witJ) light maps. This behavior
makes it possible to have beautifully realjstic shadows (see FIGURE 7.2) without constantly
updating them during gamepla)', but aLso means you should never force a static light to animate.
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on the other hand, has no maximum value. You must use this property with care, however, as set
ting it too high can make your textures look overbright. Typically, you should stick with values of

255 or lower to keep the light's falloff (the amOU!1t at which it fades at a given distance) from
looking unrealistic

Ught Radius

Every light in Unreal has an area of effect.
which is ddermined by the LightAadius

property. Within the radius set by this
property i~ at least some amount of light.

Outside a light's radius. no light exists.
Th is pro pert y gives you a useful way to
inueast' a light's intensity. Using this prop

erly, you can control the distance thai light
travels from its source. In FIGURES 7.4

and 7.5, you can see the effects of small
and large Ligh tRadius settings. FIGURE 7.4 Asingle light with a small radius.

Light Type and Light Effects

The Light Type property has been made

obsolete in rum! versions of the Unreal
Engine. Ifl the past, this property enabled

yOll to create lights that pulsed, flickered,
or behaved like strobe lights. You can still
create :hesc effects, but you must use a new

kind of Actor called a ProJector. Projectors

and some of the remaining LightEffects are
discussed later in this chapter.

FIGURE 7.5 A single light with a large radius.
Directional Lights

A dirwionallight can be alJned in a specific direction, like a flashlight. Technically, a directional
light is any light with its bOirectlOnal property set to True. You can set it yourself, or you can
create Actors that have the property already set. There are two such Actors: Sunlight and
Spotlight. In the following subsections. you see how these Actors can be used in your scenes.

Sunlight

A Sunlight is a special kind of Actor that enables you to simulate a light source that's infinitely far
away, such as tbe SUIl. It's especially useful for olltdoor levels or any environment where you can
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4. Add two lights about 128 units away

(rom the ~enter of the new skybox

(see FIGURE 7.9).

5. Double-click one of the lights. and in
the Properties window, open the

LlghtColor tab. Set the following
propertie s:

LigntHue: 25

LlghtSaturation: 100

6. Open the Actor Class browser.

expand Info> Zonelnfo, and click FIGURE 7.9 lights added to the skybox.
SkyZonelnfo. Rlght,click the floor of

the skybox, and choose Add
SkyZonelnfo Here. Move the new

Actor close to the floor of the Skybox.

7. In the main room. select all the faces of the top cube-the surfaces above the cross

beams. Right-click one of the selected surfaces, and choose Surface Properties,

8. Under the Flags tab, click the Fake Backdrop check box, and close the window. Rebuild the

level's lighting. and activate Textured view in the 3D viewport. You can now press K to acti
vate the skybox preview, Notice that the upper part of the main room appears to open into

a cloudy sky and that the clouds don't move In relation to the camera.

9. Deactivate the preview by pressing K again. Save the level when flrllshed.

END TUTORIAL 7.1

In TUTORIAL 7.2, you place a Sunlight in the level, which emits light from the fake backdrop of

the level's upper surfaces. You then position and aim Ihis light and use illO caSl parallel shadows

onto the level's floor.

TUTORIAL 7.2: Creating a Sunlight

1. Continue from TUTORIAL "1.1, or open thl:! file saved at tne end of tnat tutorial. In the
Actor Class browser, select Light> Sunlight. Right-click and place thiS Actor anywhere in

the main room, Its position is irrelevant, but for thiS example, place it in one of the room's
upper corners (see fiGURE 7.10).

2. On the 3D viewport toolbar. click the Lock to Selected Actor iCOn, and then click the
Sunlignt Actor. The camera jumps \0 the exact location and orientation of the Sunlight.

3. As long as Lock to Selected Actor IS active, when you rotate the camera, the Sunlight
rotates as well. In a sense, you're using the camera to aim the light. Rotate the camera so
that the crosshairs point at the center of the crossbeams. as shown in FIGURE 7.11..
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FIGU RE 7.10 Sunlight added to main room.

7

4. Deactivate the Lock to Selected

Actor option, and move lre camera

away from the Sunlight.

S. Double-click the SunlighllD open its

Properties window, and lren expand

the light Color tab. Set the following
properties:

lightHue: 31

LightSaturatjoll: 143

6. Next. you need 10 create a "filler"

light to soften the shadows in the

main room. HoJdmg down the L key.

click 0:1 the center of the main

room's floor.

FIGURE 7.11 Sunlight aligned by using lock to
Selected Actor.

7. Double-click the new light to open its Properties wmdow. and open the lighting tab_ Set

the L 19htEffect property to LE_Non Inc ldence.

8. RebUild and SWitch to Dynamic light mOde In the 3D viewport. Notice that the shadows on

Ihe ground are a bit blurry.
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9. Select all five surfaces of the bot·
tom half of the room. The easiest

way to do this IS to select one wall

and press Shift+8-

1.0. Right-click any of the seier-ted walls,
and choose Surface PropertiBs from

the context menu.

11. Under the Pan/Rot/Scale tab, set
Light Map to 8, and rebuild the

lights. The final result should look
something like FIGURE 7.12.

FIGURE 7.12 Clean shadows from an adjusted
Light Map value.

END TUTORIAL 7.2

Spotlights

Spotlights arr spetial Actors that create a directional light you (al\ aim around your level, much
like their real-world counterparts. Spotlights are a useful way to CfeJle realistic lighting in your
levels, such as lamps, searchlights, and more. In TUTORIA L 7.3, you learn how to create and aim

Spotlights to control the look oflighg in your levels.

TUTORIAL 7.3: Using Spotlights

1. Open the Spot light_start. ut2
file, which contains a large room

with a tall stone pedestal in the
center (see FIGURE 7.13),

2. To create a Spotlight, in the Actor

Class browser, expand Light. and

select Spotlight

3. Right·click in one of the upper cor

ners of the room, and choose Add
Spotlight Here. If you (ook at this

new Actor in the Top viewport, you

can see an arrow pointmg out of it

(see FIGURE 7.14). This arrow

means that it's a directional light

FIGURE 7.13 A view of the
Spothghf_ start:. ut2 level.
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4. Using the skills you learfled If)

TUTORIAL 7.2, click the lock 10

Sele(;ted Actor tcon to aim the light

at the StOM pedeslal in the middle

of the room (see FIGURE 7.16).

5. Deactivate 'he Lock to Selected
Actor option, ofld sel the fOllowing
propen,es for the light:

In the L1ghtColor lab

LlghlBnghl ness: 128

LlghtHue: 170

lightSaturatlon: 178

In the Ughtlng tab

LlghlRadlus: 128

8. RebUild lighting, and lesl the level. A

Player Start has already been cre·

aled (or you. Notice thaI the IIghl IS
slaying within a cone shape (see

FIGURE 7.16). You can change the

size of this cone to suit your fleeds.

Exit Unreal when finiShed. and go
bad< 10 UnrealEd.

7 7. In the Spotlight'S Properties window.

OPen the lighting tab. ;:jnd set

LightCone to 64 Notice In lhe 3D

viewport thai the cone of lignt gets

smaller.

8. You (\{lW have less light 1(1 your level.

The light was (airly dim alrea<lY. so

coumeract the smaller Itght cone by

~e"ing LightBrightness to 200.

9. Rebuild your level. The effect Should

be similar to blight moonlight (see

FIGURE 7.17). Test your level and

see what it looks like.

END TUTORIAL 7.3

FIGUUlE 7.14 Spotlight added to t11e comer 01
the room.

FIGU AE 7.16 Spotlight al\gJ'lecl using lock \0
Selected Actor.

flGU RE 7.18 Current lighting reSUlt after setting
~Ior and radius properties.

FIGURE 7.17 Final result.
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Lighting Workflow
When you first begin working with lights and trying to light your levels. you must first think

about the appropriate light types for different situations, such as a Sunlight for outdoor effects or

a Spotlight for theatrically focused light effects. You have ta be able to control how you see lights

ill the viewports, how to fine-tune properties such as light falloff, and how and when to rebuild

your light maps. At times you might also need ta export your light maps from UnrealEd so that

you can edit them in another program. In the following sections, you learn how to approach these

aspects of lighting.

Light Creation

You have already seen basic light creation in UnreaJEd through several chaplez:s of this book.

There are, however. a few workflow aspects of tight creation that still need to be discussed. This

sectian covers some new methods for creating lights in UnrealEd.

The first way to create lights has alrc3dy been explained: Simply right-click on a surface, and

choose Add Light Here. This method is most easily done in the 3D viewport. as you have more

precise control over exactly where the light is placed. You can do this in orthographic views if you

like, but you'll find that the light might not always be placed exactly where you want it. For exam

ple, if you place a light in a room using the Top viewport, the light might not be positioned cor

rectly in the Z-axis (vertically), especiaHy if your level had several floors. For this reason, creating

your lights by right-clicking a surface in the 3D viewport is usuaUy easier and more accurate.

The second method for creating lights is much faster than using the right-click method. You can

automatically create a light by holding down the L key and clicking. This method is similar to

llsing the right-click menu, in that yOll have more precise placement by using the 3D viewport

rather than orthographic views, but you don't have to worry about navigating the context menu.

Another important method for creating your lights is simple duplication. This method becomes

important when you need a light with the same settings as one already placed in your level. Say,

for example, that you have set up a certain light with just the right color and brightness, and you

need to create one just like it. Simply duplicating the one you have already is much faster than

building one from scratch and adjusting all its properties.

Viewing Lights

When working wi.th lights in your levels, being able to control how you see them is important. In

UnrealEd, you can alter tJ)e way lights appear based on the type of lighting task you're doing. This

section describes some viewport settings that control ho,,", yOll see lights in your levels.

The first mode--the default mode for the Perspective viewport-is the Dynamic Light mode.

You'll probably use this viewport mode most often when working with lights in UnrealEd. This

mode enables you to see all light maps and cast shadows created when you rebuild your lights and
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gives you the dosest possible approxima

tion of what the level will look like during

play (sec FIGURE 7.18). When you first

create a light, the viewport gets brighter

while you're in this mode. However, this

preview is only an esltmate oi >'our light

maps and doesn't include shadows. You

must rebuild your lights to see the effect of

any light changes.

Textured mode enables you to see your

level without lighting being a factor. All

lighting in the level is equal, with no shad·
ows of any kind (see FIGU RE 7.19). The

effect is much like turning on a single mas

ter light for your level. This mode can be

handy when you're worldng on a dark or
dimly lit level and need 10 see your work

space. However, you must remember to

switch back to Dynamic Light mode if you

want to see Ihe effects of your lights. For

this reason, typically you don't use

Textured mode much when creating or

placing lights.

Lighting Only mode deactivates all tex

tures in your level, leaving only the light

maps on a dean white surface (see

FIQU RE 7.20). This mode is perfect for

viewing your level's shadows without hav·

ing to work around any textures you might

have. For example, say you've created a

level with dark texlures. Controlling the

eX.act location of all your shadows could be

difficult if they were placed on top of these

textures. With Lighting Only mode, seeing

where all your shadows are falling is much

easier.

Radii view is a special setting that can be

used in ;lny viewport. To access this view,

right-click on a blank area of the viewport,

FIGURE 7.18 Map with viewport in Dynamic
Light mode.

FIGURE 7.19 Map with viewport in Textured
mode.

FIGURE 7.20 Map with viewport in Lighting Only
mode.
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and dloo..~e Actor> Radii View. This view enables you \0 Sf'e any AClor's area of effect. For lights,
jt's based on the LightRadius property found under the Lighting tab of 'he Properties window.
A ligh,'s radius Lan be thought of as the maximum distance Ihat lighl travels (rom it.s .sOli ree. In
'he viewport, a radi us is ~en as a large red circle (see FI GU RE 7.21). No light (a lis outside Ihis

ciTcle, Thcrefore, you c,an use the Radii view to make certain UH' lighl'~ radIUS acwaJ[y efldo~e5

your level. You want 10 keep all surfaces requiring light from a single source to be wi!.h\fl lMat
source's radius.

FIGURE 1.21 An ortjlographlc view with light radIus.

Working with Ught Effects

Now thai you know each Light has a radius,
aIld you've se~n how 10 view that radius,
you can leam how light eh.mges inside the
radius. Fal1.t>ffis the degradation of light as
il ge,s farther from i,s source. For example,
the farther an object is from a light, the less
lighl it receives.

You can think or falloff as a grad icnl that

moves from 'he light source to the edge of
the radius. going from light 10 dark
(see FIGURE 7.22). By changing [he
(aJ\off, you can greatly :liter the look of
yoW" [igh I~. Ln Unreal, $('vcraJ Lighl Effect

FIGURE 7.22 The falloff range is determined by
the LightRadius.
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settings, discussed in the following S('(

tions, control falloff. You can find them
under the LIght Effect property in the
Lighting tab of th(' Properties window,

LE_None

LE None is the default setting for the
lightEffect property. (t generates a con
stant rate of falloff from the source of the
light to the radius. For example, as soon
as an object is moved away from the light,
it begins to receive less light from the

source. The location of the light Actor
receives 100% illumination, and objects
past the edge of the radius receive no light
at all. Between those points is a constant
decrease 10 light intensity (see
FIGURE 7.23).

LE_Nonlncidence

The U:_NonIncidence setting change!>
the faJloff so that the light stays bright
closer to its !>ourcc, and then fall!> off
quickly as it approaches the radius (see
FIGURE 7.24). This selling is handy
when you're trying to create brighter
lights that don't fade as much as standard

lights.

LE_QuadraticNonlncidence

A QUJdratic Non -Incidence light
behaves similarly to a regular Non

Incidenc(> light, but with even less light

decay. This means the light stays bright
much farther from the source, and then
talls off rapidly near the edge of the
radius (see FIGURE 7.25). This setting

can be useful if you're trying to simulat~

the hot spot or light cone of a spotlight.

FIGURE 7.23 A light in the comer set to
LE._NONE.

FIGURE 7.24 A light in the comer set to
LE._Non!nCJ.dence.

FIGURE 7.25 Room with a Quadratic
Non-Incidence light In the corner.
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Animated Light Effects

Animated light effects are also available, such as LE_Disco, LE_Rotor, and LE_Warp. These effects
3re animated only within UnrcalEd, however, and move only until you rebuild your lights. The
effect is then baked into the light maps and is no longer animated inside the level. You can use
animated light effects to create interesting static effects for your lights; however, keep in mind that
each time you rebuild, the effect is slightly different.

Rebuilding Lights

Whenever you add or t.hange lights in your level, you need 10 rebuild those lights 10 s/'e how yOllr
changes affect your light maps. For example, when you change your lights' color or brightness,
the 3D viewport gets brighter as soon as you alter a property. This preview, however, is not an
exact n'preseotation of the lights in your level. In TUTORIA L 7.4, you see the importance of

rebuilding your lights when you edit their placement Of quantity.

FIGURE 7.27 Second light added to the level.

1.. Open the Rebulldlog1 . ut2 file,
which contains a room similar to
lhe one you have used in previous

tutorials.

3. Rebuild your lighting to see what the
shadows look like. Compare your FIGURE 1.26 light placed next to a wall.

results with FIGURE 7.28.

4. Create a second light In the room,
USing any means you choose. Notice
that as soon as the new light is cre·
ated, your shadows look different.

Rebuild your lights to see the new
shadows (see FIGURE 7.27).

2. Using the skills you have learned,
place a light somewhere in the level
to create an interesting shadow
from the pedestal in the middle of
the room.

TUTORIAL 7.4: Rebuilding Lighting
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5. Now select either light. and mOve it

to a new location. As soon as yOll

do thiS, the shadows associated

with that light cease to p,xist. Tne

engine is trying to give you an

approximation of the light based

on where you move it (see

FIGURE 7.28). The effect is

similar to the look of dynamic

lights moved in·game.

6. Now rebUild the lights. and see the

new shadows you have created (see

FIGURE 7.29). Whenever you

move or change il light, you must

rebuild your lignl map to gel a clear

picture of what the new posItion or

settings create in your level.

END TUTORIAL 7.4

FIGURE 7.28 Approximated lighting after moving
the light.

FIGURE 7.29 Flnallightlng after rebuilding.

Whe" working with lighting, remember that you might not alw~ys need to rebuild every single light
in your level. Although running a full rebuild before you play-test or finalize a level is a good idea.
you can save a great deal of time by using the Build Changed lights Only button on the toolbar. In

TUTORIAL 7.5, you see how this tool works and how you can use it to speed up your lighting

workflow,

TUTORIAL 7.5: Rebuilding Changed Lights

1. Open the RebuUding2.ut2 file.

You'll see the hangar and control

room level created in Chapter 3,

"Creating Your First Level with

UnrealEd:'

2. Navigate into the hangar area. where

you'll see a series of girders with a

pair of lights behind them (see
FIGURE 7.30),

FIGURE 7.30 Backlit girders.
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3. ThiS scene would look better with

one light behind each girder. Using
the skills you have leamed, move the

two eXisting lights, aM piece one
behind each girder, but don't rebuild

the lighllng yet.

4. Because thIS level IS already large and

delalled, rebuilding all the lights would

take some time. Instead. you can tell

UnrealEd 10 rebuild only lhe lights you

have changed. Click the Build Change<! FIGU RE 7.31 FInal result
Ugh!S icon on the toolbar.

S, This method is moch (aster than rebuilding every light jn your level. If you like, you can try

rebuilding all lights, JuSI 10 make a comoartson. When finished. you should bave something
like FIGURE 7.31.

END TUTORIAL 7.5

Ugirt Map Size

YOl! can conlrollhe accuracy o( your light maps with the Light Mnp,se-r1ing in the Surface Properties

window. This properlY ronlro).s the resD)u,ion o( y'our ught maps to ch.ulge their delail. The higher

you set this value, the less accutd{e your shadows look on the su(face. If {he:: number is lower, your

shadows arc much more crisp, However, bcc.ause you're i.ncreasing th.e light IIDlp'S resolution, in
eff'tX<, you're cruting a larger c.akuJillion, This docsn'l mean you always slow dow n ga meplClY if you
use )[)\ver Ught Map si:u seMi ngs. Rather, it's iusl a remmdcr that your .~hadows don't alwnys need

to be perfec.tly sharp. In fact, lower resoluu6n shadows often ac-ate a soft shadow effect, such as

when an objecl is iiI by muhiple light sources from Ole s.aDll: gl:Jlnal diroolon.ln TUTORIAL 7.6,

you le;nn h011l 10 adjusl the Llgnl Map Se<"liJlg to GOnlrollhl' look of your ;hadows,

TUTORIAL 7.6: Adjusting Light Map Size

1. Open the LightMap_s t ar t . u t 2 fIle.
You'tl see a cyltndric.al room wilh a

gIrder hovel1ng rn the middle and a

Iighl behind 1(. Notice that the

girder'~ shadow crosses aver five

surfaces on the wall.

2. Select Ihe leflmosl surface ltIat's
receiVing a shadow from the gir(Jer

(see FIGURE 7,32). Right-click on

lhe surface, and choose Sur1ace
Properties, FIGU RE 7.32 Leftmost surface selected.
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3_ In the Pan/Rot/Scale tab. change

the light Map value to 1.0 (see
FIGURE 7.33), the sharpest

settlng you can achieve.

4. Select the next surface to the nght,
and repeat step 3. setting light
Map to 4.

5. Using these technIQues. set the
Light Map value (or the next face to

the fight to 16. Set the next sur
face's Light Map to 64 and the lasl

surface to 256.

6. Rebuild your lighting, and notice the

differences In ShadOw Clarity. On the
left, you have very sharp shadows.

As you move to the nght. the shad·

ows become more vague until
they're barely distinguishable (see
FIGURE 7.34).

END TUTORIAL 7.6

FIGURE 7.33 light map vallie set to 1.

FIGURE 7.34 Final result.

YOll can use these settings to control the level of detail for your shadows, but be careful not to use

the sharpest setting too often, as it could slow down your leveL

7 Lighting Surfaces
\"\'hen lighting your levels, you'll notice that Iight behaves dj(terently based on what kind of sur
face is being lit. The following sections explain how light affects a variety of surfaces in Unre2]

and some factOrs you need to be aware of when lighting '>ueh surfaces. World geometry, static

meshes, Movers, terrain, meshes, and particles are also discussed.

World Geometry

The world geometry of your levels receives lhe
most accurate representation of lights, largely

because lights create light maps for world geome

try during rebuilding. As mentioned previollsly,
the clarity of the~c light maps depends on the lighl
map size you set for e,Kh slIrfJcc in the level. You

gel most of your level's shadows on the surfa<:c of

world geometry, as shown in FIGURE 7.35. FIGURE 7.35 Room with lights casting
shadows on world geometry.
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FIGURE 7.36 Ught seems to come through the
door. even though it's closed.

FIGURE 7.37 This is what it should look like if
the door did block light.

Meshes, such a~ animated characters,

receive light similarly to static meshes. They
can'r receive sh"dows, nor can they self
shadow. They are lit in such a WilY that sur
faces facing the light source receive light,
and surfaces facing away receive nonc.

Static Meshes, Meshes, and Movers

Static meshes receive shadows differently than world geometry does. They don't receive shadow
maps in UnrealEd, but they cast shadows onto world geometry or terrain. Therefore, preci~e shad
ows can't fall across static meshes, but static meshes can cause those shadows. Static meshes receive
a more basic lighting, in lh.H surfaces of the

Sl.<\tic mesh lacing a light source appear
illuminated, Jed surfaces facing away from
the light source receive no lighting. This
means that static mesh surfaces that are
opposite a light source receive no light
from that source. However, this effect is

usually adequate for your levels.

Because a tyIover is simply a static mesh
that has been sel into molion, it receives
light in exactly the same way as a standard
static mesh. 1t can't receive shadows. but it
can cast them on world geometry.

However, this poses a problem because
light maps are statk. not animated. $0

while a Mover is in motion, its light map
shadow remains stationary. In fiGURES

7.36 and 7.37, notice how light is passing

"through" the door, even though it's
closed,

Terrain

Terrain receives light maps similarly to world geometry, but the light maps are stored in a slightly
different fashion. When you create light maps on world geometry, the light and shadow areas are
stored in a file with a layout that includes all surfaces of your level, as though every surface were

laid out Oat and side by side. When dealing with terrain, on the other hand> your light map is a
bird's· eye view of the enljn~ terrain surface, with aJl the light and shadow areas in place as though
you were looking at the terrain from high above. You can view this combination of light map and
color texture in the Texture browser, as shown in FIGURE 7.38.
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FIGURE 7.38 Light map from terrain.

Particles

Most particles don't receive light at all. An

exception is particles from a mesh emitter,

which actually emits instances of static

7 meshes. These static meshes receive very

generalllghting, the same as any other sta

tic mesh (see FIGU HE 7.39). For more

information on particles and how to create

them in UnrealEd, refer 10 Chapter 10,

"Creating Particle Effecls."
FIGURE 7.39 Mesh emitter objects under the
Spotlight appear brighter.

Advanced Lighting Effects
This section explains several lighting techniques reserved for special situations: using the

SpecialLi t property to control which surfaces receive light, using ambient lighting, emitting

light from other Actors, creating light coronas, and using TriggerLights.



Scaling Ugllts

The Scale Lig.hts 1001 enables you to control Lhe light brightness of several or :lllliShl.s in your
JeVl:J ~iml1ltaneolllly. This tOol em. be a tremendous time saver when you need to "djust multipl~

light sources but don't W:Hll to go Iluollgh each one'~ Properties window. In TUTORIAL 7.7, you
Sf.'e how 10 3Cc.es.s this tool and use jt to control several different lights at the s~n\e lime.

TUTORIAL 7.7: Scaling Ughts in a Level
------------~

1. Open the scaleLights.vt2 hie.
which contains a large room.

2. Using the skills you have learned,

place three !ignts along the ceiling.

evenly spaced from left to ngrlt (see
FIGURE' .40).

3. Set the lights' properties as {allows
(see the results in FIGURE 7.41):

Leftmost light

Light Brightness: 100

Center light

Light Brightness: 50

2St

Rightmost light

Light Brightness: 10

4. Select all three lightS. and choose
Tools> Scale Lights from the main

menu to open the Scale Lights dia
log box. shown in FIGURE 7.42.

S. The Window has [wo seniflgs: Literal

Value and PercenVlge. Select the

Literal Value option. ar.d enter 10m

Ihe Value text box.. Click OK. and

rebuild your lights. If you don't

notice the change, cheCK the

LIght Br igM ness propenles of your

lights. They are now 110, 60. and

20. respectively. because Literal

value mode adds the value you
enter to all selected lights. You can
also add negatIVe r"lumbers 10 take

bflghtness away.

FIGU RE 7.41 Current lighting with brightness
properties set.

FI GUR E' 7.42 The Scale Lights dialog box.
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6. Now SWitch to the Percentage option.

Enter a value of 50, click OK, and
rebuild your lights. Your level is now

much brighter. If you check your

Ligh tBrightness values. yOU'll find

they are now 165, 90, and 30
because the Percentage mode adds
the percentage specified in the Value

text box. You entered 50, so
UnrealEd increased each light's cur·

rent brightness by 50%. If you had

input 100 instead of 50, it would

have added 100% to each light. effec

tively doubling its LightBrightness
value, In FIGURE 7.43, you can

see the effect this setting has on

lights in the level.

END TUTORIA.l 7.7

FIGURE 7.43 Final result after scaling the lights.

7

Using SpecialLi t

The SpecialLit property enables you to control which lights are ilium inating a specific surface.

For example, you can make your lights illuminate only a single surface or a series of surfaces.

Conversely, you could make your lights illuminate all but a specific selection of surfaces.

The SpecialLit property is available in the Properties windows for lights and world geomelry

surfaces. The property works like this: If you have set a light's Spec ialLit property to True, it

illuminates only surfaces with their SpecialLit property also set 10 True. In TUTORIAL 7.8, you

see how this works.

TUTORIAL 7.8: Using the Special Li t Property

1. Open the Spec ia1Lit_Start. ut2 file. which conta Ins the room you ''Ie bl:!en working on,
with no lights in it.

2. Create two lights, one on each side of the pyramid, about midway bet~lIeen the floor and

ceiling, Give the lights the followmg settings:

Left light

LightBrightness: 150

LighrHue: 170

LightSaturation: 0

Right light

LightBrighlness: 150

LightHue: 0

lightSaturatlon: 0

These settings give you two bold lights: one blue and one red (see FIGURE 7.44).



3. RebuIld the lighting if you want to see the shadows. Then select the red light and open its
Properties window. In the Lighting tab, set the bSpecialU t property to True, and rebuild
the lighting. Now only the blue light is lighting the room (see FIGURE 7.45).

FIGU RE 7.44 Red and bille lights
blending across the pyramid.

4. Select the nearest surface on the pyra
mid in the midale of the room. Right
click on it, and open its Properties
window. In the Flags tab, select the
Special Lit check box.

5. Rebuild your lighting. Notice that the
pyramid's selected face is now
receiving red light Instead of blue
(see FIGURE 7,46). Surfaces with the

Special Lit flag selected receive light
only from lights with the bSpecialLi t

property set to True.

END TUTORIAL 7.8

FIGURE 7.45 With the red light set to
SpecialLi t, the room becomes completely blue.

FIGURE 7.46 Only the pyramid receives red
light.
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Ambient Lighting

Setting your level's ambient light is a good way to connol the overall lighting. This setting applies

constant light to every surface of your level, be it in light or in shadow. It's a good way to lighten

your level if it's too dark in some areas. In TUTORIAL 7.9, you sec how to adjust the ambient

llghting of your levels.
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tUTORIAL 7.9: Using Ambient lighting
------------------=----------------

1. Open the Ambient_start. ut2 file.

which contains a moodily lit room

that's mostly black.

2. You need to increase the brightness
of the black areas so that the room

isn't so hard to see. To do this, first

choose View> Level Properties (rom

the main menu.

3. Expand the ZoneLight tab, and set the

AmbientBrightness property to about
8. Rebuild the lights in your level.

4. Play·test the level. Notice that
although the areas outside the spot·

light are still dark, you can now see
them faintly (see FIGURE 7.47).

USing this setting is a good idea
when you don·t want the playe(s

vision going to pure black_

END TUTORIAL 7.9

Emitting Light from other Actors

FIGURE 7.47 The final result.

, NOTE

lBy default, the hotkey for the Level Properties window
(F6) als¢ opens the Net Statistics heads-up display. I

_ _ J

Light Actors are not the only objects that can emit light in UnreD!. You can make almost any Aclor
emit light, as long as its LightColor and Lighting tabs are available in the Properties window. For

example, you can make a static mesh emit light into your level. In TUTORIAL 7.10, yOll learn

how to make a static mesh illuminate a level.

TUTORIAL 7.10: Emitting Light from an Actor

.1. Open the SMemi t . ut2 file, You'll see the light test chamber With an interesting static mesh

floating in the middle of it. above the pedestal.

2. Select thiS static mesh, and move It off to one side or II) a comer to helll you create more

interesting shadows later.

3. Double·click the static mesh to open its Properties window. Notice that it has both a

LightColor and a Lightmg tab_



4. Set the following properties for the static mesh:

In the LightColor tab

Light8rightness: 150

LightHue: 42

LlghtSaturation: 140

In the Lighting tab

LightRadius: 128

LightType: LT_Steady

5. You can see the light's effect as a
preview. Rebuild the light, and
notice that the light has disap

peared. The problem IS that the sta·
tic mesh's pivot is being used as

the light's origin. Because the Pivot
is inside the mesh, no light is
esceping. Essentially, the rest of

the light 15 in shadow, as shown in
FIGURE 7.48.

6. In the static mesh's Properties
Window. expand the DIsplay tab,
and set the b$hadowCas t property
to False. Rebuild the light now.
Your mesh should be emittmg
lig ;t just like a stalic light (see
FIGURE 7.49).

7. There's still a problem, however. If

you deselect the static mesh, It'S

completely black because the light
is inside the mesh, so its outside is
in shadow. In the Properties window
for the statIc mesh, go back to the
DiSPlay tab, and set the bunli t
property to False. This setting
causes the mesh to stop receiving
light. effectively making it visible
again (see FIGURE 7.50). Test
your level to see the effect.

END TUTORIAL 7.10

FIGURE 7.48 Initially the static mesh blocks all
the light it emits.

FIGU E 7.49 With bShsdowCast set to False,
the mesh emits light correctly.

FIGURE 7.50 The bUn11 t property of the static
mesh is set to True.
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Coronas

Coronas are a special light effect thzt creates a ringlike effect around a light, similar to the Jens

flare created when a camera looks at a bright light source, The effect is actually a texture, which

is placed on a plane that a.lways (aces the camera. A corona is visible only at a certain distance and

looks larger the farther you gel from the light. However, this is a simple optical illusion. The

corona's size never changes. As you move away from oojects in 3D, they seem to get smaller.

Because a corona's size is constant, it seems to be larger campMed to the scenery around it, which

looks like it's shrinking. The effect is similar to the effect the moon crcates when it approaches the

horizon. Even though the moon's size never changes, it appears larger when it's close to the

grotlnd. In TUTORIAL 7.11, you learn how to apply a corona to a light in your level.

TUTORIAL 7.11: Using Coronas

1. Open the Corona_start. ut2 file, which contains a spooky (and familiar) scene. You'll be
placing a corona on the Spotlight's Actor.

2. Double-click the spotlight, and In Its Properties Window, expand the lighting tab. Set the
bCorona property to True.

3. In the Textu(e browser, open the Ch apt er 7_t ex. ut x package. and open the Co(onas
group. Select the Coronal texture (see FIGURE 7.51).

<....-..._----------------------------------'
FIGURE 7.51 Selecting a texture for the corona.
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4. Back In the light's Properties window, expand the Display tab. Under the Skins property.
click the Add button,

5. In the flew [OJ index. click None, and then click the Use button to insert Corona! as the
texture (see FIGURE 7.52), You should Immediately see the corona in the viewport
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FIGURE 7.52 Using the texture as a skin for the light to use as a corona.

6. Test your level. and notice that the
corona fades in and out of existence
when it comes Into view, The corona
is too big. however. Exit Unreal, and
go back to UnrealEd.

7. Select your Iight. and in the
DrawScale30 section In the console
bar. sel the X and Y va lues to 0.5 to
make the corona smaller, as shown
In FIGURE 7.53.

FIGURE 7.53 The corona scaled down.

END TUTORIAL 7.11

Using a TriggerLight

WllelJ you need to use dynamic lighting, the TriggerLight is your tool of choice. This ligbt has

already been designated as dynamic through UnrealScript with properties unavailable in the

Properties window. This light responds to events in your level. allowing you 10 trigger it on or off

with the UseTrigger and ScriptedTrigger Actors. In TUTORIAL 7.12, you create a TriggerLight
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and usc events to control its behavior. For an

in-depth look at triggers and how they work,

see Chapter 9, H]nteractive Elements."

TUTORIAL 7.12: Creating a TriggerLight

I NOTE'

~
Ynamic lights can't be created by adjusting proper

ties. Only certain Actors, such as the TriggerLigtlt, can
act as dynamic lights.

-- - - - -- -- --- - .-

1. Open the TnggerLight_s tart. ut2 file, which contains two rooms connected by a small
hallway. You'll make one room lit and Ihe other dark.

2. In the Top viewport, consider the room on Ine right to be the lit room and the room on the
left to be the dark room (see FIGURE 7.54).

,~.~.

7

DarkRoom

FIGURE 7.54 Top-down view of the base level.

UtRoom

3, In the lit room, create a light near Ihe
ceiling with the following properties
(see the results in FIGURE 7.55):

LightBrightness: 100

lightRadius: 30

4. In the dark room, create a light in the
center of the room With the following
properties:

LightBnghtness: 32

LightEffect: Nonlncidence

LigntRadius: 20
FIGURE 7.55 Bright and dim lights added to the
rooms.
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5. In the Actor Class browser, expand Triggers, and click UseTrigger. Right-c1icl< in the hallway.

near the entrance to the dark room. and choose Add UseTrigger Here. This tngger acts as
the SWitch for your light.

8. You learn how triggers and events work in Chapter 9, For now. set the (ollowmg properties
in the UseTngger's Properties windOw:

In the Advanced tab

bHidden: False-----ThJS setting makes the tngger visible when you play the level.

In the Events tab

Event: TLightl-You need to type this entry in. This setting causes the UseTngger to
send out a sIgnal named TLightl. You'll make the light listen for this signal.

7. You have your switch set UP. so now you can create the TriggerLight. Open the Actor Class
browser, expand Lights, and select TnggerLight (see FIGURE 7.56). Do not expand
TriggerLight.
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FIGURE 7.56 Selecting a Triggetlight in the Actor Class browser.

8. Right-elick in the dark (oom. and place the TriggerLight. Move it to the center of the room.
both horizontally and vertically.
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9. To set up some controls for the TnggerLight's behavior, open its PropertIes window, and
enter the following settmgs:

In the TriggerLight tab

ChangeTime: a.1-This settirlg controls the amount of time in seconds that the light
changes (rom unlit to lit and vice versa.

In the Lighting tab

LlghtRadius: 20-ThIs setting is the light'S radius. the same as other lights you have

used.

In the Events tab

Tag: TLightl-Thls setting must be typed In. It makes the Triggerlight listen for the

TLighl1 Signal before it actIVates or deactivates.

In the Object tab

InitlalState: TflggerToggle-This settmg determines the light's mitral state (what the light
IS doing when the level is launched). The TnggerToggle setting causes the light to be
off, awaiting a signal from the trigger.

10. RebUild your lighting. and test the level. In the levei, walk up to the ecgle's head icon (the
UseTrigger) and press the E key. Watch the lights come on!

END TUTORIAL 7.12

7 Projectors
A Projector is a special Actor that has replaced the functionality of many of the lightEtfect

property settings available in UnrcalEd. In the past, LightE({ects such as Disco or SlowWave were

used to create animated effeds. With the ;\dVelll of stallc lights and precaleulated shadows, this
method became indficienl because these effens requin' dynamic lights, which are far more
processor intensive than stalic lights, With Projectors, yOIl now have: animated light functionality
that's not only faster, but also produces much cleaner results.

A Projector is not a light; iI's an Aclor that trilnsrnits a texture onto a surface. This texture tS
blended in such a way that dark areas <lppear to darken the surface, <!I1d lighter areas seem to illu
minatI' it. Technically, the values of the surface texture are multiplied by the values of the textu re
coming from the Projector.

This behavior allows a Projec~or to work much like its real-world LOunterpart. You can plHe a
texturt' lOW a Projector and aim it at any surface you like. Projectors an be ll~('d for a variety of
pUl'poses, including animated light passing through fan blades, a moving spotljght, or even an

intricate colored shadow from a stained-glass window. The best leatun' of Projectors is that their
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effect also falls across animated meshes, meanIng you can see the projected. tc\iure (.1.11 on your

character as you play.

Using Projectors

To use a Projector, you place an image in it (in this chapter's example, d texture), and then aim il at

a surface. The image is then projected onto thaI surface. fn TU TORIAL 7.:13, you sa how [0 create
and use Projectors in your levels. You begin by addulg a Projector to your level, and then selcC1jng

a tc>..1ure for it. You then adjust some settings If) makc 11 work c()rrect.! y and aller ils rota lion.

TUTORIAL 7.13: Creating a Simple Projecto r

1. Open the ProjectOrLevel.ut2 file, which contains a simple room with a slarned.glass

window on one side. To begin. you add a simple Projector In the room to gIve the iHUSKln

that the stained-glass window is prOjecting light onto Ihe floor,

2. First, open the Actor Class browser,

and click Projector. Next. right-click in

the middle of the window within the

level, and choose Add Projector Here.

3. Just like a Spotlight, the PrOjector

Acto( Is directional. with an arrow

indl(":ating its current (jlrection.

Currently. the arrow points out of the

room, througn the Window. To fix thiS.

Click the Lock to Selected Actor icon.
and position the Projector so that Irs
In front Of the window. pointing at the

floor (see FIGURE 7.57l-

4. In th~ Texture browser. select the

St31.nedGlass texture. found in the
Chapter]_ tex. utx package. In the

Projectors Properties window, open

the Projector category. click the

PrO]Texture propertY. and click Ihe

Use button. NOlJce that the texture

now covers the entlTe floor af th~ map.

AlSO notice the large boxes viSible In

the viewport around U1e Pmjeetor (see

FIGURE 7.58). These boxes serve

two purposes. The cyan box ShowS

the area within whlctl the texture is

projected. The yellow box IS a bound

Ing box for the PrOjector's entire effect.
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bel ipBSP set to True to avoidFIGURE 1.59
tlUng.

6. Save your work, and test the map. You

now have a fully functional Projector.

Notice when you play the map that the

texture falls not only on the (loor, but

also on your character's gun. Keep in

mind. however. that objects in the Projector's path don't cast shadows, For example, If you were

to place a stallc mesh III the middle of the room, the stained·glass projection would faJi on the

surface of the mesh, but would also (all on the flocr, completely Without a shadow,

5. To fix the tiling issue, you need to

change two of the Projector's proper·

ties. Open the Properties window tor
the ProjectOr and under the PrOjector

category. set the bClip8SP property

to True. Next. set the FOV property to

5. The texture IS now contained

within the cyan box's area, as shown

In FIGURE 7.59.

TUTORIAL 7.14 assumes that you're using Adobe Photoshop, If you don't have a copy of

Photoshop, please skip to Step 7.

END TUTOHIA 7.13

TUTORIAL 7.14: Creating Non-sq uare Projectors

7

1. Open the Proj ectorLeve12. ut2

file. You'll see a room similar to the

one in TUTORIAL 7.13, but the

stained-glass window is circular

rather than square. For Circular

shapes, you need an Irregularly

shaped Projector texture.

2. To create the texture needed for a
Projector, you need to edit a preexist

ing texture in Photoshop. Start

Photoshop and then open the

StainedGlass. tga file, found in the

Chapter 7 folder on the CD.

3. Using the Elliptical Marquee tool,

hold down the Shift key and make a

circular selection in the middle of

the texture. Make sure to keep your

selection away trom the edges, as

shown in FIGURE 7.60.
FIGU HE 7.60 Texture with circular area in the
middle selected.
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T

4. Next. press Ctrl+Shift+1 to Invert your

current sell:!ction. set your color to a
neutral gray (RGB values of 128, 128,
128). Choose Edit> Fill from the main

menu, and in the dialog bOlt that opens.
make sure you're using the Foreground

color (lnd your mone is set to Normal at ~

100% opacity. The end result should be I ~
a stained-glass circle surrounded by
gray (see FIGURE 7.61). ,

NOTE
The image's gray border is important because the
gray pixels have no effect on the su rlace at wI1 ich
the Projector is aimed. In effect, this makes the
Projector look circular rather than rectangular.

FIGU RE 7.82 Edges of the circle blurred for a
blending effect.

FIGU RE 7.61 Area around the circle filled with
gray.

If you have skipped to this step, you can lind
this texture in the Chapter 7 folder on the CD.

----- -----------,
NOTE

T

5. Choose Select > Feather (rom the

menu. and set the value in the dialog

box to 40 to create a softened area
around the selection_ Next. choose

Filter> Blur> Lens Blur from the main
menu. Make sure the radius of the blur

is set to 20 to blur the edges of the
circular texture (see FIGURE 7.62).

Name: NewWindow

6. Now you're ready to expor! the texture

In a format that UnrealEd can under
stand. Choose File> Save As from the

Photoshop menu. Name the file
NewWindow. and set its file type to

Targa (TGA). In the Targe Options
dialog box, set Resolution to 24
bits/pixel, and click OK.

7. Back in UnrealEd. open the Texture
browser, and choose File> Import from
the browser menu. Navigate to the

NewVJlndow. tga texture you just created.

8. Click Open, and then use the following

settings in the Import Texture dialog
box (see FIGU RE 7,63):

Package: myLevel

Group: none (Delete any entry in thiS area.)
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FIGU RE 7.64 Texture assigned to the Projector.
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FIGURE 7.65 The Projector's result with the
texture's UClampMode and VCla'mpMode properties
set to TC_Clamp.

FIGURE 7.63 Importing the leKture ioto
UnrealEd.

The FOV property expands the

Projector's field of view. enlarging the

texture. The bGrad~ent property

causes the projected texture to be
more intense near the Projector

Actor and fade off with distance. The

MaxTraceOistance property enables

you to adjust how far the Projector

call project. In thiS example, the

50% increase prevents the texture

from looking washed out.

bGradlent: True

MaxTraceDistance: 1500

9. Use the skills you learned in

TUTORIAL 7.13 to creote and posi

tion a Projector In the level. This time,

use the NevIWindow texture you just

created. As before, the texture tiles

across the floor (see FIGURE 7.64).
You could fix this problem by setting

bClipBSP to True, but instead, you'll

adjust a setting within the texture.

10. Return to the Texture browser. Right

click on the NewWindow texture, and

choose Properties to open the

Texture Properties window, which is

discussed in more detail In Chapter

8. "Creating Materials in Unreal." For

now. open the Texture category, and

set the UClampMoae and VClampMode

properties to fe_Clamp. Close the

Texture Properties window when

finished. The results are shown in

FIGURE 7.65.

11. Finally. tweak some of the Projector's

properties to make it look more real·

istic. Open the Projector's Properties

window, and set the following:

FOV: 30

7

.12. Save and test your level. Notice that the ProJector's effect IS now circular Clnd much more

subtle.

END TUTORIA.L 7.14
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This section de5cribes some common prob
lems that first-time lighters experience so
that you know to look out for them. By

knowing about these simple problems. }'OU

can avoid them in your own projects and be
far more effective at lighting your levels:

~ Always have a light source. Whether
it's a static mesh or just a simple
open window, make sure your light

appears to originate from some
object. A room lit by an invisible

light source looks unrealistic and
makes your levels Jook fake. For
example, if you're lighting a dungeon
level, you want your light to seem to
come from torches. not from some
unknown source. In FIGURES 7.66

and 7.67, you can see how much
more realistic your lighting looks if
you create a physical light source
for it.

~ Avoid using too much ambient light.

Ambient light. or Zone light. is a
good way to make your levels appear

to have general illumination. It is
good to use ambient light when you
don't want your shadows to look peT
fectly black. However, you must be

careful not to overuse this lighting, as
it can make your level look wilshed

out and remove the dramatic feel of
your shadows (see FIGURE 7.68).

~ Keep all eye on your contrast. The

shadows of your level should be dra
matic, but not overly so. Be careful
that you don't have both brightly lit
areas and pure black shadows, as
shown in FIGURE 7.69. This look
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FIGURE 7.66 Simple lighting with no visible light
source.

FIGURE 7.67 Same lighting as FIGURE 7.66
but with a light fixture.

FIGURE 7.68 The shadows are washed out even
though there's only one light

FIGURE 7.69 Room with bright light and perfect
black shadows.
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FIGURE 7.71 Only a few lights with larger radii.

FIGURE 1.10 large room filled with lights.

FIGURE 7.72 Room full of static meshes with
light Map size at about 32.

(

FIGURE 7.73 Same as FIGURE 7.72 but with
a Light Map size of 1. In this example, sharp shadows
might not be necessary.

rarely happens in lhe real world and

should be avoided in your levels.

Remember that bright light tends to

reflect off surrounding surfaces,

which typically lightens the shadows

in your room.

~ Avoid using too many lights. OftI'll

yOli need to use multiple lights in
one area, but don't go too (,Jr.

Remember to make the most of the

properties you h,lve avauable for

your lights. When lighting large

areas, be sure you don't place many

lights when you could simply

increase the Ligh tRadius property

of a single central light source.

Compare FIGURE 7.70 with

FIGURE 7.71 to see the difference.

The results don't necessarily speed

up gameplay, but they do make light

map rebuilding much faster.

~ Don't overuse sharp shadows.

When adjusting your level's shad

ows, remember that changing the

size of your light maps is, in [acl,

changing their resolution. The finer,

or smaller, you ser your Light Map

size. the more high-resolution your

shadows are. This setup can become

a problem if used too much. The

higher your light map resolution,

the more texture data must be

stored on your video card during

gameplay, on top of the textures

already in your level. This can result

in level slowdown and should be

avoided. In FIGURES 7.72 and

7.73, you (an see the effect of hav·

ing large and small Light Map sizes.
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• Keep dynamic light use to a mini

mum. Stalic lights were designed to

erea te bea11 t ifllJ and realistic Iigh Iiog

scenarios without a lot of overhead

on the computer. Dynamic lights.

on the other hand, are very proces

sor intensive because they are
updated every frame. If lIsed 100

much in your levels, dynamic lights FIGURE 7.74 Room lit with static lights.

can drastically diminish your leveJ's

performance. Try not to use

dynamic lights unJess absoJutely

necessary, In FIGURES 7.74 and

7. 75, yo u can see t he difference

between using static lights and

dynamic lights.

Summary
FIGURE 7.75 Room lit with TriggerUghts. Notice
that dynamic lights don't cast shadows.

This chapter has covered many .1spects of lighting in Unreal. You should now have J solid under

standing of the concepts behind creating Jight in youf levels. Practicing your lighting skiJls is rec

ommended so that you become accustomed to lighting workflow and melhods of creating

reallstic llght. The Unreal Engine is capable of fantastic ligbt handling, but only through experi

ence will you be able to take advantage of its full capabilities. In the next chapter, yuu take your

first look at terrain creation and see how terrain can be used to generate outdoor areas for your

levels.
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Creating Materials in
Unreal

Materials can be thought of as coatings of paint applied to the sur
faces of objects in you r levels. Materials provide a specific look for

your surfaces. whether Ihey are made of wood. plastic, steel, or con
crete. Materials can be divided into three separate categories: tex
tures, shaders, and modifiers. A texture supplies the color for your

object, like applying an image across the surface. A shader uses tex
tures to <.reate 3 kind of surface effect, such as reflectivity or specu·
laxity, which is how light creales highlights on the surface. A modifier
is a component thai applies some sort of action or process to a tex
ture, sllch as a TexPanner, which pans the texture in a specific direc
tion, or a TexRotator. which rotates the texture,

In Ihis chapter, you take an in-depth look at materials and how they
are made. You learn how textures can be imported into Umeal, how
to create shaders, and how to apply modifiers 10 create powerful
materials for your levels. The chapter begins with a discussion of
textur~s ilnd explilins some considerations for generating your own
textures.
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Textures

A textu rc is technically nothing more than an image placed OD a surface in your level. In this sec
tion, you take <In in-depth look at textures, how they work, and how they are created. Textures are
the m.\terial component that provides color and a tactile look. Keep in mind that textures are sta
tic-they don't animate on their own. To achieve mOlion or animated effects, you need to incor
porate other components that are engineered 10 drive such effects. These compoo~Tlts are
discussed later in the" Modi fiefS" secti 00.

Textures are created in cx:ternal applications, such as Adobe Photoshop or Corel Painter. You can
import images created in these applications into UnrealEd simply by saving them to the proper
file formal. UnrealEd supports five file formats: BMF, pex, TGA, UPT, and DDS. The folJo\\'ing

l!SI describes these furmats and whal kind of results you C30 expect from t.hem:

~ BMP-The Windows bitmap format is supported by many different 2D paint applica
tions. This format is I05sleS5, meaning it doesn't decrease or remove any information from
your original image. As such, BMF files tend to be very large compared to other formats.
This format does. however, support a few simple compression algorithms to help decrease
file size.

~ PCX-This image format was popular in the early days of MS-DOS and Windows. It is a
lossless format, but its compression algorithm is inefficient by today's standards. It has
been widely replaced by formats that support better compression, such as lPG,

~ TCA-This is a lossless image format, commonly called a Targa file. It supports up to 32
bits per pixel and supports an alpha channel. It has become the preferred format for
image importing when working with Unreal£d.

An alpha channel is a separate grayscale image embedded in some image files that aUow$
you to create transparent areas in your texture, Black areas on the texture, which have an
RGB value of 0, are transparent, and white areas, having an RGB value of 255, are opaque.
Shades of gray appear as varying levels of transparency. For example, if you want to create
a texture of a wire mesh or a chain-link fence, you could create an alpha channel th,lt was
white where the wires or fencing exists and black in aIJ the holes. The result would be thaI

you could see through the texture in all the areas that are black 011 the alpha channel.
Alpha channels are important in Unreal becaus<, they make it possible to create areas in

your surfaces that are semitransparent or even fully transparent and provide a way to
keep transparent areas independent of the rest of the texture.

~ UPT- This format is created by UPainf, ,I 3D texture painting application by Right

Hemisphere. DPaint is included with Unreal Tournament 2003 and Unreal Tournament
2004, The program allows you to paint textures directly on lhe surface of your models.
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.. DDS--This is the Direct Draw Surface format created by Microsoft and 0 riginally intro

duced (or Du-ectX 7, The formal illows ~aving compressed and uncompressed llnages,
More important, il enable~ you to save muhiple mipmaps of your te.xlure,

The word "Ml P" is an acronym ror mliltul!l in parvo, or "much in iiI lie," A mipm2p i.s a

serres of lextures that begin at high resolutions and move 10 lower resolutions. This
aUows for a "level of der ail'" effe<:( \"hen playjng a g2mc, so pl.1ye~ see the higher resol\J-
I ion ,e'k'U re when they're dose to a surface and )o\~er rcsolution texlores as lhey move
aw'3y from that surface, The lower resolulion tenures are always smaller lhan UtC'\r prede
cessor by a powl'C of cwo, For example, if your L.nilialll:xcure has a resolu I ion of 512 xS 12,

its next Inlpm:lp is 2S6x256, The nelCl )S 128x128, then 64x64, and so on, depending on
the number of mipm~pscrc:ated for }'our tex:1ure, Mipmaps use more memory lhan a
stand.. rd le:dure but are far le~ processor Intensive, allowing {or much fasler gameplay,
e~pe(ially on computers with I,uge amounts of m~mory,

DDS imagt'S also make it p-ossible to store ClIbit mvirol1ml'nl maps and volume textures. A

cubic environment map is .\ way to represent an object's surround inB environment from
a srecinc PO(l1t in space, In effecl, il enabks you to mal<e an objecI seem to be renteting
its surrounding envjronment, sim ilar to real-world matcrials such as SI.3inless sleeL CubIC

environment maps, or CUGem"ps, are discussed laler in the "Cre;l1i ng ReOecli ~e Surfaces
wilh Cubemaps and Tcxf.nvMaps" section. Volume leX\ures are three-dimenslonal tex
tures u~d to si m\.date re.d-world cf(rxts such as fog, llame, and explosions, Although the
DOS format supports volume te)(IUre~, they haven'l been Implemented in Ihe Unre21

Engine.

You (In create ODS fiJcs by usi ng several methods. UnrealEd provides some fu nclionality
(or creating DDS fiJes, including the creation of mipmaps. You can use Olher loots as well,

il,c1udillg the Microsoft DXTex rool and Ihe DDS PhOloshop Plug-in ;lvailable from
Nvidia.

Creating a Terlure

When creating a lex.lure, you musl kee-p a few things in mind. The size of your texlure controls
how dCf;liled it appears in-game, and its file (ormM conlroJs how much data (if any) lS lost when
you create ie In TUTORIA.L 8.1, you look;u creating a lexture completely from scralch in Adobe
Photos)wp, Th is lutorial assumes a basic uodcrslilnd ing of PhOloshop ilnd does nOl lOci ude com

prchensive inslructlons for every nuance 0 f the program.
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TUTORIAL 8.1: Creating a Texture in Photoshop

8

1. Start Pholoshop, and choose File>

New from the menu to create a new

image, In the New dialog box (shown
If) FIGURE 8.:1), enter the following

settings, and click OK when finished:

Name: tile

Width: 512 pixels

Height: 512 pixels

Resolution: 72 pixels/Inch

Mode: RGB Color/S bil

Background Contents: White

2. Choose Filter :- Render :- Clouds

from the menu to cover your canvas

with a basic cloud effect (see

FIGURE 8.2).

3. From the Layer menu, choose New

Adjustment Layer :- Curves, Click OK

In the New Layer dialog box to use

the default settings.

In 1he Curves dialog box (shown in

FIGURE 8.3). move the lehmost

point down 10 about midwayan

the graph. ThiS removes the

pnmary dark areas on Ihe image,

resulling in somelhing similar 10

FIGURE 8.4.

....--1
1

::J

FIGURE 8.1 The New dialog box in Photoshop.

FIGURE 8.2 Rendered cloud.
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FIGURE 8.3 The Curves dialog box.

FIGURE 8.4 Clouds after brightening.
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FIGURE 8.5 The Color Balance dialog box.
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4. Choose Layer> New Adjustment

Layer> Color Balance. and click

OK in the New Layer dialog box.

Set the followmg properties in the
Color Balance dialog box (see
FIGURE 8.5):

Cy1ll1, -100

Magenta: 0

Yellow: 50

Tone Balance: Midtones

Preserve Lummosity: Select this
check box

Click OK when done. Your result
should be similar to FIGURE 8.8.

S. Add a new layer by clicking the New
Layer button QI, located at the bot

tom of the Layers palette. With this

layer selected. choose Filters>

Render> Clouds from the menu to
add cloUds to your new layer (see
FIGURE e.1).

6. Edit the curves of this new layer by

choosing Image> Adjustments>
Curves from the menu. Move the
flfst curve point to the top of the

graph. and then create three points
In the middle of the curve, movmg

the center point down to the bottom

of the graph, as shown in FIGURE
8.8. The results ShOuld look similar
to FIGURE 8.9.

NOTE
To add new edit points to the curve, simply
click on a section of the curve away from the
existing points.

FIGURE 8.6 Clouds after adjusting the color balance.

FIGURE 8.7 The Layers palette showing the
cloud layer.

FIGURE 8.8 The edited curve used for the
desired effect.
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FIGURE 8,12 The
tile image after applying
the Ocean Ripple filter.

FIGURE 8.9 Cloud layer after the curve adjustment.

FIGURE 8.10 The layers palette showing
changes to the blending options.

FIGURE 8.11 The
tile image after changes
to the blending options.

7. In the Layers palette's blending
options, set the new layer's mode to
Multiply and lower its opacity to
30%, as shown in FIGURE 8.10.
You can see the results or these
changes in FIGURE 8.11.

8. Select the Background layer and

choose Filter> Distort> Ocean
Ripple from the menu. In the Ocean
Ripple dIalog box, set the following
properties (see the results in

FIGURE 8.12):

9. Next, you'll add an alpha channel to
the tile image. Select the new
Clouds layer (If it's not already).

Press Ctrl+A to select the entire
layer, and then press Ctrl+C to copy
it to the Clipboard.

10. Click the Channels tab, and then
click the New Channel button QJ
at the bottom of the palette to cre·
ate a blank alpha channel (see
FIGURE 8.13).

Ripple SIze: 12

Ripple Magnitude: 9

11. Select the new alpha channel.
and press Ctrl+V to paste in the
information from the layer (see
FIGURE 8.14).

12. Choose File> Save As from the
menu. Set the file formal to Targa
( . tga extension). and name the
image tile. Click Save, and in the
targa options dialog box that opens,
choose 32·bitsjpixel, and click OK.

8

END TUTORIAL 8.1

FIGURE 8.13 The
Channels palette with a
blank alptla channel.

FIGURE 8.14 The
Channels palette with an alpha
channel from the cloud layer.
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You have now created a new TGA file containing an alpha channel. which can be imported into

Unreal.

Using 8-blt Textures

As an alternative to using a 32-bit texture with an alpha channel, you can use 8-bit textures. An 8·bit

texture has no more than 256 coJors, all of which are stored in a palette. This palette can hold no more

than 256 entries> and each pixel of the image references a vallie in the palette. These textures are called

8-bit textures because in a computer's memory, 8 bits can hold up to 256 unique values. This means

the name "8-bit" refers to the amount of memory used for each pixel of the image.

In Unreal, B-bit textures are useful for fWO reasons: They save space, and you can mask out an entire

color or, more precisely, an entry in the palette. [n TUTORIAL 8.2, you see how to set up this texture.

TUTORIAL 8.2: Creating an 8·bit Texture

"
3 OK

e.rt:e1

load...

save.•.

J;i"PreloleW

P<+3tUl: ILa;J (SBIoctlV91

~:~

fp.;ed: I~ """ "''''to ::J
~Ir~

1:Ilher.!t:lrn.:"" ~

~t:~'fo

r PrJlSl¥Ve~Coo,-- -_. ---

T<tlo>: Ic~crn

FIGURE 8.15 The Indexed Color dialog box.

FIGURE 8.16 The Color Table dialog box.

1. Start Photoshop and open the texture you

created in TUTORIAL 8.1.

4. To set the transparency color, clicK the

first entry of the color table, the square in

the upper-left corner. The Color Picker

opens, where you can select the color thnt

becomes transparent after the texture is

II) Unreal. However, If you move the mouse

over your original image, you see the

Eyedropper tool, which you can use to

select a color directly from your image.

2. Choose Image > Mode > Indexed Color to

open the Indexed Color dialog box (see

FIGURE 8.15), where you can specifY

how to convert your image to a 25&color

image. ObViously, thiS converSion

decreases your image'S detail because

you're removing data.

3. Next, choose Image > Mode > Color Table
from the menu. You can use the Color
Table dialog box, shown in FIGURE 8.16,

to view and set the colors in your palette.

You can set a specific color for the first

entry and force Unreal to read every

instance of that color as transparent.

END TUTORIA 8.2
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Importing a Texture

In this section, you learn how to get the textur(" you created in the previous $rctioo into UnrealEd

so that you can use it to texture your surfaces. Before you begin, however, there's ao importaol

rule you need to keep in mind; Although your textures don't need to be perfectly square, they
must have pixel dimensions that are powers of two, such as 2, 4, 8, 16,32, 64, 128, and so on. For

example, a texture that's 128x256 pixels is acceptable, but you can't have a texture that's 137x231

pix:els. With that rule in mind, try importing a texture into a level by following TUTORIAL 8.3.

TUTORIAL 8.3: Importing and Using a Simple Texture

1. Start UnrealEd. and open the
Textures browser, shown in
FIGURE 8.17.

2. Next. choose File> Import from
the menu to open the Import
Textures dialog box, where you
can select a file to import.

3. Select the Tile. tga image
you saved in TUTORIAL 8.1

and clie\( Open. ThiS opens
the Import Texture dialog box
(see FIGURE 8.18), where
you can set which package to
save tne texture in, its group,
and the name for the new
texture.

flo 'ok ..... r _ ... "",'""

r.."" IAQ~cs.-1 "O'I>,d .............1._"...1_1 ""_ls"""'l """'I
jj ~'" Q'1l!11 ~J ----~·II

FIGURE 8.17 The Textures browser.

:TiP
I Remember that groups are used to organize multiple

objects within a package.
l_ _ ~8

4. Change the package to MaterialTest to
create a new package of the same
name. Clear the Group text box, as you
won't be creating any groups in this pack·
age. Finally. set the name to tileTel(.

5. Underneath the Name text box is the LOD attribute. which stands (or Level of Detail. Make
sure it'S set to zero, which produces the highest quality selling. Anything higher than 0
decreases the Quality.

6. Notice the Options section beneath the main Info section. Select the Alpha and Generate
MipMaps check boxes. The options In this section can be changed after the texture is created,
but irs more convenient to set them now. The following list explains the available options:

~ Masked-This property is used if your texture doesn't have an alpha channel. It
takes a single color of your texture and makes It transparent. You could. for example,
mask out the color green In your texture. The effect is similar to the green screen
used in movie making: Anywhere the color green eXists In your texture, you can see
through to the surface behind.
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.. Alpha-This option specifies

whether your image's alpha

channel is used, provided
you're using an image format

that supports alpha channels,
such as TGA. The file you're

using in this tutorial is a TGA
with an alpha channel. To use

the alpha channel, you must
make sure the Alpha check

box IS selected.

In'fl0rt TMIt Uh! -"

. Oplk.m

r I~"""'" P' Gc""''''. MipMOI'I

r ~ r OetoolHock'l

FIGURE 8.18 The )mport Texture dialog box.

FIGURE 8,19 The Textures browser with the imported
texture.

.. Generate MipMaps-This

option tells UnreajEd to

generate a series of

lower·resolutlon versions

of your onginallmage.
They are displayed if play
ers are positioned at a

distance from the texture

and don't need to see a

high-resolution te;<ture. It

81so prevents a moire

(pixel distortion) effect

that happens when you
view a high-resolution tex

ture at a long distance.

7, Click the OK button II) the

Import Texture dialog box to
create your texture, which then

shoW's up In the Textures
browser (see FIGURE 8.19).
You can place thiS texture on

any surface in your level. just

like any other texture.

8. Currently, this texture package has not been saved. You must save It If you want to be able
to see the texture in the game. After making sure you're viewing the Materiallest package,
save your new texture by choosmg File'" Save from the Textures browser menu.

9. Leave the name as MaterialTest and click Save. Now you can use this package in any of

your levels.

END TUTORIAL 8.3
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The Texture Properties Window

At this point, you have created a fully functional texture that CJn be used in your Unreal levels.

You can now make changes to this texture by altering its !Jroperties. To do this) you use the

Texture Properties window, which has a few differences from the Properties windows you)ve been

using for other objects. To help you better understand how this window works and how to use it,

this section introduces you to the Texture Properties window interi<lce and 6.111ctionality. To get

started, you can access the Texture Properties window by right-clicking your new lexture in [he

Textures browser, and choosing Properties from the context menu (see FIGURE 8.20).

]

FIGU RE 8.20 The Texture Properties window for your tileTex texture.

8 At the top left is the Material display window that gives you <) preview of what your materia! wiU

look like. You can use it to reference your materiJI on a flat plane, a cube, or a sphere, as explained

later in this section.

To the right of the Material display window is the Material Tree, which shows a hierarchical view

of all tbe components of your current material. Here you can select and change the propenies of

any texture, shader, or modifier in your material's hierarchy.

Directly beneath the Material display window, you see the Material Display buttons for control

ling what you see in the display window:

~ Clear-At the tirue of this writing, the Clear button is nonfunctional.

~ Show Fallback Material-YOll use this button to creale afal/back material, which is a basic

material that Unreal uses if your computer\ hardware is incapable of displaying an
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advanced material. When distributing your work, creating it fallback material is a good

idea in case someone playing your level is using an older video card.

~ The Material Backdror This button shows a multicolored checkered background in your

display window. This view LS especially useful for testing transparency.

.. The Layer-Looking-Vlhen this button is activated, you always see the result of the com

ponents in the Material Tree or the effect produced at the top of the hierarchy. No matter

which component in the tree you select, you always see the Dnal result as long as this but·

ton is activated, If this button is /lot activated, yOll see only the result of the currently

selected component in the Material Tree.

The three buttons on the right determine the type of geometry used in the Material display win

dow. By default. the geometry is set to plane. You can also switch to cube and sphere, which show

you what rhe material looks like if applied to those types of geometry. "\Then using a cube or
sphere. you (,In rotat~ the object in the Material display window by dragging on the object with

the left or right mOllse buttons. The le(t mouse button allows you to rotate only on the Z· axis by
moving the mouse left and right. When using the right mouse button. you can likewise rotate on
the Z-axis, but you can also rotate 00 the X-axis by moving the mouse up and down.

Texture Properties

This section describes the categories available in the Texture Properties window-Animation,

Material, Quality. Surface, and Texture-and explains some properties available in each category.
At the end of this chapter, you should have a broad understanding of the properties available in

the Texture Properties window, For a complete listing of all properties found in this window.

please refer to Appendix A, "The UnrealEd Manual."

AnImation Category

The Animation category holds information for creating frame-by-frame animation in your tex
tures (see FIGURE 8.21). The AnimNext property, for example, tells Unreal which texture is the

next frame of an animatioo. This allows you to show one frame after the other to display an entire

animation. Say you have a lO·frame animation of a character walking. The frames are named

CharacterOl, Charaeter02, Character03, and so on, The frames are set up in such a way that you

can (oHow the tenth frame with the first. creating a constant cycle. You could import all these

frames as textures into UnrealEJ. and in the Animation category, set Charactt"rOI's AnimNext

property to Character02. You then set Character02's AnimNext to Character03, and follow this

pattern all the way through to the r:4-;;;~=::;===============:'::j]
~~_ Non.

10th image. The 10th image is set c;::~~. 11_
~- "-to:QlOback to CharacterO 1, wb ieh i:;-;Mo'....,S"'=----'-o---------------------,1

causes the frames to loop back FIGURE 8.21 TIl A' t' te nlrna Ion ca egory.
and cycle indefinitely.
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In <lddition, this category contains the MaxFrameRa t e and MinFrameRate properties. If both prop
erties are set to zero, Unreal loops through the frames of your texture as fast as the computer's
hardware capabilities allow. Different computers play the animation at different speeds, so older
machines might fun the animation very slowly, and newer machines might run it so quickly you
can't see what's going on. To force the animation to play at a constant speed from machine to
machine, you must set these properties to J reasomble value. The value is measured in frames per

second. Therefore, jf you want your animation to cycle through 30 frames in a second, you need
to set MinFramerate to 30. To sel a playback speed limit for faster computers, you could set
MaxFramerate as well, perhdps to 60.

Material Category

The Ivlaterial category, shown in FIGURE 8.22, is where you can set the fallback material discussed
earlier, in the FallbackMatBnal properry. This category also contains the Surf aceType properry,
which gives other Actors a way of determining the type of surface you're creating, For example, if

you set the Su rf ac eType property to EST_Snow, other Actors look to that property to know what to
do when they come in contact with that surface. A character, for instance, would make soft

crunching sounds as its feet faU 011

the surface. A hovercraft would see

the property and throw snowlike FIGURE 8.22 The Material category.
particles into the air.

Surface Category

[n the Surface category, shown in FIGURE 8.23. you have access to the properties available in
the Import Texture dialog box when the texture is first imported. For example, if you create a 32
bit TGA file that includes an alpha channel, but didn't select the Alpha check box in the Options
section, you could simply come \0 this category and set the bAlphaTexture property to True. The

bMask~d property corresponds to the Masked cneck box in the Import Texture dialog box.. You
also find the bTwoSided property in this category, which makes a texture visible from both sides.

8 As you might recall from Chapter 4, "Advanced Brush Techniques," by default the Unreal Engine
doesn't render the back faces of polygons. If you set this property to True, the texture can be seen

from both sides, effectively making the polygon's back face visible in-game. This setting is
especially useful when using
Sheet brushes in your levels,
which, by default, can be seen

from only one side. FIGURE 8.23 The Surface category.

Texture Category

In the Texture category (see FIGURE 8.24), you find the Detail property, which is used to add

more levels of detail to your texture. The properlY enables you to overlay a grayscale image onto
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your texture to give the appearance
of minuscu!e cracks, crevices, and

any other kinds of tactile detail you

can imagine. The brightness or
darkness of this grayscale image
affects the final blend that occurs

with your texture. YaH want 10 keep FIGURE 8.24 The Texture category.
this image's overall value near 127.

or perfect gray. so that you're neither increasing uor decreasing the original textllre's brightness.
You also want to k~ep these images fairly small and extremely tiJeable. The Oetal.lScale property
controls the number of times this image is tiJed across your texture.

Up to this point. you have been dealing with textures of a fIxed size, such as 256><256 or 512x512.

In more advanced materials. such as a ScriptedTexture, Unreal creates the material on the fly dur
ing gameplay. ;md the size of the material isn't predetermined by a texture. The UClamp ;md
VC lamp propenies are used to clef! ne the siu 0 f these materials. 0 [] most text 1I res that have ilC tu al
shes, these properties are useless. 5(fiptedTextures are discussed later in this chapter in "Using a

Scr ipledTextu re."

Yuu can use the UClampMooe and VClampMode properties to control whether the texture tiles

(repealS) on a specifi<.: ~urface, such as a static mesh, in the U or V direction. The default set! ing,
TC_Wrap, causes a texture to tile indefinitely in that direction. A setting of Te_Clamp restricts the

tiling to one copy in the given direction. The remaining area in that direction is fiUed by stretch
ing th(' line of pixels at the edge of that texture. This means if you have a nontransparent color at

the edge of your texture, it's stretched across the surface from end to end. FIGURE 8.25 shows
!.he result of both seHings.

FIGURE 8.25 The difference between TC_ Wrap and TC_clamp.
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Shaders
Shaders are material components that ilpply certain effects to your material, such as transparency

and spt'willrity--the way a highlight is neatrd all a material when light reflects off its Sllrface.

These components help mak£' your object look like iI's made of glass, metal, polished wood, and

more. In this section, you Jearn how to create shaders and see how they can add a new level of

realism to your materials.

$haders acquire the data they need from a series of "maps." This term is not to be confused

with levels, which are also sometimes called maps. You use these maps to designate which parts

of a shader are glossy, matte, transparent, opaque, and much more. You C3n crealc maps for

these shaders directly in UnrealEd. TUTORIAL 8.4 shows the steps for creating a shader in

UnrealEd.

TUTORIAL 8.4: Creating a Shader
----------------------

r
':':"-I~:""'~ -- --
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2. Make sure the package IS set to

MaterJalTest Leave the Group

entry empty, and set the name to
tileShader. Leave the Class set·

ting as Raw Matenal for now (see
FIGURE 8.28),

1. With the Texture browser open,

Choose File> New from the menu.

8

3. In the Properties section, you can

select the type of MaterialClass

to create. The Ma ter ialClass
property is easily the most impor·

tant setting In this dialog box. as

it defines what type of matenal
you're creating. In this tutorial, F'IGURE 8.26 The New Material dialog box.
you'll use Engine. Shader. You'll

look at many other options In later

sections.

4. Click the New button to create the
shader and open its Properties

window (see FIGURE 8.27).
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,FIGURE 8.27 The Properties window for the new material.

END TUTORIAL 8.4

The Shader Properties window is similar to the Texture Properties window. 1:1 FIGURE 8.27, the

Material Tree section has been tilled with a new hierarchy of textures leading into the shader. The
item at the top of the tree is the final materiaL It combines the information from all its child mate
rials (that is, Diffuse, Opacity, Specularity, and so on) to form the material. This list is not slatic;
it's adjusted and updated depending on which propenies you use in your shader. Each child
material holds a texture, a shader, or another type of Im.teriaL The child materials of your shader
are red by default to indicate that they have been assigned a default textu reo In the foUowing sub
sections, you see how to sel- up these maps to form your shader.

Diffuse and Specularity Maps

The Diffuse map determines the overall coJor for your material. In TUTORIAL 8.5, you establish
your Diffuse map with a texture.

TUTORIAL 8.5: Setting Up the Diffuse Map

1. Open the Shader Properties window. if irs not open already. In the Textures browser. select
the tileTex texture you created In TUTORIAL 8.1.

2. Back in the Shader Properties window. click None next to the 01 f1 use property, and the"
CliCk the Use button. In the Matenal Tree network view, you see the red texture of Diffuse
change to the blue texture you imported. You·1I also notice that the icon for your top
s~lader has ctlanged (see FIGURE 8.28),
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r
FIGU RE 8.28 The Shader Properties window with the Diffuse property set.

3. The properties for your texture have also expanded. Keep in mind. however. that currently
the Diffuse map and the texture in the Textures browser are one and the same. meaning
that any changes you make to this texture for the Diffuse map affect the texture itself. If
you select the Diffuse map in the Material Tree network view. you see only the texture's
properties. This view can be usefUl if the other properties get in the way, and you want to
focus on just one speCific map.

END TUTORIAL 8.5

You now have a working shader thaL you (an apply LO any surraa in your lewIs, ClIf!'ently,

however, this shader is no different from the texture thaI makes up ib Diffuse map_ In

TUTORIAL 8.6. yOll make this shader more interesring by adding some speculafJty (or a shiny

look. For the Specular map, you'll creClt/' ~ ttxture environmrnt map, which IS discussed in

delaillatl'f in the "Creating Reflective Surfa<.:cs with Cl1bcrnaps and TexEnvMaps" section_

TUTORIAL 8.6: Adding the Specular Map

1. You still haven't learned how to create environment maps. so you'll use one that's been
created for you. In the Textures browser, open cnapte r8. u:x from the CD.

2. Next. you need to set the SpeCUlar map of your new shader to the Chapter8 _ut x environ·
ment map. First. make sure the t1leShader's Properties window is displayed. Now SWitch to
the Chapter8 package in the Textures browser and select EnvironmentMap_
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3. In the tileShader's PropertIes window, select the SpeculaI' property aM click the Use but
ton. Switch your display window geometry to a cube, and look at the results. The cube now
looks glossy (see FIGURE 8.29).

FIGU RE 9.29 The glossy cube inside the tileShader's Properties window.

END TUTORIAL 8.6

Although this shader is looking far more interesting than it did previously, it would look even bet

ter if you removed the specularity from the darker) corroded areas of the tile. You do this with a

SpecularityMask, which aIJows you to control which parts of the material appear to have spec

ulari 1Yand wh ich ones do not. A mask is a textu re that ca n be used to hide a r can trol aspects of

other textures. However, the SpecularityMask property reads data only from a texture's alpha

channel. In this case, the texture you originally imported included an alpha channel, but you need

to remember to create one yourself when making your own textures. Because the t ileTex texture
you used for the Diffuse map includes an alpha channel, you can use thar same texture in
TUTORIAL 8.7 for the Specular i tyMask.

TUTORIAL 8.7: Taking Advantage of the SpecularityMask Property

1. You have already seen how to use the Use button, so this time you take a different
approach to placmg a texture into a property. Select the Diffuse property, select the text of
the texture's name. and press Ctrl+C to copy it to your computer's Clipboard.

2. Select the SpecularityMask property, press Ctrl+V to paste the Clipboard contents into
the field (see FIGURE 8.30), and then press Enter.
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FI GURE 8.30 Specular i tyMask in operation.

3. Make sure the Outpu tBlendlng property is set to OS_Normal. This setting ensures that
all channels operate without adding any extra blendmg effects. You'll be loOking at these
options shortly,

END TUTORIAL 8.7

At this point, the darker spots of the material should no longer have any sp{'cularlty. FIGURE 8.31

show'> the image and alpha channel side by sidt'_

FIGUREB.31 On the left is the Image, and on the r1gllt is the al pha cha nneL
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As you can see, the darker areas of the alpha channel are the areas that have less specularity, and

the while parts have full specularity.

Opacity Maps

The Opacity map of a shader works the same way as the Specularity map. It reads the alpha chan

nel of its assigned texture and uses it to designate which parls of a material are transparent,

opaque, or some level in between. For the Opacity map, while areas of the texture are opaque

(solid), and black areas be transparent. Shades of gray produce varying levels of transparency in

relation to the brightness of the gray.

Self-Illumination Maps

You can use a Self-Illumination map to brighten certain areas of your material. By default, how

ever, a Self-IUuminatioll map overlaps the entire Diffuse map. This causes the material to be unJit,'

or no longer responsive to lights, and hides the Diffuse map. To counteract this effect, yOll can LIse

a Self-Illumination mask to determine which areas of your material show the Self-IUumination

map and which parts show the Diffuse map.

The Self-Illumination mask works the same way as the Specularity mask, in that it reads your

texture's alpha channel and uses that information to control where the Self-Illumination map

is visible and where it is not. The white areas of the mask cause the Self-Illumination map to

show on top; the black areas show the Diffuse map. The shades of gray in between allow for

partial transparency of the Self-Illumination map, causing the Diffuse map to shine through

partially. In addition, white areas of the mask designate areaS that aren't affected by lights in the

level. Black areas receive illumination regularly, and shades of gray create areas where light has

only a partial effect. The Self-Illumination mask is especially useful for areas of a material that

need to be glowing.

other Properties

Shadel'S also include a Detail map, which functions in the same way as a texture's Detail prop

erty. You need to specify a texture to use as a Detail map and then set the DetailScale property,

and you'll add a new layer of detall to your material.

If the Wireframe property is set to True, your material is rendered in-game as a wireframe. The

TwoSided property determines whether the negative side of a polygon renders when the material

is applied to it. This property is especially useful with a Sheet brush, which by default is visible

from only one side. The TwoSided property also proves useful when you're creabng a transparent

or semitransparent material. If, for example, you apply a glass-like material to a cube, you expect

to see all of the cube's surfaces when you look through it. If TwoSided is not selected, however,

you can't see the back of the polygons that form the cube.
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The Outpu tBlending property allows you to apply a variety of effects on your shader to control

how it blends with other materials. Several modes are available for this property, described in the

foUowing Jist:

.. OB_Normal-This mode causes no extra blending effects to be applied .

.. 08_Masked-This mode uses an alpha channel to make certain areas of your shader

visible or invisible. [t doesn't produce any variation of transparency. If no alpha chan

nelis specified, the transparency is calculated with the Diffuse map instead. If the map

has an alpha channel, all areas with an alpha value less than 128 are im"isible. If the

image has no alpha channel and is not an 8-bit image with a palette, this property has

no effect. Finally, if it's an 8-bit image, all colors located in the first entry of the palette

are invisible.

• OB_Modulate-Areas that are white (RGD value of 255) become invisible, and black areas

(RGB value of 0) become opaque. Every shade of gray in between creates a faded effect

based on its value.

.. OB_Translucent-This mode causes the dark areas of your material to be more

transparent and the brighter areas mure opaque.

)- OB_Invisible-This mode hides your material based on your Opacity map, but leaves

your environment map visible. If, for example, your material has a Reflectivity map, only

the reflective areas remain visible; the rest of the material is hidden.

• 08_8r igh t en-This mode creMes a general brightening of your entire material.

• OS_Darken-This mode creates a general darkening of your entire material.

Modifiers
A modifier is a type of material that alters or changes the look ofan existing material. A wide V<lri

ety of changes arf' possible, from a simple change of color to making the texture animate in some

8 way. In this section, you learn about the most frequently used modifiers and how they can be used

to manipulate your materials.

The Color Modifier

The Color modifier allows you to change a material's tint to a particular color. To use it, you sim

ply need to choose a color and selcctlhe material yOll want to modify. In TUTORIAL 8.8, you see

how to create this modifier and apply it to your material.
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TUTORIAL 8.8: Creating and Using the Color Modifier

1. Creme a material by choosing File> New from the Textures browser menu. Use the
(ollowing properties:

Package: MaterialTest Class: Raw Material

Group: (leave this setting empty) MaterialClass: Engine,ColorModifilH

Name: ColorModifler

2. Click the New button and lake a look at the properties for this new material.

3. Only four properties are available for thiS modifter, described In the followmg list:

• Color-This property allows you to choose a color for tinting your material.

• RenderTwoSided-Thls property (uneteons the same as the bTwoSided property for
lextures, discussed earlier. It enables you to see a matenal on the backface, or

negatIve side. of a surface.

• Alpha8lend-Thls property behaves the same as a texture's bAlphaTexture
property. It checks the alpha channel you have applied to a material and uses it to

control transparency for your matenal.

• Material-This property determines which material is affected by this modifier.

Set the Color property to some shade of green. and set the Material property to

uleTex. The results are shown in FIGURE 8.32,

FIGURE 8.32 The tileTex texture modified to have a green tInt.

EN D TUTORIAL 8.8
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The TexOscillator Modifier

You can use the TexOscillator modifier to add repeating motion to your textures. It's created in the

New Material dialog box in the same manner as the Color modifier. However, the effect of the

TexOsciJlator changes over time. You can use it to make your textures move in a specific direction

or to stretch them. The key aspect of the TexOsciJlator is that its animation oscillates, or moves

back and forth io a cycling fashion. This means the animation starg at a certain point) goes to its

extent, and then moves back to its origin<ll position. If you graph the motion, it would look like a

sine wave (discussed in more depth later in this section).

The UOscillationRate and VOscillationRate properties control the sperd Jt which the texture

moves in the U or V direction. The speed is measured in complete revolutions per second.H, for

example, you set it to 2, there would be two revolutions per second or one revolution every 0.5

seconds. You can set it to a negative number if you like. which causes the animatjon to begin by

moving backward, and then os<:iUating fon....ard.

The UOscl.llationPhase and VOscillatlOnPhase properties control the pOInt at which the anima

tion begins in the U or V direction. The properties are set to a 0 to 1 scale: 0 is the beginning of the

animation, and I is the end, which could also be considered the start of the second cycle. If you set

UOscillationPhase to 0.5, for example, your animation would begin at the middle in the U direction.

The UOscilla t ionAmplitude and VOscilla tionAmplitude properties control the distance trav

eled during animation. They are set to a value of I by default, meaning that if the texture is pan

ning, it moves the length of its texture size from left to right, and then back to its original position.

It then mOves the len~th of its texture size from ri~ht to left, and then back to its original position.
11 repeats this cycle indefinitely as a constant, smooth motion. If you bump the size up to 2, the

texture moves twice as far (two texture sizes) in each direction.

The motion can be represented by graphing a sine wave, as shown in FIGURE 8.33.

..
," '.' O1It1!latotRalll =.'2': '

O:Scl/l&tOr~lIise:': Q' .'
., : 06cIIIafo,~litvd.":2,:

- ...
FIGURE 8.33 A sine wave representing the movement of a TexOscillator.
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The final properties for a TexOsciUator are UOscillationType and VOscillationType. These

properties control the type of animation in your material. These are the four (ypes available:

~ OT_Pan-Tbis lype causes the texture to pan, or move in a sliding motion. You can set the

distance it moves by adjusting the VOse i llationAmplitude or UOscillat ionAmpli tude

property. The pan moves the texture in one direction, then back in the other direction,

and finally back to its original position to complete one oscillation.

~ OT_Stretch-This type scales your texture by the amount set for the amplitude. It then

shrinks the texture back to its original size, completing one oscillation.

~ OT_StretchRepeat-This type functions similarly to OT_5t retCh, but does not smoothly

shrink the texture back to its original size. Instead, the texture snaps back to its original

size to complete one oscillation.

~ OT_Jitter-This type moves the texture around randomly at the speed specified in the

OscillatorRate property and by an amount no higher than the OscillatorAmplitude

property specifies.

Rememher that you can set separate oscillator types, oscillator rates, and oscillator amplitudes for

both the U and V directions. If you mix and match these settings, you can create some interest

ing effects.

The TexPanner Modifier

The TexPanoer modifier also animates your texture, but unlike the TexOsciJlator, the animation

does not go back and forth. It simply pans your texture in a given direction at a constant rate. By

default, the texture moves to the left. The PanDHection property controls the direction in which

the texture moves. However, the settings for the PanDirection property are fairly unique.

Although it includes Yaw, Pi tch, and Roll settings, all the control you need to change the texture's

pan direction is available by adjusting the Yaw setting. You can adjust it in Unreal rotation units

to control the direction in which your texture moves.

Unreal's rotation units are quite different from standard rotation degrees or even radians. A 360

degree rotation is equal to 65,535 Unreal rotation units. The reason has to do with how a com

puter's memory functions internally. A computer's memory is divided into various

compartments, and each compartment can hold only a certain amount of data. The largest num

ber one of these compartments can hold is 65,535. So if you try to place the number 65,536 in

one of these compartments, the computer stores a value of 0 instead.

When incrementing numhers in a computer, the computer internally counts up to onfy 65,535

and then starts at zero again. This is similar to degree-based rotations, in that if you rotate a tex

ture 360 degrees, you could then start at 0 again and continue rotating. In Unreal rotation units,

the same rule applies. Because a computer's memory compartments don't automatically reset to

zero when they reach 360, an extra calculation is needed to tell the memory unit to restart at zero.
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That calculation would take time. If a full rotation were set to 65,535, however, the reset would
be automatic. Therefore, the rowtion system has been converted to a number system that auto

matically restarts at zero when a full rotation has been reached, without the computer needing to
create any extra computations,

You can easily convert from degrees to Unreal rotation units with the following formula:

(65535 x degrees) / 360 = Unreal rotation units

U~Ing this formula, 90 degrees would be 16,383 units, and 180 degrees would be 32,768 units. You
can use this system to control the direction in which the TexPanner moves your texture. 1\ value

of 0, which is the default setting, moves your texture to the leh. To move the texture to the right.
you need to rotate the direction 180 degrees, or 32,768 units. You can use TABLE 8.1 to control
the exact direction of the pan. The nature of Unrea]'s rotation units is discussed in more detail in
the next section.

TABLE 8.1 Controlling tile Direction of the Pan

Direction Yaw Setting

Up 16384

Down ·16383

Leh 0

Right 32768

The Roll setting has no affect on the PanOlrect 1011 property. The Pitch setting influences
the motion, but using ani}' Yaw IS recommended, as il gives you direct control over the texture's
dir~clion,

8

The PanRate property controls the speed of
the pan, calculated in texture sizes per sec
ond, This means that if you set PanRate to 2,
your texture moves two texture sizes in the
given direction every semnd.

The TexRotator Modifier

CAUTION
The PaoRa t e property's result can become unpre
dictable jf its Yaw value is set to anum ber other than
what's listed in TABLE 8.1.

The TexRotator modiner allows you to rotate your textures two-dimensionally to the right or
left and three-dimensionally by flipping them in a horizontal or vertical direction. This modi
fier is immensely useful for controlling special textures, such as a rotating fan. You can create

the modifier in the New Material dialog box, the same way as the other modifiers discussed
previously.
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The first property available in the TexRotator modifier is TexAotationType, which controls the

kind of rotation yOll receive from the modifier. You can use these three types of rotation:

~ TRJixedRotation-This setting doesn't animate the texture at all. Instead, it simply rotates

the texture to a specified angle. The Yaw setting allows you to rotate the texture to the left or

right. Pitch allows you to flip the texture horizontally, and Roll flips it vertically.

~ TR_ConstantlyRotating-As the name suggests, this setting causes your texture to rotate

constantly in a given direction. The Rotat ion properties control not only the rotation's

direction, but also its rate.

~ TR_OscillatingRotation-This setting is similar to the effect of the TexOsciJlator, in

that it rotates the texture a certain amount in one direction, and then the same amount in

the opposite direction. rt repeats this cycle indefinitely. The OscillationRate,

OscillationAmplitude, and OscillationPhase properties apply only when this setting is

active and function the same as their TexOscilJator counterparts, discLlssed previously.

The UOffset and VOffset properties control the location of the center of rotation, also called the ori

gin of rotation. By defauJt, it's set to zero, which is the pixel at the texture's upper-right corner. To accu

rately place the origin, you need to know the size of your texture, For example, if you want to place the

origin of rotation at the center of a 128x128 texture, you need a UOffset and VOff set value of 64.

The TexScaler Modifier

The TexScaler modifier does not animate your tex:tu re, so it scales your material only once. If you

want to animate a scale, you use the TexOscillator modifier with an oscillation type of St retch or

St retchRepeat. The TexScaler modifier has four properties:

FIGURE 8.34 On the left, UOffset and VOffset are at
the default of 0, On the right, UOffset and VOffset are
adjusted $0 that the origin is in the center of the texture,

illustrates how an object scales

with its origin in these two

locations. '

~ UScale and VScale-These properties control the amoLlnt that the material is scaled in the

U and V directions. For example, setting both to 2 would make the texture twice as large.

~ UOffset and VOffset-These properties control the location of the origin of seating, calcu

lated in pixels. This setting is similar to the origin of rotation used in the TexRotator modi

fier. Be default, it's set to 0, which is the pixel at the texture's upper-left corner. Therefore, the

scale either shrinks the texture

toward that point or expands

the texture away from it. To

place the origin of scaling at the

center of a 128x128 texture, you

need a UOffset and VOffset

valueof64. FIGURE 8.34
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The Combiner Modifier

- ------

The Combiner modifier enables you to bring two materials together as one. This modifier has
severa! different settings that contro! the manner in which the materials are blended. To use ii,
you need to designate the first material called Materiali, a second material called Material2, and
sometimes a mask, with an alpha channel used to control how the two materials are combined.
A InJsk is not dJways necessdry, as illustrated in some of the Combiner's properties.

The COnlbineOpera tion property determines how the materials interact with each other and
specities how or if they make use of the mask texture's alpha channeL The following Jist describes
the avaiJahle modes, wid, figures to illustrate. For these illustrations. the rnatrrials shown in
FIGURE 8.35 are used.

• •
• ft.

FIGURE 8.35 From left to right: Matt, Mat2, and Mask.

8

.. The CO_use_Color_From_Materiall

and CO_Use_Color_From_MaterlaI2

modes simply show Materiall or
Material2 without adding any special
blending processes,

.. CO_Mul tip ly lTlultiplies ?vfateriall aJld

Malt:rial2 togelher to produce a final
output. FIGURE 8.36 shows the

result. When using Ihls mode, Unreal
consid"rs the Module2X and Module4X

properties, In any other modl', these
properties are ignored,

If Moaul e2X is sel (0 true, the fina 1
material's brightness is doubled. If
Module4X is ~el to true. the material's
brightness is quadrupled. Keep in

-~ --------~~---~-.......,

NOTE
You can try these examples yourself, or open the

I combinerTes t . ut x package included with this
; book.

FIGURE 8.36 Using CO_Multiply
for the CombineOperar ion property.



mind that the Module4X property has

priority over Module2X. Therefore. if
Module4X is set to True, the Module2X

propercy is ignored .

.. The CO_Add mode adds the values of

the two materials together to produce

the final material. In most cases, it con
sidcrab�y brightens your new material,

as shown in FIGURE 8.37.

» CO_Subtract causes the values of

Material2 to be subtracted from

MateriaH to produce the final output

(see FIGURE 8.38) .

.. CO_AlphaBlend_l'Iith_Mask dra.....s

Material! over Malerial2 and uses the

mask to determine where you can see

through to Material2 (see FIGURE

8.39). The white areas of the mask

show Materiall, and the black areas

show Material2_ If you need to reverse

the result of the mask, you can use the

InvertMask property. When set to

True, it invert~ your map.

.. When using

CO_Add_IHth_MaSk_Modulatlon, the

MasK property is ignored and the alpha

channel of MateriaJ2 is used inslead,

Vv'here the alpha channel of Malerial2

is white, Materiall and Material2 are

added together. Por ex~mpJe, say Ihat

MateriaJ2 has the alpha channel shown

in FIGURE 8.40.

Then the Combiner modifier would

outpllt what's shown in flGURE 8.41.

You can see that the black areas simply

show Material2, and the while areas

add the values of Material] and

Material2 together. If your Material2

didn't have an alpha channel, the lVVO
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fiGURE 8.37 Using CO_Add for the
ComblneOperation property.

FIGURE 8.38 Using cq_SUbtract for the
CombineOperation property.

FIGURE 8.39 Using CO_AlphaBlend_Wi th_Mask
for the CombineOperat i on property.

FIGURE 8.40 An alpha channel.
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FIGURE 8.41 White circle with a black back
ground used as the alpha channel.

materials would be added together in
their entirety, just like using the CO_Add

mode.

• CO_Usa_Color_From_Mask provides

results that are the same as
CO_Use_Color_From_Materla11.

The AlphaOperat ion property controls what
the Combiner uses as the final alpha channeL
By defalllt, AO_use_Mask is selected. causing
the alpha channel to be the alpha channel of
the mask. This mode also requires setting the
Mask properly to Materiall, Material2, or
nothing al all.

When usi ng AD_Mu1t 1p1y, the alpha channels of Ma teriall and Materia12 are multipl ied together
and the resulting alpha channel is used. AO_Add adds the two materials' alpha channels together to
generate the final alpha. AO_Use_AlphaJrom_Matena1t and AO_Use_A1phafrom_Materia12
simply allow you to use the alpha channel of the respective materiaL This mode also requires set·
ting the Mask property to Materia]}. MateriaJ2, or nothing at all.

Creating Reflective Surfaces with CUbemaps and
TexEnvMaps
To create a surface thaI appears to be reflecting its surrounding environment, yOll implement an
environment map into your material. An environment map is a panoramic represenlation of your
level's environment, sampled from a specific reference point in the level. To create this map, you
acquire six images of your level, all taken from a single location and each pointing in one of six

8 directions: up, down, north, south, east, and west. The Cubemap stores these images and com
piles them together. However. this alone doesn't produce an environment map. The TexEnvMap
converts the Cubemap into an environment map, based on the reference point used to create the
Cubemap's images and the player's position and oriental ion.

The Cubemap's textures are represented internally in the configuration shown in FIGU RE 8.42.

Notice thaI you could fold the sides of this image together and get a cube. If yuu were to do
lhis, and thrn look at the images from inside the cube, you would have a representation of
your surrounding envirollmem, just like painting a panoramic landscape on the walls of a
room.



FIGURE 8.42 A CUbemap's intemal representation.

\Vhen acquiring the images that hecome your environment map. precisely rotating the camera

manually would be extremely difficult. To alleviate this problem. UnrealEd has a series of hotkeys

that rotate your camera in the necessary directions. You can use the diagram in FIGURE 8.42,

or you can use the folJowing list:

~ Number pad 0: East

~ Number pad 1: West

• Number pad 2: South

~ Number pad 3: North

~ Number pad 4: Up

• Number pad 5: Down



8

298 Chapter 8 Creating Materials In Unreal

If you're using the Runtime Engine. these hotkeys are already set up for usc in UnrealEd. In the

retail build of Unreal10urnament 2004. however, these hotkeys must be added manuaUy. 10 do

this, go to the System folder of your Unreal Tournament 2004 inst:lllatjon directory and open the

User. lni file. Using whatever search function is <lvailable in your texI editor. search for NumLock=.

When you find it, place the following lines of text beneath thaI line:

NumPad0=set playercontro!ler bZeroRoll False set playercontroller rotation
(pltch=0,yaw=0,roll=16384)

NumPad1~set playercontroller bZeroRoll False set playercontl'oller ,·otation
(pitch=0,yaw=32768,roll=·163841

NumPad2=set playerr-ontroller bZeroRoll False set playercontroller rotation
(pitch=0,yaw=16384,roll=32768)

NumPad3=set playercontroller bZeroRoll False ,
set playercontroller rotation,

(pitch=0,yaw=16384,roll=0)
NumPad4=set playercontroller bZeroRoll False set playercontroller rotation

(pltch=16384,yaw=0,roll=16384)
NumPad5=set playercontroller bZeroRoll False set playercontroller rotation

(pitch=163B4,yaw=0,roll=16384)
NumPad6=set playercontroller bZeroRoll True ,

set playercontroller rotation,
(pitch~0,yaw=0,roll=0)

These lin/'s simply assign tht number pad keys to point the camera in the correct directions.

TUTORIALS 8.9 through 8.12 walk you Ihrough the creation of a working Cubemap.

TUTORIAL 8.9: Taking the Cubemap Screenshots

1. Open the Tutorial!)_09_Start. L't2 file, which is the same level you created in
Chapter 3. "Creating Your First Level With UnreaIEd." The goal of this tutorial IS to make a
Cubemap so that objects in the control room. such as the glass wall. can be reflective.

2. Before you make the six texlures you need to create your environment map. you need to
adjust some settings in Unreal Ed. From the UnrealEd main menu, choose View>
Viewports > FIxed.

3. Choose View> Advanced Options. In the Advanced Options dialog box, expand Editor>
Advanced, and set UseAxisllldicator 10 False 1o hide the small axis indicator in the cor
ner of the 3D viewport.

4. Because you want the Cubemaps 10 be a reflection of the room. you don't want the light
icons, or any other Icons, to interfere. To hide them, you're going \0 create a group, add all
the Actors with Icons to the group, and then hide the group lemporarlly_ Open the Group
browser by clicking the Group browser icon on the loolbar.



5. By default. there's only one group labeled None, T IS group holds every AClor that Isn'lln

some other group. and because there's no other group at the momenl, the None group
contains every Actor in the level. You want a group to hold aU miscellaneous Icons in the

control room. Before you can create the group, however, you need to have at (east one
Actor selected that you plan to put in the group. Therefore, select the eight lights that are

immediately visible from the center of the control room, and then select the Player Start
(see FIGURE 8.43).

FIGURE 8.4.1 Icons that need to be selected.

6. From the Group browser's menu, choose Edit> New Groop. In the New GlOUD dialog box.
type in the group name leons and CIICI( OK.

7. To hide these ICOrlS, simple clear the check box next 10 the Icons group. II not all the

icons disappear. that means you simply didn"t place them In thal group, TO add other

Actors to the group, select those ActOrs, make sure the Icons group is selected in the

Group browser. and choose Edit;.. Add Select~(J Actors 10 Group. After thal. yOu might

need to choose View> Refresh so that everything is uO{jat xl.

8. Because the final resolution you·1I be uSing for these Cuoemaps is 256x256. you"re going
to change the viewports into a configuration that more Closely reflects Ihat lotio. From
the main menu. chOOSe View" VlewportS > Configure, select the thud buC1.ort (large

Perspective view on the right, wilh three stacked ollhogroPhic views on the left> and

click OK.

9. NaVigate the 3D vlewport's camera Into the center 01 the conlrol room (see FIGURE 8.44).
FIGURE 8.45 shows the c;,mera's Position in the PerspectIVe viewpoll.
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FIGURE 8.44 Top vlew of ttle camera j)()Sttlon.

FIGURE 8.45 3D vlew <If the camera posItion,

10. N()W press 0 on the number pad lO (01.3le the C.3lY1era 'nto position (6r your E.3st shoL

Press F9 to lake a screenshot of this scene (see FIGURE 8.46).

11. Now press 1 on the number pad, and press F9 to take another screenshot. Press 2 on the

numMr pad, and Pl'e ss F9 again. Cantin ue until you 'lie pressed 5 on the numbe r pad tor a

lolal of six screenshots. However, before you use them in your Cubemap. you mus\ change

their si2e to something acceptable 10 Unreal.
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FIGURE 8.48 Image taken of the East position (number pad 0).

END TUTORIA 8.9

In TUTORIAL 8.10, rOll resize the series of screenshots you just created to 512xSl2 in Adobe

Photoshop. You'll be doing this WIth an Action, which automates the task, turning the entire

pro<..e:>s into just a few clicks and key presses. If you don't have Photoshop, you need to resize the

images to 512x512 with the 20 image application of your choice.

TUTORIAL 8.10: Resizing Screenshots
---------------------

1. Start Photoshop, and open your six screenshots. You can find them in the ScreenS/lOts

folder. located Within the installation folder o( UT2004 or Unreal Runtime, depending on

which program you're using. You can open all SIX by holding down elfl and clicking each
file indiVIdually.

The Actions palette.

DJdAdIoM~n

~·~IIIt(u.r.c.\latl)

) 'Fr •Ch~.;j , ~ Pent
-> ·,l(Mt"'1Wfl'it;-~-if·toti

~ -::::l~(lyp4l)

t- "_.MIl p.~~~;;')

~ ~om;u;at~~~

~ robt~n. L.I(~

FIGURE 8.41

2. Notice that the images aren't

256x256. YOU'll fiX the size manu·
ally for the first image, but then set

up an Action that automates reSizing

the other images. Begin by clicking
the A<;tions palette or choosing View

> Actions from the menu (see

FIGURE 8.47).
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I1ill 3. Click the Create New Action Icon IT!ll at the bottom of the Actions palette.

4. In the New Action dialog box, set the following properties, and click the Record button
when you're finished:

Name: EnvMap Resize

FunctIOn Key: F2 (Selecl the check box next to Shift)

Color: None

5. AI/ your Actions are now being
~

recorded for future use. From the
f1xB Dmenslcns: 7flUJ< (was 1.14M);l /j/i:

menu, choose Image> Image Size.
Y«llh:~ IfiJeI< 0dI (.nee

Set the following properties (see
FIGURE 8.48), and click OK when

Hedrt: IS12 1~e1s ~ ~...
finished: ~SIn!;

Constrain Proportions: Clear this
IMdth: 118,06 Ion :::::J

check box (dO this first!) 1-fl>Il;tlt: 118.06 Ion .tl

Width: 512 pixels
A.e:lolJ1lcrI: In I~jh:h :=1

Height: 512 pixels
j;O r
r Cl:r!<lr....Pr~

~ ~pe Imilge; rBiC\bi:: :::::J
6, Save the image and close it,

[Q] 7. Click the Stop button ~ at the bot· FIGUR~ 8,48 The Image Size dialog box.

tom of the Actions palette.

8. The Action has now been recorded. and you can repeat tne Action whenever you like by
pressing Shift+F2. Try it by selecting the next image, and pressing the hotkey combination.
Repeat until all six images have been resized.

9, Rename each image so Ihat the first screenshot IS named cube0, the second named
cube 1, and so on, If you're unsure as to the order, look at the number of the screenshot.
The lowest number is cubeO, the next is cubel, and so on up to cuhe5, which is the high.
est number,

10. You're finished With Photoshop for now,
so go ahead and close It.

END TUTORIAL 8.10

Make sure you save the images in one of the formats
compatible with Unreal, as mentioned at the begin
ning of the eha pter. In this case, BMP works fine.

Your images are now scaled to a size that's a power of two, so they are ready to be imported into

Unreal. In TUTORIAL 8.11, you see how to get the textures into Unreal and use them to create
a Cubemap_
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TUTUR]AL 8.11: Creating the Cubemap

1. In UnrealEd, open the Textures browser, and choose File:> Import from the menu. Navigate

to the six resized images you just saved, select all six. and click Open.

2. Change the package to control Room and make sure the Group entry is blank, as you're

not adding a group to the package (see FIGURE 8.49). Click the OK All button.

- -

3. With the new textures imported,

you're ready to create your
Cubemap. Choose File > New from

the menu, set the following proper·

ties In the New Material dialog box,

and click New when you're finished:

Package: controlRoom

Group: (Leave this entry empty)

Name; controlRoomCube

MaterialClass: Engine.Cubemap

Impmt Tr.Mhltc _

[

I;:, E.\o.8.~"'~borc> ~.
P~'lcorlJofl""" OKA,!I

a,<qX I ~

~.....; .-I,,-,--"""---:)----~--I c:....oel

LOD: l~

FIGURE 8.49 The Import Texture dialog box.

4. In the Properties Window for the CUbemap. expand the Cubemap category. Select the Faces

property, and click the Add button six times. This creates six new index entries, labeled [0)

through (5). Set Index (0) to the cubeO texture by selecting the texture in the browser, and

clicking the Use button next to Index fOI. Repeat this precess to set index [1) to the cube1
texture, index (21 to the cube2 texture, and so on. See FIGURE 8.50 if you need Mlp.

FIGURE 8.50 Cubemap properties.

END TUTORIAL 8.1
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Your Cllhemap has been created. As you'll recall from earlicr in the chapter, however, it isn't
enough to create the effect you want. In TUTORIAL 8.12, you create aTexEnvMap to convert the
Cubemap into an environment map.

TUTORIAL 8.12: Creating the TexEnvMap

1. In the Textures browser, choose File> New, set the followmg properties, and click New
when you're finished:

Package: controlRoom

Nome: controlRoomEnv

MaterialClass: Engine.TexEnvMap

2. In the Properties window for the Tex£nvMap, change the Ma tel" ial property to
controlRoomCube (see FIGURE 8.51).

FIGURE 8.51 TexEnvMap properties.

3. Set the EnvMapType property to EM_Calfleraspace so that the environment map takes the
player's position and orientation into account when rendering. The result IS that the reflec·
tion appears to be moving like a reflective surface. If you set the EnvMapType property to
EM_WorldSpace, the reflection map would he dependent on the direction the surface was
facing and would appear static. Insteacl of moving with the player- FIGURE 8.52 shows
the final result.
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FIGURE 8.52 A cube placed inside the control room with the environment map applied to it.

END TUTORIAL 8.12

Now that you have successfully created an environment map, you can make any object in the con

trol room reflective by placing this environment map on it. lif you want more control, however.
you could apply it to the Specular chaonel of a shader.

Final Blend Material
You can use the Fioal Blend material to add anotl,cr layer of blending to your materials. It's
similar to the Combiner modifier, but uses only a texture and its alpha channel (if it has one),

instead of operating from two textures and a mask. YOli can create the Final Blend material by

choosing it in the MatertalClass property when creating a new material. To illustrate how this
material works, t.he same texture used as an example for the Combiner modifier is used (see

FIGURE 8.53). The textUre on the right is used as the al pha channel. The folJo.,.,ing properties

are available for the Final Blend material:

.. AlphaTest-This property activates the texture's alpha channel, allowing yOll to use it for

blending. The AlphaRef property enables yOll \0 adjust the range of your alph<l channel.
As you know, an alpha channel is a grayscale image, and its values range from 0 (black) to

255 (white). All alpha channel values lower than the number placed in the AlphaRef

property are treated as zero.

305
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fiGURE 8. 3 On the left Is the Image. and
on the right is the alpha channel.

FIGURE 8.59 Effects of
the FB_Bn.ghren setting.

FIGURE 8.57 Effects
afthe FB_Translucent
~tting.

FIGURE 8.66
Effects of the
F8_AlphaBlend setting.

, t
I

I t a
• •..-

.- .
•, I , I•. .-.

:- :- .'

FIGURE 8.54
Effects of the
FB_lJoduJ B re senlng.

~.~. l!~--o<ro;.a- ...~~

FIGURE 8.58
Effects of the FB_
AlphdAloc1ul ace setting.

,-,.,

fiGURE 8.58
Effects 01 the
F8_Darken setting.

,,1.-.-..- -.1.11...,.......'-.........,
111'- -··VY'I..n.·..~

~ Frame8ufferBlending-Th.is property

specifics ,he way ia which the bknding

of thc material OCCII(5. 8y default, iI's SCI

(0 FB_Ove rw f 1t e, wnlcn has nO effect

on the I("lilure. '111e following liSI

describes the oth{'r .1V~iJablc swings (or

this propertj' ;j.nd ilustr3tC$ their effects

wilh figures:

~ F6 _~oclula te darkens all Jlpha

eh,l1lne! values loweJ lhan J27

and brigh/ens "U others (see

FIGURe 8.64). The material's

transparency is affected as well.

The color white is completely

transparent. and black is com·

pletclr opaque.

~ FB_AlphaBlend used on any male·

rial or tn,1ure is identical '0 sening
the m:llcrial's bAlphaTextufe

propcl'l}' to True. This .!>ell1ng
blends Ih.: millcrial's alpha channel

for op:l.city. Th'f("fnrc, Lhe black

areas of !.he channel bl'GOme com
pletely rransparent, and lnt' \...hi,e

3U:lS become' op3que (see

FIGURE 8,66).

~ FB_AlphaModula te_

MightNotFogCorrectly lnodu

la(~s aU areas where the alpha
channel is black. Therefore,

rnc while parts of the alpha chan

nel arc not influenced
(see FIGUF..! 8.5e).

.. FB_TranSllJCent makes the black

.u-e.1.S o( the rnau:rial complelely

lrmsparent rtJld the white areas

cOlllpktdy opaque. !':very other
color is p,lrli:illy trampi1rent, based

on its \laluc(~~ FIGURE 8.57).

8



~ fB_oarken darkens the texture so that it app<>ars darker

on the background. This makes the texture's colors look
inverted (see FIGURE 8.58).

~ FB_Br ight en makes all black areas of the material com

pletely transparent, anu all others are blended according

to the intensity of the alpha. The visible areas are then
brightened (see FIGURE 8.59).

~ fB_Iovis ible causes the texture to be completely hid
den (see FIGL';!E 8.60). This setting is useful only when

dealing with Zone Portals.

The last two properties for the Final Blend material are used to control

the order in which the texture is drawn:

~ ZTes t-This property works with the ZWrite property

(explained next) to control the order in which the texture is

drawn. When the ZTest property is sct to True, the position of
the texture is tested to ensure that the rearmost tex(Ure is not
drawn last-that is, on top of the texture above it. However,

this property is useful only when {\I.'O textures overl.ap, as in

FIGURE 8.61, where ZTest is set to False. Noticf that the

smaller circles at the back of the cube are ac:tuaUy being drawn

after (on top of) the circles on the front of the cube. To fLX this,

set ZTest to True.

~ ZVJrite-The Z information tested by the ZTest property is

not saved unless the ZWn te property is set to True. After set
ting ZTest and ZWrite to TflIe, the error is fLxed, as shown in
FIGURE 8.62.

Using a ScriptedTexture
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FIGURE 8.80 Effects of
the FBjfl1lisibl e setting.

FIGURE 8.81 ZTest
set to False.

FIGURE 8.82 ZTesr
and ZWr i t e set to True.

A ScriptedTexture material allows the Runtime Engult' to create and alter the material during

gameplay based on dynamic elements in the game, such as a plilyer's score or walking in froni of

a security camera, When you first create this texlore, the Material display window is blank

because you're no longer basing the material on a pre-existing texture. All the inform<ltion for cre

ating the texture is produced during runtime, so yOll need to create an Actor that sends data to
the ScriptedTexture while the game is playing.
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Two types of Actors can be used for this purpose: the CatneraTexturcClient and the

MessageTextureClient. The CameraTextureClient sends the pixel infonnJtion it reads from a

sl'ecific point in space and direction to the ScdptedTexture. resulting in a security camera

effect. The MessageTextureClient sends text to the ScriptedTexture, allowing it to draw custom

text onto the surfaces of your levels, such as a constantly updating scoreboard, making it pos

sible to automatically display a character's name on a license plate when he or she enters a

vehicle. for example.

In TUTORIAL 8.13, you use a ScriptedTexture to create a security camera effect.

TUTORIAL 8.13: Creating a Security Camera

I, Open the Tutoria18_13_Start. ut2 file. You'lI place a camera pOinting down into the
base of the elevator and tlave that camera feed into the middle monitor in the control
room,

2. From the Textures browser menu. choose File> New. Create your ScriptedTexture with the
follOWing settlllgs:

Par.kage: securityC(lmera

Group: (Leave this entry empty)

Name: cameraData

MatenalClass: ScnptedTexture

3, As mentioned earlier. you won't see anything in the Materia) display window at this point
because the texture has no pixel data, In addition, you haven't set the texture's size yet.
You can do this With the UCla'np and VClamp properties. In the ScnptedTexture Properties
window, set both propertieg to 256 (see FIGURE 8.83). The other propBrties listed in
this window should be familiar to you by now.

4. Next. you need to create the Actor that serves as your camera. It can be almost any
Actor in your level. To designate a camera, you need a position and a direction. which all
Actors can prOVide. In this case, you'll use an emitter, as it doesn't have a lot of excess
functionality.

In the Actor Class browser, select Emitter. Right·click somewhere near the base of the ele·
vi;ltor, and add It to the level,

5, By default. however, an emitter doesn't specify (l direction, which is necessary for the
Actor to serve as a camera. Open the Properties window for the emitter, and under the
Advanced category, set the bDirect lonal property to True. A red arrow points out of the
Actor, showing its direction (see FIGURE 8.64)_
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FIGURE 8.84 Emitter with a dIrectional red arrow.

FIGURE 8.63 The ScriptedTexture Properties window,

6. Now move the emitter to the corner
away from the wall and door, and

rotate it until its red arrow is point·

ing toward the entrance to the eleva·
tor. Alternatively. you could click the

Lock to Seier-ted Actor leO(\

above the 3D viewport and then
click me emitter. Now as you move

and rotate the camera around, you

are. in fact. moving the emitter (see
FIGURE 8.65). When it's In a good

posItion, click the Lock to Selected
Actor icon again, and the emitter

slops moving around.

Also, set the Tag prOjJerty of this emitter to securi tyCamera. The CameraTextureClienl

uses thiS information later,

7. Next, you need to create your CameraTe~ureClient. You can find it in the Actor Class

browser under Info> CameraTextureClient. Although the position of this Actor has no

effect, place It near the emitter for clarity (see FIGURE 8.66).
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The Skins property 1$ used to over
ride some of the materials on your

static mesh. You'll use It to change

the first material to your

ScriptedTexture. With the
ScriptedTexture selected in the

Texture browser, click Use (or index

(0) of the SKins property. You can

now rebUild nnd test your new secu

rity camera in the game (see
FIGURE 8.68).

END TUTORIAL 8.13

FIGURE 8.68 The security camera working
in,game.

Although the effect is interesting, il could look a little more realistic. In TUTORIAL 8.14, you use
some of the skills you have acquired throughout this chapter to add video static and scanlines to

the ScriptedTexture.

TUTORIAL 8.14: Improving the Security Camera

1. Within the securityCamera texture

package is a texture named
sc reen I, which contams a stag·
nant texture sun liar to television

static. You'll use it to create more

realistic static by adding a

TexPanner to pan the texture CIt a
very high rate. Using the sKills you

have learned so far in this chapter,

create a new TexPanner and name

It static (see FIGURE 8.69).

2. In the Properties WIndow for the
TexPanner. change tne Ma ter lal

property to screen1, set PanFlate to

about 125. and change Yaw to

20000 (see FIGURE 8.70). These

settings cause your matenal to pan
In both the U and V directions.

-'j

FIGURE 8.69 The New Material ialog box for
the lexPanner.
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fIGURE 8.70 Properties of the static TexPanner,

3. For the scanllOes. you'll use the Line texture. which is also in the securityCamera paCK
age. Next, you scale the textu~e down SO that It repeats multiple times, and then pan it in
an upward direction. First, create a TexScaler mudlfier and set its name to scanlines.

4. Open the Properties window of this new TexScaler, change its Material property to the
Line texture. and chunge the VScale property to 0.01 (see FIGURE 8,71). Refer back to
the section" The TexScaler Modifier" earlier in this chapter if you need to.

5. Next, create another TexPanner so that you can move the scanlines vertically, The name of
this TexPanner should be set to lIlOliingScanlines,

8. Now open the new TexPanner's Properties window and ct1ange the Material property to
scanlines. Set the PanRate to 0.05. You won't see any difference, however, because the
movement is in U, not V. Therefore, change the Yaw value for PanOirect ion to 16383
(see FIGURE 8.72). Your scanlines now have an upward movement.



FIGURE 8.71 Properties of the scanllnes TexScaler.

fiGURE 8.72 Properties of the movingScanlines TexPnnner.

Using a ScrlptedTexture 313



8

314 Chapter 8 Creating Materials In Unreal

7. To combine the movmg scanlines and static. create a Combiner modifier with the name
scanStatic. Set Materiall 10 movingScanlines and Material2 to Stat ic (see
FIGURE 8.73).

I ~
[E]rr~~~I(;)1.__ ..

COJlto__CdoV"'__
.-.._ -"l__u...JoI.....

,...._.... I ..e-.~

rftP -.swc'

""'"F....
F
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J>Su;:......_-==~-=-':':'-:=-:--::-:-:-::-:::=-:::-:"'7:--- __--=.... 'l

FIGURE 8.73 Properties of the scanStatic Combiner.

8. Change the CombineOperation properly to CO_Multiply to combine your stalic and scan·

lines.

9. You'lI use another texture in your securityCamera package called Monitorfade to fade thl:l
outside rim of the screen. Again. you'll use a Combiner. Name this new Combiner
tadedSc:anStatic. Set Materiall to scanStatic (lnd Mi'lterial2 to MonitorFade. Change
the CombineOperation property to CO_Multiply. The scanline/static effect is now blurred

at the edges.

10. Now you need a final Combiner to bring the effect and ScriptedTexture together. Create a
Combiner and name it finalOutput. In its Properties window (see FIGURE 8.74), set
Materiall to cameraData, whiCh is your ScriptedTexture, and Material2 to
fadedScanStatic. Change the CombineOperation property to CO_Multiply. Finally, the
matenal is a little dark, so brighten it by setting Modu}ate4X to True. As mentioned preVI
ously. this setting makes your material four times brighter. FIGURE 8.75 shows the final
result.
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FIGURE 8.74 Properties of tile finalOlrtput Combiner.

FI GURE 8.75 Final effect of your secu rity camera,

END TUTORIAL 8.14
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Your security camera effect is finished! You can use this technique to create security cameras that

update in real-time in your single-player levels. Keep in mind, however, that Unreal's architecture

currently doesn't allow such an effect to update during a multiplayer game session.

Summary
This chapter has covered mJny different materials and explained how they are created. the prop

erties associated with them, and how they can be Llsed in your levels. You started by creating a

simple texture in Photoshop, and then imported it into UnrealEd ,

You also learned that shaders give you real-time cffect~ that combine materials together, and

modifiers can be used to alter your textures over time or statically. In addition, you saw how

Combiners Jre used to bring two textures together by using a mask, and environment maps can

make your materials seem to be reflecting their surroundings. You learned about the Final Blend

material and used a ScriptedTexture to add an advanced camera effect to your level.

By now, you should have a thorough understanding of the workflow associated with materials

and how the different types of material can be combined to create eJCtremely interesting effects.

Remember that material creation, although highly technical, can be an art form, allowing you to

create and express a variety of looks for your levels.



Chapter

Interactive Elements

Tn this chapler, you wjIJ t"xpand on the level you created in

Chapter 3, "Creating Your First Levd with UnrealEd;' by adding ele

ments thal players Can interact with, including elevators, jump pads,
and tdeponers. The chapter begins with a ~irnpJe ove!"View of each

element, and Ihen goes into more detail on the parameters for con

troUing them. NcJCt is a discussion of how to create a complex eleva
tor with custom doors, camera vibration upon activation, and a

texture that displays the elevator's current position. Finally. you lcarn

how to create jump pads and teleporters to send your players to new
locations on the map. These game clements are simpk to incorpor<lte
into your level and can add realism and excilement to your levels.

Movers
In Unreal, a Mover is simply a special type of stacie mcsb that's ani
mated in the level. They are used to create practical level elements,

such <IS moving doors <lnd elevators, Ijfts, or LIn)' $olid aspect of the

level that requires motion. A Mover's motion can be activated in a

variery o( different ways. Each Mover has eight individual keys, which

ue recordings of an object's position and rotation during different

pointi> of animation, For example. you can set the' nrst key of a door
Mover to have an initial position and rotation (or when it's closed.
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Then you can men add a ~cond key Ihal Slore.s me position and the relation (or lhe door when it's

open. """'hen Ihe Mover is activated, it moves to i15 OCXl key, which effeCllvely opens tne door.

By deflult, you can have only up to eight keys on any given Move.r. After ii's activaled, a Mover

smoolhly cycles through any keys 'hal "ave been recorded (or il amI doesn'l stop until it reac"es

Ihe lasl key. There are several ways 10 aCI ivate a Mover, depending on irs sellings. They can be aCli

valed by characters bumping inlo 'hem or by ShOOILng lhem wilh a weapon. More advanced

Movers can he activated through a scp,uale triggering syslem, which sends an event \0 the
engine's message quelle. Appendi~ A, "The Unreal&:! Manual," contains a comprehensive Itst or

aU Mover-triggering methods.

In this secrion, you see hOI" to implement
Movers in your hangar level (rom Chapler 3.
You begin with 3 simple door lhal leads into
th e con Irol roo m and Ihen lea rr. how 10 ma ke
the door functional so Ihal il opens when a

player bumps mlO II and closes shan Iy the re
after.

Creaiing the Fir8t DOOf'

NOTE
The Iutotials In this chapter assume Ih al you have
completed Chapter J ()f' at least have a baSIC under·

standing of UnrealEd workflow. Make sure you know
hO'W 10 place static meshes, including adjusllng lhelr
scale with Or awSCa1eJD.

9

Doors are one o( lhc mOSI common applicalinns of Movers. In faC1> many properties inherenl to
Movers are named 3fter door func(ions> ,~uch as StayOpenTlfle. One o( Ihe grealesl btnefi15 o(

their archilect Llre is that yo u can c.ceale many different kinds o( doors, such as swi nging or slid

ing doors, by using Ihe same se( o( al(tibutes. In the ne>., (tIll subsections, you eX'amine lhe
process of door crcalion one step at a lime. This prDCe.ss has been div)ded into lhrce m:l)or steps:
placil)g the door. adding i\l\jmalion to the door, and controlling Ihe door's l>eoilvior.

Placing the 000'

Now ;hal you knOIli whOle Movers are. you can learn how to ~(lualJy plac.e one in your level. In
TUTORIAL 9.1, you place an automalic door Ih.1t !e;l<:!S Into Ihe conlrol room, beginning with
gelling lhe lvlover in place.

TUTORIAl. 9,1 Placing the Door

LOpeI' lhe map you completed in Chapter 3, or open Tutor u19_0f _Start. ut2 (rom the
boox's CD.

2. Ope" Ihe Static Mesh browser. and open the XceptOneObIH.I./$x pac~age. In the Doors
group. select Aux2DoorH (see FIGURE 9.1).

3, Move lhe BUilder brush 10 the location of the door 11'10 lhe ~ntrol room. and click lhe Add
Mover Icon •. NOllce lhal ttle mesh is purple in 'he viewport 10 Indlcale Ihal It'S a Mover
reI her (han a standard static mesh. which IS leal.
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FIGU RE 9..1 Static Mesh browser with Door selected.

4. Move the door into a c;losed posi.

tion, and adjust the scale of lne
mesh accord:ngly. For this tutorial,
the following values are recom
mended: 0.9,0.45, and 1.85.

5. The texture applied to this static
mesh IS far too bright. so you need
to replace it with a darker UV2 tex
ture_ In the Properties window for
the Mover, go to the Display cate
gory and change the UV2Texture

property to Texture' XceptTwQ.

Flux2Stuff.FluxOoor8512·. The
result is shown in FIQURE 9.2.

END TUTORIAL 9.1

FIGURE 9.2 Mover in position.

You now have your Mover in place, and it's ready to be Jllimated.]n TUTORIAL 9.2, you see how

\0 make this Mover respond in your level.

Adding Animation to the Door

Movers are animated by using keys containing positional and rotationai values. When a Mover is

activated, it goes down the list of keys, smoothly adjusting its pusition and rotation until it

reaches the last key. In TUTORIAL 9.2, you place the required keys to make your door open and

close,
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TUTORIAL 9.2: Adding Animation to the Door- - .----------------------
1. In the (ollowing sleps. you'll set keys

to make your door move.

fortunately, the firSI key has alre<ldy
been seI for you, The position in

which you rnitially place a Mover
denotes its firsl key, called Key 0

(Base).

2. Right-clicl{ on Ihe ck>or, and choose

Mover:> Key 1 fTom Ihe conlexl

menu, The !'Iexl place you move the

door will be lis locallon (or the sec·

and key, ~emember th.'lt Ihese keys

store POSlt1on and rotation. FIGURE 9.3 Mover in open posltloo.

9

3. In the 3D viewpo<l, move the door upward until it's almost out of sight. as showr. in
FIGURE 9.3. This will be the open positiOIi.

4. Right-click on the door. and choose Mover> Key 0 (Base), Notice lhat the door jumps back
to Its ongmal pasmon. This meanS the anImallon data has been stored oarreelly. and Ihe

dOOf is almost ready for use.

END TUTORIAL 9.2

Controlling the Door's Behavior

'(our Mover is \f\ piau, and jt's alma,l ready to lest in the level. Before you do that, however, you need

to se-e some properties you can sel for the Movt'r 10 mouo) ils behavior when animated. In

TUTORIAL 9.3, you're going (0 sel ,he Mover upso thai it opens when bumped bY!l player, remains

open for.\ while, and then doses, You then look a' a few other important propertie-s (or con/rolli ng a
Mover's behavior, For a fu1IliSl and explanalion of these properties., be sur~ to chock Appendix A.

TUTORIAL 9.3: Controlling Your Animation

1. Double-cllck the door 10 open the Mover Proper lies Window, and open the ObjeGt category.

2. ClICk ,he Ir'ILtialStllte property. and set it to B!J~pOpeoTillled (see FIGURE 9.4}. This Slate

causes the dOOl' to OpM when Irs bumped. stay open for a penod of hme. and then close.

3. Open the Mover tab. Scroll down until you see the Nu~f<.eys property. Because you have

sel up two keys. Ihe value should be set to 2 (see FIGURE 9.5).

4. Below NumKeys is the StayOpe1\1 Hie property. This properly conlrols how long (IJ\ seconds)
ltle OMI stays open or. 10 be more specific, how long Ihe Mover sits al its lasl keyframe.

Se' Ihis propeny 10 a value of 2, which causes the door to stay open for \Wo seconds

belore It closes.
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FIGURE 9.4 InltialState property
set to BumpOpenTimed.

FIGURE 9.5 NumKeys property set to 2.

5. Scroll up until you find the DelayTime property. Set it to 0, if it Isn't already. This setting

means the door opens as soon as it's bumped.

6. Finally, make sure KeyNum is set to O. This property controls the key thaI the Mover begins
with.

7. Rebuild for good measure, and test your level. Your door should open when yOll bump Into
it, and stay open for two seconds.

8. Save your map.

END TUTORIAL 9.3

Using Encroachment

Before you go any further, take a look at some other ways rou can conlrol your door's behavior.

One of the most import;l111 factors of 3. Mover's functionality is what it does when a player gets

in its way when it doses or returns to its first key. You Ciln set a Mover to stop when a player gets
in its path, have the Mover go back 10 its open po~ilion. or just simpl~' crush the player. You con
trol this behavior with the MoverEncroachType pIOpecly. available in the Mover Properties win

dow under the Mover tab. The following is a list of the settings available for this property:

~ ME_StopWhenEncroach-When an Actor gets in the way. the Mover stops dead in its tracks.

~ ME_ReturnWhenEncroach-The Mover retreats to ilS previous positioll when it hits an Actor.
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~ ME_Cr'UshWtlenEncroach-This setting C<luses the Mover to kill any Actor in its path.

~ ME_IgnoreWhenEncroach-The Mover goes right through the Actor, but still causes damage
to the Actor. You can control the amount of damage with the EncroachDamage property.

Feel frce to experiment with these settings, and see which beh,wior works best for you. The next

section introduces you to triggers and explains how to use them to add new dimensions to Mover
functiona lity.

Introduction to Triggers
Triggers are Actors that can be placed anywhere in your level. When they are activated, they initi

ate a uniquely named event. Any Actor that has been set to respond to tbat trigger then performs
a function of its own. Many different types of triggers arc available in UnrealEd. This chapter
includes tUlOrials on how to usc a variety of triggers in your levels, In this section, you see how to
add a MessageTrigger to your level to make a message appear onscreen.

You can activate a trigger in different ways, depending on what kind of trigger you're using, Some
are activated by the player via the UseTngger property, somt' arc activated by touching or shoot·
ing, and some are activated by scripting, which is discussed later in "Complex Elevator I: The
ScriptedTrigger." \Vhen the trigger is activated, it creates an cwnt, The user specifies the name of
this evenl. If any other Actors have their Tag property set to the same name as the event, those
Actors perform a certain function, called the Trigger function. The following section explains
how this work~.

Creating a MessageTrlgger

In TUTORIAL 9,4, you create a MessageTrigger that flashes text onscreen when the door opens.
Adding this trigger is easy because Movers trigger an event when they reach their zenith, or last
keyframe. AU yOLl need to do is create a MessageTrigger Actor and make it respond to the event

sent by the Mover.

TUTORIAL 9.4: Establishing a MessageTrigger

9
1. Open the Actor Class browser by clicking Its icon • on the toolbar,

2. Scroll down to Triggers. click the + sign next to it to expand it, and select MessageTrigger
(see FIGURE 9.6).

3. Right·click near the door, and choose
Add Message Trigger Here from the
context menu.

NOTE
The placement of this tligger is irrele~ar\t because the
player doesn't interact with it directly.



4. Double-cJick. the new lIigger to open

ItS Properties window. and scroll

down to the MessageTngger tao.

You'll see three properties: The

Jolessage property conlrols the meso
sage thal's displayed. I.lessage type

controls how the message IS dis

played. (TABLE 9.1 lists the POSSI'

ble l.Iessagetypes.) The Teall
property determines which team can

see tile message In team·based

gametypes.

6. For the l.lessage property. enter The

Control Roo- Door Has Been

Opened! You can add another meso

sage. if you like. The tex.t In this

field is what appears onscreen when

the door is opened.

TABLE 9.1 Messagetype

lAessagetype Description
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FIGURE 9.6 Mess8geTrigger selected In the Actor
Class browser.

EMf_Default This sening shows the message in lhe default rOM in the lower-left cor

ner or lhe screen. The message appears In a slml~ar manner to player

Join messages.

EMT_Deathl.lessage

HolT_Say

The message appears as large blue lext in 1he middle of the screen TO

denOle a en I ic.:ll event. such as 8 player going on a killing spree. Th'S

IS l.I'1e default settll'g.

The message appears as leXl in the console bar.

The message IS displayea as thOugh you had said It, ellen if some

other player in a multlplayer game triggered it,

Same as EMT_Say. ex.cept that the result appears as though the

message had been sent usIng TeaIllS ay',

8, Make sure I.lessagetype Is set to f!.ll'_CriticalEvent, the default, so that the message

19 dIsplayed as an In-game f)<)t/(/catlon.

7, II you wele to test the tflgger now. you still wouldn't get any response You have e.stab

IIshed l.I'1e MessageTrigger, but you haven't yet set up the system to activate it. You need

to set the MessageTligger's Tag property to the same flame as the event generated by the

Mover. Exl)anO the MessageTngger's Event tab, and set the Tag property to OoorOpened
(see FIGURE 9.7).
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8. You're almost there. Go back to the
Mover Properties window by double
clicking the door. Under the
MoverEvents tab, next to the
OpenedEvent property, type
DoorOpened.

TIle name o( the event generated
when the door opens is now called
DoorOpened. By setting the
MessageTrigger's 1 ag to the same
name. the tngger "listens" for the

DoorOpened event to be launched.
When It IS. the MessageTrigger dis

plays its message. as shown in
FIGURE 9.8.

9. Save your map.
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FIGURE 9.7 The Tag property of the
MessageTrigger.

FIGURE 9.8 The MessageTrigger in operation.

END TUTORIAL 9.4
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Launch the game. and test out your new door. V\'hen you open the door, the me~sage you entered

is displayed onsereen. MessageTriggers are a great way to keep players informed about events

going on in the game and an excellent way to learn how triggers work in gennal.

Elevators
In essence, an elevalor functions exactly
like an automated door. It has a start posi

tion, usually the bottommost floor, and an

end position, the extent of the elevator. In

this section, you use a Mover to place an
elevator in your leveL You'll begin with a

simple eleva. tor controlled by the

UseTrigger function. Later. you'll change it

to a ScripredTrigger to accommodate a

wider range of functionality. including
camera shake, automated doors, and ani

mated textures. Vou']) also create a progress

har that allows players to see the elevator's
progress while it's in use. FIGURE 9.9 FIGURE 9.9 TIle final working elevator.

shows what the final elevator looks like.

A SImple Elevator: UseT'rlgger

In this section. you create a simple elevator by using the lJseTrigger .'\ctor. rnstead of bumping

into the Mover, as in the door example. you set up a s~'slem by which players can activate !he ele
vator with a UseTrigger. This means the elevator is set into motion in the game when a player

stands within the UseTrigger's radius and presses the Usc key (E. by default). III the ne>..1. two sec
tions. you place the necessary static meshes and a Mow'r for your simple elevator and establish
the U3cTriggCl's functionality. These tutorials will further you r knowledge of how events arc gen
erated and how they can be used to controltne behavior o( m;Jny ilspe<..ts of your levels.

Placing the Elevator Geometry

In TUTORIAL 9.5. you place your static meshes and the Mover reqll!red for your elevator. This
stage requires bringing some new static meshes into your level 2nd duplicilting a few that ilre

already in the control room. After evcr~hing is in place, you (an set up your UseTrigger so that
players ca.n have more direct control over the elevatOr's behavior.
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TUTORIAL 9.5: Building the Elevator

1. Open your map from TUTORIAL

9.4. or open Tutorial.9_0S_

Start .ut2.

2. In the Static Mesh browser. ope/\ the
newHangar2 .usx package, Select

elevatorFrame from the PackageQ

group, aod place il in the hangar, It
should straddle lhe Indenl800n in

the wall and align wllh the floor. Use
FIGURE 9.10 if you need help,

3. Al the top of the frame, you need 10

place some protective railings,

Duplicate a reiling from Ihe control

room, scale II accordingly, and place
il alOl\g lhe top of (he frame. Repeal

(his slep two more times to place
one rail on each of the frame's three

sides (see FIGURE 9.11).

4. Now you need 10 place lhe elevatOl' 10

~erve as Ihe Mover, ln the Static
Mesh bo'CMlser, select elevatorlJrt from

the Elevator group, Make sure Ihe

Builder brush is near the small Inden-
tation in the floor of \he haf\gar. Click

the Add Mo'/e' bunon In \he toolbox,

Align. the elevalor With all SIdes of the

IndentatIOn, Rotale Ihe elevator so

that in the Top Viewport, ItS coolml

panel is in the tower·IeN corner, Use

FIGURE 9.12 as a gUide.

S. Place some lights in al'od ar()lJoo

the eleva lor sha h vnlil you're S.2.t.is·

lied wllh toe result- Refer to

FIGURE 9.13. if needed.

8, The original placerneJ'\\ of (he

elevatorl.lft. aulomatlcally sel the (HSt

I<ey, so y()lJ need to se\ the second,

Rlghl~hck on the elevatc{UI'l., choose

Mover> Key 1. and move the
e(evatorlll't up in the Z·axls so that

the tOp surface ahgns vAlh the botlom
of the hall\vay (see FIGURE 9.14).

FIGURE 9.10 Use elevatorFrame as a protective
barrier for the elevator,

FIGURE 9.11 Three railings placed on lOP of Ule
barrier,

FIGURE 9.12 Top view of the elevalorlift Mover.



FIGURE 9.13 3D View of the elevator shaft.
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FIGURE 9.14 3D View of the
elevator at the top.

7. Set the key back to Key 0 (Base). The elevator should jump back dowo to the bollom of
the elevator shaft.

8. Save your work.

END TUTORIAL 9.5

Implementing the UseTrigger

The elevator has been placed in your level. so now you can use some of the techniques yOlllearned
in the previous section to make it functional. This time, however, you expand on what you already

know by making the elevator respond 10 a player's direct command. To do this. yOll implement a

UseTrigger, which allows a player to make the elevator move by pressing the Use key rather than

simply bumping into it.

TUTORIAL 9.6: Setting Up the UseTrigger

1.. Because a player has to be WIthin a certain distance from the UseTrigger to actually use it.
th(,l placement o( this UseTrigger is an important (actor. Also. because the trigger doesn't
(ollow ihe elevator. you need to place two UseTriggers: one at the bottom of the 11ft's range
and the other at the top. In the Actor Class browser. expand friggers. and select
UseTrigger. as shown in FIGURE 9.15.

2. Right-click in your 3D viewport 00 the elevator's control panel, and choose Place UseTrigger
Her~_ Position the tflgger so that it's fight In front of the elevator's control panel (see
FIGURE 9.16).

3. DOUble-click the tngger to open Its Properties Window. In the Advanced tab, set bHidden to
False so that you can see the trigger while you're in the game, which IS helpful durmg the
creation process. After everything is finalized. you can SWitch this property back to True.



FIGURE 9.15 UseTrigge r selected in the Actor
Class browser.
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FIG URE 9.1.6 Position the UseTrigger In front of
the elevator's contral panel.
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4. The UseTrigger generates an event

whenever a player presses the Use
key while within a certain radius of
the trigger. This awon perfectly SIm-

ulates a player pUShIng a bunon. In
lhe UseTrfgger Properlles window, go

to the Events lab. Next to me Event
property. lype frontLHt.

5. Double-click Ihe elevator to access
the Mover Properties window. In the

Events lab. set the Tag property to
(rontLlft as well to make the

Mover respond whenel./er the

trontllft event IS generated.

8. In the Mover Properties window. go
to the ObJeCI lab. Set the
In.!.tialState f)roperty to
TnggerToggle. Next, in the Mover

tab. set MoveT ime to 5. With this

selling. the eleVi'llor takes (ive sec·

OMS to move from lts flrst to its
last key.

7. Right<.lick the Mover. and choose

Mover> Key 1. The elevator snaps

to the top of Ihe shaft. In the 3D

I./iew. select the UseTrigger at me

base of tne eleVi'ltor Shaft. and
duplicate It by pressing Ctrl+W.

Move the duplicated ,rigger up In the

2·uis so \ha, il'S in fron' of the can·
\rOI panel when the elevator 15 at
the top of the shaft. as shown in

FIGURE 9.17.

8. salle your work.

9
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FI GURE 9.17 A second UseTrigger at the top of tile shaft.

END TUTORIAL 9.6

Your elevator is now fully functional, so you can rebuild and test your level. When you walk up

to the elevator, press the Use key (the Ekey, by default). The elevator moves to the top of the shaft

and waits for you to retrigger it.

Another Mover property can help control your elevator's motion. Under the Mover tab in the

Mover Properties window is the MoverGlideType property, which controls how the Mover ani

mates from its first key to its last. By default, it's set La MV_GlideByTime. This setting causes the

Mover to accelerate as it leaves its first key and decelerate as it approaches its last. If you set this

property to MV_MoveByTime, the Mover animates at a constant rate. For a full list of all the prop
cuies dvailablc (01 Move-IS, please see Appendix A,

Complex Elevator Overview

Jn this section and its subsequent tutorials, yOll enhJIlce your simple elevator to add a series of

advanced functionaUty. You'll begin by adding a ScriptedTrigger to the e1cvatOl's control panel

that acts as a router, sending out several different events ,0 other triggen. The final result will be

an elevator that behaves according to the following list of features:

~ Character activates the elevator by activating a control panel located on the lift mechanism.

~ After a one-second pause, the player's view shakes violently as the elevator begins to move.

~ An automated door at the top of the elevator opens only when the lift mechanism is at

the top of the elevator shaft.
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• There's a second control panel at the /0 p o( the elevalor shafl so /h~, the player can call

the elevator,

• Both control panels have an aClivation bUllon, \Vhile the elevator is in motion, the acllva

tion buttons on each con(rol panel change (rom red 10 green, The buttons shift back to
red when the elevator slaps moving,

• Each co I\Irol panel exhibits a progress bar Ihal constantly displays the elevator's curren t

position ill (hc elevator shafl,

All this functionalily is established through the l1.<;e ()( a Sc.riptedTrigger, which send" event" out
to severa) olher triggc rs.

Complex Elevator I: The ScriptedTrlgger

Tn lhis scoion, you expand on lhe simple eleva lor crl~aled in Ihe previous section. by adding a

ScripledTrigger to your eleva lor's conlrol palleL This <rigger m,)l<e~ your system more powerful

by allowing you to generate mu hiple even Is from one tngger. ScripledTriggers can generale events

based on user-den ned eond il ions, cycle Ih rough loops, and /Tluch more, For this chapter's exam
pie, you'll rework your (riggen, so tnat 1he UseTrigga ~ends an e'Jen\ (0 the Sc.riptedTrig,ger, wh..ich

then move~ the elev3lor.

"''hen using a SaipledTrigger, you rarely use Ihe properlies ill the Evenls tab. Instead, you set

mosl of your (unclionaliq' in (he AISuipt lab, It.'here you'll find the Act lons property, You can

add as many AClion~ wilhin lhis property as you lil<c, They are stored in an array and c:ompleted
in a linear (ash ion (rom lap to bot(om, Some Acrions halt the proc~ until certain condition." are

mel or even skip other AClions, In this way, you can sUlek as many Actions as you like into the

I rigger,

TUTORIAL 9.7: Implementing a ScriptedTrigger
-----------------

9

1, Open the Actor Ctass browser, and

expand Actor > Keypoint > AIScript >

Scripted Sequence. Click

ScriptedTrigger,

2. Rlghl-cllcl< anywhere In your 3D view

port. aM choose Add Scr\ptedTrigger

Here. The tngger's placement is

irrelevant w just place il some
where that 'IOU can easily access
(see FIGURE 9.18).

FIGURE 9.18 ScrlptedTrigger in place.



3. Each Action added tnto the

ScnptedTrigger has different proper

ties. Open the AIScript tab, click the

Actions tab, and click the Add but
ton to add an Action. This allows a
new Action to take place but doesn't
designate what type of Action it IS.

Your new Action is indexed with a
lero (SEE FIQURE 9.19)_

4. Next to the New tab, open the drop

down list and select Action_WAlT·

FOREVENT. Then click the New

button. This sets Action [01 to
Action_WAITFOREVENT (see
FIGURE 9.20). The WAITFOREVENT

Action listens for a specific event,
and then responds when that event

is genterated.

5. The WAITFOREVf.NT Action has a

unique property called

ExternalEvent. You can see it
listed underneath the Action in the

AIScript tab. Click the word None

next to ExternillEvent, and enter
frontLift (see FIGURE 9.21).

ThIS means the trigger won't

progress to the next Action until the

f ron t L if t event is generated,

6. Now th(lt you have told the trigger

when to progress, you need to tell it
what lo do. Click the Actions head

ing under the AIScript tab, and clit.k
the New button again. You gel a new

Action indexed with a [lJ.

7. USing the drop-down list next to the
New entry in Action [1), set the

Action to Action_TRIGGEAEVENT

(see FIGURE 9.22), and click the

New bUlton. This Action generates

an event when the ScripledTrigger
reaches it. Remember that the
ScriptedTrigger completes its

Actions from lop to bottom.
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FIGURE 9.19 A new Action tor the
ScriptedTrigger.
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FIGURE 9.20 The WAlTFOREVENT Action ot the
ScriptedTrigger.
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8. Your UseTriggers are already gener
ating the frontLift event. When
Ine ScriptedTrigger •hears - that
event. it then generates the event
that sets the elevator in motion.
Because the Mover is set to already
respond to frontLift. the
ScdptedTrigger is currently useless,
Open the Properties window tor the
Mover, go to the Events tab. and set
its Tag property to
f ron tLl ftMover. an event that
doesn't yet eXIst. This causes the
Mover to stop responding to the
UseTrigger$ and allows you to insert
the ScriptedTrigger into the system.

9. Go back to the Properties window
for the ScnptedTrigger. and reopen
the AIScript tab. Under the Actions
tab. go to Action [1), and expand the
Action_TRIGGEREVENT tab under
neath the [1) index number. Set the
Even t property to front Li ftMove r.
as shown in FIGURE 9.23.

10. If you were to test the
ScriptedTrigger now. you would have
a prOblem. nemember that the
Actions in the ScriptedTrigger move
from top to bottom. Currently, the
trigger receives the frontLift
event. $ends out the
frontli ftMover event, and then
stops. This means the elevator will
work once and never again because
the frontli f tMover event is sent
only one time. To fix this problem,
Cldd a new Action, select
Acrion_GOTOACTION. and click the
New button.
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FIGURE 9.21 ExternalEvent property of the
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11. Expand tile propen,es of your new

AC\lon. and make Sure
Ac t.l.onNUlllber is set (0 O. wt\IC/'l IS

the default. This causes the

SCfiptedTrigger to jump back to the
(Irst Action after It sends out the

f r(ln tll f tt.!over event so thut It

goes tlae\< (0 listening (or the
,r::lnUift event. This setting
allows the SCnptedTrigger to be

used repeatedly.

12. Save your work.

FIGURE 9.23 Event property ollhe
Scr!ptedTrlgger set to frOML if rMover.

END TUTORIAL 9.7

You have now rl~ced Lhe Sc.ripledTrigger into rour eleva lor syslcm. To recap. the Melh.od 1 dia·
gram in FIGURE 9.24 shows hO\\l lhe original system flowed, whC:JJ it was JUSt the UseTrlggers

and the Mover. The Method 2 diagram shows the n.-:w flow using the ScriptooTriggn

loIETl100 1

.....".,.

-1"'",ntLArTAG
'----

EVE"r I

WEll100 1

- lI.'avgr

1"""'tUllMouG( rAG

EV"N1 I
FIGURE 9.24 this diagram demonstrates the flow of the ScriptedTrigger.

FIGURE 9.24 shows how yO\) Gre3red lhe ScripledTrigger and ulen established a new Action that

told the [rigger to wail for the frontLift event. You lhen broke the connection between the

UscTrig,gers jnd the Mover by swing the Mover's Tag properly to fron t LiftMover. YOll {hen

placed ~ new Ac.tion th~, sent Oul Ihe t ront Li ftl.lOver event, causing the elevator 10 move.
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It might look like you broke your system just 10 put it back together. However, using a

ScriptedTrigger enables you to launch several different Actions simultaneously. In TUTORIA L 9.8,

you add Lhe ViewShaker, which derives its behavior from Lhe ScriptedTrigger. Later, yOll use It to

drive animated textures \vith the help of MaterialTriggers.

Complex Elevator II: Adding a ViewShaker

In I!"US section, you add a ViewShaker trigger to your elevator. When a player activates the elevator.

there's a short pause, then the view shakes !en and right, as though the .:levator jerked suddenly. Tn
TUTORIAL 9.8, you see how to use the VicwShaker trigger and insert actions in the ScriptedTrigger.

FIGURE 9.25 OffsetMag property of the
ViewShaker.

FIGURE 9.26 The ViewShaker trigger
at the top of the elevator shaft.

TUTORIAL 9.8: Adding a ViewShaker

1. In the Actor Class browser. expand Actor

> Triggers. and click ViewShaker.

2. Rtght-eIiCk near the elevator, and choose
Add ViewShaker Here (rom the context

menu. The placement of this trigger is
important, as "It has a radius of effect.
Only players within the radius can see

their views shake. Place it near the

UseTrigger.

3. Double-click the ViewShaker to open its

Properties window. In the ViewShaker

tab. set the ShakeAadlus property to

128.

4. You use three major properties to make
the camera shake: Of (se tMag.

OffsetAatc, andOftsetTlme.
OffsetMag determInes the amount of
shake in the three a)oal directions. Set all

three values (X. Y. and Z) of OtfsetMag

to 3. as shown jn FIGURE 9.25.

5. OffsetAate controls how fast the view

9
will shake, Set each aXial value to 100,

6. OffsetTlme determines how long (set In

hundredths of a second) the view

shakes. Set thiS value to 15.

7. You have now established the
VlewShaker's functionality. but you
haven', determined when it functions.

You stili need to tell It which event brings
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it to life. In the ViewShaker Properties

window. open the Events tab and set

the Tag property to liftShaker.

8. Duplicate the ViewShaker trigger, and

place the duplicate near the top of the
elevator shaft close to the second
UseTrigger (see FIGURE 9.26).

9. You need the ScriptedTrigger to send
out a liftShaker event to the

ViewShaker. To do thiS, dOUble-click the
ScriptedTrigger, and open the AIScr;pt

tab in the Properties window. Expand

the Actions liSt.

10. Select Action 11], whic/'l should be
Action_TRIGGEREVENT _Click the Insert
button next to it to insert a new Action

directly above Action (1).

11. Set the new Action to another
Action_TRIGGEREVENT, and click the

New button. Set the event of thIs new

Action to liftShaker (see FIGURE
9.27). The ScriptedTrigger is now send

ing out two separate events: one to

shake the view and another to move

the lift.

12. Next, you'll set up a delay so that

when you push the button on the ele·
vator's control panel, there's a slight

pause before the elevator actually

moves. Using the skills you just

learned. Insert a new Action before

Action (1). Set this new Action to
ACtlOI1_WAlTFORTlMER, click New, and
set the PauseTlme property to 1 (see

FIGURE 9.28). This causes the ele

vator to pause for one second before
shaking and rising.

13. Test your level, and save your work.

END TUTORIAL 9,8

NOTE
This radius is measured in Unreal units.
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FIGURE 9.27 TRIGGEREVENT action wah the
event set to liftShaker.
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FIGURE 9.28 WAITFOFlTIMER Action with the
Pause Time property set to L
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You have established a solid system that enables you to activate the elevator, wait a moment, see

the view shake, and then have the elevator rise. The elevator also waits at the top for a player to

activate it again. In the next section, you add a new door to the top of the elevator shaft and a trig

ger to set it in motion when the elevator reaches the top.

Complex Elevator III: Elevator Door

In TUTORIAL 9.S, you place an automated door at the top of (he elevator shaft and set it up so

that it opens only when the elevator is on the top floor. This automated door adds a bit more real

ism to your level because it appears to be a safety feature. This addition also serves as a Jesson to

demonstrate how to activate multiple Movers from J single ScriptedTrigger and how to adjust the

timing of that activation.

TUTORIAL 9.9: Setting up the Elevator Door

1. For continuity, use the same kind of door that you used earlier In the control room's
entrance. The easiest method 1$ to simply duplicate that door, and move the duplicate to
the opening at the top of the elevator shaft (see FIGURE 9.29). Adjust the DrawScale
setting accordingly,

FIGURE 9.29 The elevator door moved and scaled into position,

2. Make sure that Key 0 IS the door's closed POSition Clnd Key 1 contains the door's op(:!n
position. The door will be sliding up, just like the control room door.

3. Double·dlck the elevator door. In the Properties window, open the Object tab. and set the
lnit ialState property to TriggerToggle. As with the elevator, this setting enables you to
trigger the door's up and down movement.
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4. In the Events tab, set the Tag
property to IiftDoor_

S. Now you can use the events the ele·
vator generates to open and close
the door. Open the Properties win·
dow for the elevator. In the
MoverEvents tab. set both the
Closing Event and OpenedEve'lt
properties to liHOoor (see
FIQURE 9.30). This makes the ele·
vator lift trigger the door once when
it reaches the top of the shaft and
again as it start~ to go back down.

8. Save your map.
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FIGURE 9.30 The elevator door's Tag property is
set to 11 ftDoor.

END TUTORIAL 9.9

Complex Elevator IV; Second Control Panel

YOll have the door in place and have established its animation, but there's still a problem: What

if you're in the hallway, and the elevator is at the bOltom? The door would be closed, and you'd

have no way to call the elevator up! In TUTORIAL 9.10, yOli place a trigger and control panel

into the hallway so that players can access the lift from the top or bottom.

TUTORIAL 9.10: Placing the New Elevator Control Panel

1. In the Static Mesh browser, open the Elevator group, and select the elevatorControl static
mesh.

2. Navigate to the top of the elevator shaft, and place the mesh near the door. on the
wall opposite the window, as shown In FIGURE 9.31. Don't worry about the lack of
texture.

3. Duplicate one of the UseTnggers that have been placed in the level, and poSition the
duplicate in front of the new control panel (see FIGURE 9.32). This UseTrlgger provides
a way to call the elevator if the door is currenlly closed,

4. Save your work. and test your level.
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FIGURE 9.31 E[evator control placed on
the wall opposite the window.

END TUTORIAL 9.10

FIGURE 9.32 UseTrigger placed in front of
the control panel.
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You now have a complete elevator system that allows you to call (he elevator from the upper hall

way or the floor of the hangar, You also have a door in the hallway to keep players from acciden

tally stepping out and falling to their doom. In the next section, you add a MaterialTrigger and

set up some animated textures.

Complex Elevator V: MaterlalTrlgger

In this section, you see- how a MaterialTrigger can be used to create animated textures. A mater

ial is a combination of a texture and a shader, which controls how light reacts on the texture's sur

face. First, you set up a texlUre for a button on the elevator's control panels. This button will be

red when the lift is stationary and turn green while the lift is in motion. Next, you create a

progrt'ss bar texture that displays the elevator's current location in the elevator shaft. Both sys

t<'JnS take advantage of the MaterialTrjgger and the MaterialSwltch, a type of material available in

Unreal. For mOfe information on materials, refer back to Chapter R. "Creating Materials in

Unreal."

In TUTORIAL 9.11, you set up the animated texture for the elevator control panel butlon, As

mentioned previously, you want the button to be red when the elevator is not moving and green

while the elevator is in motion.

TUTORIAL 9.11: Esta blishi ng the Mate rialTr igger and Mater ialSwitctl

1. First you create the Mnteria[Trigger. In the Actor Class browser, expand Actor> Triggers.
and click MaterialTngger. This trigger'S position is Irrelevant, so place it somewhere that
you can access easily.

2. Open the Texture browser, open the Chapter9. utx package, and select the MatTrigger
group. This group has three textures; Green, Red, and LiftProgressTex. You'll use them
shortly. For now. choose File> New from the Texture browser's menu to open tlie New
Material dialog box.
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3. Change the package 10 Chapter9, which saves your new matenal 1n10 lhe Chapter9 pack·
age. Set the Group enlry to MatTtlgger, and change the Name entry to StartStop, Finally,
change the Mate rlalCla 55 10 Ma lerlal$wllch.

4. Click New. and the oroperhes for Ihe newly created matenal appear If) a new wmdow (see
FIGURE 9.33}.

1_
FIGURE 9.33 The MaterlalSwitch Properties window for the SrartSrop material.

6. 'This matenal allows you to store oUle, materials mIlCh like Ih€ SCripledTrigger stores
actions. Because yO\) want to sWITch belWeen a start matenal aOO a stop materiaL se~ecl

the Matenals entry. aOO click the Add bunon twice. FIGURE 9.34 shows Ihe two new

matenals edded,

B. The nrst 5101, entry 10). will be the Red texture, Bad in the Texture browser. select the Red
texture. Return 10 (he MalerialSwlIch Properties Window. click entry (0). and ehek the Use
button (see FIGURE 9.35).

339
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FIGURE 9.34 Two materials added to the Macerials property.

FIGURE 9.35 Entry (OJ of the Materials property set \0 use the Red texture.

7. Repeat the process for entry (lJ. using the Green texture instead of Red (see
FIGURE 9.36).
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FIGURE 9,36 Entry [1) of the Materials property set to use the Green texture.

8. Save your work.

END TUTORIAL 9.11

In TUTORIAL 9.12, you set up the control system that drives your MaterialSwitch. To do this.

you place a series of events into your MaterialTrigger, and then slightly modify some current set·

tings for your ScriptedTrigger and lift Mover.

TUTORIAL 9.12: Controlling the MaterialSwitch
=-------------------------

1. Double-click your MatenalTrigger to Ollen Its Properties window. Under the MaterialTrigger
tab, click MaterialsToTrigger, and then click the Add button.

2. In the Material Editor, select the StartStop material you m8de in TUTORIAL 9.11 (see
FIGURE 9.37).

3. Back in the MaterialTrigger Properties window, click entry tOI under MatenalsToTrigger, and
click the Use button,

4. Now you need to control when the switch takes plar.e. First. go to the Events tab, and set
the Tag property to ol10ffTrigger (see FIGURE 9.38). You haven't created this event
yet, but YOU'll remedy that in the next step.
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5. Open the ScriptedTrigger's Properties
window. Expand the AIScript tab, and
select Action entry [11, It should cur·
rently be the VlAITFORTlMER Action,
Insert a new Action_TAIGGEREvENT,

which becomes entry (11. pushing
WAITFORTIMER to entry (2J (see
FIGURE 9.39).

8. Set the Event property for the new
TRIGGEREVENTto onOffTrigger
(see FIGURE 9.40). ThiS causes
the material to be triggered as soon
as a player actIvates the UseTrigger.
but there's a problem. Currently, the
button changes to green and stays
green. You need to create another
event that triggers the material a
second time to switch it back to red.

FIGURE 9.37 Select the StarrSfop material.
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FIGURE 9.38 Properties of the
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FIGURE 9.39 Action list for the ScriptedTrigger.

7. Opell the lift Mover's properties. Open the MoverEvents tab, and set ClosedEvent to
onOffTr igger. This setting triggers the material to switch when the elevator reaches the
bol1om. but you also need it to switch when it reaches the top_ You can't switch the
OpenedEvent because it's currently being used to open the door.



8. Instead of changing the lift's

OpenedEvent, double-click the eleva
tor door Mover, In Its Properties win·

dow, expand the MoverEvents tab, if

it isn't open already. Notice the

Open ingEvent property, which gen
erates an event as the door is open·

ing. Logically, that means it

generates an event at the same
time as the lift Mover's

OpenedEvent. Set the elevator door
Mover's OpeningEvent pro~rty to

onOffTrigger,

9. Open the Texture browser, and

select the StartStop material.
Switch to the Static Mesh browser,

and locate the elevatorControl

mesh. Select Material [1], Md click
the Use button (see FIGURE 9.41).
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...-

FIGURE 9.40 TRIGGEAEVENT Action with the
Event property set to onOffTrigger.

FIGURE 9.41 StartStop material used on ttle elevatorControl static mesh.

10. Locate the elevatorLift mesh, select Material (21, and click the Use button (see

FIGURE 9.42).
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FIGURE 9.42 Another StarrStop material used on the elevatorLift static mesh.

11. Save your work!

END TUTORIAL 9.12

You have just completed the burton's texture as well as the system that allows it to switch from

green to red. You can now rebuild your level and play-test the map. Notice that the button turns

green while the elevator is in motion and red when the elevator stops. In TUTORIAL 9.13, you

setup a progress bar texture that displays the current location of the elevator lift as it moves along

the elev~(or shaft.

The progress bar requires creating another MaterialTrigger. This time, however, you usc a new

kind of material: a TexPannerTriggered. This material pans, or moves, in a certain direction and

a certain distance each time it's triggered. The texture itself is a black bar on a white field, which

you pan in a vertical direction. You then synchronize the panning action to the elevator's

motion.
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TUTORIAL 9.13: The Progress Bar

1. In the Texture browser, create a new material with the following settings:

Package: Chapter9

Group: MatTngger

Name: progressBar

Ma terialC lass: MalerialSwltch

2. When the MaterialSwitch Properties window opens. expand the Materials tab (see
FIGURE 9.43). Click the Add button to create a new material. Next to the New entry,
change the material type to TexPannerTr iggered, and click New.

FIGURE 9.43 TexPannerTrlggered created as the first material for the progressBar material.

3. A new TexPannerTriggered material has been created. To adjust its properties, select
the LiftProgressTex texture from the Texture browser. Select the Matenals entry in the
TexPannerTriggered properties list. and click the Use button (see FIGURE 9.44).

4. The texture in the Properties window has changed, but it's not moving. Expand the
PanDirection property. and set Yaw to 16000 (see FIGURE 9.45). This number controls
the direction of the pan but also influences the pan's speed.
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FIGURE 9.46 PanAate set to 0.2.

6. The StopAfterPerLod controls how many complete cycles will be performed. A
StopAfterPer Lad of 1 results in a full cycle of your texture, meaning your progress bar
will wrap back around to the bottom of the display. You need \0 stop the texture panning
before it wraps around. Therefore, the StopAf t erPer iod needs a value slightly less
than 1. Enter a value of 0.93 (see FIGURE 9.47).

FIQURE 9.47 StopAfterPeriod set to 0.93.



348 Chapter 9 Interactive Elements

7. Set the AeTrlggerAction property to RTA_Reverse (see FIGURE 9.48). This setting
causes the texture to move upward the first time it's triggered, down the second time, up
the third. and so on. Because your elevator 11ft begins on the hangar floor. the texture now
moves in tandem with the lift.

FHo\..t .....
~a~J

P• .oM(IDI ~.........~
-_ 0
...... 0

"m,
+'riI Q.:'
T~ TOl_~tl

r 'Ut!F'wj 1""..

FIGURE 9.48 ReTl'lggerActlon changed to RTA_Reverse.
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8. Now you need 10 sel up the events
to handle when the material's ani

matIOn 45 triggered. Duplicate the
eXlstmg Mi'ltenalTrigger, and ooen
its properties. Change its
Ma ter ialsToTr igger property to
progressBar (see FIGURE 9.49).

9. You already have an event In place
that causes the lift to move, and
you can use that event to trigger
the texture as well. Open the
MaterialTfigger's Events tab,
and set the Tag property to
t ron t Ll f tMover (see
FIGURE 9.50).
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FIGURE 9.49 MaterialToTrigger property set
to the progressBar material.



10. In the Static Mesh browser. set
Material (0) of elevatorControl and
Material (1) of elevatorlift to the

new progress8ar material. Unless
you have selected another texture in
the Texture browser, you should be

able to Just click the Use key.

11. Save your texture package to record
the new materials as well as the
Chapter9 static mesh package.
Save your map, and you're ready to
test your new elevator!

END TUTORIAL 9.13
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FIGURE 9.50 Tag property set to
frontLi frMover.
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You have completed a complex elevator system complete with camera shake, automated doors,

and animated textures. You should now have a thorough understanding of how Unreal uses

evenls and tags to control your triggers' bellavior. Jn the next section, you learn how to create

jump pJds in your levels to propel players across your map.

Jump Pads
Jump pads are Actors that launch players over great distances. The effect is similar to stepping into a

C<ltapult. rump pads can be used to enhance the action and fun factors of your levels. They can also

l>~ u~J \0 allow player~ tu LlU~~ over alea~ whelt~ (l :-UlJple JUIllP i~Il't ellough. III TUTORIAL 9.14,

you sec how to place jump pads in your levels and control their trajt(.tories. In this way. you have pre

cise control over exactly where a jump pad sends your players.

TUTORIAL 9.14: Adding a Jump Pad to the Hangar

1. To begin, you need a small alcove
near the top of the hangar's right
wall to test your jumping pad.
Create a 256x256x256 cube, sub·
tract it from the wall, and put a

light in the room. Use the Top and
Side views to gauge alignment (see
FIGURE 9.51).

2. Move the Player Start from the hall·
way Into this new recession. and
rotate It to point out into the room

(see FIGURE 9.52).
FIGURE 9.51 Subtracted area for the jump pad.
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3. A functional jump pad actually
requires two Actors: UTJumpPad IS
the launch pOint, and JumpSpot is
the destination. Open the Actor

Class browser and expand Actor>
NavigationPoint > JumpPad. Click
the UTJumpPad Actor. Note that you
didn't select the JumpPad Actor,
which is non-placeable.

r

TIP
In the Actor Class browser, a star next 10 an
Actor's name signifies that the Actor is placeable.

I

4. Right-c1ICl( on the floor of the new
room, and choose Add UTJumpPad
Here from the context menu to
give you a launch pOint (see
FIGURE 9.53).

5. Now you need to add the destina·
tion. Back in the Actor Class
browser, expand Actor>
NavigationPoint :> JumpDest, and
click the JumpSpot Actor. Right-click
near the base of the elevator, and
place the Actor there, as shown in
FIGURE 9.54.

6. Next, you need to establish the con
nection between these two Actors.
Open the Properties window for the
JumpSpot, and scroll down to the
Object tab. In this tab is the Name
property. which is read·only and can
not be changed. Take note of thiS

name (usually JumpSpotO), as you
use it in the next step (see
fiGURE 9.55).

FIGU RE 9.52 A Player Start placed in the room.

FIGURE 9.53 A UTJumpPad Actor placed in the
room.

FIGURE 9.54 JumpSpot Actor placed near the
base of the elevator.



7. Select the UTJumppad. and in its

Properties window, scroll down to
the NavlgstlonPoinl lab. Expand the

FarcedPa ths proper!)'. and set the

value o{ enlfy 101 to JUIlj)Spot0. or
whatevet name appeared ,n your

JumpSpot's Name property (see

FIGURE 9.56). Also. expand the

Advanced tab and set bHldden to

False so Ihal you can see the lump

pad icon in lhe game.

8. Cllcl( the Build Paths Icon on Ihe

toolbar. ana sel<!ct the Jumppad
NOw you can see the arc that play·

ers trallel if they pass Ih10ugh the

jump pad (sec FIGURE 9.57).

9. In the Properries window of the

UTJumpPad, expand the Jumppad

tab. You can edll the Jump pad's arc
of the jump pad by USing the

JUllpZI.lOOI f ier properly. Try setting
it to 0.5. as shown In FIGURE

Q.58. You must rebuild your paths,

nowever. \0 see the change.

10. If you would like to see the area of

effect for your jump pad. you can

flght·CliCk on the top oar of the 3D

viewpon. afld choose Actors> Ra<lii
View from the context menu. The

result is shown In FIGURE 9.59.

11. Save your map. rebuild (or goed
measure. and test your level.
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FIGURE 9.55 NaAJ8 property of the JumpSpot
Actor.
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FIGURE 9.56 ForcedPaths 10J property set to
JumpSpotO.

FIGURE 9.57 Arc from Jump~d to JumpSpot.
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FIGU RE 9.58 JumpZModi fier property set to 0.5 and Ute newly generated arc.

FIGURE 9.59 llle radius of effect for the jump pad.

END TUTORIAL 9.14

You have now added a jump pJd to your hangar that launches players across the level, based on

the arc you established with the JumpZMod~herproperw Jump pads can add more gameplay

depth by providing access to unreachable areas of a map. In the next section, you see how you can

create teleporters to instantly send your players from one point on the map to another.



Teleporters
Teleporters, like jump pads, can be used to transport a player from one point on the map to another,

Unlike jump pads, however, teleporters send players to the destination instantaneously, regardless

of the obstacles between the origin and the destination. Tdeporters can be set to send a player to a

series of random locations or even to teleport the player to a new level! In TUTORIAL 9.15, you

see how to set up J simple teleportcr to send a player from one spot on the map to another.

TUTORIAL 9.15: Setting Up a Simple Teleporter

1. In the Actor Class browser, expand
Actor:> NavlgationPomt >

SmallNavigationPoint. and click

Teleporter.

2. Place the telepoTler in the alcove
near your jump pad (see FIGURE

9.60). II necessary, adjust the jump
pad's position to make room. Place
a second teleporter somewhere in
the control room,

3. Now you need to establish the con·
nection between these teleporters, FIG URE 9.60 A teleporter Actor placed in the alcove.

Select the teleporter in the control
room, and open its Properties window. In the Events tab, set the Tag property to
ControlAoom. This setting functions as the teleporter's name, or designation.

4. Now seler-t the teleporter you placed near the Jump pad, In its Properties windOW, expand
the Teleporter tab, and set the UF!L property to Cont rolAoom.

5. When you select a teleporter, you see a red arrow pointing out of it. similar to the Player
Start icon. This arrow show!:> the player's orientation when teleporting to that destination,
in relation to the direction the player was facing when entering the original teleporter.
Adjust the rotation of the teleporters in the Top view so that they're facing in the correct
directions (see FIGURE 9.61).

6. If you test the level now, you would find that the teleporter near the jump pad sends you
to the conlrol room. but not the other way around. Select the teleporter near the jump
pad, and set its Tag property to TopTeleporter.

7. Select the control room teleporter, expand the Teleporter tab, and set the UAL property to
Con t rol.Room.

8. In the Advanced tab of both teleporters, sel the bHidden property to False so that you can
see the icons in the game.

9. Save your map, and test your level.

353
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FIGURE 9.61 Top view showing the rotations of the two teleporters.

END TUTORIAL 9.15

You now have a tdeporting system that sends players from the alcove in the waU to the control
room, and back again. In TUTORIAL 9.16, you see bow to expand on this technique by adding
a randOl"P. factor. You'll place a series of teleporrers that send players to a random point eaLh lime
they elHer a teleporter.

TUTORIAL 9.16: Creating a Random Teleporter
----------------------

9

1. Creating a series of random tete
porlers is simple. To begin, open the

Properties window for the control
room teleporter, and set both its Tag

and URL properties to Random (see
FIGURE 9.62).

NOTE
You can use any name you like, as long as it's
the same name for both the Tag and URl
propertjes.

2. Repeat this process for the tele·
porter in the hangar alcove.

\l9
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FIGURE 9.62 The URL and Tag properties of the
control room teleporter are both set to Random.



Teleporters 355

3. Duplicate either teleporter three more times. and place the duplicates at random locations
throughout the level, as shown in FIGURE 9.63.

FIGU RE 9.63 Five teleporters with random destinations.

4. Test the level, and enjoy your random teleporting experience.

END TUTORIAL 9.16

Challenge: Ifyou test the level, you'll find that it is possible to ride the elevator to the top and tele

port back into the hangar. However, from the hangar floor, there's no way to call the elevator back

down. Using the skills you have learned in this chapter, place a new control panel for the elevator

near the elevator shaft. Be sure to include the trigger needed to make the panel funcl ion properly.

Summary
In this chapter, you learned how triggers can be used to dramatically alter the way your game is

played. By now, you should have a thorough understanding of how events are generated, how tags

can be set, and how triggers can control multiple aspects of your level. Using these skills, rou can

create complex systems that turn your levels into Jiving environments with mulliple levels of

interaclivity.
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Chapter

Creating Particle
Effects

N('arJy every game tries to replicate a real-world effed from <l nal·

ural environment. Fire, smoke, rain, waterfalls, and J myriad olher

effects are all elemenlS that can bi' used to enhao(e realism during

gameplay. In many games, you also find special effects that go out·

side the realm of reality, such as teJeportation effects, magical

sparks, and more. To achieve these effects, you use what are knOWIl

as particles.

Particles are added into Unreal levels through Emitter Actors. In this

chapter, you learn about the practical use of particles and the emit

ter types used to create particle effects in Unreal. Keep in mind,

however, that rather than cover all the available properties of parti

cles and the Emitter Actor at once, the properties are diSCussed as

they become relevant during the chapter. The properties specific to

each emitter type, however. are discussed in the section correspond

ing to each type.
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Particle Theory
In their simplest form, particles are noth
ing more than points in space with a cer
tain look designated to make them
resemble part of a specific effect, such as a
single tlame, a puff of smoke, or a sci-fi

sparkle. The points are then assigned a
specific behavior that controls their move
ment, scale, rotation, and much more. In

FIGURE 10.1, you can see a particle effect
from a level in Unreal Tournament 2004.

To be more technically correCI, particles

are a series of dala blocks that hold infor
mf.tion such as position, lifespan, velocity,
scale, and many more. This data is then
changed and updated over time based on
rhe existing data. For example, a raindrop
starts off somewhere in the sky, and then

begins descending faster and fasler because
of gravity, Eventually, the drop hits the
ground and dies. Aparticle can have a sim

ilar existence.

FIGURE 10.1 A cool particle effect in CTF-Chrome,
a map included with Unreal Tournament 2004.

P05.III()('l' <0. IGl:>

Acceletallon <0, ·1 >
Trme'O

Taking that example a bit further, yOll

col1ld track a raindrop's activity as it falls.
Say that the raindrop starts out with posi
tion <0, 5> (20 coordi.nates are used here
for simplicity), and it's accelerating toward
the ground in the Y-axis. You want the par
ticle to accelerate in such a way thaI its

speed doubles as each second goes by. To
do this, you need to assign an acceleration
of <0,-1>. FIGURE 10.2 illustrates this

simple rclindrop movulg for three seconds.

PoSd~OIl <0. 5:.
ACC6~(~1I00_ <cC. ' b

T""0.3

FIGURE 10.2 A particle in motion.

10

In Unreal, particles work in the same manner, in lhal you can assign a series of values that con
trol various aspens of their behavior. However, using only a single particle rarely produces the
effect you want. Most effects, such as fire, smoke, and sleam, require creating hundreds, if not
thousands, of particles. To handle the creation of vast quantities of particles, Unreal uses what's
known as emil1ers, Emitters are Actors that simply pump out particles from a specific location.
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They cont rol how many particles are created, al whal speed they Slart ou I, how long they Jive, and

much more. Emitters give you enough conlrol 6ver y6ur pilrtid~ that you rarely, if ever, need 10

reson 10 programmini!- 10 achieye Ihe effect yOLl \vant

Emitler Aclor

SpnleEmiltlll' (Sm~\(e)
Sprile€mirter (Fife)
SllarkEm;ll81 (Sparks)

FIGURE 10.3 The relationship between the
different emitter types.

FIGURE 10.4 A single emitter Actor can hold
many emitters.

Emitter Types

UnreAl has five different types of emit;ers, each designed to provide a specific type of effect:

Sprile, Spark, Mesh, Beam, and Trail emillers (sec FIGURE 10.3). These emitter types share a set

or com mo n proper lies, but each one als 0 h. as ind iv idu a\ p rope rl iI'S unique to Ihat type. For exam

ple, you c.a n u~ Ihe Mesh Em iner to display your particles as stalic meshes, a feature Lhat none o(

Ihe other emitters is cap!lble of. Some emitters are meant tor effects such as snow or rain
(Spri leE(7litler), lightning effects (Beam Emilier), and declric sparks (SparkEmitler), The sheer

number of properties might seem overwhelming at nrst, but most 0 f the properties are fairly sel (

explanatory.

The Emi tter Actor is the con tainer for Lhe

various emitter Iypes. Within thiS Emit1er

Actor, YO\l can have a~ m<lrlY parlicle emil

ters as you W2nl, and they can be o( any

type and in any combinalioQ you wan!.

Although this design might sound confus

ing al lirst. it comes in handy when you're

trying to create more co mplex effects that

req uire mul Li pic emi Iter types. Say, (or

ex.ample, that you want to ere"te a fire
effect. You could have three SpritcE.mitters

inside Ihe Emilter Actor--onc to simulate
tb~ firc, one 10 si mulate tne smoke, and a
third to emil sparks (sec FIGURE 10.4).

This design meiln~ ~·oo don't have to plaa

thrco' separate Actors in your map to pro

duce a single effect.

SpriteEmitter
Toe SpriceEmille.r. the most popular and mosl commonly used emilter. is used co create common

effeCls such as \...aterfaUs, l""tre, smoke, and much mOre. When usi ng a Sp ritetmllter, each pa n icJe

onscreen is repre-sented by a spri/(: (see FIGURE 10.5). A s\>rite is simply a reClangular 20 plane

on whic1l an image i.s plJced, This pl:me always faces tow"rd Ihe camera, To be precise. this means

sprites are always perpenJJcub.r 10 the Gamera, Bc(.)use the image'S used (o~ each sprite can have
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a mask or an alpha channel, the outer edge

2D planes C;l1l be transparent, effectively

allowing you to make the sprite appear to

be Jny shape you want.

In TUTORIALS 10.1 through 1.0.3, you

simulate steam coming from a pipe by

using J SpriteEmitter.

:':
I

Sprite
,:

Smoke Sprite

FIGURE 10.5 A simple smoke sprite.

TUTORIAL 10.1: Creating and Setting Up Your Emitter

1. Open the Tutorial10_01_Start.
ut2 file. This map contains a large
air pipe with a smaller pipe con·

nected to It that you'll use as the
exit point for some steam (see

FIGURE 10.8).

2. First, you need to create the Emitter

Actor. Open the Actor Class browser

and select Actor > Emitter.

Underneath this Actor is a series of

other emitters, mostly specialized

for use within the game through
Unreal$cript. Place the Emitter Actor FIGURE 10,6 Room witnout any particle effects.

at the end of the pipe. as shown in
FIGURE 10.7.

3. You now have an Emitter Actor, in
which you can start placing other

emitter types. For this tutorial, you

need only one simple SprileEmitter.

Open the Properties window for the

Emitter Actor. Under the Emitter cat

egory is one Emit ters property.

This array starts Ollt empty. so add

one to it by clicking the Add button
(see FIGURE 10.8).

10 FIGURE 10.7 Emitter Actor placed at the end of
the pipe.
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4_ Now you need to specify what kind of emitter type to add. Select SpnteEmmer (rom the

drop-down list next to the New entry, and click the New button. which gives you access to
a wide variety of new options, shown in FIGURE 10.9.
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FIGURE 10.8 Emitters property with one
Item in it.

5. At this pOint, you should already see

some feedback in the main view
port. If not, make sure that Realtime

Preview IS enabled by clicking the

joystick Icon in the viewport's

upper-left corner or pressing the P
key, Notice a few things you'll need

to change (see FIGURE 10.10).

First. the sprite IS the same as the

icon used for the Emitter Actor. Also,

you need to change the sprites' size
and add some movement to them,

You'll do this in TUTORIAL 10.2.

6. Save the map.

END TUTORIAL 10.1
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.
FIGURE 10.9 Properties of the SpriteEmitter.

FIGURE .10.10 The beginning of your particle
effect.



FIGURE 10.11 On the left is the texture's color
data and on the right is the alptla channel.
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In the Emit1er Actors Properties window,

the Texture category provides all the neces

sary properties for controlling your sprite
textures. Only two of these properties are

important at the rnom~nl: Texture and

DrawStyle. Texture is used simply to specify
the texture you wallt to use tor your sprite.

DrawStyle determines how the texture data
is interpreted and drawn onscreen, much

like the material properties discussed in

Chapter 8, "Creating MateriaJs in Unreal."

For demonstration purposes, the tt'X1.ure
shown in FIGURE 10.11 is used.

•
0<-

r
I

'.
"'lo""~ _" •

•

TABLE 10.1 shows the OrawStyles available for use with particles. The right column contains a

description of each DrawStyle, and the image in the left column shows what the texture in
rlGURE 10.1.1 would look like using that particular DrawStyle,

10

TABLE 10.1

Texture

Texture DrawStyle

Description

PTDS_Regular makes the texture opaque. However, the alpha chan
nel is stili taken into account, making all black areas of the alpha
channel completely transparent and all other parts opaque_

PTDS_AlphaBlend makes the darker parts of the RGBA texture's
A-channel more transparent than the bright parts. Black becomes
completely transparent, and The white parts are completely opaque.

?TDS_Modulatf!d makes the bnghtesr colors of the texture more
transparent than the darkest cOlors, so black becomes opaque, and
white becomes completely transparent. However, the brighter colors
still brighten the background.

PTOS_Translucent makes tl1e texture's darkest colors more trans
parent than the bnghtest colors, so white becomes opaque, and
black becomes completely inviSIble. All other colors are partially
transparent.



TABLE 10.1

Texture

~.I

•

SprlteEmltter

ContJnued

Descrlpllon

PTDSJuph&~Odulcltemakes the darker areas more transparent if

the actual alpha channel is something other than while .

PTOS_Darken makes the telClure's colors negative <ll'\d translucent.

PTOS_B!"'igh t.en mal<es the texture b(lghten the btlck.ground. so the

texture becomes translucent and bnghter than rts onglnal verSlorL

As you un s~e, the alpha chan nl"l i~ u$cd in all the draw lypes. However. onl}' in PTDs_AlphaBlend

and PTDS_AlphaJ.kldulate are lhe alpha cnannd's grily ~reas used. The rcst of .he dray,' types

make all black areas transparent and all olher colors opaque. Tn TUTORIAL 10.2. you me Ihe
DrawStyla pToperry with a SpriteEr-1iucr CO create a ~leam effect.

FIGURE 10.12 On the left Is the texture's oolor
data and on the right is the alpha channel.

TUTORIAL 10.2: Creating the Steam

1. Open Tu~ori8110_02_St2rt.ut2. or
conunue with the file (rom

TUTORIAl. 10.1.

2. Open the Tel(ture browser ana load

the ChapceI"10.utx package. $elect

the Smoke texture. In fiGURE
10.1.2. you call see this texture's
RG8 and alpha channels. Notice that

the RG8 information for the texture is

completely white.

3. In lhe Properties window (or the

SpriteEmitter, open the Texture cate

gory. FOI the 7exture propeny. elic\<

the Use butt<ln.

4. Your texl.ure ($ now In use. However.

your sprite Iool<s Irl<e F IGUR E 10.1 J.

RGB Alpha
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Notice that your texture is completely
white, except for the alpha channel.

which actually holds the smoke (or
mation. Because your current

OrawStyle. found under the Texture
category, is set to PTOS_Regular, the

alpha information IS used as a mask,

making the texture either completely
opaque or transparent and nothing in
between. Change the OrawStyle

property to PTOS_AlphaBleOd. and

notice that the alpha information is

now read incorrectly. FIGURE 10.14
shows what you should gel.

5. Your texture is correct now, but the
size IS stili far too big. In the

SpnteEmitter Properties Window, open
the Size category, where aU adjust·

ments to sprite soze are made. The

property StartSizeRange specifies a
range from Min to Max in X, Y, and Z.

The size is a random value Within that

range. Becau$e the three axes are
Independent of each other, you do get

considerable control over the texture's

size. However. the UniforOiSi ze prop

erty is set to False by default and
can't be set to True unless

UseOirectionAs (under the Sprite cat·
egory) is set to something other than

PTDU_None. For your purposes, set the
Min and Max values of X to 5 and 15,
respectively. Because Urll.for·mSize IS

True. the sprite will always be a perfect

square ranging in size from 5 to 15
units in width and height.

6. Now you need to give the steam

some locomotion. Under the Velocity

category is another set of properties
speCifically meant for settrng the
speed of particle motion. The

5t artVelocityRange property, mea

sured in Unreal unIts per second,

sets the range of possible velocities
that a particle can have when It

FIGURE 10.13 The sprite information is being
used incorrectly.

FIGURE 10.14 Setting DrawStyle to
PrOS_A) phaBlend fixes the ugly sprite problem.

FI'::'U K~ 10.15 The current progress of your
steam.



begins its life, It works just \ike the
StartSizeRange property except

that you aren't hindered by a prop
erty such as UniformSize. meaning
you can set the velocity range in any
axis without restriction. For the Y

property of the
StartVelocityAange, set the Min
and Max values to 50 and 80,

respectively. to make your partIcles
move anywhere from 50 to 80 units

every second. To give the steam a
little dispersion, set the Min and
Max values of the X and 2 compo

nents to ·5 and 5, respectively.
FIGURE 10.15 shows what the

steam should look like.

7. The steam should also rise slowly,
so add some acceleration to it. In
the Acceleration category is but one

property: Acce Ie rat 1.011. Because
the Z·axis is pointing upward, set
the Z component of the

Acceleration property to 15 to
make the velOCity in the Z-axis
Increase over time. This setting
causes the steam to rise into the
air, as shown in FIGURE 10.16.
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FIGURE 10.16 Steam rising into the air.

FIGURE 10.17 Thick steam rising into the air.

8. Now you need to fix the main problem that keeps your steam from looking like real steam:
the lack of particles. Under the General category is the MaxPart ~cles property, which tells
Unreal the maximum number of particles this emitter can have at any given moment, By
default, it's set to 10, which means you have only 10 partIcles onscreen at one time, Set
this property to 400 to make the steam look much thicker (see FIGURE 10.11).

9. Save the map.

END TUTORIAL 10.2

Up to this point, the life of your particles hasn't been discussed, Every particle hves for only a

certain amount of time, and then disappears into oblivion. Under the Time c<ltegory, you have
access to three useful properties: InitialDelayRange, Ini tialT imeRange, and Lit etimeRange.

TABLE 10.2 describes their functionality.
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TABLE 10.2 Time Category Properties

Property Description

InitialDelayRange

InitialTimeRange

LifetimeRange

This properly sets the amount of time before the Emitter Actor actually
begins emitting particles. For example, if the Min and Max values are
both set to 5. the emitter walts five seconds before it begins emitting
partir:les.

ThiS property sets the mitial age of particles (their age at creation
time). Therefore. if a particle's life is 5 and the Initial time is set to 3.
the particle lives for only two seconds.

The Min and Max values set a range, and each partIcle IS given a life
time. measured in seconds. somewhere wit/lin that range that deter·
mines how long it lives. By oefault. each oarticle lives for exactly four
seconds, However. it's far more realistic If each particle doesn't live the
same amount of time. To 00 thiS. use the Mln and Max values to supply
a range for this property.

Lr1e-ilfne

AJthough your steam is looking fairly good, having the particles come into and out of existence

instantly is rather unrea1i~tic. This is where the Fading category of properties comes into play.

These properties enable you 10

have your sprites fade into and out

of existence smoothly by slowly

increasing and decreasing lhe L<leSlal1 Fed.'nfl'Cll,,,,.

sprites' opacity, as illustrated in
FIGURE 10.18. FIQURE 10.18 The visibility cycle of a particle.

If you Sd Fade! n to True, each sprite fades into existence from complete transparency to full vis
ibility. FaeternEndTime specifies the amount of time in seconds that it takes for particles to fade

ill. If yOll set FadeOut to True, each sprite fades out of existence from full visibility to complete

invisibility. FadeOutSt artTime determines when a panicle starts to fade out. By Ihe end of its life
lime, the particle is completely invisible, if FadeOut is set to True and Lifetlme is gre;tt("r thall

F'adeOutStartTime, the particles are completely invisible the moment they die.

10

FiloeIIiFactor ,HId FadeOutFilctor arc (Wo ()(ht:r properties that COllie illlO play with f(l(Ji/lg.

They control the "mollnt of fading, either in or out, in the different channels: Red (X), Green (Y),
Blue (2), and Alpha (W). The lower the number, the faster each channel fades in or oul. By

default, aU channels a.re set to J, meaning th<lt all components fade in or Out at regular speed. If
you set a channel to 0, that channel fades instantly and, hence, is complctcly visible at all times.

Therefore. if you have a completely white texture fade in with the Red component set to 0, the

texture starts out red because only that component is completely visible. In TUTORIAL 10,3, you

use these properties to finish your steam effect.



SprHeEm/rter 369

TUTORIAL 10.3: Adding the Final Touches to the Steam

FIGURE 10.~9 Current progress of your steam.

FIGURE 10.20 ,Steam after turnIng the opacity
down.

1. Open Tutorlil110_03_St.art. ut2, or use the file you saved in TUTORIAL 10.2.

2. In the Properlles window for the
SpriteEmitter, expand the Time cate
gory. Change the LifetimeRange's
Min and Mal( values to 3 and 3.5,
respectively. This setting causes
your particles to live anywhere from

3 to 3.5 seconds and helps prevent
any particles (rom going through the

adjacent wall.

3. In the Fading category. set Fadeln
to True and FadelnEndTime to 1.

Now set FadeOu t to True and

FadeOu tSl:artTime to 2. Your parti

cles will fade to visibility in one sec
ond, stay completely visible for one

second, and then start to facie out

until death. FIGURE 10.~9 shows

the current progress of the steaM.

4, Although it's Starting to resemble
steaM, It curr~ntly lOOks more like

gravlty-defylng milk. To fix this, you
need to make all tl1e particles more

transparent. In the Cofor category.
the Opac i t y properry controls the

particles' overall onaclty. Setting
this properry to 0 would make all
your particles completely inVISible.

Set It \0 0.1 Ie prOduce ~()mething

that looks more like steam (see
FIGURE 10.2Q).

5. Save the map.

END TUTORIAL 10.3 ._-------- ---------

As you can see from this steam example, creating an c((eel is only (\ matter or understanding the
effect you wanl to create and tweaking a series of paramders. A thorough under~ta[lding of the

..vailable properties and their uses simplifies your job.

~ another example, take? look at TUTORIAL 10.4, which shows you how to create a generic

releportcr effect.



TUTORIAL 10.4: Creating a Teleporter Effect
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1_ Open TutorialI0_04_Start.ut2.
This map nas a teleporter in the

center of the room that you'll use
as the basis of your effect-creat

Ing a spiraling group of particles
that rise from the teleporter base

(see FIGURE 10.21).

2_ Using the skills you have lea/ned,

create an Emitter right on top of

the base (see FIGURE 10.22).
and then add a ParticleEmitter to

the Emitter.

3. In Ihe Texture browser, open the

eh ap t e r 10 texture package and

select the Flare texture. In the
Properties window of the
ParticleEmitler, go to the Texture

category. Click Use tor the
Texture properly. Also, make

sure the OrawStyle property IS

set to PTOS_Translucent. You
can see the result in FIGURE
10.23,

4. Now you need to decrease the

particle size. Under the Size cate
gory, change the Star'tSlleAange

property's Min and Max values in

X to 10 and 15, respectively. Also,
change MaxParticles in the

General category to 200. FIGURE
10.24 shows the result.

S. Save the map. You now have the
start of an emitter effect, but you

need to make the emitter spawn
ptlrticles over the base's entire

area.

END TUTORIA.L 10.4

FIGURE 10.21 Final teJeporter effect.

FIGURE 10.22 Emitter on top ot the teleporter.

FIGURE 10.23 The new texture Is now being
used for the emitter.

FIGURE 10.24 Smaller particles with more
being emitted,
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By default, an emitter aJways emits particles from the location of the parent Emitter Actor. This

is fine in many cases, but often you need particles to be emitted from an entire areiJ or volume.

For this purpose, you have the properties in the Location category.

You can use the StartLocationOffset property to control where particles begin their life. By

default, it's set to (0, 0, 0), which means particles start out at the Emitter Actor's location.

However, this setting depends on the coordinate system you have set up. Under the General cat

egory, you have the CoordinateSys tern property. TABLE 10.3 describes the availab~e options for

this property.

TABLE 10.3 CoordinateSystem Settings

Option Description

PTCS Relative If this option is set, the particle's position is always in relation to the
Emitter Actor's location. Therefore, a particle at position (0, 0,0) is in
the same location as the emitter.

PTCS_Absolute If this option is set, the particle's position is based on the coordinate
system of the world, Therefore, a particle at position (0,0. 0) is at the
center of the world.

PTGS_Independent This mode functions almost exactly the same as PTGS_Relative.
Particles are spawned at the Emitter Actor's location. However, after
they've spawned, their location is absolute and no longer relative to the
emitter's position. This d"lfference becomes apparent only when the
emitter IS moved.

You'll find the StartLocationOffset property immensely useful when combining multiple

emitter types into one parent Emitter Actor because often you need to give the emitter types a

slight offset from each other.

In addition, you can cause particles to emit anywhere inside a particular volume. You start by set

ting the StartlocationShape property to the shape yOll want to emit from, and then adjust the

corresponding property to match the dimensions of the shape you want, TABLE 10.4 describes

each shape and the corresponding properties.

TABLE 10.4 StartLocationShape Settings

Shape Properties

PTLS_Box This setting causes particles to be emitted from a box.
StartlocationRange specifies the locations of the six sides of the
box: X(Min), X(Max), Y(Min), Y(Max), Z(Min), and Z(Max), For exam
ple, if you set the Min value of X, Y, and Z to -50 and the Max value of X,
V. and Z to 50, you would get a perfect 100xl00xl00 cube.
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TABLE 10.4 Continued

Shape Properties

This setting causes particles to be emitted from a sphere,
SphereRadiusRange specifies HIe Min and Max radius of this volume, If

you set Min to 0 and Max to 60, particles are emitted from anywhere

inside a sphere with a radius of 60. However, If you set both Min and

Mal< to 60. particles are emitted only on the sphere's surface.

This setting enables you to specify a polar region for particles to be
emitted from. X, Y, and Z correlate to theta, phi, and radius, respectively.
In Unreal, this means X controls the amount of rotation around the Z
axis, Y controls the amount of rotation around the Y·axis, and Z controls

the radius. When Y is 0, you're at the very top of your hypothetical
sphere. When Y is 32767 (lBO degrees), you're at the very bottom of

the sphere, Vou could use this setting to cause your particles \0 emit
from a circular plane, for example (see FIGURE 10,25).

You'U usc these new properties to adjust the
te[eporter's particle effect. In IUTORIA L 10.4,

you continue from TUTORIAL 10.3 to

enhance the look and behavior of the current

pilrticJe system.

FIGURE .10.25 The X, Y, and Z values for
PTLS_Polar.

TUTORIAL 10.4: Creating a Teleporter Effect (Continued)

Particles covering the base of theFIGURE 10.26
teleporter.

1. Open the Properties window for the ParticleEmltter, and go to the Location category_
Because the teleporter base is round, set the StartLocationShape property to

PTLS]olar. The radius of the base is about 35 units: therefore, set the Max value of the

Z component in the
St art Loca tionPolarRange to 35.
Because you want particles to emit

from anywhere inside this radiUS,

set the Mln value of the Z compo
nent to O. The Xcomponent needs
to go in one complete circle, so set

Min to 0 and Max to 65535 (360

degrees), Finally, Yneeds to be par·

allel to the teleporter base, so set
Y's Min and Max to 16384 (90

degrees) to create a flat, circular

area that's parallel to the ground
(see FIGURE 10.26).

10
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2. TO add some upward movement to

the particles, in the Properties win·
dow for the SpriteEmitter, go to the

Acceleration category and set the Z
component of the Acceleration
property to 50. FIGURE 10.27

shows the results of this setting.

3. Some fadmg would improve the

effect. To do this, set Fade I n under

the Fading category to True and

change FadeInEndTime to 0.5. Now
set FadeOut to True and change the
FadeOutStartTime to 1.5, Finally. FIGURE 10.27 Particles rising from the teleporter.

under the Time category. set the

Lifet imeRange property's Min and

Max values to 2 and 3, respectively.

See FIGURE 10.28 for tM

results.

4. Save the map. The effect is now

close to being done, but you stIli
need to change the particles' color

over time and add some revolving
action in TUTORIAL 10.5.

FIGURE 10.28 Particles fading in and out from
life to death.

END TUTORIAL 10.4---------------------------
To change the color, you have the Color category. In this Lategory, the rno~t useful property is
ColorScale, which enables you to change pa rticle coler over time. Basically, it's an array that

holds the times at which the color changes and the wlor to which each particle changes. Each
array dement has two data items: Color and Re JativeTime. '[he Re Jat 1vellm(-! propC'rtv speci
fies a point in the particle's life. If set to 0, you're referring 10 the beginning of the particle's life.
When set to 1, you're referring tu the end of the particle's life, regardless of the particle's lifetime.

Say yOll added two elements to the ColorScale property. The first dement's Color is set to black
and RelativeTime is sct to O. The second element's Color is set to white and RelatlveTime is set

to 1. To make this setup work, however, rou need to set UseColorScale to True- or nothing will

happen. With thaI setup, particle... fade from black to white over their lifespan. FIGURE 10.29

shows a simple example and a more complex example.
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Simpl!> Example

FIGURE 10.29 Examples of color scales.

You c<In also use the ColorScaleRepeats property to make the ColorScale repeat the number
of times specified. [f you set ColorScaleRepeats to 1, the simple example in FIGURE 10.29

would go [TOm black to white at the halfway point of the particle's lifespan and then from black

to white .lgain.

If you just want to give your particles a certain tint or apply random colors to each particle, you

could do so with ColorMu It i pllerAange. This properry enables you to specify a range [or each

component: X (Red), Y (Greeo), and Z (Blue). For example, if you specify a range from 0 to I for

each component, each particle gets a random color.

To add some revolving motioo to your particles) you GIO set the properties in the Revolution cat

egory. Before any revolution occurs, you must set UseRevolut iOI1 to True. I3y default, particles

revolve around the Emitter ActOf, but if the CoordlOateSystem properly is set to PTeS_AbsOlute,

they revolve around the ceoter of the world. To change the point the particles revolve around) yOll

can change Revolut ionCen t erOffsetRange.

For controlling the speed of revolution, you must set Revolut lOnsPerSecondRange. With a value

of I, each particle makes one complete revolution every second. Because you are given ranges for

each axis, each particle can have a varying amollnt of revolution speed. You can also lise the

Revolut lOnScale and UseRevo lutlonSca) e properties \0 control the amount of revolution over

time, much like the ColorScale property_ In TUTORIAL 10.5, you finish off the teleporter par

ticle system by using these settings.
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TUTORIAL 10.5: Adding the Final Touches to the Teleporter Effect

1. Open Tutorial 10_05_Start .ut2, or use the
file you saved in TUTORIAL 10.4.

2. In the Properties window for the SpriteEmitter,

open the Color category. Set UseColorScale to

True and add two elements to ColorScale. You
want the particles to go (rom yellow to blue

over then lifetime. Therefore. set the first ele·
ment's Color to yellow and RelativeTime to

O. Then set the second element's Color to

blue and RelativeTime to 1 (see FIGURE
10.30). These settings produce the effect
shown in FJGURE 10.31.

3. To make your particles revolve. in the Revolution
category. set UseRevolut io~ to True. You want

the particles to revolve slowly around the Z·axis.
so set the Revolut ionPerSecondRange prop

erty's Z component Min and Max to 0.3 and 0.5.
respectively, See the results in FIGURE 10.32.

4. You now have a convincing teleporter effect!

Save the map.
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FIGURE 10.30 UseColorScale and
ColorScale properties set up so that
particles fade from yellow to blue.

FIGURE 10.31 Particles that fade from
yellow to blue.

END TUTORIAL 10.5

FIGURE 10.32 Particles that revolve
around the Z·axis.

You've learned about several important particle properties. There is, however. another important

concept thaI hasn't been covered yet: subdivisions on texlUres. These subdivisions enable you to

have an animated sprite. At this point, aU your particles have only a single texlure applied. By
using subdivisions. you can divide a texture into seclions and cycle through these sections. Under

the Texture category are eight properties dealing with subdivisions. TABLE 10.5 describes these

properties. To demonstrate these properties. the lexture shown in FIGURE 10.33 is used.
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FIGU RE 10.33 On the left Is the texture, and on the right is tile same teldure with the Indices for
each tile.

TABLE 10.5 Texture Subdivision Properties

10

Property

TextureUSubdiviS10ns

Te~tureVSub61VLsions

SubdivlS10n$tart

SutxlivisionEnd

SubOil/isionScale

UseSubdil/isionScale

Description

This properly specifies the number of tiles that make up the

selected lelltwe. lrom len 10 rlBhl. For the sample texture, this

property Sholl Id be set 10 4.

ThiS property specifIes Ihe number of 'des that make up the

selected tel(\ure, lrom lOP to bon om. For the sample texture,

thi s properly shOuld I:>e set to 4.

This property specifies the firSt tile 01 the texture you want to

use. The t,les' lnc1ices are shown on Ihe right in FIGURE 10.33.

This property specifies the last tne of Ihe texture you want to
use. By default. each particle cycles through each al/ailable tile

once in its IIfelime. If Subdi'lisiol'Start IS 3 and

SubdivisionEnd is 6, tiles 3, 4, and 5 are used. If start and

end are b<>th 0, ell Liles are used.

Using thiS property enables you to control at what sneed the
liles change from one to the other. Usually. the amount o( time

between tile changes IS eQual for slIllles, but you might not
always wanl '''liS selting. Each element in the array specifies

when. In relative time, the tile thenges. 1/ you add only one
item to the array aM set the value 10 1, the fifSI tile Is used for

the pafllcle's entire life. If you set ;1 (0 O. the first tile changes

oller to Ihe second tile right when the particle's life beginS. With

only one item in the array. you have access to <lI\ly two tiles. II

you have twO items in the array. you have access to three tiles,

and so on. FIGURE 1.0.34 shows hOw array IndiceS arid set

lings are used to contrOl tile changes.

This property must be set to True before SubdivJ.Sl0nScale

can be used,
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TABLE 10.5 Continued

Property Description------------
81endBetweenSubdivlsions

UseRand~uodivision

When set to True. the tiles don't change II'\slLlnlly. Instead. they

change smoothly (rom one 10 the next

When set to True. each particJe randomly selects a tile Decween
SuMivisionStart and SubdivlsiDnEnd, and it uses that one

lIle IhroughoU't !he partlcle's ll(espaA. When this property IS sel

to True, Subdiv.islonScala IS ignored el1l.J(ely,

T\ffle'O nme: 0.2 TIt'I'oEl:O.S Time: 0 7 rIma: 1

FIOU RE 10.34 The sprite changes at glven index values when using the Subdi vis i onScale
property.

NOTE
In TUTORIAL 10.6, yOIl take advanlagt of texture subdivI
s)ons to 're<lte ~ome fire.

TUTORIAL 10.8: Creating Fire

WI\eIl using SUOO1V is looSeB 1&,
I Subd1visionStart and
i SubdivlSlonEnd are ignored.

----- ---. ---

1. Your goal Is \0 get the lire eNect
shown in FIQURE 10.35,

BeSides lhe fire, you also have dar\(

smoke rising (rom Ihe hre, So you'lf

be usiflg two SprlleEmitters, Sta rt

by opening 'Tutorial f0_06_
Star t , ut.2. which contains ooly a

torch In an o1herwise empty room
(see FIGURE 10.36).

2. Create an Emrttel Actor on top of

U'le torch, and add a SprileEmltter to
II (see FIQUAE 10.37).

3, You're go109 louse \he same (He

texlure with 16 Wes thai was Fl GU Fl E 10.35 The Onal fire eHecl
demonstrated prevIously. Open Ihe
Telcture browser and load the Chap t er f 0. ut)( texlure package. Select the Fire texture.

In l/"le Properties window (or the SpriteEmiHer, go to the Texture category and click the

Use button fOI the Textllre property. Because you have four (lies 1/1 U and V, sel
TextureUSubdivisions and TextureVSubdivLsions 10 4. By-navlflg a texlure with so

many tiles. the sprites will be animaled and hence 1001< more random (or the fire. To
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prevent this animation (rom 'pop·

Ping" from one tile to the next. set

81end8etwe en$Ul)<h visions to

True. Finally. ensure that lhe

Dl"awStyle ploperty is set to
PTOS_TranSlucent.

4. Oblliously. the size IS far tOO big for

the effect you want. Under the Size
category. set the "'in and Max val

ues of the X component of

StartSizeRange to 15 and 20.
respectively. When fire rises. it

tends to get smaller-or al least
that's the way it appears. YOu can

simulate thIs by taking advantage of
L"le Sl.2eScale property. wtllch

enables you to change the particles'

size over time and workS much like

the oU'ler scale l'/pe properties
you've already used. Add one Item

to the Si zeScllle prOperlY- Set
RelativeTllle to 1 and
AelanveSize to 0,2. WIth this

setuP. the partIcles stan alit at thalr

regular size end shnnk to 20'l6 af

their original size by the end of their

lifespan. In eHect. the fire rises to a

cone Sh()pe. Also. set

UseSizeScale to True so that the

Sl.2eSca 1e propertY IS actually

used.

6.. To make particles emil f'om a larger

olea. vndel lhe Location category.

set StartLocatlonsnape to

PTlS_Sphere. Set tne Mln and I.la~

values of SphereRAdiusRange to 0
and 15. respectively. FIGURE

10. J 8 shows lhe currenl progress

of the lire eHect.

FIGURE 10.38 Empty room with an unlit torch.

FIGURE 10.37 A SprileEmitter added 10 the
torch.

FIGURE 10.38 FIre eHect up to (hi!'. point
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6. The mOilon needed lor the (lie IS SIm

ple. All you wanl is lor the names 10

move up. So II) the Velocity c.ategolY.

Setl.lll1 and Mal< of the Z component

of StartVclocityRange to 20 and
60. respecllvely, FIGURE 10,39
snows the resutts.

7. To lI)crease the IlUmM( 01 panicles.
go to the General cBtegory ilnd set
l.laxParticles \0300,10 decrease

the lifespan of yOUf particles, under

Ihe Time category, set the Min and
Ma x va lues of Li t 8t lMeR ange to 2

and 3. respectively. Finally, (0 add

some tadlng to your panIcles, under
(he fading category, set Fada In to

Tlue, Now change Fade r nEI1dT il1le
to 0.1, set FadeOu t to True, and set

FadaOutStartHms to 1.5 (see

FIGURE 10.40).

8. Although Ihe (ire Is stanlng to look
mare like fire. It slill needs ta look a

bit mare random, Ta this end, you're

going to use some of tne properties

In the Rotation categolY. With these

properties, 'lOll can mak,e inarviClual

particles rotate. TA8LE 10.0 aut·

lines the three properties useful for

your lire.

TABLE 10.6 Particle Spin Properties

FIGURE 10.39 Upward-moving flame.

FIGURE 10..40 The fl&me effect with mare
partides, fading, and a shorter 1I1etlme.

NOTE
If the flames penetrate the underside of the
lord1, sImply move the emlt1er LIp.

Property

SpinPa.-tl.cles

SpinsPerSecondAange

Description

Wh!:r, set to True, your partlcles spin al the speed specified in

SpinsPerSecondAanqe,

This property speclties a range of speeds at whiCh your particles

spin in each specific axis, It's me~sured in number of 36O-degree

spins per secon(!. Therefore. II It's set to 1. particlp.s spin, In lhe

specified ax,s, 360 degrees every second. If you're using a SImple
2D sprI(e that's set up to face th". c:amera al all limes, the X com

ponent is the Orlly one Ihat needs 10 be adjusted.
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TABLE 10.6 Continued

Property Description

SpinCCWorCW This property specifies whether the particle is going to spin clock·
wise or counterclockwise, By default. it's set to 0.5 for each axis,

which means there's a 50-50 chance of the particle spinning clock
wise or counterclockwise. If you set it to 1, all particles rotate

clockwise. A setting of 0 causes all particles to rotate counterclock

wise. A setting of 0.6 means there's a 60% chance the particles

rotate clockwise,

Therefore, set SpinParticles

to True and set the Min and Max

of the X component of

SpinsPerSacondRange to 0.5 and
1, respectively. This way, all parti

cles WIll always be rotating,

9. Finally, under the Color category, set

Opacity to 0.3. You now have a
convincing flame, as shown in

FIGURE 10.41. Save the map. In
the next tutorial, you add smoke to

the effect,

10

FIGURE 10.41 The flame effect without smoke.
END TUTORIAL 10.6

.Another addition you can make to the fire is black smoke. I N TUTORIAL .10.7. you'U do that hy

adding another SpriteEmitter to your Emitter Actor and setting its properties to simulate smoke.

TUTORIAL 10.1: Adding Smoke to the Fire

1. Open Tutorial10_07_Start, ut2, or use the file you saved in TUTORIAL 10.6,

2. In the Properties window for your Emitter, add another Spri teEm itter. For the rest of this

tutorial, YOU'll be working with the properties of thiS new SpriteEmitter that's located at
index 1 (see fiGURE 10.42}.

3. In the Texture browser, open the Chapter10. utx texture patkage and select SmokeTlles.
In the Texture category, click Use next to the Text ure property_ This texture has four tiles

across and four tiles down, so set TextureUSundivisions and TextureVSubdivisions

to 4, Also. set BlendBetweenSubdivisions to True. Finally, ensure that DrawStyle is set

to PTOS_Darken so that the smoke is some shade of black (see FIGURE 10.43).



FIGURE 10.42 New SpriteEmitter
located at index 1.

4. Under the Size category. set the M~n

ann Max v<'llues of the X component
of StartSueRange to 10 and 20,
respectively. Under the Velocity cate·

gory. set the Min and Max values of
the Z component of the
StartV~lor.ityRangp.to 20 and 60,
respectively. These settings produce
the smoke shown in FIGURE
.10.44.

5. Under the Location category. set
StartLocation$hape to
PTlS_Sphere and set the Min and

Max values of SphereRadlusRange

to °and 15, respectively. Also. you
want the smoke to start slightly
above the base ot the fire, so set
the Z component of
StartlocationOffset to 40.

Sprit~~mitt~~

FIGURE 10.43 Texture category of the
Sprite£mrtter.

FIGURE 10.44 Smoke rising from the fire.

FIGURE 10.45 Smoke effect with more particles.

381
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8. To produce more particles, go to the

General category 81"1d set MaxParticl es

to 50. You're startil"lg to get the smoke
look you want (see FIGURE 10.45).

7. To help your smoke blend into the fire

Slightly belter, go to the Color category
and set Opaci ty to 0.6. Also, go to the
Fadmg category and set Fade I n to True

and Fade JnEndTime to 0.5. Then set
FadeOut to True and FadeOutSt a rt Time

to 3. Finally, under the Time category, set
the Min value of LifetimeRange to 3.5,
which creates a more random lifetime for

the particles. You now have a complele FIGURE 10.46 The final fire effect.
fire effect. shown in FIGURE 10.46.

8. Save the map.

END TUTORIAL 10,7 -------_.__._--------------

By now, you should reaJ.ize that working with parlicles is simply a mailer o( Iweaking properties

ufltil you get the look you're going for. The (ollowi ng sect LOllS describe the Olhe r available emitters

and how to use them in your maps_

SparkEmitter

As its name SUUl!sts. the SparkErnitt'r is used to creale sparklike eff~cL5, 3\)ch as the spa rks (rom
a welding torch, sparks from a short circuit, or even fi re\"'orks.

This emiller spawns partides that are r~pTt~senled as l-pixel.th.ic.k lines thaI follow the direction of

the p.a.rLicJes. Bl!cause itS whok purpose i~ to generate sparks.. lhc single-pixel lines are aU it needs.

Consequently, the SparkEmilter has a lack o( (lex ibility lhat makes many of Ihc properties non

functional. The Size category, for instance, (s completely unusable.

However, you have access to tJlIee new prope rl ies \l nder the Spark ca legacy, dcsa ibed in fA B L E 10.7.

TABLE 10.7 Spark Category Properties

1

Property

LineSegmentsRange

Description

This property controls the lenglh of 'he spar\<. segmenlS. Setting

a range wllh (he Min and Max COITlPonenls means the lengths
of the sparns can be random. If the lengths ore 100 long. you

can see the indiVIdual straight segments. You must be careful.
however, not 10 make the lengths lOa loog Of 100 sho/t or the
SparkEmitler WOf\'~ wor\<.
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TABLE 10.7 Continued

Property Description

TimeBeforeVisibleRanQe

TimeBetweenSegroentsRanQe

This properly is not currently implemented.

This propeny controls the oelail of your hnes. SettIng thIs

value to a lower number increases lhe segrnents on your lines.

This increase IS most obvIous when lhe particles are on a

curved path. If your particles' palh IS very curved. you'lI wanl

to set this property to something Quite low, such as 0.2. When

setting It (0 a lOw value. however. you might need to increase

the MaxPa rt ic I es property. Because each segment is consl(l.

ered another panicle, the number 01 particles can increase

rapidly.

When you're \'lorking with a SparkEmitttr, the Hxture property i.nOucn,~ tile line' color.
Therefore, all other properties under the Tex1ure Gltegory, 01 her than Texture, .are n610nger LllefuJ.

As an example of Ihe SparkEmilter, TUTORIAL 10.8 \\'a1ks you through Cft3t ing a firew6rks SYSltffi.

TUTORIAL 10.8: Creating Fireworks

1. Open 'fufon3110_lil8_Start. ut2.

In ltte middle of the room is a static

mesh that you'lI use as the firework

launcher. On top 01 this launcher 'IS

31\ EmItter Actor that currently has a

SpriteEmmer in it. 1hl5

SpflleEmlner's only Job IS '0 shoot
panicles into the a.r. Your goal i5; 10

get the paniCles l6 explode mlO Cl

dauling display 01 multicolored fire

works. as ~oWl'\ in FIG UIfE

10.47.

The fireworks fire created With lhe

SparkEmirter. Every time a particle
collides wl,h ,he world geometry in

Ihe sky, the fireworks flom your

SparkEmiller are spawned.

FIGU RE 10.47 Final fireworks effect.

2. In the Properties wrndOw for the Emitler, and 3 Sl'l3rkEmlller (see FIGURE 10.48).
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3. First you nee<1 10 get the fireworKs

effect 10 work correctly. and then
you'U have it react cnly wl'\en spriles

from the SpllleEmitter hil lhe cell
mg. In the Properties window for the

SparkEmiuer. go 10 Ihe Spark cale

gory and set the I,l1n and ~aJ( values

01 LlneSegnrentsAange to 2. You

......-ant ',wfy good detaIl on your fire

works. SO set bOCh Che '''In and Mal(

values of

Time Be twe enSeglient sR ang e to 0.2.

4. Because you want me lines to start

Oul while so thaI you can change
Ihem mo!e eaSIly. you need 10 use a
white le)(1ure. In the Texture tlrowser.

open the Cl'lapt er 10. uh texture

packa~e and select tl'le Flare lex·

lure. Under the lexture category of
your SparkEminer. Click the Use

button for the Texture properly.

5. Under the Velocity category. sel the

Min and P.l3lC values of the X. Y, and

Z components of

Sunveloci tyRange to ·100 and
100. respectively. You Should see

some spark.s be emitted from the

Eminer Actor. However, there are far
too few particles. so under the

General category. seT l.IaxParticles

to 2000. FIGURE 10.49 shows

the results.

6. To apply some gravity to the sparks.

go (0 the Acceleration category and

set the Z component of the

Acceleration properly to ·50 (see

FIGURE 10.50).

7. Under the Time category. set the
Mln and loIax values o(

L11etimeAange to 1 and 1.5.
respeclively. After setting these
properties, you'll notice a dramatic

Increase In the number of particles

FIGURE 10.48 PropertJes tor the new
Spa~Emltter.

FIGURE 10.49 The SparkEmitter shooting out
sparks.

FIGURE 1.0.50 Sparks are now influenced by
~gravi'ty."
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FIGURE 10.51 Decreasing the lifetime increased
the densrty of sparks.

FIGURE 10.53 Changing the focation shape
helps make the spark positions more random.

--'_.

being emitted (see FIGURE
10.51). By default, the emission
speed is determined by the number

of MaxParticles. so you always

have that number of particles

emitted.

8. You want your particles to have com
pletely random colors. Therefore, go

to the Color category and set the

ColorMult iplierRange property's

Min and Max values of the X, Y, and
Z components to 0 and 1, respec
tively (see FIGURE 10.52).

NOTE
Step 8 Involves cllanging 8 total of six
properties.

9. Right now the particles are snapping

out of existence abruptly. To fix this
problem, go to the Fading category
and set FadeOut to True and FIGURE 10.52 Randomly colored sparks.

FadeOutStartTime to 0.8- To give

the particles a bit more random

ness, go to the location category

and set StartLocationShape to
PTLS_Sphere. Now set the Min and
Max values of SphereAad lusRange
to 0 and 15, respect!ve1y. FIGURE
10.53 shows the results of these

senings.

10. Now that the effect is looking the
way you want it. you can attach it to

the SpriteEmitter. Save the map.

END TUTORIAL 10.8

Under the Collision category of every emitter type, you have access to a variety of properties for
controlling how your particles collide with other objects and how they react when;] collision
occurs. If you set UseCollision to True, your particles start to collide with objects in your map.

However, the properties of most interest arc the ones thac enable you to spawn particles upon col
lision with another object. By setting SpawnFromOtherEf1Ii t ter, you can specif~' an emiuer type
within your Emiller Actor rhat's called 00 to spawn particles every time' a wllision occurs. The
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number specified is an index to the current emitter_ The SpawnAmount property specifies the

number of particles to emit when a collision happens. Also, if you want to prevent the possibility

of too many collisions, you can use the MaxCollislons property and set a range of the maximum

number of collisions. If you sct the Min and Max values of this property to I, each particle can col
lide with something unly one time.

The ~mitter thilt'S called on does, however, need tu have a few properties set correctly. First, the

Automat iclnitialSpawning property under the Spawning category must be set to False. This set·

ting prevents the emitter from emitting particles before a collision happens. Second, the

RespawnDeadPart icles property under the Local category must be set to f.alsc so that particles that

are emitted aren't forced to respawn. In TUTORIAL 10.9, you take a look at colliding particles.

TUTORIAL 10.9: Making the Particles Respond to Collisions

10

1. Open Tutoriall0_09_Start. ut2. or use
the file you saved in TUTORIAL 10.8.

2. In the Properties window for the
ParticleEmitter. go to the Collision cate
gory and set SpawnFromOtherEmitter
to 1, which is your Spa rkEmltter, Set
S13awnAmount to 500. AlSO, set both
the Min and Max values of

MexCall ts lons to 1 so that only one
collISIon is allowed for each particle.
finally, set UseMaxCollisions and
UseCollision to True. At this point.
you can already see the particles
responding to the collisions. However.
particles are still being emitted
from the top of the launcher (see
FIGURE 10.54).

3. Under the properties for the
SparkEmitter. go to the Spawnmg

category and set
Automat iClni ti a lSpawning to False.

Under the Local category. set

AespawnDeadPart icles to False.

4. That's it-you now have a fully func
tional firework effect! FIGURE 10,55
shows the final result. Save the map.

END TUTORIAL 10.9

FIGURE 10.64 Sparks emitted trom collision
points and from the launcher.

FIGURE 10.55 The tlnal fireworks effect.
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MeshEmitter

The MeshEl'nillcr is Just an em..iuer Ihol cmi,s slatic meshts. The properties you've le:lrned :l!x'ul

(or other emincr types \Y()rk the same way (or [he Me-shEmilter. except til:!, propenies with three

dimeosions c.an be used 10 their full potential \";th the MeshEl))iucr. Und~r the Me-sh category.

you have a"'es.s to .all the McshEmirter·speciJic properties, dl2"scnbed in TA BLE 10.8.

TABLE 10.8 Mesh Category Properties

Property Description

Stauclolestl This pro~rry specifies the static mesh to be emined.

AenderTwoSlded Tllis property causes UMeal to render bolh sides of a static mesh. As

you learned in Chatper B. 'Creating Malerials in Unreal: rendering both

Sides is use(ul when dealing with partially transparent objects in which
both sides are viSible. However, thiS property is useful only If

UselAeshBlenQl.locle is sello False.

If set to True (Ihe default), the static mesh leeks like it does when you

simply place it in your map. If set to False, the static mesh's look

depends 011 the DrewStyle property under the TeJCt:ure category_

UseParticleColoi When this property is set to True. tl',e propenies set In the Color category
influence the color of the static meshes. However, this property is usefUl

only i1 the Usel.leshBlenQldode propef1y ,s set to Tr\.le.

[n TUTORIAL 10.10, you crt:.atc: a MeshEmine-r and use these properties to control the m~hl""s

you're emitting.

TUTORIAL 10.10: Creating a Conveyor Belt with Barrels
-'----------------------

1. Open TutorialI0_10_srart,ut2 (see
FIGURE 10.56).

2. The goal is to create an eminer behind the
gates thaI emits barrels moving along the

conveyor belt First. create an Emitter Actor

and add a MeshEmltter to it. and then place
the MeshEm/tter at one end of the conveyer

belt (see FIGURE 10.61).

3. WI'th the Static Mesh browser open, load

lhe Chapter 10_slll. usx package and select
Sarref. In the P,operUes window for the

MeshEmitter. go to lhe Mesh category. Click

the Use button for the Sut icJJesh pro~erty. The defaUlt size is a bit small. so under lhe

Size category, change the UnlTorillSize property to True to make sure you can scale the
static meshes uniformly. Nen, change the Min and Uali values of the x component of

St anSizeAange to 2, Chaflging this setting doubles the size of your static meshes,
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FIGURE 10.57 Top view showing where to place the emitter.

10

4. Under the Velocity calegory, set the

Min and lJal( values of the Y compo

nentof StartVelocityRange to -51.
This value should ensure that the

barrels move at apprOlCimfllely the

same speed as the conveyor belt
texture. Now's II good time to make

sure the barrels are resting rigl'lt on
the surface o( the cOlweyor belt.

5. Now you need 10 make the barrels
lNi~ IMg€r. Under the Time t.ategory,

Change bolh the Min and Max values
of li f Po CilieRange to 25. FIGURE

10,58 shows t~e results.

6. To give the barrels some varIation
in position, go to the Location

category. and make sure

StartlocationShape is set to

PTlS 80x. Now set the Min and Max

values of the X component of

StanLocationAange to ·70 and

70, respectively. FIGURE 10.69

shows the results of these sellings.

7. That's it! Save the map.

END TUTORIAL 10.10

FIGURE 10.58 Ballels movlng all the way to the
end of the conveyor belt In a straight line.

FIGURE 10.59 Barrels moving along the
conveyor belt



BaamEmitter 389

BeamEmitter
With the BeamEmitter, you can aeate such effects as lightning. This emitter works by stretching

a texture from onc point to another. Most of the discussion about this emil\er typO' centers on

determining these two points. However, you can also divide your texture into multiple segments

so that you can apply some noise to its overall shJpe. This technique can be immensely Llseful

when you're trying to create a realistic lightning bolt tbat zigzags through the air. You can also

make your lightning bolt have multiple branches that shoot from the main branch, which can

make the lightning look more realistic

Under the Beam category, you h(!ve access to all the properties you need to set to make your

BeamEmitter function properly. TABLE 10.9 explains the uses of these properties.

TABLE 10.9 Beam Category Properties

Property Description

Det er'm 1 neE ndPo lotBy

8eamTextureUScale

8eamlextureVScale

RotatingSheets

lrlggerEndpoint

This property controls how the end points are determined.

Use this property to determine how many times the texture is repli·
cated In the U, or horizontal. direction. The default sening is 1.

Use thiS property to determine how many times the texture IS repli·
cated in the V. or vertical. direction. Th~ default setting is L

This property determines how marlY 2D sprites (planes) are used to
represent each beam. Values 0, 1. and 2 all have the same effect of
using only one plane to represent a beam. Anytl,lng greater than 2 is

translated as the number of planes, Therefore, If you set thiS property
to 3, every beam is represented with three planes. FIGURE 10.60

shows how the rotated sheets work In·game.

When thiS property IS set to True and DetermineEndPointBy is set
to PTEP_Actor. every time a beam hits an Actor, that Actor's trigger

function is called. ThiS property is often used to trigger emitters.

Rl>la liog$"ee'5. 0 Rl>la loogSl>ee IS. 4

FlGU HE 10.60 This figure shows two sets of rotated sheets to illustrate how the Rot8tedShee t
property works.
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TABLE 10.10 describes the different options available for DetermineEl1dPointBy.

TABLE 10.10 DetermineEndPointBy Settings

Setting Description

,01 E.P_Velocity The endpoint is determined by taking the particle's velocity and

lifetime and calculating the direction and distance from the emit

ter_ This means St a rtRangeVe locl ty and Aeeel erat ion are

going to influence the endpoint's direction and distance.

PTE?_Distance The endpoint is calculated by using the particle's velocity to

determine the direction. The distance from the emitter is
specified by the BeamOistanceRange property.

PTEP_Offset This setting allows you to define an offset from the beam's start
point. To define this offset, you must populate 8eamEndPoint s
with at least one element. The Offset property in each element

defines the distance from the start point. You can even define a
range for the offset if you want a random offset. However, the

Weight property of this element must be greater than O.
Furthermore. you can have multiple elements in 6eamEndPoints

if you want to have varyirlg offsets to jump between, The Weight

property is then used to define the possibility of this offset

being used to calculate the endpoint. The possibility increases
as the number in Weight is increased.

PTEP_Actor The endpoint is calculated based on the position of certain
Actors. The elements of 8eamEndPoints have the ActorTag
property, which allows you to specify the tags of Actors you want

to use as targets. The Weight property has the same effect as

PTEP_Offset.

PTEP_TraceO-tf set This setting works much the same as PTEP_Of f set except that

instead of blindly going to the specified offset, it checks to see
whether it hits a solid surface. If it does, it uses the pOint of

impact as the endpoint.

Uf\llke PTEP_Offset, this setting uses the Offset as an

absolute position instead of a distance from the beam's start

point.

In TUTORIAL 10.11, you create a BeamEmitter and use the properties discussed in this section

to create a randomiy striking lightning effect.
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FIGURE 10.61 Ugtrtnlng bolts randomly striking
the four posts.

2. You're going to need a total of five

Emitter Actors: one on lhe ceiling

inside the orb and OI1e at each con

ductor. Start by creating one Emitter

Actor on \he ceiling and then create

anotl1er on one of tile conducrors

(see FIGURE 10.a2), After the

emirter 011 the cooduetor is set up

l)roperly. you'll duplicate iI over to

'he other three conductors.

3. In the ceiling emitter. add one
BeamEminer, Under me Beam cate
gory, change Deterllu.neEndPOlnt8y

to PTEP_Actor. Now )'ou need to

populate BealllEnclPOlnts, so add

Of"le elemen\ Into it.

1. Open Tutorial10_11_Start.ut2.

YOur goal is to create IIgh\ning thaI

goes (rom the large glass orb on

the ceiling to the four surround,ng

posts containing smaller orbs.

which are referred to as 'conduc

tors - In IhlS tutorial. This magical

lightning. no~ver, doesn't str,ke all

four posts at rhe same time;

instead. it random I)' strikes each

one (see FIGURE 10.81).

TUTORIAL 10.11: Creating Electric Belts

4. You neeO the tag for your deSlina

tlon Emitter Actor, so open lhe

Propenles winoow for your corxluc·

lOT emit1er. and go to the Events

category. Cnange ttle TaQ property

10 Conduct or1.

5. Back 'In the Properties window (or lhe

ceiling emitter, go to the Beam cate

gory. Change the ActorTag of the

first element in BeaJllE nclPoint S 10

ConductOi1. After ensuring thaI

Realtime Preview is enabled, you

should see a beam from Ihe ceiling to

the conductor (see FIGURE 1.0.63).

FIGURE 10,62 Two emitters crealed and put in
position.

FIGURE 1.0.63 Text.ure ~tretched from one
em itter to t1le othe r,
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e. Open the Texture orowser so lhal you can choose a more opj)(opriate lexlure (f)( yotJr light·

ning bolls. Open the Cnapt er r0. utx package and select the lightning texture. Back in the

8e.amEmilter Propertres window, go to Ihe Texture calegory and cllc\< the Use button next

10 lhe Te'llture property. See the results In FIGURE 10.64.

7. In \he Size category. change bolh the Min and Max values of StartS.l.zeRange to 50

(see FIGURE 10. (5).

10

8. Undef Ihe Gene ral category, Change

tJaxParticles to 3 so that you have

only \he bolls of lightning al arry one

time. Change lhe l.lin and !.lax values

of L i f e~ 1rleR~ nge ur-.der the Time

calegory to 0.1 and 0.2. respectively.

B~use Ilgh1n1ng bolts slrlke QUICkly.

they SllOUld have very ShOrl lives.

9. The [Inal area you need to fix rS the

lacS< of v8natlOO In the hgtl\nlng bolls.

RIght now. each boll of hgh\l\ing 15 per·
feclty straighl, b<1l yoo can easily fix

lhis by adding beam noise. Yoo can

add IwO kinds of noise: high frequency
and low freqt.Jency. They wor!< togelher

to creale the final etfect. Hlgt\ fre

Quency nOISe creates ttle little details

aM bends In t\)e beam's curve. and

low freQu~ncy noise changes lhe

beam's IWerall flow more subl/y. For

eac.h noise. specify the oomOer of

divisioos f)( frequency POll'lts.

Under Ihe BeamNoise category.

change HiQhfrequencyf'oints 106.

Set 'he Min and J.ll'\'lI values of the X.

Y, and Z components of

HighFrequencyN61seRange to ·10
and 10, respectIVely. Now change

lowfreqllencyPolnts to 3. Finally.

set ihe l.ll n and \,lax val ues of all

compOnents of

lowF reQoellcyNo iseR anQe to .5()

and SO. respeclively. FIGURE

10.66 shows Ihe rlnal effect.

10. Save lhe map.

END TUTORIAL 10.1

FIGURE 10.e4 Ughlning bolt strelche<l from one
emitter to the other.

FIGURE 10.6S Thinner lightning bolt

FIGURE 10.66 Each IIgJltnlng bolt has noise
applied to it
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FI QURE 10.87 Large flares shooting out of the
conductor.

Under the Loc.a.\ category is the AespawnOeadParticles properly. \ivlle.n this property is set to

True, II particle dies aod is Ihen spawned again. However, if this propt'rty is set to False, particles

are spawned unlil ~axi'a rt lC19S is reached, and aMer !.hose p.Olrlicles die, lhey arLo'r spawned

again. Tnerdore, Lhe emitter is dead until a resct occur:;.

By default, part ,des aren't rueL However, if you SCi AutoRese t to True, the emitter re.~e!.5 after il

dies. This c.auses particles to spawn UIltiJ reaching MaxParticLes; then they die- and the emitltr

is restl. n,is cycle repezts indefinitely. l( you wanl 10 add a delay between resets, you can use

AutoFlesetTlflleRange. You can even sel a range for Ibis property If you want a random delay

Ixfore resets. In TUTORIAL 10.12, )'OLl use these properties to finalize your lightnlng effect.

TUTORIAL 10.12: Finishing the lightning

1. Open Tutorial10_l2_Start. ut 2. or U!'>e the {lie you saved In TUTORIAL 10.11.

2. In lhe Properties WIndOw (or (he BeamEminer, go to the Local calegory. Set

FlespawnDeadPartlcles 10 False and AutoReset to True. NelCl. change the !.lln and Max

values of AutoResetT il1eRange 10 0.5 and 3. respec(lvely, to produce the delay between

strikes that you're rooking for.

a. Evecy Ome a lightning bolt strikes a conductor, you want some sparks emitted from rhe

conduc1ors, To do this. you have the Tr iggerEndpOlnt property However. you have to run

the map 10 see an eminer get tnggered. Ttlerefore. you'll create the effect first. aM then

set the properties for it to be tnggered. In \he Properties window for tM conductor emitter.

add a SprileEmitl.er.

4. In the Texture browser. select the Rare teX1ure from the Chapt er10. utx texture package

Under I he Text ure catego/y for (he Sp"teEm/tler, click the Use buttoo on the Text ure

property.

5. Under the VelOCIty Cdtegory, sel Ihe

lot 1 n and Max values In the X and Y

components of

S13 rtVe loc i tyR2.flQe to ·150 and
1S<), respectively, Then set the Min

and I.lax values In Z of

StartVelocityRange to 50 and

100, respeclively. These sett Ings
cause your paniCles to be scanere<l
out and up (see FIGURE 10.87).

8. In the Size c.ategory, set the l.Iin

and Max values cf the X component

of the StartSizeRange property 10

i() and 20. respectively (see

FIGURE 10,68\,
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7. To add some gravity. go 10 the

AccelerallOn category and set the Z
component of Acceleration 10 ·300.

8. Under the General category, lI'\Crease

!.IaxF'art 1 c les to 100. Also. In the
Time category, change the Min and

"'a l( valueS of L 1 fat ilteRange 10 1

and 1.2. respectively. FIGURE

10.69 ~how", the result!> of these

settings.

9. Ne~t. under tM Fading category. set

Fadel" to True, Change FIGURE 10.68 Small flares shOC>ting from the
Fllde [nEndTi me to 0.2, set fad eOut to conductor.
True. and change FaoeOu t StartTime
to 0.7 (see AGURE 10.70).

10. The effeCt now lOOks the WfroI you want
II. so you Just need [0 set the proper-

lies to make it react to the lightning.

To lhls end. you have the Trigger cate-
gory. Sel the r,. LggerOisabled prop.

erty to False to effectively make thiS
emitter triggerable. at'ld change
ResetOnTrigger to True. To prevent

the emllter (rom emintng partICles

inf1.lally. change
AutO.BticlnitialSpawning under

the Spawning calego'Y to False. Also. FIGURE 10.69 Large number of flares shooting
sel !nltlalPartlclesF'erSecOfI<1lo from a ().)nductor.

1000. Because yoo have
lJaxParticles sel to 100, It W111 take

0.1 seconds (Of ell partICles to be

emined. Finally. set
AespawnOeadParticles unde/lhe

Local calegO'Y '0 False. With these
senings. ,he particles will no longer

emil conslanlly. so 10 lest II. you have
10 change some property of the

$prileEmlner fOI the emlner to reset.

11. To make this work. go '0 the

10 BeamEminer's prQi)elties and set

TI" iggerEndpoint under lJ\e Beam

catego'Y to True. However. as mer;. FIGURE 10.70 Flares fade In and out smoothly.
lioned before. you can see lhls Ilol0'1<

only If yOu run the map.
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12. Finally, dup'icate the conductor emitter to the other three conductors. However, you need
to change the Tag properties of the other three emitters to Cooductor2. Conductor3, and
Conductor4. Also, add three more elements to BeamEndPoints and change the ActorTag

of each element 10 one of the conductors. Finally, set the Weight property of the elements

to 1 so that each conductor has an equal opportunity to receive a lightning strike (see
FIGURE 10.71). You can see the final effect in FIGURE 10.72.

FIGURE 10.71 The BeamEndPOln ts property of the BeamEmitter.

FI GURE 10.72 The final lightn ing effect.

END TUTORIAL 10.12
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TrailEmitter
The TrailEmitter;s a handy tooJ when you're trying to uC<'le ~uch effects.33 laser Ir.lils (or a S4::i

fi proton torpedo. Tra,IEmirlers are used more commonly in UllrealS<:ript than directly imple
mented in maps. The traiJ'slength is primarily influenced by the speed at which thc Eminer Actor
is moving. For t]le Tra.ilEmitler to work correctly, it must be andlhed 10 something thai mOves.

Othenvise. you won't be able 10 see a trail of any IOnd. To do this, you altach the emitlcr to a
Mover.

Under the Trail category o( the emiller, you have access 10 a number o( important propuries.
described in TABLE 10.11.

TABLE 10.11 Trail Category Properties

Properry Description

10

Ois.anceThreShold

uaxPointsPerTrail

MaxTrailTwistAngle

PointlifeTlme

Tr ai llocat ion

TrallShadeType

UseCrossedSheets

Th,s property determines the distance between each trail segment.

The property specifies the ma~imum number of points on a trait.

This property determines how the trail faces the c&mem. If It's $et to

the default of 16535. the trail points more toward the camera. As

values start (0 deViate from this defaUlt wlue. the trail starts to point

away from the camera.

This property determines how long the poinlS lille. It's used only

when Tra ilShaaelype 1$ set (0 PTTSTJ'o lntlHe.

This property determines how the tUlil 1$ calculated. However, only

the PTTL_Followl:1rI1tter OPli()(l is currenUy functional. so always

use this setting for the Traillocation property.

This property determines how the tr:ail is going to fade out. These are

Ule settings you can use:

PTTST_None-No fading
PTTST_RandOlllSt a t ie-Not Implemented

P1TST_Randol10ynanac-Randomly (ade in al'1d out

PTTST_llllear-Fade out bas.ed on ;lumber of points In e'l,lstence

ane lotal number of points.

PTTST_PO.lntl.l fa-Fade out IS based on POlntLJ. fe Time.

1/ this property 1$ set to True. the trail is composed of two perpendic·

ularly inlersectmg pla,\es Instead of the default single plane.
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TUTORIAL 10.13: Using the Trail Emitter

1. Open TutonBl10_12_Start. ut2, which is a simple room with a Mover that moves

around the four corners.

7. You now have a working TrailEmltter, shown in FIGURE 10.78. Save the map.

6. To make the trail fade from blue to yellow over its lifetime, m the Color category, set

UseColorScale to True. Add two items to ColorScale. Set the flfsl item's Color to blue

and Its RelatlveTime to O. Set the second item's Color to yellOW and its FlelatlveTime

to 1 (see FIGURE 10.75).

FIGURE 10.74 Moving the emitter in the
Perspective view.

5, Under the Size category, set both

the Min and Max values In the X
component of StartSizeRange to

5. At this point, you should be

able to see some fairly good
results when you run the level. To

test the emitter in UnrealEd,

make sure Realtime Preview is
enabled, and start moving the

Emitter Actor in the Perspective
view (see FIQURE 10.74).

2. Create an Emitter Actor and place it at the Mover's location. Because you want the Emitter

to move With this Mover, you need to change the AttachTag property of the Em:tter Actor
to the Mover's Tag property. In the Properties window for the Emitter. go to the Movement

category. Change AttachTag to trailMover, which IS the tag of the Mover.

3, Add ~ TrilllEmltler 10 the Emitter ActOr. Open the Texture browser, load the Chapt er10. utx

texture package, and select the SoftFlare texture. Back in the Properties window for the

TrailEmitter, go to the Texture category and click the Use button for the Text ure property,

4. Under the Trail category for the TraiIEmi~er. set TrailLocation to PTTLJOllowEfl1it t er

to flnsure that the trail is generated in relation to the emitter's speed and location. Set

UseCrossedSheets to True so that the trails are composed of two planes. Also, change
MaxPolntsPerTrail to 500 so that the trails have a high amount of detail. To make the

trails fade off, set Tra i.JShadeType under the Trail category to PTTST PointLlf e. Now

set PointLi feTime to 2, whiCh

gives each point a lifetime of two

seconds.
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FIQU RE 10.75 The Color category of the TrailEmitter.

FIGURE 10.76 The TrailEmitter in action.

END TUTORIAL 10.13
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Summary
At this point, you should have a good grasp of how to crea te a variety of particle effects in your

levels. These concepts also extend into the realm of UnreaJScript programming and can be used

for such effects as projectile trails for your weapo I)S. Also, with these fundamental rules, you

should now be able to create your own new and interesting effects to add a heightened level of

realism to your levels. Chapter 11, "The Karma Physics Engine," introduces you to the Karma

physics engine and how it can be used to push your level's realism even further by including reac

tions and animations based on the real laws of physics.





Chapter

The Karma Physics
Engine

In this chapter. you learn how to create animations in Unreal that
are based on the laws of physics. Such animations are often called

dynamic snnulations, meaning thaI they're driven by outside forces
such as gravity, wind, or the force of an explosion. Apart from the

many other features of the Unreal engine discussed in previous

chapters, the Unreal engine also colltains a powerful physics engine
that makes it possible for animiltions such as bouncing objects or
complex coUisions to be calculated in real time.

Instead of creating a physics engine from scratch, however, Epic

Games utilizes a third-party physics solution known as Karma. The
now defunct MarhEngine company created this versatiJe engine,
which was implemented into the exiMing Unreal engine. Aside from
the basic real-world physics of collisions with objects, it also imple

ments Ragdol/s, which make realistic death sequences possible.
Ragdolh are characters whose animation is driven entirely by the
physics engine, allowing their joints to flex realistically as they fall,
tumble, and so on. Ragdolls alone were a huge step in the evolution

of game engines because they made unrealistic and repetitive ani
mated death sequences a thing of the past.
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The use~ of the Karma engine extend to weapon projectiles and objects in your scene that react

to physical forces, such as gravity, explosions, and collisions with other Karma objects. However,

many aspects of the Karma engine are useful only when you delve into the programming world

of UnrealScript. Because this book doesn't venture into the programming side of the Unreal

Engine, you'll learn ways you can take advantage of the Karma engine without programming.

First, you'll explore using simple Karma objects in UnrealEd and how to create these objects with

external 3D packages, such as Maya. Then you see how to set up a character to work effeclively as

a Ragdol!. This topic leads to the introduction of the Karma Authoring Tool, commonly known

as KAT, and how to use it to l"\>leak a Ragdoll's effects.

First, however, you need a brief discussion on precisely where you can use these Karma effects. The

Karma effects mentioned thus far would work perfectly well in a single-player game. However, if you

were to create, say, a rope bridge that Karma controls, it wouldn't act as yOIl would expect in a mul

tiplayer game. On the server, all the Karma effects would act normally, but the clients wouldn't

receive information about how the bridge should react to explosions, projectiles, and so forth. When

playing on a client computer, the bridge wouldn't move at all. RagdoH effects, however, such as death

animations, work fine because they are calculated separately on each client machine, meaning the

same death sequence varies on each client. The process of sending information from the server to

the client is known as replication. It's possible for the rope bridge to work on a multiplayer map; how

ever, it would require significant changes tu the replication code in lhe Unreal engine. Bel3use that

topic gues far beyond the scope of this book, iI's not covered here. V\'hen applying the information

in this chapter to your own levels, be wary of where Karma effects can and cannot be used effectively.

Karma Theory
This section explores the basic ways to take advantage of the Karma engine from within UnrealEd.

The key to accessing the Karma engine in UnrealEd is a special type of Actor: the KActor. This

Actor and its subclasses are used to make objects react dynamically with the environment. The

fundamental difference between this Actor and the other Actors you've used previously is that

under the Movement category of its properties, the Physics properlY is set to PHYS_Karma. This

setting passes control of the object's movement to the Karma physics engine.

How the object reacts, however, is determined by the KParams property found under the Karma

category in lhe object's Properties window. Physical properties such as mass, buoyancy, and fric

tion can be adjusted. Because of lht' many properties available, this entire section has been dedi

cated to discussing thelll.

So how does a Karma Actor know which parts of the environment it can interact with? The

bBlockKarma property, which is inherent to all placeable Actors, enables level designers to control the

surfaces that can affect a Karma Actor. Many Actors, such as static meshes and 81ockingVolumes,

have this property set to True by default, meaning that Karma Actors collide with lheir surfaces.
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To begin, TUTORIAL 11.1 leads you through constructing a level that shows how to create a

simple Karma Actor.

TUTORIAL 11.1: Creating a Simple Karma Actor

1. Open Tutoriall1_01_StarLut2,

2, In the Static Mesh browser, open the Chapter 11 . usx package. Under the Karma group,
select Barrel.

In the Properties window under the static mesh viewport. the only prooerty influencing
Karma is UseSimpleKarmaColllsion. This propertY determines the behaVior of non-Karma
objects that come into contact with Karma Actors. To be more precise. this property allows
Karma to use a static mesh's collision model to calculate collisions. If set to True and the
static mesh has a collision model, that collision model is converted and used to calculate
the collision of Karma objects
against this static meSh. If this prop
erty IS True and the stattc mesh
doesn't have a collision modl:ll,

Karma objects don't collide wIth this
static mesh al all. finally, If this
property IS set to False, Karma
objects collide directly with the static
mesh's triangles, Be careful to use
this option only if the static mesh
consists of large triangles. If the
mesh is composed of many small tri
angles, it's much harder (ann, there-

fore, slower) for the computer to FIGURE 11.1 Karma barrel added into the level.
calculate collisions With the surface.

NOTE
If you need access to the Rocket Lau ncher, bring
down the console with the - (tilde) key, and enter
loaded. This cheal code gives you all weapons and
fu II adrena Ii ne.

3, Right-click in the level. and choose
Add Karma Actor from the context
menu to place the Karma barrel in
the level (see FIGURE 11.1).

4. When you run the map. notice that
the barrel hangs in the air. By
default, Karma Actors are disabled at the start of a level. To enable them, you must
apply a dynamic force to the object. A simple solution is Just shooting the barrel with
some sort of weapon. Unfortunately, the Assault Rifle doesn't have enough power to
activate the Karma Actor on Its own, so you need to use a more powerful gun. such as
the Rocket Launcher. When you hit the barrel with enough force. it comes alive and falls
to the ground realistically.
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5. If you want the barrel to fall the
moment the level starts, go to the
object's Properties wmdow. Under
the Karma category, expand the
KParams property, and expand
KarmaParams myLevel.
KarmaParams9. Under KarmaParams
is the KStar IEnabled property. As
the name suggests. this property
determines whether the Karma Actor
IS enabled the moment the level
starts. By default, this property IS

set to False, which means you have
to shoot the Actor to enable it. Set
this property to True, as shown In

FIGURE 11.2.

6. Save and test the map. Notice that
the Karma barrel starts reacting
before you even begin playing the
level.

END TUTORIAL 11,1
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FIGURE 11.2 KStartEnabled property ot the
Karma barrel.

General Karma Properties

Now that you know how to go about creating Karma Actors. you need to know what properties
are available to control them. The KI-'arams property can be set to one of these four property

groups: KarmaParams, KarmaParamsCollision, KarmaParamsSke 1, and KarmaPararnsRBFull.

TABLE 11.1 lists the properties available in each group and describes whM each properlY does.

TABLE 11.1 Karma Properties

Property

KarmaParams

bDestroyOnWorldPenetrate

bDoSafetime

Description

When this property IS set to True. if
the center of the Karma object
prisses through the world. the object

is destroyed.

If this propp-rty is True. the Karma
engine does extra checks to avoid
objects passing through the world.

Default

False

false



TABLE 11.1 Continued

Property

bHighOetailOnly

bKAllowAotate

bKOoubleTickAate

bKNonSphericalInertia

bKStayUpright
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Description Default

When this property is set to True, the False

Karma Actor doesn't react with
anything in the level unless the game

settings are set to a high detail level.

This property, when set to True, allows False

the Karma Actor to rotate around the
Z-axis. This property is relevant only

when KStayUpright is set to True.

When this property IS set to True, the False

Karma Actor is updated twice as many

times, which improves the simulation's

accuracy. However, two objects with
different tick rates might not collide

because of the differences in accuracy.

By default, a Karma Actor uses a False
spherical inerria tensor, which is simply

an approximation of an object's mass
distribution. (For a description of an

inertia tensor, see the explanation of the
KlnertiaTensor property at the end of

this table.) If this property is set to True,

the Karma Actor uses a non-spherical
inertia tensor that more accurately simu-

lates an object's inertia. Consequently,
however, the calculation is slower. When

using KarmaParamsRBFull, the values in
KlnertiaTensor are used. If not, the

object's collision hulls are used to calcu-
late an inertia tensor. A collision huJl is

an invisible shell of simple geometry

that surrounds an object and is used for
collision detection.

When this property is set to True, the False

Karma Actor tries to maintain its upright

orientation. The StayUprightSt iff nes 5

and StayUprightDamping properties
(see their entries later in this table) con-

tribute to how this property is calculated.
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TABLE 11.1 Continued

Property

KActorGravScale

KAngularDamping

KBLJoyancy

KLinearDamplng

KMass

KMaxAngularSpeed

Descriptlon

This property is <I gravity multiplier for
the Karma Actor. It can be used, for
example, if you want to make certain
objects fall faster than others. Be care·
ful, however, because a value higher
than 1 might cause the Karma Actor to

fall through the world geometry.

Tnis property sets the amount of (orce
that's applied to decrease the Karma
Actor's angular motion, which results In

rotational drag. The higher the value, the
more the Actor resists rotation.

With thIS property, you can determine
how well the Karma Actor floats In a
WaterVolume. The default value of 0
means that the object completely ignores
the existence of water. A value of 1

causes the Actor to float in the water
unW it comes to rest. If you want the
object to actually float toward the waler's
surface, you need to sel this property 10

a value higher than 1. However, the value
doesn't need to be much higher than 1
for noticeable differences.

Much like KAngularDampwg, this
property determines the force causing
translational drag, or a resistance to
Imear movement. The higher the number.
the more drag IS applied to the move
ment (not rotation) of the Karma Actor.

ThiS property is used as a multiplier for
the mass of a Karma Actor. This mass
IS relative to the volume of an object's
Karma Primitives. Just keep in mmd,
however, that thiS property does not

determme a Karma Actor's ~bsolute

mass.

This property sets the maximum amount
of angular, or rotational, speed that a
Karma Actor can achieve.

Default

1.0

0.2

0.0

0.0

1.0

10,0
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Property

KMaxSpeed

KStartAngVel

KStartEnabled

KStartLinVel

KVelDropBelowThreshold

Repulsors

StayUprightStiffness

Description

This property sets the maximum

amount of linear (translational) speed
that a Karma Actor can achieve.

When the Karma Actor is first triggered,

it rotates in the direction specified in

these three fields. which mdicate
rotation in the X-. Y-. and Z-axes.

When th is property is set to True, the

Karma Actor starts simulating as

soon as it spawns into the level.

As with KStartAngVel, this property
determines the amount of linear

translatIOn that's applied to the object
after It is triggered.

When the Karma Actor drops below
the specified speed, a function (that

a programmer writes) is called.

Because this function requires the use

of programmin.l2:, it's not discussed in
this book.

Because this property can be set only

in code, you can safely ignore it.

This property, which is relevant only
when bKStayUpright is set to True,

determines how a Karma Actor main
tains its upright orientation. Basically,

this property determines how quickly
an Actor returns to the upright position.

It works much the same way as a

spring. and the spring's stiffness
correlates quite well to the

StayUprightStiffness property.

Therefore, the higher

StayUprightStiffness is, the faster

the Karma object returns to the upright

orientation.

Karma Theory 407

Default

2500.0

<0,0,0>

False

<0.0,0>

1000000

none

50
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TABLE 11.1 Continued

Property

StayUprightDamping

KarmaParamsCoiilsion

KFrictioo

KImpactThreshold

KRestitution

Description

As with StayUprightSt 1 ff ness, this
property is useful only for Karma
Actors that have bKStayUpnght set
to True. StayUprightOamping works
directly with the
StayUpr ightSt iff ness property.
This property slows down the speed
at which an object returns to the
upright orientation_ The higher the
damping, the less the object wobbles
back and forth before coming to rest
in the center.

This property sets the amount of
resistance on the surface caused by
friction. Any value between 0 and 1
yields realistic results. However, values
outside that range might mean the
object never reaches a state of rest
or is always at rest. Therefore. a value
of 1 means full friction, and 0 means
no friction.

When a Karma Actor is affected by a
value higher than the value specified,
a function (that a programmer writes)
is called. Because this function
requires programming. It'S not
discussed in thiS book.

This property determines a Karma
Actor's amount of bounciness, A
setting of 0 meanS no bounce
whatsoever. When set to 1, the velo
city after impact is the same as the
moment of Impact, meaning the
object loses no energy when ricochet·
ing off olher surfaces and could
potentially bounce (orever.

Default

o

0.0

1000000

0.0



TABLE 11.1 Continued

Property

StayUprightDamping
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Description Default

As with StayUprightStiftness, this a
property is useful only for Karma

Actors that have bKStayUpright set

to True. StayUprightDamping works
directly with the StayUprightSt i ffness

property. This property slows down the
speed at which an object returns to

the upright orientation. The higher the

damping, the less the object wobbles

back and forth before coming to rest
in the center.

KarmaParamsSkel

bKOoCorwulsions

bAubbery

KConvulseSpacing

KSkeleton

KarmaParamsRBFul/

KCOMOffset

KlnertiaTensor

If this property is set to true, the

Ragdoll convulses at the interval set
in KConvulseSpacing.

This property causes the Ragdoll to
bend and flex at very extreme angles,

as though it were made of a rubbery
material.

This property specifies a range, in

seconds, between Min and Max during

which the Ragdoll convulses. USing the
default, the Ragdoll convulses every

.5 to 1.5 seconds.

This property specifies the KSke leton

to use when simulating a Ragdoll.

This property is discussed in more

detail in "Ragdolls," later in this chapter.

This property is used as an offset to

the Karma object's center of mass.

The inertia tensor describes how an

object's mass is distributed. Therefore,

modifying the values of this property
affects how a Karma object rotates in

response to an external force. Six

values are associated with this property.
However, only three are crucial: index [OJ,

index (3], and index [5]. All the other
fields (index [1], index [2], and index [4])

can be set to °and can usually be ignored.

0.0

1000000

<0.5,1.5>

<0,0,0>

[0.4]

[0.0)

[0.0]

[0.4]

[0.0]

[0.4]
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TABLE 11.1 Continued--_._._---------------------------------
Property

Karma Collision Primitives

Description Default,

Index (OJ controls how easy it is for the
object 10 roll. The higher the number,
the more the object resists rolling, This
number, however. doesn't completely
govern how an object resists rotation.
The KMass and DrawScale properties
directly influence how an object resists
motion of any kind, including rotation.
This calculation is done behind the
scenes. but it's still important to keep in
mmd when tweaking the mertia tensor.
In the same fashion as index (OJ controls
roll. mdex [31 controls pitch. and ifldex {5]

controls yaw.

The Kamld Collision Primitives are much the same as normal collision geometry except they deal

strictly with Karma. In other words, Karma collision geometry and the regular collision geome

try that blocks characters and projectiles arc two completely separate entities and must be treated

as such. Also, if a static mesh contains no Karma Collision Primitives, it can't be placed into the

level as a Karma Actor.

Typically, Karma Collision Primitives are imported along with the file containing the static mesh.

To do this, simply create a new object or a series of objects in your favorite 3D package. and add

one of the prefixes shown in TABLE 11.2 to the beginning of the object's name to specify the

Karma Collision Primitive type.

TABLE 11.2 Karma Collision Primitive Prefixes

Prefix Primitive Type

MCD8X Box Primitive

MCDSP Sphere Primitive

MCDCY Cylinder Primitive

MCDCX Convex Mesh Primitive
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When a static mesh is imported into UnrealEd, all objects that have any of the prefixes shown in

TABLE 11.2 at the beginning of the name are converted into a Karma Collision Primitive of the

specified type.

After a static mesh is imported, you have several commands you can use to modify the Karma

Collision Primitives in the Static Mesh browser. Under the Collision Tools menu is the Fit Karma

Primitive category. The first command, Sphere, simply places a Sphere primitive around the exist

ing object. If the object already has Karma coJlision geometry. you're asked if you want to replace

it. The Cylinder XIYIZ commands place a cylinder primitive around the current static mesh that

points in the specified axis. If you use the Cylinder Z command, for example, the cylinder stands

upright.

The Refresh Karma Primitives command converts the existing regular collision geometry to

Karma collision geometry. The Karma CoJlision Primitives, however, remain intact. The final

command available in the Static Mesh browser is Clear Karma Primitives, which removes all

Karma CoJJision Primitives.

Constraints

Sometimes creating simple Karma objects that interact with the level isn't enough to generate the

effect you want. To better control the behavior of Karma objects, you can use COrlSlraints, which

effectively restrict the effects of your Karma objects. For example, if yOLl want to create a lamp

connected to the ceiling by a series of chain links, you would have to constrain each chain link to

its neighboring link and then constrain the lamp to the bottommost chain link. Or perhaps you

want to create a door that's hinged on one side. You simply need to constrain the door object to

a specified hinge.

To this end, you have three constraint Actors: KBSJoint, KConeLimir, and KHinge. They are aU

subclasses of the aforementioned KActor and are used with Karma objects for extra control. You

can access them in the Actor Class browser under Actor> KActor > KConstraint. The following

sections cover these constraints and explain how to use them in your levels.

KBSJoint

The KSBJoint constraint is used to connect two Karma objects in much the same way that your

shoulder connects your arm to the rest of your body. Therefore, it's known as the ball-and-socket

joint-hence the name KBSJoint (Karma Ball Socket Joint). To use it, simply place the KBSJoint

between two Karma objects. and then set its properties to point to the two Karma objects. The

distance between the two Karma objects is maintained throughout the game. Also noteworthy [s

that Karma objects don't need to actually touch the KBSJoint Actor. In TUTORIAL 11.2, you use

the KBSJoint Actor to create a dynamically swinging lamp.
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FIGURE 11.3 Top view of where you'll put the
light system.

FIGURE 11.4 Perspective view of the newly
placed chain.

FIGURE 11.5 Both chains in position.

2. In the Static Mesh browser. open

the Chapter11 package, Under the
lIghtSystem group, select
ShortChain. You'll be us~ng this sta

tic mesh as the chain links. In the

top view, navigate to the southern

most room. where yoU'll be creating
the lamp (see FIGURE 11.3).

Right·click In the middle of this

room, and choose Add Karma Actor,

Move the chain so that the top of it
rests on the ceiling, as shown in

FIGURE 11.4.

4. All you need now for Karma objects

is the lamp. In the Static Mesh
browser, open the Chapterl1 pack·

age. Under the LightSystem group,
select Light. Again, right·click In the

viewport. and choose Add Karma
Actor. Move this newly created lamp

to the bottom of the chain (see

FIGURE 11.6),

1. Open Tutorialll_02_Start.
ut2. The goal of this tutonal is to
create a lamp that's connected to

the ceiling via a series of chain
links.

If YOu run the level now, the lamp
system would hang in midair until

you shot it with enough force to

start the S4mLllation, When it did

start reacting. however, it would just

fall to the ground. This is where con·
straints come into play, You'll need a

KBSJOlnt at each point where the

Karma objects meet. You'll also

3. With the chain still selected, press

Ctrl+W or choose Edit> Duplicate

from the menu. Now move this new
chain below the previous one so

that tile two chains create a straight

line (see FIGURE 11.5).

TUTORIAL 11.2: Creating a Lamp
11
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need one belweef'\ the ceiling af'\d

lhe firSl chain so that the entire

lamp systeln stays at1ached to the
ceiling. FIGURE 11. 7 showS you

where each KBSJoinl should be

placed.

S. First. open lhe Actor Class browser.

Expand Actor" KActo( >

KConstrainl, and click K8SJomt. Now
close the Actor Class browser, rigtll'

click near the lamp, and choose Add

KBSJolnt Here. Move II so that it
FIGURE 11.6 Ught added at the end of the

COMecls Ihe lop cr.am to the ceiling chain.
(see FIGURE H.B).

6. Duplicate the K8SJotrl't and move it
down so that It COflneCts the two
chains, as shown in FIGURE 11.9.

7. Finally, duplicate the KBSJoinl again

and move it so that it connects the

lamp to the boltom chain (see

F1GURE 11.10).

8. At ltIis point. you have everything

you need to get the dynamic lamp
system working property. All you
halle to do now IS set a few Simple
propertIes. Open the Properties win·

dow for the KBSJoint on the ceiling, FIGURE 11,7 The placement 01 KBSJolnt Actors.

and expand the KarmaConsrrainl

category. The only (Wo properties

you need to be concerned with are
I(Constrain tAc torl and

I(ConstraintActor2.

KConstraintACtcrl is connected
(constramed) to

KCons tra i ntActor2. Because you

want the chain to be connected 10

the ceiling. or world, yOU simply set

Keons t r alntAc tor 1 to the cha in

attached to ltIe ceiling and leave

KConstraintACtor2 set to None.

FIGURE 11.11 illustrates the FIGURE 11.8 Position of the topmost KBSJoiot.
constraint rela\lonships.
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FIGURE 11..9 Position of the middle KBSJoint.

NOTE
It your first click catches an object that Isn't

right, simply 100m in closer to the object and try
again. When you'~e done it correC1ly, the prop

erty should contain the name of the chain Iin k.

(This name ~aries depending on how you

created the chain links.)

9. To set KConsrraintActorl to the

chain, select the

KCons r raintActor I property and

click Find. DOing this changes the

mouse pointer to a crosshalr anci

quesllon mark. In the Perspective

viewport, zoom In on the chain and

click it.

10. Open the Properties Window for the

next KBSJoint. Under Ihe
KarmaConstraint category, set the

KeonSHa intActor1 property to the

chain above the KBSJOlnt. Set

Keenst ra i ntAc ter2 to the chain

right below the KBSJoint.

11. Finally, select the final KBSJomt that

connects the lamp to the chain and
open its Properties Window, Again, FIGURE 11.10 Position of the bottom KBSJoint.

under the KarmaCor,stramt category.

set the KConstralntActorl
property 10 the chalO above the

KBSJoint. Now set

Keons t raintAc tor2 to the lamp.

12. ThaI's it! If everything was done cor

rectly, you should now have a fUlly

working lelmp system. Save the map

as LightSystem_Complete. ut2.

11

END TUTORIAL 11.2

FIGURE 11.11 The relationship between the
KBSJoints and chains.



lkSldes Ihe KConstraintActorf and

I<Const raintActor2 properties akeady dis·
cussed, you have a few altler less used,
but sriU helpful, propenies. TABLE 11,3

describes cach o( Lhem.

TABLE: 11.3 KBSJoint Properties
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NOTE
tI you play the game and the lamp system stays
completely stagnant you might need to go Into the
properties of the three Karma Actors and set

bHighOetadOnly to False.

Property Description Default

bKDisableCollision

KCon str'aint8one I

Keon str 31n t aone 2

KForceThresnold

KConeUmit

When this property is set to True. colliSIon

between the two cOflnected Karma objects
(s disabled.

ThiS property specifies the exact skeletal

mesh Done in !(ConstraintActorl to

constraIn to.

Th:s property specifies the exact skeletal

mesh bone in KConstraintActor2 to

constrain to.

When the force within the constrBlnl jOint

reaches the amount specified by thiS

propertY. the K.ForceExceed UnrealSCript
function IS called. ThiS function IS unused
with the current (OOIS and IS In place so

th<lt programmers can create constraintS

with new behaVior.

True

None

None

0.0

KConelimit is an Actor thaI complemenLS existing joints. 11 aUows you to limit lhe amount o(

rotation between two Acton in a cone sh.ape. For elC;lmple, say you wanted to make the swinging

light you created in TUTORIAL 11.2 unable 10 swing high en6ugh 10 louch the ceiling. The

KConelimit Actor makes this entirely possible. In TUTORIAL 11.3, you adjusl lh~ lamp system

by implementmg this Actor.

TUTORIAL 11.3: Modifying the Lamp System

1. Open LightSYStem_COllplete.ut2 that you saved In TUTORIAL 11.2, or open
Tutor ial , 1_o3_5 tart. ut2 (re>m the Chapter 11 folder on Ihe CD.

2. In the ACtor Class browser, navlgbte to Actor> KAct6r > KC6nStralnl, and click KC6nellmil.
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I<CooeUmit placed next to theFIGURE 11.12
light system.

4. The re" arrow extending out of the

KConeLlmlt Actor points dowl'I the )(.

aXIs. This arrow determines around

whIch axis ro\Ction is limited. In this

c.a!>e • .'Ill rotal'lon revOlves around

the Z,.axi~. Therefore. you need \0

rotate the KConeLJmit so that it poit\ts down the Z·axls. Wlth the KConeLimit Actor still

selected, hold down the CUI key, right-elick, and drag in the FIOM viewport until the arrow

pomts down me Z-axis (see FIGURE 11..13J.

3. Right-click in the level near the

lamp, and choose Add KConeLlmit
Here. lhe exact 10000tion of this

Actor Isn't particularly important

because only lIS rOl.aLion is used.
However, movins:l it near the Actors it

Will be affecting, as shown in

FIGURE 11.12. IS a good practice.

11

FIGURE 11.13 KConeLimit pointing down the Z-axis.

5. Now it's simply a matter of Clloosing which Acto's you want to limit. As with KBSJoint. you

have the KConstraintActorl and KConstraintA.ctor2 properties. If you specifIed the tOD

chain as KConstraultActorl and lett KCOflHraintActor2 blank. KConeLimil would sim

ply De limited III rel,Hlon to the world by the amount specified In KHal f Angle. If you set

I<HalfAngle to 0, the chain would always lry lo stay perieclly straight. FIGURE 11.14

illustrates the relaLionship between KConeUmlt and the cham.
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7. You can experiment with these settings and see a V8nety of results. Keep in mmd that

KHalfAngle is measured in Unreal angles, so 65535 is equal to 360 degrees.

KConeL'mit

KConslra,nlAclor I
KCo~Slra InlAclor2
KHaliAngle

FIGURE 11.15 How to make both
chains constrained to each other.

KConoL,m'l

KConslra,nlAClor1
KConslra,ntAClo,2
KHalfAngle

6. If. however, you specified the lop chain as KConstraintActor: and the second cham as

KConstraintActor2, the second chain is limited so thaI the angle between

KConstraintActor1 and KConstraintActor2 conforms to the angle specified in
KHalfAngle (see FIGURE 11.1.5).

FIGURE 11.14 The relationship
between KConelimit and the chain.

END TUTORIAL 11.3

Aside from the KHalfAngle property, you also have KStiffness and KDampl.ng. TABLE 11.4

describes these properties and their default values.

TABLE 11.4 KSti ffness and KDamping Properties

Property Description Default

KStiffness

KDamping

This property determines how firmly the limit

IS enforced. As the number gets higher, the force

that resists the motion of the KBSJOlnt becomes

stiffer. This property can be thought of as similar
to the stiffness of a spring.

This property slows the speed at which the limit
IS enforced.

50.0

0.0
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KHinge

The KHinge constr;unt is much lIle ~me as u)t' K8$lolnt constrain!, e~cepl it works more like ~

door hinge, constT:Ji..J\ing rotation to only one axis. As with KI3Sfoint, you have the option of spec

ifying two Kanna Actors to constrain, if you s~cifyonly one Karma Actor, that one Actor is going

10 be constrainerl to the world. Unlike tJlt' KBS/oint, however, the KHi nge has fou r differen I

modes (K.f-ljJ\g~Types) thai .llter its behavior. Dependi ng 011 the mode you select, the other prop

enie-.; beh;?ve differently. TABLE 11.5 desCTlbes the four modes.

TABLE 11.5 KHlngeType Modes

I<HlngeType Description ._."_".__"

Hl_Nor.al n'IS mode cause~ the constr~int to act like (l baSIC hinge, constraining

tne object to the w()fld 0' \0 the specified Kurma Actor.

liT_Spr ingy In this mode. the hInge acts like a spring while trying to achieve a given

angle.

nT_Motor rhls mode causes the hinge to aclilke a motor. Therefore, the con

StfalT\M obl~ct mtates around the specified axIS at tl1e specified speed.

HT_Controlled This mode acts much like HTJ~otor except that it tries to achieve Ihe

specified angle and then stops when It does.
--------------

You Cdn also lrigger KHinges much as you do Movers. Under tne Objecl category of the KHinge

properties is the InitialState property, which give., you access to four differenl modes. TABLE

11. 8 describes each of them.

TABLE 11.6 InitialState Modes

Initial$tate Mode Description

ToggleUotol'" If the KHingeType IS not already HT_Motor, the trigger changes it 10

HT_I.totor. Otherwise, the trigger changes the KHingeType to
HT_Controlled and changes KOr:slredAngle 10 the current angle. This

causes the motor to come 10 a StOp.

C<)ntroll.lQtor A trigger turns the motor on, and an unlrigger lums Ihe mOlor off. An

'vnuigger" can be thought of as an automatic off switch for particular
triggers. Some triggers. such as simple proximity-based triggers. can be

said to be -triggered- when a player enlers their defined prOXimity, and

then 'untriggered" when the character leaves that proxlmiry. The

Controll.lotor mode wolil.s the same as ToogleMotor except that it
responds to trigger and untngger events instead of simply inverting the

state.
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TABLE 11.6 Continued

In itia1State Mode Descrl pti on

ToggleDesired This mode toggles the hinge between using KDesiredAngle and
KAl tDesiredAngle. Because it doesn't change the hinge type, this
mode is useful only when dealing with HT_Cont rolled and
HT_Springy.

Cont rolDes ired A trigger causes the hinge to use KAltDeSl.l'edAngle. and ~n untrigger
causes the hinge to use KDesiredAngle. As with the ToggleDesired
mode, this mode is relevant only when the type is l'IT_Controlled or
HT_Springy.

Because the HT_Normal hinge type works as a basic hingf, you'll use it in TUTORIAL 11.4 to see

how 10 crt:ale a dynamic bridge.

TUTORIAL 11.4: Creating a Dynamic Bridge

1. Open Tutorlall'_04_Start.ut2.

2. Go into the lorge room with the fan,
where you'll notIce that you already
have a bridge in place (see
FIGURE 11.18).

3. At this point. running the level and
shooting the bridge would cause the

bnoge to simply collapse. Instead,
you want the parts of the bridge to
be connected by using a series of
KHinge constraints. In the Actor
Class browser, expand Actor>
KAetor > KConstramt and click
KHinge.

4. Right-click in the level. and choose
Add KHinge Here. Move the KHinge
to the place where the bridge and
wall connect. Also, be sure that the
arrow for the KHinge is pointing
toward the pipes against the corner
of the wall (see FIGURE 11.17).

5. With the KHinge selected, duplicate
It and move it to the point where the
next two Karma Actors meet.
Continue duplicating until you reach

FIGURE 11.16 Room with the bridge.

FIGURE 11.17 First KHlnge Actor in place.
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All the KHlnge Actors In pl&ce.FIGURE 11.18

the other side of the bndge.
FIGURE 11.19 show the final

resull.

6. Now you just need to set the rela

ltonshil) between the constraints

and the bTtdge pieces. Open the
Properties window (01 the firSt con

straint cleated. Under (he

KarmaConstr3111t category. se~ct

the Keons I ra11\ cACIorl properlY.

Click the Fl1'\d bunon and select the

bndge segment nearest the

KCons~rajlll Actor. For the secofKl
KHlnge. set KConstralntACtorl to {he first bridge piece 6fld KConstraintActor210 the

seCOM bt:<lge lliece. Conllnue In this manner, wilt! KConstralfltAetor f being Ihe KarMa

AClor 10 the left or the cOrLSlIaint and KConsrraintActor2 being [he Karma Actor \0 the

flghl of \he cons\ta Inl. F<lr the ta 5[ KH Inge. set KCon s t r a intAct 0r 1 to the last bridge
piece. Use FIGURE 11.19 as a guide.

11

FIGURE 11.1.9 The relationship between the ple~ of the brfdge.

7. You should now have a completely functional btldge thaI reacts to outside forces such as

projectiles. Save and (un the map.

END TUTORIAL 11.4



Constraints 421

As you can sec, the KHinge constraint can be extremely useful. However, this tutorial showed only

one of the types available for the KHinge.ln TUTORIAL 1.1.5, you see how to use the HT_Motor

type to create a constantly rotating fan.

TUTORIAL 11.5: Creating a Fan

1. Open Tutorialll_05_Start, ut2.

2. Across from the previously created
bridge is a fan at the entrance of a
cylindrical hole, At the moment, the
fan just sits there until you shoot it,
at which point it simply falls to the
ground, First, you need to create the
actual KHinge constraint. In the Actor
Class browser, expand Actor> KActor
> KConstralr.t, and click KHinge.
Right~IiCk near the fan, and choose
Add KHinge Here. Move the KHinge
to the center of the fan and ensure
that It'S rotated In the same direction
as the fan (see FIGURE 11.20).

FIGURE .11.2.0 Move KHinge to the middle of
the fan.

3. In the Properties window for the KHinge, go to the KarmaConstraint category and select
the KConstraintActor 1 property. Click the Find button and select the fan.

4. Next, change the KHi ngeType to HT _Motor so that you can get a constant rotation for the
fan. Now change KOesiredAngVel to 16384, which sets the speed of rotation. Because
it's measured in Unreal angular U1,ltS, the fan spins 45 degrees a second. Before you can
get any movement out of this fan, however, you need to give the fan a maximum torque,
Because torque is a measurement of how much a (orce applied to an object causes that
object to rotate, you want to ensure that the maximum torque is large enough that the fan
can rotate the amount specified in KDesiredAngVeL To this end. set KMaxTorque to 100.

5. You now have a fully working fan. Save and run the map.

END TUTORIAL 11.5

The HT_Controlled type is very similar to the HT_Motor, but it takes advantage of the

KDesiredAng and KAi tOesiredAng properties to ~pe(ify the angle to achieve. In this way, the
motor starts spinning at the specified speed and SlOpS when it reaches the specified angle. You also

have the HT_Spr i ngy type for the KH inge. Wi th this type, yo II ca 11 sim ulaIe a spri ng lba t has I wo

angular goals. In TUTORIAL 1.1.6, you see how to use this type to create a catapult.
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TUTORIAL 11.6: Creating a Catapult

1. Open Tutoriall1_06_Start.ut2_
The goal of this tutonal is to use the

catapult in front of the fan (shown in
FIGURE 11.21) to propel a barrel
onta the bridge.

2. In the ActO( Class browser, select
Actor> KActor > KConstraint >

KHinge. Right-click in the level, and
choose Add KHinge Here. Place It
on the side of the catapult closer to
the bridge and ensure that it's in the
center of the catapult in the Y-8x:is.
Finally. rotate the KHinge so that it FIGURE 11.21 Catapult in front of the fan.

points down the Y-aXis (see
FIGURE 11.22).

3. In the Properties window for the
KHinge. select the
KConstraintActorl property.
Click the Find button and select
the catapult.

4. Now Change the KHingelype to
HT_Springy, and change
KStlffness to 5000 so that the
spring is relatively strong, Also, set
KDamping to 250 so that the cata·
pult doesn't swing back and forth

too much, FIGURE 11.22 KHinge Actor on the side of the

5. At this pOint, the catapult acts like a catapult

spring, However. currently you can't
tngger the c"ltapult to swing into action. To do this, you need a trigger. In the Actor Class
b(owser, select Actor> Triggers> UseTrigger. Right-click in the level, and choose Add
UseTrigger Here. Move it {lex:! to the catapult. as shown in FIGURE 11.23.

6, In the PropertIes window for the UseTngger, go to the Advanced category and set bHidden
to False so that you can see the UseTrigger 10 the game. Under the Events category, set
the Event property to TriggerCatapult.

7. Now you just need the catapult to actually respcnd to this event. In the Properties window
for the KHinge, go to the Object category. Change Initial$tate to 10gg1eDesired.
Under !tIe KarrnaConstraint category, set KAltOes iredAngle to 16384 (90 degrees). This
setting results in a hefty plunge (or whatever objects are innocently resting on the cata·
pult's surface. To associate the UseTngger with the KHinge, go to the Events category of
the KHlnge, and set the Tag property to TrlggerCatapult.



8. Finally. \0 test this calapu~l. place a

barrel on top of I\. In the Static

Mesh browser, open the
Chapterll ,usx pac~age, and under
the Karma group, select Barrel.

Right-cHcx in lite level, and choose
Add Karma Actor. Place thIS barrel

on top of the catapult. ln the Karma
properties for the barrel. set
bHighDetailOnly to False and

bKS t al't Enab1ed to True. as you dkl

wllh Ihe catapult. Also. change

K\.lass to 0.5 so that Ihe Mnel IS

slightly Iigh \er, Run the level, use

the trigger, and the barrel 1'.':1/ be

propelfed into the 1'1\11

g. SENe the map.

END TUTORIAL 11.6

Ragdolls
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FIGURE 1.1.23 Move the UseTriggel next \0 the
catapult.

As discussed briefly a (,'a(\\(,'r in this chapter. RagdoUs are the simulation of characters controlled
entirely by K"rma. Usually, you see Ihe effeGts of Ragdolls only when a character dies. At that

point, the RagdoU simublion takes over, and a death sequence is gencrJled,

For a characler model to be used;(s a RagdoU. you muSl have skeleloJlS. These skeletons, or Karma
Assets, hold information Ihat lells Karma how to simulate a Ragdoll. Usually, if you crC:lle a sim

ple biped;tl character, the ex;sring skeletons Ql n be used. However, ir your Gna r:lCler is oddly
shaped, you nl'ed to create '3 custom skeleton by using the Kormn AuthDring Too! (KAn. The
information this 1001 generates is saved in files with a .ka extension and l.ater used by Unreal. This
tool is discussed in more depth in the next seclion, "The Karma,Aurhoring Toot"

Fi rst) hOI"ever, you'U see how 10 lake advantage of Ragdolls in Unreal Ed. TUT 0 RIA L 11. 7 shol."s
you how to lake a simple Karma Actor and wnvert it into a fuUy IVorking Ragdol!.

TUTORIAL 11. 7: Creating RagdoJls

1, Open Tutor ial f 1_07_51 art, ut2, The goal o( \hls tu10nal IS 10 create a Ragdol( that
atraches to lhe cham thaI SWings aroulld Ihe cylindrIcal room In lhe leve('s nonheasl cor
ner, Notice a button rlghl next to the (O<Im you spawn from (see FIGURE 11.24),

ACIlvating this bu\\oo causes the cham to starl revolVing around the room.
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2. First, you must create the Actor to
11 act as your Ragdoll. As a template,

any KActor will work, For this exam·
pie, however, select the barrel static
mesh you used earher in the Static
Mesh browser, and place it in the
level (see FIGURE 11.25). The
exact location isn't particularly
important until you start using the
correct model.

3. In the Properties window for the
newly created Karma Actor, go to the

FIGURE 11.24 Where the Ragdoll creation will
Display category. Change the
DrawType property to DT_Me sh.

take place.

Next, to set the Mesh property, op~n
th~ Animation browser. Open the
HumanMaleA package and select
the MercMaleA mesh. Select the
Mesh property, and click Use.
FIGURE 11.26 shows the results.

4. Now that the correct mesh is being
displayed, move the model so that
the Ragdoll's right hand is Inside the
bottom KBSJolnt. This constrains
the right hand to the KBSJoint.
Remember that when you're using
this teChnique, the KBSJolnt auto- FIGURE 11.25 Barrel soon to be converted into

matically attaches to the nearest a Rilgdoll.

bone in the skeleton. In the
Properties window for this KBSJoint,
go to the KarmaConstrail1t category
and select the KConst ra intAct 01'2

property. Click the Find button, and
select the MercMaleA mesh.

5. At this point. the correct mesh is
displayed, but it Isn't being con·
trolled by Karma's Ragdoll. To do
this, open the MercMaleA Properties
window, and go to the Movement
category, Change the Phys ics
property to PHYSJarmaRagDoll. FIGURE 11.26 Barrel transformed into

MercMaleA.
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FIGURE J.1.27
the Ragdoll.

Karma category of

6. Finally, you r<eed to access the Karma proper

ties dealing with Ragdolls. To do this. go to the

Karma category and select the KParams prop

erty. Click the Clear button. For the New prop

erty. select KarmaPar-amsSkel and click the New

button. Within the KParallls property. expand

KarmaParamsSkel myLevel.Ka rmaParamsSkelO

> KarmaPararnsSkel. and set the KSkeleton

property to Mala (see FIGURE 1.1.27). ThIs

setting specifies which skeleton to use for

this Ragdoll and varies depending on which

mesh you use. Also. if you don't have your

in-game detail settings very hIgh, expand

KarmaParamsSkel myLevel. Karma ParamsSkel 0

> KarmaParams, and set the bHlghOetailOnly
property to False.

7. You now have a fUlly working Ragdoll. Save and test the level.

END TUTORIAL 11.7

The Karma Authoring Tool (KAT)
You've already s<.>en how to place Karma-controlled Actors into your levels and how to uSe con

straints to control their behavior, but what if you want to create a more complex system with

multiple joints? That's where the Karma Authoring Tool (KAT) comes into play. With this tool,

yOll can set up a skeletal mesh created in an external 3D package to work as a RagdolJ. You can

also creale and adjust physical properties, such as mass and inertia tensor, and adjust joints to be

ball-and-socket joi..nts, hinge joints. skeletal joints, and more.

After yOIl have ev!'rything set up the way yOLl want, you export the data to a . ka flle and reference

it from within Unreal. The following sections introduce you to the steps required to turn II model

created ill Maya into a fully working Ragdoll in Unreal. First. you'll take a look at the basic inter

face of KAT and how to go about using it

The KAT Interface

FIQURE 11.28 shows the KAT interface. The four viewp0r\s that take up the majority of the

interface are used to display the Karma objects you'll b~ setLing up for simulation. On the right is

the main panel, where you have access to the tool's main features. The first tab, File, deals with

file and workspace management, which is discussed in the next section, "Wor!<spaces."Yoll use the

second tab, Utilities, to manage plug-ins and basic properties that influence performance and
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display. The last tab, Edit, gives you access to all the tools you'll be using to modify imported skele

tal meshes. The control bar contains a series of properties related to transformations, some view

options. and play controls for simulations. These controls look and function much like what you

find on a VCR, allowing you to play the simulation, pause the simulation, ;\nd so forth. Finally,

you lise the status line to see the frames per second (fps) rate and run scripts. You'll see what you

can do in other parts of the interface as you work through the following tutorj"ls.

Control oar

Status line Main panel

Viewporls

FIGURE 11.28 The KAT interface.

Workspaces

In KAT, you manage your files with workspaces. Each workspace manages a file or group of files.

These files contain one or more assets. An asset is a collection of geometry, parts, and joints (con

straints). These assets, which you can think of as "game objects," are designed to work as individual

entities that can be placed multiple times in a level. An example of a good asset is a character RagdoU

or rope. .\11 asset that contains all the physics objects in one level, on the other hand, is a poor asset.

To create a new workspace, switch to the rile tab of the main panel, and click the Workspace but

ton. From the context menu, choose New. Specify a name for the workspace, and click Save. The

workspace area is cleared, and you have a file saved with the extension. kaw.
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Now you can start placing new Karma asset (.ka) files into the workspace. To do this, click the

File button, and then select New from the menu. As with creating a new workspace, specify a

nilOle and click Save. A new Ille with the specified mme is created, and your workspace is updated

with the new file.

~I

ACler you've ueated both a workspace

and a file, yOIl can then start placing ~ssets

in the files. To do this, dick the Asset but
ton, and select New from the menu. The

Create New Asset dialog box (shown in
FIGURE 11.29) opens, where you have a

variety o( options.

In this dialog box, you can specify the

asset name and the file where you want to

place the aSset. For the asset type, you

can create an empty asset, or you can FIGURE 11.29 The Create New Asset dialog box.

import an Unreal skeleton. Typically,

you import an Unreal skeleton, so you

would select Unreal Skeleton lmport in

this Type list box.

Vlewports

Because you'll be using tbe viewports often, you need to know how to go about navigating them.
TABLE 11.7 describes the basic navigation hotkeys.

TABLE 11.7 KAT Navigation Hotkeys

Hotkey Navigation Task

RMB

Shift+RMB

Clrl+RMB

In the perspective Viewport, you tumble around the view. If you're in an
orthOgraphiC Viewport, you pan around the view.

This key combination workS only in the Perspective viewport. It allows you to
pan around the scene.

This key combination allows you to dolly in and OUL It works the same In both
perspective and orthographic views.

Right-clicking in any viewport opens a context menu for performing a v3riety of operations. The

Single Viewport menu item sets the currt'ntly se1e<.ted vi('wporl to full scree.n. The other viewport

options are discussed as you use them in the following tutorials. In TUTORIAL 11.8, you use

KAT to create a simple Karma Asset.
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TllTORIAL 11.8: Creating a Simple Karma Asset (Part I)

1. The goal of this tutorial is to create a rope in Maya, bring it into KAT, and see it working

within Unreal. To begin. start Maya. If you need help navigating Maya's interface, be sure

to check out Chapter 17, "Overview of Maya." Please note that you need the ActorX

plug'ln to complete thiS tutorial. For more information on installing this plug'ln, go to
http://udn.p.picgames.com.

2. Choose Create> Polygon Pnmitlves > Cylinder from the main menu, and click the options

box @]. In the Polygon Cylinder Options dialog box that opens, change the following
properties:

Radius: 5

Height: 200

SubdiVIsion Around Axis: 10

Subdivision Along Height: 12

AXIS: Z

3. ThiS cylInder IS gOing to act as the rope. You do, however, need to triangulate it. With the

rope selected. press F3 to go to the Modeling menu set, and choose Polygons>
Triangulate from the merm

4. Before you add any jOints. you need to adjust their display size so that you can see them

In the viewport. To do this, choose Display> Joint Size> Custom (rom the main menu. In

the Joint Display Scale dialog hox. enter 5 in the text hox to make the jOints large enough
to see when created.

5. Press F2 TO go to the Animation menu set, and choose Skeleton> Joint Tool from the

menu.

6. Tap the spacebar In HIe viewport to switch to fuur View mode. Notice the vjewport labels

under each view panel. In the Side view, create a jOint on the far left of the cylinder. While

holding down the Shift key, create a jOlnl at every other segment or the cylinder until you

reach the end. Create a total of seven Joints, as shown In FIGURE 11.30.

7. Now you need to create a connection between the joint chain and the rope. Select the root

of the cham (the first joint you placed). Then hold down th~ Shift k.ey, and select the cylin

der. Choose Skin> Bind Skin> Smooth Bind from the main menu to attach the cylinder to

the Joints.

8. The last thing you need to do in Maya is to export this rope as a . pSk file. With the root of

the joint cha,n selected, type axmain Into the Command line at the bottom of the screen.
and click Enter.

9. In the Skeletal Exporter dialog box, change the output folder to an eligible path. and enter

RopeSkeletal for the mesh file name (see FIGURE 11.31), Click the Save MeshjRefpose

button. You should get a message box displaying information about the unsmooth groups

processed. SliT'ply click OK That completes everything you need to do In Maya.
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FIGURE 11,30 Joints placed in the cylinder.

END TUTORIAL 11.8

FIGURE 1.1.31
The Skeletal Exporter
dialog box.

Now that the rope has been created in Maya and exported, you need to bring it into KAT so lhat

it can be properly sct up as a Karma Asset. TUTORIAL 11.9 demonstrates how 10 import and

adjust your new Karma Asset.

TUTORIAL 11.9: Creating a Simple Karma Asset (Part II)

1. Open KAT. Using the techniques

discussed thus far, create a new

workspace named KarmaTests.

2. Create a new file and name it
SimpleAssets.

3. Next, select Sl.mpleAssets.k.a from
the workspace and choose Asset>

New from the menu. Set the name

to Rope. change the type to Unreal
Skeleton Import (see FIGURE
11.3:2), and click OK. In the Select

PSK to Import dialog box, rocate and

select the l1opeSkeletal. psk file
exported earlier, and click Open.

FIGU HE 1.1.32 The necessary setup for import
ing the rope object that was exported from Maya.
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4. Leave the settings in the PSI{ ImpOrt Options dla(o~ OOX at the defaults, and click OK. Yoo

should see a message box sayIng that you have successfully imported seven parts,

6, In the workspace view. double-click the Rope, which puts you into Edit mode, The Edit tob

then comes alive with oPllons and settings. and you'l be able to see {he rope in the
V1ewports (see FIGURE 11.33).

6. There are three different asset components to deal with in the Edit ~b (see

FIGU RE 11.34): Pans. Joints. and Geometry:

.. Parts hold the oynaffHc properties aSSOCiated with each joint. Pans also hold
inlormation about whether the joint reacts dynamically. has geometry, or both,

~ Joints hold information about what kind of jOint is bemg used. Depending on the

type, the available properties change.

• Geometry is just that geometric data used as collision dat2. This data can be cre
ated and edited within KAI When the PSK Me is nrst imported into KAT, a cylinder is

created between each joint. Therefore, the necessary collision gei:lmetry is already in

place.

FIGURE 11.33 Rope displayed In the v1ewports FIGURE 11.34
The Edit tab.

Because t.he joint type (or all Joints ,s set to ball and socket. there are no limits lor how

the join\s can rot.ate, The rope would look (ar more realistic. however, If its Joints had
some limits. Also, a balf and socket allows joints to twist, which is something you dOtl't

want your rope to do. Therefore, select afl the joints In the Joints list box in the Edit tab,

as shown in FIGURE 11.35, and click the Propenies button.
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Select a new type
for the joints.
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FIGURE 11.35
Select all joints in
the Joints list.

7. In the Type list hox at the top of the Multiple JOints Selected
dialog box, change the setting from Ball and Socket to Skeletal
(see FIGURE 11.38).

9. Now click the Play bullon. located at the
far right of the control bar. While the sim·
ulation is playing. you can LMB-drag the
rope around and see It react dynamically

(see FIGURE 11.37).

8. Although this setup works fine, you can make it more effiCient by
deleting jOint? from the Parts list. Joint? was placed just so that
the collision geometry could be generated properly_ Because the
collIsion geometry has already been created, you can delete
joint? without damaging the simulation. To do this, select joint?
in the Parts list of the Edit tab, and press Delete.

10. Finally, save the asset by clicking Save at
the top of the Edit tab. Now you're ready

to load this asset into UnreaiEd.

FI GURE 11.37 Moving the rope around in the Perspective viewport.

END TUTORIAL 11.9
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11
The Karma Asset has now been fully established in KAT and is reaJy for import into UnrealEd.

In TUTORIAL 11.10, yOll do this by using Unreal Ed's Animation browser.

TUTORIAL 11.10: Creating a Simple Karma Asset (Part III)

Rope moved and rotated into

l
:;~'-IK-"'~-;O(]I>~ecl-'~L.......--l~~~
G,~ I
N","", Ir::"A_~--·----'='--:"""

FIGURE 11.38 The Import Mesh/Animation
dialog box,

FIGURE 11.39
position.

3, In the Import Mesh/Animation dia·
log box. change the package to
KarmaOb)ects and the name to
Rope. Also, enable the Assume
Maya Coordinates check box (see
FIGURE 11.38). Click the OK

button, and save the package as
KarmaOb j ec ts.

5. Finally. you need to change the
KSkeleton of your Ragdoll, which is
currently set to Male. Change it to Rope, which is the KSkeleton you created in KAT. The
information for thiS KSkelelon is stored In SirnpleAssets. ka, which you saved earlier. To
get Unreal to see thiS information, copy SimpleAssets. ka into the Unreal directory in the
KnrmaOata folder. That's it! Run the map, and YOU'll find that the rope is completely dynamic.

4. Make sure the rope is selected in
the Ammation browser. Open the
Properties Window for the Ragdoll
you created earlier. Under the
Display category, select the Mesh

property and click Use to display the
rope, Rotate and move the rope IOto
position, using FIGURE 11.39 as a
reference.

1. Start UnrealEd, and open
Tutorialll_10_Sta r t ,ut2. You'll
be replacing the Ragdoll with the

rope you created.

2. Open the Animation browser, and
choose File> Mesh Import from the
menu, In the file browser, select the
RopeSk e1eta1 . ps k file you saved
earlier, and clic:k Open.

END TUTORIAL 11.10
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You should now h2VC a good idea or haw to use KAT 10 set Lip a worklt1g K.arma ALl<:lr fo r Un reaL

However) you typically use KAT (or selling up a characler 10 \\Iork as a RagdoU. In theory, there

lsn'r mud\ difference berween setting up a characrer and the simple rope you used in the previ

ous llllariaJs, but in praclicc you mUiil lake a few Imp0rlant step~. TUTORIAL 11.11 walks you

through the steps required to sel lip an Unreal characler's PSK /lie wilhin KAT.

TUTORIAL 11.11: setting Up a Character in KAT

1., Start KAT. Use Ihe KarmaTests workspa~ you created earlier, and create a new asset. Set

the asset name 10 Ctlaractel" and select Unreal SkeletOf' Imparl in the Type fisl box, Click
OK, select Character. psk (rom Ihe rlle browser dialog box. and chef< Open. Leave the set·

lings in the PSK Imporl Options dialog box at the defaults, and click OK. Dauble-click the
chal'i)cler In the workspace View, and you should sec the character in the vlewporls (sec

FIGURE 11.40),

F' GURE 11,40 Character Imported Into KAT.

2, The !1rsl problem IS that the character is UpSide down. Under the Pens list of the Edrt lab.

click Ihe Hierarchy button to dlso)ay a hierarchy of the characler's bones. Select the
topmost bone, named "root: In (he hierarchy (see FIGURE 11.41),
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FIOURE 11.41 Root ~elected In the Part GraphIc Hlerilrchy dialog box.

3. 01'1 the control bar. ensure that the rotation constraint is set to rX, and enter 91 In the
Angular text box to make the character rotate in gO-degree increments. In the Perspective
Viewport, hold down the Alt key and drag with the middle mouse butlOl1 (MMB) to fetste

lhe character upright, as shown in FIGURE 11.42.

FIGURE 11.42 Character rotated rigJ1t·side up.
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4. Now you need to move the character above the grid. On (he ConllOI bar, sel the transla
tional constraint to lhe Y-aXIS by deactivating the X and Z axes. MMB-drag up until lhe

character is above the grid (see FIGURE 11.43).

FIGURE 11.43 Character ml}\led ab()Ve Ule grid.

5. Now the cleaning begins. First. you don't need the JoInts at the ends of Ihe arms. Click
anywhere in a viewport to deselect everythmg. Now righl<lick In a Viewport. and enoose
Mode;> Part Hierarchy (with Skin) from the menu. FIGURE 11.44 shOWS the resulls. As

with the rope, deletmg unnecessary Darts speeds up calculation.

6. LMB-drag in the Perspective viewport to draw a marquee seleClion around the areas hIgh
Ilgl)ted in FIGURE 11.46. Hold down the Ctrl key to add to the selection. Atter all aleas

are selected. press the Delete l<ey.
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FIGURE 11.044 Character shown in part hierarchy.

FIGURE 11.45 Highlighted parts to be selected and deleted.
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7. Now you need to change some of tlle character's jOints so that it reaCls more like a

human. Right·click In a viewport, and choose Mode> Joint Editing. Under the JOints list of
the Edit tab. click the Properties button. FIGURES 11.48 and 11.47 show the JOint

lypes of each jomt.

FIGURE 11.46 Skeletal joints.

FIGU RE 11.47 Hinge Joints.
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8. For the hinges, enable the limit A.ctIVe cI1eck bOx, located l>rx1er the Properties dIalog bOx

opened In step 7. so that you can sel the range of motion for that joint. After enabling 11m·

its and selecting the joint. an arc is displayed that shOws lhe range of motion. To adjust il.
simply click and drag on the red squares at either side of the arc. The Y·axis line (INlTI
should always point down the bone. You'll probably need to rotate the joints so thaI the

arcs arch in the correct direction.

9. The skeletal joints also have limits, As with the hinges, you can adjust them by clicking
and dragging on the red squares. Because me limit IS In the shape of a cone, you can
deform the cone however you see fit. If you want to scale the cone down unrfOlmly, hold

down the Shift key while clicking and draggmg on eIther red square.

10. Now you need to edit all the Collision geometry so that it CeNers the character well. To do

this, right-click in a VIewport, and switch to Wlfetrame Collision mode. At this p<llnl. you

can select any piece of geometry on the character. right-diCk. and choose Edit Geometry

name.

11. This action puts you inlO another form 01 EdIt mode, In which the Edtl lab changes Into the

Geometry Editor (see FIGURE 11.4B). In this mode. you can create new geometry, edit
old geometry, or delete eXlsling geometry. After you're done, you can click the Finish bul·
ton to save your changes and exit Edil mode. ()j" yoo can click tlie Cancel button to jusl

exit.

'......
FIGURE 11.48 Edit mode in which you can edIt the collision geometry.
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1.2. Edit any collision geometry that doesn't fit correctly to the source geometry. You can have

collision geometry penetrate other collision geometry. However, If It does, select the pieces
that penetrate each other, right-click, and then choose Disable ColliSions from the context

menu. Some parts, however, need to collide with other parts for the simulation to work

correctly. For instance. the leg should collide With the chest and arms. Therefore, select

the parts that should collide with each other, right-click, and choose Enable ColliSions from
the context menu,

13, The final operation you need to complete is calculating your charClcter's mass. As dis

cussed previously, each part has a mass associated with it. When you first imporl your
character, a mass is automatically calculated for each part However, because you've

made changes to the collision geometry, the mass needs to be recalculated.

OK [~I

.. 19

~;'~M_
i14"~ M",,(o.re4:291

I

P' Clooli r"..bo

M"~ M"'Ia.ClJ66IJiI
~2"ooll-Qogonol~

II OK I e.-l

FIGURE 11.49 The Auto-Calculate Mass
Properties dialog box.

AI the top of the Edit tab. click the

Pertorm Action button to access a

list box containing a variety of
actions you can perform. At the bot

tom is a box describing the currently
selected action. To calculate the

mass, select Auto-Calculate Mass
Distribution in the list box, and click

OK. In the Auto-Calculate Ma&s
Properties dialog box, make sure the

All Parts option button is selected,

Select the Total Mass option button
(clear the DenSity option button).

and make sure that 1 is entered in
the text box (see FIGURE 11.49).

14. Click the OK button_ Tile mass is

then evenly distrubted thoroughout
the character's parts. However,

there's one small problem. If you
run the simulation now, you might

see Karma simulation errors

because some parts have a mass

that's too low. To alleviate thiS prob-

lem, click the Pertorm Action button FIGURE 11..50 The Mass Clamping Options
again in the Edit tab. This time, dialog box.
select Mass and Inertia Clamping in

the list. and click OK. In the Mass Clamping Options dialog box, select the Clamp Mass
and Clamp Inertia check boxes. Change Min Clamp Mass to 0.01 and Min Inertia Clamp

to 0.001, as shown in FIGURE 11.50.

15. Click OK. That's it l Your character 1$ now ready to be Imported mto UnreaiEd.

END TUTORIAL 11.11



u

"oJ .....1•• II .... 1("... _._

Summary

,,"" ,"'..... ><w, "' ....'" , "'"" l'""M;",,;" Ok_ '" "'"'' ""'''''.N; ....', ",m '.')'0"'
L:.....J .'" "". You "'" k" "'" '''m' ,'" ,""~,. " ..,""', "'" "'" of K, "" •.", "" .od Ok,., '"~

""" """,,,~ .."" " .. ,,,.~ ''''''''''' ""''''';''l ".., "'" ""T. "'~I ,,,," kd"","'" ~".
"oJ '" "~"'r<"',~" ,..., oM "'•. ,.,.....,'" J",,,,,g "".'M "._ k..~, ...~ w", ....",,,.
",<J .".'" '" ... "', ;",.",.;.;" ;" "',,' ~,.. '.' ,,,...,. """. '" ,... ,.'" ,,,, ''''', ~~ "" Ok... ,,,

'''''',,'' '" """1'".,,, ,""IIi"".: "'"'PO'" _,",,"" " ..", (''''_'''' .,,,,,,' ;" ~"H ~..,,<



Chapter

Advanced Bot/
AI Navigation

After creating your map, you'll probably want to play against arti

ficial illtelligence (AI) controlled bots. Unfortunately, this process

isn't automatic. Bots don't automatic~lly know how to navigatt

your map or find secretly placed POWtT-Up~. To help the bOIs, you

designate points in your map tbat the bots can follow. If some

places can be accessed only by jumping or double jumping, you
need to further specify these points so that the bots know how to

access those areas as well. After specifying these points throughout
the level, Unre<llEd USeS the points to calculate the best way [or

bots to navigate between them. In the end, you'll have an inter

locking network of lines connecting the various points, as shown
in FIGURE 12.1. r:-!:_~enliJllly, Ihi!: netwMk srt'Cifit>~ whert> a hoI
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can navigate. The goal. of course, is to

create enough points so that the

entire map is accessible to the bots.

Although this task can be tedious for

large maps, seeing a bot navigate

intelligently through your map is an

extremely rewarding experience. This

chapter demonstrates how these net

works are created, along with some

important considerations a level

designer must rl'ffiember when creat

ing navigation points for a levfl.
FIGURE 12.1 The web of paths generated for bots to
navigate.

Basics of Bot Navigation
Making a map in which bots can navigate

efficiently requires two steps:

1. Placing the navigation points.

2, Letting UnrealEd generate paths between

these points to create the interlocking

network on which your bots travel.

I NOTE
I Because the Unreal Runtime Engine does not come

equipped wilh any sort of bot AI, tills chapter is useful
only for Illose who own Unreal Tournament 2003 or
Unreal Tournament 2004.

A variety of Actors are used as these navigation points, most of which are a subset of the

NavigationPoint Actor. This Actor holds all the information about a certain point on the map: the

next point conoected to the current point, how to get to this point. and so on, The other Actors

you'JJ be using expand on this foundation to cause bots to perform more specific actions, such as

using a jump pad, Llsing the Trans]ocator, and won.

For basic navigation, the only Actor you need is PnthNode. If you had an extremely simple, m05tl~'

flat map, you would simply need to distribute these Actors throughout the level while making

sure each PathNode is roughly 1000 Unreal units apart. Because PlayerStarts are also navigation

points, a path is automaticaUy generated to them. Also, every pickup in the level, such as weapons,

ammunition, and health pickups, has an associated Inventory-Spot Actor, which is also a naviga

tion point. Although you don't see ItwentorySpot Actors, a path is generated between them and

other NavigalionPoint Actors, nonetheless.

If you have a mOTC complicated level, however, such as one that jllcludeslifts and doors, you need

to use special Actors designed to have bots handle these obstacles. Each subsection ill this chap

ter covers the series of Actors associated with helping your bots make decisions about complet

ing certain tasks. FIGURE 12.2 shows all the Actors you'll be using in this chapter.



After placing all the required Actors to
make bots do what yOIl Want them to do.
you must build the paths. You (an do this

in UnreaJEd by choosing Build> Rebuild
AI Paths or by clicking the BI/ild Paths

button on the toolbar. This process gener
ates paths between JIl the navigation

points in your level. Aftcr this process is
completed. you can view the paths by

right-clicking on a Perspective view's title

bar and choosing View> Show Paths from

the context menu. After turning this

option on, you see Iin~s traveling [rom

navigation point to navigation point.

Because these lines are color-coded, yOll

can use the colors as a debugging tool.
TABLE 12.1 descnbes the meaTllng of

each color.

TABLE 12.1 Bot Path Color-Coding

Color Meaning
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FIGURE 12.2 Hierarchy of Actors used in this
chapter.

White This path is very wide and can be traversed by large non-player charaC1ers
(NPCs). If a path is a maIn route used by vehicles. the color should be white.
Bots prefer these paths beci'luse they have lots of room to dodge and strate_

Green ThIS path is relatively wide and can be used by large NPCs. For medium-size
maps. you want most paths to be green.

Blue ThiS path IS quite narrow and traversable only by smaller NPCs. From a deSign
standpoint, these small, cramped areas usually decrease game flow, so try to
avoid lhem or ensure that wider alternate paths are available,

Purple This path Indicates a lift., teleporter, or jump pad.

Light Purple This path indicates a ladder.

Yellow ThiS is a forced path. If you want a path between two navigation pOints but
one Isn't generated automatically, you can force a connection by entering the
destination navigation pomt's name in the ForcedPaths array of the source
navigation point. You can fino this property under the NavigationPoint cate·
gory. FIGURE 12.3 shows a forced path.

Red This is a proscribed path. II does exactly the opposite of a forced path: allows
you to break the connection between two navigation points. To do this, enter the
destination navigation pOint's name in the Pros cr ibedPat h!; array of the source
navigation pomt. FIGURE 12.4 shows a proscnbed path.
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FIG URE 1 2.3 A forced p~th, After
entering the name Navigallon2 In the
ForcedPIHns array of Na~igatlonl, a
path Is forced berween them.
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FIGURE 12.4 A proscribed path.
After entering Navigation2 in the
Pros cr ibedPa rhs array of Navigation 1,
the original path between them is sev·
ered and Is replaced witt'r a red path
drawn between the nodes.

Before After
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While creating navigation points for }'our level, keep in mind that bots prefer white palhs and take
them i( availJ.bk. If a white path isn't available, the bot chooses green paths, and i( all else (ails. it
chooses blue paths. This iso't always the case, however, because many other variables come into

play when a bot chooses a path. In TUTORIAL 12.1, you see how to create a basic PathNode sys

tem to help your bots navigate a simple level.

TUTORIAL 12.1: Basic PathNodes

1. Open Tutorialt2_0'_Start.ut2. ThiS
level Simply contains a room with a Player

Stan. a weapon base. and a Super Shield
Charger (see FIGURE 12.5). If you start

the level now and spawn a bot. it would
do nothing after spawning. much like a

hypnotized monkey. To make this bot actu
ally navigate the level effectively. you must
place PathNodes.

2. Right-click between the Player Start and
the weapon base. Clod choose Add Path
Node Here from the context menu.
FIGURE 12.6 shows the placement of

the PathNode.

3. Now click the Build Paths button on the
toolbar. You won't see anything at this
point. However, behind the scenes.
UnrealEd has generated paths between
the PlayerStart, the PathNode. and the
weapon base. To view these paths. right
click on the Perspective viewport toolbar.
and choose View > Show Paths. In the
Perspective viewport. you then see paths
between the three Actors. as shown in
FIGU RE 12.7. If you placed the
PathNode In a good pOSition. the path col
ors are some shade of green_ If not.
adjust the PathNode by moving It farther
away from obstructions. centered between
the column and the wall. You have to
rebUild paths every time a navigation
point's position changes. for slight modifi
cations. you can use the Build Changed
Paths button. located next to the Build
Paths button on the toolbar.

FIGURE 12.5 The unpathed map.

FIGURE 12.6 First PathNode placed in the
map,

FIGURE 12.7 After rebuilding. paths are
drawn between the navigation points.
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4. Although the bot reaches the weapon base,

it still doesn't have access to the entire

map or the Super Shield Charger. You can

easily solve this problem by placing a few

more PathNodes, The general gUideline IS

to add enough PathNodes so that bots can

easily access all playable parts of tne level.

To avoid adding unnecessary PathNodes,

place just enough so that most paths are

green, as shown in FIGURE 12.8,

FIGURE 12.9 snows all the PathNodes

you have added circled in white,

5. Ret:>U1ld the paths ()nd run the map. Bring

down the console with the tilde (-) key.

Type gl10st and then press Enter. Put away

the console, and move above the level so

that you have a good view. Now go to the

console and type in addbots 1. Put away

the console again. and enjoy the fluid

motion of the AI-eontrolled bot. If. however,

your bots don't move effectively. it's a clear

sign you need to modify the PathNodes'

positions or add more if the bots don't

reach certain areas of the level.

END TUTORIAL 12.1

FIGURE 12.8 Fully pathed map.

FIGURE 12.9 PathNodes circled in white.

Aside from placing PathNodes. you can also tweak a variety of properties to make the bots react

the way you want them to. TABLE 12.2 describes these properties and lists their default values.

TABLE 12.2 NavigationPoint Properties

Property Descri ption

bAlwaysUseStrafil1g Setting this property to True ensures that bats

strafe to this navigation point.

bBlocked Setting this property to True makes all paths to

this navigation pOint unusable.

bMakeSourceOnly By setting this properly 10 True, paths leave the

navigation point, bul no paths lead to the

navigation point.

bNeve rUseSt rating Setting this propl:!rty to True causes the bots to

navigate directly to this navigation pomt wilhout

strafing back and forth,

Default

False

False

False

False
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TABLE 12.2 Continued

Property

bOneWayPath

bPropagatesSound

bVehicleDestination

ExtraCost

ForcedPaths

ProscribedPaths

Description

This property takes into account the navigation

point's rotation. Therefore, to use this property,

you must set bDnectional to True in the
Advanced category of the Properties window.

Setting bOneWayPath to True causes bots to go
only in the direction this Actor points. Therefore,

after a bot reaches this navigation point, it can

continue only in the navigation point's direction.

When this property is set to True, this navigation
pOint can be used to carry sound.

If this property is set to True, forced paths to this

navigation point have maximum width to accommo

date vehicles.

This property adds an extra cost to the navigation
point. The higher the cost, the less likely it is that

a bot uses this navigation point.

A path is forced from this navigation point to every
navigation point specified in this array.

All paths to navigation points specified in this

array are broken.

Default

False

True

False

o

N/A

N/A

Design Considerations

When placing navigation points in your level, you need to understand what bots are "thinking." One

of their primary concerns is fmding goodies: weapons, power-ups, health packs, and so forth.

Therefore, you don't want to place all the goodies in one part of the level, as the bots would simply

congregate in that area of the map the entire time. A bot rarely goes down a path unless there's some

reason to do so. To alleviate this problem, you need to spread the goodies evenly around the entire

level so that bots have a reason to explore the level. If a certain part of your level has no objectives,

strategic advantage, or worthy pickups, you might want to remove that part from the level.

Another important consideration is placing less powerful weapons and ammo in the level's main

paths. Doing this keeps your bats more focused on the objective and prevents them from spending a

lot of time searching for weapons. Conversety, more powerful weapons, such as the Redeemer, shouJd

be placed in harder-to-reach areas so that bots don't try to grab the most powerful weapons on a whim.

You want to keep bats from hoarding certain items by placing them in out-of-the-way areas. Because

a bot attaches a cost to every action it takes, the product of the action has to justify the cost. For exam

ple, translocating has an extra cost, so unless translocating provides a much shorter path 10 the bot's

goal or allows access to a valuable item, such as a Super Shield, a bot isn't likely to go that route.
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Tools for Debugging
Now that you have a general idea of how to get bats to navigate your levels, ii's time 10 introduce

some debugging tools that can help when your bOIs are misbehaving. The first place to i.nvesti

gate is th(' Map Check dialog box, which automaticaUy shows you problems wilh your map. This

12 dialog box pops up just after rebuilding only jf there's a serious problem with your palh setup.

You also have access to a variety of console commands that help you in-game wilh problems that

aren't quite as obvious and take closer examination 10 solvr and remf'dy,

Diagnosing Problems with the Map Check Dialog Box

Because the Map Check dialog box displays a variety of possible errors that might not be self

explanatory, understanding what each error means and how you can fix it IS important. If you

double-click on an error, the Perspective viewport snaps to the Actor in question. The following

list shows possible errors, their descriptions, and how to fix them.

~ No navigation point associated with this mover-!-This error indicates that a Mover doesn't

have a navigation point associated with it. If the Mover is not a lift or door, go to its Al

category and set the bNoAIRelevance property to True. This setting effectively makes bots

ignore the Mover. However, if it is a lift or door, see lhe "Lifts" section iater in this chapler

[or how to make bots recognize the Mover and use it properly.

~ Cannot reach [specific pain t j from this node.'-If the Actor generat ing the crror is too fa r

from the specified point, this error message is generated. Typically, the point is some sort

of objective, such as a flag, weapon base, and so Oil. To fLX this problem, simply place a

few PathNode Actors between the objective and the complaining Actor.

~ Should be JumpDest for PathNode X/-This error is usuaJJy generated if you can go from

PoinlA to PointB but not from PointE to PoinLA-. For example, PointA might be on a

higher plane than PointS, so you have to Jump to get to it. To ftx this problem, place a

JumpSpot at the complaining Actor's location and remember the Name property under the

Object category. In the properties of PathNodeX, enter the JumpSpot's name in the

ForcedPa ths array. Finally, just delete the originally complaining ActOr.

~ Only X PlayerStarts ;/1 tllis level-If your map is set to play with more thall X number of

players, increase the number of PlayerStarts in the level. You should always have more

PlayerStarts than the number of bots intended for the leveL

~ Path to PatllNadeX;s very long-add a PathNode irl bern-een-This error message tells you

not only the error, but also the solution. Basically, the path between the complaining

Actor and PathNodeX is longer than desirable; therefore, just place a PathNode between

the two Actors. Make sure the distance between two navigation points isn't too far

becmse a bot won't make certain decisions while traveling down a path. Of course, this

delays the bot's reaction. For example, if the distance is too far, a bot continues along the

path instead of chasing an opponent going in the opposite direction with his team's flag.
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• jumpDest has no forced paths to it-This error occurs if a JumpDest doesn't have a

PathNode associated with it. As you'll see in the "JumpSpots" section later in this chapter,

for every JumpDest, there must be a PathNode with a ForcedPaths array containing the

JumpDest's name.

• No forced destination for this jumppad!-As you'll see in the "Jump Pads and Teleporters"

section later in this chapter, a JumpPad Actor must have a destination. The JumpPad's

ForcedPaths array must contain the name of a PathNode. If it doesn't, you'll get this

error message.

• Navigation point not on valid base, or too close to steep slope-Every NavigationPoint

Actor, except (or FlyingPalhNode, must be placed on the ground and not too close to a

sharp drop-off.

• No paths from [specific point]-This error indicates that no paths lead to a specific point.

Either delete the navigation point if it's completely unnecessary, or create some

PathNodes that lead existing paths to this lonely navigation point.

Console Commands

'While in-game, yOll can type the commands shown in TABLE 12.3 into the console to debug bot

pathing in your level. If you're using the default key bindings, lise the tilde key to bring down the

console.

TABLE 12.3 Console Commands for Bot Navigation Debugging

Console Command

ShowDebug

Viewclass class

ReviewJumpSpots

ShowAI

ViewBot

ViewFlag

Description

This console command displays Information that varies depending on
the current state you're in.

This command snaps your view to a certain Actor of the specified
class in the level, Repeating the command cycles you through other
Actors in the level. For example, if you want to cycle through lights In

the level, type Vlewclass light.

This command spawns a bot and makes that bot attempt various jump
types on every jump spot In your level. Later in this chapter when you
learn about jump spots, this command becomes a crucial debugging
tool. ReviewJvmpSpots also takes an optional parameter that enables
you to limit the type of jump tested. ThiS parameter can be Tran sloe,
Combo, Jump, or LowGrav.

This command is similar to ShowDebug but shows only information that
relates to AI debugging.

This command cycles your view through the bots in the level.

This command sets your view to the current flag carrier.
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Console Command

SoakBots

RememberSpot

Pathing

Description

This command causes bots to report any errors they encounter_ If an
error occurs, the game pauses and shows you information about the
error. To continue, simply press any key bound to a command.

This command records your current location. Later, you can type
ShowOebug, and two paths are displayed: a white line drawn directly to
the spot you remembered and. if a route can be traced through the
navigation points to the rememhered spot. green lines representing
that route.

As mentioned previously, you can use a variety of Actors other than PathNode to give specific
orders to bots. These orders can include telling bots to translocatc, use an elevator, defend a flag,
and so on. The following sections discuss each action and which Actors you can use to direct bats.

Jump Pads and Teleporters

In Ch",pter 9, "Interactive Elements," you Ifamed how to us;, jump pads and tdeporters in YOllr
levels. BecallSf the UTJumpPad and Teleporter Actors are child objects of the NavigationPoint
Actor, bats automatically respond accurately to both of thelTl. If an element such as a jump pad
or teleporter works for humJn players, it will work just as well for bats. Therefore, when a bot is
trying to calculate the shonest distance between two points in the path network, it takes the paths

generated by jump pads and tdeporters into account.

Jump Spots

A jump spot specifies a location to which a
bot can jump. Usually, bots automatically
delide the kind of jump to make, whether

it's a double jump, translocation. dodge
jump, or just a regular jump. As with the

PathNode, you simply place a JumpSpot
Actor at the location to which you want
the bot to jump_ If) however, you want the

bot to jump back, you have to place
another JumpSpot Actor at the other end
of the path (see FIGU RE 12.10),

--

I IJumpSoo, Pal~Nooe I
GAP

I ?alhNo<le I I JumOSPOI I

FIGURE 12.10 How you jump hom a PathNode
to a jump spot and create the same setup to get
back.
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No more than eight paths can lead to one jump spot. Also, keep in mind that because jump spots

are probably hard-to-reach areas, you might need to force a path to the jump spot. To do this,

place the JumpSpot Actor's Name property in the ForcePaths array of any PathNode you want to

be the source to the jump spot.

Although bots do decide which kind of jump to make, in special cases you might want them to

use other means, such as the Translocator. The properties shown in TABLE 12.4, found under

the Actor's JumpSpot and JumpDest categories, hel p tremendously for these special cases.

TABLE 12.4 JumpDest and JumpSpot Properties

Property Description

JumpDest

bForceDoubleJump

JumpSpot

bDodgeUp

bForceAllowOoubleJumping

bNeverlmpactJump

bNoLowGrav

bOnlyTranslocator

TranslocTargetTag

TranslocZOffset

This property causes the bot to double jump no matter what

the circumstance.

If you want a bot to dodge jump against a steep incline in
order to climb it, you must set this property to True.

If a bot decides to double jump, this property simply tells the
bot to go ahead and double jump instead of performing a final
check to see whether the jump will succeed or fail.

If you set this property to True, bots don't try to use the

ShieldGun to boost themselves to the jump spot.

If this property is set to True, bots don't attempt to get to the
jump spot while playing in low gravity.

Setting th is property to True causes bots to translocate only to
this jump spot.

If the jump spot is hard to reach, you can specify the tag of
some target object in this property, and the bot aims at this

target when translocating.

If a bot is aiming too high or too low, you can offset its aim
with this property. It should be used only to handle minor
translocation problems, so adjust with care.

TUTORIAL 12.2 shows how to effectively make a bot jump onto a steep ledge.



d52 Chapter 12 Advanced Bot!AI NavIgation

TUTORIAL 12.2: Jumping onto a Steep Ledge

12

1. Open Tutoria112_02_Start. ut2.

This map has a lower level contain

ing a Player Start and two weapon
bases, with PathNodes scattered

throughout so that a bot can easily
navigate among them. Howp-ver. the

upper level IS totally inaccessible to
a bot. as shown in FIGURE 12.11.
If you ran the level now and added a

bot, the bot would simply run back
and forth on the lower level_ To fiX

this prOblem, yOU'll add a JumpSpot

Actor near the ledge of the upper

level and tell a PathNode to make a
path to it.

FIGURE 12.11 Initial paths without a way to get
to the upper level.

2. Open the Actor Class browser.

expand NavigationPoint :>

JumpDesl. and click JumpSpot

(see FIGURE 12.12).

3, Right-click near the middle edge of

tM upper level. and choose Add

JumpSpot Here. FIGURE 12.13
shows the placement of the

JumpSpot Actor.

4. RebUild the paths now, Depending

on exactly where you placed the

JumpSpot, YOU'll probably notice that

no path IS generated from the

PathNode to the JumpSpot (see
FIGURE 12.14). There's a return

path from the JumpSpot to the

PathNode, but If the bot can't get up
to the JumpSpot, the return path is

useless.

iloo,
1

a;J..Itd'..,,
-U£..

.J: .-.t~

.~:Qd.

, s.J<~

~"'UM"

FIGURE 12.12
Class browser.

J

JumpSpot selected in the Actor

FIGURE 12.13 The JumpSpot Actor (circled in
white) has been added to the upper level.



6. To fix this problem, you force a path

from the Path Node to the JvmpSpot.

In the Properties window (or the

PathNode, go to the NavigationPolnt

category. In index [OJ of the

FDl'ceClPa ths array, eype in the

name of the JumpSpot Actor (see

FIGURE 12.15). You can find this

name In the Properties window of
the JurnpSpot Actor under the

Object category.

8. Now It you rebuild the paths, you

see a path that goes from the

PathNode to the JumpSpot. as
shown in FIGURE 12.18.

Pathlog

FIGURE 12.14 A path from the JumpSpot to the
P8tt1Node. but no! one from the PathNode to the
JUmp$pol

FIGURE 12.15 JumpSpol1 in the ForcedPaChS

array of the Path Node.

1. If you run the map now. howe\ler. the

bots rarely. it ever, jump to the

JumpSpot: they get there only \lia

the Translocator. if it's available. To

fix this problem, open the Properties

window fOt the Jump5pot Actor.

Under the Jurnp5pot category, set

the bForceAllowOoubleJu~pi~Q

property to True. Run the map again.

and notice that the bots are now
Intelligent enougtl to jump onto the

upper level,

H
Hano

FIGURE 12.16 A path now goes from the
PathNode to the JumpSj}llL

END TUTORIAL:....:1~2':..:...:.2 _



654 Chapter 12 Advanced Bot/AI Navigation

TUTORIAL 12.3 shows how you can force a bot to get inlo areas that are accessible only via the

Translocator.

TUTORIAL 12.3: Translocating Through a Small Hole

12 1. Open Tutorial12_03_Start. ut2.
This map conSists of two rooms with
a small window that connects them
(see FIGURE 12.1.7), so the only
way to get into the roorn is with the
Translocator. The bots, of course,
have absolutely no way of knowing
how to do this. without supreme
direction from the level designer. To
use the Translocator, you're gOIng to

need a target along With a jump
spot. However, because you need to
prOVide a way to get out of the room
as well, you'll need another Jump
spot on the other side.

2. First, place a JumpSpot Actor next
to the wall in the room with the
Super Shield Charger. You don't
want 10 place It too far from the wall
because it won't work well (see
FIGURE .12,18).

3. Open the Actor Class browser.
expand Keypoint, and then click
LookTarget. Place It in the level so
that it rests on the base of the win·
dow (see FIGURE 12.19). In its
Properties window, go to the Events
calegoryand set the Tag property to
WlndowT arget_

FIGURE 12.17 Map for testing bots with
translocators.

FIGURE 12.18 JumpSpot Actor placed at the
base of the window.

4. In the Properties window (or the PathNode nearest the window, go to the NavigationPoint
calegory. Add the JumpSpot Actor's name in the ForcedPaths ar~ay. Again, yOll can find
the name In the Object category of the JumpSpot Actor.

5. Now you need to tell the bots to aim at the target when using the Translocator. To do thiS.
open the Properties window for the JumpSpot Actor and go to the JumpSpot category. Set
the TranslocTargetfag property to Window1arget, which you speCifIed earlier in the Tag
property of the LookTargel. Finally, set the bOnlyTranslocato(' properly to True so that
bots use the Translocator only to reach that JumpSpol.
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FIGURE 12.19 LookTarget placed at the base of
the window.

FIGURE 12.20 Final setup for the bats to
trans locate back and forth through the window.

8. Aner rebuilding the paths, run the

level. If you dOll'l have Trans!ocowrs

enabled in dea!hmatch, you can

temooraTiIy enable them by typing

the follOWIng into the console: open
Autop!ay?translocator:1. The

bot should then [ranslocate into the

loom. If the bot aims too high or low

when shooting the TranSJocator Into

tlie room, simply raise or lower the

LookTarget.

7. You do. however, have one (inal

task, When a bot does get into the
room, he's stuck. To fix this prob

lem, you need a Jump spct nelct to

Ihe PalhNode (r. the main room and

3 PalhNode neX1 to the originally

placed jump spot. Seleel the

JumpSpo\ Actor and duplicate it.
Because the name Changes when

you duplicate. select the originai

JumpSpOl Actor and move 1\ to the

main room next to the PathNode.

8. Now select \.he PathNode in the

main room and duplicate il. Move

Ihls new PathNooe '"10 the shield

room Ilext to the Jump Spot. All

that's left to do Is mal<e lhe new
PathNooe generate a oath to the

new Jump soot.

9. Open the PropertieS window fOI the PalhNode m the shIeld room and go LO Ihe

NavlgationPolnt category. Change Index rOJ of the ForC&ClPaths array to the name of the
JumpSpot AClor III the main rO()m.

10. RebudO paths and run the map. Your bots shOuld now Jump from room to room inlelllgen1iy

with the Translocator. See FIGURE 12.20 for the final setup.

END TUTORIAL 12.3

Doors

Doors are Movers lh.at respond to a play<.'''~ prcsenc~ ;Ind open 1ccordingly. Although these nav

igation types :lI<.' ea.sy (or human players to USc, they require Some setup before bots can usc them.
The m-.lin problem you hllve when ,~orking with doors is that a Mover bloc.ks paths much like a
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static mesh. In this section, you explore various ways around this problem and see some capabil

ities of the Door navigation type. In TUTORIAL 12.4, you see how to have a bot navigate

through a door without the use of any special Actors.

12 TUTORIAL 12.4: Simple Door Setup Without Door Actor

1. Open Tutor ial12 04_Sta rt . ut2.

This map has a siMple door in it that
responds to player interaction.
However, a Mover is blocking the paths
(see FIGURE 12.21), so bots don't
realize they can navigate through the
door,

2. Open the Properties window for the
door. Under the Collision category, set
oPathColllding to False.

3. RebUild the paths, and you'll notice a
path generated through the door (see
FIGURE 12.22), This path. in effect,
causes the bot to use the door prop
erly. Tnis fix is a simple one because
the door opens fast enough for players
to simply walk through. If it took any
amount of lime to open the door, the
current setup would cause the bot to
repeatedly knock itself against the
door until it finally opened. TUTORIAL
12.6 examines this special-case
scenario.

END TUTORIAL 12.4

FIGURE 12.21 Door without a path through it.

FIGURE 12.22 Door with a path through it.

Although TUTORIAL 12.4 shows a viable way of making bats navigate through doors, you can

get more control by using the Door Actor. This Ador is a control system that makes sure paths

mntinue through doors without needing 10 modify the Mover. It also tells the bot what to trig

ger to open the door. This way, if a bulton or switch isn't directly next to the door, the bot can still

find it and understand that it must hit the button or switch before it can pass through tht> door.

The Door Actor can also completely block the path running through the door when the door is

closed, This way, if you have a secret area that's unlocked later during gameplay, the bois don't try

to navigate to that secret area until the door is opened.
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The bAutoDoor property found under the Al (;J'egory of a MOI'er aUlomalioJly gcner;ttes a Door

AClor when rebuilding palhs. This Door Actor is :lLJlomat'lcaJJy assoCJated with the Mover.
However, this automatic associalion mayor may I10t work drpendi.ng 01"\ your SCIUp. J( the aulO

mat ic setup doesn't funci ion properly, you can t\veak it or cr('.lle Ihe enlire Sl:.tup manually.
TABLE 1.2.5 describes Ihe pertinent pmpeflies of the Door AClor.

TABLE 12.5 Door Actor Properties

Property

bB1ockWhenClosecJ

bloi t i211yClosed

OoorTag

OoorTrigger

D~rlplJon

setting this properly to True causes the door to
block any pathS running through It while the door

is closed, Whitt'! the door IS closed, DotS don't
altempt to open or navigate t)1rQugh the door,
Tl'l€refore, if thiS properly is True, the door must

be opened via some other trigger or event that
happens in-game,

This property should be set to reflect whether or

not the Door Mover IS open Of closed before bemg

lnggered. A value of True means the ooor begins

closed; False means II begins WIth the door open

This property should be set to the Door Mover's
Tag propeny.

This property should be set to the Tag property of

the Actor that triggers the door.

Default

False

True

None

None

You have now seen how to set up an AI-navigable: door system by simply adjusl ing the propertie-i.

o( a Mover. In TUTORIAL 12.6, yOll create a similar setup using the Door Actor.

TUTORIAL 12.5: Simple Door Setup with a Door Actor

1. Open Tutorial12_05_Sta"1:. ut2. ThiS map IS exactly the same as the one in TUTORIAL

12.4. but instead of tinkering with the Mover's ColliSIon, you'll add a type of fl(lVIgatlon

pOint that handles pathlng through the door.

2. Open the Actor Class browser. Under NavigatlOIlPolnt, select Door. Add a Door Actor in the

level and center It on t~.e Mover.

3. Open the Door Properties wIndow, and navigate to the OMr category. Set the DoorTag
property to BlastOoor. which is the Mover's Tag property. Now set the OoorTr19ger

property to BlastDoorTr igger, which IS the trigger's Tag propel1Y.
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12

4. Rebuild the paths. and notice
that even though the mover's
bPathColl iOlng property IS set to
True, paths are generated though
the door (see FIGURE 12.23).
Bats now respond properly to the
door,

FIGURE 12.23 Using the Door Actor to generate
paths through the door.

END TUTORIAL 12.5

TUTORIAL 12.5 demonstrated a simple setup for the Door Actor. In TUTORIAL 12.6, yOll see

how to use the Door Actor to drive the behavior of your bots so that they can also use more com

plex door systems, such as a door that's opened through the lise of a separate trigger.

TUTORIAL 12.8: Complex Bot-Door Interaction

1. Open TutonalI2_08_Start. ut2. In thIS map, you must access a trigger, which is away
from the door, and then wait for the door to finish opening before walking through :L As in
TUTORIAL 12.5, you'll use a Door Actor to accomplish thiS teat.

2. Add a Door Actor into the center of the Mover. In the Properties window for the Door. set
the OoorTag property to BlastDoor and the DoorTrigger property to BlastDoorTrigger.
Although the setup is the same as in TUTORIAL 12.5. this map demonstrates the power
of the Door Actor in enabling bots to deal With more complicated situations.

3. Finally. rebuild the paths, verify that the paths do, in fact. run through the door. and then
test the map. You'll notice that the bots act intelligently by going to the trigger. waiting for
the door to open, and then traveling through it.

END TUTORIAL 12.6

Lifts

As with most interactive elements. to gel bats to work with llfrs, you must create a few exira

Actors and set a few properties. The two Actors specific to lifts are LiftCenter and LiftExit.

LiftCenter is used to specify where bats should stand while on lhc Ijfl. TAB LES 12.6 and 12.7

show the pertinent properties for these Actors.
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TABLE 12.6 LiftCenter Properties

Property Description

li f trag Set this property to the Tag of the Mover being used as the lift.

liftTrigger Set this property to the Tag of the trigger that triggers the lift. This IS,

of course. necessary only when a trigger is controlling the lift.

LiftExits should be placed at every location where the bot can get on or off the lift.

TABLE 12.7

Property

LiftTag

UftExit Properties

Descrlptron

Set this property to the Tag property of the Mover bemg used as
the lift.

SuggestedKeyFrame This property associates a certain keyframe with a keyframe of the

Mover. Therefore, the bot uses this LiftExit when the Mover is at the
specified keyframe. However, this property is merely suggestive and
isn't always necessary.

When creating the actual Mover for the lift. often setting the Mover's IllitlalState to

StandOpenTimed is a good practice. This setting ensures that the Mover waits until the player is
actually on Ihe Iifl before advancing 10 another key(-rame. Wilh 8umpOpenTlmed, the Mover starts

moving as soon as the player touches iI, even though Ihe pl3yer might not be complelely on the

lift. Also, setting InitialState to aumpOpenTimed is required to make non-triggered lifts usable

by boes. In TUTORIAL 1.2.7. you create a lift that can be used by bots in your level.

TUTORIAL 12.7: Creating a Bot-Navigable Lift

L Open Tutor ia112_07_St art, ut2.
This map has one lift that gets you
from the lower level to the upper
level.

2. Open the Actor Class browser,
expand NavigationPoint, and clicl<
LiftCenter.

3. Somewhere on the lower level. nght·
click near the lift and "hoose Add
liftCenter Here. Move thIS Actor to
the center of the lift, as shown in
FIGURE 12.24. FIGU RE 12.:24 LiftCenter placed on th e base of

the lift.
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FIGURE 12_25 UftExits placed on the upper and
lower levels.

FIGURE 12.26 The bot paths are now running
between the upper and lower levels.

6. Right·c1ick in front o( the lift, and

choose Add LiftExit Here. At the exit

from the lift on the lIpper level. right

click and choose Add LiftExit Here.

FIGURE 12.25 shoVis the place
ment of the$e LlftExlts.

4. In the Properties wmdow (or the

LiftCenter. go to the LiftCenter cate
gory. Change the Llf trag property

to Li ftMcver, which is the Tag

property of the Lift Mover.

5. Open the Actor Class browser.

expand NavigatlonPoint, and click

L1ftExit.

7. In the Properties window for the

liftExit on the lower level, go to the
Lift£Xit category. Change the

Li ftTag property to Lit tMover and
the SuggestedKeyFrame property to

0_ Please note. however. that with

such a simple two-keyframe lift, this

property isn't c:ruclal, but it's always

a good practice to associate the cor

rect keyframe with the correct eXit.

8. In the Properties window for the

LlftExit on the upper level, go to the

lIftExit category and set Ll ftTag to
Li ftMover and change

SuggestedKeyF rarne to 1.

9. Rebuild paths and run the map, If the bots are ignoring the lift, you might need to increase

their difficulty level. Generally, skill levels of Adept or higher work. FIGURE 12.26 shows

the bot paths in place.

12

END TUTORIAL 12.7

Ladders

As discussed in Chapter 9. "Interactive Elements," ladders are created with a Laddervolume, This
volume. in and of itself, is mough for a player to climb up a laddn For bots, however, you need
navigation points. The LadderVolume has the bAutoPath property, which by default is set to Trlle.
When you rebuild paths with this setting, one AUlOLadder Actor is placed on the lap of the
LadderVolume and aile Autol.addcr Actor approximately 40 unjl~ from the bottom. You must,

however, rotiHt' thesr two Actors to point in lhe opposite direction 'IS the Ladde/"Volume.
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~u.se the one AUloL3dder Aoor lS placed 21 the lOp ofrhe LadderVolume. you should makoure

lile laaderVolume c.>XIt"ncls ;lbOI.H 10 unirs above the ledge you're- trying to reach wlIh Ihe ladder,

jfyou're having trouble with Ihe 3lllom3tically gener aled navigarion poi nlS, simply set bAut oPa t h

to False and manually place Ladder Actors at Ihe (Op and bottom of Ihe Ladd~rVolu[Jl&. This
Aclor, which works mllch like any or.her navig:ation pOlnl, can be fOllllclll nJcr Navi.gatioTlPoint :;
S01alLNavigationPoinl in the ACIOf Cla.~s browser.

Advanced Pathing
Using everything discussed 10 this point, you can make OOts navigale everywhere ill ~ level, They

can grab power-ups, weapons, and everything else you've placcd in .3 level. Howl:V!:r. in Caplure

me Flag (CTF) or Bombing Run gametypes, you might ....'ant the bois to act more ulltUigently
when it comes to choosing a path. For example, you mit;ln hJW mulliple palhs 10 a nag or otner
objective, And you want bots to (avor one path over the other. And what if you want to spul1)r
certain points as defense points and others as sniping points? You c.ouldn't do alII his wid, the

basic navigalion points; you need to inlroduce 3 few new Actors, covered in dctai..l in the follow
ing sections,

AasauJtPBths

An MJaultParh. or a series o( AssauitPilths, d.efines a p,'lh 10

an objccLive. Each pJlh you creall' <:.an be a5.S1g.n.:d a pnoriry

so ,bal betS can choost one path more often than Jnolher.
You can even de-fine pal hs as 3tlacking palhs or returning

palhs so that bots use one p;ttn (or allJcking and anotl'er for
relurnlflg 10 Iheir own b3SC when completing an objective.

See thc dUlg.Jam in FfGURE 12.27 as;'ln ex.lmpk.

Ther~ tlfe TWO palhs to get from the Red bttse to the Blue
b3se: Patn A, which is on the lower lev~l, and Path 13, which
is on the upper level. By simply placing one Assa\.JlrPa!.h

Aclor on each path, you can conrrol how you want those

paths Lo be used. For example. you could m~ke the nOt

attack via Path Band retllrll via Path A. To du Ihls, you
would set bRe'turnOnl y or Assauh Path I 10 T(ue imd

bNOReturl'l of AssaullPalh 2 10 True. TUTORIAL 12.8

shows how to set tht'se paths up.

I

/t- . -. ".,: PaUl B

~:~t Red B... ~1J.~
.,~~~,.,

FIGURE 12.27 A simple
AssaultPaUl diagram.
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TUTORIAL 12.8: Using AssaultPaths

1. Open Tutorial12_08_Start. ut2.
This map is a CTF map with two
sep3rate pathways leading to each
base (see FIGURE 12.28). The
goal 1$ to make Red team bots
attack from the upper hallway and
return through the lower hallway.

2. Open the Actor Class browser.
expand NavlgationPoint. and click
AssaultPath.

3. Place this AssaultPath along the
upper hallway near the Shield
Charger (see FIGURE 12.29).

4. Place another AssaultPath along
the lower walkway, as shown in
FIGURE 12.30.

5. In the Properties window for the
AssaultPath in the upper hallway. set
PathTag index [01 to AttackPath.
Although setting the PathTag prop-
erty isn't entirely necessary, using

PathTag to describe what the
assault points are for is a good
practice. So that Red bots use this
AssaultPath, set Ob) ectiveTag to
xBlueFlagBase. which IS the Tag

property of the flag base. AlSO. set
bNoReturn to True.

6. In the Properties window for the
AssaultPath in the lower walkway.
set PathTag index (0) to
AeturnPath. As with the previous
AssaultPath, set Obj ectiveTag lo
x81ueFlag8ase and bAe tu rnOnly
to True.

7. Rebuild the paths, and test your
map. The bots should now attack
according to your AssaultPaths.

END TUTORIAL 12.8

FIGURE 12.28 The map used for this tutorial.

FIGU HE 12.29 AssaultPath placed after the
Shield Charger in the upper hallway.

FIGURE 12.30 AssaultPath placed along the
lower walkway.
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You can also set up your level so that after a bot reaches the end of one AssaultPath, he has to go

on to ~lI1other one. This setup is specified in the Pos i tio/] property. In the example shown previ
ously in FIGURE 12.27, you could sel AssaultPath l's Pos it iOJ1 to 0 and AssaultPath 2'$

Posit ion to 1. This setup causes a bot to go to AssaultPath 1 and then AssaultPath 2 before finally
going to the Blue base.

When creating more compli

cated scenarios, however, you
must also use the PathTag
property. Until now, the
PathTag property has been

used only to give a certain pJth

a name. Consider the diagrJn1
shown jn FIGURE 12.31 as an

example.

To get from the Red base to the
Blue base, the bot can choose
from three separate palhs. You
want a 50% chance Ihe bot will •. AssaultPalns

take the left route, so simply FIGURE 12.31 A more complicated AssaultPath example.

give the Assau[tPath on the left

a priority of 0.5. The same idea goes for the center and right paths: Set them to 0.3 and 0.2 so
that the total adds up to I. After the bot chooses one of the paths and arrives at the Assau[tPath,

he has to choose which Assau ItPaln ht' goes to next. The f] rsl criteria is which AssaultPaths
accept him. All other AssaultPaths that have the current Assau!tPath's PathTag property in their
PathTag array will accept the bot. If this criteria were nOt in place, nothing would stop a bot
[rom going down the left path, reaching [fIe AssaultPath, and Ihen going all the w"'y back to the
AssaoJtPath on the rightmost side. This is why the ASSJoltPath on lhe rightJllost inlcrseCl ion has

both PathA and PathB in its PathTag property. After that criteria is mel, the bot decides which
Ass3ultPath to go down based on the priority. Just be sore the priorities lor each set of paths add
up to l. TABLE 12.8 shows the pertinent properties for the AssaoltPath Actor.

TABLE 1.2.8 AssaultPath Actor Properties

Property

bEnabled

bNoGrouping

Description

Setting this property to False causes bots to Ignore

the AssaultPath. You ciln, however, toggle this
property by triggering it.

When this property IS set to True, bots gather
reinforcements before moving on.

Default

True

False
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TABLE 12.9 Defense Point Properties of the UnrealScriptedSequence Actor

465

Property

bNot I nVetnc le

bAoamingScript

bSniping

Pnori ty

WeaponPreference

Description Default

If this property is set to True, bats ignore this False
defense POint If they're in a vehicle,

If this property is set to True, after a bot reaches False
thiS pomt it's free to roam around the point while
it's defending.

When this property is set to True. bots use thiS False
point as a snlning pOint.

If multiple defense points are associated With an 0
objectIVe, this property enables you to set
weighting for a certain point so that bots use one
more often than another.

ThiS property specifies the weapon the bot should None
use while defending at thiS POIOt. Most commonly
used to ensure:! that bots are using Ule sniper rifle
when bSniping is set 10 True.

NOTE
ThiS is tile only we.apon base In the level.

In TUTORIAL 12.9, you see how to place an UnrealScriptcdSequence Actor in your level and use

it as a way to designate defense points for objectives. The bots in your level use these poinls as

prime locations for objective defense.

TUTORIAL 12.9: Creating Defense Points

1. Open Tutorla112_09_Start. ut2. In this map, which is the same as Tutorial 12.8's map
with only slight modifications, you'll create a sniping POint in the Blue base.

2. Open the Actor Class browser, and select UnrealScriptedSequence.

3. Add an UnrealScriptedSequence Actor
to the Blue base just in front of the
weapon base that spawns the sniper
rifle. Now rotate the Actor to point
toward the area being defended.

4. Open the Properties window of the UnrealScnptedSequence Actor, go to the Events cate·
gory, and set the Tag property to DefendBlueFlag, the bSniping property to True, and the
WeaponPreference property to SniperRif1e,

5. Run the map.

END TUTORIAL 12.9
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Vehicle Navigation

To get vehicles to navigale throughout a level, you nted 10 add HoverPathNodes, RoadPathNodes,
or FlyingPathNodes. You place RoadPathNodes in your map much like regular PalhNodes; how

ever. unlike regular PilthNooc:" you must SpJU- them out mort and make sure that aU paths are

12 whit~. Also unlike Path.Nodes, you don't want to create J web of road paths. Inslead, you want 10

enwre that each road foUows a single line and br~n(hc:s only when necessary, depending on the

rerrain. If paths start (0 connect roads mat are separJtC', >'ou can slo\"ly lower the value of the
l.IaxRoadDist property of the offending RoadPathNode until It connects only 10 the nodes you
want.

.......'hen only a hovering vehicle, such as the Manta, can navigate over a cerwin area, place a

HoverPa.thNode in th:lt location instead of a RoadPathNode. This \oJJY. only howring vehIcles try
to uS<' these navigarion points.

FlyingPathNode.s define the ,uea and roures that bots can use when using flying vehicles such as

the Raptor. Paths are generated not only between FlyingPathNod~ bur also to Jny navigation
points on the ground. With this in mind, you should always have some FlyingP:lthNodes that have
a view of nearby objectives. Because: flying vehicles should be able to navigak most of the level
freely, use the S3me web technique as with normal PathNodes, in which every FlyiflSjPathNode

connew to all FlyingP.1thNodcs around it. The area that a FlyingPathNode controls is defined by
its Collis lOnHe ight and Coll is ionRadiu s properties. Therefore, when debuggi ng
FlyingPathNodes, activating the Radii Vlew in the vicwporr you're working in is helpful.

Summary
In thiS chapter, you have learned a variety of methods for making your computer-controlled
opponents more I\1teUigenl \n your levels. ThIs chapter has covered basic bot pathing as well as
how to make your bots navigate specific obstdcles. including areas that ca n be reached ol11y by
jumping, double jwnplflg, and translocating. You have also learned how to make your bats use
interactive elements, sudl as lifts and tnggerable doors, in your levels. In addition, you have seen
how (0 use and control As.saultPaths and how to set rhem up so.that your boIs make more com
bat-conscious deCisions on your levc\'s battlefield. This chapler h~ also covered points you must
consider when implemenling vehicles in your level. At this poine, you should be able 10 con(i
dentiy control bots' actions in almost any situation within you r level. Remember that bot patrung,
although not euctly difficult, is another aspect of proper gJfllC design that requius careful plan
ning and consideration to achieve the best results. Make sure yOll practice these skills so (hal you
become l!ccustomed to how artificially intelligent charactcr~ interact in YOllt levels.



Chapter

Matinee: Creating
Custom Cinematics

This chapter introduces you to Matinee, an UnrealEd tool that

enables you to easily create in-game cinematic sequences Jnd fly

throughs or even animate Actors in your levels (see the interface in

FIGURE 13.1). The chapter begins with a discussion of machin

ima, a new generic term used to describe the creation of real-time

movies with <l gaming engine. From there, you take a dose look at

how to create Matinee sequences Jnd explore the Scene Manager

Actor and the components it manages: Actions and Sub ActiorlS.

Next, you'U set up a simple Matinee sequence of your own in which

your viewport camera is instmcted to move from point to point.

With this in place, you can view the sequence in action through the

built-in Matinee Pre\;ew window. IAThen you're satisfied with the

camera movement, you can move on to learn how to trigger this

sequence within the game.
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With a general underslandi..ng of hOI'"
Matinee works. you lhen movc inlO a serics
or more complcx e.X2mples thal involve
such things as crcaling camera CuIS,

manip\Jlaliflg carner.. oriental ion, mo\' ing

Actors along paths, and adding lext into
your movies. B~ Ihe end of lhis chapter,
you'll have a solid fo undatJon for rhe

methods required to develop your own
Malin~e culscenes or comple(e machinima
tilms.

Introduction to the
World of Machinima

FIGU RE .13.1 The Matiflee interface.

[n loday's gaming world, in-game animaled
movies have become very po pula r, YOll COl n
find them in many games, They can further a game's plot, enhance the action, or <.each you more

about Ihe characlers ina game. In facl, many games begin by playing so me son of movie designed
10 give players perri nenl informar io n. Th is in formarion can be a his lOry of the game's slOI)' line, ~

preview of lhe gameplay, an introduclion to (he main chu.3cter, or anything that would promote

the game 0 r inform the player.

Until only a few years ago. these movies, oflen re(erred to as cutsu11es, were created In external 3D
animJlion applications, wen as 3d.s. max or Maya. The fin;')l animation was then rendered into a

movie, and Ihe game was scc to play chese movies at specific points throughout gameplay.

As gaming engines evol\'ed and lheir graphical capabilities were enhancw, real-lime C\llscene.s.
became po.ssible. Game sludios were tinally able to develop their movies wilh Ihe game engjne
ilself, inslead of having (0 render rhem from 31)01her appliotion. Level designers oould develop
(lIe "s£{" ({he level), add in Ihe "aclors" (ch.1f.acrers), and script a series o( events to take place.

These eve nIs could be an)'l hing---dialogu e uc{wee n. characters, moving objecls, sou nd effects 0r
music:, explosions, or any other cmematic component or dIea needed for the movie.

As the abilily (0 usc the game engine [or cinem;!.tic cuts.cenes comlnlled to improve, tools were

created 10 ea!oe lhc pr<xe~ of develop Ing real-time movies. 1l,ese 10015 became more robusl and

easier to use, allo~,ng more people to gel Involved in the process of creating thelf own mllll

movies, From Ihis c.a me the bIrth o( T)1(JCn Im'rna, lhe process o( IiImmak.ing wIlhin a comp Lller·
generated, real·lime 3D en\'ironmenl. Today, machinima is qUIckly becoming i\ popular method
for creating animated movies and sh orIS. There's even an an.nual Machirllma F~ m Fesllval ,vhere
fi 1m makers compele (or awards In several 1)1 m-related C2tegories.
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With the Runtime Engine or Unreal Tournament 2004, machinima movie development has been

made easy by crea{ing Matinee sequences. The MJ.tinee tool has been developed and imple

mented into Unreal£d to make the process of crealing these sequences fasr} efficient, and simple.

The next section CO\ier~ the Matinee system and discusses how it GUl be used to creale these

sequences.

Overview of the Matinee System
Before you begin looking at the Matinee interface in more depth, take a minute 10 read about the

elements uwolved in a Mal [nee sequeoce. At th.c heart of Lhe S)'Slem lies the Sc~ne Manager Actor.

This Actor is necessary for creating a Matinee sequence. Although the Actor em be created

through the AClor Class browser, generating it io the Matinee interface is notably C:lsier. Finding

multiple Scene Managers used throughou{ a ~cen~ is not uncommon. One manager might be

responsible for controlling the whereabouts of the viewport camerJ (the C3me:r;t through which

you play the game), and Ihe other manager might h,mdJe moving an Actor.

As its name implies, me Scene Manager is a management system. Tt manages a series of Actions

and gives you control over how the sequence is ca rried out. Depending on the Scene Manager's

configuration, these AClions enable you 10 control the movement of the viewport camera or

another Actor in Ihe level. [f yOll ned to control both, you need two Scene Manager~ in your map.

Actions define where a C1mera or Actor needs to be al a specific time. Location and orientation

are determined by imerpolQliolJ POintS, which are as.sociated with each Action, The time between

twoyetions is the amounl of time the system takes 10 mov-e the Actor from one interpolation

point to another or the amount of time an Actor pauses at a given point.

Each Action can have a ust of Sub Aetions, which give you additional connol over what's going on

in the scene, such as controlling the camera's orientation, Cadi,ng in or out of Actions. controDing

game speed. or triggering orher Actors. AJthough a simple Ma{jnee sequence doesn't require Sub

Actions for every Action, generally Sub Actions are necess~ry to dchicvc the look you wan!.

FIGURE :1.3.2 illustrates a simple Matinee sequence in which a camera moves along a path. The

sequence is composed of a single Scene Manager that governs til r~e Actions. J11 this scenario, after

the Scene Manager is activated, viewport camera control is handed off to the Scene Manager and

un no longer be influenced by the player. The Scene M<lOager moves the camera from Action to

Action, its location determined by associ;lled interpolation points. As the firsl and third Actions

are initiated, Sub Actions within the Act ions are lallnched, providing control over the camera's

orientation and producing fade-im and fade-ouls. When fhe last Action is rcached, camera con

trol is handed back to the player, and the Scene Manager goes into an idk state waiting co bl.: trig

gered ag.ain.
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Sceoo M nager
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FIGURE 13.2 Overview of the Matinee system.

One of the key dements in this example is the c.lmera, which is moving along a path. A camera

p,Hh is generJteJ afler you have created atleas( two Actions associated with interpolation points.

[nlcrp{)!,llion points are special Actors that level designers place In a scene. They are used to spec

ify the posirion and oriemation DC the c.an1l'f.l or Actor the Scene Manager is conlroUing.

During setup, level designers (re-.lle a series of interpolari0n points defining a camera or AClOr'S

location. ~ext, Actions are created, and the interpolation poinLS are then associated with their

respedive Actions. In this way, the Sane Manager is instructed where the camcr:l should be
located when th.lt Acti.on is performed. The Scene Manager also interpolates between the points

of two sequential Actions, creating J. path of .animation. By setting lhe Du,.a tion property of e~ch

Action, yOLl can control the timing of the sequence, or how long it takes the Actor to traver~e

the p.llh from onc interpolation point to the next. FI GU AE 13.3 demonst rate5 the

relJlionship between Actions, interpolation point~, and me resulting cameril and Actor paths that

are genrr'lted.
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FIGURE 13.3 How Actions create paths,

Two of the Action~ in FI GURE 1 S.:1 con ta lJl Sub AClions. Act ions are C4rried out linearly---one

alier the other. Sub Actions, on rhe o'her ha nd, are performed in parallel, me3ning they are aU

launched at [he ~me (fme when 'heir correspondmg AdiOrl takes place. The Scene Manager

processes ea.ch Ac.t io n in order, from the lOp 0 ( Ihe list 10 I he bolto m. As a11 Act ion is reached, all

ils Sub Actions are performed simultaneously. Eyen though Ihe Sub Actions fM an Aclion ncwr

in y3ralle\, you do have fine-tuned control over Iheir timing (hrough each Sub Action's Delay

parameter, which offsets [he lime at which (hey take place.

ASane Manager isn'] automatically activated when 11 level begins. Jt must be Irisgered before il
begi ns processing Acl ions. This triggering is caused by an event ,hat occurs w ilhi n the game, such

as a plzyer walking into a specific area, or by a seri pted sequence. UnriJ the manager is triggered,

it co nll0)s nothing.

The Matinee Interface
Now thai you haye a basic ul1derslanding of hOIll Ihe Matinee syslem works, you can take a closer

look al (he Matinee 1001. At its co re., Mat inN: is an in lerrace designed to ease lhe process or M:l·

tlng up and managing Scene Managers, Actions, and Sub Actions. Everything you do in ~vf.alinec
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can be done without this interface, but this approach to developing a Matinee sequence woulJ be

far more tedious.

To open Matinee, simply click the Matinee icon in the toolbox. The Matinee interface is

divided into four sections, each accessible through its own tao at the top of the interface: Scenes,

Actions, Sub Actions, and 1001s. The tlrst three sections are basic management systems for creat

ing and controlling Scene Managers, Actions, and Sub Actions. The final tab, Tools, gives you

access to three different tools for developing controlling animation paths within a sequence. The

following three subsections provide an overview of thesf tabs.

The Scenes Tab

In the Scenes tab, you can create new Scene Managers to add to your level as well as !emove them,

You can set and adjust Scene Managers' properties and organize the order of your Scene

Managers. The tab also provides access to a Preview window to view your current progress on

your sequence. FIGU RE 13.4 illu~trJtes the functionality of the Scene tab.

Delete Scer.e

Duplicate Scene Move Scene Up

Add New Scene Move Scene Down

Scene Window

t------,--++-- Open a Preview window

Properties for selecled Scene Mar.ager

FIGU HE .13.4 Overview of the Scenes tab.

Notice that each Scene Manager in the Scenes tab has a teal bar across the bottom, designed to

show you important events along that scene's timeline. Actions in your scene are represented as

small yellow tick marks on this bar, Areas of the timeline alternate between bright and dark teal

to differentiate from one Action to the next.
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In the Actions tab, you can add new

Actions to the selected Sane Manager. You

can also copy an Action and delete Actions
from the Scene Manager. You can also

adjust the order of your Actions, and
this tab also includes 3 Preview window

to check out your current progress.

FIGURE 13.5 shows Ihe interface of the

Actions tab. The buttons for this tab per
form the same functions as those [or the

Scenes tab. The Actions appear in the

Actions window, with the properties for
the selected Action appearing below that.

Al the botlom or each Action is a small

white bar that indicates at what point FIGURE 13.5 Overview ofJbe Actions tab.
?Iong the timeline AClions lake place and

the duration of these Actions.

The Sub Actions Tab

In the Sub Actions tab (see FIGURE 13.6),

you can create new Sub Actions for the

currentJy selected Action. You can also

clone a specific Sub Action, delete a Sub
Action, or change the order of Sub Actions

in the list. This tab also provides acces~ to
the Preview window. The buttons for this

lab perform the same functions as those

for the Scenes and Actions tabs. The Sub
Actions appear in the Sub Actions window.

with the properties for the selected Sub

Action appearing below that.

Notice that the white bar underneath each
Sub Action doesn't behave the same as in

the Action tab because aIL Sub Actions of a

given Action are launched simultaneously.
Thert:forc, Lhey ilfen'l redll~ u~iJlg ii per

centage of the total timeline.

FIGURE 13.6 Overview of the Sub Actions tab.
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The Tools Tab

13

The Tools tab provides a small interface

for creating 'he Actors needed for a
Matinee sequence, You can create new

interpolauon points or LookTarge15 (see

FIGURE 13,7). J{ you're using UT2003

or UT2004, you can aJso create bOlh a
new interpolation poiot and a new Action

(see FIGURE 13,8). When the pair is cre·

~ted IOgelher in this fashion, the Action is

automatically associated with (he inter

polation point.

Creating a Simple
Matinee Sequence

Thi.1 seCl ion explains how to generate a
basic Matinee sequence, as shown in !he

following list:

~ Creace a Scene Manager.

• Creace cwo Actions (seuing
durations and so forth).

• Create two interpolation points.

• PrelTiew the sequence.

This section covers the steps in the pre

ceding list and provides tutorials so tha(

you can learn (he techniques behind each

seep.

In TUTORIAL 13.1, you construct your

first Matinee seq uenC<'. Note thllt I his

tutorial is done in Unreal1 Runtime. To
begin the sequence, you'll move a camera

{rom one point ro another (referred (0 as

Points A and B) over a specified amounr

of time.

FIGU RE 13.7 Overview of the Tools tab in
Unreal runtime.

FIGURE 13.8 Overview of the Tools tab in
UT2003 and UT2004.
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TUTORIAL 13.1: A Basic Matinee Sequence

1. In UnrealEd, open the map

Tutorial13_01_Start.urt. Take a
moment to become (ami liar WIth the

level's layout. Most of the action will

take place near the stable. Nalligare

your Perspective lIiewpo" somewhere

close to the stable, as ShOwn In

FI Ci. URE :13. a. Position arid orrenta

lion aren't impOrUlM at this lime.

2. Click the Matinee button in the tool·

box to open (he Matinee inteliace.

3. In the Scenes tab, Click the Add New

Scene [QJ loon to add a Scene

Managet Actor 10 yOllr scene (s.ee

FI GlJRE 1.3.10). Tne Scene Manager

is then 1I,,1ed 10 the SCene WIndow.

FIGURE 13.9 The s~lIe in which vou'll creat~

a Matinee movie.

;;; .

FI a. UHE 13.10 When you add the SCene Manager. Its iron appea~ in tile Perspect]v€ viewport.

4. At this point. the Scene Manager has a

10lal time of 0.0 seconds because rt Cur

rently has no ACtions. Select your flew

Scene Manager lfl the Scer\e wmdow.

Clicl( the ACHons lab. and click Ihe Add

New Action button ~. From the menu

that OpeflS, select ACtion MoveCame-ra.

INOTE
To !>foe the Sune Man.ager Actor In your ~rspective

lI\ewpon. simply dolly your camera ~clc (rom where
It currently Is.
l- _
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An Action is added to the Action window (see FIGURE 13,11). Repeal slep 4 10 add

another Action.

One of tne mosl Importanl functions of Actions is defining the lime at which the camera or
Actor will be ell Ihe assocIated tn(erpolatlon POIi'll. This Lime IS set through the Duratlon

property, which establishes the ttme needed to move from one Actor to the neJ(\.

13

Currently. you can see lhat 'he
Dura t 101'1 property of both AC\lons

is 0.0 seconds. Prev.ewlng 'he

scene in this state can cause
UnrealEd to crash because Irs
essenuaUy like Instructing the cam·
era to be two places at once.
Camera cuts typically use Duration

settings of zero. but they don'I crash

Unreal. Camera cuts are discussed

in more detail shortly.

6. Make sure the secon,1 Action is

selected (it will be highlighted); if
no!. click it. In the Properties sec
tion, expand the TilYle category and

set Dur <It .1.01'1 to 6. This seiling

tells the Scene Manager thaI it

takes six seconds to go from the

first Act,on 10 Ihe second Action.

However, where is the first pOint

actually located? You need 10

define the location and orientation

of both Point A and Point B so that

you can associate the InterpOlation
points with their corresponding

ActlOns.

6. In ltle Perspective vieWpOrt, positiOrl

your view exactly wh.ere you would

like your ClImera to start. Keel) in

milld that both pOsition and Orienta

tion of the camero are ImpOrwnt. as

they are used In the interpolation

point you'r about to create (see
FIGURE 13.12),

FIGURE 13.11 The Actions seen In the Action
window,

FIGURE 13.12 This Image shows what the c.9m·
era should see when you create the first Interpolation
pllint. which you'll do in the next step,



7. In the Matinee dialog OOX. chef< the

Tools tab, and click Add )nlerp(llaticn
Pomt. You'll see red ccosshairs within

a wMe box (see FIGURE 13.13).

II yoo navigate your 3D viewport so

thal you can see the icon. you'll find

tl\al the crosshal rs are realty an

arrow pointing In Ihe direction yovr

camera was looking (see FIGURE
13.14).

e, Now Ihat you have an In\erp()lation

pOlrlt. you need 10 specify Ihet il
will be assoclaled with Poinl A. All

you need to do IS lell the Iirst
ACtIon to use thlS pain!. Back in

the Matinee dialog box, go to (he

Actions tab, and select the first

Action.

S. In Ihe Properties secl~on. expand

the MatAction category, Select the

Interpolation p(l\nt in the viewport Iii
It lsn'( already). Click lhe word None

In the I ntPOHlt properly and then
chck Use (~ FIGURE 13.16).

FlOURE 13. 13 Looking Ihrou gh the interpol atlon
point

FI au If E 13.14 A SIde vlew of the Interpolation
point

FI GURE 13.15 Asslgnlng Interpolatlon points to Actions.
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FIGURE 13.16 Navigate to the point where the
camera needs to stop.

~ Add another interpoiation point.

~ Set this new interpolation
point as the IntPoint para
meter in the second Action by

clicking the Use button (see
FIGURE 13.17).

10. Now you need to set up Point B. Again, you need to use an Interpolation point to specify
where Point B is. Complete the following steps:

~ Navigate the Perspective view·
port as though you were the
camera moving jn a straight
line from the first interpolation
point to where you would like
to place the second one. For
this tutorial, move forward so
that you're lookmg into the
opening of the stable (see
FIGURE 13.16~.
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FIGURE 13.17 Adding another interpolation point and linking It to the second ActIon.

In any viewport, you can see that a line now connects the two interpolation points. Tne
viewport camera will follow this path.

11. You can preview the sequence through the Preview window. In the Matinee dialog box, click
the Preview window icon m. In the Preview window, click the Play button . You can now
watch your viewport camera move (rom Point A to Point B (see FIGURE 13.18).
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FIGURE 13.18 Using the Preview window to watch the camera travel between the two points.

12. Save your work.

END TUTORIAL 13.1

Congratulations on completing your first Matinee sequence! In the following sectiom of this chapter.

you'll improve and enhance this sequence to understand the tools and eftects available in Matinee.

Working with the Scene Manager
Although the Scene Manager's primary function is carrying out its list of Actions, it includes sev·

eral important properties with which you should become familiar. You can find these properties in

the Scenes tab under the ScencManager category. TAB LE 13.1 describes each of these properties.

TABLE 13.1 Scene Manager Properties

Property Description

Affect This property is Me of the most important for the Scene Manager. Its

setting determines whether the sequence affects the viewport's cam

era or a specific Actor, The two settings are AFFECT_ViewportCamera

and AFFECT_Actor.

AtfectedActor If you're uSing this Scene Manager to control an Actor, you need to
set this property so that the manager knows which Actor to control.

Assigning an Actor is easy; simply select the Actor in any viewport
and then click the Use button in the AffectedActor field, It the

Affect propeay is set to AFFECT_ViewportCamera, this properly is
useless because you don't need to specify an Actor to affect
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TABLE 13.1 Continued

Property DescrIption

bCinema t icView This property applies only if the Affect property is set to
AFFECT_VlewportCamera. When bCinematicVtew is set to True. the

camera viewport is displayed 'n letterbox format.

13

bHldeHUO

blooping

EventEnd

EventStart

(UT2003 and UT2004)

NextSceneTag
(UT2003 and UT2004)

As of this writing, the bHideHUD property appears to have no effect.

The goal IS allowing the designer to display or hide the heads·up diS'
play during playback of the Matinee sequence. The HUD automatically

vanishes at the start of a Matinee sequence.

When set to True, this properly causes the Actions to continue loop·

ing. In other words, after the last Action is reached. the Scene
Manager starts over at the first Action and continues processing.

This property enables you lo trigger an evenl after the Scene

Manager has completed Its Action list.

This property enables you to trigger an event at the same moment

the Scene Manager IS triggered.

This property triggers another Scene Manager as soon as the current

Scene Manager's Actions are completed.

Triggering the Matinee Sequence
The Matinee sequence you've created works great when previewed through the Matinee Preview

window, but currently, it doesn't play within the game. This is because the sequence hasn't been

told to play. In this next tutorial, you're going to see how to trigger the sequence to begin playing

it in-game.

Scene Managers lie dormant until they receive a broadcGlsted event that they're lislening for. By

default, that event is SceneManager. However, this name isn't very descriptive and can become

confusing, especially if the scene contains multiple Scene Managers. Therefore, changing your

Scene Manager's Tag properly to something more descriptive is always a good idea.

In TUTORIAL 13.2, you see how to launch your Matinee sequence during gamcplay by using a

standard trigger.
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TUTORIAL 13.2: Establishing a Trigger

1. Continue from TUTORIAL 13.1, or

open Tutorial13_02_Start.urt. In
the Scenes tab of Matinee, select

the SceneManager entry in the
Seerle window (see FIGURE
13.19).

2. Expand the Events category and set

the Tag property to Start'Aovie.
Now the Scene Manager IS liste0ing

for the StartMovie event to be $ent

through the level.

3. Open the Actor Class browser,

expand Actor> Triggers. and click
Trigger.

4. Right-elick on the grOUnd under the

first interpolation point. and choose
Add Trigger Here from the menu. A

trigger is placed above the ground
(see FIGURE 13.21).

NOTE
The name of the SceneManager has now
changed to StartMov'i.e. as shown in
FIGURE 13.20. Also. nOlice that the Total
Time setting Is now 6.0 seconds.

5. To see this trigger during runtime,

double·click the trigger icon to open

Its Properties window. expand the
Advanced category, and set the

bHidden parameter to False.

6. To set the event, expand the Events

section and set the Event property

to StartMovie. This event Will be
used to trigger the Seen!:! Manager,

FIGURE 13.19 Select the Scene Manager,

FIGURE 13.20 Set the Tag property to
StartMovi e.

7. You're now ready to test your sequence in the game. No compiling IS necessary because
YOu haven't affected geometry. lights, or bot paths. Simply run the level by clicking the Play
Map icon •. FIGURE 13.22 shows the result.
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FIGURE .13.21 Add a trigger into your scene.

When you run over the trigger Actor,
the StartMovie event IS broadcast.

Tile Scene Manager hears the
broadcast and takes control of the
camera's viewport, The camera then
begins at POint A and interpolates to
Point 8 over six seconds. After the
camera reaches Point 8. control is
handed back to the player,

9. Save your work.

END TUTORIAL 13.2 FIGURE 13.22 You can see the trigger in-game,

Controlling the Camera Path
So far, you have created a simple path for the camera to move on. This path is defined by two
points, A and B, making it ;) straight line (referred to as a Lrnear path). A straight line can be lim
iting when you want to have a Ilythrough in which the camera moves along a curvy path, for
example. To help resolve this limitation, you can set interpolation points to a Bezier path, allow

ing you to zdjust their shape with Bezier weight handles.

In TUTORIAL 13.3. you see how to change the pJl.th style, how to add interpolation points, and
how to use the bSmoothCorner property.
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TUTORIAL 13.3: Camera Path Enhancement

1. Continue from TUTORIAL 13.2 or open Tutorial13_M_Start. un. The palh between

two interpolation points can be one of two types: Linear or Bezier. The Belier palh prt>
vides two Bezier handles (or adjusting the line's CUNa1ure, In lhe ACllons tao. select ,he

second Action. Expand the Path category and set the PathScyle parameter to PATH·
STYLE_Bezier. Notice thaI your path suddenly beC<lmes a wifd ale (see fiGURE 13.23),
Actually. whenever you convert a path style (rom Linear 10 Be2ler. the seC1ion of lhe euJVe

in question changes to an S shape.

FIGURE 13..23 Top view showing the path.
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2. To &l1just the CUNeo simply drag one of

the Be21er handles around (see

FIGURE 13.24). ThiS handle can be
freely moved In 3D 5pace. so you can

move it In any viewport.

3. Continue to ex.p~rimentWith the

shape of the CUNe by using the

Be21er handles. While watching the

results in the Preview window (see

FIGURE 13.26).

TIP

l
in UT2D03 ilnd UT2004, you can right-click Dn Ihe line

and choose Straig/l1en Curve to Quickly Slraigh1cn a

I curve._. .__... _.__.__ .. __ -'

TIP
If you deselect the AetJo/l$ In tile Aeti<lns tab of the
Maulloe dialog bo(. tile CUNe vanishes. Acscleo 8/1
Action to make it real>~r.
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FIGURE 13.24 Using \he Beziel handles to adjust the path.

FIG URE 13.25 h helps to preview the scene while making adjustments 10 the path.

4. Now try adding anolher Action inlo the mix. Make sure Ihe last Action IS seleC'ted, or you'll
insert on Action between the two Actions. Add another ActionMoveCamera and set Its
Duratlon to 4 (see FIGURE 13.2f1). You can czll this new Action Point C. It now takes a
total of SIX seconds to go from PO{(lt A to Point B and an additional four seconds \0 go
from Point B to POint C.
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FIQURE 13.26 Adding a third Action (0 (he Action window.

You can start to see how Ihe limeline

is being dIsplayed in the window. Look

at Ihe btlghl while lines al the bottom
of Act iOl1 s 2 and 3. Thes e line s mdl

cate when a specific ACt Ion IS aCllve.

NOTE
If you don't see the fines, re.select the third Action.

6. Open the TOOlS tab. and clIck Add Inlerpolation Point ID create a new Interpolation point

inside the stable. Keeo in mmd Ihal the camera needs 10 continue polntmg in the same

general direchon if you're going to get good results from the Interpolation. Back In Ihe

Mallnee dialog oox. click the "wons lab, and selecl tne Ihlrd ActIon,

6. Expand the MatAction category, and set I nt Po.!.n t to Ihe new Interpolation point by click·
ing the Use but10n (see FIGURE 13.27\. If thiS doeSl\'t work, make sure Ihe InterpolatiOfl

point Is seleCle<1 In the viewport

Currently. thiS new section or Ihe patn is linear. Play bacK the seQuence, and see what it

looks like. YOU'1l nollce a "h~cup· when the camera passes over the second intelpoJallon

point because you are going from a smooth 10 a linear interpolation.

7. To keep the path smooth, yoo need 10 converl the last Action's path 10 Bezler, Do that now

by selecti()g lhe Ihlrd Action in the ActiOl'ls lao, and expanding Ihe Path category. Set the

PatllStyle property 10 PATHSTYLE_BeZler (see FIGURE 13.28\. Play back the seQuence

again, and Mlice that the transiuon through the second interpolation point is smoother

now.
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FIGU RE 13.27 Assigning the new interpolation point to the second Action.

FIGURE 13.28 PathStyle set to Belier for the last Action to keep the camera movement
smo<Jth.
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As you select each Action, you see that segment of the patll highlighted in yellow. If the
PathStyle property IS set to Bezier, you'll see two Bezier handles. but what happens when
two segments joined by an interpolation point are both Beller? To better understand how
having multiple Bezief sections can affect your path. try the following:

.. Verify that the last Action is still selected.

• Select and move the Beller handle at the second interpolatIOn point (Point B), You
can see that it'S affecting the segment between the first and second interpolation
POints (see FIGURE 13.29).

FIGURE 13.29 Adjusting the Bezier handles at Point B.

• The two Belier handles are moving In tandem because of a paramNer setting In
the Path category, set bSmoothCorner to False (see FIGURE 13.30},

.. Try moving the Bezier handle again, Same thing: Both handles contmue to move
together. Now select the second Action and change bSmoothCorller to False, Try
movmg the handles again for both Actions. Notice that the Bezler handles are now
"broken: meaning you can point them In two separate directions. You now have
complete control over the handles' positioning.

8. Having total control over the Bezier ti1ngents might not necessarily be benefic It'll , however.
Play back the scene in the Preview window. and watch wl)at thp. camera does when it tran·
sitions from the first Dath segment to the second, Notice the sharp change in directlon
typically an undesirable effect.
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"FIGURE 13.30 Setting bSmoothCorner to False allows the Belier handles to be moved
independently of one another.

9. If you didn't mtend for this sharp change to happen, don't worry: it's easy to correct. Set

the bSmoothCorner parameters for both Actions back to True, and then try to move one of

the handles. The curve will become smooth again.

10. Adjust the curve back so that a smooth path IS est13blished for the camera to move from
outside to inside the stable.

11. Sove youl work.

END TUTORIAL 13.3

Creating Camera Pauses and Camera Cuts
So far, you have learned how to make a camera move along a path. The movie would be more inter

esting, however, if you could create pauses in the camera's movement as well as cuts from camera to

camera. TUTORIAL 13.4 introduces you to the techniques for accomplishing these tasks.

You'U begin by having the camera pause al the last jnterpolation point you added (Point C) for a

tol,11 of tluee seconds. After the pause is over, you'll do a camera cut to the other side of the stable.

TUTORIAL 13.4: Pausing and Cutting

1. Continue from TUTORIAL 13.3 or open Tutoria113_04_Start. urt. Add an ActionPause
Action to tne end of your Action window, and set its Ou ration property to 3.

2. Even though this Action represents a pause, you still need to associate it With an interpo
lation pOint. Use the last interpolation point (Point C) you added for this Action. You want

the camera to pause rather tnan move from its current location,
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3. Play back the preview. You'll find that you have a problem. When the pause Action is
reached, the camera snaps to the orientation of tile associated Interpolation point. So
what happened'> By default, a camera always looks down the oath It'S traveling. It doesn't
interpolate its orientation between the first interpolation pomt and the second one. In this
case. however, you net:d direct control over the camera's orientation. You learn how to do
this in TUTORIAL 13.5 by using a Sub Action. For now, leave it as it is and continue with
creating the camera cut.

4. To have the camera instantly cut to a new location after the 3-second pause is over. follow
these steps (see FI GU RE 13.31 for the results):

• First. add two new ActionMoveCamera Actions to the end of the Action Window.

• Leave the Duration property of the first new AcUon set \0 O.

• Set the Duratlon property of the last Action to 4. This senll'lg should give you an
instant camera cut after the pause, and at ihe cut. the camera will begin moving again.

• Create two new interpolation pomts: one on the opposite side of the stable and the
other inside the stable.

• Associate the new Interpolation points with their respective Actions. You should have
the camera cut to the outside of the stable and then let it move inside.

FIGURE 13.31 The camera cut is now in place.

6. Play back the preview. The camera does perform a camera cut. but Its motion is a bil Jerky,
You'll fix this problem in TUTORIAL 13.5 by using Sub Actions.

6. Save your work.

END TUTORIAL 13.4
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A Closer Look at Sub Actions
With Sub Actions, designers can stage a range of effects or events at specific times. You could say

that Actions "own" their Sub Actions. This doesn't mean that Sub Actions are required; they are

optional, but they can produce more advanced results than lIsing Actions alone. This section

focuses primarily on fWO Sub Actions: Orientation and Fade,

TABLE 1.3,2 describes the eight available Sub Actions and what they do,

13 TABLE 13.2 The Available Sub Actions

Sub Action

Scene Speed

Game Speed

Oflentation

Camera Shake

FOV

Trigger

Fade

Camera Effect

Description

The Scene Speed Sub Action enahles you to control the speed of the cur
rent Scene Manager. This Sub Action doesn't affect overall game speed or
any other Scene Manager, for that matter, All Actions and Suh Actions
belonging to thiS manager are affected. The key properties are Max (the
speed exiting this Sub Action) and Min (the speed coming into this Sub
Action). For example, if you enter a Sub Action with a Min value of 1, that
represents normal speed. If the Sub Action's Duration property is set to 2

and the Max value is ,5, the Scene Manager's speed would slow by half
over a period of two seconds and then continue at this speed. If you need
the Scene Manager to speed back up, you need to add a second Scene
Speed Sub Action with settings such as Max =- 1 and Min =- .5 so that you
enter at half speed and then increase to normal speed again.

The Game Speed Sub Action gives you control over the entire game's
speed. Tne Method of operatio(\s is the same as the Scene Speed Sub
Action. The entire game speed changes over the duration period you set
from the Min value to the Max value. Again, a value of 1 is standard speed.

The Orientation Sub Action enables you to control the viewport camera's
orientation. Several methods can be useu i:1 this Sub Action (or controlling
orientation. These methods are covered in TABLE 13,3.

The Camera ShClke Sub Action enables you to perform a camera shake
operation On the viewport camera.

The FOV Sub Action enables you 10 set the field of view for the viewport
camera.

With this Sub Action, you can broadcast an event.

The Fade Sub Action enables fade·ins and fade-outs to occur,

Camera Effect can be used to overlay textures over the HUD or apply
Motion Blur to the scene,
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Setting Camera Orientation

Now that you have the camera pausing and cutting, you need to ftx the abrupt snap the pause
caused. Controlling camera orientation is J task you need to deal with in nearly every Matinee
sequence. To do this in TUTORIAL 13.5, you'll use the Orientation Sub Action.

TUTORIAL 13.5: Inserting Sub Actions

1. Continue from TUTORIAL 13.4 or open Tutoria113_05_Start. urt. In the Matinee
dialog box, click the Actions tab, arld select the first Action.

2. In the Sub Actions tab, click the Add New Sub Action button ~. From the menu. select
SubActionOrientation.

3. The Orientatlor. Sub Action has four methods for controlling the camera, as shown in
TABLE 13.3.

In this tutorial. you're going to use the LookAtAc tor method, which requires designating
an Actor to serve as the camera's target,

TABLE 13.3 Camera Orientation Methods

OrientatIon MethOd

None

LookAtActor

FacePath

Interpolate

Dolly

Description

The camera doesn't change from its current direction,

The camera looks at :he Actor specified In the LookAt property.
Generally. using the LookTarget Actor is a good idea, as it stands out
In the level.

The camera looks in the direction it is moving.

When traveling between two points, the camera starts with its orien
tation matching the orientation of the starting interpolation pOint.
Over the time required to get from the first point to the second. the
camera interpolates its orientation to match that of the interpolation
point irs coming into.

When using the Interpolate method, making use of the
EaselnTime property is important. This property is the time it takes
(or the camera to cnange to its new orientation. If this property isn't
set, the camera simply snaps to the new orientation when It reaches
that point. Using EaselnTime gives you a way of smoothly interpolat·
ing the camera over the time of the two Actions.

If you want to have the camera perform a simple dolly (a push), you

can use this method of orientation. The camera inherits the orienta·
tion of the starting Action's associated Interpolation point and main·
tains that orientation as it travels to the next Action.
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4. In the Matinee dialog box, click the Tools tab. Position your camera in the Perspective view

where you want the LookTarget to appear-use a location in one of the stables. After the

camera is poSItioned, click the Add Look Target button. If you back your camera up, you

can see the newly created Actor (see FIGURE 13.32).

13

FIGURE 13.32 The LookTarget icon.

FIGURE 13.33 Setting the LookAt property.7. Save YOllr work.

5. The Actor is selected by default- While it's still selected. click the Sub Actions lab, click

the LookAt property. and click the Use button to add the selected Actor's name to the

field (see FIGURE 13.33). Make

sure to change CamOrientation to

CAMORIENT_lookAtActOf,

6. Play back the sequence through the
Preview window. Notice that the

camera slays fixed on the new tar·
get throughout the sequence,

Furthermore. you might notice that

after the pause. the camera contilt

ues to look at the target. After you

set a camera Orientation Sub

Action, the camera continues to use

the set methOd of orientation until
another camera Orientation Sub

Action IS reached.

END TUTORIAL 13.5
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Introducing Fades

Fade-ins and (ade- OOIS are an effeclive method of creati.ng cinematic-style Matinee Scqlll"IICC~.

They keep your movie (rom popping in or OUI too quickly ;md can be UM:d to cre1te dram.ltlc

effects 31 the beginn!ng and end o( youe sequenccs.

In TUTORIAL 13.6, you see how to add carner.! fades 10 yuur sequences 10 make them resemble

a "real" movie even more.

TUTORIAL 13.6: Fading In and Out

L Conllnve from TUTORIAL 13.5 or open Tutorial13_06_Start.urt. To create a fade-in,

open the Matinee dialog box, click the Sub Actions tab, select the first Action in }'our

Action window, an<l then add the SubAClionFade Sub Action.

2. 8y de/av1t, the fade IS set to {ade·oul. which WOuld be a strange ....wy to starl a mO\i1e. In

the Fade plopert1es, set the bFadeOut property to False to make the mOVie fade In. You

can see that the FadeCo lor property IS black by defaull. Chang'lng this color enables you

to fade Into or oot of a specific color. For Ihls tutorial. leave rt sel 10 black.

FIGURE 13.34 SettJngUle fade's DunH10n

JHoperty 10 three seconds.

3, 111 (he Tlma category. set Dura t lon
to 3 (see FIGURE 13.34). TlflS

setting means the fade in Irom

blacll Will take a t01'l1 Of Ihree sec
ondS. Test the effect by playing the

scene 111 the Preview window.

4. To make yOur fades a little more

advanced, yoo'li have the seQuence

lade OUI by the end 01 the pause and

then lade back In at Vle camera cut.

Add <mother Fade Sub Action 10 the

first Action. ThIs slep mighl seem a

bit str<!l1ge at first. but it enables you

to make use of the Delay properry.

6. If you add the Duration settings of

!.he nrst lour A.ctlons, yOu' I tind they

tOlfll 13 seCilnds. To make the sane

fade out over the last two seconds 01

the pause Action. set the Delay prop.

erty to 11 and Durat lon to 2.

6. Now you need to fade back in on the camera cut, Select the MoveC6mero Action \hal

Immediately follows the ActionPause ACllon. It's the second AClion WIth a DuraHon

setting of O.
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7. Add a Fade Sub Action and set its bFadeOut property to False and Duration to 2. Play
back the sequence. You should see the camera fade out at the end of the pause and then

fade back in after the camera cut.

8. Save your work.

END TUTORIAL 13.6

Using Matinee to Control Actors
Up to Ihis point, you've been using the Scene Manager to control your viewport's cameras.

However, as mentioned previously. you can have Scene Managers control Actors as well. The con

cept i~ the same; you $Iill have interpolation points associated with Actions, which specify the

time required to move from poir.t to point. The resulting path can be adjusted the same way a~

the camera's path. The only real difference is thaI you must tell the Scene Manager to control an

Actor and s?ccify the Actor to be controlled.

Tn TUTORIAL 13.7, you create a new Scene Manager that controls the location of your LookAt

Actor. By moving the LookAt Actor while Matinee is in progress, you can produce more dynamic

camera movements.

TUTORIAL 13.7: Moving Actors with Matinee

1. Continue from Tu torial 13.6 or
open Tutorial13_07_Start.urt. In

the Matinee dialog box, add a new
Scene Manager,

2. Set the new Scene Manager's Tag
property to MoveTarget (see
FIGURE 13.35).

The Idea IS for thiS Scene Manager
to begin at the same time the other
one does. You could easily do this
by setting the Tag property to
StartMQvie, the same name used
for the other scene. However, thiS

method isn't generally considered
good workfiow because it makes It
more difficult to quickly deCipher
whiCh Scene Manager is dOing what.
To solve this problem, you'll make
use of another Sub Action, the
SubActionTrigger.

FIGURE 13.35 Setting Ule new Scene Manager's
Tag property to Move Target.
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NOTE
If you're using UT2003 or UT2004, you can lise the
Even tS ta rt property of the first Scene Manager to
trigger.

Ho1tUlt"C" - HovrT03n]rl J

FIGURE 13.36 The path generated from the new
Actions.

FIGURE 13.37 Setting the new Scene Manager
to affect Actors instead of the player'S view.

3. Select the first Scene Manager, and

add the SubActlonTrigger Sub Action to
the first Action in the list.

4. Under the Trigger propertIes, set the
EventName properly to MoveTarget.

The Sub Action creates the
MoveTarget event, which triggers the
second Scene Manager because that
Scene Manager's Tag property is set
to MoveTarget. In thiS way, both
Scene Managers begin at the same
time.

5. Now you need to create <J path along
which your LookAt t;)rget can travel.
The method you use is up to you. but
don't forget you need two new If\terpo·
latioll pomts and two new Actions.
These Actions need to be under the
MoveTarget Scene Manager. Set the

Duration property of the second
Action to 12. FIGURE 13.36 shows
an example of a path created by two
new Actions.

6. Return to the properties of the new
Scene Manager. Under the
SceneManager section, set the follow
ing parameters (see FIGURE 13.37):

Affect: AFFECT_Actor

AffectedActor: Select the
LookTarget ilnd click Use

7. Play back the preview. What went
wrong? If you play the preview back
with the second Scene Manager
selected, you see the viewport move
along the path. as though you were
controlling the camera again. If you
preview the first Scene Manager
instead. it appears that nothing has changed. (You need to close the Preview window.
select the first Scene Manager, and then reopen the Preview window to see its playback
using the correct Action's path.) This happens because the SubActiofiTrigger's event broad·
cast never occurred. You need to actually run your map to test it out. Aun the map now.
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8. After testing Ihe mop. you might need

to tweak the location of the new Inler
polation points or the Duration sel

tlng of the second ActIon. If your
LookTargel seems to be standing still
for Ihe first part of Ihe sequence.

simply lower liS Duration setting.

END TUTORIAL 13.7

TIP
II> make It easier to $U tile Looklarget In-game, you
can make it visible by opel)jj)g its properties and setting
bHldden (found in the Advanced category) to False.

Adding Text to Your Cutscenes
Another cinematic-style effect you can add to your movies i5 text, especially if you're creating an

intTO movie for your g2me. This text can be the game's name, opening credits, or any other kind

o( message you wanl players LO read. At this poinl, you should be gef1ing the hang of Matinee and

how to use il 10 set up your own scenes.

In this two-pare tulorial, you USt' lht' Camera Effect Sub Action 10 add cUSlom lex! to your movie.

In TUTORIAL 13.B, you creale a c:u~tom laWre in PhOloshop and Import il into the myLevel

I,acka ge In Unrea IE.d.

TUTORIAL 13.8: Text Creation, Part I-Creating and Importing

1. Continue from TUTORIAL 13.7 or

open Tutorial13 _08_Start. urt.
Open Pholoshop and create a new
Image with the fOllowing options:

Width: 1024

Height: 1024

Mode: RGB Color

Contents: Transpareflt

2. Set the foreground COlor to red and

the font size to 174 PI. Select any

fonl.

3. Use the Text tool 10 create some

text. For this example, Ihe lext A

Mat inee Product ion was used

(see FIGURE 13.38).
fiGURE 13.38 Adding text to the document.



5. In UnrealEd. open the Texture browser and import the Matlnee_Text, tga file.

4. Save tne file to your hard drive as Matinee_Text. tga. Be sure to set your options to

32 bits/pixel.

----------- -

6. In the Import Texture dialog box, set
the following:

Package: myLevel

Group: Matinee

Name: Matinee_Text

Adding Text to Your Cutscenes 497

NOTE
If you didn't set bAlphaTexture to True, you won't
be able to S~ anything but this graphic when you dis·
play the ll>-Xt. The alpha property is used to cut away
everything except the text.

7. When you import the texture. the Image mlghl not look like what you expected. as shown
in FIGURE 13.39_ Don't worry. You can fix this by adjusting a single property. Select the
newly imported texture, righl·click the texture, and choose Properties.

a.
-IDee
Clion

FIGURE 13.39 The text might look a little scary at first!

8. In the Texture Properties dialog box, expand the Surface category and set bAlphaTexture
to True to correct the problem. Close the dialog box.

END TUTORIAL 13.8

Now that you have added the texture to the scene, you can use it in your Matinee sequence in

TUTORIAL 13.9. For this example, the text should fade in three seconds after the movie begins.
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TUTORIAL 13.9: Text Creation, Part II-Fading Text

••;tlmet: - ~toJr1:HoylC .

FIGURE 13.40 Adding the CameraOverlay effect.

5. Back in the CameraOverlay Sub
Action, click the OverlayMaterial
property and then click the Use but·
ton to assign the selected material
as the overlay_

1. Continue from TUTORIAL 13.8 or open Tutorial13_09_Start. urt. Make sure the
Matinee dialog box is open_ Select the StartMovie Scene Manager.

2. Verify that the first Action is highlighted, arid add the SubActionCameraEffect Sub Action.

3. Expand the CameraEffect property and click CameraOverlay (see FIGURE 13.40). Click
the New button to see several new properties.

4. In the Texture browser. verify that
the Ma tinee_Te xt texture is
selected.

6. Set the O.isableAf terDura tiO.1

property in the CameraEffect section
to True. If you don't do th is, the text
remams in your viewport for as long
as the game runs, even after the
Matinee sequence has finished and
control is handed back to the player.

7. Set three final properties:

13

StartAlpha: 1

Delay: 3

Duration: 2

8. If you play back the scene in the
PrevIew WindOW, you won't see any

text. To see the CameraOverlay Sub
Action work. you need to actually
launch the map and trigger the
sequence. fest it now. FIGURE

13.41 shows the results.

At this point, the texr is being dis·
played dunng the movie as you've
mstructed It to do. There are a few
ways you can display the text. In this
example, the text pops In and pops
out, but in the next few steps, you'll
make it fade in and fade out.

FIGURE 13.41 The text is now visible in-game
when the Matinee sequence is triggered.
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9. Set StartAlpha to 0 and EndAlpha to 1. These settings tell the Sub Action to start by not

drawing the overlay at all. The image slowly fades in (from 0 to 1) over the specified dura·
tion, In this case, it takes two seconds for the text to fade all the way in.

10. To get the text to fade out. add another SubActionCameraEHect Sub Aclion,

11. As before, create the CameraOveriay Sub Action and (l ssign Ma t er ia1_Tex t to the

OverlayMaterial property.

FIGURE 13.42 Setting tile text to fade out over
a two-second duration,

Duration: 2

12. Set the following properties (see

FIGURE 13.42):

StartAlpha: 1

EndAlpha: 0

Oi sableAfterDuration: Fa Ise

Delay: 5

Now lake a look at what you've

done, By reversing the StartAlpha
and EndAlpha settings, you have

Instructed the overlay to draw I'lt

100% and fade out over a duration
of two seconds. You have delayed

this Sub Action from processing for
five seconds. Think about it: You

have already used the first five sec

onds of the movie for the first text
overlay (three-second delay and a
two-second duration), so if you delay

this Sub Action by five seconds.
everything should work out perfectly.

13. Play·test the level in-game one (ina I time. Verify that the text now fades In and out.

14. Save your work.

END TUTORIAL 13.9

Adding a More Cinematic Feel
Your sequence is nearly complete, However. you can give it a more movielike feel by adding ~ Jet

terbox effect at the top and bottom of the screen. In TUTORIAL 13.10, you see how to do this

by adjusting the bCinematicView property.
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FIGURE 13.44 You can place the ScriptecITrigger anywhere in the level.

8. Beneath the new
ACTION_Tr iggerEvent you just cre·
ated is the Event property. Set it to

StartMovie, the sarne event your

onginal trigger used,

7. Launch your map. Because there

are no latent Actions before the
ACTJON_Tr iggerEvent, the Action
takes place immediately. without any

input (rom the player. This triggers

the Scene ManDger, which begins to

play the movie as soon as you enter
the map.

8. Save your work.

END TUTORIAL 13.11

FIGURE 13.45 Clicking the New button Is
required to commit the Action to the list.

Changing Levels with Matinee
As your scenes becom~ increasingly complex, you might wish you could divide them into differ

ent levels. Chaining levels logel her with Matinee is aCTUally quite easy and allows you to playa
transitional movie or sequence as your players move from one level to the next. In TUTORIAL

13.12, two simple levels named Levell and Levell are used, each one containing a Player Start,
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a light, and two interpolation points, You'Jl set up a simple Matinee sequence that begins in

Levell. and when you complete the sequence, Level2 is automatically loaded and its Matinee

sequc:nce begins playing.

TUTORIAL 13.12: Setting up Level1

13

j,. In UnrealEd, open the map Levell. urt.
which is a Simple room.

2. Open Matinee and create a new Scene
Manager. Set its Tag property to StartMov ie

(see FIQlJRE 13.46).

3. In the Actions tab, create an
ActionMoveCamera Action, and associate it
with the upper interpolation point in the map.

4. Create another ActionMoveCamera. Set its
Duration to 5, and associate it with the other
Interpolation point (see FIGURE 13.47),

5. Select the first Action, and click the Sub
Actions tab.

6. Create a SubActionTrigger Sub Action and set
the following properties (see FIGURE 1.3.48):

Delay: 4,99

EventName: LaunChLevel2

FIGURE 13.47 Two Actions should be
in the list.

FIGURE 1.3.46 Create a new Scene
Manager and set the Tag property.

FIGURE 1.3.48 Set the Delay and
EventName properties.



7. In the Actor Class browser. expand

Actor> Keypoint > AIScnpt >

ScrtptedSeQuence and click
SCJlptedTrigger. Place this tngger

anywhere in your level.

8. Set up the following Action list

(or the Scnptedlrigger (see
FIGURE 13.49):

ACTION_TriggerEvent

Event: StartMovle

ACTION_WaitForEvent

ExternalEvent: LaunchLeve 12

ACTION _ChangeLevel

URL: Level2

9. Save the map.

END TUTORIAL 13.12
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...-

. :.-....,

FIGURE 13.49 The Action list for tl\e
Seri pled/rigger.

In TUTORIAL 13.13, you set up your system if} the second level so lhat your Matinee sequence

jumps from one level 10 the other.

TUTORIAL 13.13: Setting up Level2

1. Open the map leve12.urt, shown
in FIGURE 13.50.

2. Open Matinee and create a new

Scene Manager. Set its Tag property
to StartMovie, just as you did
before.

3. In the Actions tab, create an Action

and associate It with one of the
InterpolatIOn points In the map.

4. Create another Action. Set its
Dura lion to 5. and associate it with

the oUler Interpolation point.

5. Using the techntques you have

learned. create a ScriptedTrigger
Actor somewhere In the level.

FIGURE 13.50 This is what you should see when
you open Leve12. urr.
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6. Set up the following Action list for the ScriptedTrigger:

ACTION_TriggerEvent

Event: StartMovie

7. Save the map.

END TUTORIAL 13.13

You can now test the sequence by opening the Levell. urt map and running it. Verify that as soon

as the level loads, the simple Matinee sequence launches, propeJling the camera forward. When the

camera reaches the end of its path, Level2 should load. Using this technique, you could ea~iJy estab

Lish a system by which players could finish a level, view a congratulatory movie of some kind, and

then see a preview of the next level. FI GU RE 13.51 demonstrates how this system works_

Using a Sc"ptedT"gger 10 da'sy-chain levels logelner

levell level2

--~
The
ActionChangelevel
Action will force lhe
new level to load

ACIIon l,sl

TnggerEvenl: StarlMovoe
Wa,tForEvenl. launchLevel
CnangeLevel: Level2

Action List

TriggerEvenl: StaJlMov'e

FIG URE 13.51 Overview of using a ScriptedTrigger to daisy-chain levels together.

Summary
This introductory chapter to Matinee has covered a wide variety of topics, from a simple overview

of the Matinee interface to creating your own ba~ic sequences, including fades and camera cuts, and

adding an aim for the camera. You've also learned how to create cinematic effects, sudl as movie

titles and letterbox formatting, and learned how to develop intro movies to levels and use a Matinee

sequence when jumping from one level to another. By now, you should have a basic understanding

of how Matinee works and how to create sequences for your levels. You can use these sequences to

animate the camera or Actors within the level. You should also understand how all these compo

nents are related and how they can be used to create interesting Matinee sequences.



Chapte

Creating Scripted
Sequences

In many games, you find that the player character is not the only ele

ment involved with the environment. Often the game drives many
actions and events to enhance the overall experience, For example,

you might be playing a game in ""hich you're moving through a sci

('nee laboratory and see scientists going about their duties, assistants

moving equipment, secretaries carrying important items, and so

forth, Within UnreaJ, these elements must be added into a level as
scripted scquem:es. This chapler covers how you can use the

Scriptf'dSeqllence Actor to create a varl"ty of custom events within

your Unreal levels.

Adding interactive or reactive game elements, making non-player

characters (NPCs) perform dctjOns, and other such events add an

incredible amuunt of gamepl<ly v<1[ue 10 your levels. For example,

say your character is behind a closed door, and you want a scientist

NPC on the other ~idc to open the door for you. With scripted

sequences, you can tell a bot, or NPC, [0 move to the but/on that

opens the door, st;;rt a door-pre:;sing animJtion, and then open the

door.
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To create these scripted sequences, you have the ScriptedSequencc Actor, lotated under Keypoint

> AIScript in the Actor Class browser. This Actor contains all the main functions for controlling
NPCs, or xPawns, and controlling how events are processed. Subsets of this Actor are the
ScriptedTrigger and UnrealScriptedSequence Actors. The ScriptedTrigger should be used when
handling events, as when you used it in Chapter 9, "Interactive Elements," to create an advanced
elevator. UnrealScriptedSequence Actors are used when you want to control the behaviur of bots,
as you did in Chapter 12, "Advanced Bot/AI Navigation."

This chapter starts with a general discussion of how to create Actions, the backbone of scripted
sequences. From there, you learn how to control the timing of events and see that certain Actions
are latent, meaning they must be finished before moving on, and some are not. Then you learn
how to use logical conditions to control whether certain Actions should occur.

Using an Actions List
Scripted sl'CJuences have an Actlons properly located under their AIScript category. This prop
rrty can hold J series of Actions that are performed from the lOp to the bollom of the list. This
series of A(Jions is known as the AetiorlS list. An Action can perform a variety of tasks: trigger an
evmt, playa sound. spawn an Actor, control artifical intelligence (AI), and much more. When a
level starlS, the first Action is performed. followed by the second. and continuing until reaching
the final Action in the list. Unless there's an Action that alters the sequence. such as an
Actlon_GOTOAC1ION. the ScriptedSequence carries out the last Action and then stops.

Using Latent and Non-latent Actions

Actions are categorized into two main lypes, depending on how they are performed: latent and
non ·Iatent. faten! actions «(Iuse Act ions in the Iisl to pause until the current Action is finished
before tht"y're carried oue Non-laterrt actions cause some effect or event and then immediately
proceed 10 the next Action without waiting until the fint Action is completed. For example, jf you
Lise an Act loo_PLAYANIM to play an animation of a character waving. and then immediately fol
low It with an ACtlon]LAYSOUNO, both Actions would seem to bappen simultaneously.

TABLES 14.1 and 14.2 describe the available non-latent and latent actions.

TABLE 14.1 Non-latent Actions

Actlon

ACTION_ASSetPlayerSpawnArea

ACTION_ASTeleportToSpawnArea

DescrIption

Enables or disables

Play er'SpawnMa nage rs,

Causes players to spawn at

points controlled by the
specified Player
SpawnManage r.

Notes

Used in Assault
gametype

Used in Assault
gametype
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Action
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Description Notes

ACTION_ChangeLevel

Action_ChangeObJectiveTeam

ACTION_ChangeScript

Loads another map. Useful for

creating Matinee sequences
that span multiple maps.

Updates the specified objec

tive so that it belongs to the
specified team.

Leaves the current script and

starts running the specified

scnpt.

AI control only

AI control onlyACTION_ChangeWeapon

Action ConsoleCommand

Action CROUCH

ACTION_DamageActor

ACTION_Damage Instigator

Causes the controlled pawn
to switch to the specified

weapon. The pawn must

already have the weapon in
its Inventory.

Performs a console command.

Causes the controlled pawn to AI control only

crouch until an ACTION_Run or
ACTION Walk is used.

Causes all Actors with the

specified Tag to receive

damage of a certain type and

amount.

Damages the player or NPC
that caused the current script

to run.

ACTION_DestroyActor

ACTION_DestroyPawn

ACTION_DisableObjective

ACTION_DisableThisScript

ACTION_DisplayMessage

Removes all Actors of the
specified Tag from the level.

Removes the controlled pawn

from the level.

Allows an objective to be
bypassed and counted as

complete.

When performed, causes the

In-game (bot) AI to ignore this
script. Applies only to

UnrealScriptedSequence Actors.

Displays or broadcasts a

message to one or all players

in the game.

AI control only

Used in Assault
gametype
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Action

ACTION_EndSection

ACTION_Fireweapon

AGTION_FireweaponAt

Actlon_FORCEMOVETOPOINT

ACTION_FreezeOnAnimEnd

ActiOrl_GOTOACTION

ACT ION_ GotoMenu

Action_IFCONOITION

Actiao_IFAANDOMPCT

Action_KILLINSTIGATOR

Description

Used to marK the end of a

group of Actions controlled by
an Action_IFCONOITION or

Action_IFRANDOMPCT.

Causes the controlled pawn
to start or stop firing its

current weapon.

Causes the controlled pawn

to shoot at an Actor, desig·

nated by a Tag.

Snaps the controlled pawn

to the specified pomt.

Freezes the controlled pawn's

animation and physical move·

ment after its current anima·
tion finishes.

Jumps the scnpt to the speci·

fied Action. Useful for making

scripted sequences repeatable.

Displays the game's main
menu. A custom Illenu class

can be specified with the

MenuName property.

If the associated
TrjggeredConditions
bEnaoled property is False,

It causes the script to sklO to

the Aclion after the next
Aclion_ENDSECTION.

Based on the given probability,

the script mayor may not j
ump to the Action after the

nenAction_ENDSECTION.

Causes the controlled pawn

to jump. The type of jump can

be control leo with the
JumpAction property.

Kills tne player that caused

the script to run. Should be
used only with ScriptedTriggers.

Notes

AI control only

AI control only

AI control only

AI control only

AI control only
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Action_LEAVESEQUENCE

ACTION_LocalizedMessage

Action_PlAYAM8IENTSOUND

Action_PLAVANNOUNCEM£NT

Action_PLAYLOCALSOUND

Descript 10 n

Exits the current script and

ignores any further AclJons.

Broadcasts a localized rnes:.age.

Causes the &rlptedSeQuence's

AmhientSovnd properl.les 10
be set according La this aclion,

Causes the controlled pawn 10

play an animal ion,

Plays an announcement sound

in the game's currenlly selecLed

announcer vo Ice. The specified

sound must be a valid annoul\Cer

sound.

Causes the Instlgator"s view \0

shake as IhOugh hit by a weapon,
Occurs only when the inshgalor

is within a specified radius from

the Scnpteds.equence ACIOI.

Causes all olaye($ 10 heal a
sound. nIlS sound is not location

based.

Sets the cuuent music to the

specified song. This Action can

set the mUSIC lor Just Ihe

instigalOI or 101 au players In

the level. The song must be a

tile from the MusIC dHectory
under the folder wnere you

Installed Ut1real, WIthout the

.ogg extensIon. FO! example,
If you want to play I<R .O~ 1 . ogg.

you would set the $C1fi9 property
to I(fl -1).1.4 I.

Plays a sound thal originates f(om
the ScriptectSeQuence Actor.

Causes the controlled pawn to
run when movmg. [DIsables 'he
effect of Ac t ion_CROUCH and
ACtiOn_WALK.)

Using an ActIons LIst 509

Notes

Al control only

Al control only
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TABLE 14.1 Continued

Action Description Notes

Actlon_SETAlEATNESS Sets the alerlness of Ihe
controlled pawn.

Hides aU Actors with the
specified Tag,

ACTlON_SetObjectiveAct iveSta tos Oelermines whether the

specified objective lS aCllve.

AI oon[rol only

Used in Assault
gametype

A[ control only

Sets the instigalor'S current
physics Iype.

Sets the [ocatlon that the

COnlrolied pawn tries to look

toward, Because Ihis Action
is non-latent, you need m<)re

time to pass after this Aetior.

to see the effect.

Caoses the controlled ~wn Lo AI cQ./ltrol or.ly
shoot at ils current target.

14

Spawns an Actor of the SpeCI'
fied class. The Actor can be
spaWI'\ed from the location of

Ihe SCnptedSequeJ)ce Actor

or from a controlled pawn'$

location. Addit(or.allocatlon

and rotation offset can also

be 5el.

Causes the controlled pawn AI conlrol only

to stop playing Its current
animaTion.

ACTION_StopShooting Aborts the effect of Al control only
ACT10N_ShootTarget,

Causes the heads-up display's Used in assault

(HUO's) currenl subtitles

to advance.

Causes the oonuolled pawn A[ control only

to throw its curren! weapon in

the direction specified by the

WeaponVeloclty propertY.
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TABLE 14.1 Continued

Action

Action_TRIGGEREVENT

Action USE

TABLE 14.2 Latent Actions

Descri ption Notes

Causes the specified event to
be broadcast.

Causes the controlled pawn to
use the player.

Causes the controlled pawn to AI control only

walk when moving.

Action

Action DrawHUDMaterial

ACTION_FinishAotation

ACTIONJreeze

Description

Renders the specified material as an

overlay onto the HUD. You can specify
the width. height, and size the material

is displayed at. Also. you can set the

amount of time the matenal is displayed.

Waits until the instigator or
controlled pawn is facing its

goal.

Freezes the controlled pawn's

animation and physical

movement.

Notes

AI control only

Actioo_MOVETOPOINT

Action_MOvETOPLAYER Causes the controlled pawn to navigate

to the instigating player. Script running
continues when the pawn reaches the

player.

Causes the controlled pawn to navigate
to the specified point. Script running

continues when the pawn reaches that
point.

ACTION_PlayExplosionSound Plays a random explosion sound. With
the SoundEmitterActorTag property,

you can specify a location for the sound

to be emitted from. (Default location IS

the scripted sequence itself.)

Action TELEPORTTOPOINT Teleports the instigator to the specified

point. The audiovisual teleportation
effect can be enabled or disabled.

AI control only

AI control only
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TABLE 14.2 Contlnued

14

Action

Action_TURNTOWAADPLAYER

Action_WAITFOAANIMEND

Action_WAITFOAEVENT

Action_WAITFORPLAYEA

Action_WAITFORTIM~R

Description

Causes the controlled pawn to face the
player,

Causes SCript running to pause until the

controlled pawn's current animation
finishes.

Causes script running to pause untIl the

specified event is broadcast,

Causes script running to pause until the

player IS withlJ) the specified distance of
the controlled pawn.

Causes script running to pause for the

time specified. Note that the time is in

seconds.

Notes

At control only

AI conlrol only

AI control only

TUTORIAL J.4.1 shows how to creale a simple ScriptedTrigger that uses both latc-nt and
non-Ialent Actions to open a door in a complex manner.

TUTORIAL 14.1: Using a ScriptedTrigger

1. Open TutorialI4_01_Start. ut2..
In this map, you'll create a
UseTrigger thai plays a sound,

opens a door, and turns on a

·caution" light.

2. In the Actor Class browser, navigate
to Triggers. and click UseTflgger.

3. Add Ihe UseTngger In front of the
door (see FIGURE 14,1). To make
the useTngger visible In-game, open
the Properties wmdow for the

UseTrigger, go to the Advanced cate

gory, and set the bHidden property

to False.

FIGURE 14.1 The UseTrigger placed in front of the
door.

4. Because you have three separate Actions to perform, this is a great place for a
ScriptedTrigger. Open the Actor Class browser, expand KeYPOIot > AIScript >

ScriptedSequence. and click ScriptedTrigger.
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5. Place the ScriptedTrigger next to the

UseTrigger (see FIGURE 14.2).

Although the location of a
ScnptedTrigger is irrelevant. place It
near the useTrigger because the two

triggers will be working with one

(lnother.

6. Open the PropertIes window for the

UseTrrgger, Under the Events cate·

gory. type MuIt iTngge r as the set
ting for the Event property. This

event will be the One that triggers

the chain of events.

7. Open the Properties window for the
ScriptedTrigger. Under the AIScript

category. select the Act lOns prop
erty, ar1d click the Add button. By

default, the Actions in the Actions list
begm evaluating as soon as the level
starts. In this case, however, you

don't want anything to happen until

you activate the UseTrtgger, ThiS

means you need to walt for the

MultiTrigger event to be triggered

before any Actions take place. To do

this, select Action_WAITFOREVENT

and click the New button. Sel the
EJ(ternalEvent property to

~ultiTrigger (see FIGURE 14.3).

Until this event IS triggered, the next
Action is not performed.

FIGURE 14.2 The ScriptedTrigger placed next to
the UseTrigger.
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FIGURE 14.3 One Actioo created for the
ScriptedTrigger.
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r
-~-- ----
NOTE
You need to manually enter MultiTrigge r for the
Even t property.

8. Now you need to add three Actions

to the list: one to play the sound. one
to open the door, and one to turn on

the light. Select the Act ions property

and click the Add button three limes.

For index (1), select

Act iOn_PLAYSOUND and click New.
Open the Sound browser. If you're using Unreal Tournament 2004, open the

IndoorAmbience package and select door10, If you're using the Unreal Runtime Engine.

open the EI.I_Runtime_A package and select door12. Back in the Properties window for
ACtiOfl_PlAYSOUNO, select the Sound property, and click the Use bulton.
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9. For mdex (2). selecL Action_TAlGGEAEVENT and click New. Because the Tag property fOf

the door is Blast()oor. set the Event property of the Action_TAIGGEREVE~Tto

BlastOoor.

10. For index [3L select Actlon_TRJG(;EREVENT and cOck New, The Tag property (or the light is

Cwt ionLight. so set the Event property of the Ac tio"_TRIG<JEREVENT (0 Caut ion Lillht.
This setting ac!\vates a dynamic light that's already in Ihe scene,

11. Save the map, and give It a tes1 spin. Note that the door opens, the sounds plays, and the
light swrtches on after yOI) hit the trigger. Also, notice thal although the Actions are takIng
place In a specific order, they all appear to be happening at the same time,

END TUTORIAL 14.1

Controlling xPawns

Now that you have an idea of how to control even,s, you're ready to take it one step further and

control actual non-player characters (NPCs). This brings anolher property of ScriptedSequence.s

into the spotlight: Con troll erCl ass. By default, it's set to NonL. For controlling an xPawn, you

must set It to Scr iptedCon troller. Basically, this scI ling overrides 'he Controlle reI ass for the

xPawn, allowing the ScriptcdSequence Actor to take control o( the xPawn and alter its behavior.

If you dido't use this setting, il would default to a bOI-style Al, which would, in effect. spawn an

additional player into the game.

To associate Lhe :<.Pawn with Lhe Sc.riptedSequence Actor, set the :<.Pawn's AZScrlptlag property,

found unJcr the Al category, to the Tag property of the Scr(pledSequence. lUTORIAL 14.2

demonstrates how to set up a simple saDano in which a S<:riptedSequence controls an :<Pawn.

TUTORIAL 14.2: Controlling a Pawn
-----------------------

L Open Tutona114_02_Start .ut2. In this tutorIal, you're going to creale an NPC tnal runs
to the player, beckons for the player to follow, end then opens the door, You already have a
series of PalhNodes set up for the NPC to follow; you just need 10 give the NPC the proper
commands, For more 'nformation on creating bOI paths, please refer to Chapter 12,

~Advanced BotjAI Navigation'-

2. First, you need to create the NPC. Open the Actor Class browser, navigate to Pawn >

UnrealPawn, and click xPawn, In the Top View, move the xPawn to the lower right of the
level, near the PathNode_ Rotate the xPawn to point toward the PathNode (see
FIGURE 14.4l.

J. Open the Actor Class browser; navlgate to Keypoint > AIScripc. end c!ic\< ScriptedSequence
Aclor. Place this Actor neXl to the xPawn,

4. In the Propertles window (or the &riptedSeQuence Actor, go to the Events category and
change the Tag property \0 Pawl)C<lntroller, Also. under Ihe AISCript Category, set the

Con t rollerClass property to Scr ipt~dCorrtroller.
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5. Now open the Properties window for
the xPawn and go to the AI category.

Set the AIScriptTag to
Pawn eon trolle r, which forces the
xPawn to listen for behavior com·
mands from the Scriptp.dSeQuence

Actor. After doing this, you'll see a
line connecting the
ScriptedSequence icon to the xPawn
(see FIGURE 14.5).

6. Now that everything is set up prop
erly, you can create the Actions (or
the xPawn to follow. Open the
Properties window for the
ScriptedSequence. First, you need
to wait for the player to nit the
UseTrigger. which sends the
CallNPC event, so add ~n

ActiOI'l_WAITFQREVENT and set the
ExternalEvent toCallNPC.

7. Second, tile xPawn needs to move
to the player. To do this, add an
Action_MOVETOPOINl and set the

DestinationTag to CallPoint.
which is the Tag property of tile
PathNode next to the UseTrigger.
Because you have PathNodes lead·
ing to the DestinationTag, the

xPawn moves correctly from
PathNode to PathNode until reachmg
the destination.

FIGURE 14.6 ScriptedSequence connected to the
xPawn.

8. At this point, you need the xPawn to look at the player. To do this, add an

Action_TURNTOWARDPlAYER.

9. With the xPawn now facmg the character, you must make sure the xPawn is stationary and
not playing any animations. For this, add ar. Actl.on_WAlTFORTIMEA and set the

PauseTime to 0.5. Now add an Act ion_PlAVAN lM and set the BaseAnim to
gesture_beckon. Because Action_PLAYANIM is non-latent. you need to make sure the
animation ends before moving 10 the next Ar.lion; therefore, add an
Actlon_WAITFORANIMENO and leave Channel set to O.

10, To make the xPawn turn toward the console as he moves toward It. add an
Actlon_SETVIEWTARGET and change the ViewTargetTag property to ConsoleTag. As
before, add an Action_MOVETOPOINT and set the OestinationTag to ConsolePoint,
which is the Tag property of the PathNode in front of the console.
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11. As before, you need to ensure that the xPawn IS stationary and Isn't playing any other ani

mations. So add an Action_WAITFORTIMER and set the PauseTime to 0.2, which IS lower

than before because the previous Action_SETVIEWTARGET should already have the xPawn

facing in the right direction. Now add an Action_PLAYANIM and set the BaseAnim to

gesture_halt. To ensure that the animation ends, add an Action_WAITFORANIMEND,

12. Finally, you need the door to open. Add an Action_TRIGGEREVENT and set Event to

BlastDoor, the Tag property of the door Mover.

13. Save the map and run it. When you're in·game, go over to the UseTrigger and press the
Use key (the E key, by de1ault), If it doesn't work correctly, use TABLE 14.3 as a

reference for the Actions in thiS tutorial.

TABLE 14.3 Actions for the ScriptedSequence

N/A

N/A

BlastDoor

Properties to Set

PauseTime = 0.5

ExternalEvent = CallNPC

DestinattonTag = CallPolnt

BaseAnim = gesture_halt

N/A

BaseAnim = gesture_beckon

ViewTargetTag = ConsoleTarget

DestinatlonTag = ConsolePoint

PauseTime = 0.2

Event

Action

Action_WAITFOREVENT

Action_MOVETOPOINT

Actioo_TURNTOWAADPLAYEA

Action_WAITFORTIMEA

Action_PLAYANIM

Action_WAITFORANIMEND

Action_SETVIEWTARGET

Actioo_MOVETOPOINT

Action_WAITFORTIMER

Action_PLAYANIM

Actlon_WAITFORANIMEND

Action_TRIGGEREVENT

Index

10)

(1)

(21

(31

[4)

[5J

[6J

[7)

[8)

(9)

(10)

[11)

END TUTORIAL 14.2

You can also use ScriptedSequences when you're creating intro movies with Matinee and custom

animations. TUTORIAL 14.3 shows you how to use a custom character with custom animation

to create a movie sequence. For more information on using Matinee. see Chapter 13. "Matinee:

Creating Custom Cinematics."
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TUTORIAL 14.3: Using Matinee with ScriptedSequences

FIGURE 14.6 xPawn placed in the l~l.

fiGURE 14.7 Custom character rotated and
maved into position.

2. To start off, place an x.Pawn in the

center of the room, which is located

In the center of the level (see

fiGURE .14.6). Change

Control!erClass to

SCI" LIHedCont roller. Also, unDer

the UflIealPawn category, set the

bNoOef ault Invent ory ptoperry to

TrUll SO that the character isn't

halOing a gun,

3. Because yoo want to use your own

cuStom CharaC'ler, nOI the defClult,

open Ille Animation browser so that

you can load the correc' charaetef.
Open the Chapter14_Ani.m.u\o( ll8Ck·

age. WIth ,hiS character viSIble 11'\ the

browsef, open the Properties WlndllW

for lhe lCPawn. Under the Display cat·

egory. select the LlaSIl ptopeny and

chck Use. Also, ~Iecl the Skins

property and click Empty. RC>\1Ile tt\e xPawn so that It J1{lmts between the two interpolation

pOintS. Also. move the :&awn so that 11 rests on the floor (see FIGURE 14.7). Because

you need to control thiS pawn w'rth a ScnPledSeQuence, go to lhe AI category and set the

AJScnpt Tag property to LfCl>ntrl>llar.

1. Open Tutorial14_03_Start.ut2.

In thiS level. you have a Matinee

seQuence where the camera flle$

around the level and circles around

the mSlde of a room. InSide this

room, you're going to place a CU$'

tom character and cause It to play

some of the custom animation

inc;uded with it.

4. NeX1, create a SulptedSeQuence near the xPawn, Under the Events category, dlange Ule

"fag property tl> LfCont roller. If you ran the level now, you would notice that the xPawn is

in the wrong pOse. Playing an aIllmatlon a,t this point would cause the t:t\aracter to snap

(rom this pose to the first frame of Ihe animation you want. To correct thiS. you have a sin·

gle-frame animation (KickSlart) thai leaves the character at the correct pose for starting

the animation. From there, you need to start the M811nee sequence. which can be trig

ger€:d wlttllhe StarUJov1e. evenl. TABLE 14.4 shows Ihe Actions needed for the

SCrlptedSeQuence Actor.
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TABLE 14.4 Actions for the ScriptedSequence

Index

[OJ

[lJ

Action

Action PLAYAWIM

Action_TRIGGEREVENT

Properties to Set

BaseAnl~ = KlckStart

Event = Start~cvle

14

5. Because you want the anlmallon to start when the camera enters Ihe room. you need to

have the Matinee sequence trigger an event. To do this, open the Matinee dialog box.
Selecl the StartMovie scene and switch to the ActIOns tab, Then select the second Action

from Ihe bottom. Now switch to Ihe Sub Act\oos tab. and seleGt the third Sub Act\on (rom

the top. Add a SubAc\\onTrigger, Under the Trigger category. set the Eve ntNallle pmperty to

St artAct ion.

6. With that set up, reopen the ScriptedSeQllence properly and add the (\nal Actions that

will wait (01 the event, as shown in TABLE 14.5, and Ihen play the ar1lmal)OJ). At the very

end, Quit to tile main menu,

TABLE 14.6 Actions for the ScriptedSequence

Index Action Properties to Set

(2) Action WAITFOAEVENT ExternalEvent = StartAct lOn

(3) Act ion_Pl..AYAN 1M 8as eAI'llm = KiCk

(4\ Action_WAITFORANIMEND NjA

(5] Action_G.ot:~enu NjA

7. That's itl save and run the map. The

character's animation won't begin

until the Matinee seQuence lells rt

to. FIGURE 14.8 shows a screen

shot of the custom animation,

END TUTORIAC14.3

FIGURE 14.8 The character playing the custom
animation.
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Logical Conditions
Although the simple Actions you've seen so far can handle most situations you run into, at times

you want the result or running of a script to differ depending on external conditions. To this end,

you have the following three Actions (described previously in TABLE 14.1): Action_IFGONDI·

nON, Action_ENDSECnON, and Action_IFRANDOMPCT. To use the Action_IFCONDITlON, you

must also have a TriggeredCondition Actor, which is located under the Triggers section of the

Actor Class browser. When this Actor is triggered, an internal value toggles between True and

False. To use it, you create a section of Actions that are blocked off by an Action_IFCONDlTION

and Action_ENDSECTION. If the internal value is True, the Actions within the block are carried

out, and those outside it are disregarded.

TABLE 14.6 Actions for the ScriptedSequence

TUTORIAL 14.4: Using If Conditions

1. Open Tutoria114_04_Start. ut2. [n this tutorial. you create a system in which a pawn

must activate a control unit before the player can open the door.

Properties to SetAction

2. First, you'll set up the ScriptedSeQuence to make the pawn run over to a PathNode and
send the IC_DoorControl event to the TriggeredCondition. Add a ScriptedSequence

Actor next to the existing Trigger. In the Properties window for the ScriptedSequence, first

set the ControllerClass to ScriptedController. Next, the xPawn must be associated
with the SCriptedSequence. The xPawn's AIScriptTag is currently set to NPCScript, so

set the ScriptedSequence's Tag property to NPCScnpt. Now add the Actions shown in
TABLE 14.6 to the ScriptedSequence.

Index

Event=IC_DoorControl

BaseAnim=gesture_halt

N/A

VlewTargetTag=BotPanel

DestinationTag~ SwitchPoint

PauseTime=0.2

[0]

(1)

(21

(3]

[4]

[5]

[6]

[7]

Action_WAITFOREVENT

Action_WALK

Action SETVIEWTARGET

Action MOVETOPOINT

Action_WAITFOATIMER

Action_PLAYANIM

Action_WAITFORANIMEND

Action_TRIGGEREVENT

ExternalEvent

N/A

CallBot

3. Now you need to actually create the TriggeredCondition. In the Actor Class browser, go the

Triggers section and click TriggeredCondition. Place this Actor next to the trigger.
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4. In the Properlles Window (()( lne TriggeredCondltion, go to lhe iriggeredCondilion category,
and set orr iggerCo n trolled lo True so thaI the TriggeredCoodilion can be extema!ly

controlled by a trtggec. Also, set lhe Tag property under the Events category to
I C_DoorU)nt roI.

5, The UseTogger In flom o( \.he second PalhNode sends 'he Te 5t Con 501 e event. There(ore,
open the ScripledTrigger PropertIes window and creale the set of Aclklns shown in
TABlf 14.7.

TABLE 14.7 Acti 0 ns to r the ScriptedTrigger

14

Index

/0)

(1)

(2)

(3)

(4)

(5)

Action

Actlon_WAlTFOAEVENT

Actioo_IFCONOITJON

ACt1.on_PLAYSOUNO

Action_TRIGGEREVENT

Action_ENOSECT10N

Action_uOTOACTION

PropertIes to Set

ExternalE~ent = TestConsole

TrlggeredCondltlonTao ~ IC_DoorCOntrol

Sound = ~enuSounds,J_MouseOver

Evenc= OpenDoor

N/A

As you can see, whaCs between Actlon_I FCONDIT ION and Actlon_ENDSECTJ~ Isn't
perlorme<l unless lhe TnggeredCondltlon IS toggled \0 True by the ScnptedSequence,

6. Save the map and lest the level. Run over ID the Ingger and watch the xPawn run to the
(Irst PathNode. Now you should be able tD open (he door.

END TUTORIAL 14.4

Action_lfAANOOMPCT is lIsed when )'OU wan. some group of ActiOns to happen randomly. As
wilh Action_I FCONDITION, you musl aJSQ hd\'c an Attion_ENDSECHON to signify 'he end o{ Ihe

block. The one proper( y avJ..i.lablc \n inis Action is Probabll i t y. Sell ing (his property to I causes

lhe Actions inside the block fQ always be performed. A value of 0, however, means the ACl10ns are
never <:..arried QUI. Finally, selling i' '00.5 means there's a 50% chance of Ihe Actions being per
formed.

TUTORIAL 14.6 shows how 10 create a l1ickering dynamic. light b,' using Act ioo_1 FRANOOUPCT.

This method gives you more control over how Ihe light nickers and is an exceUenl demonstration

of how useful this Action Ciln !x:.
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TUTORIAL 14.5: Using Random Conditions

TABLE 14.8 Actions for the ScriptedTrigger

3. Now add a ScnptedTngger near the Triggerllght, and then add the Actions shown ,n

TABLE 14.8.

Index Action Properties to Set

[0) Action_WAITFORTIMER PauseTime = 0.10

[lJ Action- IFRANDOMPCT Probability = 0.50

[2) Action_TRIGGEREVENT Event = FlickerLigh t

[3) Action_ENDSECTION N/A

[4] Actio"_GOTOACTION ActionNumber= 0

FIGURE 14.9 TriggerLighl placed next to the static
mesh.

2. In the Actor Class browser, select
light> TriggerLight. Place this light

next to the static mesh (see
FIGUR£ 4.9). In the Properties Win·

dow for the TriggerLight. go to the
LightColor category and set

lightBrightness to 200, lightHue

to 150, and LightSaturation to

150. Also, under thp. lighting cate
gory, set lightRadius to 10. Under

the Events category, change the Tag property to FlickerLight. Finally, under the Object

c;alegory. set InitialState to TriggerToggle so that the light responds to external
events.

1. Open Tvtoria114_05_Start. ut2.
This level IS nothing but a simple

cube with a light fixture where you'll

be placing the flickering light.

When the level starts. you wait for 0.1 seconds, and then a random condition says that

there's a 50% chance you SWitch the light on or off. After that, you just jump back to the
top, wait another 0.1 seconds, and so on.

4. Save the map and test the level. You should now have a flickering light.

END TUTORIAL 14.5
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Summary
In this chapter, you've learned everything you need 10 create more interactive levels and intro

movies. You started with a look at how to use scripted sequences, and then learned how to use

Actions to control what takes place in your sequences. along with a list of the primary Actions

available and the differences between latenl and non·lalent Actions. Finally. you learned how to

use logical conditions with your scripted sequences to create conditional actions. With these sim

ple foundations, you should be able to create a massive variety of scripted sequences to enhance

the look and feel of your levels.



Chapter

Level Optimization
(Zoning) and
Distribution

Introduction to Level Optimization
Each level you create IS a collection of trjangles that are sent to your

video card to be "rendered." 'WIlY is this important? Well, video cards

call draw, or "crunch," only a limited number of these triangles per
frame. Therefore, if the video (:lrd had to render an entire level, the

frame rate is slowed down dra.'>ticaJly unless it's a very small level.

Obviollsly, jf the graphics engine is crunching data for areas that are

invisible to the plaY'cr, It'S doing unnecessary work, which can lead

to a drop in game performance. To optimize ;l level, level designers

must use a series of techniques that allow video cards to render only
what players can Sl'e,

Although many optimization techniques are controlled by level

designers, one important technique j,<; aUlomarically controlled by

the rendering engine. This chapter focuses 011 optimizations that
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TUTORIAL 15.1: Zoning a Level

1. Open Tutor ia115_01_Start . ut2. You'll use this
unzoned level and follow the steps in this tutorial to
zone it. FIGURE 16.3 shows where you'lI be creating

Zone Portals.

2. First, you need to change the Builder brUsh into a
sheet. Right-click the Sheet bullon Ie in the toolbox_
The first Zone Portal you're creating is (or the hallway

on the lower level. Therefore, enter the following values

In the SheetBullder dialog box:

Height 512

Width 768

3. Move the brush to the entrance of one of the hailways

(see FIGURE 15.4).

4. Before creating the Zone Portal, you' should select a tex-

ture for the surface. Open the Texture browser and load

the WIll_text ures, ut x package. From the editor group,
select the ZonePortallexture (see FIGURE 15,5).

Although you don't have to use tIlis texture, ii's good to have

a texture that clearly distinguishes the surlace as a Zone

Portal, so as not to confuse it with the rest of the level.

'l" -~
I j .' ! iLl
~----?

FIGURE 15.3 This top view
of Ute level shows where you'll
be placing Zone Portals.

FIGURE 15,4 The brush fits perfectly in the hallway,
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S. Cllc\( the Add Special Brush !JUHnn

• In Ihe toolbox.

6. In the Add Special dIalog bOl(,

select Zone Portal in Ihe Prefabs

list box (see FIGURE 1 S. 8). This

opllon sets the solidity to Non

Solid so that olayers can run

Ihrough lhe Zone Portal. Also, the
Invisible check oox IS selected so
Ihal Ihe player can't see Ihe Zone

PortCi I in-game. Click OK and then

Close.

7, Select the newly crealed Zone

Portal and duplicate it. Move It to

the other entrance to the hallway.
Rebuild the geometry and SWitch to

Zone/Portal view mode. You'll

notice thilt (I-ot hallWay is now a dif·

ferent color because the hallway ts
one zone. and the rest of the level
is another lone. In FIGURf 16.7,

you can get an idea of the change

in coloration (rom one zone to the

nert.

FIGURE 15.6 S~tic Mesh browser with the
ZonePortal teJrture sel eeted.

FIGURE 16.6 Set Prefabs to Zone Portal in the
Add Spedal dialog box.

FIGURE 1S. 7 Pe~peetlve view of one lone Portal.
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8. For the entrances to the upper hallway. create a Sheet brush with the following dimensions:

Height: 384

Width: 528

Axis: AX_YAxis

Move the brush to the upper level at one of the entrances to the hallway_ You need to
rotate the brush In Top view to align it with the entrance (see FIGURE 15.8). Also. make
sure It aligns In the Z·axis.

FIGU RE 15.8 Brush rotated and moved into place.

9. Add a Zone Portal. Now duplicate the Zone Portal and move it to the other entrance, After
rebuilding the geometry. you should have a total of four different zones. as shown in
FIGURE 15.9.

10. Rebuild your level's geometry. Switch to Zone/Portal mode in the Perspective view by click·
ing Its icon .... Save and test your level. Right now, you won't notice any change as far as
gameplay is concerned. Later in this chapter, you learn how to debug, diagnose. and view
your optimization results.
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FIGURE 15.9 AZone/Portal view of the fmal loned map. Each lone is surrounded with a
white border.

END TUTORIAL 15.1

Antiportals
Consider a large outdoor level in which you have two bases with a large mountain between them.

This mountain prevents players at either base from seeing their enemy's base. Unfortunately, the

graphics engine still calculates and draws the polygons for each base, not to mention the players

as well. This means that although players on each base don't necessarily see each other, each tune

they look in the direction of the enemy base, that base and all the players in it are being calcu

laled. Naturally, this leads to a slowdown in gameplay, as excessive graphics calculations must be

made.

The problem is that you can't use a simple Zone Portal to fix the problem. The Zone Portal would

have to he massive to divide the terrain, so it would be useless; as long as a Zone Portal is within

a player's field of view, the zone on the opposite side of the portal is visible. You need some way

to tell Unreal that as long as the player is on one side of the mountain, the information on the

opposite side of the mountain no longer needs to be rendered. To accomplish this, you could fit
an Antiportal inside the mountain. Antiporta)s are convex volumes that prevent objects hidden

behind them from being rendered. They are liseful in large, open areas where zoning would be

inefficient. Placing an Antiportal within the mountain prevents the graphics engine from :en

dering anything the mountain occludes.
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Because Antiportals must be convex, you

need to know how to differentiate between

a convex and a concave object (see

FIGURE 15.10). With convex objects,

such as a cube, sphere, or cylinder, you can

draw a line from one point to every other

point in thaL object, and the line would Convex Concave

never leave the object's boundaries. FIGURE 15.10 A concave versus a convex object.
However, with a concave object. such as a

torus, at some point the line would leave

the object's bou ndaries.

TUTORIAL 15.2: Using Antiportals

1. Open TUTona115_02_Start. ut2. This onslaught level is an outdoor level with two bases
sepMated by mountains: a perfect target for Antiportals. As FIGURE 15.1.1 shows. you
can see the blue base while standing in the red base. This IS precisely what you dorn
want. Therefore, you're going to place some A:lt;portals in the mountains to occlude lhe

blue base (see FIGURE 15.12). -

FIGURE 15.~1 Before creating Antiportals, Note the blue base's static mesh in the center of
the figure.
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FIGURE 15.12 After creating Antlportafs, the blue base's sUllie mesh Is no longer rendered.

15
2. Right-Click the Cylinder button Ii) on

the loolbar. Use the followIng values
(or the cylinder:

Height: l02<l

OUlerRadius: 768

NOTE
To view similar results In UnrealEd, make sure 'IOU

switch to W1refnlme mode In Ille Perspective vlawpor1.

3. Center this brush on the terrain, as shown in FIGURE 15.13. AlsO, make sure the
bonom 01 the cylinder is below the terrain.

fiGURE 15.13 Cylinl1er brush centered on the terrain.
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2. Using the Vertex Editing tool. move the brush's vertices so that the brush more accurately

approximates the shape of the terrain (see Figure 15.14).

FIGURE 15.14 Brush after editing the vertices.

3. In the Perspective view, make sure the

brush is completely inside the moun·
tam. If a player somehow gets inside

the Antiportal. the result will be a Hall
of Mirrors effect because the rendering
engine stops everything from being
rendered.

NOTE
If you want to edit the Antiportal, you C<Jnnot modify

the Antiportal's vertices. You must delete it, then mod·
ify the Builder brush, and then create another
AntiportaL

__ I

4, Click the Add Anti porta I button. In the toolbox.

S. That's it! You should have a working Antlportal.

END TUTORIAL 15.2

Aside from working in outdoor areas to optimize rendering. you can also use Antiportals when
zoning isn't sufficient. Take a moving door, for example. When a player is looking at a closed door,
whatever is behind the door shouldn't be rendered. although it is by default. However, just 2On
ing the two rooms won't alleviate this problem because a Mover wouldn't keep the player from
"seeing" the Zone Portal. In this case, you would combine the use of Zone Portals and Antiponals.

If you set the door Mover's AntiPortal Tag property to the rag property of one or more
Antiponals thaI cover the door, the Antiponal occludes everything behind the door when it's

dosed and lets everything render when it's opell. TUTORIAL 15.3 demonstrates how to set up
this scenario.
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TUTORIAL 15.3: The Antiportal Tag

1. Open Tutorial15_eJ_Starr.ut2.

2. To Cleate an Antlportal (ha\ covers Ihe doOJ', firsl creale a Sheet with lhe (allowing
dImenSions;

HeIght: 244

Width: 496

AxiS: AX_YAx/s

J, Move the btush Lo the center of Ihe doorway.

4. Click the Add Antlporlallxtnon I() the loolbox,

S. fr. [he Properties window for Ihe new1y created Arl1ipofl.3l. go to the Events calegory, Set
the Tag property 1o DDorAP.

8. Open lhe Properties wiMOw (or the Mover, In the Mover category, set lhe Ant)PortalTag

properly La DoorAP.

7. Save and run the map, Alter loading the map, bring down lhe console WIth lhe hide (-) key
and type r.ode 1. wtl\Ch puts lhe~view Inlo Wueframe mode. Notice thai the door occludes
everything behind II when clOSe<:!. bul when iL'S t)J)en. everything IS rendered prOt)erly.

END TUTORIAL 15.3

An Anliporlill can be activilled and deacllvilled by using a lrigger. To enable lhis behavior, simply

set lhe AnlipoT(al 's I ni t ialSt 8tf 10 Tr iQQuToggl e or Tngge rCon tr 01. For more informati on

on using triggers in Unreal, please refer 10 Chapler 9, ~ Inler"C! ive H::menls."

Antiponals un also be al1ached to other objects, such as Movers. Simply set Ihe An Ii ponal's

AttachTaQ to (he Mover's Tag property, and it will follow tht Mover. You could have done Ihis in

Tutori al IS.3 by setting the AntijXlrta{'s An ach Tag to at as tDner, lhe Mover's Tag propeny. If
you did ,his, you could safely ignore the AnHPor\ a1 TaQ properly. With lhis SCIUP, \he objects on

The other side of the door would come into view as the door opened.

Distance Fog
As you learned ill Chapler S, "Terrain ,n fog is useful for creal in g moody a\ mospheric effects, such

a,~ mucky fog. However, it's also useful for oplimiution. Everyl hing afler I he 0 i s t ancefogEnd

property is no longer rendered, me.nning thai the graphics engille ignores any obje<:IS Ihat arc

complele.ly hidden by fog. For outdoor levels wiTh a single-colored sky, fog is e2sy 10 sel up; hOIll

ever, when there's a sky texture, it an be quite !ricky. Tn TUTORIAL 15.4, rou see hOllllhis \\IorKS

br adding fog to !.he playable area of an outdoor map.
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TUTORIAL 15.4: Using Distance Fog

1. Open Tutorta115_04_Start .ut2. Currently, the level doesn't have fog enabled inside the
playable area. For optimization purposes. you're going to enable fog, and then finalize the

effect by makmg the skybox and fog blend together.

2, Open the Properties Window of the Zonelnfo located in the center of the map.

3, Under the Zone/nfo category, set bOis tanceFog to True.

4. Although the map now has fog, you need to tweak the fog's color and density. Under the
ZoneLight category, set the 0 is t anceFogeo lor property to IB: 150, G: 155. R: 147]. Now
set OistanceFogEnd to 2000 and OistanceFogStart to 1000.

5. Fog is now set up for the level's playable area. You can save and run the map If you want
to test it at this point. Notice that everything beyond the Dis tanceFogEnd stops render·
ir.g, which is precisely what you want. However, the skybox doesn't blend with the fog color
at eye level. One possible fiX is selling the skybox's fog to a matching color, DOing thiS,
however, would make the sky texture In the skybox disappear. Instead, YOU'll use a
cylindrical static mesh that surrounds the SkyZonelnfo.

6. Go to the skybox and aelete the Terrainlnfo because you won't be able to see it anyway

with the cylinder surrounding the SkyZonelnfo. #

7. Open me Static Mesh browser and load the Chapterl5_SM. usx package, From the Fog
group, select the FogRing static mesh (see FIGURE 15.15~.

FIGURE 15.15 Static Mesh browser with the FogRing statfc mesh selected

8. Add the FogRing to the skybox and set DrawScale3D to (2, 2. 4) _Center it on the
SkyZonelnfo, and in the Side view, move the FogRing SO that it's sticking out of the skybox
by approximately 16 units (see FIGURE 15.16).
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FIGURE 15.16 Side view of the fog ring in position.

9. Open the Terture browser and load the ChapterI5_te)(.u{x package. Select the

r09_ f <lde texture.

,

10. In the Properties window of the FogRlng. go to the Display category. Add an element to the

Skins property and set it to the selected f 0(1_fade tex:lure.

11. Set bun Ii t to True to prevent the Iigh tS surround Ing the FogRing from In lIuencing Its color.

Also. set bShadowCast to False so that it doesn'( ~s( shadows on the sky's visible area.

12. Savt~ and play the map. The fog Should now blend seamlessly with the sl<ybox.

END TUTORIAL 15.4

Terrain Optimization

Optimizing Ihe rendering c( tel rain (ocuses pri

m.arlly on one property: Te rrainSec t cr51 ze.

Essentially, this property divides your terrain into

~ector! so that when a portion o( that sector is

visible and should b~ r~ndered, the entire st'Clor is

rendered. As your terrain disappears, enlire sec

lors disappeAr i.n blocks. 1n FIGU RE 15.17. you

can see the result or setting TerrainSectClrSi z e

to 16.
FIGURE 15.17
0116.

TerrainSectorSize
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When TerralnSectorSue is set 10;'1 smaUer value, tbe graphics engine Lokes longer 10 process
which sectors to render. 0 n Ihe other hand, setting this property to a higher value often cau~

more o( the terrain 10 be rendered, but less lime is spent cakulallng what should be c.akulated,
or n ndered. Therefore, you'll have 10 play with this value to see what works best fa r yourleveJ. In

a lar£e map where a 101 of the lerrain can be hidden al a g~en time, such as an area with dramatic
moun(aiJ)~ it makes sense 10 set a large TerrainSnctorSize vaJue.

Tweaking this value in-game GaO be immensely useful. To do Ihis, you use the aditactor com
mand. Type the following into the console \0 open the Properties window for the Terrain!n{o

Actor:

ed~tactor class=Terr81nJnto

If you have mulliple Tcrrainlnfo Actors, check Lhl: n.amc under Lhe Object category bdore play
ing the map, and then use U\e following console command:

editobj Terrclnlnf00

I.n Lh is command, Te r r a in I nf 00 is U\f name of the Terrain!n fo Actor you want to edit. After the
Properties window opens, simply modify the Terrai"SectorSlZe property located under ~hc

Terrainlnfo category. FinaUy, observe the effect Lhi.s &tiling h~s 01) the tcrra..in by using the I"llOoe

1 console command, as demonstraled e~rlier in TUTORIAL 15.3.

Profiling and Debugging
Often yall can u~e ~Il the optirni2ation leehniques in a single [tvcl. but some optimization tech
niq ues don't work well in certain levels or situat.ions. Theretort:, ;I[rcr using zones, Ani iportals, or
any otll er a ptim iZ,I( ia n 'ech niq ue in yo II r Ie vel, it's wise Ia check whe ther there was ;m ac Iu;)l gain

in level effiLiency, usu:!Uy marked as an increa$( in speed, This seclion covers the di(ferenl ways
to cheel< Ihe speed o( rendering and describes debugging cechniquts to ensure that yaur opti
mlulions have been implemented properly and are working correctly.

Viewport Di~18Y Modes

As yOll have no doubl noticed while using UnreaJEd, me Perspective viewport has many seuings
10 aid I'OU in consl rucli ng yo ur levels. One useful display mode [or viewing how your zone-s have
been divided is UJne/Portal vif"\v. In thIS mode, each zone is displayed with a different color (see
FIQURE 15.18). Also, different shades of the same color within a panicular 20ne indicate ESP

cuts. Therefore, you <:.an use (his mode (0 view where your zone-s exist an d the extel\t of Lhe SSP
cuts wilhm them. Remember that lhe fewer SSP cuts you have, the (asler your level C3n be calcu
lated. You can access lh is mode by clicki ng Ihe Zone/Portal icon (second icon from I he right)

in lhc loolbox.
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FIGURE 15.18 A Zone/Portal view of a zoned map. Each zone is surrounded with a white !>order.

•When using Depth Complexit>, mode. you see how many textures are being drawn over a

given part of the scr('t"n. This mode is llst'ful when dt"tennining where terrain layers, deco lay
("rs, particlf's, and so forth have bc(Orne too dense and could slow your game down on certain

machines, After switching over \0 this mode, a bar appears on the right side of the viewport

with a gradient from green to red (see FIGURE 15.19). Green areas of the viewport represent

areas that have but one texture. \\'hen an (lfea is covered with more textures. the gradient shifts

toward red. If the area goes beyond red, it simply loops back through the gradient to start

again (see FIGURE 15.20). If this happens, you might want to consider decreasing the num

ber of textures covering that area. 'tOll can access this mode by clicking the Texture Usage icon

~. Seei ng the behavior of this mode in FIGU HE 15.20 might be difficult. If necessary. open

any Unreal level and switch to this mode to see the effect of the texture complexity.
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FIGURE 15 ..19 Texture depth complexity on terrain and deco layers.

#

FIGURE 15.20 Textu re depth com plexrty going beyo nd the green-to-red sea Ie and looping back
to green.
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Console Commands

The first command you'U be looking at is rmode, which enables you to change the "render mode."
By specifying an argument to this command) you can choose between J I different render modes,
described in TABLE 15.1.

TABLE 15.1 Render Mode Console Commands

Console Command

rmode 1

rmooe 2

rmode 3

rmode 4

rmode S

rmode 6

rmode 7

rrnode 8

rmode 13

rmode 14

rmode 15

Description

Wireframe mode. This mode is extremely useful if your zones are work
ing properly.

Zone/Portal mode. This works exactly like the same mode available In

UnrealEd.

Texture usage mode. This mode color-{;odes every BSP surface to

indicate what texture is being used.

BSP cuts mode. This mode IS no longer fully operational. To view BSP
cuts, use rmode 2, as explained previously in the "Viewport Display
Modes" section.

DynamIC Light mode. This is the defaUlt mode when playing the garfle.

Textured mode. This mode is the $ame as rfl10de 5 except that no
lighting IS applied to surfaces or objects in-game.

lighting Only mode. In this mOde. all textures appear white, but have
both light maps and vertex lighting applied.

Depth CompleXity mode. Unlike It'S counterpart In UnrealEd, this mode
doesn't work properly in·gi'lme.

Top view mode, ThiS mode IS much like the Top view In UnrealEd.

Front view mode. This mode IS much like the Front view in UnrealEd.

Side view mode. This mode is much like the Side view in UnrealEd.

The second useful command is sta t. This command, whether used in UnrealEd or in-game, dis
plays a huge array of llseful information, depending on the argument supplied. The simplest
usage is stat fps, which displays the current frame rate. This command works in UnrealEd as
well, but the frame rate is capped at 30, Also note that in UnrealEd, the stats are updated only
if you update the viewport or enable real-lime preview. TAB LE 15.2 describes the reSl of the
arguments.
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TABLE 15.2 Statistics Console Commands

Console Command

stat all

stat hardware

stat render

stat none

Summary

Description

This command displays all information relevant to the game, such

as the number or polygons. animated meshes, terrain sectors, parti
cles. and many other items. vIsible in the current view. Much of the

information IS related to optimization; however, tile next commands
In this table nstrow down the amount of visible mformation

onscreen. instead or showing all statistics.

ThiS command shows you technical JnfOrmalion about what's being

rendered. NumPrimltives, IOC8ted at the top, shows the total num
ber of primitives currently being rendered. NumTextures shows the
number of textures currently in view. For those with a technical back

ground, the rest of the InformaliOn thIS command displays can be

quite useful. However, an in-depth discussion of this additional (nfor- .

mation goes far beyond the scope of thiS book and requires an
understandmg of programmmg concepts.

This lmmense~y useful command showS render statistics. Each sec
lion has inrormalion about the different elements that make up the

current frame. Furthermore, every sectlOI) of information shows h~

long an element takes to render in milliseconds. The Frame section

shows IT'\formation abollt how long it takes to render ali entire
frame, (or example.

When optimizing your level, check the sections of information to see

Which element takes the most time; using optimization techniques,
If pOSSible. reduces the amount of time rendering takes.

This command removes all the information (rom the view.

In this chapler, you have learned a variety of techniques for optimizing your levels: zoning for
areas that can be divided. Antiponals for open <treas or dynamic occlusion of oojecls (as in lhe

door example), and using distance fog 10 your advnotage. For lerrClin, you (In use the

TerraioSectorS12e property to more accur:ltely control what parts of terrain snould be ren

dered. You should now have an understanding of why optimiziltion is so important when work

ing with levels in Unreal. and you should be comfortable establishing your own systems of

optimiul ion for your own levels. Doing so ket:ps your levels (asl and hjgh.ly playable across a wide

varielY of computer types and allows more players to use your level simultaneously withour as

much risk of performance drop.
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Chapter

Gametypes

This chapter discusses the technical details of how to take an exist
ing map you've created and make it playable as a specific gametype.
Eleven gametypes are available in Unreal Tournament 2004:
Deathmatch, Team Deathmatch, Last Man Standing, Mutant,
Invasion, Capture the FJdg, Double Domination, Bombing Run,

Onslaught, and Assault. With each gamerype, you can play the maps
you've created using differen I ru II'S. Howeve l', nea rJy <,very gamrt ype
requires you to make certain changes to how your map is set up. For
example. Capture the Flag maps require placing a pair of flags,

Double Domination maps require domination points. and

Onslaught maps requircO Power Nodes. In FIGURE 16.1, you see

the map used for demonstrations in this chapter.

Each map you create should be designed with a specific gametype in
mind. If, (or instance, you design a map for Capture the Flag (CTF).
you wouldn't use that same map to play Double Domination
because a crF map requires elements that aren't necessary in a
Double Domination map, and vice versa. Although you can force

Unreal to use a specific gamctype on a map, this can lead to unpre
dictable results. Therefore, if you want to use the same map with
multiple gametypes, you need to create a separate map file for each

gametypc.
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The gamerype used when you load a map

depends on two things: the filename and

the DefaultGa,.eType property in the

~vel Properties window. (n Unreal, (he

levels associated with CJch gametype are

decided based on the filename. For eJtam

pIe, when you launch Unreal Tournament

2004 end are looking [or 11 le".:! to pIny, Ihe

map named CTF ·Citadel. ut2 is always

displayed under the CTF gamctype,

regardless n{ the Oefau 1tGameType sell ing.

TABLE 16.1 specifie.~ !.he abbreviation faT
each gametype.

FIGURE 16.1 The demonstration map.

TABLE 16.1 Abbreviations for Gametypes

Abbreviation Gametype

OM· Deathmatch. Team Deathmatch, Last Man Standing. Mutant, Irwasiono

CTF- capture the Rag

DOM- Double Domination

16 BR

ONS·

A5-

Bombing Run

Onslaught

Assault

Setting Level Properties
Before you CJn playa map with a specific gamet~-pe, you need (0 set its Def alii tGame Type prop

erty. This step is a universal one for level creation, so it's covered here, at the beginni ng of the

chapter.

The DefaultGalieType property is The class that controls the game's opf'ration. [f you run your

map from within UnrealEd, the game' ype specified in this property is USf'd. Also, when using the

open <map> command in Unreal's console, the specified map is loaded and played wjrh the game

type designated by that map's Defaul tGalleType.

To set this properly, open yom map in Unreal Ed and choose View> level Properties {rom Ihe

main menu or pr"ss the F6 key. Under Ihe L('vellnfo C3legory. you must set lhe Oe1aultGalieType

10 the class of Ihe ganle1ype you \v3n( to use. TABLE 16.2 specifies the class (or each gamelype.



TABLE 16.2 Gametype Classes

Gametype Class

Deathmatch xGame. xDeathMatch

Team Deathmatch xGame xTeamGame

Capture the Flag xGame xCTFGame

Double Domination

Bombing Run

Onslaught

AssaLJlt

xGame.xOoubleDOM

xGame.xBombingRun

Onslaught,ONSOnslaughtGame

UT2k4Assault.ASGamelnfo

The following sections cover all the different
Actors you need to create and the properties
that need to be set before these gametypes
work properly. Important design tips and

tricks are also given for each gametype.

NOTE
You must type these classes in manually. There's no
drop-down list in the level Properties window lor this
parti euIar property.

,

Deathmatch-5tyle Gametypes
Deathmatch is the simplest gametype. The rules arc simple: Kill or be killed. Players relentlessly
hunt and destroy each other in an "every player for (hemselves" fashion. Every kill awards the
player with a "(rag," and the first player that reaches the "frag limit" or the player with the most
frags when the timer runs out wins the game.

With Team Deathmatch, an entire team of people work together to demolish the opposing team.
The number of frags each tcam member acquires is added to the team's total frags. The first team
to reach the maximum number of frags win.> the game. There's absolutely no difference in the
implementation of Deathrna:ch and Team Deathmatch.

Creating a Deathmatch map isn't difficult. The only requirements are placing PlayerStarts around
the map and setting the level's OetaultGameType property to xGame.xOeathMatcn. During a
game, a player is randomly spawned from the PlayerStart Actors. In UnrealEd, however, you can

add these PlayerStarls by simply right-clicking in a viewporl and choosing Add Player SIMI Here
from the context menu, as mentioned throughout this book,

Othtr garnetypes are intended to be treated
in the same fashion as Deathmatch maps:
Last Man Standing, Mutant, and Invasion. In
the Last Man Standing garnetype, each player

NOTE
Stlould you need to access the PlayerStart Actor, you
ca n fi nd it in th e Actor Class browser under
NavlgationPolnt > SmaliNavigationPoinl.
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is given a certain number of Jives. After players lose all their lives, they arc out of the match. The
last player remaining is the winner.

In the Mutant gametype, the first player to gain a frag is declared the "mutant." That player is then
invisible, deals more damage, and gains a tremendous load of ammunition. The mutant's health
also drains constantly and can be replenished only by killing other players. Naturally, Ihe mutant
is a coveted position, Any players who kill the mutant then become the mutant themselves. Also,
oonmutaot players arc not allowed to kill each other, with one exception. The player with the low
est score is designated the "bottom·feeder" and is allowed 10 kill any other player, as compensa
tion for his score deficit.

In the Invasion gametype, all players (whether they are human or bot) are on the same team. The

team is then attacked by waves of computer-controlled monsters. Each subsequent wave gets
more difficult. When players die, they must sit out and wait for the next wave. The game is over
when aJl human players die in a single wave of attacking monsters.

Adding Weapons

For Deathmatch as well as the other gametypes listed in this section, the most )imponant items
to populate yOUT level with are weapons, ammunition, and other pickups, such as health, arl#lor,
and adrenaline. In TUTORIAL 16.1, you see how to bring these Actors into your level and get

them positioned on the map.

TUTORIAL 16.1: Adding Weapons and Pickups

1. Start UnrealEd, and open the Tu toria116 01 Start. ut2 file Included in the Chapter 16

folder on the CD.

2. Although thiS level has been equipped with several PlayerStarts. it has no weapons. Open
the Actor Class browser. and expand the xPickUpBase category. This category has seven

separate pickUp classes, described in 'ABLE 16.3. FIGURE 16.2 illustrates these
pickup bases.

From the list, choose xWeaponBase. Right-click 00 the floor in the Perspective view, and

choose Add xWeaponBase Here to place a weapon base on the floor.

TABLE 16.3 xPickupBase Pickup Classes

Class Name Description

HealthCharger This class creates a base that spawns Simple Health Pack pickups,
visible in-game as f10atmg blue crosses,

ShleldCharger

SuperHealthCharger

This class creates a base that spawns Simple Shield Pack piCkUps,

which are displayed in-game as floating gold crests,

This class creates a base that spawns the "Big Keg O· Health"

pickup.
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TABLE 16.3 Continued
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Class Name

SuperShieldCharger

UDamagp.Charger

WildcardBase

xWeaponBase

Description

This class creates a base that spawns Super Shield Pack pickups.

This class spawns Double Damage pickups.

This base randomly spawns items Included In its list, which are dis
cussed later in this section.

This base spawns a particular kind of weapon, which you can control
via its prope(ties.

FIGURE 16.2 The piCkUp bases, from left to right: HealthCharger, ShieldCharger.
SuperHealthCharger. SuperShiefdCharger, UOamageCharger, WildcardBase.

3. Double,click the weapon base mesh to
open its Properties window, Under the
xWeaponBase category, set the
WeaponType property to the mighty
Rocket LaunCher (see FIGURE 16,3).

4. Now you need some ammUnition piCk'
ups for your weapon. In the Actor
Class browser, expand Pickup> Ammo
> UTAmmoPlcl<up. Various ammo
types are listed. their names corre·
sponding with their weapons.

From the list. select
RocketAmmoPlckup. Right·click on
the floor next to the weapon base
you just created, and choose Add
RocketAmmoPickup Here from the
context menu (see FIGURE 16.4).

5. From these few sleps, you should
be able to equip your level with a
veritable arsenal and enough pick·
ups to keep the game's pace up.
However, there are a couple of other
important pickups that you have not
yet discussed; the Heallh VIal and
the Adrenaline pickup.

NOTE
You'll probably need to move the weapon base up a lit·
tie so that it's sitting on the floor, not passing through it.

I NOTE

You won't see the selected weapon type in the editor.
but It's spawned when you play the game.

FIGU RE J.6.3 Rocket Launcher floating over the
weapon base while in·game.
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FIGURE 18.5 The Health Vial.

FIGURE 18.6 The Adrenaline
pickup.

FIGU HE 16.4 Rocket ammo next to tile floating
Rocket launcher.

The Health Vial appears in-game as
a small floating blue test tube (see
FIGURE 16.5). When collected, it
adds five health points to your char
acter, even if it's already at 100%
health, Collecting Health Vials
allows you to increase your
character's health to 199%,

The Adrenaline pickup (shown in
FIGURE 16.6) adds three points of
Adr~naline to your character. As you
play the game. activities such as
kills also increase your Adrenaline.
When your Adrenaline reaches 100,
you can perform Adrenaline
Combos, which boost your
character's abilities in some way.

Adrenaline: Pickup'> TournamentPickup '>
Adrenali nePickup

Add a few of these pickups around the level.

Creating these Actors is easy: Simply navigate to them
In the Actor Class browser, and then nght·c1ick in your
level and place them. rhe follOWing are the paths in the
Aclor Class browser for each piCKUP:

Health Via); Pickup> TournamentHealth >

MlniHealthPack

6. Using the skills discussed so far in Ihis tutorial, popu
late your level with weapons, ammo, and other pickups
until you're satisfied. Save your work and test the level.

r
NOTE • ---l
If you have set up any bot paths in your level, you should at least I
rebuild you r paths before you test and save. Flags and weapon
bases create navigation points of their own, so make sure you

I have rebuilt so that bots can use these objects to navigate
I through the level as well as access any pickups or items.
L

16

END TUTORIAL 16.1

Now that you know how 10 add a variety of pickups to your level, you can have more control over

how your level is played. In TUTORIAL 18.2, you expand on Ihis knowledge by learning about

the wildcard base, which can randomly spawn a variety of pickups.
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TUTORIAL 16.2: Using the Wildcard Base

1. Continue from TUTORIAL J.6.1. or open the file you saved at the ene of that tuton(ll.
You're going to add a wildcard pickup base to your level. As mentioned earlier, this base
generates random pickups based on a list you set in its Properties window.

2. From the Actor Class browser, expand xPickupBase, and select WildcardBase. Right-click m
the Perspective view, and place the base on the floor somewhere in your level. A POint
near the halfway mark of the level would be best for the sake of game balance.

3. Double-click the base to open its Properties Window. where you see the WlldcardBase cat·
egory. When expanded, it reveals two properties. The first is bSeQuential. which forces
the base to spawn Items in the list sequentially, from highest to lowest. So the Item m
entry 5 would spawn just before entry 4, and so on. If this property is set to False. the
items spawn in a random order.

The second property is
PickupClasses, which is the list
where you store the Items you can
Include In the wildcard base. Make
sure you don't skip entries, as this
can yield unpredictable results.

4. Selthe list to any items you like,
and then save and test your map,
Find your wildcard base, and see
now it spawns the pickups that were
I(l your list. In FIG URE 16.7, you
can see the wildcard base with a
Double Damage pickup floating
<'lbove.

END TUTORIAL 16.2

FIGURE 16.7 A wildcard base with a Double
Damage pickup.

Deathmatch Design Considerations

Ahhough Deathmatch is the simplest gametype, making a good Deathmatch map requires care

ful planning. Vo/hen your map is play-tested, bugs and design flaws become all too obvious.

Therefore. keep the following tips in mind:

• If you have a huge map, make sure you can't see large portions of your map from any point

or angle. This prevents a player from seeing an excessive number of players simultaneously,

which can slow gameplay down by forcing too m..n\' calculations on the computer.

• When placing weapons inside your level, make sure that powerful weapons and pickups

aren't placed too closely together. These items should be evenly spaced throughout the

map.
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~ If you design a map that's more suited to a 1 on 1 Deathmatch, you should modify the
ftJename to include 1on1 after the prefIX (such as DM-l on1 ·Albatross .LJt2). Modifying
the map name to reflect the type of map you have is always a good idea.

~ Place your PlayerStarts in locations that aren't completely ohvioLls. For example, don't
allow players to spawn from some sort of static mesh pod, or that area will likely become
a target for other players. Nothing can take the fun out of a game quite like being [ragged
instantly when you enrer a match!

Capture the Flag (ClF)

16

In the Capture the Flag gametypc, players arc
divided into two teams. Each team has its
own base and controls a flag. The goal of the
game is to infiltrate the enemy's base, take its

flag, and bring it back to your own base to get
points. However, a team is awarded a cap

ture only if it manages to take its oppo

nent's flag while keeping its own flag at its
base. The team that reaches a certain num
ber of points, or captures, wins.

To make a map compatible with this game
type, a level designer has only two tasks: set
the levc]'s OefaultGaflleType to

xGame. xCTFGame, and place two flags in
the map. The cwo Actors for this task are

xBlueFlagBase and xRedFlagBase. The
Actor Class Browser path to find these two
Actors is shown in FIGURE 16.8. Both

Actors must be placed in your map for the
level to work correctly. Keep in mind that

only the aag appears in UnrealEd. Its base
appec.rs only when the map is run.

CAUTION
Although you can place more than one blue and red
flag, it's not recommended and doesn't work as
expected. meaning you can't capture multiple nags of

a single color.

FIGURE 16.8 The Actor Class browser path to
the red and blue flag bases.
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TUTORIAL 16.3; Creating a elF Map

1. Start UnrealEd. and open the

Tutorial16_03_Start.ut2 map

found In the Chapter 16 directory on
the CD. You'll be converting this
map, shown in FIGURE 16.9, to a

Capture the Flag map.

2. First, press F6 to open the Level
Properties window. Open the

Levellnfo category. and set the

Defaul tGameType property to

xGame . xGT FGame. Remember that

you must type this class name into
the entry field.

3. At the southern end of the Map is a
wall with a window. On either side or
that wall. you'll create the two flag

bases. First, open the Actor Class

browser end expand NclVlgalionPomt

> JumpDest > GameObjective >

CTFBase > RealCTFBase, where

you'll see the red and blue flags.
which an~ listed as xBlueFlagBase
and xRed!="lagBase. Place the blue

flag on tl'e eaStern side of tl'e wall
and the red (lag on the western side

(see FIGURE 16,10).

4. Save the map as eTF· R~ng 1.3 . ut 2
and give It a test run. The flags and

their bases are now in place, and
you can take the flag and return it to

your own base to score.

END TUTORIAL 16.3

FIGURE 16,9 Map beJore being converted to a
elF map.

Now that you have set up the necessary A.ctors to create a CTF map, you need 10 sci up the
PlayerStan Actors in a manner that coincides better \\;th thIS gamerype. For team·based game
types, you don't wanl your players to spawn at random locations across the m:tp. Instead, you

have players spawn at their tearn's base. You learn how to set this up in TUTORIAL 1.8.4.
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END TUTOR,IAL 16.4

You now have a (unctional CTF map. In many maps included with Unreal Tournament 2004, you

sec vicw screens at each base that display the leam's color and insignja. In TUTORIAL 16.6, you

see how 10 sel these iten15 up in your m~p.

A PlayerStart neX1 to the blueFIGURE 18.11
flag.4, Double-cllck the PlayerStart to open

its Properties wmdow. Ullde( the

PlayerStart category. set the TeamNurnber property to 1. A value of 1 designates the blue

team. and a value 0: 0 deSignates (he red team.

5, Duplicate this PlayerStan to several positions near the blue flag.

6. Repeat steps 2-5, placing the new PlayerStarts near the red flag, and verity that the

TeamNurllcer property for each one is set 100 instead of 1.

7. Save your work.

2. Right·c1ick any of the Player$larts, and
choose select:> Select All PlayerSlart.

Press Delete to remove all

PlayerStarts from the level.

3. Using the skills you have learned thus

{ar, create a new PfayerStart next to the

blue flag (see FIGURE 18.11).

1. C'-ontinue (rem TUTORIAl. 16.3, or

open the file you saved al tile end of

that llitorial.

TUTORIAL 18.4: Adjusting PlayerStarts for elf

TUTORIAL 16.6: Setting Up View Screens for elF

1. Continue (rom lUTORIAL 16.4, or

open the (lie you saved at the end of

that tutorial. You're gOing to set u~

the m()(1ltor view screens In ei:lch

base so (hat they display the learn

colors and team symbols.

2. Select and delete (he monitors in

each flag room (see fiGURE 1.6.12).

They are currently static meshes,

which you'll replace WI(h speCial

Actors designed specifically (or this

task.
FIG URE 18 .12. Monitor deleted. leavi ng on Iy the
shadow.
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3. In the Actor Class browser, expand Decoration> xMonltor 10 see a lisl of monilors to

choose from. The one most SImIlar to the monllor that was origJJ'\ally In the level is
xMomtorC. Select II. and place il \J) the same local Ion as the Q{lg(/"lal monitor, You might

need to use the OrawScale30 property to adjust Its S12e.

4. Double-click Ihe maMor to access
its senlngs. Under Ihe xMorillOl cal·
egory. adjust Ihe Team property 10

CI)/'respond wlln the teams. Remem·

ber that a eQuals the red <eam, and
1 equals blue, FIGURE 16.13

shows Ihe moniior (or Ihe red team.

S. save your work and lesl the map.

END TUTORIAL 16.1;

elF De8.ign Cons.iderations

FIGU HE lG.:13 A monitor for the red team.

Every CTF map should have two distinct seClicms: a red base and a blue base. Nalurally. the fed fl~

should be placed within the red base and the blue Aag within ~he blue base. TIle area in and around

each base shouJd he designed and teXlured in such a way rhM players Gln e.a.siJy identify which base

they are in, For example, you mighl want to have red decorations in the red base, and vice ver&a.

Also, one team should not have aIly un fair advant ages over the oth er because of rhe ba~'s design,

One WlIY La prevent this is (0 su-nply create one base and mirror i/ on the other side or the map.

bUl this duplication can make the maps look and feel sLlgnant. SIrUCluraJly, mirroring is a good

idea, but you should usually change the decorations in e-ach base, along wilh any other arlifacts

thal don't change gamcplay, Therefore, lry /0 make the two bases as differen, as p()$Siblc wh i.le

ensuri ng mat neither leam has an advantage- ove r the other.

This guideline also applies /0 pickups and wCilpons. You don't wanl one base /0 be Glled with

powerful weapons while I he ot her has pr2clic.ally I\oth ing. Make sure you strive 10 keep your bi
els balan eea for gameplay, Th is balance ensu res dHt yom players are sat istied with their eJqJeri

ence and that the game moves 3t a decent speed,

Double Domination
In Do llblc Domination, players are divided in 10 two 1C!l ms. The goal of each team is to LJ ke ~i olul

laneous control of cwo speciiic 10C<ltions in the map, v,'hen a player rUlIs over one of these dom

ination points, that poinl becomes controlled by that player's team. One learn has to conl ro) both

domination points simultaneously (Of 10 seconds to get a point. After scoring, both domination

~inl5 become neulral, and th~ process hegjl)s agaln,
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Similar to CTF maps, a level designer's

most important job is placing two domi

nation points in the map. xDomPointA

and xDomPnintB are the two Actors that

represent these domination points.

FIGURE 16.14 shows the Actor Class

browser path to these Actors. You need to

place only one of each Actor somewhae in

),our map to have a working Double

Domination map. In TUTORIAL 18.6,

you convert your Deathmatch map from

earlier into a Double Domination map. FIGURE 16.14 The Actor Class browser path lead·
ing to the Actors used in a Double Domination map.

TUTORIAL 16.6; Creating a Double Domination Map

FIGURE 16.15 The map before being converted
to Double Domination.

3. In the Actor CIBSS browser. eXPBnd

NavlgallonPOInt > JumpDest >

GameObJectlve > DominationPoint >

xDomPoint. where you see two

Actors: xDomPOlntA. and
xDomPointB. Obviously, these Actors

are the domination points needed

for your level.

As in TUTORIAL 16.3, you need to place one of eacl1 of the Domination Point Actors on

the east and west sides of the southern wall (see FIGU~:E 16.16).

2. Press F6 to open the Level
Properties wlndow_ Under the

Levellnfo category. set the
De faul tGameType property to

xGame. xDoubleDOM. Remember that

you must type this class name into

the entry field.

.1. Open the
Tutona116 06_Start. ut2 file
from the Chapter 16 folder on the
CD. FIGURE 16.15 shows the
current map.

16



Double Domination 553

4. Using the skills you acquired in
TUTORIAL 16.4, place two groups
of PlayerStarls, each designated for
a corresponding team.

S. Save the map as DOM·Aing13.ut2,

and test It out.

END TUTORIAL J.6.6
FIGURE 16.16 Both domination points in the map.

YOllr domination points are now in place. At this point, the map is playable for a Double

Domination game. However, some screens that show the currenl status of each domination point

would be useful for players. In TUTORIAL 16.7, you sr.t these screens up.

TUTORIAL 16.7: Creating Monitor Screens for Double Domination #

1. Continue from TUTORIAL 16.6, or open the file you saved at the end of that tutorial.
You're going to populate your level with SCreens that display which team controls which
domination point.

2. In the Actor Class browser, expand Decoration> xMonitor > xDOMMomtor, where you find
xDOMMonitorA and xDOMMonitorB. These meshes automatically update to display which
team hos control of the A or B domination POints.

3. Select xDOMMonitorA. and place a
copy on the left Side and slightly
above one door in the level.
Repeat with xOOMMonitorB,
placing a copy on the right side
(see FIGURE 16.17).

4. Select the pair of monitors and
duprtcate them. placing them on
both sides of each doorway in the

map. This way, players can always
look at the doorways to see the
current status of the domination
points.

5. Save and test the map.

END TUTORIAL 16.7

FIGURE 16.17 The domination point status
screens are now in place.
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Design Considerations for Double Domination

As with lhe other gametypes, you need to keep a few guidelines in mind when creating a map for

Double Domination. First, be sure to avoid placing spawn poims too close to domination points.

Placing spawn point too close makes domination points overly easy to control and results in a

possible stalemate.

Second, avoid placing powerful weapons, ammo, or an excessive amount of health near domina

tion points. To make domination point defense more challenging, defenders should not be given

a large supply of ammo for their favorite weapon while covering a control point.

Bombing Run
Bombing Run is another team·based gametype, in which the object is to take a ball and throw it
into the enemy team's hoop. If a player jumps through the hoop while holding the ball, his team

scores seven points. Simply tossing the ball through the hoop gives the team only three points.
The learn with the mosl points wins the game.

16

A Bombing Run map must contain three

things: a ball and two deHvery points,

which act as hoops. One xBombDelivery

Actor (the hoop) should be placed in both

bases. Only one xBombSpawn Actor (the

baJJ) needs to be placed in the map. This
ball should be place'd at an equal dislaole

from the xBombDelivNY !\ctors so that no

team has an unfair advantage. The Actor

Class Browser palh 10 locate these Actors is

displayed in FIGURE 16.:1.8.

FIGURE 16.18 The Actor Class browser path to
the necessary Actors for a Bombing Run map.

Under the xBombDclivery properties is the Team category with the Team property. One of the

xBombDelivery Actors must have this property set to 0 (for the red team), and the other must

have this property set to 1 (for the blue team). Obviously, these properties should correspond

with thelr bases so that the blue delivery point is in the blue base. and vice versa.

Another imponant property when working with Bombing Run is TouchDownDifficulty, found

under the xBombDelivery category in the xBombDelivery Actor's Properties window. This prop

erty determines the probability of a bot shooting the ball through the hoop instead of running

through the hoop with ball in hand. A value of 1 means the bot will most likely shoot the ball

through the hoop; a value of 0 means the bot will probably run through the hoop with the ball

in hand.
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FIGURE 18.19 The Actor Class browser path
leading to the ShootSpot navigation points used by
bots in your level.

rtiOTE
In most levels, you want to set the goal up so that a
player cannot get behind it. You can do this by adding
pits, walls, and so forth_

Two other Actors that are important when

working with Bombing RUll are

BJueShootSpot and RedShootSpot (see

FIGU RE 16.19 for the Actor Class

browser path). These two Actors specify a

point al which bots attempl 10 ShOOI the

baU into the hoop. Hitting these points
doesn't mean the bots will definitely shoot. but if they do shoot, lhey shoal from these points. If
you don't place these Actors in your map, bots never try to shoot the baH through the hoop.

TUTORIAL 16.8: Setting Up a Bombing Run Map

1. Open the Deathmatch version of the map, Tu tor i a11 6_08_Start _ut2, You'll convert thi s

map into a Bomblllg Run arena_

2. Press F6 to open the level Properties window. Under the levellnfo category, set the

DefaultGameType property to xGame. xBomblngllun. Remember that you must type this

class name into the Mtry field.

3. In the Actor Class browser. expand NavigationPoint > JumpDest > JumpSpot >

GameObJeClive. Witnin. you find the xBombDelivery and xBombSpawn Actors.

To begin, you place the goals. Select xBombDelivery in the Actor Class browser, and nght-clicl<

to place one on either Side of the soutnem wall of the arena, much as you did for the eTF

and Double Domination gametypes_

4. Now you need to specify which
bomb delivery. or goal. corresponds
with which team. Open the

Properlies window of the goal in the

blue base. Under the Team category,

set the Team property to 1. Setting
this property (or the goal in the red
base Isn't necessary, as the Actor

comes in with this value set to 0
(red) by default. FIGURE 16.20
shows both goals set up.

6. Now you need to add the ball. The

only ptoblem is that the center point

of your map has two doors on the

north wall. These doors get in the

way of the ball's spawn point, so
select both Movers and delete them

for the time being,
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6. Using the skills you acquired In

TUTORIAL 16.4, place two groups

of PlayerStarts, each designated for
a corresponding team,

7. To add the ball. select the
xBombSpawn Actor in the Actor

Class browser. Right-chck and place

this Actor directly in the doorway on
the north wall (see FIGURE 16.21),

This position is in the center of the

map, meaning that neither team has

an advantage.

8. That's about it, as far as setup.
Save your IT\ap as BR· Ring 13, u t2.

Play-test the map. and try to shoot a

hoop or two!

END TUTORIAL 16,8

---- -- .-----

""':':URE 16.21 Ball spawn base.

r
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When (:reating Bombing Run levels, often you want to
place particle effects into the goals to create a visual
effect. For more information on particle systems, refer

I to Chapter 10, 'Creating Particle Effects: '
L ---'

16 Design Considerations for Bombing Run

The main concern when working with the Bombing Run gametype is PJayerSt8rts. Don't put

them too far away from the goal) such as several hundred units "way; however, avoid putting them

right on or next to the goal.

Aha, preventing the goal from being visible from long distances is a good idea. This keeps play

ers (TOm being able to shoot the ball through the goal as soon as they get their hands on the ball.

Onslaught
Onslaught is another team-based gametype. The player's main task during an Onslaught game is

to initialize Power Nodes in a connect-the-dots fashion to establish a link between the player's

base and the enemy team's Power Core (see FIGURE 16.22). After that link is established) the

enemy's Power Core is vulnerable to attack and call be damaged as long as the link from the

Power Nodes remains in place. The object of Onslaught is to destroy the enemy team's Power

Core,

An Onslaught map has four main components: Power Cores, Power Nodes, Vehicles, and Teleport

Pads. The Weapon Racks found in most Epic maps could be considered a fifth component) but

they aren't completely necessary, and you can easily use standard weapon bases.
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FIGURE 16.22 Onslaught map showing link setup. ,
The most vital components 3re the Power Core., and Power Nodes for each team, known as

ONSPowerCoreBlue, ONSPowerCoreRed, which can be found in tbe Actor Class browser path

shown in FIGURE 16.23. You also need the ONSPowerNodeNeutral Actor, found ill the path

shown in FIGURE 16.24.

In TUTORIAL 16.9, you see how to establish Power Cores and Power Nodes.

FIGU RE 16.23 The Actor Class browser
patll to the Onslaught Power Cores.

FIGURE 16.24 The Actor Class browser path to
the ONSPowerNodeNeutral Actor.
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1. Open the Tutorial 16_09_Start .

ut2 map. which is an open
landscape: prime area for an

Onslaught map.

2. To place the two Power Cores, press
F6 to open the Level Properties win
dow. Under the level/nfo category,
set the DefaultGameType property
to xGame. xOnslaught. Remember
that you must type this class name
into the entry field.

3. In the Actor Class browser, expand
NavigationPomt > JumpOest >

JumpSpot > GameObjective >

DestroyableObjective >

ONSPowerCore, where you find the
red and blue Power Cores, listed as
ONSPowerCoreRed and
ONSPowerCoreBlue. Place the red
core at the southern end of the map
in an open area (see FIGURE
18.25).

3. Select and nlace the blue power
core in a similar open aren at the
northern end of the map (see
FIGURE 16.26).

4. Return to the Actor Class browser,
and expand the ONSPowerNode cat·
egory. located in the same path as
the Power CoreR. Select the
ONSPowerNodeNeutral Actor, Ule
Actor used to create Power Nodes.
Place this Actor in a (ew choice loca·
tions (see FIGURE 16.27). Exact
placement doesn't matter for this
tutorial, but when creating your own
maps, you should consider
placement carefully.

FIGURE 16.25 Red Power Core In position.

FIGURE 16.26 Blue Power Core in position.

FIGURE 16.27 A Power Node in place.
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5. Using the skills you acquired in TUTORIAL 16.4, place two groups of PlayerStarls. each

designated for a corresponding team.

6. Save the map as ONS·Ring13.ut2. There's no pOint In testing now. as you have only,a
series of unlinked nodes.

END TUTORIAL 16.9

You have added the nodes needed lor the map, but without [inks between them. the map is

unplayable. In TUTORIAl. 16.10. you bring this map to life by creating the links needed to make

the nodes and cores functional for this gametype.

TUTORIAL 16.10: linking Power Nodes

1. Continue from TUTORIAL 16.9. or

open the file you saved at the eno
of that tutorial. You'lI connect the

Power Nodes you created previously

to create the links needed for me
map to function.

2. First. start the map (rom Unreal Ed_
To establist"'. links between your

Power Nodes and Power Cores. you
use the Link Designer. which must

be accessed from within the game.
Notice that when the game starts,
the Power Cores and Power Nodes

are missing (see fiGURE 16.28).

3. When the game begins, press the

Esc key. In the window that pops up,
click the Map button in the upper

left corner. Next, click the Link
Designer button in the lower·right

corner. A window opens to show the
location of all your Power Nodes and

Power Cores. despite the fact that

you don't see them in the game
(see FIGURE 16.29).

4. Next, you click Power Nodes to cre

ate links. The pattern is Simple:
Click the Power Node or Core where

you want the link to begin, and then

click the Power Node or Core where

you want the link to end. Repeat

FIGURE 16.28 The Power Cores and Power
Nodes don't yet appear in-game.

FIGURE 16.29 The Unk Designer.

I
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this process until all the Power

Nodes have been linked. and the
links eventually run back to the

Power Cores (see fiGURE 16.30).

5. When you're finished, click the
Export to UnrealEd bulton to place

the links you created in the

Clipboard for pasting Into UnrealEd.
Next, bring down the console with
the tilde (-) key. and type exit to

leave the game.

6. Back in UnrealEd, right·click any·

where in your level. and choose Edit
> Paste> Here from the context
menu. This places a small eagle
head Icon-the Link Setup icon-in

your map (see FIGURE 16.31).
Double·click this icon. and verify that
Its properties say

ONSPowerL~nkOfficialSetup

Properties.

FIGURE 16,30 Link Designer with links in place.

16
7. Save your work. Retest the map, and notice that the Power Cores and Nodes are in place

and (ully functional (see FIGURE 16.32).

FIGURE 16.31 ONSPowerlinkOfficlalSetup is
displayed with the Link setup icon in UnrealEd.

END TUTORIAL 16.10

FIGURE 16.32 In·game shot of the now
functional Power Core.
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Many of the Onslaught maps included with Unreal Tournament 2004 offer different setups for
node links, which adds a tremendous variety of playability to all your favorite maps. In
TUTORIAL 16.11, you create some alternative link setups to change how the level is played.

TUTORIAL 16.11: Creating Aiternat'lve Link Setups

1. Continue from TUTORIAL 18.10,

or open the file you saved at the
end of that tutorial. You're going to

learn how to create alternative links
for your map. This is a fast and

easy way to make variations of your

map to change Its difficulty and

game speed.

2. Open the map. When the game

starts, press Esc, click the Mal) but·
ton in the upper·left corner of the
window, and then click the Link
Designer button in the lower-right

corner.

3. Click the Clear links button. Next,

using the skills you learned in
TUTORIAL 16.10, reestablish the
links in a different pattern (see an

example If) FIGURE 16.33}, When

you're finished, click the Export to
UnrealEd button and exit the map.

FIGURE 16.33 The Link Designer with a new
pattern of links,

4. In UnrealEd, flght-click next to the original Link Setup icon you created earlier, and paste

the new Lin\{ Setup Actor next to it. just as you did in TUTORIAL 16.10.

5. Double-click thiS new Actor to open its Prooerties window. Under Ihe LinkSetup category.

change the SetupName property to AlternateSetup1. (When creating your own map, any

name tan be used.) Save your map when finished.

6. Instead of playing the map from UnrealEd, start Unreal Tournament 2004. Click the Instant
Action link in the title screen, and choose Onslaught as your gametype. In the Map List,

you'll see ONS·Ring13 (see FIGURE 16.34).

In FIGURE 16.34, the small plus sign next to the map name has been expanded to dis

play both the default link setup and the new AlternateSetupl. You can repeat these steps

in this tutonal to create as many Imk s~tup v(lrialions as you like.
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FIGURE 16.34 ONS-Ring13 in the map list with the link setups expanded.

ENP TUTORIAL 16.11

16 For all Intents and purposes, you now have a functional Onslaught map. However, most
Onslaught maps included with Unre<11 Tournament 2004 contain vehicles to help navigate the
leveL Vehicles add a new stage of pl<1yability to }'OU r levels. In TUTORIAL 16.12, you see how to
place vehicles in your level.

TUTORIAL 16.12: Placing Vehicles

1. Continue from TUTORIAL 16.11. or open the file you saved at the end of that tutorial.
You'll add some vehicles and weapon racks Into the map.

2. In the Actor Class browser, expand SVehicleFActory > ONSVehicieFactory, where you see a
list of Actors thal correspond to the available vehicles for Onslaught. TABLE 16.4
describes these Actor classes.

TABLE 16.4 Available Vehicles in Unreal Tournament 2004

Actor Class Vehicle and Description

ONSAttackCraftFactory Raptor: A fast-moving flying vehicle. good for air strikes and ground
support.

ONSBomberFactory A currently unused bomber aircraft.

ONSHov erCraftFact 0 ry Manta: A single-occupancy attack vehicle that hovers just above the
ground, allowing it to cross harsh terrain quickly,
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TABLE 18,4 Continued

Actor Class Vehicle and Description

ONSMASfactory Leviathan: This massive "foruess on wheels" packs several plasma

turrelS and C<'ln transform \0 deploy an extremely powerful Car1AOIl.

ONSPAVfac t cry Helfbe flder: This jeep-Ilke ver.lcle can be dnven by one player. but

requires a second to occupy the cannon in lIS rear. A third passen

ger can afso control a plasma cannon.

ONSSAVfactory SCorpion: This one-player off·road vehicle has a plasma bola

launcher In the rea rand packs mass\Ve retractable blades, which

can be deployed from the sides for quick decapllallon.

ONSTankFacrory Goha1h: ThiS awesome tank has a main cannon turret as well as a

heavy machme gun thai can be controlled by a passenger.

3, The ne)(\ pan IS Simple: Select the

vehicle you want to aad. and then

right-cIICk ne>:t to a Power Node or
Core to odd the vehicle, as you would
any other ACI(){, Unreal does the rest

of the w()(k {or you. When you start

the game, the vehicles are wntrolled

by the team WM conlrols lhe nearest

Power Node or Core, Place as many

vehicles as you like, rete", r.g 10

FI au HE 18.36 for companson.

4. (Optional) If you have a Power Node

near the ~nler of the map, you m~hl

want the vehldes lo spawn facIng one

direction (or the red learn or facing the

opposite direclJon {or the blue team.

To do thIs. open the ProperlleS window
(Of the vehicle you want to reverse,

and expand the ONSVehlClefactory

category. wt'lere you lind !he

bReverse81ueTeBIIlOl rec t ion prop.

ercy. If set to true, the VehiCleS face
the opposIte direction when the blue

team wnlrols that PO~( Node (s&e

FIGURE 16.36}.

6, In the same category Is the
RespawnT ime property. which ef'lables

you to wntrol how quicl<1y a vehicle

respawns In a factory after II'S

FIGURE 16.35 Vehicles next to a Power Core
and Nodes.

FI GURE 16.36 Vehicle faces the opposite
dlr~ion when controlled by the blue team.



destroyed. Be careful thaI you don'l use valves lower than 5, which could result If\ the
vehicle never respawl'lng,

6. Save your work and lesl Ihe m<!p, Activate a few Power Nodes, and notice that vehicles
sp<!wn for your team after the node IS cOIIs\ructed.

END TUTORIAL 18,12

Defending Ihe Power Core is a major part of any Onslaught game. As such, ii's a good idea 10 install
lurrels around Power Cores and Nodes to nelp fen.d off advancing enemies. In TUTORIAL. 18.13,

you see how to add lurrels to your level

TUTORIAL 16.13: Adding Turrets
-----=--------------------------

1. Continue from TUTORIAL 16.12, or open the file you saved at the end of thatlulorlal.
You're going to add player/bot-eontrofled turrets to help With Power NOde <lAd Core
defense.

.
FIGURE 18.37 Shot of the turret In place.

4. Con\lnue placing turrets near the
rest of your Power Cores and Nodes.
Even if you don't place Ihe turret
right next to a Power Node. it auc<>
matically calculates which Power
Node it's closest to.

2. Il\ the Actor Class browser, expand Pawn> Vehicle> ONSWeaponPawn >

ONSSlatlOllaryWeaponPawn, where you see the ONSMaf\valGunPawn AClor. ThiS IS the
controllable lurret (ound In many Epic maps for OnSlaught. Select thiS AClor, ~

3. Right-ellcl< and place the turret near
Me 01 the Power Cores or Nodes
(see FIGURE 16.37). Really. that's
all there Is (0 II, Unreal takes care
01 lhe rest. In that the lurret
becomes aclive only when Ih<!t
Power NOde \s online and accessible
only to team members (r(}((\ [he
team who conlrols it.

16

6. Save your work and test the map, Give the turret a try)

END TUTORIAL 16.13

Another game element common to Onslaught maps is the weapon locker. In lhe game, il appears

as a circu(;n rack covered in a variety o( weapons, and it's a great place (Q load up be(oTe march

ing forth 10 lay waSle to ,he enemy. In TUTORIAL 16,14, you see how 10 place weapon lockers

in your level.
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TUTORIAL 16.14: Adding Weapon Lockers

1. Continue from TUTORIAL 16.13, or

open the file you saved at the end of
that tutorial. You'll add the weapon

lockers. where players can load up

on all the weapons they need to
vanquish their enemies,

2. To begm, open the Actor Class
browser. expand Pickup, and click
WeaponLocker Actor, This Actor

enables you to create .. racks' of

weapons in your map that players can
use to load up before diVing Into the

tray.

3. Right-click and place a weapon locker
anywhere in your level (see FIGURE

16.38), and then double-click it to
open Its Properties window,

4. Under the Weaponlocker category IS

the Weapons property, Which contains
an array liSt. Slmpiy click the Ado

button for as many weapons as you

want, and then set the WeaponClass

properly for each entry. You can also

add extra ammo to a specific weapon
with the ExtraAmmo property, but thaI

ammo boost applies only on the first

pickup. not on subsequent locker
contacl. You can see what the

weapon locker looks iike in the game

in FIGURE 16.39.

5. Test your level. and save your worl{

END TUTORIAL 16.14

FIGURE 16.38 Weapon locker added to the
level.

FIGURE 16.39 Weapon locker stocked (in-game).

-- -- ~

NOTE .__ ,_. I
You need only one of eilch weapon. Placing mutt\ple copies I

is (utile, as you can pick UP each weapon only on~, I

Gelting around a larger Onslaught lTIap can be tedious if you don't have a vehicle nearby, but yOll

can solve this problem \vith the lise of tdeport pads. In TUTORIAL 16.15, you tJke a look at how

to add teleport pads to the existing level.
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TUTOR AL 16.15: Adding Teleport Pads

1. Continue from TUTORIAL 16.14, or open the file you saved at the end of that tutonaL
You're going to aad Teleport Pads to the game so that players can transport directly to
Power Nodes or Cores under their control.

16

2. In the Actor Class browser. you'll sel:!
the ONSTeleportPad Actor. You don't
need to expand anything (unless the
Actor category has been closed). Right·
click and place thiS Actor in your level
(see FIGURE 18.40). Typically, plac
ing it relatively close to a Power Node
or Core IS a good idea.

This Actor follows similar rules as
vehicles. It's automatically associ·
ated with the Power Node or Core
it's closest to. If the red team con·
trois that Power Node or Core, only
the red team can access the lele
porter, and vice versa,

3. Start the map. When you enter an
activated teleporter, press the Use
key (the E key, by default). A screen
IS displayed where you can choose
to which Power Node or Core you'd
like to teleport

4. Save your work.

END TUTORIAL 16.15

!NoTE
I Transporting is already inherent to Power Nodes and

Cores, You're simply creating extra areas from which 3

: player can teleport.

FIGURE 16.40 A Teleport Pad added to the
level.

Your level is almost finished. Now you need to create the bird's-eye view of the level that's shown

in the Link Designer. In TUTORIAL l6.1E1, you see how to create this image.

TUTORIAL 16.16: Creating the Link Designer Picture for Your Level

1. Contmue from TUTORIAL 16.15, or open the file you saved at the end of that tutorial.
You're going to create an image of the level for the Link Designer screen,

2. Start your map. When the game begins, press Esc. elie\{ the Game tab at the top of the
window, and then click the Settings button. Adjust the following settings:

• In the Player tab, change the Weapon Hand setting to Hidden. This means you won't
be able to see your weapon in the view.
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NOTE

NOTE
If your texture's scale doesn't align to wtlere the Power
Nodes and Cores appear on the link map, there's a fix.
Go to the Level Properties window, and in the RadarMap
tategory, set the bUseTerrainForRadarRange
property to False. Next, set the CustomRadarRange
property. Use half tlle width of your map plus 100. So if
your map is 4,096 units across, you'd use a value of
2,148 (4,096 / 2) .. 100). Depending on your map
size, small adjustments might be necessary, althougn
trlis formula should get you very close in mos1 cases.

This is only one method of collecting this screenshot.
You could use a variety of other methods, inclUding
taking a larger screensllot, and then aIteriog it and
adjusting its size in your favorite imaging software,
such as Adobe Photoshop.

FIGURE 16-41. UT2004 as a 256x256 wjndo~.

• In the Weapons tab, disable Custom Weapon Crosshairs, and set the Crosshair

option to Hidden, which is at the bottom of the list.

• Finally, in the Hun tab. select the Hide HUD check box.

3. If you're currently running In full·screen made, press Alt+Eflter to go to a windowed mode.

4. Bring down the console, using the

tilde (-) key. Type setres 256x256

to set the window's resolulion to

256x256, which is exactly the reso·

lution you need for your image (see

FIGURE 16.41).

S. Next, at the console. type ghost to

make your character able to fly.

Press the tilde (-) key again to put

aWdY the console, ana fly yourself

high above the level so that you can

see It in a lop-down View, Rotf'lte

yourself so that north is at the top

of the window, as in the UnrealEd's

Top viewport.

6. Finally, notice that at this resolution,

the field of view (FOV) seems too high.

To correct this. go back to the console,

and enter the command FOV 20 to

lower Ine field of view, alleviating the

"flsh-eye" distortIOn. After doing thiS,

YOU'll likely need to position yourself

higher above the map. If you're already

looking down, simply use the Back
!Jullon (5 by defdult).

1. You should now see a bird's·eye view of

the map. Make sure you position your·

self so that the window outlines the

playable area of your map perfectly.

8. Use the screenshot button (F9 by

default) to create a new screenshOl in

your Screenshots folder, typically

located in your UT2004 folder. The

screenshot should be named some·

thing like Shot00001 . bmp. Your screen·

shot number might be different, so sift

through the images until you find the

one you just took.
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9. Go to \he UmealEd Te)('\ure browser. Import the Image using Ihe name Aadarl.lap. and
Slore it ir. Ihe myleve( pockage, Next. righl·chck the texture, and choose Compress> DXT1

[0 reduce the Image's file size.

10. Make sure the new RadarMap telcture is selected in the Texture browser, Next, go to 'he

Level Properties wir.dow (or your level, and unCler the RadarMap category. chck the

AadarMapllllage property, and dick the Use bUllon,

ll. Save and lest your map. Notice that your new Image appears in Ihe game map as lVen as

in fhe Link Designer (see FIGURE 16.42j.

,

Unk DesIgner with image in place,

'END TUTORIAL 16.18

Design Considerations for Onslaught

lNhen da;igning an OnsJaugh I map, ir's !I gOM idea to plan your map carefully, espe<:ially place

ment of nodes and their links. "(ou want Ihe map 10 be challenging but not impo~ible, yet enwre

thM nl"ither te;\m has any geographical or equipment-based advanlage. To avoid one team having

an advantage, you should make certain b6th learns have: the same number DC each vehicle type,

the same number o( turrets, and so on.

Placc your Power Cores in a weU-dcCended location Ihat's not Visible {rom long dislance-s. Few

rhings are as frustrating as discovering lhat the enemy can pummel your Power Core inlo obliv
iOIl with a tank cannon while firing from;l mile aw-ay.

Keep in mind Ihat teams swap loeJtions from one round (0 the next. Because of 'his, level

sj'lllmelry is sl rongly advised to keep the: g<lme from bCC6ming uobaJanced.
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Be aware of the kinds of vehicles you need for your map, and don't overdo it. For example,

remember that the Manta is very fast and doesn't take steep inclines well, or the Leviathan is

excessively large and might be out of place in a smaller map. If airborne attacks would make the

map too easy or be out of place, avoid adding Raptors. If, however, your bases are divided by a

massive chasm, you need flight-capable vehicles.

Make sure all weapon bases and weapon lockers are equipped with Link Guns. They are vital in

an Onslaught map, as they allow you to repair vehicles, repair damaged Power Cores, and con

struct Power Nodes faster.

When creating your Onslaught map, you might want to keep in mind two special properties

located in the Level Properties window. The first is DustCo!o r, under the DustColor category. If

left at the default (black), dust from tires and Manta fans is brown. You can LIse the Color Picker

to change the color to anything you like, such as white for snowy levels.

The second is StaHl, under the LeveJ1nfo category. This property, set in Unreal units, sets a limit

on how high the Raptor can fly, but does so in a smooth manner so that if the Raptor goes beyond

this limit, its vertical velocity slowly bleeds off, and the Raptor fall.~ until it's back below this

height. A horizontal blue line, visible in the Front and Side views, gives you a visual representa-

tion of the height limit. ~

Assault
Assault is another team-based gametype in which one team is attacking while the other is defend

ing. The game is objective based, in that the attacking team is trying to complete a series of objec

tives, and the defending team opposes them. The objective types include destroying ohjects,

holding objects, or activating switches.

The game also has a set time limit, dictating how long the attacking team has to complete its

objectives. If it fails, the defending team is successful. If the attacking team completes each objec

tive, it's successful.

After this, the two teams swap positions: The attackers become the defenders, and vice versa. If

the new attackers complete all the objectives in less time than their opponents did, they win the

match. If the new defenders manage to hold the objectives longer than their opponents did, they

win instead. If neither team compJetes aU objectives, the win goes to the team that scored the most

objectives. To sum up, both teams attack. The team that attacks the most effectively is the winner.

Setting up an Assault map requires quite a bit of work, so you'll be going through it step by step.

As an overview, the process requires the following:

~ Setting up objectives

~ Setting up player spawn management

~ (Optional) Matinee intra and ending scenes

569
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In this chapter, we will be discussing the first two of these: establishing the objectives and con

trolling player spawn locations. For more information on Matinee sequences, be sure to check out

Chapter 13, "Matinee: Creating Custom Cinematics."

Before you begin, take a look at the map you're going to create. Planning your objectives before

the level design is a good idea, so the following list explains the types of objectives you're going

to create so that you have a good idea of where you're going before you get into the tutorials:

1. The first objective is to throw the switch to open the first set of doors, which requires

walking up to a computer and pressing the Use key. After that's completed, the doors

open and your team can proceed.

2. Next, you need to get through the second set of doors. This time, you have to hack the

door's computer instead of pushing a button. Fortunately, there's an AutoJ-Iacker 9000 in

your pocket. You simply need to stand near the computer long enough, and the doors

slowly open as the system is compromised. If you die or get knocked aside, however, the

doors begin dosing slowly until they are completely dosed again, or until you or a team

mate gets back into position to hack the computer.

3. Finally, you need to get through the third door. At this point, subtle tactics must go out

the window. You need to destroy the lock mechanism over the third door. After it's blo~n

away, you can enter the final room.

4. In the final chamber, you need to access a computer in the room to stop its calculation

cycle. Simply walking into it should do the trick. With that, you will have successfully

completed all your objectives.

Now that you know what you're going to be doing in terms of play, the (allowing list outlines

these same objectives using UnrealEd terminology:

1. The first objective is a TriggeredObjective. In this case, you hook it up to a simple

UseTrigger so that when a player activates the trigger, the objective is completed.

2. The second objective is called a I-loldObjective, meaning that a player mLlst hold a certain

position for a set amount of time before the objective is considered complete. In this case,

if the player moves away from that spot for any reason, the timer slowly counts back,

meaning that the doors slowly close until someone holds the position again.

3. The third objective is considered a DestroyableObjective. This means some object must

be destroyed before the objective is completed.

4. The final objective is a ProximityObjective. This objective is completed when players

enter a specific radius from a set point.

You also have to carefuUy control how your player spawns react to objectives being taken. For exam

ple, when the match starts, the attacking team spawns and begins charging the first objective. If the

defenders spawn near the back of the map. they could be too far away to defend that first objective.

This means they need to spawn somewhere ncar the first objective to have a chance to protect it.



Assault 571

At the same time, if the defenders fail and that objective is taken, they need to be spawned closer

to the second objective when they are killed. The same goes for the attackers. As soon as they com

plete the first objective, there's no reason for them to spawn all the way back at the beginning of

the map. Instead, they need to spawn a little farther along in their progress, possibly at the first

objective they just claimed.

Player spawn management can be complex and confusing. You might find yourself getting dis

oriented as to where players should spawn at different times. You have a few alternatives: You

could create entirely new sets for both defenders and attackers as each objective is taken, or you

could set up a system so that as attackers claim an objeC1ive, they use the same spawn points the

defenders were using to try to hold that objective. You could foUow this pattern aU the way across

the map so that you don't need two separate sets of spawn points. VVhich method you use simply

depends on the design of your map. If it's convenient to reuse spawn points from one team to the

other, by all means do so. If defenders and attackers are taking separate routes across the map, .

however, having two sets of points for defenders and attackers might make more sense.

Either way, planning your objectives on paper is probably best. Make a quick sketch of your map, and

diagram where you want attackers and defenders to spawn for each objective. In FIGURE 16.43,

you can see an example that you'll be ming, in which the attackers simply reuse the defender's spawn

points as the objectives are progressively claimed. Therefore, 0 points (defending spawn poin'ts)

become attacking spawn points after that objective has been claimed. For example, the 0] points

become X2 points after the first objective has been claimed, meaning that when attackers are work

ing on objective 2, they spawn from the same place the defenders did on the first objective.

0?02
0 2 0 2

Objective 1 ---+ 1===:j:::==:t===~==::::jf::::==l===I+--ObJectl ve 3

0'0'
DID'

XI ~ Attack spawn point (Objective 1)
0 1 =Oelend spawn poinl (Objeciive 1)

Objeclive 4

FIGURE 16.43 Plan your objectives on paper first.

[n TUTORIAL 16.17, you establish your map as an Assault map and create your first objective.
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TUTORIAL 18.17: Setting Up an Assault Map and Creating an Objective

1. Open the Deathmatch version of your map, Tutoria116_17_Start .ut2. You'lI convert this
map into an objective·based Assault map, Before you begin. open its level Properties win·
dow. setting the Defau 1tGameType property to UT2k4Assault .ASGame!nfo.

2. locate the computer terminal just to

the fight of the first closed door. ThiS
is the pos Itlon of your first objective.
In the Actor Class browser, expand
NavigationPoint > JumpDest >

JumpSpot > GameObjective. and
click TriggeredObjective. Place this
Actor on the (Ioor right In front of the
monitor (see FIGURE 16.44),

3. You need to set some properties for
this objective, Open Its Properties win
dow. and under the Events category,
set the Tag property to 08Jswi tch,

This setting causes the Actor to
"listen" for the OBJswi tch event

4. Next, set the Even t property to
08Jswi tCh_ complete. ThiS means
that after the objective is complete,
it "transmits" the OBJswitch_com.
plete event, which you can use to

cause other events to happen, such
as doors opening,

5. Now you need to add a UseTrigger
from the Actor Class browser under
the Triggers category Place it very
close to the TriggeredObjective Actor
(see FIGURE 16.45). Next, you
need to set some properties (or it.
Under the Collision category, set the
CollisionAadius property to 70,

which means players need to be
within 70 units of the trigger to
activate It.

FIGURE 16.44 A monitor with a
TriggeredObjective in front of it.

FIGURE 16.45 A UseTrigger added next to the
TriggeredO bjective.

6, Now you need to set up events for the UseTngger. Under Its Event category. set the Event
property to OBJswitch so that the trigger transmits thiS event when it's activated.

7, Select the trigger located between the first two doors and delete it. Select both doors. and
open the Properties window. Under the Events category, chwge t:le Tag property to



OBJswitch_complete, which causes
the doors to open after the objective is

completed.

8, (Optional) You can add a Triggerlight

rn front of the Objective, mostly for
visual effect but also to give you a

better idea of where the objective is
located. In the Actor Class browser,
expand the Light category, and click

TriggerLight Actor, Place this Actor
near your TnggeredObjective and

UseTrigger. Next. set the following
properties (see FIGURE 16,46 for
the results):

Under the Light Color category

llghtBnghtness: 255

lightHue: 150

LightSaturation: 50

Under the lighting category

LightRadlus: 5

9. Save the map as AS-Ring13. Test

it out. and try to complete the first
objective.

END TUTORIAL 16.17
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FIGURE 18.46 A light added to indicate the
location of the trigger.

Under the Events category

Tag: OBJswltch_complete

Under the Object category

1n!tlaIState: TriggerTurnsOff

Under the TriggerLight category

blnitlallyOn: True--- ----- -:lNOTE
You might need to move the light closer to the floor to

see an effect.

You've now completed the first objective in your Assault map. Next, you set up a new type of
objective, called a HoldObjective. TUTORIAL 18.18 shows how to get this objective into the

level.

TUTOR'AL 16.18: Creating the HoldObjective

1. Continue from TUTORIAL 16.17,01 open the file you saved at the end of that tutorial.

Next, you add the second objective, the HoldObjectlve, to the level.

2. In the Actor Class browser, expand NavigatiooPoint > JumpDest > )umpSpot >

GameObJectlVe > ProxlmltyObJective, and click HoldObJective Actor. Place this Actor on the
computer at the Jett side of the second set of doors (see FIGURE 16.47).
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3. In the HoldObjecti"e's Properties

window. expand lhe Ellents ~tego(y,

and set the T~g P{OP~ to OB.Jholc

and the Event property 10
08Jhold_co~plete.

4. In the HOldObjeclive category. set

the MoverTag propeny 10 000l's2

(which is the name of the doors. as

you might recall).

5. Delete the lIigger between the two

doors. Select bolh doors and open

the Properlles window. Under the

Events category. set the Ellen t prop·

erty to OBJhol.d so that the doors
transm)l lhls event when they are

completely open. This, in tum. Wilt

complete the obJective.

6. To slow the doors down a linte.

under the MOiler category, set the

l.1oveTlllle property to 5. meaning

that a player needs to hold that

position for fille seoonds to com

plete Ihe ooJectille.

7. Save and test the map. Your second

objective should now work propelly

(see FIGURE 16.48).

r NOTE
UOller tM Move(s ObjeCl category, the
J 1'\) 11a1Stat e propeny Is OJrrenUy
set to Triggerecnt roI. This means
that, be!laviorally, ltle door opens only as
long as ~omeooe Is tJiggering it (that Is.
standing 00 tha HoldObJectlve~ If you
change the InuialState p~ertyto

..,. r iQQe,..A<lV anee Instead, lhe door
would oonllnue to open until tfle player
was kJlled or moved away from tire spot
1nan tile door would simply stop and watt
to be moYed ru ftll et.

END TUTORIAL 16.18

FIGURE 16.47 Second objective room wilh a
HoldObjeetive added in front of the monitor.

FIGURE 16.48 The HoldObJectJve In-game with
Its graphIcal Indicator for where you should stand.
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In Assault maps, often you find objectives that require you to destroy some type of object.

TUTORIAL 16.19 introduces you to the DestroyableObjective and shows how to set it up in your

level.

TUTORIAL 16.19: Creating the DestroyableObjective

1. Continue from TUTORIAL 16.18, or open the file you saved at the end of that tutorial.
You're going to add the third ohJ~ctive for your map. i'l DestroyableObJective.

2. Navigate the Perspective view to the
third door. You see a static mesh
centered over the door (see
FIGURE 16.49). In the Properties

window, expand the Display cate·
gory. Click the Stat icMesh property,
and copy the line you see there to
the Clipboard by pressing Ctrl+C.
You'll be using this mesh in your
next Actor, and copying this line
keeps you (rom having to dig the
Actor out of the Static Mesh
browser, When you're finished,
delete this static mesh,

FIGU RE 16.49 The mesh YOU'll be using for the
Destroyabl eObjective.

3. In the Actor Class browser, expand NavigationPoint > JumpDest > JumpSpot >

GarneObjective > DestroyableObjective, and click DestroyableObjective_SM Actor. Place
this Actor in the level. When it comes in, it looks like a simple cube.

4. To fix thiS, you need to adjust one of this Actor's properties. Open the

DestroyableObjective's Properties window, and expand the Display category. Click the
Stat icMesh property, and click Paste to paste in the iine you copied from the static mesh
previously. This line changes the cube into the static mesh shown in FIGURE 16.48.
Rotate the mesh, and place it In its onginal position.

5. Under the Actor's Events category, set the Event property to OBJdestroy_complete. Now

you need to specify how eaSily the object can be destroyed. For testing purposes, you'll
leave this setting lOw. but you might want to set it higher when you finish the map_ For
now, set it to 100, which allows It to be destroyed by about two rockets.

8. Next, you'll set up a damage mesh for the door lock so that it has a separate model when
it's destroyed, To do this, in the Static Mesh browser, open the Chapteri 6_SM package,

and select the smashMesh model.

Now open the Properties wi ndow for the DestroyableObjective. Expand its
DestroyableObjective_SM category, and click the Des t royedStaticMesh prOperty. Click the
Use button next to this property to paste the smashMesh's path into the property. The

mesh now converts to the new damage model after It'S destroyed in the game. To set up
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an explosion effect, simply create an emitter that warts for the OBJdest roy _complete

event. For more information on emitters, see Chapter 10, "Creating Particle Effects:

7. Finally, you need to adjust the doors to respond to the objective and slow down their
motion a bit. If you haven't already, delete the existing trigger that was used to open them
in the Deathmatch version of the level.

Select the doors, and open their Properties Window. Under the Events category, set the
Tag property to OBJ destroy_comp 1ete to open the doors after the lock IS destroyed.
Under the Mover category, set the MoveTime property to 2 to make the doors run more
slowly.

8. Save your work and test the level. Verify that all three objectives are working.

EN TUTORIAL 16.19

Another type of objective is the ProximityObjective. This objective can be completed simply by
coming within a specific range of the associated Actor. In TUTORIAL 16.20, you see how to

create this objective.

TUTORIAL 16.20: Creating the ProximityObjectlve #

16

1. Continue from TUTORIAL 16.19, or open the file you saved at the end of that tutorial.
You're going to create the fourth and final objective, the ProximityObjectlve.

2. In the Actor Class browser, expand NavigatlonPoint > JumpDest > JumpSpot >

GameObjective, and click ProximityObjective Actor. Place this Actor in your level. just In
front of the computer along the north wall of the last room, near the Window.

3. Open the Actor's Properties window. Under its Event category, set the Event property to
OBJfinal_complete. This setting causes the Actor to send out this event when It'S trig
gered. The event sent out IS used to end the map. The Actor requires no tag, as Its
inherent nature is to tngger when a player reaches a certain proximity to it.

4. Under the Collision category, set the Co 11 iSl0nRadlUS property to 70, ThiS setting
causes the Actor to trigger when an attacking player gets withm 70 Unreal units of II.

5. Back in the Actor Class browser, expand Triggers, and click Trigger_ASRounoEnd. This
Acto(s only (unction is to end an Assault round after all objectives have been completed,
Place this Actor in the map; its location doesn't matter.

6. In the Properties window of this new Actor, expand the Events category. and set the Tag
property to OBJfinal_complete, which as you might recall, is being sent out by the final

objective.

7. Save and test the map, Make sure that all objectives are functioning correctly.

END TUTORIAL 16.20
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Now that your objectives are in place, you need to be able to choose the order in which they need

to be accomplished, Because the objectives have no order by default, your map would be

unplayable if you had to complete an objective to which you hadn't yet been able to adval'lce. In

TUTORIAL 16.21, you see how to assign an order to the objectives in your level.

TUTORIAL 16.21: Setting Objective Order

1. Continue from TUTORIAL 16.20. or open the tile you saved at the end of that tutorial. If
you played through the map right now (with a cheat or two activated to move through

walls), you would see that you can complete these objectives in any order. This won't do

because sometimes drastic changes in the level take place after an objective is claimed.
You always want objectives to be taken in a speCific order. so you'll number them to make

sure this happens.

2. For setting up objective order, each objective has a common category named
GameObjective and a common property, DefensePnority. This is a zero-based property

that you must use to give each objective a certain priority, Keep In mind, however, that this
system must be numbered in reverse, meaning that the final objective is numbered zero,

counting upward back to the first objective.

3. Open the Properties window of the final objective (the ProximityObjective), expand its ~

GameObjective category, and set Its Defens ePnority property to zero.

4. Repeat this process With the remaining objectives, setting their DefensePriority

properties as follows:

• Objective 3 (DestroyableObjective) set to 1

• Objective 2 (HoldObjective) set to 2

• Objective 1 (TriggerObjective) set to 3

5. Save and test your map. The objec
tives can now be completed only in the

proper order. You're ready for player

spawn management now.

END TUTORIAL 16.21

NOTE
You can have multiple objects with tile same priority.
This allows you to set up alternate routes or createl areas that players can access for special bonuses.

Your level is nearing completion. Now you need to control how players spawn as they play the

leveL This can sometimes be difficult, as your attacking and defending teams need to spawn from

different points at different times during gameplay. In TUTORIAL 16.22, you see how to set up

these spawn points.
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TUTORIAL 16.22: Establishing Player Spawn Points

1. Continue from TUTORIAL 16.21, or open the file you saved at the end of that tUlona!.

You're going to set up your system of player spawns for the match. To avoid confusion, you
begin by deleting all existing PlayerSslarts. Select a PlayerSlarl, right-click on il, choose
Select> Select All PlayerStarls, and then press the Delete key,

2. Next, create a cluster of four PlayerStarts in the southwest corner of the first room. Selecl

all four of these PlayerSlarts, duplicate them, and mO\ie them to the defender's spawn

location. They should be somewhere In front of the first door, where the computer can
easily be defended.

3. Select all four of the defender's PlayerStarts. In the Properties WindOW, expand the

PlayerStarts category. and set the TeamNumber property to 1.

4. Duplicate the four defender PlayerStarts.
and place them near the second door,
just across from the HOldObjeetive, Set

the TeamNumber property for this group
to 2. Repeat to set another group in

front of the third objective with a
TeamNurnber of 3, and again to place a

final group in front of the last objective,

with a TeamNumber of 4.

! NOTE
The TeamNumbar properties don'l necessarily indi
cate specific teams io this case. Rather, they are used
to give each group of spawn points a specific ID !lum-

I ber so fllat they ca n later be assigned to a
PlayerSpawnManager Actor,

6. Save your work. There's no point in testing just yet.

END TUTORIAL 16.22

Next, you need 10 control how the spawn points in yOLlr map are used. To this I'nd, you can use
toe PJayerSpawnManager Actor, which gives you <.Ontrol over when particular spawn points
become available for each team. In TUTORIAL 16.23, you see how 10 place these Actors and use

them in the level.

TUTORIAL 16.23: Setting Up PlayerSpawnManagers

1. Continue from TUTORIAL 16.22, or open the file you saved at the end of that tutorial.

You're going to place some special Actors Ifl your level to control where attackers and

defenders spawn al any time in the match.

2. In the Actor Class browser, expafld Info, and click PlayerSpawnManager Actor. Place one of
these Actors just outside Ihe first group of four PlayerStarts (TeamNumber 0). You're using

a specific pattern when placing these Actors: Attacker-based managers are placed outside
the group, and defense-based managers are positioned inside, Because thiS first group is

only attackers, you have only a manager outside the group.
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3. Open the Properties window, expand the Events category, and set the Tag property to
PSM_Att1. This setting designates the manager as affecting the first group of attacker
spawn points.

4. Move the view to the second group of PlayerStarts (TeamNumber 1). Add a

PlayerSpawnManager in the middle of the group. Remember that managers in the middle

of the group are designated for defender spawn points. Set its Tag property to PSM_Def1

to designate the manager as controlling the first defense spawn point.

Expand the PlayerSpawnManager category. Set the AssaultTeam property to

EPSM_Defenders. Next. set the PlayerStartTeam property to 1 to associate it with this
particular set of PlayerStart Actors.

5. Add a new PiayerSpawnManager Actor outside the group for attackers, Set its Tag property
to PSM_Att2. In the PlayerSpawnManager category. set bEnabled to False, so that the

manager Isn't active when the match begins. Set the PlayerStartTeam property to 1 to

associate it with these spawn points.

6. Select the two managers at the TeamNumber 1 group of PlayerStart5. Duplicate the pair,

and move the duplicates to the third set of spawn pOints, located in front of the
HoldObjective. Position and rotate them so that the manager that was originally inside the

cluster of spawn points is still within the new cluster. ~

7. Open the Properties window for the manager within the group (defender). Set its Tag
property to PSM_Def2. Under the PlayerSpawnManager category, set bEnabled to False

and PlayerStartTeam to 2.

8. Now open the Properties window for the other duplicated manager. Set its Tag property to
PSM_Att3. and set the PlayerStartTeam to 2.

9. Duplicate the two current spawn managers, and move the duplicate to the next cluster (in

front of the DestroyableObiective) of PlayerStarts, positioning them as you did before. The
manager within the group needs its Tag property set to PSM_Def3 arid its

PlayerStartTeam set to 3. The manager outside the group needs a Tag property of
PSM_Att4 and a PlayerStartTeam of 3.

10. Select only the central manager (defender) and duplicate it. Move the duplicate to the last

group of PlayerStarts, and open its Properties window. Set its Tag property to PSM_Def4

and its PlayerStartTeam to 4.

11. Save your work. You still can't test this map yet, but you're getting close.

END TUTORIAL 16.23

Now you need to create a system that controls the PlayerSpawnManagers, telling them when to

switch team spawn locations from one point to another. To do this. you set up a ScriptedTrigger

Actor in TUTORIAL 16.24.
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TUTORIAL 16.24: Hooking It All Up

1. Continue from Tutorial 16.23. or open the file you saved at the end of that tutonal. You're
going to establish a ScriptedTrigger that's controlled by the objectives and uses the events
sent from those objectives to control and reroute player spawn locations.

2. In the Actor Class browser, expand Keypoint > AIScript > ScriptedSeQuence. and click the
almighty ScriptedTrigger Actor. Place this Actor anywhere In your level.

3. In its Properties window, expand the AIScript category, where you'll be setting up an Action
list. Click the Actions property, and then click the Add button to add a new blank Action.
Click the New line, and in the drop-down list, choose Action_WAlTFOREVENT. Click the
New button to create thiS Aclion.

4. With the new Action added, you now have a new property named ExternalEvent. Set it to
OBJswltch_complete, which causes the trigger to listen for the event sent when the first
objective is completed.

5. Under the Actions property, click the Add button again. This gives you Action index (11. In
the New line. choose ACTION_ASSetPlayer-SpawnArea. Click the New button next to the
drop--down list.

6. This Action should now show two new properties: PlayerSpawnManagerTag and
bEnabled. These properties are used to enable and disable PlayerSpawnManagers. Set
PlayerSpawnManagerTag to PSM_Att1, and set bEnabled to False.

7. You might have noticed a pattern when using the ScriptedTrigger: You add an Action, spec
ify the Action, and set the corresponding properties. You'll add several more Actions to
this trigger, using TABLE 16.5 to walk you through setting up the rest of the trigger. You
can check your ScriptedTrigger against thiS table if you need help,

TABLE 16.5 Necessary Actions for ScriptedTriggerl

Index

[01

(1)

[2J

(3J

[4J

Action

Act ion_WAI TFOREVENT

ACTION_ASSetPlayerSpawnArea

ACTION_ASSetPlayerSpawnArea

ACTION_ASSetPlayerSpawnArea

ACTION_ASSetPlayerSpawnArea

Properties

Externa lEvent = OBJswl tch compi ete

PlayerSpawnManagerTag = PSM_Att1
bEnabled :: False

PlayerSpawnManagerTag = PSM_Att2
bEnabled :: True

PlayerSpawnManagerTag = PSM_Defl
bEnabled = False

PlayerSpawnManagerTag :: PSM_Def2

bEnabled = True
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Here's how this setup works. one Action at a time:

~ Index [0]: During this Action, the ScriptedTngger walts until it receives the

OBJswitCh_complete event when the first objective is completed. Then it continues

to the next index.

~ Index [1]: This Action disables the first group of attacking spawn points.

~ Index [2]: This Action enables the second group of attacking spawn points.

~ Index [3]: This Action disables the first group of defending spawn points.

~ Index [4]: This Action enables the second group of defending spawn points.

In a nutshell, the first Action starts the trigger, indices [1] and [2] advance the attackers,

and indices [3] and [4] advance the defenders.

8. Duplicate the ScriptedTrigger, and adjust your Action indices to match TABLE 16.6.

TABLE 16.6 Necessary Actions for ScriptedTrigger2

Index Action Properties

[0] Action- WAITFOREVENT ExternalEvent = OBJhold_complete ,
[1] ACTION_ASSetPlayerSpawnArea PlayerSpawnManagerTag ~ PSM_Att2

bEnabled = False

[2] ACTION_ASSetPlayerSpawnArea PlayerSpawnManagerTag ~ PSM_Att3

bEnabled = True

[3] ACTION~SSetPlayerSpawnArea PlayerSpawnManagerTag = PSM_Def2

bEnabled = False

[4] ACTION_ASSetPlayerSpawnArea PlayerSpawnManagerTag = PSM_Def3

bEnabled = True

9. Next, duplicate the trigger again, and match the action indices with TABLE 16.7.

TABLE 16.7 Necessary Actions for ScriptedTrigger3

Index

[0]

[1]

[2]

[3]

(4]

Action

Action WAITFOREVENT

ACTION_ASSetPlayerSpawnArea

ACTION_ASSetPlayerSpawnArea

ACTION_ASSetPlayerSpawnArea

Properties

ExternalEvent = OBJdestroy_complete

PlayerSpawnManagerTag = PSM_Att3

bEnabled = False

PlayerSpawnManagerTag = PSM_Att4

bEnabled = True

PlayerSpawnManagerTag = PSM_Def3

bEnabled = False

PlayerSpawnManagerTag = PSM_Def4

bEnabled = True
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10. Make sure you rebuild paths at least once before starting the map. Save and test your
work. Now you can progress through the map as you expect. As you complete each
objective, test your respawning position by killing yourself. A fast way to do this is to type
suicide in the console.

END TUTORIAL 16.24

Summary
In this chapter. you have taken an extensive look at necessary Actor setup for the available game

types in Unreal. With this knowledge, you should be ready to experiment and create your own

variations of any kind of map you like. Combine what you have learned in this chapter with the

skills you find throughout this book, and you'll become a more versatile level designer.

#



r,·

External Design
CHAPTER 17

CHAPTER 18

CHAPTER 19

CHAPTER 20

CHAPTER 21

CHAPTER 22

CHAPTER 23

Overview of Maya

Polygonal Modeling Tools

The Art of Texturing in Maya

Static Meshes

Character Modeling

Importing Characters into UnrealEd

Character Animation





Please keep in mind that this chapter is

intended to give you a basic overview of
using Maya, not to teach you every

nuance of the program.

'---- -----

Chapter

Overview of Maya

This chapter introduces you to Alias's powerful 3D content creation

tool, Maya. For years, Maya has been an industry standard in the

filmmaking industry and has recently been used in some of today's

hottest games. The lessons covered in this chapter are used as the

cornerstone for most of the remaining chapters in this book.

By now, you should already be accustomed to using UnrealEd, so

you should be familiar with the basic concepts of working in 3D

space. The chapter begins by covering some basic theory behind

how Maya works and continues with a thorough discussion of

Maya's user interface. You then move on to learn about Maya's pow

erful material creation ,NOTE
tool, Hypershade, and a

tool for seeing 3D scenes

at their most fundamental

level-Hypergraph~
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V-Up Versus Z-Up

------_._-------------~

When working in Maya, an important factor to keep in mind is the difference in coordinate sys

tems among 3D applications. Some programs, such as UnreaJEd, use a coordinate system in

which the Z-axis points upward. Other programs, such as Maya, use a Y-up system, in which the

Y-axis points upward. FIGURE 17.1 shows the difference between the two coordinate systems.

Both coordinate systems function on an equal level, and neither is technically better than the

other. However, when you're switching from one program to the other, you must keep the differ

ences in coordinate systems in mind. Fortunately, most exporting programs and plug-ins have

settings to deal with the conversion so that you don't have to.

z

The Unreal Coordinate System

y

The Maya Coordinate System

FIGURE 17.1 Unreal coordinates versus Maya coordinates.

17 Maya Theory
The following sections discuss the fundamental nature of Maya. You must understand some of

this program's concepts before you can use it effectively. These concepts include nodes and con

nections as well as how construction his

tory works. These concepts are discussed

first to help you better understand how

Maya works internally.

Nodes and Connections

At its heart, Maya is simply a system that

creates nodes and connections between

them. Even the simplest object is actually

composed of a series of nodes. These

nodes define the object you see in the

viewport. In FIGURE 17.2, you can see a FIGURE 17.2 What you see onscreen.
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simple cube in a Maya viewport, and

FIGURE 17.3 shows the series of nodes used

to create it. TABLE 17.1 lists the types of

nodes and describes what sort of data each

node provides to create the cube object you see.

Transform node

NOTE
The node structure explained in TABLE 17.1 is the
same tor any polygonal object, not just cubes.

I_ClJ_poIyClM__1 _------'H~~1
Input node Shape node

FIGURE 17.3 What goes on inside Maya.

H ® InItIaIShlldlngGroup

Shading Group node

Shading Group node

TABLE 17.1 Polygonal Object Node Structure

Node Description

Input node This node contains all the geometric data for the object, including

such attributes as width, height, depth, and the number of subdivi

sions (edges) in each direction. You can think of this node as the

"blueprint" of your cube.

Shape node This node receives data from the Input node and uses it to con

struct the cube. The attributes of the Shape node control the cube's

internal behavior rather than its external appearance. You can think
of this node as the "builder" of your cube.

This node is used to control what your object looks like when ren
dered. It controls the behavior of the material applied to the object.

This node can be thought of as the "painter" of your cube.

Transform node This node contains all the transform data for your cube-its posi

tional, rotational, and scale data. You can think of this node as the

"mover" of your cube.

NOTE
When you are looking at the nodes in the Hypergraph,
the Transform node appears to be separate from the
other nodes. Keep in mind that the Transform node is
tied into the network, although you cannot see the
connections.

"'------ -_.-. -

Therefore, as you can see in FIGURE 17.3, your blueprint (Input node) is sending data to the

builder (Shape node) of your cube. After constructiop, the builder hands the cube off to the

painter (Shading Group node) to determine

what sort of paint job it should have. Finally,

the finished work is sent to the mover

(Transform node), which then decides where

the cube is placed and what sort of scale

(size) it should have.
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Because the example discussed so far is only a single object, the node network is currently sim

ple. The more actions you perform on objects, the more complex their node network becomes.

These networks can eventually become quite massive. FIGURE 17.4 shows a node network for

defining an entire character, after it has been constructed and prepared for animation.

.-~

_._--------------~

-~""""""":~~~~~---".-. '---='-

FIGURE 17.4 Maya's node network for a character.

There are so many nodes and connections that you can barely see the individual nodes. In fact, if

each node icon in FIGURE 17.4 were one inch long, the network would span over 10 feet!

Construction History

Now that you understand that all Maya

scenes are constructed as a series of inter

connected nodes, you can see how con-

17 struction history works. As mentioned, the

Input node feeds data to the Shape node,

which then constructs the object you see in

the viewport. However, as you perform

actions on an object, more nodes are cre

ated that are connected into the Shape

node. In FIGURE 17.5, you can see a sim

ple cube, just like the example in the previ-
ous section. FIGURE 17.6 shows the FIGURE 17.5 A cube in Maya.

nodes to create this cube.
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Transform node

589

Input node Shape node

@llnillalShadingGrOUp

Shading Group node

FIGURE 17.6 The nodes needed to create the cube in FIGURE 17.5.

To illustrate how construction history

works, an extrusion has been performed

on the cube. An extrusion is simply a way

to pull out part of an object while adding

more geometric detail. (This simple

modeling operation is discussed in
Chapter 18, "Polygonal Modeling Tools.")

After the extrusion, the shape of the cube

has changed as well as it subsequent node

network (see FIGURES 17.7 and 17.8).

I,-CJ)..;",.~ -"H iiib polyExl,udoFaCOl

FIGURE 17.7 Cube's appearance after the extrusion.

1.-.:;.".'a>_pClD_'_---Jf
1-----t:_-LI'a>-=--~__'------lHj~~'-~I

FIGURE 17.8 A new node, polyExtrudeFacel, is added behind the scenes.

A new node, polyExtrudeFacel, has been

added to the network and is feeding

information of its own into the Shape

node. This means the Shape node must

now consider data from two separate

sources. The mass of nodes used as

inputs is called construction history. In
effect, it records every operation per

formed on an object as a separate node in

the network. Currently, this network is

still quite small. In FIGURE 17.9, the

simple cube has been modeled into a

basic spaceship. FIGURE 17.10 shows

the resulting network.

'--

FIGURE 17.9 A spaceship model.

..----_._--
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FIGU RE 17.10 Maya's node network for this spaceship.

Every action performed to create the spaceship was stored in the network as a separate node. This

model is relatively simple, yet the network is already quite large and complicated, even to the point

that you can't see what the individual nodes are if you take in the network as a whole.

The Benefits and Drawbacks of Construction History

Result of the extrusion

FIGURE 17.11 Shape after the two operations.

Using the object's construction history, you

can access the settings of the wedge and

change its angle from 90 to 45 degrees (see

FIGURE 17.12). Notice the object's new

shape in FIGURE 17.13. This method

allows you to alter modeling operations that

took place several actions ago. In a way,

it allows you to go back in time and

make changes to operations that have

already taken place. The shape you see in

FIGURE 17.11 was achieved without hav

ing to undo the extrusion, even though the

extrusion took place after the wedge.

As you can see, construction history can quickly become quite large. Construction history can be a

help in some cases and a hindrance in others. Because each operation you perform is stored as a node,

you can access each node and change the attributes in it. These changes are sent back down the net-

17 work, thereby changing your object's shape. In FIGURE 17.11, two operations have been performed

on the cube. The first is a 90-degree wedge;

the second is a polygonal face extrusion.

_ ...._._---
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Changing the wedge angle to 45.

Result of changing the wedge

{NPIJTS
~Ret
liiiWMIdgef......
paIjOCUbB1

~M;Ia 45
~,6

FIGURE 17.12

FIGURE 17.13
angle.

-

FIGURE 17.14 Spaceship after changing the
construction history.

The drawbacks of construction history are

twofold. First, although you can edit the

attributes of actions performed at any point
along the history, you must avoid changing

attributes that alter the topology, or number
of polygons in the object. For example, in

the spaceship model created earlier, the
original Input node for the cube still exists

in the network. If you used it to change the
number of subdivisions in length, height,

and depth, you would see a drastic change
in the object's shape (see FIGURE 17.14).

As you can see, the shape has been changed

to an indistinguishable mass of polygons.
This happens because the number of poly

gons has changed, and new unaltered poly

gons have been added to the shape's

polygons, resulting in the changed polygons

moving to new positions. You must be care

ful, as changing the topology of highly com

plex models can cause Maya to crash.

The second drawback of construction his

tory is that each node of an object's history is

calculated separately and, therefore, requires

a lot of processing power. So the more oper

ations you have performed on an object, the
slower your computer is likely to run.

Eventually, this increase in construction his

tory can make your scene so dense that Maya
becomes unstable_ You can combat this

problem by deleting your object's construc
tion history periodically. Doing this takes all

nodes that are sending information to the

Shape node and records their information
permanently into the node. FIGURE 17.15

shows how greatly simplified the spaceship's

network from FIGURE 17.10 becomes

after history deletion.

!
~

I
l
i-
~

!
r
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The huge network of nodes is gone. This

means the computer runs faster, but you

can no longer edit attributes of the indi

vidual nodes because their results have

been permanently written to the Shape

node. Now that you have a general idea of

what's going on under Maya's hood, take a

look at Maya's user interface.

FIGURE 17.15 After history is deleted, the
spaceship's network shrinks.

Overview of the User Interface
The following sections introduce you to the Maya user interface (see FIGURE 17.16) and

cover the parts of the UI separately. As you read, it's a good idea to have your copy of Maya or

Maya Personal Learning Edition (PLE) open to help you refer to each component as it's being

discussed.

Status line Viewport Main menu bar Shell

17

Toolbox

Channel
box

Layout
Select

Layer
Time Editor
slider

RangeJi~~~~~~~~~~~~~~~~~~~;~~~~~slider
Common

line
Help line

FIGURE 17.16 The Maya user interface.
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'rhe Vlewports

The viewports are your windows into the three-dimensional world. They are very similar to the

viewports in Unreal: You have one three-dimensional viewport, called the Perspective view, and

three two-dimensional views known as the orthographic views (see FIGURE 17.17). The ortho

graphic views consist of the Front camera, which looks down the Z-axis, the Side camera, which

looks down the X-axis, and the Top camera, which looks down the Y-axis.

FIGURE 17.17 A four viewport layout.

Around one of the viewports (typically the Perspective when a new scene is opened) is a thick

blue bar to designate that the viewport is active. By default, some actions, such as playing anima

tion in the viewports, respond in real time only within the active viewport. Only one viewport

can be active at a time, but you can change which viewport is active by clicking another view

panel.

When you begin a new scene, you see only the Perspective viewport in full screen mode. You can

toggle any viewport by tapping the spacebar to minimize the Perspective viewport so that you can

also see the three orthographic views. You can use the same technique to expand viewports to full

screen. When doing this, Maya reads the location of the mouse and expands the viewport that

your cursor is over.

View Modes

The viewports have four separate view modes to adjust how you see your objects. The first mode,

Wireframe, is the default setting. It allows you to see the edges of a polygonal object. You can also

view objects with a smooth shaded surface or see how. they would look with textures or lighting

applied. TABLE 17.2 shows the hotkeys for each view mode.

593
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TABLE 17.2 View Mode Hotkeys

Mode

Wireframe

Smooth Shaded

Hotkey

4

5

Mode

Textured

Lighting

Hotkey

6

7

Textured and Lighting modes are useful only If you
have textures or lights created In your scene.

NOTE ~ ---------1
In TABLES 17.3 and 17.4, LMB stands for left
mouse button, RMB stands for right mouse button,
and MMB stands for middle mouse button.

Viewport Navigation

Now that you know the general areas of the

VI, you can see how to navigate the viewports.

There are three major ways to move the view

around while in the Perspective viewport:

rotate, pan, and doUy (see TABLE 17.3). Pan

and dolly are the navigation options for the

orthographic views (see TABLE 17.4).

i~NOTE
.,..

TABLE 17.3 Viewport Navigation for the Perspective View

17

Operation

Rotate

Pan

Dolly

Key Combination

Alt+LMB-drag

Alt+MMB-drag

Alt+RMB-drag or
Alt+LMB-drag and
MMB-drag

Description

This operation rotates the camera around its focus
in the direction defined by the mouse's movement.

This operation pans the camera (moves without
rotating) in the direction defined by the mouse's
movement.

This operation is similar to zooming except that
you move the camera instead of adjusting its
focal length.

TABLE 17.4 Viewport Navigation for the Orthographic Views

Operation

Pan

Dolly

Key Combination

Alt+MMB-drag

AIt+RMB-drag or
AIt+LMB and MMB-drag

Description

This operation pans the camera (moves without
rotating~ in the direction defined by the mouse's
movement.

This operation is similar to zooming except that
you physically move the camera instead of
adjusting its focal length.

Practicing these navigation skilJs is highly recommended, until you become as accustomed to

them as you are the UnrealEd navigation methods.

---------- -- - - --_.-
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Camera Focus

When using the Perspective view, notice that the camera rotates around a specific point in space.

This is called the camera's focus. You can center this focus on a selected object by pressing the F

key or average it between aU objects in the scene with the A key.

'rhe Main Menu Bar and Menu Sets

Maya's main menu bar, shown in FIGURE 17.18, is located across the top of the window. This

menu bar gives you access to nearly all the tools and commands needed to use the program.

Certain commands are found in menus pertaining to those commands' functions. For example,

you find the Create Polygon Tool command in the Polygons menu.

-

NOTE
The Rle, Edit, Modify, Create, Display. Window, and Help
menus are always visible, regardless of your current menu set.

"-------

FIGURE 17.18 The Modeling menu set.

Maya has hundreds of commands, which are spread across nearly 30 separate menus. However,

nowhere near this many menus are visible at the top of the screen because the menus have been orga

nized into menu sets. These menu sets enable you to see only the menus you need and hide those that

aren't needed for the task you're perform

ing. Moreover, unless you're viewing at a

very high resolution, you wouldn't be able

to fit all the available menus on your screen.

You can switch between these menu sets by using two methods, which is typical of Maya's work

flow: Usually several methods are available for performing a task. The two most common meth

ods for switching between menu sets are using the Menu Set drop-down list or the hotkeys. The

Menu Set drop-down list shown in FIGURE 17.19 is located just beneath the main menu bar in

the Status Line (discussed in "The Status Line" later in this chapter).

FIGURE 17.19 The Menu Set drop-down list is set to Animation.

-----.------
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The second method for changing menu sets is using hotkeys. TABLE 17.5 lists the available

menu sets, their associated hotkeys, and the menus items in each menu set.

TABLE 17.5 Menu Set Hotkeys

Menu Set

Animation

Modeling

Dynamics

Rendering

Hotkey

F2

F3

F4

F5

Menu Items

Animate, Deform, Skeleton, Skin, Constrain, Character

Eait Curves. Surfaces, Edit NURBS, Polygons, Edit
Polygons, Subdiv Surfaces

Particles, Fluid Effects*, Fields, Soft/Rigid Bodies, Effects,
Solvers

Lighting/Shading, Texturing, Render, Paint Effects, Fur*

*These menus are available only in Maya Unlimited. not in Maya PLE.

Tear-Off Menus

One of the handiest features of the menu system in Maya is the ability to tear menus off and leave

them floating in your window. In TUTORIAL 17.1, you see how to do this.

TUTORIAL 17.1: Using Tear-Off Menus

-, 1. Start Maya if it's not already running.

'I

2. From the main menu, click File.

3. In the menu that drops down, click the two
horizontal bars running across the top,
just above New Scene. This step tears the
menu off, making it a floating window.

4. Notice that the menu has turned into a
n~w floating window (see FIGURE
17.20). You can click any command in
this tear-off menu as many times as you'
like, and it doesn't close until you use the
close button in the upper-right corner. You
can use this technique on any menu in
Maya, even those in the viewport menus.
You can move this floating window around
the screen by dragging its title bar.

END TUTORIAL 17.1

,.:I
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FIGURE 17.20 The floating File menu.
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The Status I.ine

The Status Line shown in FIGURE 17.21 is located directly beneath the main menu bar. It con

tains a variety of commands for scene management and enables you to swap between different

modes in Maya. TABLE 17.6 describes the components of the Status Line.

I.. -
FIGURE 17.21

TABLE 17.6

Name

Menu Set
drop-down list

File buttons

Selection Mask
drop-down list

Selection Mode

Selection Masks
(Hierarchy, Object,
and Component)

Snapping buttons

Construction
History options

Rendering options

Input box

Sidebar buttons

The Status line.

Components of the Status Line

Description

You can use this drop-down list box to change between the different
menu sets, as described previously.

You can use these three buttons to start a new scene, open a saved
scene, or save your current scene.

You can use this drop-down list to control what types of objects are
selectable in your scene. Clicking the small black triangle opens a list
box for choosing selectable objects.

Here you can switch between Hierarchy. Object, and Component modes.

You can use this area to determine which objects or components are
selectable in the viewport. It can appear in three different ways,
depending on which selection mode you have chosen.

You can use these buttons to snap objects to the grid, to curves, to
points, or to view planes or to make a selected object live.

You can use this area to access all input or output connections of an
object or to switch off construction history.

You can use these buttons to render the current frame, open an
Interactive Photorealistic Renderer (IPR) render, or access the Render
Global Settings dialog box.

You can use this multifunction window to select objects by name,
rename multiple selected objects, and edit numeric values in absolute
or relative modes.

These buttons switch your sidebar between the Attribute Editor, the Tool
Options, and the Channel Box.
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You can expand or collapse the sections of the Status Line to make more room. At the beginning

of each section is a small black bar. If the shape in the middle of it is rectangular, the section is

expanded. If the central shape is triangular, the area has been collapsed:

Expanded area

Collapsed area

The Shelf

The Shelf shown in FIGURE 17.22 is the horizontal area just under the Status Line. You can use

the Shelf to perform common Maya functions with a single click, instead of having to dig through

menus or navigate deep into other parts of the UI. Best of all, you can even create your own

Shelves.

IlL I ...

~I

FIGURE 17.23
The Shelf selector.

17

FIGURE 17.22 The Shelf for polygons.

By default, the Shelf displays an array of tabs across the top, which give you quick access to the

different available shelves.

Creating Your Own Shelves

If you like, you can even build your own Shelf to include the tools you use most. You can also add

and remove items from existing Shelves. In TUTORIAL 17.2, you see how to create and edit

Shelves,

TUTORIAL 17.2: Creating and Editing Shelves

1. Start Maya, if you haven't already.

2. To the left of the Shelf area is a small white square with a
black triangle underneath (see FIGURE 17.23).

The gray tab is a Shelf selector, which is practical only if you
have hidden your Shelf tabs, which can be done from the list
that opens when you click the black triangle below this tab.

3. Click the black triangle. From the list that opens, select New Shelf.

4. The Create New Shelf dialog box opens, where you can enter the name for your new Shelf.
Enter myShelf, and click OK.

5. You now see your new Shelf at the far right of the available shelf tabs. Click the new tab
shown in FIGURE 17.24.

-- --- ------
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FIGURE 17.24 The myShelf tab.

6. The shelf is currently empty, so you need to add some commands to it. Hold down the
Ctrl+Shift keys, and choose Create> Polygon Primitives> Cube. Instead of a cube being
created in the viewports, a new icon. appears in your Shelf.

7. You can also remove items from your
Shelf. MMB-drag your new cube icon to
the small trashcan icon IitI on the
Shelf's upper-right corner.

END TUTORIAL 17.2

The Channel Box and Layer Editor

CAUTION
In step 6, be sure not to click the options box icon [Q].
Clicking it opens the Polygon Cube Options dialog box.

If you're not sure what a specific Shelf button does,
hold your mouse cursor over it, and a tooltlp Is dis
played to let you know.

.",-,

The Channel Box, shown in FIGURE 17.25,

is an easy way to access your object's
attributes and place animation keyframes

(discussed in Chapter 23, "Character
Animation"). To be technical, the Channel

Box displays the object attributes that can be

animated, so everything you see in the Channel Box

can be animated. By default, this includes the object's
location in three-dimensional space, its rotation on

all three axes, and its scale. You can also set the
object's visibility and see a list of an object's

construction history.

Just above the Channel Box, you see three buttons for
controlling whether the Channel Box, the Layer

Editor, or both are visible (see FIGURE 17.26). By

default, both are displayed.

Channel Sliders

The Channel Box doesn't show any visible sliders or

any other way to change values besides typing in

numbers manually. This is because the Channel Box
uses an invisible slider system called channel sliders.

TUTORIAL 17.3 introduces you to these tools and

shows you how to control their behavior.

IChln'IOI< Olllecf
~
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FIGURE 17.25 The Channel Box
for a newly created cube,

FIGURE 17.26 Channel Box and
Layer Editor controls.
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TUTORIAL 17.3: Using Channel Sliders

1. From the Maya main menu, choose_~reate > Polygon Primitives> Cube to create a polygon
cube in the center of the viewport..

2. In the Channel Box, click Translate X. \1
3. Place your mouse cursor on the viewport, C!)1d MMB-drag to the left and right. Notice that

the cube moves back and forth in the X-axis with your mouse motions.

END TUTORIAL 17.3

You can also control the slider's speed and configure whether it works at all. The three buttons

above and to the right of the Channel Box control the modes and behavior of the channel slid

ers. TABLE 17.7 describes them.

TABLE 17.7 Channel Slider Controls

17

Button

Channel slider!
manipulator switch

Channel slider speed

Channel slider setting

The Layer Editor

Image Description

You use this button to switch between
using manipulators and channel sliders,
channel sliders only, or neither.

You use this button to adjust the speed of
channel sliders to fast, medium, or slow.

You use this button to adjust between lin
ear and hyperbolic slider motion. You can't
use this button unless you've chosen to
use channel sliders only.

,----

At the lower-right area of the Maya interface is

the Layer Editor (see FIGURE 17.27), which is

used to separate objects in your scene into laye~s.

Layers are a great way to organize complex scenes

or hide geometry that's obstructing your work.

One layer can have several objects in it, but each

object can be in only one layer at a time.

In TUTORIAL 17.4, you see how to create a

layer, how to add objects to it, how to adjust the FIGURE 17.27 The Layer Editor.
layer's visibility, and how to remove the layer.
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TUTORIAL 17.4: Using Layers

1. Click the New Scene button ~ in the Status Line. If prompted to save, click No.

2. Click the Polygons Shelf tab. In the Polygons Shelf, click the Cube button
cube in your scene.

3. In the Layer Editor, click the New Layer button ~. A new layer named layerl is displayed
(see FIGURE 17.28).

4. Double-click this new layer in the
Layer Editor to open the Edit Layer
dialog box (see FIGURE 17.29).
Change the name to myLayer, and
set the color to red. Click Save
when finished.

5. Next, you'll add the cube to the
layer. The cube should already be
selected in your viewport and high
lighted green. If not, click it. Next,
right-click the layer in the Layer
Editor and choose Add Selected
Objects from the context menu.

The cube is then added to the layer.
You can verify this by looking at the
Channel Box. Under the Inputs sec
tion, you should see myLayer (see
FIGURE 17.30).

If you deselect the cube by clicking
in an open area of the viewport,
notice that the cube's wireframe
turns red.

6. In the Layer Editor, the small V to
the left of the layer (see FIGURE
17.31) is a toggle for controlling
the layer's visibility and the objects
within it. Click the V. and notice the
cube vanish.

7. To delete the layer, right-click on it in
the Layer Editor and choose Delete
from the context menu. The layer is
now gone, and the object returns in
its original navy blue color.

END TUTORIAL 17.4

---_.... - -- -.. ----- - -_.- -

FIGURE 17.28 Layerl is found at the top of the
Layer Editor.

FIGURE 17.29 The Edit Layer dialog box.

FIGURE 17.30 There are now two items in the
Inputs section.

FIGURE 17.31 When the V is visible, objects in
th~ layer are also visible.

NOTE
The box next to the Visibility toggle is used to select

Template or Reference layers for your object. These

options enable you to see your object, but not select it.
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.,- ..,TIP , -
Beneath the Layer Ed itor are two buttons for con-
trolling the width of the sidebar containing the
Channel Box and the Layer Editor.

The Attribute Editor shown in FIGURE 17.32

gives you access to all an object's attributes,

whether they can be animated or not. The

Attribute Editor shows all properties available

on each node connected to an object.

'rhe Attribute Editor

At the top of the window is a menu that

includes commands to help you sort through

attributes, add or remove attributes, or get help

on specific attributes. Below the menu are tabs

representing the nodes that make up your

object.

~~o:ror-

~~ '.~:.
QIm

1.~.

Ltt~ )~ QIm

Below these tabs is an area where you can

rename the currently selected object, and

under that is the list of available attributes

for the current object. You can expand or col

lapse these areas for more room and use the

scrollbar on the right to navigate through

the list.

In TUTORIAL 17.5, you use the Attribute

Editor to adjust the width of a cube.

FIGURE 17.32 Attribute Editor for a cube.

TUTORIAL 17.5: Using the Attribute Editor

1. Using the skills you have learned so far, start a new scene and create a cube.

2. With the cube selected, press Ctrl+A to open the Attribute Editor, shown in
FIGURE 17 .33.

3. Click the polyCubel tab to access the attributes of the cube's Transform node.

4. In the Poly Cube History area, you see the Width attribute, which has a numerical entry
field as well as a slider (see FIGURE 17.34). Adjust the slider, and notice the cube's

width change, as shown in FIGURE 17.35.
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FIGURE 17.33 The Attribute Editor
open to the pCubeShapel tab.

END TUTORIAL 17.5

FIGURE 17.34
The Width attribute.

FIGURE 17.35 The
width changes on the cube.

The Attribute Editor gives you another way to access an object's attributes. However, you must

remember that the Attribute Editor displays all attributes of an object, whether they can be ani

mated or not.

The Time and Range Sliders

Near the bottom of the Maya interface, you see the Time Slider and Range Slider. which are used

to control your animation timeline. The following sections give you an overview of these con

trols, but their use is discussed in depth later in Chapter 23.

Time Slider

You can use the Time Slider, shown in FIGURE 17.36, to switch between different frames. or

moments in time, of your animation. You can think of it as a ruler that shows all the frames in

the current time range. You can click anywhere on the Time Slider to jump immediately to that

frame. You can also drag right or left to sample your animation forward or backward. This drag

ging is called scrubbing the timeline. A thick black line displayed on the Time Slider wherever you

click is called the Current Time Indicator. As its name implies, it indicates the current frame.
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At the end of the timeline is the Current Time Field, where you can type a specific frame into the

timeline, instead of clicking on or dragging to a specific frame. This field can be extremely useful

when you have thousands of frames visible in the Time Slider.

Current time field

4
I

6 B
I .I

Time slider

22 IZA 26 28
I

:Ill noo

FIGURE 17.36 The Time Slider.

Transport Controls

To the right of the Time Slider are the Transport controls, similar to the controls on a VCR or

DVD player (see FIGURE 17.37). You can use them to play your animation forward or back

ward, to jump forward or back by frames or keyframes, and to rewind or fast-forward to the

beginning or end of the animation. FIGURE 17.37 shows the Transport controls' functions.

Play backward

17

Jump to beginning of range

Jump back one keyframe

Play forward

FIGURE 17.37 The Transport controls.

Jump forward one keyframe

Jump to end of range

Jump forward one frame

Range Slider

The Range Slider is used to control the length of your animation and the visible range of the time

line (see FIGURE 17.38). The entry fields on the outside of the Range Slider are used to deter

mine the animation's total time, and the numbers inside control the visible range on the Time

Slider. Between these entry fields is a slider for changing the visible range or moving the range

back and forth along the total timeline. You can use this slider to "focus" the Time Slider on a cer

tain area of your animation for tweaking purposes.

To the right of the Range Slider, you have access to Maya's character sets and two buttons. From

left to right, they are the Auto Keyframe button and the Preferences button (which opens the

Preferences dialog box). Much of the functionality in this area is discussed in detail in Chapter 22,

"Importing Characters into UnrealEd:'

l~ __ .

FIGURE 17.38 The Range Slider.
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The Toolbox and Layout Selection

Move

Scale

Lasso

Select

Rotate

FIGURE 17.39 The Toolbox.

FIGURE 17.40 The Layout Selection options.

Show Manipulator

The Show Manipulator tool displays the
manipulator for many of the nodes In an

object's construction history.

On the left side of the Maya window are

the Toolbox and the Layout Selection
options (see FIGURE 17.39). The

Toolbox at the top is where you access the
manipulation tools, such as Move, Rotate,

and Scale. You can click any of these icons

to use the corresponding tool.

You can use the Layout Selection options
to quickly switch between different layouts

for your viewports (see FIGURE 17.40).

Some layouts include different tools, such

as the Outliner, which lists alJ objects in
your scene, the Curve Editor, which

enables you to tweak your animation, the

Hypergraph, used to view network con
nections, and the Hypershade, for working

with materials.

NOTE

If you have pressed the spacebar for any

amount of time while using Maya, you

might have already seen the Hotbox. The

Hotbox is a large hidden menu that

appears only when the spacebar is held
down (see FIGURE 17.41). The top bar

includes all the constant menus that are
available regardJess of menu set, and the

bar just below includes the menus avail

able in each viewport.

Along the bottom are the many menus
available in the different menu sets. With

the Hotbox, you can access any menu in FIGURE 17.41 The Hotbox.

'rhe Hotbox

~
I

~

l

l

l

----- ---------~---------.---------- -----
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Maya without needing to switch menu sets. They are visible even if you have chosen to hide all

menus.

The Hypershade
The Hypershade is Maya's powerful system for creating and applying materials and shader net

works. This section gives you an overview of how to create and apply a simple material to an

object by using the Hypershade. You work with the Hypershade in more depth in Chapter 19,

"The Art of Texturing in Maya." In TUTORIAL 17.6, you create your first material using the

Hypershade.

TUTORIAL 17.6: Creating a Basic Material and Texture

17

1. Using the skills you have learned so
far, start a new scene and create a
polygon sphere (see FIGURE
17.42).

2. Open the Hypershade from the main
menu by selecting Window>
Rendering Editors> Hypershade.
(This might take a moment on some
computers.) The Hypershade window
is composed of three major areas
(see FIGURE 17.43):

~ Tab area-This area can
display a variety of things,
depending on which tab you
have selected. By default, it
shows the materials you have
created.

FIGURE 17.42 A wireframe sphere in the
viewport.

~ Work Area-You use this area to create your material's shader networks. You can
have several different networks in this area, if needed.

~ Create Bar-Typically, you use this area to get new components for your shader
network.

3. In the Create Bar, click the Blinn icon to create a new Blinn material. The new node for
this material, called blinn!, is displayed in the tab area and the Work Area (see
FIGURE 17.44).

-_. ----- -----
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Tab area

,~.

Create bar Work area

FIGURE 17.43 The Hypershade window.

l

4. Double-click the new Blinn node (in
either area) to open the Attribute
Editor (see Figure 17.45).

5. Next to the Color entry, click the
small button with a checkered
pattern to open the Create
New Render Node dialog box
(see FIGURE 17.46).

FIGURE 17.44 Anew Blinn material.
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FIGURE 17.45 Attributes for the Blinn
material.

FIGURE 17.46 The Create Render Node
dialog box.

17

6. Click the Checker button to create a new checker node, which is connected to the Blinn
material's Color attribute. You see the material become covered with a checker texture.
Also, you can see both nodes in the Work Area as well as how they are connected (see
FIGURE 17 .47).

FIGURE 17.47 The nodes that make a checker material.

7. Move the Hypershade window so that you can also see the sphere in the viewport, and
MMB-drag the blinnl node onto the sphere.
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NOTE
If you're viewing the sphere In Wireframe
mode, you need to release the mouse button
while your cursor is over one of the wires.

8. Press 5 to enter Smooth Shaded
view, and then press 6 to enter
Textured view. You can see the
result of the texture on the surface
(see FIGURE 17.48).

~
You can navigate the Hypershade window Just
as you do the orthographic vlewports. You can
pan with Alt+MMB and zoom with Alt+RMB.

l

FIGURE 17.48 Sphere with the new checker
material.

END TUTORIAL 17.6

The Hypergraph
The Hypergraph enables you to see your scene's nodes and the connections between them. You

can open it by choosing Window> Hypergraph from the main menu. In TUTORIAL 17.7, you

take a look at how to use the Hypergraph.

TUTORIAL 17.7: Introduction to the Hypergraph

1. Start a new scene, and create
a polygonal sphere (see
FIGURE 17.49).

2. From the main menu, choose
Window> Hypergraph to open
the Hypergraph window (see
FIGURE 17.50).

3. The Hypergraph can be displayed in
two different modes: Scene
Hierarchy and Dependency Graph.
By default, you see the Scene
Hierarchy mode, which shows all the
objects in your scene as single

nodes. FIGU RE 17.49 Sphere in viewport.
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4. Select the polygonal object's node, if
it isn't selected already (see
FIGURE 17.51). Selected nodes
are displayed as yellow.

5. Click the Input and Output
Connections icon ~ on the toolbar
at the top to switch the window to
the Dependency Graph mode (see
FIGURE 17.52), which enables
you to see the nodes that connect
to form your object (as discussed
at the beginning of the chapter).
The more you use Maya, the more
you'll find yourself using the
Hypergraph to analyze and edit the
connections between your scene's
nodes.

FIGURE 17.50 The Hypergraph window.

FIGURE 17.51 The polygon sphere node in the
Hypergraph window.

17
FIGURE 17.52 Dependency Graph mode shows the nodes needed when making a polygonal
sphere.

END TUTORIAL 17.7

Object Manipulation
When working with objects in Maya, there are two w~ys to manipulate them: manipulating the

object as a whole (Object mode) and manipulating the components that make up that object

(Component mode). For polygons, "components" refers to the object's vertices, edges, and faces.

The following sections discuss both methods and how to access them.
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Object Mode

In Object mode, you're manipulating the entire object. You can move it, rotate it, and scale it, all

while manipulating the object as a whole. You can do this with the Channel Box and the Attribute

Editor, as mentioned earlier, or with Maya's set of transform tools. These tools have a manipula

tor that's visible in the viewport, allowing you to interactively adjust your objects' position, rota
tion, or scale. You can access these tools with the Toolbox, as mentioned earlier, or with hotkeys.

In TUTORIALS 17.8 through 17.10, you see how to use these tools to manipulate an object in

the viewport.

TUTORIAL 17.8: Moving Objects in Maya

1. Using the skills you have learned so r;!""=~~:;::;e;:::===============1
far, start a new scene and create a
polygon cube (see FIGURE 17.53).

Color Corresponding Axis

Red X-axis

2. Select the cube, if it isn't already,
and click the Move Tool icon. in
the Toolbox or press the W key.
Make sure the Caps Lock key is not
on, as Maya's hotkeys are case
sensitive.

3. Notice the new manipulator that
appears in the middle of the cube
(see FIGURE 17.54). The Move
manipulator (also called the
Translate manipulator) can be used
to move the object around in 3D
space without having to adjust any
attribute numbers. Do this now by
dragging on any of the arrows.

The manipulator's arrows are color
coded to correspond with three
dimensional axes. The code works
as follows:

--
FIGURE 17.53 The polygon cube.

Y-axisGreen

I

l

l
I
I

Blue Z-axis

You can remember this code with
the simple equation RGB =XYZ.

FIGURE 17.54 Cube showing the Move
manipulator.
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4. As you drag an arrow, you move the
cube in the direction of the related
axis. You can move in all three axes
by dragging the yellow square in the
center of the manipulator. Try this now.

You can expand and shrink any manipulator
with the + and - keys.

5. You can also move on two axes at a
time or in a plane-like fashion in the
Perspective viewport. You can can
cel out motion on any axis by
Ctrl+c1icking the axis you want to
cancel. Try this now by Ctrl-elicking
on the X-axis (red). FIGURE 17.55
shows the result.

NOTE
Moving in all three axes actually moves the
cube on a plane perpendicular to the camera.

Notice that the yellow square is now
parallel to the YZ plane, which
means that when you move the
object by using the square, you
move on only the Y and Z axes. Try
this now.

FIGURE 17.55 Center of the Move manipulator
after canceling out the X·axis motion.

J.

FIGURE 17.56 Manipulator back to normal.

6. To put the manipulator back to its normal state, Ctrl-elick on the yellow square. This
makes the manipulator face the camera again (see FIGURE 17.58), so you'll be moving
on all three axes, on a plane perpendicular to the camera.

END TUTORIAL 17.8
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TUTORIAL 17.9: Rotating Objects in Maya

FIGURE 17.57 The farther you rotate, the larger
the wedge.

FIGURE 17.58 Rotating with the yellow ring.

2. With the cube selected, click the
Rotate Tool icon in the Toolbox
or press the E key.

3. You'll see a new manipulator that
looks like three orthogonal rings
with a fourth yellow ring surround
ing it. The Rotate manipulator uses
the same color-coding system as
the Move manipulator, with red
being the X-axis, green the Y-axis,
and blue the Z-axis. Try dragging on
any of the rings. A small pie-wedge
indicator appears to show you
how far you have rotated (see
FIGURE 17.57).

4. The yellow ring that surrounds the
entire manipulator enables you to
rotate perpendicularly to the camera
(see FIGURE 17.58). Try this now.

1. Continue from TUTORIAL 17.8, or
start a new scene and create a
cube.

5. You can also rotate freely on all
three axes by clicking anywhere
between the red, green, and blue
axes (see FIGURE 17.59).

l

I

I

r
r

FIGURE 17.59 No wedge appears when rotating
freely.

END TUTORIAL 17.9

---------~~------~~---
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TUTORIAL 17.10: Scaling Objects in Maya

17

1. Continue from TUTORIAL 17.9, or
start a new scene and create a
cube.

2. With the cube selected, click the
Scale Tool icon • in the Toolbox or
press the R key.

3. The Scale manipulator that appears
is composed of four cubes: three
colored for the main axes and a
fourth yellow cube in the center (see
FIGURE 17.60).

4. Click the red cube, and drag it
toward the object. Note that it
scales the cube in the X-axis (see
FIGURE 17.61).

5. You can also scale uniformly on all
three axes by dragging the yellow
cube in the center of the manipula
tor (see FIGURE 17.62). Try this
now.

END TUTORIAL 17.10

FIGURE 17.60 Cube showing the Scale
manipulator.

FIGURE 17.61 The other axes disappear
when you're scaling in only one.

FIGURE 17.62 All the axes are visible when
scaling uniformly.

Now that you've seen how you can manipulate at the object level, you can take a look at component

manipulation. But first. review the hotkeys for manipulating objects:

Tool

Select

Move

Hotkey

q

w

Tool

Rotate

Scale

Hotkey

e

All the hotkeys are listed in lowercase. If you have the Caps Lock key on when using hotkeys, you

get different results.
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Component Mode

Each object in Maya, polygonal or otherwise, is constructed of components. As mentioned ear

lier, polygons are composed of vertices, edges, and faces. After selecting a component, you can

perform a wide variety of actions on it, including moving, rotating, or scaling. There are three

main ways to switch between Object and Component mode. TUTORIALS 17.11 and 17.12

introduce you to aU three methods: using the Status Line, using hotkeys, and using marking

menus.

TUTORIAL 17.11: Using the Status Line

FIGURE 17.64 Polygon sphere in Component
mode.

FIGURE 17.65 The selected vertices are yellow.

3. With the vertices visible, LMB-drag
a marquee selection around several
of the vertices or click the vertices
individually. Notice that the
selected vertices become yellow
(see FIGURE 17.65). Make a few
selections to get a feel for select
ing vertices.

4. To select edges, you can click the
Select by Component Type: Lines
selection mask button ~ in the
Status Line. The purple spots on
the surface disappear (see
FIGURE 17.66), and you can
select edges by drawing a marquee

2. To make vertices selectable, you
must be in Component mode. To
enter Component mode, click the
Select by Component Type icon ~
in the Status Line, near the top of FIGURE 17.63 Polygon sphere in the Viewport.

the screen. You should see small
purple points appear across the
sphere's surface (see FIGURE

17.64). If you don't, make sure the
Select by Component Type: Points
selection mask button [!] is acti
vated in the Status Line.

1. Using the skills you have learned
so far, start a new scene and
create a polygon sphere (see
FIGURE 17.63).
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FIGURE 17.66 Each line is one edge.

-

~

or clicking on individual edges.
Notice that selected edges are
orange.

To select faces, click the Select by
Component Type: Faces button ~,

also in the Status Line. A blue dot
appears in the center of each face,
which is a handle you can use to
select specific faces (see FIGURE
17.67). You can select faces by
clicking on them or drawing a mar
quee selection over them. Selected

faces turn orange.

5. When finished, you can switch back
to Object mode by clicking the
Select by Object Type icon ~.

In TUTORIAL 17.12, you learn the other

two methods of accessing components.

END TUTORIAL 17.11

FIGURE 17.67
face.

Each blue dot represents one

17

TUTORIAL 17.12: Hotkeys and Marking Menus for Selection

1. Begin by selecting the sphere you created in TUTORIAL 17.11 and pressing the F9 key
to make vertices selectable. When finished, press the F8 key to toggle back to Object
mode.

2. Now press the FiO key to make edges selectable, just as when using the Status Line.
Press F8 when finished.

3. Press Fl1 and notice that the object's faces are now visible. Press F8 again when
finished. For your reference, these are the selection hotkeys:

Hotkey

F8

F9

FlO

Fl1

Function

Toggles between Object and Component mode

Makes vertices selectable

Makes edges selectable

Makes faces selectable
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4. Now hold down the RMB while the cursor is on your object to display a floating marking
menu. Surrounding the center of the marking menu are the names of all the components
(see FIGURE 17.68).

5. While still holding the RMB, move the cursor over Vertex (see FIGURE 17.69), and
release the mouse button.

FIGURE 17.68 The marking menu.

Vertices are now selectable. as
shown in FIGURE 17.70. You can
use this method to make any of an
object's components selectable.

6. When finished, hold down the RMB
over the object to make the marking
menu appear and choose Object
Mode to go back to Object mode.

END TUTORIAL 17.12

FIGURE 17.69 A line follows your
cursor when using the marking menu.

FIGURE 17.70 The sphere's vertices are now
selectable.

Now that you have seen the three methods for accessing an object's components, you can learn

more about selecting them. You can make multiple selections in Maya, such as selecting several

sets of components simultaneously, by using hotkeys. In TUTORIAL 17.13, you see how to use

hotkeys for selection.
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TUTORIAL 17.13: Making Selections

1. You'll be using the sphere you cre
ated in TUTORIAL 17.12. Begin by
switching to Component mode and
making vertices selectable. Review
the previous tutorial, if necessary.

2. Tap the spacebar to open the Four
View layout. Tap the spacebar again
over the Side view to make it full
screen (see FIGURE 17.71).

3. Draw a marquee selection box over
the vertices of the sphere's upper
half, as in FIGURE 17.72.

4. Hold down the Shift key, and draw
another selection box around the
entire sphere (see FIGURE 17.73).

Notice that the selection was
inverted; the selected vertices were
deselected, and the unselected ver
tices became selected. Holding
down the Shift key inverts the
selection status of any object or
component.

5. Hold down the Ctrl key, and draw a
selection box around the right half of
the sphere (see FIGURE 17.74).

Notice that the selected vertices
become deselected, and the unse
lected vertices remain unselected.
Holding down the Ctrl key subtracts
from your current selection, not
adds to it.

6. Hold down the Ctrl and Shift keys
together, and draw a selection over
the left half of the sphere (see
FIGURE 17.75).

FIGURE 17.71 Side view of the sphere.

FIGURE 17.72 The top half of the sphere's
vertices are selected.

FIGURE 17.73 The bottom half of the sphere's
vertices are selected.

FIGURE 17.74 The bottom left half of the
sphere's vertices are selected.
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~.
! Notice that the selected vertices at

the bottom remain selected, and the
unselected vertices at the top
become selected. The Shift+Ctrl
keys only add to your selection.

,'.
I,,

FIGURE 17.75 The left half of the sphere's
vertices are selected.

END TUTORIAL 17.13

The three selection methods are valuable tools for making complex selections in your scenes.

Keep in mind that all three work in Object mode as well as Component mode, so you can use

them to select multiple objects onscreen. This list summarizes the selection hotkeys:

Hotkey(s)

Shift

Ctrl

Ctrl+Shift

Summary

Method

Invert selection

Subtractive selection (deselect)

Additive selection

Throughout this chapter, yOll have learned several fundamentals behind using Maya, from its

node-based architecture to its user interface. You have also practiced several methods of object

manipulation, including how to access components of your polygonal objects. By now, you

should have a general familiarity with Maya's interface and understand how to create polygonal

primitive objects. You should also have a basic understanding of how Maya's node-based archi

tecture is used in the formation of construction history and how history can both help and harm

you.

In the next chapter, you build in this knowledge by learning how to use the tools for polygonal

modeling and begin constructing your own creations for placement in Unreal.





NOTE
This chapter assumes that you have a
reasonable understanding of naviga
tion in Maya, especially using the
menu and viewports. If you don't have
a solid grasp of these topics, please
refer back to Chapter 17.

Chapter

Polygonal Modeling
Tools

This chapter discusses a variety of polygonal modeling tools avail

able in Alias Maya 5. Chapter 17, "Overview of Maya," explained the

difference between Object and Component modes in Maya as weU

as what you can do with an object's components. In this chapter,

you'll move on to learn about many of the tools you need to con

struct your Unreal models in Maya. Please note, however, that not

every available modeling tool is covered. Instead, this chapter con

centrates on a wide variety of tools you'll likely use when creating

low-polygon game content for Unreal.

Practicing with the tools and commands covered in this chapter to

get the hang of how they are used is a good idea. The better you

understand how each tool works, the more you'll be able to use a

variety of tools illstead of

restricting yourself to merely

a few. This can dramatical1y

speed up your workflow and

decrease your turnaround

time for model completion.
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Modeling Terminology
This section provides a list of common terms used in modeling that can be confusing to begin

ning modelers. These terms are used throughout this chapter, so getting familiar with them is a

good idea:

~ Polygon-Defined as a many-sided shape, a polygon is the basic unit of game modeling. A

model is constructed by using many polygons. In game models, polygons are usually

three-sided (triangular).

~ Triangles-Three-sided polygons. All game models, including ones designed for Unreal,

are constructed as a series of triangles. Triangles are used because, logically, they are the

only surface that always exists on a single plane. Nonplanar faces are difficult for many

programs (even some 3D applications) to calculate, so games engines don't support them.

Triangular faces are often called tris, pronounced as "tries."

~ Quads-Four-sided polygons are often called quads. When modeling, constructing your

object primarily with quads is a good idea, and then you can simply run a Triangulate

operation to convert the quads into triangles.

~ Vertex, vertices-Vertices are one of the three key elements of a polygon. They are the

points that form the model's shape. You can think of them as the dots in a massive 3D

connect-the-dots game. These points are connected to form your final model.

~ Edge-If vertices are the dots in a connect-the-dots game, edges are the lines connecting

those dots. To be more technical, an edge is a line that connects two (and only two)

vertices.

~ Face-A face is the surface created across a series of vertices and edges, allowing you to

see your model. In some programs, a face is always a triangle, and a polygon can be com

posed internally of many faces. This means a four-sided polygon is actually composed of

two faces. In Maya, the term face and polygon are interchangeable.

~ Primitive-A primitive object is a prefabricated 3D shape. In Maya, primitives consist of

spheres, cubes, cylinders, cones, planes, and tori. You can often create complex models by

building from a primitive object.

~ Extrude, extrusion-An extrusion is essehtially an extension of a single face or a selection

of faces. For example, you can select a single face and extrude it from the model, which

effectively moves the face away from the model while creating new faces that stretch from

the extruded face back to the edges of that face's original position. For more information,

please see the "Extrusions" section later in this chapter.

~ Split-The term splitting usually refers to adding an edge to your model, such as with the

Split Polygon Tool, which is covered later in "Splitting Polygons." It also refers to the

action of dividing a single vertex into multiple vertices. Because of this dual definition,

splits that create new edges are casually referred to as cuts.



Modeling Terminology 623

FIGURE 18.2 A sphere
with hard edges.

FIGURE 18.1 A sphere
with soft edges.

'\

~ Cut-The addition of an edge to a model. Many tools in Maya can perform this

operation.

~ Merge-Merging in Maya is the conversion of two or more components into a single

component, such as combining two vertices into a single vertex. You can use this tech
nique to remove excess detail from your model or to "stitch" two separate models

together into a single seamless model.

~ BackJaces-Backfaces are the back (or negative) side of a polygon. In Maya, Unreal, and

all other 3D programs, a polygon has a front and back side. By default, Maya shows

polygonal backfaces in the viewport, although you can adjust the display settings so that

they don't. In Unreal, backfaces aren't rendered at all.

~ Surface normals-A surface normal is a line that

designates the front of a polygon. You can use surface

normals to verify that the positive side of your polygons

are pointed outward. If they aren't, your model won't

render in Unreal.

~ Vertex normals-Unlike surface normals, which define a

polygon's positive and negative sides, vertex normals

control the shading across a model from one polygon
to the other. They can be used to create hard and soft

edges.

~ Hard and soft edges-Using vertex normals, you can

control how the surface of your model appears to be
shaded when rendered in Unreal. The faces on each side

of a soft edge appear to be blended together with no
seam. The faces on each side of a hard edge appear to

have a crease between them. The Unreal Engine reads
hard and soft edges to create creases between certain

areas of your model. In FIGURE 18.1, you can see a
constant smooth sphere with softened edges, which

appears to be only a single surface. FIGU~E 18.2

shows the same sphere with all its edges hardened.

Modeling Methods
There are many different ways to model an object in Maya. The following sections describe two

major methods for polygonal modeling: box modeling and polygon creation.

/----.

~-----~-~.------------------------ --------------- -------_.





B. In FIGURE 18.7, new polygons have been

appended to the original and branch outward. Each

time you create a new polygon, you adjust vertices

to shape the model as you work.

c. In FIGURE 18.8, you can see the model taking

shape, one polygon at a time.

D. The finished model, with the same result as in the

previous example, is shown in FIGURE 18.9.

Understanding the Tool Options
and Display Settings in Maya
This section covers some of the important settings and dis
play modes you need when modeling in Maya. While you

work, typically you switch these settings on and off repeat
edly, so practicing until you're accustomed to their use is a

good idea. To begin, the Polygons> Tool Options menu
item contains two important options: Keep New Faces

Planar and Keep Faces Together.

The Keep New Faces Planar option is used primarily with

the Create Polygon tool and Append to Polygon tool.
When this option is enabled, new polygons are forced to be

planar-that is, to have all their vertices exist on the same
plane-when they are created. If you try to create a

nonplanar face with this option selected, you see an error
message.

Modeling Methods
- -, -~~.- - ------"---

FIGURE 18.7 B.

FIGURE 18.8 C.

FIGURE 18.9 D.
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The Keep Faces Together option is one of the

most important options for modeling with

polygons. This option affects a variety of polyg
onal modeling tools, such as Extrude Face,

Extract, and Duplicate Face. It works like so:

When this option is enabled, new polygonal

faces created with functions such as Extrude

Face stay connected at their adjacent edges.

When this option is disabled, the two faces are
extruded individually. Compare the differences

in FIGURES 18.10 and 18.11. FIGURE 18.10 Four faces extruded with
Keep Faces Together enabled.
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FIGURE 18.11 Same four faces with
Keep Faces Together toggled off.

~~
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Often you need to see different areas or aspects

of your model at different points in the model

ing process. Maya comes with several viewport

features that enable you to easily switch through

these aspects, making game modeling much eas
ier. For example, often you need to see how

many polygons your model contains to verify

that it's staying under your polygon budget. To

do this, choose Display> Heads Up Display >

Poly Count from the main menu. When the Poly

Count option is enabled, it displays a list in your

viewport that gives you constant feedback about

the polygon components visible in the viewport
(see FIGURE 18.12).

The system is displayed as a series of rows and
columns. The rows are fairly self-explanatory;
they allow you to see the current number of total FIGURE 18.12 The Poly Count system.

polygon components onscreen. The columns,
however, need a little explanation:

~ The first column gives the total count of polygon components for aJl polygonal objects in

the viewport.

~ The second column shows the number of polygon components for the selected polygon
objects in the viewport.

~ The third column shows all the selected components for objects partially visible in the

viewport. So if you have selected a few vertices in Component mode, for example, this

column shows how many you selected.

18 You might also need information about your model's surface normals so that you are aware
which side of your model is actually going to render in Unreal. As you know, the backfaces

(negative sides) of polygons aren't rendered in Unreal, so you must use the polygon's surface

normals to determine which side of each polygon is displayed. There are a couple of ways to do

this in Maya, and you can choose the method that b~st suits you. TUTORIAL 18.1 shows you

both methods.
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TUTORIAL 18.1: Displaying Surface
Normals in Maya

1. Open Maya, and start a new scene.
Make sure you're in the Modeling
menu set (if not. press F3).

2. Create a polygon sphere by choos
ing Create> Polygon Primitives>
Sphere from the main menu. Then
press the F key to focus the
Perspective viewport camera on it
(see FIGURE 18.13).

3. Next, choose Display> Polygon
Components> Normals from the
main menu to show the model's nor
mals as a series of lines that point
perpendicularly away from each
face's surface. The lines point
toward the positive side of the poly
gon, so your cube should look like it
has spines sticking out of it (see
FIGURE 18.14).

4. Press the G key to switch normals
back off. From the main menu,
choose Display> Custom Polygon
Display> options box [Q]. This
opens the Custom Polygon Display
Options dialog box (see FIGURE
18.15), where you can choose a
variety of display options designed
to make polygon modeling easier.
For the purposes of this tutorial.
you'll use Backface Culling, at the
bottom of the dialog box, Make sure
your sphere is selected, and click
On in the drop-down list box. You
won't see any change in your model
right now.

5. With the sphere selected, press Fl1
to make polygon faces selectable.
Select about half the faces on the

FIGURE 18.14 Normals visible on the sphere,

FIGURE 18.15 The Custom Polygon Display
Options dialog box.

----- ---'----' ----
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sphere with a marquee selection,
and delete them with the Delete key.
Rotate the camera so that you can
see the inside of the sphere. Notice
that you can't see the back side of
the sphere, and your marquee selec
tion ignored the faces on the back
side of the object (see FIGURE
18.16).

This step shows the dual nature of
the Backface Culling option. It hides
all polygonal backfaces in the view
port and, as a result, prevents you
from selecting polygonal compo-
nents from behind. The upshot to all
this is that polygonal objects appear in
the viewport as they would in Unreal,
meaning you can't see the reverse
side of the polygon.

END TUTORIAL 18.1

FIGURE 18.16 Backfaces of the sphere now
appear to be invisible.

NOTE"·

You must return to the Custom Polygon Display
Options dialog box whenever you want to toggle
Backface Culling on and off.

18

Polygon Modeling in Maya
This section lists the polygon modeling tools found under the Polygons menu on the main menu
bar. This menu centers primarily on tools that affect entire polygonal objects rather than tools
that focus mostly on polygon components. Not every tool in the menu is covered; instead, the
tools most pertinent for creating game models are discussed.

Creating Polygons

The Create Polygon tool enables you to create your own custom polygons in 3D space. This tool
is essential to effective polygon modeling because eventually you'll find that an existing primitive
simply doesn't offer the control you need. In these cases, you can create your own polygon shape,
and from that shape, you can extrude, append, and sh<ipe other components to form your model.
TUTORIAL 18.2 introduces you to this tool and demonstrates its use.

I
TUTORIAL 18.2: Using the Create Polygon Tool

1. Open Maya, and start a new scene. Make sure you're in the Modeling menu set (if not,
press F3). Press the 5 key to use Smooth Shaded mode in the viewport.

2. Choose Polygons> Create Polygon Tool from the main menu.
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3. Click once on the grid in the view
port. A square point appears on the
grid, which is a reference showing
you where the object's first vertex
will be created.

4. Click a second time on the grid,
away from the first point. A line
appears between the two points.
showing you where one of the
polygon's edges will be located.

5. Click a third time to form a triangle.
Notice that the triangle is filled in
with pink to represent where the
polygon's surface would be if you
finalized the tool operation at this
point (see FIGURE 18.17).

6. Click as many times as you like,
creating any polygonal shape you
desire. Notice, as in FIGURE
18.18, that the pink surface
updates to show you what the
object will look like when you
finish.

7. Press Enter to complete the tool
operation. This step finalizes the
creation process, and you are
rewarded with a complete polygon.
Notice, however, that despite the
number of times you click, you're
creating only a single surface. This
means you can potentially make single
polygons that are composed of many
sides. Polygons with several sides can
be quite a problem, as Unreal displays
only triangular polygons (those with
only three sides).

END TUTORIAL 18.2

FIGURE 18.17 The Create Polygon tool before
finalization.

FIGURE 18.18 An interesting polygon.

NOTE
When creating a polygon, you can click with the mid
dle mouse button (MMB-click) and relocate the last
point you placed.

.,

...:-._-_.

If you click the options box icon for the Create Polygon tool, you see a variety of options for

creating polygons. TABLE 18.1 describes these options and explains how to use them.
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TABLE 18.1 Create Polygon Tool Settings

Option Description

Subdivisions This option enables you to control the number of subdivisions along each
edge of the polygon you create. It doesn't subdivide the actual surface, so
don't use it in the hopes of creating a polygon grid. For those actions, you
can use the Subdivide command, covered later in this chapter in
"SUbdividing Polygons."

Limit Points To This option allows you to limit the number of vertices in your polygon. For
example, if you set it to 3, you can create only triangles, and after the third
click, the tool automatically completes its operation. A setting of -1 removes
any limitation.

Texture This area controls how UV texture coordinate information is stored for the
new polygon. It has two main settings: Normalize and Unitize.

Normalize scales the entire polygon'S UVs uniformly so that they fit within
the 0 to 1 texture space. Unitize arranges all the UVs for the object along
the outer edge of the 0 to 1 texture space. This effectively shapes your poly
gon's UVs into a square. If your polygon has three vertices, they are placed
at three of the 0 to 1 texture space corners.

For more information on texturing and the nature of UVs in Maya, be sure to
see Chapter 19, "The Art of Texturing in Maya."

Ensure Planarity This option ensures that the polygon you create is entirely planar. The plane
on which your polygon exists is determined by the location of the first three
vertices. This option is directly linked to the Keep New Faces Planar option,
located under Polygons> Tool Options.

Operation This option effectively switches the tool between the Create Polygon and
Append to Polygon tools.

Adding to Existing Polygons

18 As its name suggests, the Append to Polygon tool enables you to add to existing polygons. You

should note, however, that this tool can be used only to add onto polygonal borders, meaning

edges that are next to a hole or on the edge where the polygon object stops. You can use this tool

to create new polygon faces that are simply attached to a single face or to fill in holes in areas of

your model that are missing polygons. In TUTORIAL 1.8.3, you see how to use this tool to add

polygons onto an existing face.



TUTORIAL 18.3: Using the Append to Polygon Tool

1. Open Maya, and start a new scene.
Make sure you're in the Modeling menu
set (if not, press F3). Using the skills
you learned in TUTORIAL 18.2, select
the Create Polygon Tool, and create a
triangular polygon (see FIGURE
18.19).

2. Select the Append to Polygon tool from
the Polygons menu. The edges of the
triangle now look thicker. These thick
ened edges are used to designate
edges where you can use the Append
to Polygon tool. Click any edge of the
triangle. Purple arrows indicating the
direction of each edge are displayed
(see FIGURE 18.20).

3. Click on the grid at some point directly
away from the edge you clicked on. A
new pink polygon appears to show you
where the append will take place after
you finalize the tool operation. Also, the
new polygon has one solid green edge
and one dashed edge. If you click on
the side with the dashed edge, you can
add as many points as you like to the
new polygon without the polygon folding
back over itself. Click once to turn the
new polygon into a quad, as shown in
FIGURE 18.21.

4. Press Enter to complete the tool opera
tion. Feel free to make as many
appends as you like. FIGURE 18.22
shows an example after several
appends. You can also edit the ver
tices' locations when you're done to
close the shape. In this way, you can
model polygons much as you'd fold bits
of cut paper.

END TUTORIAL 18.3
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FIGURE 18.19 A triangular
polygon.

FIGURE 18.20 Edge direction
arrows visible.

FIGURE 18.21 A quad
appended to the triangle.

FIGURE 18.22 The original
triangle, after several appends.
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Operation
18

As with the Create Polygon tool, you can use several options to change the Append to Polygon

tool's behavior. TABLE 18.2 lists these options and describes what they control.

TABLE 18.2 Append to Polygon Tool Settings

Option Description

Subdivisions This option allows you to control the number of subdivisions along each

edge of the polygon you create. It doesn't subdivide the actual surface, so

don't use it in the hopes of creating a polygon grid. For those actions, you can

use the Subdivide command, covered later in "Subdividing Polygons:

Limit Points To This option enables you to limit the number of vertices in your appended poly

gon. For example, if you set it to 3, you can append only triangles, and after

the third click, the tool automatically completes its operation. A setting of -1

removes any limitation.

Rotation Angle This option becomes available only while you're clicking to create an appended

polygon. Use the slider to adjust the rotation of the appended polygon. This

option is much like folding on the edge of the append.

Texture This area controls how UV texture information is stored for the new polygon. It

has two main settings: Normalize and Unitize.

Normalize scales the entire polygon's UVs uniformly so that they fit within the

o to 1 texture space. Unitize arranges all the object's UVs along the outer

edge of the 0 to 1 texture space. This option effectively shapes your polygon's

UVs into a square. If your polygon has three vertices, they are placed at three

of the 0 to 1 texture space corners.

For more information on texturing and the nature of UVs in Maya, be sure

to see Chapter 19.

Ensure Planarity This option ensures that the polygon you append is entirely planar. The plane

on which your polygon exists is determined by the rotation of the polygon to

which you're appending. This option is directly linked to the Keep New Faces

Planar option, located under Polygons> Tool Options_

This option effectively switches the tool between the Create Polygon and

Append to Polygon tools.

Combining Objects

When modeling for Unreal, especially characters, in sbme situations you might need polygonal

meshes to behave as though they were one polygon object. For example, you might need a piece

of armor, such as a shoulder plate, to follow your character's movement. In this case, simply com

bining tbe meshes is usually easier than adjusting the models so that the character and the shoul

der plate are one seamless model. Also, modeling this kind of detail into your characters by

making several adjustments to separate models results in a severe increase in your polygon count.

Many professional game models, including those in Unreal Tournament 2004, use combining to

avoid this problem. In TUTORIAL 18.4, you see how this tool works.

---------_._---_..__ . --
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TUTORIAL 18.4: Using the Combine Command

1. Open Maya, and start a new scene.
Make sure you're in the Modeling
menu set (if not, press F3).

2. Create a polygon sphere, and
move it a few units away from the
center of the grid. as shown in
FIGURE 18.23.

3. With the sphere selected, press
Ctrl+D to duplicate the sphere.
Move the duplicate to the other side
of the grid's origin point (see
FIGURE 18.24).

The names of the spheres in the
Channel Box are currently pSpherel
and pSphere2. These names will be
important in a moment.

4. Draw a marquee selection box
around both spheres to select them,
and choose Polygons> Combine
from the main menu.

5. The two spheres are now considered
to be a new single object (see
FIGURE 18.25). Notice that the
pivot of the new object is located at
the origin point, and that the name
has been changed in the Channel
Box to polySurfacel. This is impor
tant to remember because if you
combine and then separate objects,
you lose their original pivot and
naming information.

I~N=O...::.T=E ,...

The opposite of the Combine command,
Separate, can be found under the Edit Polygons
menu rather than the Polygons menu.

END TUTORIAL 18.4

._--_.--_. _.

FIGURE 18.24 Two separate spheres.

FIGURE 18.25 The two spheres combined.
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Using Booleans

Boolean operations are a way to alter the shape of one polygonal object based on the shape of

another polygonal object. For example, if you subtract a cylindrical shape from a large cube, the

result is a cube that appears to have a hole in it. Boolean operations are an easy way to create

machined-looking shapes. These operations can be used for a wide variety of objects, from gun

barrels to windows in walls. You must be careful when using Boolean operations, however,

because all meshes imported into UnrealEd must be converted to triangles, and using a Boolean

operation can significantly raise the number of polygons in your model. In TUTORIAL 18.5, you

learn the Boolean operations available in Maya and see how to apply them to your model.

TUTORIAL 18.5: Applying Boolean Operations

1. Open Maya, and start a new scene.
Make sure you're in the Modeling
menu set (press F3 if not). Create
two cubes, and position them so
that they're intersecting each other,
as in FIGURE 18.26.

2. For your first Boolean operation,
selection order is no matter.
Therefore, simply select both cubes
using your favorite method. Choose
Polygons> Booleans > Union from
the main menu. If you're in a
shaded view, YOU'll see little to no
change in the cubes' look because
the change is taking place where
the two cubes pass through each
other.

FIGURE 18.26 Two cubes for the Boolean
demonstration,

18
If you press the 4 key to show the objects' wireframe, you can see that the edges where
the two objects are intersecting have been removed. This Boolean operation has effec
tively turned the two cubes into one seamless model.

3. Rather than undo and reapply the command, you can simply use construction history to
change the Boolean operation. With the new object still selected, go to the Channel Box
and click the polyBoolOpl node. This expands the Inputs list to display a new attribute:
Operation. Clicking this attribute opens a drop-down list that you can use to switch
between the three available Boolean operations.

Click the Union operation, and from the pop-up menu, choose Difference. FIGURE 18.27
shows the result-it looks as though the second cube's area was removed from the first
cube.
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4. Repeat step 3, setting the
Operation attribute to Intersect.
This operation leaves only the area
where the two cubes intersected
one another.

5. As a point of interest, open the
Outliner by choosing Window>
Outliner from the main menu. Sift
through the list until you find the
pCubel and pCube2 entries. They
are the remaining transform nodes of
the original cubes. You can select
either one, and move, rotate, or scale
it in the viewport to affect the shape
of your Boolean object in real time.

END TUTORIAL 18.5

FIGURE 18.27 The result of using the Difference
operation on the cubes.

Mirroring

One of the easiest ways to speed up a modeling project is to model only half of your object. In

Maya, you can use the Mirror Geometry command to make a mirrored duplicate of half an object

and merge the two objects together. Obviously, this technique can dramatically speed up model

ing time on symmetrical objects. In TUTORIAL 18.6, you see how to use this command to dupli

cate and mirror half a model.

TUTORIAL 18.6: Mirroring Geometry

'-

"

1. Open Maya, and start a new scene.
Make sure you're in the Modeling
menu set (press F3).

2. Create a polygon cube. In the
Channel Box, set its Subdivisions
Height, Subdivisions Width, and
Subdivisions Depth to 4. FIGURE
18.28 shows the result of these
settings.

3. Right-click over the object, and
choose Face from the marking menu
to make faces selectable on the
object.

FIGURE 18.28 A polygon cube.
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4. Select and delete half the faces on
the cube that are in the negative X
direction (see FIGURE 18.29). If
you haven't rotated the camera
much, these faces are on the left
side of the cube.

5. Next, try selecting some faces on
the remaining side of the cube and
moving them around. Use FIGURE
18.30 as a reference, or just make
an interesting shape. Don't move
any of the faces that are on the
seam.

6. Return to Object mode by pressing
the F8 key. Choose Polygons>
Mirror Geometry> options box from
the menu. In the Mirror Geometry
Options dialog box, set the following
options:

Mirror Direction: -X

Merge With Original: Select this
check box

Connect Border Edges: Active

7. Click Mirror, and you can see
that the model has been copied,
mirrored, and welded together
(see FIGURE 18.31).

NOTE
If you don't toggle off Backface Culling in the
Custom Polygon Display Options dialog box,
selecting and removing these faces In step 4
can be more difficult.

END TUTORIAL 18.6

FIGURE 18.29 Half the cube has been removed.

FIGURE 18.30 The cube reshaped after faces
are moved.

FIGURE 18.31 Your model, fully mirrored.

_.. , ------_...-----
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Smoothing Versus Averaging Vertices

When modeling, sometimes you need a model that's relatively smooth, such as an organic or a

rounded surface. Unfortunately, the inherent polygon limit of most game engines, including

Unreal, makes these types of surfaces difficult to achieve without creating an excessive number of

polygonal faces. You can, however, use a couple of commands in Maya should the need for

smooth rounded objects be impossible to avoid.

TABLE 18.3 Smooth Command Options (Exponential)

FIGURE 18.32 Polygon cube before being
smoothed.

Polygon cube after beingFIGURE 18.33
smoothed.

Smoothing

The Smooth command, located under the

Polygons menu, offers a pair of algo

rithms (methods) called Exponential and

Linear that tesselIate your model to a

higher number of polygons, and then

adjust those polygons' position to create a

smoothed result. The problem is that this

command results in objects with a very

high number of polygons. The

Exponential and Linear methods offer

different options for controlling polygon

count in the resulting model. Both meth

ods can be accessed in the Smooth

Options dialog box or in the Inputs area

of the Channel Box after the Smooth

command is applied. In FIGURES 18.32

and 18.33, you can see before and after

images of the effects of smoothing.

The Exponential method gives you a much

smoother result at the cost of a high face

count. TABLE 18.3 lists its options.

I..
Option Name Description

Subdivision Levels

Continuity

This option controls how many faces are in the resulting mesh.
Each time you increase this value, the number of faces increases
exponentially.

This attribute controls how smoothly the new faces blend together
to create a complete model. It has two settings: 0 is no smoothing,
and 1 results in full smoothing.

/
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TABLE 18.3

Option Name

Continued

Description

Smooth UVs

Keep Geometry Borders

Keep Selection Borders

Keep Hard Edges

Keep Tessellation

Keep Map Borders

This option determines whether the Smooth operation affects UVs
as well.

This option prevents border edges from being smoothed.

If you have selected only specific faces for smoothing, this option
stops the Smooth operation at the edge between the selected and
nonselected faces.

If you have specified any hard edges, a technique covered later in
"Adjusting Surfaces and Hard Edges: those edges aren't smoothed.

This option prevents the Smooth operation from adding new ver
tices, should you make any construction history adjustments after
smoothing.

This option controls how UV borders are smoothed and is active
only if the Smooth UVs check box is selected. The None setting
doesn't affect the borders (outer edges) of the object's UVs. The
Internal setting smoothes only internal borders, and All smoothes
all borders.

The Linear method doesn't typically produce as smooth a result as the Exponential method, but

it gives you far more control over the resulting number of faces. TABLE 18.4 lists and describes

the options for this method.

TABLE 18.4 Smooth Command Options (Linear)

Option Name

Subdivision Levels

Divisions Per Face

Push Strength

Roundness

Description

Similar to the Subdivision Levels option for the Exponential method,
this option controls the number of faces in the final mesh.

This option is also used to control the number of final polygons by
controlling the number of times each face is subdivided. You can
think of it as a fine-tuning for the final number of polygons.

This option determines the final object's volume. A setting above 0
pushes the resulting faces outward. This option can help solve the
problem of smoothed objects looking much smaller than the original
presmoothed model.

This option scales vertices from the center of the model, resulting
in a rounder look. It has an effect only if Push Strength is set higher
than O.



Averaging Vertices

Because smoothing typically creates a high number of

polygons, you can use the alternative method of aver
aging the location of preexisting vertices in your

model. The result is a smoother-looking model, with
out the need to add more detail. To do this, you use the

Polygons> Average Vertices command. This command
is useful only ifyou want to smooth your object's shape

without adding any more vertices. Compare the differ
ences in FIGURES 18.34 and 18.35.

The number of vertices in the cube hasn't changed. Be

aware that when you're using the Average Vertices

command, the selected vertices become much smaller

each time the command is applied, so you'll likely

need to scale them back up.

Triangulation

When working on projects for Unreal, your models

must always be composed of triangles. There's no

exception to this rule because a triangular face, logically,
is always planar, and the rendering engine requires

much more calculation to display nonplanar faces.

In Maya, you don't have to worry about this rule

much. First, you can still view nonplanar faces in the

viewport as you model, and second, you can convert
every face in your entire model to a triangle with a

single command. The Triangulate command is simple

to use, and it doesn't have any options for you to

worry about setting. FIGURES 18.36 and 18.37

show the results of using Triangulate.

NOTE
For many of the static meshes In Unreal Tournament
2004, you should try to keep the number of vertices
down to Just a few hundred.

TIP
u ~ ";, .~'

The Average Vertices command doesn't work unless
you are selecting vertices. If you're averaging an entire
model, you must actively select all its vertices.
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FIGURE 18.34 Polygon cube before
averaging its vertices.

FIGURE 18.35 Polygon cube after
averaging its vertices several times.

FIGURE 18.36 Polygon cube before
triangulation.

FIGURE 18.37 Polygon cube after
triangulation.
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Cleaning Up Your Polygons

The Cleanup command in the Polygons

menu is used to correct or point out errors

in a polygonal mesh. It can find a long list

of problems and offers a few options for

correcting them. This command is a main

stay of beginning modelers, as it can easily

and instantly repair the simple or careless

mistakes made when still learning the

toolset. The Polygon Cleanup Options dia

log box (choose Polygons > Cleanup >
options box to open it) is divided into four

main sections: General Options, Tesselate

Geometry, Other, and Remove Geometry

(see FIGURE 18.38). The folJowing sec

tions describe this tool's features and

explain what each option is used for.

General Options

,
I

I

I,;
FIGURE 18.38 The Polygon Cleanup Options
dialog box.

This section contains basic parameters that control how the Cleanup operation functions. The

settings are all fairly straightforward, as shown in TABLE 18.5.

TABLE 18.5 General Options of the Cleanup Command

18

Option

Operation

Select All Polygonal
Objects

Construction History

Description

This option tells Maya what to do with any of the problems it finds. Your
choices are Select Geometry, which more or less simply points out the
problem areas, or Select and Cleanup, which locates and fixed your
errors.

This option tells the Cleanup tool which objects to fix. If this check box
is selected, the operation is performed on all polygonal objects in your
scene. If it's not selected, the operation affects only the selected
polygonal object.

Select this check box if you want to keep the construction history of the
repaired object.

Tessellate Geometry Options

You can use the options in this section to establish the areas of a model to be tessellated (divided

into triangles). Selecting all these check boxes is the same as running the Triangulate function on

your entire model. TABLE 18.6 lists the settings for this section.

-_ .. - .. _ .._._----------



TABLE 18.6

Option
i 4-Sided Faces
!
r..- Faces with More

r Than 4 Sides
,

l Concave Faces

l
I

I
I

l
Faces with Holes

Non-planar Faces
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Tessellate Geometry Options of the Cleanup Command

Description

This option tells the Cleanup operation to triangulate all faces that are
four-sided (quads).

This option triangulates all faces that have more than four sides.

This option triangulates all concave faces on your object. You can imagine
concave faces as any face on which a straight line could enter the face, exit
it. and leave it again. For example, a single face shaped to look like the let
ter C would be concave; a face that's a simple square would not. Concave
faces can be difficult for a variety of calculations. such as dynamic simula
tions. This option breaks a concave face into a series of triangles, which
can never be concave.

This option triangulates any face that has an opening in it, such as a single
face in the shape of the letter O.

This option triangulates all faces that don't exist on a single plane. For
example, a quad (four-sided face) could have three vertices that are all
coplanar and a fourth vertex raised above the rest. The result would be a
nonplanar face. This option divides nonplanar faces into a series of planar
triangles.

Other Options

The options in this section specialize in the selection of nonmanifold geometry, which is essen

tially, geometry that can't be unfolded into a single, flat piece. Certain tools in Maya, such

as Boolean operations, can't use nonmanifold geometry. TABLE 18.7 lists the settings for this

section.

TABLE 18.7 Other Options of the Cleanup Command

Option

Nonmanifold Geometry

Normals and Geometry

Geometry Only

Description

This option tells the Cleanup operation whether it deals with non
manifold geometry. If this check box is selected, the operation
selects and attempts to repair geometry. If it's not selected, non·
manifold geometry is ignored.

If selected, this option causes the Cleanup operation to repair
the nonmanifold geometry and fix any problems with the surface
normals.

This option repairs the model's geometry without affecting the
normals.
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Remove Geometry Options

This section includes a variety of settings to help you remove excess geometry from your model.

It's perhaps one of the most useful areas for beginning modelers, as it's easy to create unnecessary

detail when you first begin exploring the toolset. TABLE 18.8 lists the settings for this section.

TABLE 18.8

Option

Edges with Zero
Length

Faces with Zero
Geometry Area

Faces with Zero
Map Area

Lamina Faces

Remove Geometry Options of the Cleanup Command

Description

This option removes edges that exist between two vertices sharing
the same location. The Length Tolerance setting for this option
enables you to control how short the edge must be before it's
removed. Be careful not to set it too high.

This option removes faces that are almost infinitely small in area.
They can be created in a variety of ways, especially when making care
less extrusions. You can use the Area Tolerance setting to control how
close to zero the face's size must be before it's deleted.

This option removes faces with zero area for UV coordinates. Again,
the Area Tolerance setting provides a threshold so that you can control
how close to zero the area can be before the face is removed.

These faces rest one on top of the other, with normals facing in oppo
site directions. An example is merging two cubes without deleting the
faces that are touching.

18

Editing Polygons
The Edit Polygons menu is dedicated to actual modeling tools-tools that are intended to manip

ulate the components of polygonal objects. The following sections explain the most important

tools for you to know as a beginning modeler. Keep in mind that many tools in this menu work

only when a particular type of component is selected. In this case, Maya typically issues a warn

ing to tell you which component you need to ~eJect.

Subdividing Polygons

The Subdivide tool simply adds more topology to selected faces or edges. This tool is great to use

when you simply need more detail on which to model. Its use is fairly simple: It can tessellate your

model into quads or triangles. In TUTORIAL 18.7) you take a look at using this tool.
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TUTORIAL 18.7: Using The Subdivide Tool

1. Start a new scene and go to the
Modeling menu set.

2. Create a polygon cube, and press
Fll so that you can select its faces.

3. From the Edit Polygons menu,
choose Subdivide> options box. Set
the mode to Triangles, and click the
Subdivide button.

4. Your polygon has been divided into tri
angles, as shown in FIGURE 18.39.
You could move the new vertex in the
middle of the face to create a differ
ent shape that would have been
impossible a moment ago.

FIGURE 18.39 The face at the top of the cube
has been subdivided.

5. Feel free to apply the tool several times and view the results. You can also set the mode
to QuadS, which divides the faces into more four-sided faces.

END TUTORIAL 18.7

Splitting Polygons

The Split Polygon tool is quite possibly the most important tool in polygon modeling. You can

use this tool to add edges to your model and control where they are located, how detailed they

are, and much more. TUTORIAL 18.8 introduces you to this vital tool.

TUTORIAL 18.8: Splitting Polygons

1. Start a new scene and go to the
Modeling menu set. Create a polygon
cube to be used as your test object.

2. From the Edit Polygons menu,
choose Split Polygon Tool. Notice the
cursor turn into a V-shaped arrow.

3. Click any edge of the cube, and then
click another edge directly across
from the first one you clicked. Notice

the green line that connects the two
points you clicked. Next, click the next
parallel edge around the cube. A new
split appears. connecting the points to
the third edge (see FIGURE 18.40).

FIGURE 18.40 A split across three edges of the
cube.

~.- --------- - ----
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4. Press the Y key, which completes
the split, finalizes the new edges
you just made, and then restarts the
tool for you to make a new split.
Feel free to make another split.
Repeat as much as you like, and
press Enter after the last split.
FIGURE 18.41 shows a cube with
several splits.

END TUTORIAL 18.8
FIGURE 18.41 An excessively split cube.

When using the Split Polygon tool, you should keep the following rules in mind:

~ A split must begin and end on an edge. When splitting, you can create points in the

middle of a face, but keep in mind that the first and last points must be on edges.

~ A split cannot end on the same edge from which it began. If you need to make such a

split, you need to make it from two separate split operations.

~ You cannot "jump" edges. This means you must click on each individual edge as you split

across an object. This process can be quite confusing for beginners, especially when creat

ing splits in corners. Be sure you know from which edge you begin your splits.

~ You can relocate the last split point you create by MMB-clicking it.

The Split Polygon tool also has several options you can use to adjust or fine-tune the splitting

process. TABLE 18.9 describes each of these options.

TABLE 18.9

Option

Subdivisions

Snap To Edge

Snap To

Magnets

Number Of
Magnets

Magnet
Tolerance

Split Polygon Tool Options

Description

This option controls the number of vertices to be spread across your new splits.

This option allows split points to be placed only on existing polygon edges. Switch
it off if you want to add points to the middle of a face.

This option activates snapping magnets, invisible markers that allow you to mark
off percentages of edges for precise splitting. When this option is selected, split
points tend to "pop" to these invisible magnets as you drag across an edge.

This option controls the number of snapping magnets on each edge. Setting it
to an odd number enables you to make splits down the center of an object.

This option controls the strength of snapping magnets. The higher this value. the
farther away the snapping point jumps to the magnet.

:..--- ._ .. - - • __.. - ._ __ __ _ __ . ~ .. . . . ~ .. - " ·---0 -~
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Extrusions

Extrusions are one of the most common modeling functions. You can extrude almost every poly

gon component except UVs. For your purposes, this chapter focuses mainly on face extrusions,

although you can easily apply the knowledge to edge extrusions, which function exactly the same.

Extruding vertices is a little different, so this technique is covered separately in "Extruding Vertices."

In essence, an extrusion moves an existing component away in its local space. It then connects that

component back to its original position with new geometry. This process can sound a little con

fusing at first, so take a look at this tool first hand in TUTORIAL 18.9.

.,

NOTE

FIGURE 18.43 The extrusion has been
moved up.

Notice that the manipulator's blue-Z axis
is pointing straight up, even though in
world coordinates the Y-axis points
upward. By default, the Extrude manipula
tor works in local coordinates, in which Z
always points in the direction of the sur
face normal.

To fix this, you can click on the small
pale blue circle above and to the right
of the manipulator. This allows you to
move your extrusion in world rather than
local coordinates.

3. A new manipulator appears that's a
hybrid of the Move, Rotate, and Scale
manupulators (see FIGURE 18.42).
Clicking one of the arrows enables
Move mode. Clicking one of the rings FIGURE 18.42 The Extrude manipulator.

around the manipulator enables Rotate
mode, and clicking one of the small
cubes enables Scale mode.

1. Start a new scene. and enter the
Modeling menu set. Create a (you
guessed it) polygon cube.

2. Press Fli, and select the face on top
of the cube. From the Edit Polygons
menu, choose Extrude Face.

TUTORIAL 18.9: Making Face Extrusions

r

r
I
I

l

Move the extrusion upward, and notice
that the face is connected back to its
original location with four new faces
(see FIGURE 18.43). This step

If you like the Move/Rotate/Scale manipulator, you
can use it for normal object transformations. To use it,
choose Modify > Transformation Tools > Move/
Rotate/Scale Tool from the main menu.
L-________________~
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demonstrates how powerful the extru
sion function can be, as it enables you
to create a lot of detail on your object
quickly.

4. Select other faces and make more
extrusions. Try extruding more than one
face at a time (see an example in
FIGURE 18.44). Make adjustments
using the manipulator's Rotate, Scale,
and Move modes. Also, experiment with
toggling the Keep Faces Together
option, as explained in "Understanding
the Tool Options and Display Settings in
Maya" earlier in this chapter.

5. When finished, go back to Object mode,
and move the object you created out of
the way.

6. Create a new cube. Switch to the Side
viewport, and choose Create> CV
Curve Tool from the main menu. Create
a curve from the top of the cube into an
interesting shape, as shown in
FIGURE 18.45.

The starting point of the curve is very

important in this case, as it's the point
from which the extrusion begins. If you
make the curve in the wrong direction,
the extrusion runs backward. Be certain
you begin the curve at the top of the
cube.

7. Return to the Perspective view, and
select the top face of the cube. Right
click on the curve, and choose Object
Mode from the marking menu. This
command enables you to select the
curve in Object mode, even though you
might be in Component mode. Do this
now by Shift-clicking the curve.

When you're finished, you should have
the face at the top of the cube (indi
cated in orange) and the curve (indi
cated in green) selected, as shown in
FIGURE 18.46.

FIGURE 18.44 A simple abstract shape,
made completely of extrusions.

FIGURE 18.45 A curve that starts from the
top of the cube.

FIGURE 18.46 Both the face and curve are
selected.
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FIGURE 18.48 The extrusion is now following
the curve.

FIGURE 18.47 The initial result isn't quite
what you expected.

9. In the Channel Box, find the
ExtrudeFace node. (There should be
only one.) Click on it to see a list of
attributes. Scroll to the bottom of this
list, find and click the Divisions
attribute, and then MMB-drag to the
right in the viewport to use the virtual
slider. This operation increases the
extrusion's divisions. Notice that the
more divisions you add, the more the
extrusion conforms to the shape of the
curve (see FIGURE 18.48).

8. From the Edit Polygons menu, choose
Extrude Face. Notice that the face
snaps to the end of the curve (see
FIGURE 18.47).

With the virtual slider, you can raise the
Divisions value up to a limit of 25, but you're
free to type In whatever value you like.

Tift

10. Experiment with the Twist and Taper
attributes, and see what results you can
come up with. FIGURE 18.49 shows
an example of the result of modifying
these attributes.

1-.
I

r,----------I

I
!

t
1-

END TUTORIAL 18.9

FIGURE 18.49 Extrusion after modifying the
Divisions, Twist, and Taper attributes.
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Extruding Vertices

Extruding an edge is virtually identical to extruding a face, but extruding vertices is quite a bit

different because there's no manipulator for vertex extrusions. Extruding a vertex isn't the most

commonly used function, but it's good for pulling points, spikes, and other similar shapes out of

geometry. TUTORIAL 18.10 gives you a look at using this command.

TUTORIAL 18.10: Vertex Extrusions

18

1. Start a new scene, enter the
Modeling menu set, and create a
cube.

2. Press F9, and select a single vertex

from the object's surface.

3. Choose the Extrude Vertex com
mand from the Edit Polygons menu.
Notice that no manipulator appears,

as shown in FIGURE 18.50.

4. Go to the Channel Box, and click
the polyExtrudeVertexl node. Make
adjustments to the Length, Width,

and Divisions attributes to see
how the manipulation process
works without a manipulator.
FIGURE 18.51 shows an example
of the results of adjusting these

attributes.

TIP
You can manually enter values between 0 and 1
for the Width attribute, although the virtual
slider allows values only between 0 and 0.5.

END TUTORIAL 18.10

FIGURE 18.50 A vertex extrusion.

FIGURE 18.51 Several alterations made to the
vertex extrusion.

Chamfering Vertices and Beveling Edges

Even though you should try to avoid excessive polygon counts when creating game models, some

times you need to create objects with rounded edges. Adding slightly rounded edges always makes

your models look more realistic than creating razor-sharp 90-degree angles. Two commands are

available for creating slightly rounded edges: Bevel (for edges) and Chamfer Vertex. These two

functions add new detail to the shape to make it look less sharp. TUTORIAL 18.11 demonstrates

/~- how to use these tools to round off the edges and corners of shapes.
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A beveled cube.

FIGURE 18.52 A cube with all vertices
chamfered.

FIGURE 18.53

Each vertex is divided into three ver
tices, and a surface is stretched
across each group of three. This is
how chamfering works. In essence,
it splits a single vertex so that
there's one new vertex for each
edge that was leading into the origi
nal, and a surface is stretched
between these new vertices. In
effect, this command rounds off the
corners of objects.

2. Choose one of the cubes and select
all its vertices. Choose Chamfer
Vertex from the Edit Polygons menu
(see the result in FIGURE 18.52).

1. Start a new scene and go to the
Modeling menu set. Create two poly
gon cubes, and move them apart
from each other.

3. Now select the second cube, and
choose the Edit Polygons> Bevel
command to round off all the edges
and corners. In the Channel Box,
click the polyBevell node to see
four options for controlling the
bevel. The most important option is the Offset attribute, which controls how far the
edges are beveled. Play with the settings and see what kind of shapes you can create.
FIGURE 18.53 shows an example.

TUTORIAL 18.11: Chamfering and Beveling

,,,,---.

I

~-
I,

When you're modeling photorealistic objects, keep in mind that beveling is a major factor
because no objects in the real world have perfectly sharp edges. In game engines such as
Unreal, however, beveling is typically seen as extra faces. If you don't need beveling for a
specific shape, you should consider avoiding it.

END TUTORIAL 18.11

Cutting Faces

You can think of the Cut Faces Tool as a massive cutting laser. You can quickly cut all the

way through a model, if you're in Object mode, or cut through a specific selection of faces.

TUTORIAL 18.12 demonstrates how to use this tool to add detail right where you need it in your

model.

---~ .-------~--~-----._--
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TUTORIAL 18.12: Using the Cut Faces Tool

Wedging Faces

The Wedge Faces command is a powerfuJ weapon for a polygon modeler's arsenal. Basically, it

allows you to hinge an extrusion from a single edge. Its uses are practically limitless, from creat

ing folded plates and pipe works to even making intersections in catwalks. In TUTORIAL 18.13,

you see how this tool is used.

1. Start a new scene, and go to the
Modeling menu set. Although you
could create any polygonal object
you like. for this example, create a
cube so that you can easily see the
results.

2. From the Edit Polygons menu,
choose Cut Faces Tool. Your cursor
turns into a triangular arrow. Click
on the center of your object and
drag away. A thick black line that
crosses the viewport appears to
indicate where the new cut will be
placed (see FIGURE 18.54).
Release the mouse button at the
angle you like.

3. Use the tool again, but hold down
the Shift key as you do to make the
cut line snap to 45-degree incre
ments. Make a cut or two using this
method.

4. Now open the Options dialog box for
the tool (choose Edit Polygons> Cut
Faces Tool> options box from the
menu). In the Cut Direction drop-
down list, select Custom Cut, and click
the Cut button. A plane manipulator
that can be moved, rotated. and scaled
is displayed (see FIGURE 18.55).
This manipulator gives you precise
control over where to locate the cut.

END TUTORIAL 18.12

FIGURE 18.54 The Cut Faces tool indicator.

FIGURE 18.55 The Custom Cut manipulator.

NOTE""" ,

Using these settings, you can also make cuts that are
perfectly aligned to specific axes.
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FIGURE 18.56 The first step in creating the
wedge is to select a face.

FIGURE 18.57 The initial result of the wedge
operation.

1. Start a new scene and enter the
Modeling menu set. Create a poly
gon cylinder, and in the Channel
Box, set its Subdivisions Caps
to O.

TUTORIAL 18.13: Using the Wedge Face Command

2. Select the face on top of the cylin-
der, as shown in FIGURE 18.56.

3. Right-click over the object, and
choose Edge from the marking

,
menu. With the face still selected,
hold down the Shift key and select

I one edge on the side of the
I

1-
selected face.

4. From the Edit Polygons menu,
I

choose Wedge Faces, The faceI
1 pops up from its original location,

as though it were hinged from
the selected edge (see
FIGURE 18.57).

5. With the object selected, click
the polyWedgeFacel node in the
Channel Box to access the
wedge's angle and divisions.

6. Practice using this tool a few times.
Combine it with Face Extrusions,
and see what kind of shapes you
can come up with. FIGURE 18.58
shows an example.

FIGURE 18.58 The result of a few wedges and
face extrusions.

END TUTORIAL 18.13

---------------_. -------_.. - -_._---
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Merging Vertices

The Merge Vertices command is a vital tool for polygon modeling. It enables you to convert two

models into one solid, seamless mesh. To use it, simply select a group of vertices, run the com

mand, and specify a threshold distance. If the vertices are within the specified distance of each

other, they snap together and merge to become one vertex. TUTORIAL 18.14 introduces you to

this concept.

TUTORIAL 18.14: Using the Merge Vertex Command

- '-

18

1. Start a new scene and enter the
Modeling menu set. Create two
cubes, and move them slightly apart
from each other on a single axis, as
shown in FIGURE 18.59.

2. On each cube. delete the faces that
are facing each other. If you were to
skip this step and merge the ver
tices anyway, the result would be a
Lamina face.

3. Select both cubes in Object mode
and choose Polygons> Combine
from the menu. This step is crucial,
as you can merge only vertices that
are on the same model.

4. Select two vertices directly across
from each other. From the Edit
Polygons menu, choose Merge
Vertices Tool> options box. In the
Tool Settings dialog box, set
Threshold to 0.5. FIGURE 18.60
shows the results.

5. Repeat step 4 for the other three
vertices, or you can select them all
at once and adjust the Threshold
setting until they merge properly
(see FIGURE 18.61). This process
can be tricky. however. especially if
the distance between the two cubes
is actually larger than their width.
height, and depth.

FIGURE 18.59 Your two subjects.

FIGURE 18.60 A pair of vertices merged to a
single vertex.
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The result is a rectangular object
that is a fully merged, seamless
model. This tool is a valuable one,
and you should practice using it to
help prevent excess geometry in
your model.

NOTE
If the vertices don't merge at this point, you can
adjust the Th reshold setting in the Channel
Box by clicking the polyMergeVertl node.

END TUTORIAL 18.14

Flipping Triangle Edges

As mentioned earlier, all game models

intended for use in UnreaJ need to be tri
angulated. For this reason, modelers need

a great deaJ of control over how those tri

angles behave. Often, particularly with

character models, a triangle can be facing

the wrong direction, resulting in poor
deformation when the model is animated.

You can improve it by changing the direc

tion of the triangular edge. Instead of hav

ing to delete the edge and repLace it in a
new direction, in Maya you can flip these

edges over quickly with the Flip Triangle

Edge tooJ.

The tool's use is simple: Just select the edge
in question, and run the command. In

FIGURES 18.62 and 18.63, notice the

dramatic changes in the shape of the

model just because of the placement of

this edge.

Editing Polygons

FIGURE 18.61 The cubes are merged into one
model.

FIGURE 18.62 With the triangle edge pointed at
the camera, the face folds as shown here.

FIGURE 18.63 After the triangle is flipped,
however, the face folds in the other direction,
completely changing the model's look.

653
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Adjusting Surfaces and Hard Edges

Normals are an essential aspect to be aware of when modeling an object for Unreal because a

polygon's negative side isn't rendered, as stated earlier. Controlling the direction of your normals

is easy, but does deserve some discussion. In TUTORIAL 18.15, you see how to change the direc

tion of surface normals of a polygonal object.

TUTORIAL 18.15: Controlling Surface Normals

1. Start a new scene, and go in the
Modeling menu set. Create a poly
gon sphere, and using Component
mode, delete the upper half of its
faces. Using the skills you learned
in TUTORIAL 18.1, display the
normals. Your example should be
similar to FIGURE 18.64,

2. Open the Custom Polygon Display
Options dialog box. For the Backface
Culling option at the bottom, select
Keep Wire so that you see only the
wireframe when looking at the back- FIGURE 18.64 A half sphere with visible normals.

face of polygons (see FIGURE
18.65), This option makes reversed
normals even easier to see.

18

3. Often the tools you use cause your
model's surface normals to run in
two separate directions. Although
you don't currently have this situa
tion, knowing how to reverse the
direction of a polygon"s normals is
helpful.

To do this, select a few faces of the
half-sphere, and from the Edit
Polygons menu, choose Normals>
Reverse> options box. In the
Reverse Options dialog box, set the
mode to Reverse to simply change
the direction of the normals. Notice
that you can see the faces with
reversed normals on the inside of
the sphere (see FIGURE 18.66).

FIGURE 18.65 Backface Culling set to Keep
Wire.
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The second mode in this dialog box
is Reverse and Propagate, which
effectively flips all normals in a
model, even if you selected only
one. The third mode is Reverse and
Extract, which reverses the normal
and completely separates it from
the model, making it a free-standing
polygon face.

You can use the Edit Polygons>
Normals> Reverse command when
ever you see that a normal is
pointed the wrong direction on your
model. Normals should always point
in the direction of the surface you
need to display. For example, if you
were modeling a crate and the nor
mals were pointed inward, the crate
would not render in-game.

Another handy tool for controlling
surface normals is the Conform
command, located under Edit
Polygons> Normals. This command
hunts for stray normals and makes
sure they point in the same direc
tion as the majority of the faces.
This command is a one-click fix
when you have just a few normals
pointed in the wrong direction.

Editing Polygons
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FIGURE 18.67 Conform has reversed the
normals you flipped a moment ago.

655

4. Apply the Conform command to your model now to make all the normals face in the same
direction (see FIGURE 18.67). If, after you use Conform, all the normals face in the
wrong direction, you can then use the Reverse command to flip them.

You can apply these few techniques to make sure your models' normals face in the proper
direction. This step is a vital one after your model is finished and just before you import it
into Unreal.

END TUTORIAL 18.15

Another way to have normals control the look of polygon models is by using hard edges. Hard

edges allow you to create the appearance of creases or seams along the edges of a model. The

advantage of hard edges is that they can be transferred into Unreal, allowing you to control when

an edge should look smooth or sharp. In TUTORIAL 18.16, you work with a simple example to

see how to use hard edges to control your model's look.

----- ----------------
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TUTORIAL 18.16: Controlling Hard Edges

18

1. Start a new scene, and go to the
Modeling menu set. Create a polygon
sphere. Rotate around it a bit, and
notice that you don't see any edges.
You might see a hint of shading that
suggests the edges, but no creases.

2. Select a ring of edges around the
sphere, as shown in FIGURE 18.68.
Any ring will do, so don't worry if it's
not exactly at the equator.

3. From the Edit Polygons menu, choose
Normals> Soften/Harden> options
box. In the Soften/Harden Options dia
log box is a slider with two buttons
underneath for moving the slider fUlly
to one side or the other.

The number in the slider is an angle
value that controls when a hard edge
occurs. If two faces meet at an angle
greater than this value, the edge where
the faces meet is considered hard. If
the angle where they meet is less than
this value, that edge is soft.

4. Set this angle value to 0, and click the
Soft/Hard button.

5. Deselect the sphere entirely, and then
rotate the camera around the sphere.
Notice the crease-like edge around it
(see FIGURE 18.69). This edge is a
result of the object's normals being
modified to simulate a crease. No
extra topology has been added.

END TUTORIAL 18.16

Summary

FIGURE 18.68 A ring of selected edges
around the sphere.

FIGURE 18.69 You can see the crease
around the middle of the sphere indicating the
location of the new hard edge,

A fast way to select a ring of edges is to select a sin
gle horizontal edge and choose Edit Polygons >
Selection> Select Contiguous Edges.

This chapter has covered a wide variety of polygon modeling tools. You have been introduced

to many of the fundamentaJ skills needed to shape polygon objects. At this point) you need to

practice with many of these until you're comfortable with how they function.
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The Art of Texturing
in Maya

In this chapter, you examine how to prepare your polygonal model

to receive a custom texture in Photoshop. This process requires

understanding the concepts behind UVs and UV layouts for poly

gons in Maya. You learn how to create these UV layouts, import

them into Photoshop, and use them as a template to create a texture

for your objects.

UVs and the UV Coordinate System
Every polygonal object in Maya has UVs. They are a vertex-like

polygon cOmponent used strictly for texturing purposes. UVs

enable yOll to take a three-dimensional surface and lay it out flat so

that you can paint a. texture on it in a program such as Photoshop.

As an analogy, consider having to print a design on a beach ball

using a computer printer. To do this, the beach ball's surface needs

to be completely flat and laid out in a configuration that fits com

pletely within a standard sheet of paper. Unfortunately, laying the

surface out in this manner means you would have to completely

destroy the beach ball. This is where UVs come into play. UVs are an

.,
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entirely separate coordinate system, fully independent of the location of a model's vertices. They

are almost like a "second surface~' that you can use to flatten the object out without destroying the

model's shape.

All the polygonal primitives in Maya are created with a default set of UVs that can be viewed with

the UV Texture Editor, located under the Window menu in Maya. In TUTORIAL 19.1, you use

this editor to get an idea of what a UV layout looks like on a primitive cube.

TUTORIAL 19.1: Examining UV Layouts

1. Open Maya and start a new scene.

2. From the Create menu, choose Polygon Primitives> Cube.

3. Choose Window> UV Texture Editor. This window shows you the UV layout on selected
objects (see FIGURE 19.1). Keep in mind that if you have nothing selected, this window
is blank.

19 FIGURE 19.1 The default UV layout of a cube.

Notice that the UVs for the cube are arranged as though it were unfolded and laid out flat.
At the same time, however, the cube retains its original shape because the actual vertex
locations in 3D space are separate from the UV coordinates.

END TUTORIAL 19.1

------ ---- ---- ----_._--
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UVs and the UV Coordinate System

Because UVs exist in a coordinate system separate from a model's vertices, their position has no

effect on the final model. UV coordinate space is a two-dimensional system rather than a three

dimensional one. Its two dimensions, U and V, are surface dependent, meaning they exist only

along an object's surface. For example, pretend that your stomach has UV coordinates. The U

direction runs horizontally, and the V direction runs vertically. If you draw a line across your

stomach from left to right, that line moves only in the U direction of tbe UV coordinate space.

No matter how far you continue the line, even around to your back, you are still moving only in

the U direction along the surface. The UV coordinate system, therefore, is a two-dimensional sys

tem that "wraps around" a three-dimensional one.

The UV Texture Editor
The IN Texture Editor is the primary tool for creating UV layouts in Maya. UVs can be

edited, manipulated, and controlled by using the UV Texture Editor, which you viewed in

TUTORIAL 19.1. In this section, you examine this editor briefly to see how it's used to control

your object's UVs. The editor is divided into three main areas: the menu bar. the toolbar, and the

view.

The Menu Bar

The menu bar contains all the relevant commands to control your UVs. The following list

describes the menu items:

~ Polygons-This menu contains all the commands needed to layout the UVs of a polygon

model. Instead of explaining each one now, you learn about these commands as you use

them in the following tutorials.

~ Subdivs-This menu contains a few commands necessary for adjusting UVs on a
subdivision surface. This menu isn't covered in this book.

• View-This menu contains many commands for controlling what you see in the view

port. Sometimes it can be difficult to tell what UVs are doing, especially when your layout

consists of several overlapping pieces. Using this menu, you can show or hide specific

groups of UVs to help make the arrangement process easier.

~ Select-This menu has a variety of useful commands to help with selection of your

object's components. You can use these commanas to select aU UVs within a contiguous

piece, or shell, and to convert a specific selection into vertices, edges, faces, or UVs.

~ Image--This menu provides controls for how the texture is displayed in the UV Texture

Editor.

~ Help-This menu gives you access to Maya's help system.

----_ ... - ------_.__._- ----_.. -

659



660 Chapter 19 The Art of Texturing In Maya
'--------

The Toolbar

Across the toolbar are a series of icons and entry fields that can be used for many commands (see

TABLE 19.1); these commands are also available from the main menu. Also, notice that the tool

bar is divided into six collapsible groups to save space.

TABLE 19.1 UV Texture Editor Toolbar

19

.....,- -

Icon

•
Name

Rip UVs (U direction)

Flip UVs (V direction)

Rotate UVs Counterclockwise

Rotate UVs Clockwise

Cut UVs

Sew UVs

Layout UVs

Move and Sew UVs

Split Selected UV

Description

Rips the selected UVs horizontally in the UV
Texture Editor.

Flips the selected UVs vertically in the UV Texture
Editor.

Rotates all selected UVs 45 degrees in a
counterclockwise direction.

Rotates all selected UVs 45 degrees in a
clockwise direction.

Divides a piece of the UV layout along selected
edges. Although selecting edges is the most effi
cient way to use this tool, you can also use it with
selections of UVs.

Attaches two edges together in UV space. It does
n't affect the shape of the actual model, even
though you're working with polygonal edges. Note
that when selecting one edge in the UV Texture
Editor, the corresponding edge shared on the
model is also selected.

Automatically generates a layout for the UVs of
your model based on a set of criteria you enter in
the options dialog box. Using this command from
the Polygons menu to open the Options dialog box
is usually easier.

Moves and attaches selections of edges to one
another. The difference between this command and
Sew UVs is that Move and Sew UVs tries to move
the pieces of the layout, instead of just the edges.

Breaks a single UV up so that there's one UV for
each edge that was leading into that Uv. For exam
ple, if you have four edges leading into a single UV,
this command would break that UV into four
separate UVs.
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TABLE 19.1 Continued

Icon Name Description

~ Cycle UVs Cycles through all the UVs within the face that con-
tains the selected UV, and then selects all the
edges of that face. This command can be useful

I when you're having a difficult time seeing what a

I particular face is shaped like In the UV Texture
~

Editor,

[EI Align UVs (minimum U) Aligns a selection of two or more UVs in the U
direction so that they line up with the UV that was

I farthest to the left in the UV Texture Editor.

Bl Align UVs (maximum U) The same as the previous command. except that
the UVs are aligned In the U direction to the UV
that was farthest to the right in the UV Texture

"

l Editor.
i

~ Align UVs (minimum V) Aligns a selection of two or more UVs in the V
direction so that they line up with the UV that was
the closest to the bottom of the UV Texture Editor,

!- ",--

Align UVs (maximum V) The same as the previous command, except that
the UVs are aligned in the V direction to the UV
that was closest to the top of the UV Texture
Editor.

,.... Grid UVs Moves the selected UVs to the nearest grid inter-
section based on the settings created for the com-
mand, Using this command's Options dialog box
from the Polygons menu is easier.

Relax UVs More evenly distributes the selected piece of the
UV layout to make more efficient use of texture
space. The result is not unlike taking an average
location for all the UVs of a selected piece.

ImJ Toggle Isolate Select Mode Hides all UVs that aren't currently selected. which
can make manipulating the UVs much easier.

too Add Selected Adds the current selection to the current isolated
selection, making it visible,

IfID Remove All Clears the current isolated selection, essentially
hiding all objects visible while the isolated select
is active.

Remove Selected Removes any selected UVs from the current
isolated selection,

'''-' - - "._-. --------_.-..
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TABLE 19.1 Continued

Icon Name

Show Background Image
(toggle on/off)

Description

Shows or hides the texture you're applying to your
objects in the UV Texture Editor. The texture tile
outside the 0 - 1 texture space, which you discuss
in a moment.

Show Grid (toggle on/off)

Snap to Pixels (toggle on/off)

Filtered Display Mode
(toggle on/off)

Toggles the display of the grid in the UV Texture
Editor.

Controls whether you can snap UVs to pixel bor
ders. This option is useful when you're trying to be
precise about which texture pixels are included in
your UV layout.

Specifies whether the texture is rendered with
hardware filtering in the UV Texture Editor or is
drawn with sharply defined pixels.

Image Ratio (toggle on/off) Controls whether the texture space is square or
matches the size ratio of the selected texture.
Because all Unreal textures must be square, you
don't need to use this option for game models.

Texture Borders (toggle on/off) Controls whether UV borders are drawn with a thick
line instead of the single pixel line.

19

Display RGB Channels

Display Alpha Channel

uo:m:il?t:1 U and V coordinate entry fields

[miJ Refresh the Current UV Values

Copy UVs

Paste UVs

Paste U Value to Selected UVs

Paste V Value to Selected UVs

Copy/Paste for UVs/Faces
(toggle)

Displays the color information of the texture in the
UV Texture Editor.

Displays the alpha information for the texture in
the UV Texture Editor.

Used to type in an exact location in UV space,
moving the selected UV to that location.

Refreshes the UV coordinate entry fields to display
the correct number for the selected UV.

Copies the selected vertex colors, UVs, or shaders
to. the Clipboard so that you can paste them onto
other UV sets.

Pastes any vertex colors, UVs, or shaders that are
stored in the Clipboard.

Pastes the U value that has been stored in the
Clipboard onto the selected UVs.

Pastes the V value that has been stored in the
Clipboard onto the selected UVs.

Determines whether copy and paste work for UVs
or faces.
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The Viewport

¥ou navigate the UV Texture Editor viewport exactly the same way as the orthographic views in

Maya. Alt+MMB pans the view, and Alt+LMB and MMB zoom the view. You can also use

Alt+LMB to pan the camera, something you can't do in an orthographic viewport.

The UV Texture Editor viewport has a unique grid that's divided into four quadrants, with the

upper-right quadrant darker than the rest. This quadrant is darker to indicate that your entire

texture fits into this quadrant. Outside the upper-right quadrant, the texture simply repeats, or

tiles. In most cases, therefore, you want your entire UV layout to exist within this grid's upper

right quadrant, which is also known as the 0-1 texture space because all the coordinates for this

quadrant exist within 0 and 1.

Mapping UVs

,,.,-.

Before you can start laying out an object's UVs, you must understand how to map UVs in the UV

Texture Editor. UV mapping is a way to take a selection of faces and Jay out their corresponding

UVs in the UV Texture Editor. Several types of UV mapping are available in Maya, but this book

focuses on three: automatic mapping, planar mapping, and cylindrical mapping.

FIGURE 19.2 A character model with UVs laid out with
automatic mapping.

Mapping Methods

With automatic mapping, Maya

automaticalJy lays out your

model's UVs based on a series of

criteria (see FIGURE 19.2). You

can control the method used in

automatic mapping in the tool's

Options diaJog box, which you can

access by choosing Edit Polygons

> Texture > Automatic Mapping

from the main menu. You'JJ find

several options for controlling the

way the automatic mapping takes

place. Unfortunately, this com

mand rarely yields usable results

for your game models because the

UVs are usually laid out in a pat

tern that's practicalJy impossible

to follow. However, you can use this method as a "quick fix" to achieve a simple UV layout,

especialJy when you intend to use the textures already included in Unreal.

--- ._._---_ .._--_ .. --------._----_.--- --..-
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In planar mapping, the UVs of

selected faces are laid out as

though they had been pulled off

the model and laid out flat onto a

single plane. You can choose a

specific axis on which the plane is

projected, or you can let Maya act

to interpolate one based on the

angle of all the selected faces.

You'll be using this mapping

method a bit later. FIGURE 19.3

shows a planar mapped sphere, in

which the plane is projected down

the Z-axis.

In cylindrical mapping, the UVs

are laid out as though they had

been projected onto a cylinder.

This mapping method is espe

cially useful for character faces

and for any object that's rougWy

cylindrical in form, such as an

arm or leg. For example, if you cut

the leg off a pair of pants, the leg

would be a cylindrical form. If

you make a cut that runs all the

way along the inseam, you could

then lay the fabric out flat. This is

exactly how cylindrical mapping

works. FIGURE 19.4 shows a

character's leg that has been

mapped cylindrically.

FIGURE 19.3 A planar projected sphere.

FIGURE 19.4 A cylindrically mapped leg.

19
Creating UV Layouts
Mapping is only the first step in creating a proper layout for your UVs. On an actual model, you

map each part of the model, a piece at a time, using the mapping method best suited to that spe

cific area of the model. When finished, you have a series of pieces representing your model that

are laid out flat. At that point, all you need to do is move, rotate, and scale each piece in the UV

Texture Editor so that they aU fit in the 0-1 texture space.
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TUTORIAL 19.2: Creating a Mesh and Preparing for UV Layout

FIGURE 19.6 The edges of the cube have been beveled
to create a simple rounding.

For now, you'll just create a
simple mapping to use as a
reference so that you can tell
what has been laid out and
what has not. To do this, select the Dice and choose Edit Polygons> Texture> Planar
Map> options box from the menu. Make sure the Fit to Best Plane option is enabled, and
click Project. This creates a single map that includes all the faces.

1. Start a new scene in Maya.
Verify that you're in the
Modeling menu set (if not.
press F3).

2. Create a polygon cube with a
length, width, and height of
64 (see FIGURE 19.5).
Name the cube Dice.

4. The bevel action has caused
the cube to lose its UVs, so
you need to create them from
scratch. You can verify this by
selecting the Dice and open
ing the UV Texture Editor from
the Window menu.

3. With the cube selected, choose
Edit Polygons> Bevel >
options box from the menu. In
the Bevel Options dialog box,
set the Offset value to 6, and
click Bevel. This creates an
extra set of faces at the cor
ners of the cube, which round
it out without adding too much
detail (see FIGURE 19.8).

This process might seem easy, and in concept, it is quite easy; in practice, however, laying out an

object's UVs can be time consuming. Also, many beginners wonder what's the right or correct way

to layout an object's UVs. Unfortunately, this is where many users run into the fine line between

a skUJ and an art form. The truth is that there is no single "correct" way to create a UV layout

onJy the method that works best for you or your texture artist. Before you get too far into that,

however, try creating your own UV layout for a simple object in TUTORIAL 19.2. Over the next

few tutoriaJs, you create a static mesh of a dice; later, using the skills you learn in Chapter 20,

"Static Meshes:' you can import it into UnreaJ with a complete texture.

I
~

I
I

l
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5. Select the Dice in Object mode, and open the UV Texture Editor. You see the UV layout for
the object, which looks similar to an orthographic view.

6. Press F12 to make UVs selectable, and then draw a marquee selection across all the UVs
in the UV Texture Editor. Try the Move, Rotate. and Scale tools to see how they work on
the UV selection. When you're finished, move the UVs to the side, outside the 0-1 texture
space. You'll be using these UVs only as a starting point for your layout. With that, your
Dice is ready to create the UV layout. Save the file as UnrealDice.

END TUTORIAL 19.2

As mentioned earlier, there's no right or wrong way to layout an object's UVs. There are some

fundamental guidelines to consider, however, and they are explained as you come across them in

subst;quent tutorials. In TUTORIAL 19.3, you create a simple UV layout for the static mesh cre

ated in TUTORIAL 19.2.

TUTORIAL 19.3: Creating a UV Layout for the Static Mesh

1. Continue from TUTORIAL 19.2, or open the file you saved at the end of that tutorial.
You're going to create a UV layout that you can paint in Photoshop.

._"
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2. In the Perspective viewport,
press Fl1 to make faces
selectable. Select the face
at the top of the Dice. From
the Edit Polygons menu,
choose Texture> Planar
Map.

3. Open the UV Texture Editor.
Notice the interesting manirr
ulator visible on the mapped
UVs (see FIGURE 19.7).
It's a combination of the
Move, Rotate, and Scale
tools. You can use the
arrows or the small blue ring
in the center to move. The
arc in the middle is for rota
tion. The three squares are

FIGURE 19.7 This manipulator becomes available when
you create mappings.



used for scaling in U, V. or U
and V simultaneously. Areas
on the border of the manipu
lator, such as at the corners,
are pale blue, red, or green.
They are used for a special
type of scaling that enables
you to expand the manipula
tor without affecting the
other sides.

4. Move and scale the selected
face so that its lower-left
corner is at the UV coordi
nates 0.4, 0.7. Place the
upper-right corner at the
coordinates 0.6, 0.9. You
can use the numeric entry
fields in the toolbar. or sim
ply use the Move tool with
grid snapping activated to
help. Make sure the piece
remains a perfect square, as
in FIGURE 19.8.

6. Now, select the bottommost
face of the Dice and apply
planar mapping to it. Adjust
the face so that it's aligned
with the grid. exactly one
grid space to the right of the
first face you mapped (see
FIGURE 19.9).

Creating UV Layouts 667

FIGURE 19.8 The first face of the Dice is now laid out.

FIGURE 19.9 Two faces are now laid out.
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8. Continue this pattern to lay

out the rest of the Dice
object's major faces. After
you map a face, always
place the face on the oppo
site side next to it. For
example, place the left and
right faces next to each
other and the front and back
faces next to each other.
When finished, you should
have something similar to
FIGURE 19.10.

7. In the UV Texture Editor,
move and scale the remain
ing UVs that are still outside
the UV Texture Editor so that
they fit in the area to the
right of the major faces you
just laid out. All these corner
faces have the same color,
so their placement is not
that important. In fact, if you
want to, you could scale
them down so that they fit
inside a single pixel.
Whatever color that single
pixel contains is spread
across all the UV faces that
were scaled into the area.

8. Save your work. Now you're
ready to take this UV layout
into Photoshop.

END TUTORIAL 19.3

FIGURE 19.10 The major faces of the Dice object are
now laid out.

FIGURE 19.11 All the faces of the Dice are completely
laid out.

Creating Textures from UV Layouts
Now that you have seen how to create a lTV layout for your object, you need to learn how this lay

out can be used to create a texture in an external paint application, such as Photoshop. You won't,
however, import the texture into Unreal, as the methods for this process have already been
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covered in Chapter 9, "Interactive Elements." In TUTORIAL 19.4, you import the UV layout cre

ated in Maya into Photoshop to create a texture.

TUTORIAL 19.4: Exporting Your UVs into Photoshop

1. Continue from TUTORIAL 19.3, or open the file you saved at the end of that tutorial.
You're going to import the UV layout you created into Photoshop so that you can create a
texture with it.

2. With the Dice selected, go to the UV Texture Editor. From the Polygons menu, choose UV
Snapshot. Set the File Name text box to a path and name you can easily locate. Set the size
in X and Y to 512. The Color Value setting controls what color the lines of the UV layout are.
Because the background is always black, stick with white for the UV layout lines. Also, make
sure the image format is set to Targa (see FIGURE 19.12). Click OK when done.
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FIGURE 19.12 These are the settings you need
in the UV Snapshot dialog box.

3. Open Photoshop, and open the Targa file you just created from the same path used in the UV
Snapshot dialog box. You see the same thing you saw in the 0-1 texture space in Maya's
UV Texture Editor, except that the image
is white UVs on a black background.

4. As a rule, you should never paint on
yourUV snapshot, so create a new
layer over the background layer. Name
this layer DiceColor.

5. With the new layer selected, use the
Paint Bucket tool and fill the layer
with white. Bring the layer's opacity
down to about 90% so that you can
barely see where the UVs exist.

6. Remember how you mapped first one side
of the Dice object and then the opposite
side? On real dice, numbers on opposite
sides always add up to seven, With that in
mind, make a series of dots in the laid out
UVs that coincide with the dots on an
actual set of dice. Use FIGURE 19.13 if
you need help.

7. Set the opacity for the DiceColor layer back
to 100%. Save your work as a new Targa
file with the name DiceTextureComplete.
Choose 32-bit when prompted how to save
the Targa file.

END TUTORIAL 19.4

FIGURE 19.13 Here is the dot pattern
for your layout. Note that the DiceColor layer
has been lightened a bit for clarity.



Because you already know how to create new textures for materials (covered in Chapter 8,

"Creating Materials in Unreal") and because you have yet to learn how to get Maya models into

Unreal as static meshes, in TUTORIAL 19.5, you simply add the texture to the object in Maya.

After you read Chapter 20, "Static Meshes," you'll know everything you need to know to create

static meshes and import a custom texture based on UV layouts.

TUTORIAL 19.5: Applying the New Texture

disconnectAttr file1.outTransparency lam
bert2.transparency;

This line performs the same function as removing the
wire between the two nodes.

-

-
You can also disconnect the nodes by typing the fol-
lowing Maya Embedded Language (MELScrlpt) line
into the command line at the bottom of the Interface:

NOTE
:, ~-

Because the texture's placement now depends on the
UVs, you can delete the Place2DTexture node from the
lambert2 network. It has no effect on the flnal object.

I, Return to Maya. Open the Maya file you

saved in TUTORIAL 19.3, if it's not

open already.

2. Right-click on the object, and from the

marking menu, choose Material>

Assign New Material> Lambert. This
creates a new Lambert material,
applies it to the object, and opens the

Attribute Editor for the new material.
Click the Map button (with the check

ered pattern) next to the Color slider.

In the Create Render Node dialog box,
click the File texture button.

19

3. In the Attribute Editor, next to Image Name, is a small button with a folder icon. Click this but
ton, and navigate to the DiceTextureComplete. tga texture you finished in TUTORIAL 19.4.

4. If you press 6 on the keyboard, you'll notice that the object seems to be almost com
pletely transparent, but this is nothing to worry about. The reason it looks transparent is

that the Targa file has an alpha channel to control its transparency. Maya noticed the

alpha channel and took the liberty of assigning its data to the Transparency attribute.

5. You need to break the connection

from the File texture to the mater
ial's Transparency. Open the Hyper

shade window. Right-click on

Lambert2. and choose Graph

Network.

6. In the Work Area of the Hyper

shade, you see the network from

the shader. Note that between

the File1 and Lambert2 nodes,

there are two connections: The

top one is feeding the color, and
the bottom is feeding the trans
parency (see FIGURE 19.14).

FIGURE 19.14 The two nodes of the shader, with
two connections between.
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Click on the bottom connection wire.
The tooltip should say it connects
from filel.outTransparency to lam
bert2.transparency. With the wire
selected, press the Backspace or
Delete key to break the connection
between the nodes, allowing you to
see the Dice clearly in the viewport
(see FIGURE 19.15).

7. Save your work. After Chapter 20,
"Static Meshes; you'll be able to
bring this Dice into Unreal and use it
as a new decoration in your levels.

END TUTORIAL 19.5

FIGURE 19.15 The Dice's texture can now be seen
because the connection from the alpha channel to the
transparency has been broken.

One of the most important things to remember about UVs is that they can be overlapped to repeat

a texture on a surface. This process can be a little difficult to picture at first, so in TUTORIAL 19.6,

you see how it works.

TUTORIAL 19.6: Overlapping UVs

FIGURE 19.16 All six squares have been "stacked"
onto the area with the one dot.

3. You have six squares of UVs
that make up the sides of the
Dice. For this tutorial, you place
each square on top of the
square that's in the upper left,
which is the side with one dot.
One at a time, place the other
five squares on top of the first
square. You can snap the ver
tices if you like, but for this
example, precision is not vital. In
FIGURES 19.16 and 19.17,

1. Continue from TUTORIAL 19.5, or open the file you saved at the end of that tutorial.

2. Select the Dice object, and open
the UV Texture Editor. You see the
texture you created in Photoshop
in the background. If necessary,
switch off the background image
to make it easier to see the UVs.

----_. ------ -----------_.
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you can see what this looks
like in the UV Texture Editor
and the viewport.

4. Save your work. Remember
that you can think of UVs in
the UV Texture Editor as points
that sample areas of the tex
ture. Moving the UVs around
causes your object to sample
different parts of the texture at
the locations those UVs have
on the surface.

If you can, watch the viewport as you move

the UV squares. You see the texture shift
along the surface of the Dice until each
side contains a single dot.

END TUTORIAL 19.6

FIGURE 19.17 The result of overlapping these
UVs is that the texture repeats on the surface.

19

,----

UV Layouts for Characters
At this point, you have created a basic UV layout for a static mesh. Character UV layouts are sim

ilar, but often require a lot more planning. When creating a UV layout for your character, you

should consider three major points. First, you'll probably have an easier time if you begin the lay

out process by drafting your layout on a piece of paper. This gives you a map that you can follow

as to where certain pieces should be. Second, develop a standard layout for your characters. For

example, you place faces for a character's right leg in generally the same location for the IN lay

outs of all your characters. Having a standard layout makes it easier for you or your texture artist

when it's time to paint a texture.

Third, you should consider how you plan to use the textures on your character. All the characters

available in Unreal Tournament 2004 include two textures: one for the main body, which is usu

ally at a resolution of 1024XI024, and a separate texture just for the head, also at 1024xl024.

Having these two textures serves two purposes. First, it allows for highly detailed faces and heads

because all the texture's resolution is used to color only the head. Second, it makes it possible to

create several different characters by using the same model and body textures. The end result is

as though you had several different characters wearing the same uniform or one character wear

ing different uniforms.
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In TUTORIALS 19.7 and 19.8, you take a look at how to layout some of a character's UVs. The

entire character layout process isn't covered, however, as it's typically a slow process involving

repeating many of the same techniques.

TUTORIAL 19.7: Laying Out the UVs of a Character's Shirt

FIGURE 19.19 This initial planar map is just a
reminder of which parts have yet to be laid out.

At this point, you could use the Polygons > Layout UVs
command from the UV Texture Editor's menu, and you
would get a basic but relatively usable layout. This method
is sometimes useful when you need to quickly texture a
cha racter or object that isn't seen often or not up close.

NOTE

FIGURE 19.18 You can use these settings for
your initial planar projection.

Move and scale the UVs a bit,
and place them outside the 0-1
texture space, as shown in
FIGURE 19.19.

1. In Maya, open the
CharacterComplete. mb file, which
contains a completed character
model. If you check the UV Texture
Editor, you can see that the charac
ter's UVs are completely haywire
right now.

2. Select the character, and choose
Edit Polygons> Texture> Planar
Mapping> options box from the
main menu. In the Polygon Planar
Projection Options dialog box,
enable the Fit to Bounding Box
option and select Z Axis to create a
planar projection of the entire char
acter (see FIGURE 19.18). Click
the Project button when you're
done.

4. Back in the viewport, switch to
Face component mode by press
ing Fl1. Select the faces on the
front of the character's shirt.
Make sure you select only faces

3. Open the UV Texture Editor, and
take a look at what you've done.
The character's UVs are very
similar to what the character
would look like in the Front
orthographic view. Using an ini
tial mapping of this type gives
you a guide for what parts have
been mapped and what parts
have not.rl

r

Ir---.-
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tFIGURE 19.20 Faces selected for the next mapping.

FIGURE 19.21 The first faces of the shirt have been
mapped and positioned.

that are relatively planar to
each other, meaning that
the faces should meet
each other at a very slight
angle whenever possible.
This helps avoid texture
stretching later. At the bot
tom of the shirt, select the
first 16 faces, as shown in
FIGURE 19.20.

5. With the faces selected,
choose Edit Polygons>
Texture> Planar Mapping
> options box. Enable the
Fit to Best Plane option,
which automatically ori
ents the plane for opti
mum results. Click the
Project button when
finished.

6. Back in the UV Texture
Editor, move, rotate, and
scale the newly mapped
faces so that they're
somewhere within the 0-1
texture space (see
FIGURE 19.21). The
placement doesn't really
matter now; you can
always move them around
later. Notice that the faces
you just mapped have
been moved off the

original planar map.

7. In the viewport, select the next row of faces on the shirt, and make another planar map. In
the UV Texture Editor, rotate and scale these new~ mapped faces so that they're directly
above the last set you mapped. Be sure to scale them to a size relative to the faces you
mapped earlier.

19

When you first map the new faces, you can't see the last mapping you created because
when you're selecting faces, you can see only the faces that are selected. Right-click over
the new mapping, and choose UVs from the marking menu. Some of these new UVs are
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The next set of UVs has been moved

FIGURE 19.22 The new mapping for the four faces of
the chest overlaps the other UVs, making it difficult to select
specific UVs.

FIGURE 19.23
above the first.To close the gap between

these two pieces, you use
the Sew UVs command. Press F9 to make edges selectable. Select one edge at the
bottom of the most recent mapping. Notice how the corresponding edge beneath it is

probably overlapping some
of your older mappings, as
in FIGURE 19.22.

8. In this situation, you can
use a special selection
operation for UVs: selecting
a separate piece, or shell.
Select a single UV vertex of
the four faces you just
mapped, and choose Select
> Select Shell from the UV
Texture Editor menu. This
command automatically
selects all the UVs in that
piece, which makes select·
ing overlapping UV pieces
easy. With the piece
selected, move and scale it
into position over the first
12 faces you mapped ear
lier (see FIGURE 19.23).

9. You now have a gap
between these two pieces.
Gaps between UV pieces
can lead to seams in the
texture, so you should go
ahead and remove them.
Keep in mind that you can't
always remove every gap
between your UV pieces.
Inevitably, you'lI have gaps
somewhere. Just do your
best to have them fall in
places where a seam would
be less likely to be noticed,
such as on the shirt's
sides and under the arms.

I

r
I
i
I
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FIGURE 19.25 The UVs of the front of the shirt have been
laid out.

The two pieces of the shirt have been sewnFIGURE 19.24
together,

automatically selected,
too, because these two
edges are, in fact, the
same edge on the model.
Choose Polygons> Sew
UVs from the UV Texture
Editor menu. You'll see the
two edges merge together
into one. Repeat this step
to sew up the seam
between the two pieces
(see FIGURE 19.24).

10. Repeat the steps for mak
ing planar maps and
sewing them together until
you have a single piece
that represents the front
of the shirt (see FIGURE
19.25). You can then
make a separate piece
that forms the back of the
shirt, or if you prefer, make
a single piece that's the
whole shirt. This piece
would be like making a cut
on either side of the shirt,
from the bottom, through
the armpit, and to the bot
tom of the end of the
sleeve. You could then
open the shirt up and lay
it flat.

11. Save your work. You could
use these methods to
move around the entire
character, laying out all
the UVs you find.19

You can try the other mapping methods dis
cussed earlier. In TUTORIAL 19.8, you'll try
using a cylindrical map around the faces of
the character's leg.

END TUTORIAL 19.1

Remember when making your planar maps to selett
faces that are already close to being planar to each

other. This technique helps avoid texture distortions

later.
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TUTORIAL 19.8: Using a Cylindrical Map for a UV layout

1. Continue from TUTORIAL
19.7. You're going to lay
out the UVs for one of the

character's legs.

2. First, select all the faces

around the character's left

leg (see FIGURE 19.26).
You can make several mar
quee selections while hold

ing the Shift and Ctrl keys,

or you can use the Paint
Selection tool, found under

the Edit menu. This tool
enables you to select com-

ponents in a paintbrush FIGURE 19.26 All faces of the leg have been selected.
fashion across your model.

3. With the faces selected,
/- choose Edit Polygons>

Texture> Cylindrical

Mapping to create a wire
frame cylinder to be used

for the map. To begin using

it, MMB-drag one of the

red handles midway along
the cylinder. This enables

you to close the cylinder's
sweep (circumference).

4. At the middle of the cylin
der, MMB-drag the red ring

to rotate the cylinder so
that its seam runs along

the inside of the charac

ter's leg (see FIGURE
19.27). If possible, watch
the UV Texture Editor while

you're doing this to help

prevent obvious texture

seams on the leg.

'---------- ------~

FIGURE 19.27 The Cylindrical Mapping manipulator is
surrounding the leg,
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5. At the bottom of the Cylin
drical Mapping manipulator
is a small red cross. MMB
click it to activate a new
manipulator that's similar to
the Move/Rotate/Scale tool.
Use it to rotate the entire
cylinder in the X-axis so that
it's aligned more with the
angle of the leg. A rotation
of about -5 degrees should
do. Look at your results in
the UV Texture Editor (see
FIGURE 19.28).

6. You can repeat this process
with the right leg and both
arms. Combining the skills
you learned in TUTORIAL
19.7, you could then create
your own UV layout.

END TUTORIAL 19.8

FIGURE 19.28 The UVs of the leg have been cylindrically
mapped and are ready to be laid out.

19

Considerations for UV Layouts
Remember that laying out UVs for a character isn't the kind of process you're going to finish in a

matter of minutes or even hours. Creating an efficient UV layout is a skill that comes with prac

tice and effort. The following list offers a few pointers, however, that should help you as you get

started:

~ Go slow. Don't rush by mapping several faces at the same time and just fitting them in

wherever you can.

~ Be organized. Don't just sling your mappings into the texture space. Have a plan when

you begin, and try to follow it.

~ Use as much of the texture space as you can. Typically, your texture is I024xl024. Any

gaps in your pieces are a waste of precious pixels. Try to keep everything as tight as

possible.
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FIGURE 19.29 The UV layout for an official Unreal
Tournament 2004 character.

~ Practice and use as many

of the tools in the UV

Texture Editor as you can,

especiaJJy those in the

View menu. Hicting what

you're not working on

makes your life far easier

when working on UV

layouts.

~ Don't be hard on yourself.

UV layouts are an art form

that no one just knows

spontaneously. Becoming

skilled at UV layouts takes

a lot of time and effort.

~ Keep UV face sizes in relation to their polygonal counterparts. This guideline can be con

fusing, but think about it: If a single face of your model is very small, you don't want that

face to take up half your available texture space. Keeping the sizes of polygon faces and

faces relative in the UV Texture Editor prevents your texture from becoming ctistorted.

~ You can place the UVs of your character's head so that they stretch across the entire 0-1

texture space, even though they overlap other UVs. This is because you're usually placing

a separate face texture on

the head anyway.

\
l
I

As an example, FIGURE 19.29

shows the UV layout for the

Jugg character in Unreal

Tournament 2004, such as

Gorge. Notice that it's broken

up into many pieces-so many

pieces, in fact, that differentiat

ing one piece from the next is

hard. On the other hand, you

can also see that it uses almost

every pixel of the texture area,

so the character can be covered

with as much texture as
FIGURE 19.30 The same Unreal Tournament 2004
character whose UV layout is shown in FIGURE 19.29.



680 Chapte!..!9 The Art of Texturing in May_a _

possible. Obviously, this layout

required a lot of planning and

work to ensure that the texture

artist knows which pieces of the

UV layout correspond with

what parts of the character.

Also, notice a piece that sits out

side the 0-1 texture space. This

piece is making use of the fact

that textures repeat as you go

outside the 0-1 texture space.

FIGURES 19.30 and 19.31

show the character with his tex

ture applied and what the tex

ture looks like in the UV

Texture Editor.

19

FIGURE 19.31 The texture used on the character, as seen
in the UV Texture Editor.

Summary
In this chapter, you've taken a look at several aspects of creating a UV layout for your character.

You learned how to use the UV Texture Editor, a variety of mapping methods, and several tools

you can use to lay your UVs out in the 0-1 texture space. Remember that no one can tell you the

"right" way to layout the UVs of your characters or objects. The best way is always the way that's

easiest for you to understand and foHow.



Static Meshes

In this chapter, you learn about static meshes in Unreal and how to cre

ate them with Alias Maya. When you finish this chapter, you shouJd

have a good understanding of the procedure for creating your own sta

tic meshes for your Unreal levels. The bulk of this chapter is dedicated

to creating static meshes and getting them into Unreal. Therefore, it's

mainly tutorial-based. You begin by reviewing the use of static meshes

in Unreal, and then work through a variety of tutorials to construct a

series of catwalks that can be used to create continuous walkway net

works in Unreal. You also learn about creating colJision models to sim

plify the calcuJation of player collisions with static meshes. Finally, you

learn how to get these meshes into Unreal and use them to create a level.

The Importance of Static Meshes
When playing an Unreal level, static meshes are what provide the

bulk of the geometric detail. A static mesh is an optimized polygonal

model, meant to be instanced (duplicated) throughout your level.

The vertex locations of a static mesh are stored in your video card,

allowing multiple copies of a single mesh to exist in a level, with vir

tually no more overhead than the original mesh.

AJthough the architecture of a static mesh enables you to create muJti

pIe instances of a single mesh, you must be aware that loading too many
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different meshes negates their advantage. When you bring in a single mesh, all its geometric data is

stored in your video card. All subsequent copies of that mesh can be stored as location data. If you

have many separate meshes in your level, each mesh must be stored in your video card's memory,

which is why newer, more powerful video cards are so important for gaming with the Unreal Engine.

Because a static mesh can be instanced multiple times, you can fill your levels with tremendous

amounts of rich detail. Computationally, meshes carry far less overhead than the world geome

try of your levels. In fact, many levels made with the Unreal Engine are mostly composed of mas

sive, open BSP shells, which are then filled with static meshes to create the actual physical detail.

Static meshes are also used for more than decoration. Many static meshes are designed with more

practical purposes in mind. For example, you can make a static mesh to generate walkways or lifts to

help players move throughout your levels. Later in this chapter, you see how to create a series of cat

walks that can be snapped together to create an intricate series of walkways throughout your levels.

Preparing to Model
As mentioned in Chapter 3, "Creating Your First Level with UnreaIEd," the grid is important when

working in UnrealEd. Your BSP brushes and static meshes look much better if they are accurately

snapped and aligned to the grid, so you should make sure your Maya models are created on a sim

ilar grid. In the following sections, you see how to set up Maya's grid for easy transfer of models

from Maya to Unreal. You also learn how to create a new Maya project to help organize how your

files are saved.

Adjusting the Grid

As a reminder, one Maya unit is equal to one Unreal unit. As you have seen in Unreal, the grid is

always divided into multiples or factors of 16. You can establish the same setup in Maya by adjust

ing the default grid. In TUTORIAL 20.1, you change Maya's grid to match the UnrealEd grid

exactly. By doing this, you can create meshes that snap exactly from end to end so that you can

create a seamless series of catwalks.

TUTORIAL 20.1: Setting Up the Grid

20~

1. When you open Maya, you see the default grid. you could use this grid to construct your
static meshes, but you would probably need to scale them up after you import them into
Unreal. Instead. YOU'll make the grid larger.

2. From the main menu, choose Display> Grid> options box [Q] to open the Grid Options
dialog box.

3. Using the formula discussed earlier, you need to set the grid to give you one major line every
16 units. In the Grid Lines Every text box, enter 16. You also need to enlarge the grid as a
whole. In the Length and Width text box, enter 1024 (see FIGURE 20.1). You can also adjust

--- ---" - -----
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the grid line colors and the number of
subdivisions to whatever you're com
fortable working with.

4. Click the Apply and Close button at the
bottom, and you'll see your new grid.
There is, however, a problem: If you try
to zoom out far enough to see the
entire grid, you'll notice that it chops off
in the distance (see FIGURE 20.2).

This cut-off view is caused by the
camera's clipping plane. A clipping

plane is a two-dimensional plane that
hides everything behind it. To see the
entire grid, you need to push this clip
ping plane back farther.
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FIGURE 20.1 Updated settings in the Grid
Options dialog box.

FIGURE 20.2 Viewport showing the newly resized grid.

5. From the Perspective viewport's menu, choose View> Camera Attribute Editor,

6. Under the Camera Attributes category,
set the Far Clip Plane attribute to
4000 (see FIGURE 20.3).

You can immediately see the entire grid
surface. as shown in FIGURE 20.4.

7. Repeat steps 6 and 7 for each
orthographic view,

8. Save this scene as
UnrealModeling.mb.

-----_._----

FIGURE 20.3 Far Clip Plane attribute.
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FIGURE 20.4 Viewport with the proper falloff.

END TUTORIAL 20.1

Creating a Project

When using Maya, creating a project is the easiest way to control how and where your files are

saved as you work. If you don't create a project, all files are stored in a default folder, making it dif

ficult to discern which files are associated with your current work. In TUTORIAL 20.2, you learn

how to establish a project in Maya to store files for your static mesh models.

TUTORIAL 20.2: Setting Up Your Project
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4. Click Accept when finished. You have now
created a folder where your files are automat
ically saved when you use Save or Save
Scene As from the File menu. Test this by
choosing File> Save Scene As. Notice that
the path is already set to your new folder.
Save the file as GridSetUp.mb, and You're
ready to begin modeling!

3. In the Name text box of the New Project dialog
box, enter UnrealCatwalkSM (see FIGURE
20.5). For the location, enter any path you like.

1. Continue from TUTORIAL 20.1, or open the UnrealModeling. mb file you saved.

2. You begin by setting your project. A project in
Maya is simply a way to keep track of where
your files are saved when working on a particu
lar scene or a variety of scenes. From the main
menu, choose File >Project > New.

20

FIGURE 20.5 The New Project dialog box.
END TUTORIAL 20.2
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Modeling the Catwalks
Now that you have set up your project and adjusted Maya's default grid, you're ready to begin

modeling. In TUTORIALS 20.3 through 20.19, you see how to create a series of five different

catwalk types. After you import them as static meshes, you can instance them numerous times to

create a variety of different catwalk networks. The following subsections focus on the tutorials for

creating each different model.

Creating the Base Catwalk

The base catwalk is strictly a Maya model and won't be exported into Unreal. Instead, it's used as

a foundation from which to create the other models for your catwalks. In TUTORIALS 20.3

through 20.9, you see how to set up this base model.

You also create the placeholder textures for your model. Materials created in Maya cannot be sim

ply transferred to Unreal. However, placing textures on the geometry of your models enables you

to control how many material slots are available for your model and which polygons those mate

rial slots affect. You'll begin in TUTORIAL 20.3 by creating the floor of the base catwalk.

TUTORIAL 20.3: Modeling the Floor of the Catwalk

1. Continue from TUTORIAL 20.2, or
open the GridSetUp. mb file you
saved earlier.

2. Press F3 to enter the Modeling
menu set, and from the main menu,
choose Create> Polygon Primitives
> Cube> options box. In the
Polygon Cube Options dialog box,
set the following attributes, and
click Create when finished:

Width: 256

Height: 16

Depth: 256

FIGURE 20.6 A polygon cube placed on the grid.

3. The new cube has been created in your viewport. Press 5 to use Shaded mode in the
viewport (see FIGURE 20.6). Also, in the Channel Box, click the name pCubel, and
change it to Walkway.

4. You'll be adding some physical detail to the walkway. For this, assume that the Z-axis
points forward. With the cube selected, press Fll to make faces selectable. Select
the face on top of the cube. In the Polygons Shelf, click the Extrude Faces icon
FIGURE 20.7 shows the Extrude manipulator displayed on the cube.
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FIGURE 20.7 Polygonal face ready for extrusion.

5. Click the red scale handle on the Extrude manipulator, and scale the face up about 50%
(see FIGURE 20.8).

FIGURE 20.8 Polygonal face after first extrusion.

8. Press the G key to repeat the Extrude command. Scale the face down in X, as shown in
FIGURE 20.9.

7. You should now have five faces across the top of the cube. Select the two faces that
straddle the center face (see FIGURE 20.10), and press the G key again.
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FIGURE 20.9 Polygonal face after second extrusion.

FIGURE 20.10 Two faces selected with the Extrude manipulator showing.

8. Because both faces were selected, using the manipulator changes both faces. Scale the
faces down in X slightly, and use the blue arrow to move them both down about 50% into
the cube, as shown in FIGURE 20.11. This should create two depressions similar to tire
tracks.

9. The cube now has several extra faces on its front and back. You need to delete them and
replace them with a single face. To do this, switch to the Top view, and select the topmost
and bottommost faces in the viewport (see FIGURE 20.12). You can do this easily hold
ing down the Shift key and making two marquee selections. After you have the faces
selected, press the Delete or Backspace key to remove them.

~-'"-- --------- ------ --------
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FIGURE 20.12 Faces that need to be deleted.

10. The shape now has a hole on each end. To fill in these holes so that the object looks
solid again, press FiO to select edges, and select one edge at each open end (see
FIGURE 20.13).

From the main menu, choose Edit Polygons> Fill Hole. A single face replaces the holes at
the ends of the shape.

11. Delete your shape's construction history by choosing Edit> Delete by Type> History from
the main menu. In the Channel Box, set Translate Y to -8 to place the top of the Walkway
at the center of the grid (0,0,0), which is also called the origin (see FIGURE
20.14).Finally, save your scene as BaseCatwalk. mb.
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FIGURE 20.13 Two edges have been selected.

FIGURE 20.14 The floor for your catwalk is now complete.

END TUTORIAL 20.3

Now that the floor for the catwalk is in place, it would be nice to have some handrails. In

TUTORIAL 20.4, you see how to place cylinder primitives to act as handrails for your model.
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TUTORIAL 20.4: Building the Handrails

1. Continue from TUTORIAL 20.3, or
open the BaseCatwalk. mb file you
saved. You're going to create two
rails to go on either side of the
walkway.

2. From the main menu, choose Create
> Polygon Primitives> Cylinder>
options box. In the Polygon Cylinder
Options dialog box, set the following
options, and click Create when
you're finished:

20

Radius: 8

Height: 256

Subdivisions Around Axis: 8

Subdivisions on Caps: 0

Axis: Z

3. Move the cylinder up in the Y-axis a
bit so that it's easier to see (see
FIGURE 20.15). You need to make
some more adjustments to the cylin
der in the following steps so that it
works properly for some of the func
tions you'll be doing later.

4. First. the edges on either side of the
rail need to be vertical. To do this,
you'll rotate the cylinder. With the
cylinder selected. switch to the Front
view and press the F key to focus on
the cylinder (see FIGURE 20.16).

5. In the Channel Box, click in the
Rotate Z text box, and enter a value
of 22.5 (see FIGURE 20.17).

FIGURE 20.15 The cylinder is above the
catwalk's base.

FIGURE 20.16 Focusing on the cylinder.
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FIGURE 20.17 Channel Box with the new Rotate
Z value.
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This setting rotates the cylinder so
that the faces on the left and right
sides are perfectly vertical (see
FIGURE 20.18), which will help
tremendously when you make the
9Q-degree turn later in this chapter.

6. You need to move the rail into posi
tion. However, you need to make
sure the rail's upper and outer
edges are snapped to the grid. To
ensure this, you'll relocate the
object's pivot point-the center of
its transformation. With the cylinder
selected, press the Insert key.

Notice that the manipulator for the
object's pivot point changes into a
series of simple lines (see FIGURE ,
20.19). As you move this manipula
tor, you're relocating the pivot.

7. To move the pivot into position,
you'll use snapping--curve snap
ping, in this example. In the Front
view, click the red X-axis of the pivot
manipulator, and the axis then turns
yellow (see FIGURE 20.20).

With the axis selected, hold down
the C key and move the cursor over
the leftmost edge of the cylinder.
MMB-drag slightly, and the pivot
should snap to the left edge (see
FIGURE 20.21).

8. Now click the vertical green (Y)
axis. It should turn yellow, as in
step 7. Again, hold down the C key,
but place the cursor over the hori
zontal edge at the top of the cylin
der. MMB-drag slightly, and the
pivot snaps straight up so that it's
even with the top edge (see
FIGURE 20.22).

FIGURE 20.18 The cylinder rotated 22.5
degrees in the Z-axis.

FIGURE 20.19 The manipulator's appearance in
Pivot Editing mode.

FIGURE 20.20 The manipulator's axis becomes
yellow when clicked.

FIGURE 20.21 Manipulator snapped to the
cylinder's left edge.

._------- -~---.----
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The pivot is now aligned with both
the left and top edges. Press the
Insert key again so that you can no
longer move the pivot.

9. You want the top of the rail to be
about 64 units from the top of the
Walkway. In the Front view, select
the rail. Holding down the X key,
place the cursor over the grid inter
section that's four grid spaces up
and one grid space to the left of the
Walkway's edge, as shown in
FIGURE 20.23.

10. Next, you need to duplicate the rail
and place a copy on the other side.
With the cylinder selected, press
Ctrl+G to place the cylinder in a
group with its pivot at the coordi
nates 0,0,0 (see FIGURE 20.24).

11. With the group (named Groupl)
selected, press Ctrl+D to duplicate
the entire group. You should now
have Group2 selected. In the
Channel Box, set Scale X to -1 to
place the copy exactly on the other
side.

12. Change the name of the two cylin
ders to Rail1 and Rai12. Save your
work.

END TUTORIAL 20.4

FIGURE 20.22 Manipulator aligned with left and
top edges.

FIGURE 20.23 Rail moved into position.

FIGURE 20.24 Cylinder after being added to a
group.

"

You have now created the rails for your catwalk. LogicalJy, you need some sort of support system

to hold the rails in place. In TUTORIAL 20.5, you begin creating these supports by modeling the

anchor for the rail supports.
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TUTORIAL 20.5: Building the Support Anchor

FIGURE 20.26 Bottom-right face selected.

FIGURE 20.25 Your catwalk's progression to this
point.

Cube after faces have beenFIGURE 20.27
scaled down in Z.

Width: 64

Height: 32

Depth: 32

Subdivisions Height: 3

2. Using the skills you have learned,
create a cube with the following
settings:

3. In the Channel Box, set Translate Y
to -32 to position the cube on the
bottom of the walkway.

4. With the cube selected, press Fll
to make faces selectable. Assuming
that the X-axis runs left to right,
select the bottommost face on the
left and right side of the cube.
FIGURE 20.26 shows the bottom
right face selected.

With both faces selected, press the
R key to select the Scale tool. Scale
the faces down slightly in the Z-axis
to produce the results shown in
FIGURE 20.27.

1. Continue from TUTORIAL 20.4, or
open the BaseCatwalk. mb file you
saved earlier. You'll be creating the
anchor that holds the rail supports
in place. FIGURE 20.25 shows
your progress so far.

5. Select the face on the underside of
the cube, and scale it down in Z
even farther (see FIGURE 20.28).
Then use the Move tool (W key) to
move it up along the Y-axis a bit so
that the bottom of the cube looks
rounded (see FIGURE 20.29).

--- --_._.---
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FIGURE 20.28 Bottom face after being
scaled down in Z.

6. Select the face at the top of the cube.
You might need to go into Wireframe
mode (4 key) to see it. Scale the face out
slightly in X. FIGURE 20.30 shows the
results.

7. Change the name of the cube to Anchor,
and save your work.

END TUTORIAL 20.5

FIGURE 20.29 Bottom face after being
moved up in Y.

FIGURE 20.30 The anchor for the rail
supports is now complete.

Now that the anchors are in place, you can add some brace pieces to them to make the structure look

more stable. TUTORIAL 20.6 shows how you can make these pieces using the Create Polygons tool.

TUTORIAL 20.6: Adding Braces to the Anchor

20

1. Next, you add some small braces to
either side of the Anchor. Continue
from TUTORIAL 20.5, or open your
saved file. Switch to the Side view,
and use Shaded mode in the view
port (5 key). Zoom in on the Anchor,
as shown in FIGURE 20.31.

2. From the Polygons menu, choose
Create Polygon. Click three times to
create a triangle that runs from the
underside of the Walkway to the
Anchor, as shown in FIGURE 20.32. FIGURE 20.31 Zoomed Side view of the Anchor.
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It doesn't matter where you start, but be sure to move in a counterclockwise direction. You
don't need to click a fourth time to close the triangle; instead, simply press Enter to com
plete the creation process.

695

I.

,

f
l

NOTE
It doesn't matter if your polygon passes into the
floor or the anchor objects.

3. Switch back to the Perspective view.
With the new polygon selected, click
the Extrude Faces icon in the Polygon
Shelf. Extrude the shape out in local
Z to add thickness to the triangle
(see FIGURE 20.33).

4. From the main menu, choose Modify
> Center Pivot to place the object's
pivot at its center.

5. Select the shape, and then Shift-select
the Anchor. From the main menu,
choose Modify> Snap Align Objects>
Align Objects> options box. Use the
following settings. and click Align when
finished to center the new triangle
shape on the anchor:

Align in: World X (make sure it's
the only check box selected)

Align to: Last Selected Object

6. Next, you copy the triangular brace.
using the Numeric Input field at the
far right of the Status Line. First,
click the small black down arrow next
to the field. and set the mode to
Relative. Recall from Chapter 17,
·Overview of Maya," that you can col
lapse icon sets in the Status Line to
access other sets.

7. Select the triangular brace. and press
W to enable the Move tool. Don't
move the manipulator! Instead, type
20 in the Numeric Input field. and
press Enter. The triangle jumps 20
units in the positive X direction (see
FIGURE 20.34).

FIGURE 20.32 Polygon creation process after
three clicks.

FIGURE 20.34 The triangle should snap 20
units farther in the X direction.
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8. With the triangular brace selected,
press Shift+D to duplicate the
object and record its next transform.
In the Numeric Input field. type -21'1,

and press Enter. The duplicate
jumps 20 units in the negative X
direction. or back to the brace's orig
inal location (see FIGURE 20.35).

9. Now for a cool trick: Press Shift+D
again. and a new duplicate appears,
already moved 20 units in the same
direction (see FIGURE 20.36).

The benefit of using Shift+D to dupli
cate is that you can make a trans
formation, and it's applied to all
subsequent duplicates. You can use
this technique to create arrays of
objects-that is. long successions
of a single shape.

10. Select all three braces, and press
Ctrl+G to group the braces together.
With the group selected. press
Ctrl+D to duplicate the group. Use
the Channel Box to set the Scale Z
for the new group to -1. This setting
makes braces appear on the other
side of the anchor as well (see
FIGURE 20.37).

11. Rename the braces as brace0
through braceS. Save your work.

END TUTORIAL 20.6

FIGURE 20.35 Two triangular bases 20 units
apart in X.

FIGURE 20.36 Three triangular bases 20 units
apart in X.

FIGURE 20.37 The completed braces for the
Anchor.

.~

The anchors are fully modeled, and it's time to create the rail supports. In TUTORIAL 20.7, you

create these supports by making several extrusions from a polygon cylinder primitive.
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TUTORIAL 20.7: Creating the Rail Supports, Part I

1. Continue from TUTORIAL 20.6, or
open the BaseCatwalk. mb file you
saved earlier. FIGURE 20.38

"-
shows your progress to this point.

2. Using the skills you have learned,
create a polygon cylinder with the
following settings, and click Create
when you're finished:

Radius: 8 FIGURE 20.38 Your catwalk's progression to this

Height: 96
point.

Subdivisions Around Axis: 6

Axis: X
"

3. Move the cylinder down about -30
units in the Y-axis to center it on the,
Anchor (see FIGURE 20.39). Also,
use the Channel Box to rotate the
cylinder 30 degrees in X. This
places a perfectly horizontal edge on FIGURE 20.39 The cylinder passes through the
the top of the object. Anchor.

4. Select the face at either end of the
cylinder. Switch to the Front view,
and click the Extrude button in the
Shelf. Extrude the faces out in local
Z just a few units, and scale them
down uniformly. You can do this by
clicking on any of the manipulator's
cube-shaped ends, and then drag-
ging the pale blue cube that
appears at the center of the manipu-

FIGURE 20.40 The cylinder after the first extrusion.
lator. Your result should be similar
to FIGURE 20.40.

NOTE
Because you selected both faces, using one
manipulator affects both sides of the cylinder.

5. Press G, and pull the extrusion out
about one grid unit in local Z (see FIGURE 20.41 The cylinder after a second

/r-- ....
FIGURE 20.41). extrusion.

'------- --_. _.- ----- -- ~ ----------
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6. Press G again, scale the extrusion
up uniformly, and move it out in
local Z a bit (see FIGURE 20.42).

7. Press G again to create another
extrusion. Move this one out in local
Z to within about one grid unit from
the edge of the Walkway. Then use
the skills you have learned to create
a shape similar to FIGURE 20.43.

FIGURE 20.42 The cylinder after a third
extrusion,

In step 7, try to make sure your shape ends
about one third of a grid unit past the edge of
the Walkway.

8. Change the name of the cylinder to,
Support. Save your work.

'-~

FIGURE 20.43 The completed base of the
catwalk's cylindrical supports.

END TUTORIAL 20.7

Now that the initial shape for the rail supports is complete, you need to "bend" the geometry up

so that it can connect with the rails. TUTORIAL 20.8 walks you through this process using the

Wedge Faces tool.

TUTORIAL 20.8: Creating the Rail Supports, Part II

20

1. Continue from TUTORIAL 20.7, or
open the BaseCatwalk. mb file you
saved earlier. FIGURE 20.44
shows your progress so far.

2. Select the face at one end of the
Support shape (see FIGURE
20.45). It doesn't matter which end
you choose because you'll be
repeating steps 2 through 4 on the
other side in a moment. FIGURE 20.44 Your catwalk's progress to this

point.
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3. Hold down the RMB over the object,
and select Edges from the marking
menu_ Then Shift-select the edge at
the top of the selected face (see
FIGURE 20.46).

4. From the Edit Polygons menu,
choose Wedge Faces> options box.
In the Wedge Faces Options dialog
box, enter the following settings to
create a low-polygon 9D-degree bend
in the support, and click Apply when
you're finished:

Wedge Angle: 90

Wedge Divisions: 3

5. Repeat steps 2 to 4 for the face at
the other end of the Support. This
should give you two 9O-degree
bends, one on each end (see
FIGURE 20.47).

6. Select the new horizontal faces at
both ends of the Support shape,
and use the skills you have learned
to extrude them upward and into the
rails, as shown in FIGURE 20.48.

NOTE
Remember to select both new faces so that
you don't have to do the series of extrusions
twice. Also, if the Supports don't run perfectly
into the bottom of the Rails, don't worry: You'll
see how to fix that next.

7. Save your work.

END TUTORIAL 20.8

___Modelln~theCatwalks

FIGURE 20.45 Choose either face on the
Support.

FIGURE 20.46 Edge at the top of the selected
face.

FIGURE 20.47 After applying the wedge to
both sides, the result should look like this figure.

FIGURE 20.48 Extrude upward to connect the
Supports and Rails.

699
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The next step is editing the shape of the rail supports by using the construction history from the

earlier extrusions. This process is covered in TUTORIAL 20.9.

TUTORIAL 20.9: Using Construction History to Fix the Supports

20

1. Continue from TUTORIAL 20.8, or

open the BaseCatwalk . mb file you
saved earlier. Depending on how you

created the Support, you might have
results that go too far out, as shown

in FIGURE 20.49, or not far
enough to meet up with the Rails,

as shown in FIGURE 20.50.

2. You can fix either problem through

the use of construction history.

Select the Support shape in the

Front view, and activate the Show
Manipulator tool by clicking its icon'

in the Toolbox or pressing the T

key.

3. Next, go to the Channel Box, and

scroll down under the Inputs sec
tion. Find polyExtrudeFace5 and

click it. The Extrude manipulator for
that particular extrusion reappears

(see FIGURE 20.51).

4. Use the local Z move handle to

adjust the Support until it goes
cleanly into the Rail without passing

through the edge of the Walkway, as
shown in FIGURE 20.52.

NOTE
Because you had selected both sides of the
Support when creating this extrusion, you'll
see both sides being fixed. However, keep in
mind that construction history can occasion
ally make your system unstable, so use this
technique in moderation.

FIGURE 20.49 Maybe the Supports go too far.

FIGURE 20.50 Maybe the Supports don't go
far enough.
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FIGURE 20.51 Make sure the manipulator
appears at this location on the extrusion.

5. Select the Support, the Anchor, and all
six Braces, and press Ctrl+G to group
them (see FIGURE 20.53). Rename
this group RallSupport.

6. Draw a marquee selection around the
entire catwalk, and choose Edit > De~te

by Type> History from the main menu to
delete the objects' construction history.

7. Save your work.

END TUTORIAL 20.9

Modeling the Catwalks

FIGURE 20.52 The Supports should line up
perfectly with the Rails.

FIGURE 20.53 The RailSupport group
selected.
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The BaseCatwalk is now complete. From here, you'll use it to construct alJ the static mesh types

covered in this chapter. In TUTORIAL 20.10, you create some basic textures for your mesh.

These textures serve a dual purpose: They give you an idea of what the UV layout looks like, and

they provide material slots in UnrealEd where you can place materials.

TUTORIAL 20.10: Creating the Placeholder Textures

1. Continue from TUTORIAL 20.9, or
open the BaseCatwalk. mb file you saved
earlier (see FIGURE 20.54). In this
tutorial, you establish the placeholder
textures used to designate how many
materials can be applied to the static
mesh and where those materials appear
on the surface. You're not applying the
textures now, just getting them in place
for later use. For simplicity, you'll create
only two materials.

FIGURE 20.54 The BaseCatwalk is finished.

._------_.-.---- - ._._--
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2. From the main menu, choose Window> Rendering Editors> Hypershade.

3. From the Create Bar, MMB-drag two new Lambert shaders into the bottom Work Area (see
FIGURE 20.55). One is named Lambert2, and the other, Lambert3.

FIGURE 20.55 Lambert2 and Lambert3 in the Hypershade window.

20

4. Double-click Lambert2 to open its
Attribute Editor. Next to the Color
field, click the checkered button ~.

In the Create Render Node dialog
box, click Checker.

5. The Attribute Editor changes to
show the attributes of the Checker
node. Click the black field next to
Color2, and set the color to some
shade of blue (see FIGURE
20.56).

6. Repeat steps 4 and 5 for Lambert3,
but this time set the Color2
attribute to a shade of red. When
finished, you should have two new
materials: one blue checker and one
red checker.

7. Save your work. These materials are
used later to designate areas for
materials in Unreal.

END TUTORIAL 20.10

FIGURE 20.56 Pick your favorite blue from the
Color Chooser.
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You have now completed the base model for your catwalk systems. In the following subsections.

you learn how to create the actual models to be sent to Unreal as static meshes.

Constructing the Straight Catwalk

In this section, you learn how to create your first model for the static mesh network: a simple

straight section of catwalk. In TUTORIAL 20.11, you'JI use the pieces you made for your base

model to set it up. In TUTORIAL 20.12, you apply the placeholder textures you created earlier.
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TUTORIAL 20.11: Creating the StraightCatwalk

1. Continue from TUTORIAL 20.10, or open the
BaseCatwalk. mb file you saved earlier.

2. From the main menu, choose File> Save Scene
As, and rename the file as StraightCatwalk.

Resaving now prevents you from accidentally
saving over the BaseCatwalk later.

3. In the Status Line at the top of the Maya win
dow, click the Select by Hierarchy and
Combinations icon lEI. Then click any of the
RailSupport group's pieces. The whole group
becomes selected (see FIGURE 20.57).

TIP
Alternatively, you can select any piece of the group, and press
the up arrow key until you have the RaiiSupport group selected.

4. With the RailSupport group selected, go to the
Channel Box and enter 64 in the Translate Z
text box. The RailSupport group jumps to the
new location (see FIGURE 20.58).

5. Next, press Ctrl+D to duplicate the RallSupport
group. In the Channel Box, set the Translate Z of
the newly duplicated group to -64. You now have
two Rail Supports forming a section of the cat
walk (see FIGURE 20.59).

6. Save your work. You have the geometry in place
for your StraightCatwalk.

END TUTORIAL 20.11

FIGURE 20.58 The RailSupport
group snaps in your viewport.

FIGURE 20.59 The two supports for
the catwalk.
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The geometry for the StraightCatwalk has been established. All that needs to be done now is to add the

placeholder textures for use as material slots in UnrealEd. TUTORIAL 20.12 shows how this is done.

TUTORIAL 20.12: Applying Placeholder Textures to the StraightCatwalk

1. Continue from TUTORIAL 20.11, or open the St raightCatwalk. mb file you saved earlier.
You'll be applying placeholder textures onto your catwalk.

2. You need to clean up the texture coordinates for your object. To save time, you do this by
applying an automatic texture mapping to the catwalk. Marquee-select the entire catwalk,
and from the main menu, choose Edit Polygons> Texture> Automatic Mapping.

3. As you place materials in Maya, you're simply designating which faces receive a specific
material in Unreal. The checkered textures you created don't appear in Unreal at all. They

are simply a way to indicate which materials are placed where.

NOTE
I

'.I

In the Toolbox, click the HypershadejPersp
icon to open the Hypershade window with
the Perspective viewport directly beneath it
(see FIGURE 20.60).

.;~

-
Step 2 doesn't create perfectly efficient tex
ture coordinates (called UVs), but it keeps

your textures from becoming too stretched.

20

FIGURE 20.60 The Hypershade and Perspective view layout.

4. Any material applied to your object is considered a placeholder, which means the default
material (Lambert1) already allows you to place one material when you get the mesh into
Unreal Ed. Therefore, you'll use the other two ma!erials to add decoration. Begin by select
ing the two Support objects (not the groups), as shown in FIGURE 20.61.

5. Hold down the RMB over the Lambert2 node in the Hypershade window, and choose Apply
Material to Selection. Press 6 on the keyboard to see the result (see FIGURE 20.62).

6. Use the same technique to apply Lambert3 to both Rail objects (see FIGURE 20.63).

7. You can also apply materials on individual faces. Select the Walkway object, and make
faces selectable by pressing F11. Then select the faces at the bottom of the recessed
tracks (see FIGURE 20.64).
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FIGURE 20.61 Avoid selecting the
Anchors.

FIGURE 20.62 You can see all the materials
on your objects in the viewport.

f
I
~.

FIGURE 20.63 You now have one material
on the Rails and another on the Supports.

FIGURE 20.64 The two faces have been
selected.

Again, right-click on Lambert3 and apply it to the selection. The red checkered material
appears only on the selected faces (see FIGURE 20.65).

8. Use this method to apply the Lambert3 (red checkered) material to bands of polygonal
faces on the Supports. Also, apply the blue checkered material to the thin strips along the
tracks of the Walkway and to the Braces on the bottom of the Walkway. FIGURE 20.66
shows the results.

FIGURE 20.65 The two faces now have
a checkered material applied.

FIGURE 20.66 The StraightCatwalk with
all the materials applied.

The placeholder textures are now applied to the object. Take note of the pattern you used for
placing these textures so that you can place them on other static meshes in a similar manner.

9. Save your work.

END TUTORIAL 20.12

---._----------~
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Now that the StraightCatwalk has been textured, it's almost ready to send into UnrealEd. First,

however, the objects that make up the StraightCatwalk need to be combined to a single mesh, and

the model as a whole needs to be converted to trianguJar polygons. TUTORIAL 20.13 covers

these tasks.

TUTORIAL 20.13: Preparing the StraightCatwalk for Export

1. Continue from TUTORIAL 20.12,
or open the StraightCatwalk. mb

file you saved earlier. You're going to
make the StraightCatwalk ready to
export in TUTORIAL 20.21.

2. To begin, you need the entire cat
walk to be a single object. To do
this, marquee-select the entire
object, and choose Polygons>
Combine from the main menu. MaY,a
now considers the catwalk to be a
single object.

3. In the Channel Box, rename the

object as StraightCatwalk.

4. Next, you need to convert the mesh
into triangles because UnrealEd does
n't accept four-sided polygons. To do
this, choose Polygons> Triangulate
from the main menu. FIGURE 20.67
shows the results.

FIGU RE 20.67 Your triangulated StraightCatwalk.

NOTE
The Exporter plug-in has an option for automatically
triangulating an object. However, triangulating in Maya
is far more efficient, especially for concave objects.

20

6. Finally, delete the object's construction history by choosing Edit> Delete By Type> History.

6. Save your work. The StraightCatwalk is now ready for export.

END TUTORIAL 20.13

Making a Ramp

In TUTORIAL 20.14, you use a quick modeling trick to turn your straight section of catwalk into

a ramp. You do this with a lattice. which, when applied to a model, enabJes you to manipulate

many vertices of the model as a single unit. You also take advantage of the Numeric Input field in

Maya's Status Line.

_._-- . --.------

.,-0
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TUTORIAL 20.14: Creating the RampCatwalk

1. Continue from TUTORIAL 20.13,
or open the StraightCatwalk. mb

file you saved earlier (see FIGURE
20.68). You'll use the

I StraightCatwalk to create the ramp.

~
2. From the main menu, choose File>

Save Scene As, and rename the file
as RampCatwalk. mb.

3. You'll be turning the StraightCatwalk
" into a ramp by using a lattice-a

r new technique. First, select the cat-
walk, and switch to the Animation FIGURE 20.68 The progress so far on the
menu set by pressing the F2 key. StraightCatwalk. "

4. With the catwalk still selected,
choose Deform> Create Lattice>
options box. In the Lattice Options
dialog box, set Divisions to 2, 2, 2
and select the Autoparent to
Selection check box. Click Create
when finished.

5. A green box representing the lattice
appears around the catwalk. As you
edit the vertices of the lattice, you
also change the shape of the cat-
walk. Hold down the RMB over one

~
of the lattice's lines, and choose FIGURE 20.69 Select lattice Point from the

Lattice Point from the marking menu marking menu.

(see FIGURE 20.69).

6. You can now select the four lattice points at the front of the catwalk (see FIGURE 20.70),

I which is designated by the positive Z direction.

7. Activate the Move tool with the W key. Then set the Numeric Input field in the Status Line

L
to Relative, and enter 0 64 0. Note that you should enter spaces between each number.

8. The catwalk changes into a ramp because the lattice points at one end have been moved
up (see FIGURE 20.71). Remember that lattices can be used to reshape entire models,
saving you tremendous amounts of work.
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FIGURE 20.71 Your second catwalk is this RampCatwalk.

Delete the catwalk's construction history to remove the lattice. Also, be sure to rename
the catwalk in the Channel Box as RampCatwalk.

9. Save your work.

END TUTORIAL 20.14

Making a Turn

20 In this section, you learn how to create a 90-degree turn section for your catwalks. This section

fits perfectly to the end of the straight or ramp parts you created earlier. In TUTORIALS 20.15

through 20.17, you use the base mesh you saved at the beginning of this chapter to create the

turn section.

.-_._-_. __ .._--~_ .. - --- - -.. ---_-._._~..... _.-------
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TUTORIAL 20.15: Modeling the gO-Degree Turn, Part I
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1. In this tutorial, you'll be creating the
90-degree turn section's static
mesh. As you do this, you'll notice
that some of the extra work you did
on the BaseCatwalk saves you time
and effort now. To start, open the
BaseCatwalk. mb file you saved ear
lier (see FIGURE 20.72).

2. From the main menu, choose File>
Save Scene As. Save the file as
90DegreeCatwalk.

3. Select the RailSupport group by
selecting the Rail or Anchor pieces
and pressing the up arrow key. In
the Channel Box, enter -64 for the
group's Translate Z attribute.

4. Press the F3 key to enter the
Modeling menu set. Select the
Walkway and both Rail objects.
Choose Polygons> Combine from
the main menu to make the three
pieces a single object (see
FIGURE 20.73).

5. Switch to the Top view. Select the
new combined object, and press the
F key to frame it in the viewport.
Press the F9 key to make vertices
selectable, and select the row of
vertices at the bottom of the view
(see FIGURE 20.74).

6. With the vertices selected, activate
the Move tool with the W key. Click
the blue Z-axis arrow to highlight it.
(If you don't select the Z-axis before
you snap, all the vertices snap to a
single point.) Next, hold down the X
key to enable grid snapping. Place
the cursor over the center of the
grid and MMB-drag very slightly to
snap all the vertices back to the X
axis. FIGURE 20.75 shows the
results.

FIGURE 20.72 The BaseCatwalk.

FIGURE 20.73 The Walkway and Rails have
merged.
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FIGURE 20.74 Use a marquee to select all the
vertices at once.

FIGURE 20.75 You just truncated half the object.
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7. Go back to the Perspective view. As

a reminder, you're assuming that the

Z-axis is pointing forward. With this

in mind, select the outermost verti
cal edge at the front of the right·

hand Rail (see FIGURE 20.76).

8. Click the Extrude Edge icon in

the Polygons Shelf. This tool works

the same way as Extrude Face. In

the Channel Box, under the Inputs
section, click the PolyExtrudeEdgel

entry. Set Translate X to -64. Scroll

down and set Divisions to 2 to place
an extra face on the new·extrusion.

FIGURE 20.77 shows the results
of these settings.

9. Of the two faces on the edge extru
sion, select the face closest to the
railing, and press the Delete key to

remove it (see FIGURE 20.78).

10. Save your work,

END TUTORIAL 20.15

FIGU RE 20.76 The edge should be on the ~
plane.

FIGURE 20.77 The result of extrUding an edge.

FIGU RE 20.78 Deleting the face leaves a gap
between the extrusion and the railing.

20

TUTORIAL 20.16: Modeling the gO-Degree Turn, Part II

1. Continue TUTORIAL 20.15, or open the 90DegreeCatwalk. mb file you saved earlier.

FIGURE 20.79 shows your progress so far.

2. Now you're going to create the gO-degree bend in the catwalk. Select the floating face
created from the edge extrusion at the end of TUTORIAL 20.15. Also, Shift-select the

face at the front of the Walkway and both faces at the front of the Rail shapes (see
FIGURE 20.80).



r

Next, hold down the RMB over the
object, and choose Edges from the
marking menu. Shift-select the edge
on the outside of the floating face
(see FIGURE 20.81).

3. With the edge and all the faces
selected, go to the main menu, and
choose Edit Polygons> Wedge
Faces> options box. Use the follow
ing settings, and click the Wedge
Face button when finished:

Wedge Angle: 0

Wedge Divisions: 6

~TE

In step 3, you're actually going to use a neg
ative wedge angle, but the Options dialog box
doesn't allow negative entries.

4. In the Channel Box, click the
PolyWedgeFacel entry. Set Wedge
Angle to -90. FIGURE 20.82

shows the results.

,..t!~TE . "" ~ ~

Depending on which side of the catwalk you
have been working on, you might need to set
the Wedge Angle to 90 instead of -90.

5. With the faces still selected, click
the Extrude Faces icon in the
Polygons Shelf. Don't move the
manipulator! Instead, go to the
Channel Box, click the
PolyExtrudeFacel entry, and set
Translate X to -128. FIGURE 20.83

shows the results of this extrusion.

FIGURE 20.79 Your 90DegreeCatwalk's
progression to this point.

FIGURE 20.80 Four faces selected.

FIGURE 20.81 The selected edge.

FIGURE 20.82 You've just added the
90-degree turn to your catwalk.
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6. As you rotate around the model, you
might notice some hard edges on
the Walkway or Rails. These hard
edges look darker than the rest of
the catwalk. FIGURE 20.84 shows
an example of this phenomenon.

To fix the hard edges, select the
combined object. From the main
menu, choose Edit Polygons>
Normals> Soften/Harden> options
box. In the Soften/Harden Options
dialog box, set the Angle attribute to
30. This setting smoothes the edge
between all faces that meet at a 30
degree angle or less. Incidentally, it
also removes the darkened areas
from the catwalk.

7. Make faces selectable by pressing

F11, and delete the faces that make
up the extra floating piece created
from the edge extrusion earlier, as
shown in FIGURES 20.85 and
20.86.

8. Select the RailSupport group, and
press Ctrl+D to duplicate it. In the
Channel Box, enter the following
values to place the new copy on
the other side of the bend (see
FIGURE 20.87):

Translate X: -272

Translate z: 208

Rotate Y: 90

FIGURE 20.83 Your 90DegreeCatwalk's
Walkway and Rails are now complete.

FIGURE 20.84 A model with hard
edges.

FIGURE 20.85 Select the floating face.

FIGURE 20.86 Press the Delete key to
remove the floating face.
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9. Create another duplicate of the
RailSupport group, and enter the fol
lowing values in the Channel Box to
place a RailSupport in the middle of
the bend (see FIGURE 20.88):

Translate X: -61.5

Translate Z: 146.5

Rotate Y: -45

10. Save your work.

END TUTORIAL 20.16

FIGURE 20.87 Your 90-degree turn
now has two RaiiSupports.

FIGURE 20.88 Your 90-degree turn
now has three RailSupports.

TUTORIAL 20.17: Modeling the gO-Degree Turn, Part III

1. Continue from TUTORIAL 20.16,

or open the 90DegreeCatwalk. mb

file you saved earlier. FIGURE
20.89 shows your progress so far.

2. First, draw a marquee selection
around the entire catwalk. From the
Polygons menu, choose Edit
Polygons> Texture> Automatic
Mapping.

3. Take a few minutes to apply the
placeholder textures in the same
pattern as you did for the
StraightCatwalk (see FIGURE

20.90). Refer back to TUTORIALS
20.12 and 20.13 if you need help.

--~--------- ---

FIGURE'20.89 Your 90DegreeCatwalk's
progression to this point.
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4. Before you go any further, be sure to
save your scene. Then choose File>

Save Scene As, and save a copy of
the file. Name the copy

T_Intersection. mb. You'll use this

file later to create the intersection.

5. Marquee-select all pieces of the cat

walk, and choose Polygons>

Combine from the main menu. Delete
the new object's construction history,

and rename it NinetyDegree.

NOTE
Object names in Maya cannot begin with a
number, although scene names can.

6. Choose Polygons> Triangulate to tri;
angulate the object (see FIGURE
20.91).

7. Choose File> Save Scene As. Set

the name back to
90DegreeCatwalk. mb, and click

Save. When asked if you want to

replace the existing file, click Yes.

END TUTORIAL 20.17

Building aT-Intersection

FIGURE 20.90 The 90DegreeCatwaik should
look like this with placeholder textures.

FIGURE 20.91 Your triangulated
NinetyDegreeCatwalk.

20

Now that you have created a 90-degree turn, creating the T-intersection is easy. In TUTORIAL 20.18,

you see how to construct a fuUy snappable intersection model.

TUTORIAL 20.18: Creating the T-Intersection

1. Open the T_Intersection.mb file you saved earlier (see FIGURE 20.92). You'II use this
file to create aT-intersection.

2. Select the RailSupport group that was placed at the catwalk's bend, and delete it (see
FIGURE 20.93).

Next, select the remaining pieces of the catwalk, and combine them with Polygons>
Combine.



3. From the Edit Polygons menu,
choose Cut Faces Tool > options
box. In the Cut Faces Options dialog
box, enter the following settings to
remove the left half of the catwalk
(see FIGURE 20.94), and click Cut
when you're finished:

Cut Direction: Custom Cut

Cut Plane Rotation: 0 -90 0

Delete the Cut Faces: Select this
check box

4. Select the curving faces of the out
ermost rail, as shown in FIGURE
20.95, and delete them, as shown
in FIGURE 20.96.

5. Next. you want to straighten out the'
curving edge of the Walkway. To do
this, you use a MELScript command
entered in the Command Line.
(Maya Embedded Language is an
internal programming language on
which all of Maya's commands are
structured.)

First, switch to the Top view and
select the six vertices that make up
the curved edge of the walkway, as
shown in FIGURE 20.97.

6. In the Command Line at the bottom.
enter the following command:

move -a -z 336

This command tells Maya to move
the selected components in
absolute coordinates and place
them at 336 in the Z-axis. The
result should look like FIGURE
20.98.

Modeling the Catwalks 715

FIGURE 20.92 The NinetyDegreeCatwalk
geometry is used to create the T-intersection.

FIGURE 20.93 Now there are only two
RailSupports on the catwalk.

FIGURE 20.94 A piece of the catwalk has been
truncated.

FIGURE 20.95 The rail before deleting faces.

.,

~---- --------_. - .. _.... - .. _----
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7. Return to Object mode (F8 key).
With the entire object selected,
choose Polygons> Mirror Geometry
> options box. In the Polygon
Mirror Options dialog box, set the
following:

Mirror Direction: +X

Merge with the Original: Select
this check box

Connect Border Edges: Select
this option

Click the Mirror button when fin
ished. These settings mirror the
object across the YZ plane in the
positive direction and connect the
mirrored object to your original.

CAUTION ........., ~ ~ .~

If you deleted the wrong half of the walkway,
you might need to set Mirror Direction to -x.

8. Delete the object's construction his
tory. Then choose File> Save Scene
As, and save a copy of the file.
Name this new file
FourWayCatwalk.m~

9. Use the skills you have learned to
triangulate the catwalk. Rename
the object as T_Intersection.
Finally, choose File> Save Scene
As, and save the file as
T_Intersection. mb. Overwrite
the existing file. FIGURE 20.99
shows the final results.

END TUTORIAL 20.18

FIGURE 20.96 The rail after deleting faces.

FIGURE 20.97 Select these vertices.

FIGURE 20.98 The edge has been straightened.

FIGURE 20.99 The T-intersection catwalk.

':,
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In this section, you create a four-way intersection model from the T-intersection. You use a tech

nique simiJar to to the one for creating the 90-degree turn. With the completion of this model,

you're nearly ready to export your models to Unreal.

In TUTORIAL 20.19, you see how to use the same geometry in the T-Intersection catwalk to

create a four-way intersection.

TUTORIAL 20.19: Creating the Four-Way Intersection

l

1. Open the FourWayCatwalk. mb file you
saved earlier. You'll use this file to create a
four-way intersection. FIGURE 20.100

shows your progress so far-

2. From the Edit Polygons menu, choose Cut
Faces> options box. In the Cut Faces
Options dialog box, enter the followin~ set
tings to chop off the back Rail of the
Walkway (see FIGURE 20.101), and click
Cut when you're finished:

Cut Direction: Custom Cut

Cut Plane Center: 0 0 208

Cut Plane Rotation: 0 180 0

Delete the Cut Faces: Select this
check box

3. Select the object, and from the main
menu, choose Polygons> Mirror Geometry
> options box. Set the following options,
and click Mirror when finished (see
FIGURE 20.102):

Mirror Direction: +Z

Merge with the Original: Select this
check box

Connect Border Edges: Select this
option

4. Triangulate the model, and rename it as
FourWay. Delete its construction history,
and save your work.

END TUTORIAL 20.19

----- ---- -- ------

FIGURE 20.100 The T-intersection
catwalk, saved just before triangulation at
the end of TUTORIAL 20.18.

FIGURE 20.101 The back Rail of the
catwalk has been truncated.

FIGURE 20.102 The four·way catwalk.
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Collision Models
When creating your static meshes, creating a custom collision model for your mesh is a good idea.

If you don't, all collisions on your new static mesh are calculated on a per-polygon basis, which

can slow down game speed drastically. Best of all, if created correctly, a collision model remains

invisible by default, meaning that it simplifies your collisions without hiding or obstructing your

existing geometry. In TUTORIAL 20.20, you learn how to create a collision model for the

StraightCatwalk model you created earlier. From there, you use the skills you have learned to cre

ate collision models for the other catwalk models.

TUTORIAL 20.20: Creating a Collision Model for the StraightCatwalk

20

1. Open the St raightCatwalk. mb file
(see FIGURE 20.103). In this tuto
rial, you'll be creating the collision
model for the StraightCatwalk. You
then use the skills you have learned
throughout this chapter to construct
collision models for the other cat
walks.

2. The idea is to keep your collision
models much simpler than your
actual geometry. To do this, create
a polygon cube with the following
settings:

Width: 256

Height: 16

Depth: 256

Subdivisions Width: 1

Subdivisions Height: 1

Subdivisions Depth: 1

3. In the Channel Box, set Translate
Y to -8. This cube serves as the
collision model for the floor (see
FIGURE 20.104).

FIGURE 20.103 The StraightCatwalk.

.FIGURE 20.104 The collision model for
the floor is ready.
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4. To create collision models for the Rail objects. create a new cube with the following
settings:

Width: 16

Height: 64

Depth: 256

.
r

5. In the Channel Box. place the cube
at the following coordinates:

Translate X: 136

Translate Y: 32

Translate Z: 0

Duplicate this cube, and set the
duplicate's Translate X to -136.

FIGURE 20.105 shows the
results.

6. Create two cubes with the following
/-. dimensions:

Width: 64

Height: 25

Depth: 32

FIGURE 20.105 The collision models for the
Rails are set up.

''':,.

Place the cubes at the following coordinates to provide collisions for the Anchors under
the Walkway:

First Cube

Translate X: 0

Translate Y: -30

Translate z: -64

Second Cube

Translate X: 0

Translate Y: -30

Translate Z: 64

7. Select all five of the new cubes you
have created. They are named pCube1
through pCube5. Use the skills you
have learned to combine them into a
single object. Rename the object as
MCDCX_Collision, and triangulate it.

NOTE
The MCDCX prefIX is important. It tells UnrealEd that
this model is a collision hull and keeps it from being
visible in the game.
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8. With the new collision model
selected, Shift-select the
StraightCatwalk object. It might be
easier to do this in Wireframe mode.

9. Next, press P to parent the collision
model to the catwalk. This step is
essential, as this collision model
must be exported with your base
model.

10. Use the skills you have learned in
this chapter to create collision mod
els for the rest of your catwalks.
Remember to keep them as simple
as possible. and always name them
by using the MCDCX prefix. Parent
each collision model to its respec
tive base model when finished, and
save your work. FIGURES 20.106

and 20.107 show collision models
for the other meshes.

END TUTORIAL 20.20

FIGURE 20.106 The collision model for the
RampCatwalk.

FIGURE 20.107 The collision model for the
90DegreeCatwalk.
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Exporting Models to UnrealEd
Now that you have completed all your models, you need to get them into UnreaJEd so that you

can actually place them in a level. To do this, you use the Unreal Tournament 2004 Exporter plug

in included with this book or with the UT2004 game. TUTORIAL 20.21 introduces you to how

this exporter program is used to send your meshes to UnrealEd.

TUTORIAL 20.21: Exporting Static Meshes from Maya into UnrealEd

1. Now that you have all the static meshes' completed, you can export them to UnrealEd. To
begin, open the StraightCatwalk. mb file you saved earlier (see FIGURE 20.108).

.
2. Using the aforementioned UnrealEd Exporter plug-in, select the UnrealEdExport tab in the

Shelf.

3. Click the Connect to UnrealEd icon . If you don't already have UnrealEd running. the
plug-in starts it for you.

4. Select the StraightCatwalk model, and click the Static Mesh Export button
Static Mesh Export dialog box.

to open the
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Exporting Models to UnrealEd

FIGURE 20.108 The StraightCatwalk with collision model.

5. In the Package drop-down list, select Create New Package. In the New Package dialog box
that opens. enter MyCatwalks. Click OK when finished.

6. Select Create New Group, and enter Catwalks1 in the New Group dialog box.

Note that the name of the object. StraightCatwalk, has already been placed in the Name
text box. Leave the Relative/World Space radio buttons set to Relative.

7. Click the Export button. You see a return message in the gray area of the Command Line
at the bottom of the Maya window. which should say Result: Export Complete.

8. Repeat these steps for each mesh you have created. When you're finished. all the meshes
will be in UnrealEd. In TUTORIAL 20.22, you see how to access these meshes and
apply textures to them. You can close Maya now.

END TUTORIAL 20.21

Texturing Your Static Meshes in UnrealEd

After all your meshes are available in UnrealEd, you need to apply textures to them. This is where

the placeholder textures you applied earlier come in handy. In TUTORIAL 20.22, you see how

to use the Textures browser and the Static Mesh browser to select and apply textures to your new

static meshes.

721
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TUTORIAL 20.22: Applying Textures to Static Meshes

1. Continuing from TUTORIAL 20.21, open the Static Mesh browser, and use the Package
drolXlown list to switch to the myCatwalks package.

2. All your static meshes are listed on the left side. Click the StraightCatwalk mesh to
select it. Notice that it is currently textured with the default green bubbly texture (see
FIGURE 20.109).

r.

~=.::.U;;; r.

FIGURE 20.109 The meshes are now accessible in the Static Mesh browser.

3. Switch to the Textures browser. Open the Chapter20. utx package, and locate the
Walkway texture. Back in the Static Mesh browser, expand the Materials category for the
StraightCatwalk mesh, and then expand Material [0]. Click the Texture property, and click
the Use button. If you don't see the result right away, move the browser's viewport to
update it.

4. Repeat this procedure to place the Rail texture in the Material [1) Texture property and the
Deco texture in the Material [2] Texture property. The StraightCatwalk is now textured (see
FIGURE 20.110).

5. Next, use the same techniques to apply textures to the other meshes. Depending on the
order in which you applied the placeholder textures. you might need to change the order in
which you apply the textures. Just make sure they all appear to be textured in the same
fashion.

6. Choose File> Save from the Static Mesh browser menu. Name the file MyCatwalks, and
click Yes when asked to overwrite.

---.....
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FIGURE 20.110 The first catwalk is now textured.

END TUTORIAL 20.22

Congratulations! Your static meshes are now ready to be placed in a level. Because you created

each mesh by keeping it snapped to the grid, you'll find that you can place the meshes perfectly

end to end while leaving UnrealEd's snap grid at a high setting, such as 32 or 64. You can use them

in a level.

Summary
By now, you should be reasonably comfortable with the methods for creating a model in Maya

and exporting it to UnrealEd. You have learned not only the modeling process, but also adding

placeholder textures to your model and importing them into an Unreal level. In Chapter 21,

"Character Modeling," you learn how you can model your own character in Maya to be used in

Unreal Tournament 2004.

- .---~~--_._-------
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Chapter

Character Modeling

This chapter discusses the steps for creating your own characters to

be placed within the Unreal Engine. Throughout this chapter, you

see how to model a complete game character. There are, however, a

couple of things you should keep in mind. First, for the purpose of

this chapter, the character you'll be working on is relatively simple,

without complex armor, decorations, or even any facial detail. This

has been done to keep tutorials straightforward so that you can cre

ate a character that's easy to visualize.

Second, this chapter covers modeling techniques in general terms.

This means that step-by-step processes for the exact placement of

each vertex of the model aren't demonstrated. To put it more

bluntly, this chapter assumes that you already have a working

knowledge of modeling tools. This has been done primarily to sim

plify the chapter and prevent it from becoming too excessive. Also,

the steps for this chapter's tutorials progressively become less

detailed, reflecting your increasing experience with the modeling

process.
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If you're new to modeling or are still uncom

fortable with the polygon modeling tools and

techniques in Maya, be sure to turn back to

Chapter 18, "Polygonal Modeling Tools."

Remember that only time and ,practice can

make you feel comfortable with modeling.

Preparation

NOTE
As this chapter is fairly straightforward, it becomes
mainly tutorial based after you begin modeling.

This section explains how to prepare for a modeling project. You should never simply dive into a

modeling project without having planned what you're going to do. To help with this planning

process, a few simple guidelines are offered in the following sections; you can follow these guide

lines to help you get started modeling as soon as possible.

In Chapter 2, "The Process of Game Development," you learned how to develop the story for your

game. During this phase, you also develop the stories and backgrounds behind each character.

Because this topic has already been covered, this chapter and subsequent ones focus more on the

actual creation process rather than on plot and character development.

Concept Art

Before you begin modeling, knowing what your character is going to look like is a good idea. You

probably already have a general idea of the kind of character you want to make; however, you'll

find it much easier to make important decisions about the character's design, posture, and even

its texture and animation if you've already made plans in each of these areas. To this end, creat

ing conceptual drawings of your character is a good idea. If you're not skilled at detailed drawing,

these conceptual sketches can be anything: general sketches of the way your character looks, sep

arate sketches of important pieces of the character's equipment, or anything else you deem

important to the character's look.

If you're already comfortable with pencil and paper, however, you'll find it's helpful to expand

your conceptual drawings to include dynamic action poses, stance and posture drawings, and

anything else that helps you remember not only what the character looks like, but how the char

acter is intended to move and behave.

Image Planes

After you've drawn exactly what the character should look like, you can use those drawings as a

basis to create your 3D model. To accomplish this, you need to create a pair of schematic-style

drawings of your character: one from an orthographic side view, and the other from an ortho

graphic front view. You can then download these images into Maya and use them to derive the



FIGURE 21.1 On the left, a side view; on the
right, a front view.
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locations for each polygon of your model. In this section, you see how to create these image

planes and make them visible in the Maya viewport. Again, however, this book isn't intended to

instruct you on drawing techniques, so this chapter offers only a series of guidelines for creating

your own image planes. FIGURE 21.1 shows an example of the pair of image planes used to cre

ate the character in this chapter.

When creating your own image planes,

first keep in mind that all parts of your

character must be aligned in both the front

and side views. With image planes, you'll

constantly reference parts of the model

from one view to the next. If, for example,

your character's head is taller in one image

than it is in the other, you could run into a

severe problem: The model would line up

with one image but not with the other. If
you tried to adjust the model to match the.

other image, it would no longer match the

first. This problem can lead to a nightmar

ish cycle of moving back and forth inces

santly between images trying to make your

model look correct.

To avoid this problem from the outset,

make sure you create image planes so that

aU parts of the images line up. For exam

ple, yOll want the characters in both images

to be exactly the same height. You also

want their shoulders, knees, ankJes, waist

line, and so forth to be the same height

from the ground. FIGURE 21.2 is a dia

gram of the two image planes shown ear

lier, but this time with lines running

between the two to demonstrate how each

part of the two images aligns with each

other.

Minor inconsistencies between the two

images are acceptable and can be difficult

to avoid if you're using hand -drawn

image planes. Just remember to keep

FIGURE 21.2 Image planes with lines connect
ing each major part.
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these inconsistencies to a minimum; this precaution makes your modeling experience faster

and easier. For example, if your character's nose goes a tad further down the face in the front

view than it does in the side view, you could compensate by simply averaging the distance

between the two images. Don't let yourself get too hung up with small inconsistencies. As long

as your major proportions are correct, the model should turn out just fine. Besides, you

can always make corrections (commonly known as tweaks) later when your model is near

completion.

Image Plane Set Up

If you have drawn your image planes so that everything is nicely lined up and proportional, set

ting them up in Maya is no problem. Your next job is scanning the drawings into your computer

and verifying that everything is still aligned. Scanning can sometimes lead to small distortions in

your images, depending on where on the scanner's glass you placed the object, whether the scan

ner automatically crops your images, and many other factors.

If you don't have a copy of Photoshop, the final image
planes have been supplied in JPEG format as
CharacterFront (IP) . j pg and CharacterSide( IP) . j pg.

- -NOTE

After scanning your images, you should open them in an application such as Photoshop and ver

ify their alignment. In TUTORIAL 21.1, you see how to do this in Photoshop so that you can be

sure you have accurate image planes. This

tutorial is simply intended to demon

strate a technique, not to go into deep

explanations of what each tool or com

mand is doing.

TUTORIAL 21.1: Aligning Images in Photoshop

1. The images have already been scanned for you, but although the drawn proportions are
correct, you'll see that they don't line up properly with one another. First, start Photoshop,
and then open the files OriginalScanFront. j pg and OrignalScanSide. j pg (see
FIGURE 21.3).

2. Because of scanning, the two images are slightly different sizes. To fix this problem, you
need to get the two images into the same document. First, you need to make the front
image's canvas larger to hold both image,S. Select the front image, and choose Image>
Canvas Size from the Photoshop menu. Set the Width value to 10, and be sure to anchor
the image on the left side, as shown in FIGURE 21.4.

3. Now that the canvas for the front image is larger, it can hold both the front and side
images. Move the side image over to the same canvas by selecting the Move tool and
dragging from the side image to the front image. This creates a duplicate of the side
image as a new layer and places it in the same document as the front image.
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FIGURE 21.3 Both images open in Photoshop.

729

You can change the color of the guide lines by choos
ing Edit> Preferences> Guides, Grid & Slices from the
Photoshop menu.

I·

4. Even though both images are now in
the same document, they are sepa
rate layers, meaning they can be
altered and affected separately. If
you look in the Layers palette, you
can see that Layer 1 is actually the
side view (see FIGURE 21.5). As
long as it's selected, you can use
the Move tool to move the side
image around the canvas without
affecting the front image.

5. You can use this layering to your
advantage, Because you can't cur
rently affect the front view, you can
assume that it's correct and adjust
the side view to match it. First, how
ever, you need to set up some
guides so that you know how to
adjust the side image.

Make sure rulers are visible on the
document. If they aren't, simply

FIGURE.21.4

NOTE

The Canvas Size dialog box.

• L • _ L_.

----- ._--_.. -_.. ---. --- ----- -----_._----
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press Ctrl+R. Click and drag from
the ruler at the top of the screen,
and drag a blue guide down to the
top of the front image's head.
Repeat and place another guide
at the bottom of the feet. Use
FIGURE 21.6 as a guide if you
need help.

6. With Layer 1 still selected, choose
Edit> Transform> Scale from the
menu. While holding down the Shift
key for uniform scaling, drag the
selection's corner markers to scale
the image up so that the top of the
head and bottom of the feet match
the guides (see FIGURE 21.7).
You'll likely have to move the image
as well. To do this, simply drag near·
the middle of the image.

7. Now you need to split the document
apart so that you have two separate
images again. To do this, you use
the Crop tool. First, use the
Navigator to zoom out a bit, just so
that you can see the entire canvas.
Next, select the Crop tool, and make
a cropping selection around the
front image. Make sure the center
marker of the crop selection is cen
tered on the front image, and notice
that the crop runs from the top of
the image to the bottom. (Refer to
FIGURE 21. 7 if you need help.)

8. Press Enter to complete the crop.
Choose File> Save As from the
menu, and save the image as
FrontImage. j pg,

9. Undo the crop by pressing
Shift+Ctrl+Z. Make a new crop in
the side view, and save it in the
same fashion with the name
Side Image. j pg.

END TUTORIIAL 21.1

FIGURE 21.5 Notice that the Layer 1 image is
actually the side view.

')

\

!

FIGURE 21.6 The top and bottom guides in place.

FIGURE 21.7 After using the Scale command, the
side and front views match.

------- --
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Darkening Image Planes

If you leave your image planes white, often you have a hard time seeing the green and pale-blue

wireframe Jines for your model. Instead of spending time changing your wireframe colors, sim

ply darken the image planes to make the wireframe stand out. In TUTORIAL 21.2, you see how

to use a single Photoshop command to make this happen,

TUTORIAL 21.2: Lowering the Image Plane Brightness

1. Continue from TUTORIAL 21.1, or open the two image planes you just saved,

2. With Frontlmage.jpg selected, choose Image> Adjustments> Brightness/Contrast. Set the
Brightness value to -100 (see FIGURE 21.8).

~.,lr!,r:",lll :i:

731

FIGURE 21.8 The Brightness/Contrast dialog box.

3. Repeat the process for the second image'. Save the images as FrontFinal. j pg and
SideFinal. j pg.

END TUTORIAL 21.2

Importing Image Planes Into Maya

Now that your image planes are created, it's time to import them into Maya and use them to cre

ate a model. In the following tutorials, you see how this is done and learn how to make sure the

image planes are properly aligned in the viewports. You'll also learn how to set up a Maya project

to control where your files are being saved.
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TUTORIAL 21.3: Creating a Project in Maya

1. Begin by starting Maya. Before you
bring in the image planes, you need
to create a new project by choosing
File> Project> New from the main
Maya menu.

2. Name the new project
UnrealCharacter, and set an
appropriate path location, such as
C:\ (see FIGURE 21.9). Leave the
rest of the lines blank, as you don't
need to create a folder structure.
Click Accept when done.

3. Next, choose File> New Scene from
the menu to verify that your next
save will be placed in your new pro
ject folder.

END TUTORIAL 21.3
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FIGURE 21.9 Fill in the New Project dialog box
as shown in this figure, using any path location.

Now that your project is set up, you're ready to begin working. You'll start by bringing in the

images you altered in Photoshop so that you can model directly from them. TUTORIAL 21.4

shows you how to do this by using Maya's image planes.

TUTORIAL 21.4: Loading Image Planes in Maya

1. Continuing from TUTORIAL 21.3, make sure you have just started a new scene in Maya.

2. Tap the spacebar while the mouse cursor is over the main viewport to switch to the Four
View layout, as shown in FIGURE 21.10.

3. Choose View> Image Plane> Import Image from the Front viewport panel menu. and
navigate to the FrontFinal. j pg file you saved earlier.

4. As soon as the image plane is visible (this might take a few minutes), set or verify the
following attributes in the Channel Box on the right side of the screen, as shown in
FIGURE 21.11: If an attribute is not specified in a step, leave it at its default value.

Center X: 0

Center Y: 0

Center z: -20

Width: 30

Height: 30
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i·, FIGURE 21.10 The Four View layout.

5. Switch to the Side viewport, and
repeat step 3 to import the
SideFinal. j pg image into the
viewport. Then set the following
attributes in the Channel Box:

Center X: 0

Center Y: 0

Center Z: 0

Width: 30

Height: 30

6. Switch to the Perspective viewport,
and notice that you can now see both
image planes clearly in the viewport
(see FIGURE 21.12). Because you
set the Center X and Center Z attrib-
utes on the image planes, the planes
themselves are offset from the center
of the grid. This means they won't be
in your way if you work in the
Perspective view. Best of all, because
of the nature of orthographic view-
ports, there's no difference in the
Front and Side views when the image
planes are moved out in this manner.

7. Save the file as
UnrealCharacter_Start.mb.

END TUTORIAL 21.4

-----

FIGURE 21.11 Set the attributes as shown in
the image.

FIGURE 21.12 Both image planes are now
visible in the viewport.
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21 The Modeling Process
In this section and the following subsections, you'll be modeling your Unreal character. You can

use many methods for polygon modeling, as described in Chapter 18. For this chapter, you'lJ

model based on preexisting polygon shapes (primitives) to expedite the modeling process and

make the steps easier for you to follow. Keep in mind, however, that the techniques demonstrated

in the following sections are not hard-and-fast rules for character modeling. There are numerous

ways to go about modeling characters, none of which is more or less correct than the next. After

you have experienced modeling on your own, you'll develop your own workflow, which mayor

may not resemble the workflow used in this book. Before you begin the following tutorials, make

sure you're relatively comfortable with manipulating polygon components, especially vertices, in

Maya.

Before you start, read on for a discussion of how modeling from image planes actually works. You

begin by bringing in a piece of geometry, whether it's a cube, a cylinder, or any other object. You

then access the object's vertices and move them so that they appear to be in the same location on

both images. For example, if you position ayertex so that it appears to be on the front of the char

acter's chest in the Front view, you should make sure it seems to be in the same location in the

Side view. If you follow this pattern with all vertices of your model, eventually you get a shape

that strongly resembles your drawing.

Modeling and Animation

An arm with two subdivisions atFIGURE 21.13
the elbow.

When creating a polygon model that will be animated, especially a character, it's important to

know how much physical detail is needed to achieve the look you want and to allow for proper

deformation of the model when animated. If you have too much detail, the model wastes precious

polygons on the screen and is tedious to skin (attach the geometry to the joints). On the other

hand, without enough detail, the geometry, such as arms, legs, shoulders, and hips, looks strange

when bending or flexing. Consider the following example: Try to bend an ordinary drinking

straw. You'll see that it creases and makes a sharp fold. On the other hand, if you do the same thing

with a bend able straw, you get a smoother

fold. The bendable straw has a series of

edges around one section, alJowing the

shape to deform. The same thing is true of

polygonal geometry.

In the example shown in FIGURES 21.13

and 21.14, a simple cylinder-style arm has

been created. The first example has only two

subdivisions along the length of the arm.

The second has four subdivisions, mostly

centered on the elbow area, as that's where

most of the deformation would take place.
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When modeling characters, always keep

in mind what they are intended to do. If

a character is simply going to walk across

your scene, you don't need a tremendous

amount of detail for animation. If, on the

other hand, the character performs a

long series of acrobatic moves, you need

more points of flexibility and more detail

at areas of deformation.

The Character
For this model, you'll use the torso as the

starting point for the modeling process.

It doesn't particularly matter where you

start when modeling; any point you're
comfortable with works fine_

Modeling the Torso

The Modeling Process 735

FIGURE 21.14 An arm with only two extra subdivi
sions added to the elbow. Notice how much better the
arm keeps its volume at the bend.

I'

In TUTORIAL 21.5, you bring in your original shape and rough it out so that it resembles your

character's torso.

TUTORIAL 21.5: Beginning the Torso

1. Open the file UnrealCharacter_
Start. mb that you savec;t earlier, or
simply open the one from the CD.

2. Press F3 to enter the Modeling menu
set, and choose Create> Polygon
Primitives> Cube from the main
Maya menu (see FIGURE 21.15).
Press 5 to use Smooth Shaded
mode in the Perspective Viewport.

3. Switch to the Front view, and then
move and scale the cube to fill the

general proportions of the charac- FIGURE 21.15 The initial cube.
tef's torso. from the base of the
crotch to the top of the shoulder
(see FIGURE 21.16). Keep in mind IP
that you're scaling it only in the You should move the cube only In the Y-axis.
Front view at this time.

~- -----.-
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4. Switch to the Side view, and then

move and scale the cube to fill

the torso volume from the side

(see FIGURE 21.17). You should

move and scale the cube only in

the Z-axis.

5. Next you'll add more subdivisions

to the cube so that you have more

vertices with which to model. With

the cube selected, click in the

Channel Box, under the Inputs se~

tion, on the word polyCube1. This

gives you access to the cube's

Input node, allowing you to alter

its construction history. Set the

following attributes, as shown in

FIGURE 21.18:

Subdivisions Width: 4

Subdivisions Height: 8

Subdivisions Depth: 2

Ior,NOTE
The number of subdivisions used in this model
was calculated based on the amount of geo
metric detail needed for proper animation and
to achieve the desired shape. With time and
practice, you'll be able to gauge how many sub
divisions to use on your own work.

6. Just one thing left to do: deleting

the faces on one side of the charac

ter. Because your character is

almost perfectly symmetrical, after

you model half of the character, you

can simply mirror the other half,

thereby shaving off 50% of your

modeling time.

FIGURE 21.16 The cube filling the torso volume
in the Front view.

FIGURE 21.17 Cube adjusted to fit the Side view.

FIGURE 21.18 Increasing the number of
subdivisions adds more detail to the cube,
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To do this, make faces selectable by
pressing Fll. In the Front view,
select the faces on the right side of
the character (that would be the
faces on the left side of the view
port) and delete them by pressing
Backspace or Delete, as shown in
FIGURE 21.19.

7. Click the cube's name in the
Channel Box. and change it to
Torso. Save your work.

FIGURE 21.19 Half of the cube removed.
END TUTORIAL 21.5

Now that you have the basic geometry in place, it's time to begin modeling it into a torso. In

TUTORIAL 21.6, you start to change this half-cube into a basic torso shape.

TUTORIAL 21.6: Roughing in the Torso

1. Continue from TUTORIAL 21.5, or
open the file you saved at the end of

that tutorial.

2. You need to move the cube's vertices
around so that they line up with the
drawing in the Front view. Make sure
that you marquee-select the vertices so
that you're also selecting the vertices
on the back of the cube. You'll start at
the bottom and work your way up.
Arrange the first two rows of vertices at
the crotch so that they're similar to the
image in FIGURE 21.20. Note that
the vertices at the bottom of the cube
are close, but not on top of one another.

3. Continue up the torso, one row at a
time. Adjust the vertices to line up with
the drawing and to follow the contours
and flow of the character's shape. Use
FIGURE 21.21 to help.

Take a closer look to see where certain
vertices were moved. First, look at the
vertex on the outside edge of the

FIGURE 21.20 Try to follow the contour of the
drawing whenever possible.

FIGURE 21.21 The rest of the vertices lined up
in the Front view.
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waistline (see FIGURE 21.22).
Notice that it's aligned with the pants
rather than the shirt. Later, you'll add
a new edge around the waist to differ
entiate the pants and the shirt.

If you're moving vertices that happen to be on
the seam, be sure not to move them in the X
axis because this causes problems with the
character's seam when the geometry is mir
rored to the other side.

Also notice the vertices at the neck
line (see FIGURE 21.23). The shirt
is being used as the guide for where
the torso ends and the neck begins.

4. Next, you need to adjust the vertice3
in the Side view so that they line up
with the side drawing. Keep in mind
that you should move or scale these
vertices only in the Z-axis because you
have already established their loca
tions in the X- and Y-axes. FIGURE

21.24 shows how you simply go row
by row, moving and scaling the ver
tices to match the drawing's outline.

NOTE"""

Keep in mind that in the Side view, not all rows
of vertices will be in a straight line, depending
on whether you moved some vertices in that
row up or down in the V-axis.

5. Go to the Perspective view, and take a
look at what you've done so far. The
shape is already starting to look a bit
like a torso (see FIGURE 21.25).
Save your work.

6. To see a completed version of this
tutorial. open the UC_TorsoRough. mb

file included on the CD.

END TUTORIAL 21.6

FIGURE 21.22 The vertices at the waistline.

FIGURE 21.23 The vertices at the neck.

FIGURE 21.24 The vertices at the bottom of
the crotch have been scaled toward each other in
the Z-axis.

FIGURE 21.25 The torso completely roughed in.

r--''\
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Now that you have the torso's basic form, it's time to add more detail and continue modeling the

shape to make it match the drawing more closely. In TUTORIAL 21.7, you clean up the shape of

the character's torso.

TUTORIAL 21.7: Refining the Torso

1. Continue from TUTORIAL 21.6,
or open the file you saved at the
end of that tutorial.

2. You'll begin by moving the vertices
at the character's outer edges (cor
ners) to round out the character's
shape, making more efficient use
of the detail you have at hand.
Beginning with the vertices on the
torso's outside front edge, move
them one at a time back in the Z
axis and inward in the X-axis.
You'll see the torso start to take
shape as you do this (see
FIGURE 21.26). Again, use the
drawing as a guide.

3. Repeat step 2 for the column of
vertices at the torso's back outer
edge (see FIGURE 21.27).
Because you don't have a drawing
to follow, you'll likely need to work
in the Perspective view. For now,
use your judgment to round out the
character.

4. Next, use the vertices at the collar
bone area and at the back of the
shoulders to round out the top of
the torso. You might want to follow
the drawing in the Side view. Use
FIGURE 21.28 for help.

FIGURE 21.26 The front outer column of
vertices has been used to round out the torso.

FIGURE 21.27 The vertices at the back have
been used to round out the outer edge.

FIGURE 21.28 The shoulder vertices used to
round the shoulder.

'",
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5. Using a similar technique, round out

the vertices at the base of the
crotch in the Side view, as in
FIGURE 21.29.

6. Take a look at your work in the
Perspective view, and tweak as you
deem necessary. Save your work.

7. To see a completed version of this
tutorial, open the UC_TorsoRefine.
rob file included on the CD.

END TUTORIAL 21.7

FIGURE 21.29 The rounded vertices at the
base of the crotch.

In TUTORIAL 21.8, you make a few more adjustments to the object you have been modeleding

to finaJize the shape of the character's torso.

..

TUTORIAL 21.8: Completing the Torso

1. Continue from TUTORIAL 21.7, or
open the file you saved at the end of
that tutorial. Note that some steps of
this tutorial simply guide you to posi
tion vertices so that the character's
shape looks natural, instead of giving
you detailed instructions.

2. Along the side of the character are
two sets of four faces that need to
be removed to create holes for the
character's arms and legs. If you're
in a Perspective view, they should be
rather obvious; in case you need
help seeing them, however, they're
highlighted in FIGURE 21.30.

Select these faces and press
Backspace to remove them.

3. You should now have two holes in
your geometry. Using the vertices at
the borders of the holes, round out
the shape of the holes so that they
aren't quite as square. Use
FIGURE 21.31 for help, and
remember to keep using the
drawings for reference.

FIGURE 21.30 The faces that need to be
removed.

FIGURE 21.31 Holes rounded out for the arm
and leg.
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4. In the Side view, you should see an
edge near the hem of the shirt.
Align it with the line where the shirt
ends and the pants begin, as shown
in FIGURE 21.32.

5. Use the Split Polygon tool to create
a new edge just above the shirt's
hem. Move around in the
Perspective view and pull this edge
out slightly, one vertex at a time, to
create a more noticeable difference
between the shirt and the pants
(see FIGURE 21.33).

Your torso should now be complete.
Feel free to go back over the model
in the Front, Side, and Perspective
viewports to double-check every
thing.

6. Choose Edit> Delete by Type>
History from the menu to delete
your model's construction history.
From now on, this step is simply
referred to as deleting history. Save
your work.

END TUTORIAL 21.8

Modeling the Legs

FIGURE 21.32 The shirt edge adjusted.

FIGURE 21.33 Splitting polygons creates a
ridge between the pants and shirt.

Because your character is symmetrical, you can get away with modeling one leg. For the purposes

of this model, this process in TUTORIAL 21.9 is fairly simple.

TUTORIAL 21.9: Modeling the Legs

1. Continue from TUTORIAL 21.8, or open the file you saved at the end of that tutorial.

2. To create a leg for your character, first create a polygon cylinder with the following settings:

Radius: 1

Height: 9.5

Subdivisions Axis: 8

Subdivisions Height 8:

Subdivisions Caps: 0

---------- - -------
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3. Move and rotate the cylinder so that
it aligns with the character's left leg
in the Front viewport, as shown in
FIGURE 21.34.

4. Stay in the Front view, and select one
row of vertices at a time. Rotate and
scale the vertices to make them line
up with the image. Your end result
should be similar to FIGURE 21.35.

TIP
For now, leave the row of vertices at the bot

tom of the leg completely flat. Don't worry

about making the vertices follow the contour

of the pants cuff. You'll take care of that after
yo u construct the foot

5. Switch to the Side view, and move
and scale the rows of vertices in the
Z-axis only. Make them follow the
contour of the leg as closely as you
can (see FIGURE 21.36). Again, for
the time being, ignore the shape of
the pant cuff.

6. Create a split that goes all the
way around the knee to add some
detail so that the knee is more
flexible when animated (see FIGURE
21.37). Reshape these vertices if
necessary.

7. Delete the faces that form the caps
(the closed cylinder ends) for the leg.
Select the border edges around the
top of the leg. From the Polygons
menu, verify under Tool Options that
the Keep Faces Together option is
set to On.

8. From the Edit Polygons menu, choose
Extrude Edge. Move the extruded
edges in world space about halfway
to the edge of the hole in the torso
(see FIGURE 21.38).

FIGURE 21.34 The leg cylinder created and
moved into place.
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FIGURE 21.35 The leg vertices adjusted in the
Front view.

FIGURE 21.36 Leg vertices adjusted in the
Side view.

FIGURE 21.37 The Split Polygon tool used to
create another row of vertices.

.-~
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NOTE

FIGURE 21.38 An edge extrusion of the leg
vertices.

FIGURE 21.39 The vertices at the top of the
leg are snapped to the vertices around the leg hole.
It currently looks like you have a single piece of
geometry, but you don't just yet.

FIGURE 21.41 Three vertices underneath the
crotch.

FIGURE 21.40 The objects have been combined,
.and the vertices around the leg have been merged,

.....

TIP

At the bottom of the crotch, notice that three
other vertices split through the crotch area
(see FIGURE 21.41). You can save some
polygons by merging them into the leg ver·
tices, as shown in FIGURE 21.42.

Remember that the protocol for point-snap
ping is to select a vertex, hold down the V key,
move the cursor over the destination point,
press the middle mouse button, and move the
mouse slightly. If this doesn't seem to be
working, verify in your Move tool settings that
you're moving in world coordinates.

9. Extrude the edge again, and this time,

point-snap each vertex to the corre

sponding vertex on the torso (see
FIGURE 21.39). There should be

eight vertices around each hole. Keep

in mind that this step will probably

require Quite a bit of camera rotation

in the Perspective view.

You can use the F8 key to toggle between
Object and Component modes.

11. From the Edit Polygons menu, choose

Merge Vertices> options box. In the

Merge Vertex Options dialog box,

choose Edit> Reset Settings to set

Distance back to its default value of

0.0001. Click the Merge Vertex button

when done. The result is shown in

FIGURE 21.40.

10. Select both the leg and torso in Object

mode, and choose Combine from the

Polygons menu. Go into Component

mode, and select the 16 vertices at the

edge where the leg meets the torso. It

should look like you have only eight ver

tices, but remember that you snapped the

leg vertices on top of the torso vertices.

I"NOTE
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12. Tweak the vertices at the hip to cre

ate a smoother blend into the
crotch. When you're satisfied, delete
your history and save your work.

END TUTORIAL 21.9

FIGURE 21.42 The vertices now merged into
the leg.

Modeling the Arms

Now it's time to create your model's arms. The method you'U be using in TUTORIAL 21.10 is

similar to the way you constructed the leg, so this time you'U move a little faster.

TUTORIAL 21.10: Modeling the Anils

FIGURE 21.43 The arm cylinder in position.

3. Move and rotate the new cylinder
into the position of the arm, as
shown in FIGURE 21.43.

1. Continue from TUTORIAL 21.9, or open the file you saved at the end of that tutorial.

2. To add an arm to your model, first create a polygon cylinder with the following settings:

Radius: 0.5

Height: 6.5

Subdivisions Axis: 8

Subdivisions Height: 7

Subdivisions Caps: 0

I

l_

4. Adjust the vertices of the arm, again
one row at a time. You should move
one row to line up with the end of
the shirt sleeve, and two other
edges should straddle the elbow
(see FIGURE 21.44).

5. Add a new edge around the middle
of the elbow and another just
above the wrist. Also, with the
same technique you used on the FIGURE 21.44 The vertices of the arm cylinder

adjusted in the Front viewport.
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torso to create a separation at the
end of the shirt sleeve, delete the
face at the top of the cylinder, but
leave the face at the bottom.

6. Next, you need to adjust the ver
tices in the Side view. Unfortunately,
you don't have a side view of the
arm available. You'll have to adjust
the vertices based on what you
think the arm should look like.
Add some subtle contours to the
bicep, tricep, and elbow. Use
FIGURE 21.45 as a reference.

7. Select the edge around the top of
the arm. Extrude it out, and then
snap all the vertices to the corre
sponding vertices on the torso.

8. Add two edges around the shoulder,
and use the resulting vertices to
round out the shoulder. Your
results should look similar to
FIGURE 21.46.

9. Now, using the skills you learned in
TUTORIAL 21.9, attach the arm to
the leg by combining and merging
vertices (see FIGURE 21.47). Do

any necessary tweaks, delete the
history, and save your file.

END TUTORIAL 21.10

FIGURE 21.45 A Side view of the modeled arm.

FIGURE 21.46 The shoulder has been adjusted.

FIGURE 21.47 The arm is now complete.

745

Modeling the Feet

Now that the arms and legs are III place, you're ready to model the character's feet. In

TUTORIAL 21.11, you see how to do this.

--------------- -------
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TUTORIAL 21.11: Modeling the Feet

1. Continue from TUTORIAL 21.10,
or open the file you saved at the
end of that tutorial.

2. To add a foot to your character,
first create a polygon cube with the
following dimensions:

Width: 1.5

Height: 1.2

Depth: 1.7

Subdivision Width: 2

Subdivision Height: 1

Subdivision Depth: 1

3. Move the cube into position so that
it surrounds the foot in the Front
viewport. and set it slightly forward
from the heel in the Side view (see
FIGURE 21.48).

4. Select the two faces at the front of
the cube, and extrude them out in
local Z. Change the Divisions setting
for the extrusion to 3. Reshape the
vertices into a more foot-like shape.
Follow the Side view for the profile,
and use your best guess for the
view from above, referring to
FIGURE 21.49 for guidance.

5. Select the large square face on
each side of the foot. Use the
Polygons> Triangulate command to
tessellate them. The triangle edge
needs to slant downward toward
the front of the foot, as in
FIGURE 21.50. Use the Flip
Triangle Edge command, if
necessary.

6. Create a split that runs from the
middle of the edge at the ankle,
around the back of the heel, to the
middle of the edge on the opposite
side (see FIGURE 21.51).

FIGURE 21.48 The cube's position in the Side view.

FIGURE 21.49 The extruded vertices shaped into
a foot.

FIGURE 21.50 The side of the foot triangu-
lated. Make sure the face on the opposite side of
the foot is triangulated in the same fashion, with
the triangle edge slanting down toward the toe.

FIGURE 21.51 Notice that the split runs all
the way around the heel.
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7. Using the vertices you just created,
reshape the heel to align with the
image. When finished. delete the
two faces at the top of the foot,
and adjust the eight vertices to
form a more rounded hole (see
FIGURE 21.52).

8. Extrude the edge around the top of
the foot up once. Next, select the
edges around the end of the pant
leg. and move them straight up to
get them out of your way (see
FIGURE 21.53). When finished. go
ahead and choose Combine from
the Polygons menu to combine the
two models.

9. Now use the Append to Polygon tool
to attach the models together into
one seamless mesh, as shown in
FIGURE 21.54. Simply activate
the tool, click on one of the edges
of the pants. and then click on a
corresponding edge of the foot.
Continue this procedure all the way
around the foot.

10. Now select the vertices from the leg
you moved up earlier. Use the Front
and Side views to line them up with
the pant cuff in the image. as shown
in FIGURE 21.55. Delete history
and save your work.

END TUTORIAL 21.11

The Character 747

FIGURE 21.52 The foot, fully shaped. Note
that the rest of the body is hidden in this image.

FIGURE 21.53 The foot and body are now
attached.

FIGURE 21.54 The foot and leg have now been
attached with faces, forming a single mesh.

FIGURE 21.55 The foot is now complete.
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Modeling the Hand

Your character is taking shape nicely. In TUTORIAL 21.12, you see how to model the character's hand.

TUTORIAL 21.12: Modeling the Hand

1. Continue from TUTORIAL 21.11, or
open the file you saved at the end of
that tutorial.

2. Extrude the two faces at the end of the
wrist out four times to shape them into
a palm and fingers. Use the image as a
guide for the Front view. For the Side
view, use your judgment and refer to
FIGURE 21.56 for guidance.

3. Select the two faces near the wrist,
where the thumb should be. They've
been highlighted in FIGURE 21.57-for
your convenience.

4. Extrude these faces out once. Select
the two vertices of the extrusion that
are toward the back of the hand. as
shown in FIGURE 21.58. Merge them
straight over with their corresponding
vertices; the results are shown in
FIGURE 21.59.

5. Extrude the remaining face out three
more times, and shape the vertices to
form a thumb (see FIGURE 21.60).

6. Make any tweaks you deem necessary.
Delete your history and save. The hand
is complete.

FIGURE 21.59 The vertices of the
thumb after merging.

END TUTORIAL 21.12

FIGURE 21.56 The four extrusions of
the hand reshaped.

FIGURE 21.57 The faces you use to
extrude the thumb.

FIGURE 21.58 The vertices of the thumb
before merging.

FIGURE 21.60 The thumb created.
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Modeling the Head

At this point, the character is looking great, except for one small problem: He has no head! In

TUTORIAL 21.13, you complete this character by adding a head to the model.
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TUTORIAL 21.13: Modeling the Head

1. Continue from TUTORIAL 21.13, or open the
file you saved at the end of that tutorial. You'll
finish your model by creating a head. For the
purposes of this tutorial, the head has been
kept very simple, without any facial details.

2. Create a polygon cube with the following
dimensions:

Width: 2

Height: 3.3

Depth: 2.5

SUbdivisions Width: 4

Subdivisions Height: 5

Subdivisions Depth: 2

3. Move the cube up in the Y-axis so that it
aligns with the head (see FIGURE 21.61),
Don't worry if the fit isn't perfect, as you'll
be adjusting the vertices in a second. Delete
the faces that fall on the right side of the
character.

4. Adjust the vertices in the Front view to make
them align with the image, as shown in
FIGURE 21.62.

5. Next, you need to adjust the vertices from the
side, which will likely require a lot of switcbing
between the Side and Perspective views
(shown in FIGURES 21.63'and 21.64,
respectively). Keep in mind that your intention
should be to round out the shape with the ver
tices on hand, No other detail has been added
to the cube yet.

6. Create a split that runs under the chin, as
shown in FIGURE 21.65. Use it to help
define the chin area.

FIGURE 21.61 The half-cube
that will become the head.

FIGURE 21.62 The vertices
adjusted in the Front view.

FIGURE 21.63 The head vertices
in the Side Viewport.

FIGURE 21.64 The head in the
Perspective viewport.
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7. Select the two faces on the underside of the
chin, toward the back of the head. They've
been highlighted in FIGURE 21.66 for your
convenience. Delete them, and then use the
vertices to resize and round out the hole.

8. Back on the torso, delete the two faces at the
top of the shoulder, right next to the seam.

9. You should now have a five-edged hole at
the bottom of the head and a four-edged
hole at the top of the torso. Even this up by
creating a split from the neck hole to the
shoulder, as shown in FIGURE 21.67.

10. Reshape the hole to round it out, and com
bine the two meshes. Then. uSing the
Append to Polygon tool, create a series of
faces that connect the head and the torso
(see FIGURE 21.68).

11. Create two splits on the neck faces, and
use them to reshape the neck, as shown in
FIGURE 21.69.

12. Time for the last step. From the Polygons
menu, choose Mirror Geometry> options
box. In the settings, make sure you're using
the -X-axis, and that the Merge with the
Original option is enabled and set to
Connect Border Edges. The results are
shown in FIGURE 21. 70.

13. Make any necessary tweaks. When satis
fied, use the Triangulate command on the
model, delete history, and save.
CongratUlations! You have completed an
entire game model.

FIGURE 21.69 The neck completed.

END TUTORIAL 21.13

FIGURE 21.65 The split needed for the chin.

FIGURE 21.66 You need to remove
these faces.

FIGURE 21.67 This split enables you to
have five edges around the neck hole.

FIGURE 21.68 The new faces attach
the head and torso.

FIGURE 21.70 The completed model.

/
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Summary
In this chapter, you have walked through the completion of an entire character. Given that this

character design was fairly simple, if you were able to follow all the way through this project,

you're more than ready to venture out and create your own characters_ You should be pleased with

yourself, as this is no small accomplishment. In the following chapters, you'll be animating, tex

turing, and getting this model into Unreal as a playable character.
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Importing Characters
into UnrealEd

So far, you have fully modeled a character and covered it with a tex

ture. Now you breathe life into the character by giving it motion. In

this chapter, you're introduced to the concepts of animation in Maya

and learn how to create digital skeletons for your character, how to

attach your character's geometry to that skeleton, how to create a

control system by which to move that skeleton, and finally, how to

create a series of animations to make the character mimic human

movement. You also see how to export your own character anima

tions into Unreal or use the animations included with the Unreal

Tournament 2004 characters.
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What Are Skeletons?
To animate game characters, you need to

construct a skeleton for them. For a digital

character, however, the term skeleton takes

on an entirely different meaning from the

bone framework that holds you up. A dig

ital skeleton is actually nothing more than

a hierarchical series of rotation points. To

be technical) they are a hierarchy of

Transform nodes to which joint clusters
are attached. FIGURE 22.1 shows a char- FIGURE 22.1 A character skeleton in Maya.

acter skeleton in Maya.

A character skeleton is necessary because a

game character is nothing more than a

series of polygons. It might form the shap~

of a person and look like it has features such

as elbows, knees) a head) and so on) but of

course) it actually has none of these features.

Polygons have no way of knowing where

they should bend or how they should flex.

The joints of a skeleton supply this infor

mation, allowing you to control the points

at which the character's body parts rotate. FIGURE 22.2 Skeletons in action.
The geometry of the model is then attached

to these joints in a process known as skinning) which is discussed in detail later in this chapter in

"Binding a Character to a Skeleton: Skinning." After the connection is complete) your character can

bend) reach) and take on a variety of different poses) as shown in FIGURE 22.2.

22

Introduction to Maya Joints
When working in Maya) the fundamental component of a skeleton is the joint, which is a loca

tion in space that designates a point of rotation. To construct a skeleton, you create networks of

these joints and parent them to one another in a logical fashion. For instance, if you picture joints

that form an arm, such as a shoulder, an elbow, and a wrist, you could imagine this parenting

hierarchy as follows:

~ As the elbow rotates, the wrist moves with it. Therefore, the wrist is parented to the elbow.

~ As the shoulder rotates, both the elbow and wrist move, meaning that the elbow is

parented to the shoulder.
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Parenting

FIGURE 22.3 A Maya scene depicting the
parenting hierarchy.

Because parenting is such an important

part of a skeletal system, this section dis

cusses its nature in more depth. Say that

you're sitting in a chair, holding this book

as you read. If you move your hands, the

book follows, meaning that the book's cur

rent position depends on where your

hands go. If someone comes up behind

you and moves the chair you're sitting in,

you move as well because your position

depends directly on the chair's position.

The chair, however, is resting on the sur

face of the earth. As the earth revolves

around the aun, it brings the chair, you,

and the book along for the ride. ]n this _

way, you could say the book is parented to

you, as your motions directly influence it.

You are parented to the chair, which is par

ented to the earth, which is in turn par

ented to the sun. You could represent this

example by using objects in a Maya scene

(see FIGURE 22.3).

This hierarchy is straightforward, as each
FIGURE 22.4 The Hypergraph's interpretation of

object has only one child. To make this the hierarchy.
analogy a little more complicated,' what if

you were holding this book in one hand and a cup of coffee in the other? In the hierarchy you

have created, this means you now have two descendants (child objects); the book and the coffee.

As you move, both objects move with you. At this point, your hierarchy would look something

like FIGURE 22.5.

Although this relationship can be seen as

you move objects around the screen, it's

also represented in Maya's Hypergraph. If

you opened the Hypergraph for this scene,

you would see a hierarchy such as the one

shown in FIGURE 22.4.

/'"'"
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FIGURE 22.5 The new hierarchy. with a cup of
coffee added into the mix.

The most interesting aspect of this system

is that a parent's influence doesn't affect

the values in child Transform nodes. For

example, if a parent object moves along the

X-axis, its child objects are completely

unaware of the motion, regardless of the

fact that they come along. This system is

very similar to how hierarchies respond in.

the real world. Think about it: Hold your-

self as still as you can. Do you feel any motion? You don't-{)r shouldn't, anyway--even though

earth is hurtling through space at about 67,000 miles per hour.

Because of the nature of Maya's parenting

system, however, an object can have any

number of child objects but can have only

one parent. Think about it: If a parent

directly influences its child's location, hav

ing two parents would mean it's possible

for the child to be influenced to be in two

places at once.

22

FIGURE 22.6 The bones and joints of a
skeleton.

Joints and Parenting

Joints use the parenting system to create the hierarchy that becomes the skeleton. Each joint has

a parent joint, eventually leading to the highest level parent of the hierarchy, known as the root
joint. The root joint is important in Maya because as it's moved, rotated, or scaled, the rest of the

skeleton is moved, rotated, and scaled with

it. Also, several functions necessary to

working with skeletons can be performed

only if the root joint is selected, such as

returning the skeleton to its original pose.

Joints are unique in Maya's hierarchies, as

their parenting system is visually repre

sented in the viewport. You can always tell

which joints are parented to which by

looking at the bones between each pair. A

bone appears as a wireframe triangular

shape that points from parent to child. An

example of bones and joints can be seen in

FIGURE 22.6.

. -----_.._---



The bone itself, however, is little

more than a visual reference

and an aid in joint selection. A

bone, in and of itself, serves no

purpose independent of joints.

A bone is created automaticaJJy

wherever two joints are created.

So if you have two separate joint

chains and you parent the root

of one chain to the last child in

the other, you see a bone

instantly created that turns the

two chains into one continuous

strand of joints. You can see this

reflected in the Hypergraph as

well (see FIGURE 22.7).

Joints and Rotation

What Are Skeletons? 757

FIGURE 22.7 On the left, before joint3 is parented; on the
right, after joint3 is parented.
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After joints are added to a character, they typically serve only one function: rotation. Joints have

little or no need to move or scale, unless the artist is trying to achieve a cartoon-like effect, such as

the character's bones seeming to stretch.

All objects in Maya have a local rotation axis, which is a coordinate system that's individual to the

object and doesn't necessarily coincide with the world coordinate system. To make this system a bit

clearer, pretend you have your own local rotation axis centered in the middle of your torso, near

your heart. If you were an object in Maya, this spot would be your pivot point.

First, to establish the directions of the world coordinates, say that Y always points up, Z always

points to the north, and X always points toward the west. For your local rotation axis, the Y-axis

always points toward your head, the Z-axis always points out of your chest, and the X-axis always

points out of your side, toward your left hip.

If you were to stand on your head, your local Y-axis would point downward, although the world

coordinate's Y-axis actually points up. Your local rotation axis would rotate with you, which illus

trates how the local rotation axis works in Maya.

Working with Local Rotation Axes

Although the local rotation axis rotates with the object, it can also be adjusted independently of that

object through Maya's Component mode. Occasionally, you run into situations in which you would

like to rotate an object in a single axis to create rotation in a specific direction. The axis you choose and

the direction in which you want the object to rotate might be completely different from one another.



758 Chapter 22 Importing Characters into UnrealEd
-- ~_.--------_. --------_._------

For example, say you're animating a car wheel spinning, and you want that spin to occur along

the Y-axis. Unfortunately, the wheel spins properly only when it's rotated about the Z-axis. The

solution to this problem is simple: Adjust the wheel's local rotation axis so that its Y-axis points

in the correct direction.

22 This same technique applies to joints. All joints have their own local rotation axis. The orienta

tion of this axis is controlled by a setting established before the joint is created. If, however, you

should discover after creating a joint that the orientation of the local rotation axis is incorrect,

you can always adjust it to give you the proper rotation. The techniques for adjusting this setting

are explained later in this chapter in "Joints and Local Rotation Axes."

Using the Joint Tool

Most of the time, you don't create joints as separate objects in the same way you create primitive

geometry. Most often, you use the Joint tool to create your skeleton's joint networks. With this

tool, you can create joints in the viewport in a point-and-click fashion and automatically parent

the joints as you click. The first joint you place is the highest level parent in the hierarchy.

The second click is that joint's child, the third click creates the second joint's child, and so on. As

you click, you see not only the joints being created, but also the bones between them. In

TUTORIAL 22.1, you use this tool to create a simple joint chain.

TUTORIAL 22.1: Creating Joints with the Joint Tool

1. Open Maya, and start a new scene.
Make sure you're in the Animation
menu set, or press F2 to go there.

2. Switch to the Side viewport, and
choose Skeleton> Joint Tool from
the main menu.

3. Click three times in the viewport.
You'll see joints created at each
click and bones connecting each
joint hierarchically (see FIGURE
22.8). You can click as many times
as you like, but remember that as
long as the tool is active, each click
creates a new joint.

4. Press Enter to complete the tool's
operation and finalize the joint chain
you just created.

FIGURE 22.8 Three joints created with the Joint
tool.

NOTE
If you MMB-click the last joint you placed, you can

relocate it by MMB-dragging. Relocating affects the
joint's local rotation axis, however, as outlined later in

"Moving Joints."
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FIGURE 22.9 A branching joint chain has been
added.

f
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5. Aside from creating freestanding
I joint chains, you can also branch off

t
' existing joint chains to make more

complex skeletons. To do this, begin
I by clicking on any of the joints in the
I chain you just created. Notice that

the joint is highlighted.

6. Now click a second time. and notice
that a new bone is created along with
the joint. The bone points from the
location of the joint you clicked to the
one you just created. Press Enter to
complete the joint chain (see
FIGURE 22.9). Feel free to experi
ment by branching off as many times
as you like.

I

I
I

END TUTORIAL 22.1

Joints and Local Rotation Axes

Because joints are mainly used for rotation, the local rotation axis becomes vitally important.

Eventually you'll run into situations in which a joint is pointing in one direction, but needs to

rotate in a direction that doesn't fallon one if its local rotation axes. Take your thumb, for

instance: Place your hand flat, palm facing down. Relax your hand, and move your thumb up and

down. Try to imagine the axis of rotation for that movement. It should run rougWy parallel to

your index finger, although your thumb points out of your hand at a completely different angle.

This situation is common when creating skeletons for characters, and you need to rotate a joint

in a direction that doesn't coincide with any single axis. Of course, because a joint can rotate in

all three axes, it can theoretically achieve any rotation. The problem comes in when you try to edit

the animated channels for that object. For example, what if, to rotate the knee, you needed to

rotate the joint on all three axes? It might look fine onscreen, but if you edit that animation, you

wouJd find three separate animation curves that·need to be adjusted, one for each axis. Instead,

you could simply adjust the knee joint's local rotation axis so that the rotation occurs only on a

single axis, thereby simplifying any editing you need to do later.

You can set the local rotation axis for a joint at the time of its creation by adjusting the Auto

Orient Joint setting of the Joint tool. By default, it's set to XYZ. Many combinations of the three

axes are available, and each combination works as follows: The first axis listed points into a joint's

bone. The third joint listed points sideways, and the second joint is at a right angle to the other

two. So in the case of XYZ orientation, the X-axis would point down the bone toward the first

child of the joint. The Z-axis would point sideways into the joint, and the Y-axis would point into

~. the joint perpendicularly to the plane created by the X and Z axes.

---_ .._._------_._--------



Manipulating Joints

Now that you see how to create a few joints, you need to know how to adjust them. You won't

always be able to create joints exactly where you need them, so it's often necessary to create sev

eral joints and then position them accordingly. You can manipulate joints in three ways: moving.

22 rotating, and scaling. Each method has its repercussions. The following sections explain these

three methods of joint manipulation and explore the consequences of each one.

Moving Joints

One of the most obvious methods of joint manipulation is to simply move the joint. However,

you need to keep some rules in mind when moving joints. First, by default, moving a joint causes

all that joint's child joints to move as weIJ. Second, moving joints also offsets the orientation of

the joint's local rotation axis. In TUTORIAL 22.2, you see how to use the joint moving method.

TUTORIAL 22.2: Adjusting Joints Through Moving

1. Start a new scene and go to the
Animation menu set. Using the Joint
tool, create a series of six joints in
an S-style pattern, as shown in
FIGURE 22.10. Press Enter when
finished to complete the joint chain.

2. Notice that each time you click, you
can see the axis marker in the cen
ter of the joint orient itself so that
the X-axis is pointed down the bone.
This is the result of the Auto Joint
Orient setting of the Joint tool.

FIGURE 22.10 Joints created in an S-pattern.
Select the Move tool, and then
select and move the second joint
of the chain you just created. Each of that joint's child joints follows the movement, as dic
tated by the nature of parenting. The rotation of the joint doesn't change, meaning that the
X-axis no longer points down the bone. This could cause problems later when you're
animating the joint.

3. What if you want to adjust the joint without changing the location of all its child joints?
There's a way to do this, and it's much like adjusting an object's pivot point. With the sec
ond joint still selected, press the Insert key. Notice that the manipulator changes to a
series of lines without arrows. Use this manipulator to move the joint around in the
viewport, and notice that the child joints are unaffected.

4. But what about the problem of the local rotation axis? Most of the time, you want one of
the axes to point down the bone, as this helps with animating. Unfortunately, now that you

1"--- -
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have moved that second joint, at least two joints no longer follow this rule. You can fix this
problem by using the Orient Joint command .

Select the root of the joint chain. From the Skeleton menu. choose Orient Joint> options
box . In the Orient Joint Options dialog box, set the following:

Orientation: XYZ

Hierarchy: Select the Orient Child Joints check box

Click Orient when finished. Notice that the joints have been reoriented so that the X-axis
again points down the bone.

END TUTORIAL 22.2

Rotating and Scaling Joints

Instead of moving joints, often rotating and scaling are far better alternatives because you can

change a joint's position without disturbing its local rotation axis. You can also use the Scale tool

to adjust the length of bones, thereby repositioning all joints in the hierarchy. Combining rota

tion and scaling is a far better method of reshaping joint chains, as you run no risk of offsetting

the rotation information of the chain's joints.

Binding a Character to a Skeleton: Skinning
Right now, if your skeleton's joints bend, the model itself would stay behind. So now that you have

completed a skeleton for your character, it's time to attach that skeleton to the geometry of your

character model-a process known as skinning.

In Maya, there are two major methods of skinning: Rigid Bind and Smooth Bind. In a nutshell, the

main difference is that with Rigid Bind, each vertex of the model is influenced by a single joint.

With Smooth Bind, a vertex can be influenced by multiple joints simultaneously. Both methods

have their pros and cons, but Unreal understands only skinning information that's created

through the Smooth Bind process. For this reason, only smooth skinning is covered in this book.

Introduction to Smooth Bind

So how exactly does smooth skinning work? The process is simple: A model's vertices are influ

enced by the position, rotation, and scale of the skinned joints. As you move, bend, and flex the

skeleton, the character model foJlows along. Because each vertex can be influenced by many joints

at the same time, the effect of the character bending is averaged out, producing a smoother result.

So how do you specify the number of joints that can influence each vertex? When you use Smooth

Bind on a character, you can set the Max Influences value in the command's options. This value

is the number of possible joints that can affect each vertex of the model. In TUTORIAL 22.3, you

/- learn how to set up a Smooth Bind skinning.
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TUTORIAL 22.3: Smooth Binding a Simple Model

1. Start a new scene and go to the Animation menu set. You'll set up a simple system to
understand the use of the Smooth Bind process.

2. Create a polygon cylinder by choosing Create> Polygon Primitives> Cylinder> options box
from the main menu. In the Cylinder Options dialog box, set the following:

Radius: 1

Height: 10

Subdivisions Around Axis: 20

Subdivisions Along Height: 16

Subdivisions on Caps: 1

Axis: Z

3. Switch to the Side viewport, as
shown in FIGURE 22.11. Using the
Joint tool, create three joints within
the cylinder: one at the beginning (for
the shoulder), one at the middle (for
the elbow), and one at the end (for
the wrist). Press Enter when done.

4. Select the root joint, the one created
at the shoulder. Shift-select the
geometry of the cylinder. Choose Skin
> Bind Skin> Smooth Bind> options
box from the main menu. TABLE
22.1 describes the settings in the
Smooth Bind Options dialog box. FIGURE 22.11 Joints within the cylinder.

TABLE 22.1

Setting

Bind To

Bind Method

Smooth Skinning Options

Description

This setting has two modes: Complete Skeleton and Selected Joints. The
Complete Skeleton mode attaches the selected geometry to the entire
joint hierarchy, regardless of which joints are currently selected. The
Selected Joints mode skins the geometry only to the joints that are
currently selected.

This setting also has two modes: Closest Joint attaches vertices to the
joints while respecting the hierar~hy. Closest Distance attaches the joints
while ignoring the joint hierarchy; instead, this mode relies on the distance
the geometry is from a given joint. The difference between the two modes
can be seen most clearly when skinning areas such as the fingers.

When Closest Joint is active, Maya makes sure to skin the vertices of each
area of the finger to joints that are in the same hierarchy as the finger
bone. Therefore, influence from the joint at the tip of the index finger is not
likely to influence the vertices at the tip of the middle finger. The Closest
Joint setting is most often used for character skinning.

.. __ ._----- -- ..._---
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Setting

Max Influences

Dropoff Rate

Description

Closest Distance, on the other hand, ignores the hierarchy, meaning that a
situation in which joints in the index finger are influencing vertices in other
fingers of the hand is very possible. Because the influence doesn't respect
the hierarchy's layout, you could easily get an influence that jumps from
the tip of one finger to the tip of another. The result would be that when
one finger rotates, other fingers near it seem to stretch toward it, as
though they were made of gum or taffy.

As mentioned earlier, this setting controls the number of joints that influ
ence each vertex of the model. This number is valid only at the moment
skinning is applied. So even if Max Influences is set to 2, you can edit
your influences to have vertices controlled by as many other joints as you
like.

This setting controls the rate at which Maya stops looking for joints to
influence each point. The higher this number, the faster the influence
drops off. The lower the number, the farther Maya looks to find joints to
influence each vertex. The default is 4, which works great in most
situations.

For now, leave the options at their
default values, and click the Bind
Skin button.

5. Select the Rotate tool. Click the elbow
joint and rotate it up 90 degrees.
Notice that the cylinder's geometry
now flexes with the skeleton. However,
the area of flex doesn't seem to be
keeping its volume; instead, it's bend
ing much like a wet noodle (see
FIGURE 22.12). You can fix this in
the next tutorial by adjusting how
much influence each joint has on the
object. Save the scene.

END TUTORIAL 22.3

Adjusting Joint Influence

F.IGURE 22.12 The skinned cylinder is deform-
ing, although not as cleanly as you would like.

~--.

Not only can you control how many joints influence each vertex of a particuJar model. but you

can also change the percentage of influence each joint is using. The amount of influence each

joint exerts is referred to as the joint's weight. You can adjust this weight to give more influence

to some joints and to take it away from others.
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The skin weighting system works as follows: Each vertex is controlled by a specific number of

joints, and each of those joints controls a percentage of the influence sent to that particular joint.

Because the value is a percentage, the combined value of all influences affecting each vertex must

equal 100%, or in Maya, a value of I. As an example, say that you have a single vertex being con

trolled by only two joints. Each joint controls 50% of the weighting, meaning they both have a

value of 0.5. If you set one joint's weight to 75%, the weight from the other automatically adjusts

to 25%. This automatic adjustment is always the case with smooth skinning.
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FIGURE 22.13 The Paint Skin Weights Tool
Settings dialog box.
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So what happens when you have an entire character, composed of thousands of polygons,

skinned to a skeleton with many joints and a relatively high Max Influences value? Naturally, the

result would be literally thousands of influence values for the modeJ's vertices. Going vertex by

vertex and adjusting the weight values numerically takes far too much time. Fortunately, Maya

comes equipped with a tool engineered specially for this problem: the Paint Skin Weights tool.

The idea of the Paint Skin Weights tool is relatively simple: Because all the values of skin weights

are calculated on a 0 to 1 basis, you could represent them visually by using a grayscale image with

oequal to black and 1 equal to white. When using the Paint Skin Weights tool, you would then

see a visual representation of the weight being applied to your geometry from any joint.

The Paint Skin Weights Tool is a brush-

based tool that enables you to adjust the

influence of your joints across your

model's geometry in a fast, interactive

manner. It displays a grayscale texture

across your model that indicates the

amount of influence for the joint selected

in the Influence section of the Tool

Settings dialog box (see FIGURE 22.13).

With this tool, you can "paint" weights

onto different areas of the surface. As men

tioned, white areas denote 100% influence,

and black areas denote 00/0 influence. The

varying levels of gray designate percent

ages between those values.

The key elements in the Tool Settings dialog

box are in the Brush section, where you can

control the size and profile of your brush.

Note that the Radius(L) is valid only if you

have a pressure-sensitive device attached to your computer, such as a digital pen. The Opacity value

is one of the most important settings you use while adjusting skin weights with this tool. It controls

how dramatic the effect of each stroke is as you paint. Leaving this value fairly low is always a good

idea; then you can build strokes on top of one another to achieve your final solution.
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The settings in the Influence section are used to designate the joint to which you're adding or sub

tracting weight. A list of all the joints skinned to the selected piece of geometry is displayed in this

section. The list of joints can be sorted alphabetically by name or by position in the hierarchy.

Keep in mind that sorting your joints by hierarchy can be quite tedious if you're working with an

exceptionally complex skeleton.

You can use the settings in the Paint Weights section to control the function of the brush. For the

Paint Operation setting, four options are available, described in the following list:

~ Replace-This operation applies the brush's set value uniformly across the painted sur

face. For example, if you need to set the weight in a specific area to 0.5, you could set the

Value slider (located just under the Paint Operation options) to that weight and paint on

the surface with this operation. Wherever the brush stroke falls, the weight is set to 0.5.

~ Add-This operation adds the number set in the Value slider to the existing value on the

surface. This is a great tool to gently increase weight in a given area.

~ Scale-This operation is used to reduce the amount of weighting applied by faraway

joints.

~ Smooth-This operation applies an average value from aJl the vertices that fall within the

brush's radius. The end result is that skinning in the painted area is smoothed out.

The settings in the Display section control how you see the tool's feedback in the viewport. Two

main options of interest are the Show Wireframe check box, which removes the wireframe from

the selected model while painting weights, and the Color Feedback check box, which can be

used to remove the grayscale color pattern across the surface of the skin. The color can be con

fusing sometimes, especially when a large complex area is only one color, such as white. In

TUTORIAL 22.4, you use this tool to adjust the skin weights from TUTORIAL 22.3.

765

TUTORIAL 22.4: Using the Paint Skin Weights Tool

1. Continue TUTORIAL 22.3, or open
the file you saved at the end of that
tutorial (see FIGURE 22.14).
You're going to adjust the weight
influence across the surface of the
cylinder to make the elbow area
keep more of its volume. Before you
begin, select the middle (elbow)
joint, and rotate it upward in the
Side view to about 90 degrees.

2. Select the cylinder geometry.
Choose Skin> Edit Smooth Skin>
Paint Skin Weights Tool> options

- _. _.__ . ----------

FIGURE 22.14 The example from
TUTORIAL 22.3.

-----_.- .._--------
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box from the main menu. This activates the Paint Skin Weights Tool and opens the Tool
Settings dialog box. If you don't see a change in the viewport, make sure you're in Smooth
Shaded mode by pressing the 5 key.

FIGURE 22.16 The weight is now adjusted. Notice
that the elbow area is keeping more of its volume.'

4. In the Perspective viewport, carefully
paint around the bottom of the
elbow and the inside of the bend's
vertical side. As weight is added,
you can see the elbow gaining more
of its original volume back (see FIGURE 22.15 Weight added to Jointl.
FIGURE 22.15). Be careful not to
add too much. If necessary, adjust'
your Weight and Opacity settings in
the Tool Settings dialog box.

5. In the Influence section, select
Jointl and repeat the process,
adding weight to the outside of the
elbow and the bicep area.

3. In the Influence section, select
Joint2 to display the weight for that
specific joint. In the Paint Weights
section, set Paint Operation to Add,
and set the Value slider to about
0.5. In the Brush section, set
Radius(U) to 1 and Opacity to 0.5.

6. To clean up the results, set Paint
Operation to Smooth, and carefully
paint around the edited area of the
elbow. Notice that the effect of the
painting is adjusted to look
smoothed (see FIGURE 22.16).
Switch to different joints, and experi
ment with the tools until you achieve
a result you like.

END TUTORIAL 22.4

22

Importing a Character Without Custom Animation
Now it's time to apply everything you've learned throughout this chapter to successfuUy import a

character into UT. You begin by importing a skeleton provided by Epic Games. The character needs

to be adjusted to fit the joints. After this is done, the character is smooth bound to the skeleton.

When the weights have been properly adjusted and deformation looks good, you begin the process

~------_. -- ._--.-
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Importing a Skeleton

In TUTORIAL 22.5, you import a premade skeleton specifically designed for use with Unreal

Tournament 2004 characters into Maya and set it up for use with your character.

FIGURE 22.17 Preparing the character in
Maya for export i'nto Unreal Tournament.

FIGURE 22.19 The character's geometry has
been uniformly scaled to match the skeleton.

FIGURE 22.18 The imported skeleton is
nearly three times larger than the geometry.

1. Open the UTCharacter_Model. mb file
from the DVD (see FIGURE 22.17) or
use the character you modeled earlier in
Chapter 21, "Character Modeling."

2. From the main menu, choose File>
Import and select Epic_Skeleton. mb

from the dialog box. The skeleton does
n't fit the geometry correctly because
the geometry and the skeleton were
modeled at different scales (see
FIGURE 22.18). Select the root of the
skeleton, and move it back in the Z-axis
so that it's positioned within the charac
ter's geometry.

3. You need the skeleton to fit the character,
but it's best not to disturb the joints'
translation or scale, which could cause
extreme deformation after the character
is in Unreal linked with existing anima
tion. Rotating the joints, on the other
hand, is not a problem. The best way to
do this so that you don't disturb the
joints is to begin by scaling the geometry
up to match the skeleton as closely as
possible. Select the Scale tool and uni
formly scale the geometry to match. Use
the Front viewport to gauge just how
much the character needs to be scaled
up (see FIGURE 22.19). The joint arms
and legs don't fit within the geometry
arms and legs, but don't worry about
this. Simply try to match up the

of preparing for export. When everything is ready, the character is exported directly into UnrealEd,

where you can link the character to already existing animation and create an Unreal Player List

(UPL) file to define the character in Unreal Tournament 2004. Then you're ready to play!

TUTORIAL 22.5: Importing a Skeleton
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shoulders and hips. You'll rotate the
joints in the next step to match the
character more closely.

4. Rotate the shoulders, elbows, hips,
and knee joints so that the arms and
legs fit within the geometry (see
FIGURE 22.20). Don't move or scale
the joints, as this can cause several
problems in Unreal after existing ani
mation is linked to your character. FIGURE 22.20 The joints have been rotated so

that the skeleton fits perfectly within the geometry.

END TUTORIAL 22.5

Skinning a Character

Now that the bones are aligned to the character, you can attach the geometry to the skeleton, or
"skin" the character. TUTORIAL 22.6 walks you through this process.

TUTORIAL 22.6: Skinning a Character

FIGURE 22.21 Setting the Smooth Bind options
can produce better results in the default skin.

FIGURE 22.22 Test the geometry deformation by
rotating the joints.

.
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~,TIP
You can always return a character to its original bind
pose quickly by selecting the root joint and then
choosing Skin> Go To Bind Pose from the main menu.

1- -.

IJ

2. Select the root joint, and Shift-select
the character geometry. From the
main menu, choose Skin> Bind Skin
> Smooth Bind> options box.

3. In the Smooth Bind Options dialog
box (see FIGURE 22.21), use the
following settings and then click Bind
Skin:

Bind To: Complete Skeleton
Bind Method: Closest Joint
Max Influences: 3
Dropoff Rate: 6

4. To see the effects of the Smooth
Bind, select and rotate several joints
and watch the deformation caused to
the geometry (see FIGURE 22.22).
After you're finished testing
the deformation, make sure you
undo all rotations.

1. Open the UTCharacter_Skeleton. mb

file. or continue where you left off with
TUTORIAL 22.5.

END TUTORIAL 22.6
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The character's geometry is now fully attached to the skeleton. Currently, however, he won't

deform properly if you rotate his joints, so you need to modify and adjust his skin weights.

TUTORIAL 22.7 introduces you to this process.

TUTORIAL 22.7: Adjusting the Skin Weights

1. Continue from TUTORIAL 22.6 or
open the UTCharacter_
SkinWeights_Start. mb file.

2. Rotate the joints so that the charac
ter appears to be sitting on an imag
inary chair (see FIGURE 22.23).
Rotate the arms down and add
some rotation to bend the elbows.
The idea is to pose the character
into a position that shows off the
deformation at major joint bends,
such as shoulders, elbows, hips,
and knees.

3. Select the character. From the main
menu, choose Skin> Edit Smooth
Skin> Paint Skin Weights Tool>
options box. Make sure you're view
ing your character in Smooth Shaded
mode in the Perspective view.

4. Take a close look at the shoulder
region of the left arm. The chest
has caved in a bit, making the arm
look more like a noodle (see
FIGURE 22.24).

Use the following steps in the Tool
Settings dialog box to correct this
problem (see FIGURE 22.25):

~ Select Bip01_L_UpperArm in
the Influence section.

~ Set Radius(U) to 2.5.

~ Set Opacity to 0.35.

~ Set Paint Operation to Replace.

~ Set the Value slider to O.

FIGURE 22.23 The character has been posed so
that deformation problems can be easily identified.

FIGURE "22.24 When the arm is rotated down,
you can see how some of the volume is lost in the
chest.
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Move the brush over the inter
secting edges on the torso
near the underarm area, and
click to begin removing
weights. As the weight is
removed, notice that the vol
ume begins to return.
Continue painting under the
arm to fill the chest back in
(see FIGURE 22.26).

5. Continue adjusting weights on
the right side of the character
until the character deforms
properly in a series of action
poses.

FIGURE 22.25 Removing weights from the underarm
area help bring volume back into the chest.

6. After the right side of the character
has been weighted, you can mirror
the weights to the left side. This
works only if the character is sym
metrical. To mirror the weights, use
the following steps:

~ Select the skeleton root and
choose Skin> Go To Bind
Pose.

~ Select the character's
geometry.

~ From the main menu, choose
Skin> Edit Smooth Skin>
Mirror Skin Weights>
options box.

FIGURE 22.26 The underarm area has been
corrected so that volume is maintained.

FIGURE 22.27 Use the Mirror Skin Weights
action to mirror weights from the left side of the
character to the right side.

N..._ Xi' • Y2 l<Z
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~ In the Mirror Skin Weights
Options dialog box shown in
FIGURE 22.27, set Mirror
Across to YZ and verify that
the Direction check box is
selected so that you mirror
the weights from positive X
to negative X.

~ Click the Mirror button.

END TUTORIAL 22.7

If III III
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Exporting the Character

The character is now fully skinned and ready to be exported. TUTORIAL 22.8 shows you how to

get the character into UnrealEd so that you can link up his properties and animations, bringing

him one step closer to being a fully playable game character.

TUTORIAL 22.8: Exporting the Character

~
I
I

1. Open the UTCharacter_Export_
Start file.

2. Before the character is ready to be
exported, you need to triangulate
the skinned character by following
these steps:

• Select the character's
geometry.

• Go to the Modeling menu set
(press F3l, and choose
Polygons> Triangulate from
the main menu. FIGURE
22.28 shows the result.

• The Triangulate action causes
all the faces for the geometry
to be selected. Simply dese
lect them, and reselect the
character.

3. From the Shelf, click the Connect to
UnrealEd Icon ( ).

4. Select the root joint.

5. From the main menu, choose
Character> Create Character Set>
options box.

FIGURE 22.28 The character must be
triangulated before exporting to UnrealEd.

• (fl',lli' (fMr,2ctcr set OJlhon~ •

FIGURE 22.29 A character set must be created
before you can export the character to Unreal.

[D]

6. In the Create Character Set Options dialog box shown in FIGURE 22.29, set the
name to UTGuy. All other parameters should be at their default settings. Click Create

Character Set.

7. Click the Skeletal Mesh Export Window button ( ) in the Shelf.

8. In the Skeletal Mesh UT2K4 Export dialog box shown in FIGURE 22.30, click the
Package drop-down list and select Create New Package. In the New Package dialog box,
set the package name to UTGuyAnim, and click OK.

--- . -- ------- - .--_...__.----._-... -------------
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9. Back in the Skeletal Mesh UT2K4
Export dialog box, select the
Underscore to Space check box.
Maya does not allow spaces in
object names, but bone names
require spaces in Unreal. Selecting
this check box handles the conver
sion for you.

10. Click the Export button. The
Command Feedback line (located
at the bottom right of the Maya UI)
shows Result: Export com·
plete. At this point, the character
has been exported to Unreal in
the UTGuyAnim package. The
package has not been saved. so
you need to be careful not to
close Unreal Ed.

END TUTORIAL 22.8
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FIGURE 22.30 Creating the Unreal package
that the character will be created in.

Getting the Character Ready for Gameplay

Now that you have the character in UnreaJEd, you need to configure several settings, such as

his mesh properties and default animations, before you can use the character in-game. Tn

TUTORIAL 22.9, you use UnrealEd to prepare your character for garnepJay.

TUTORIAL 22.9: Getting the Character Ready for Gameplay

1. Continue from TUTORIAL 22.8.

2. Switch to UnrealEd and open the Animation browser.

3. Set the Package drop-down list to UTGuyAnim. You see the character that was exported
from Maya (see FIGURE 22.31). The most noticeable thing is that he's missing his
textures! You'll correct that in the next steps.

4. Before you can assign textures, you need to create the texture package. At the moment,
the textures exist only as external files, so follow these steps:

~ Switch to the Texture browser.

~ From the menu, choose File> Import.

~ In the Import Texture dialog box shown in FIGURE 22.32, select both Head. tga
and Body. tga, and click Open.
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~ In the Import Texture dialog box that opens, set the following options:

Package: UTGuyTextures

Group: (Clear any entries)

Leave everything else at the defaults and click OK All.

~ On the toolbar, click the Save icon to save the package.

r
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FIGURE 22.31 The character can be viewed in the Animation browser, but is seen without any
textures.

5. In the Texture browser. select the
Head texture.

6. Switch back to the Animation
browser. In the properties section
under the Mesh tab, expand Skin>
Material and click the index [OJ prop
erty (see FIGURE 22.33). Click the
Use button.

..
"'0
'iii' C:\..UT Book_'Ol 22 00>0r0cW OK

"'- _ -.. ~.-..M-..\~..\u,...-..I_

OIC.,flacIraoo: UTGuyTeocllIM
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Name: Head c..lII
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FIGURE 22.32 Importing the character's
textures into a new package.

-------_..'----------,-----~-
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FIGURE 22.33 Assigning the Head texture to your character.

7. In the Texture browser, select the Body texture. Back in the Animation browser, assign the
Body texture to index [1]. The character is now textured.

8. For the character to behave properly in the game, you need to set several properties.
Instead of setting these properties by hand, however, you'll simply use a set of properties
from an existing Unreal character:

~ In the Package drop-down list of the Animation browser, select the ThunderCrash
package, where you'll see the JakobM character. Take note of how small the
character looks.

~ Choose Mesh> Copy Mesh Properties from the Animation browser's menu to place
all the properties for the ThunderCrash character in the Clipboard for later use.

~ Switch back to the UTGuyAnim package, and choose Mesh> Paste Mesh Properties
from the menu to place all the properties used with the ThunderCrash character
onto your new character. You'll see the character shrink in size significantly, but don't
worry; this is supposed to happen. The character's scale has been reset to reflect
the size of characters already in the game. Also. don't be alarmed that the character
appears to be lying flat on his back, as shown in FIGURE 22.34. This happened
because the original characters were created using a different coordinate system.
The problem will be corrected when you apply animation to the character.
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"~ FIGURE 22.34 The character's rotation will change after the ThunderCrash mesh properties are
pasted.

9. Along with using the mesh properties of an established character, you can also borrow the
default animations for that character. To use another character's animation, follow these
steps:

~ In the Package drolXlown list, select ThunderCrash. You'll see a long list of anima
tion sequences in the Sequences list on the left side of the browser. To apply these
sequences to your character, simply go to the Mesh properties tab, and under the
Animation category, highlight the DefaultAnimation entry. Press Ctrl+C to copy this
information to the Clipboard.

~ In the Package drop-down list, select UTGuyAnim. Click in the DefaultAnimation
property (it's currently empty) and press Ctrl+V to paste the information that was
copied in the previous step. Press the Enter key to apply the change. Notice that the
character stands back up at the correct orientation. Notice, too, that the Sequences
list is empty, but this is a redraw issue. To see the sequences, simply click the
Mesh drop-down list (at the upper left, under the Package drop-down list), and select
UTGuy (see FIGURE 22.35).

~ Navigate around the character and test some of the animation sequences by
highlighting a sequence and clicking the Play button (see FIGURE 22.36).
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FIGURE 22.35 The Sequences list now populated with various sequences.

FIGURE 22.36 The character is shown using the RunF (run forward) animation sequence.

----_._-
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FIGURE 22.37 Setting the BoneName

properties correctly allows the socket to
work. If this error isn't corrected, the
character can't hold a gun.

~ In the properties area, under the
Mesh tab, expand Sockets> [0] and
[:I.]. In the BoneName properties for
both [0) and [1), change the
name from Bone_weapon to
BoneWeapon (see FIGURE 22.37).

~ To apply these changes, set the
ApplyNewSockets property to True. It
looks like the property value doesn't
change, but that's not how this property works. The property "finalizes" the changes
you have made to the sockets, but its value does not appear to change.

To control whether the character can hold a
weapon or flag, you need to use sockets,

which represent a dynamic array of aliases.
These aliases are used to define specific
bones that Unreal uses to attach items to
the character. For your purposes, the two
most important items are the weapon and
the flag.

Because you copied mesh properties of
ThunderCrash, you already have sockets
established, but in this case, the name of
one of your bones is different from the one
ThunderCrash uses. To fix this, you need to
update two of the sockets:

10.

11. All the properties have been set, so save the package.

END TUTORIAL 22.9

Creating the Character's Portrait

The character portrait is another important file that you need to create. When Unreal players

decide to change characters, they can browse a list of character portraits, so you want your char

acter portrait to show in that list. In TUTORIAL 22.10, you take a look at one of many possible

methods for generating a character portrait image. You use Maya, Photoshop, and UnrealEd in

this tutorial.

~-------- ----------~---
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TUTORIAL 22.10: Creating the Character's Portrait
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FIGURE 22.38 The character has been posed for
the portrait shot.

FIGURE 22.39 Changing the background color
helps improve the final image.

1. In Maya, open the
UTCharacter_Export_Start file,

3. To make the image look better, try
setting the background color to
black. From the main menu, choose
Window> Settings/Preferences>
Colors.

2. Rotate the character's joints to pose
his upper body into some sort of
naturally relaxed position (see
FIGURE 22.38). The character's
pose is really up to you. Think about
how you would like the character
viewed in the character selection
screen.

4. In the Colors dialog box, expand the'
3D Views category under the
General tab. Set Background to
black (see FIGURE 22.39). Click
the Save button to save your
changes.

5. Position the Perspective camera in a
way that gives an interesting view of
the character. Press Shift+Print
Screen to take a snapshot of the
screen.

22

6. Open Photoshop, create a new file,
and click OK to accept the sizes
automatically entered in the New
dialog box. Press Ctrl+Vto paste
the image into the new document
(see FIGURE 22.40).

7. Select the Crop tool and use the
following settings:

Width: 256 px

Height: 512 px

.~I'",h.1- I I ...... ("0.11 ..... I, ........ t ••
"_ ~ •• ~ ~ _. _.__._. 6

FIGURE 22.40 The character image in
Photoshop where the final tweaks are applied.
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8. Crop the area around the character,
leaving the best possible results
(see FIGURE 22.41).

9. Save the file as
UTGuyPortrait.tga.

10. Switch back to UnrealEd. Open the
Texture browser, and change to the
UTGuyTexture package.

11. Import the new UTGuyPort rait. tga
file into the UTGuyTexture package.

12. Save the package.

END TUTORIAL 22.10

The UPL File and Testing the Character In-game

FIGURE 22.41 The
cropped character image.

Now that the character is complete and the packages have been saved, there's one final step before

you can use this character in-game: You need to create a UPL file. A UPL file contains important

/' information about characters. By default, Unreal Tournament 2004 contains two UPL files in the

System folder: XplayersL1. upl and XplayersL2. up!. These two files contain aJl the characters

used in UT.

When a new character is added to the game, creating its own UPL file is a good idea, instead of

adding an entry to an existing file. You don't want to upload your character to the Internet and

have to include instructions that force users to modify an original UT2004 file. Instead, it's better

workflow to simply create a new file that can be dropped into the System folder.

Fortunately, you don't have to start the UPL ftle from scratch. Instead. you can "borrow" the line

needed from an existing UPL file, add it to a new file, modify a few settings, and you'll be ready

to go. TUTORIAL 22.11 shows you the necessary steps.

TUTORIAL 22.11: The UPL File and Testing the Character In-game

1. Open Windows Explorer and navigate to the UT2004\System folder.

2. Open the XplayersL 1 . upl file in any text editor. (Notepad is fine.)

3. Find the character with the name JakobM (see FIGURE 22.42). Highlight the line and
copy it to the Windows Clipboard by pressing Ctrl+C.

4. In Notepad, start a new file.

5. Type the following:

[Public]

-~~~~---~----
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FIGURE 22.42
custom UPL file.

Copying a line from the XplayersL1 . upl file can speed up the creation of a

6. On the next line, press Ctrl+V to paste the
line copied in step 3.

7. To make your character available in-game,
locate and change the following properties in
the Player line you copied:

DefaultName: UTGuy

Mesh=UTGuyAnim. UTGuy

BodySkin=UTGuyTextures. Body

FaceSkin=UTGuyTextures.Head

Portra it=UTGuyTextures. UTGuyPortrait

Text="Name: UTGuYIAge: 36lRace:
HumanllData:IUTGuy is a custom
character created through this book.II"

8. Save this file as UTGuy. upl in the
UT2004\System folder. Time to test your
character in-game!

9. Start Unreal Tournament 2004. From the
main menu, choose Settings> Player.
Click the Change Character button to see
a listing of characters. If everything has
been set up properly, you should see your
character in the lineup, as shown in
FIGURE 22.43. Select your character and
click OK.

FIGURE 22.43 Your character is now
playable in Unreal Tournament 2004.

FIGURE 22.44 UTGuy is now in the
game and is holding his weapon.



FIGURE 22.45 UTGuy is able to play all
the standard animations.
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10. From the main menu, choose Instant
Action and start a game. Press F4 to
adjust the camera behind your character.
Another console command that's often
helpful is freecamera 1, which allows
players to rotate the camera around the
character. In FIGURES 22.44 and
22.45, you can see the player in the
game, behaving the same as any other
default character.

TABLE 22.2 Properties of the UPL File
-----------------------

781

Property Description

Race

DefaultName This property is the name of the character shown in the Select Character
dialog box.

This organizational property enables you to sort the available characters in
Unreal Tournament 2004. You can place anything in this line, and that race is
then available in the Race drop-down list of Unreal's character selection screen.

Mesh This property controls which polygonal model is used for your character.

Species This property contains an Unreal class, such as xGame. SPECIES_mere. It

controls such things as the character's blood color in-game.

BodySkin This property allows you to specify which texture is used for the character's body.

FaceSkin This property specifies the texture used for the character's head or face.

Portrait This property specifies the portrait that's displayed in Unreal Tournament 2004's
character selection screen.

Text This property controls the text in the character's bio on the character selection
screen.

Sex This setting enables you to specify whether your character is male or female,
which is important when Unreal designates a voice and creates death messages
for your character, such as "UTGuy has blown himself up."

CombatStyle This bot setting controls how a bot would behave in combat if controlling this
character.

FavoriteWeapon As its name suggests, this property allows you to specify which weapon this
character favors. Naturally, it's valid only when a bot is controlling the character.

BotUse This setting is a 0-255 value that controls the chance that a bot will use the
character. A value of 0 disables the character for bot use; higher values increase
the odds that the bot is added to your level.

END TUTORIAL 22.11

----_.. __._---,---,---- ...
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Summary
In this chapter, you have examined how to make a modeled and textured character playable in

Unreal Tournament 2004 by using the default animations from the game. You have learned how

to import skeletons, how to skin your character, and what steps you need to take to get the char-
22 acter into UnrealEd. You also learned how to add existing properties and animations to the char

acter, set up his portrait, and finaJly create the UPL file so that the character can be selected just

like the characters included in the game. From here, you should be ready to create your own army

of playable characters for the Unreal universe.



/

Chapter

Character Animation

So far, you have modeled a character, and covered it with some sort

of texture. You have also seen how to attach a character's geometry

to a skeleton, and to import the character into Unreal so that it uses

the prefabricated animations included with Unreal Tournament

2004. Now we will breathe life into the character by giving it motion.

In this chapter, you will be introduced to the concepts of animation

in Maya, in order to create a control system by which to move the

character's skeleton, and fina.lly to create a series of animations to

make the character mimic human movement. We will also show you

how to export your own character animations into Unreal, rather

than using the animations that are included with the Unreal

Tournament 2004 characters.

Introduction to Animation
Generally, when someone thinks about animation, one of the first

things that comes to mind is physical motion. Although this is true,

it does not accurately portray what animation is. In Maya, anima

tion is defined as the change in an attribute value over time. There

are thousands of attributes in Maya that can be animated. These

parameters range from an object's location in world space, to light

- --------------- --- --- -------
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intensity, material parameters, and so on. A wide range of effects can be generated through ani

mation. Of course, the world of animation in Maya as it relates to Unreal Technology is generally

movement and rotation animation.

When dealing with animation, we are required to work with time. This means that animation in

Maya typically refers to the change in an attribute value as time progresses. Time in Maya is rep

resented through frames, so one could say that a frame is a division of time. The number of

frames representing one second depends on the target media for which the animation is being

produced. NTSC Television has a playback rate of 29.97 frames per second, whereas film has a

23 playback rate of 24 frames/second. For Unreal-related games and simulations, 30 frames/second

is standard.

Popular Animation Methods in Maya
When animating in Maya, the artist must first decide which method of animation to use. This is

determined by the project at hand and the personal preferences of the animator. Maya offers many

different animation approaches: keyframes, reactive animation, dynamic simulations, expressions,

path animation, and more. In the world of game design, you will find that keyframes and reactive

animation are most commonly used. The next two sections will focus on these methods.

Keyframes

Keyframe animation is by far the most common method of animation in nearly every 3D software

package available. The animation process involves an animator recording an attribute value at a

given frame; this recording is referred to as a keyframe. The keyframe stores both the frame and

the current attribute values. The animator then advances to another frame, generally later in time,

changes the attribute's value, and records another keyframe. With only two keyframes recorded,

Maya can interpolate the change in the attribute's value between the two keyframes as time

changes. The interpolation generated by Maya results in animation taking place between the two

keyframes.

This interpolation is represented by what is called an animation curve. The animation curve

defines the value of an attribute at any given point in time. The curve travels from keyframe to

keyframe, passing through each one along the way. This curve is stored in an Animation Curve

node. A separate Animation Curve node is generated for each attribute that is keyframed. If you

were to look at any of these curve nodes in the Attribute Editor, you would find a table. The table

stores all of the keys recorded for that given attribute. Additional keyframes created for that

attribute are simply added to the table.

In FIGURE 23.1, an object's Translate X, Y and Z attributes have been keyframed. Three anima

tion curve nodes have been created. Notice the table in the Attribute Editor on the right. This is

where the keyframes for the selected Animation Curve node are stored.

r------------------------
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FIGURE 23.1 The three nodes form the animation curves, along with the table of keyframes in the
Attribute Editor.

Although the animation curve is a representation of how Maya will interpolate a given attribute's

value between keyframes, the animator does have the ability to edit its shape, which in turn

directly affects the animation. Editing the curve is done through Maya's Graph Editor. The Graph

Editor is a utility that allows an animator a way to visualize how the interpolation between

keyframes wiJJ take place, edit keyframe timing and attribute values, and adjust the overaJJ shape

of the curve.

To understand how an animation curve can be edited, you must understand tangents. A tangent

defines how an animation curve enters and exits a keyframe. This means that we have an in-tan

gent and an out-tangent for every keyframe created. There are five tangent types available in

Maya:

~ Spline-Generates a smooth interpolation into and/or out of a keyframe.

~ Linear-Generates a constant interpolation into ?nd/or out of a keyframe.

~ Clamped-Generates a smooth interpolation into a keyframe and prevents overshoot

from occurring if a value is to be held for a specific number of frames.

~ Stepped-Keeps an attribute's value constant until the next keyframe is reached; the

change is instant.

~ Flat-All tangent handles wiU be horizontal. This generates an ease-in/ease-out condition

for each keyframe.

~---~- --._---~--~..__._----~------
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Although the curve can be edited by assigning new tangent types to a keyframe, you can also use

the tangent handles (visible when a keyframe is selected in the Graph Editor) to define custom

tangents. TUTORIAL 23.1 walks you through the basic steps of animating a bouncing ball, using

keyframe animation and the Graph Editor.

TUTORIAL 23.1: Basic Keyframe Animation

1. Open Maya and begin a new scene.

2. Create a NURBS sphere. We will refer to this object as our ball.

3. Activate the Move tool. In the Perspective view, move the ball in the Z-axis so that it
appears to be sitting on the edge of the grid. Then move the sphere up along the Y-axis so
that it appears to be sitting on top of the grid (see FIGURE 23.2).

FIGURE 23.2 The sphere has been positioned so that it appears to be sitting on top of the grid.

4. Before we begin animating our ball, we need to define the length of our animation. In the
Range Line at the bottom of the UI, set the Start Time to 1 and the End Time to 60. Set
the Playback Start Time to 1 and the Playback End Time to 60. We have just blocked off

60 frames (2 seconds) for our animation (see FIGURE 23.3).

..
I
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I

FIGURE 23.3 The range slider has been set to 60 frames.

5. Verify that the viewport has focus (you should see a dark blue border around it) and then
press the S key. This is the hotkey for setting a keyframe. By default, every attribute that
is visible in the Channel Box will receive a key. Note that all of the transform attributes
have changed from white to an orangish color. This indicates that they have been keyed.



A total of ten keyframes have been created: three for the translate attributes, three for the
rotate attributes, three for the scale attributes, and one for visibility. Now, not all of these
keyframes are necessary. In our animation, the plan is to animate the ball bouncing along
the Z-axis. To achieve this animation, all we'll need to do is animate the Translate Y and Z
attributes. The Z-axis will supply our forward motion, although the Y-axis will allow the ball
to bounce up and down. All of the remaining attributes that have been keyframed will
become what are known as static channels, meaning that they represent no change over
time. If you have enough of them, static channels can actually slow Maya's calculation
down. We will address this issue shortly.

-------- ._---------- ----------.-...
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6. In the Timeline, drag the Time Slider to frame 60. This is where we will record our next set
of keyframes. After moving the Time Slider, move the ball along the Z-axis so that it
appears to be sitting on the other side of the grid. Press the S key. Another ten keys are
recorded. If you look at the timeline, you will notice red tick marks, one at frame 1 and the
other at frame 60. These marks represent keyframes (see FIGURE 23.4).
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FIGURE 23.4 The ball has now been animated, moving from one side of the grid to the other.

If you drag the Time Slider back and forth, you'll find that the sphere moves from left to
right. This is because only the Translate Z attribute has received a parameter value
change, and Maya is interpolating that value between the keys. All of the other attributes
are static, so no visible change will occur.

7. Now we will anchor the ball at frames 20 and 40. This will make it easy for us to add the
bounce. Move the Time Slider to frame 20 and without moving the sphere, press S. Move
the Time Slider to frame 40 and press S again. If you drag the Time Slider back and forth,
you will notice that the animation has not changed.

8. Because we've recorded values of the ball on the ground at frames 20 and 40, adding the
bounce will be easy. Drag the Time Slider to frame 10 and move the ball up in the Y-axis
(see FIGURE 23.5). Press S to record keys.

------- -- ._- --- -~- --- -
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FIGURE 23.5 The ball has been moved off the grid as we begin to animate the bounce.

9. Move the Time Slider to frame 30 and watch what happens. You will notice that the ball
will drop back down to the ground by frame 20. This is because of the keyframe that you
set at frame 20 just a moment ago. It's pulling the ball back down to the ground. These
keyframes were used to "anchor" the ball to the ground. When the Time Slider is at frame
30. move the ball up again and press S. Repeat this for frame 50 as well.

...,....
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The Preferences dialog for Maya.

_.
... -

u'""......

FIGURE 23.6

Click the Play button. You should have some sort of bouncing ball. Although it is not the
most realistic-looking bounce, the ball is indeed moving up and down as it travels in the Z
direction. If the ball is bouncing at a crazy speed, you probably have the Play Every Frame
option activated in your preferences.
For the most part, this setting is
only required when working with
dynamics. In our case, we will want
to view the playback in real time.

To set the playback speed to real
time you can open the preferences
dialog (Window> Settings/
Preferences> Preferences). shown
in FIGURE 23.6. In the Categories
list, select Timeline, and set
Playback Speed to Real-time (30
fps). Play the animation again.

10.

11.

END TUTORIAL 23.1

Now that we have a bouncing baH (well, sort of), we need to refine the animation curves that

Maya has produced. TUTORIAL 23.2 will take a basic look at using the Graph Editor for editing

the shape of the animation curves Maya has generated.
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TUTORIAL 23.2: Using the Graph Editor

1. Continuing from TUTORIAL 23.1, open the Graph Editor: choose Window> Animation
Editor> Graph Editor. (See FIGURE 23.7.)

r- FIGURE 23.7 The animation curves generated from animating the ball.

The Graph Editor can be divided into four elements: the menu bar, the toolbar, the outliner
(left), and the graph view (right). By default, the outliner will show selected objects and
only their animated attributes. By highlighting an object within the outliner, you will see all
of the animation curves in the graph view. If you select individual attributes in the outliner,
you will only see those curves.

In our case, if the embedded outliner is empty, the ball has become deselected. Simply
move the Graph Editor to the side and reselect the ball.

2. At this point, we have already added all of the keyframes necessary for our animation. In
fact, we've added too many keyframes (don't forget all of those static channels mentioned
earlier!). Before we begin editing our animation curves, let's get rid of all unnecessary ani
mated channels.

In the Graph Editor, highlight all attributes with the exception of the Translate Y and
Translate Z.

3. From the Graph Editor's menu bar, choose Edit> Delete. All of the highlighted attributes
are now deleted. Select the sphere in the Graph Editor's outline and you will see only two
animation curves: the curves for Translate Y and Translate Z. From the menu bar, choose
View> Frame All. This will position the graph view such that both animation curves fill the
area (see FIGURE 23.8).

---_._.- ._.._---- --- ----_._--- ... - ..-.-_.._----------_._--- ---------------
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FIGURE 23.8 All of the static channels have been deleted.

With the static channels out of the way, we can now focus our efforts on making the ani
mation look better. Because all of oar keyframes have already been recorded and the infor
mation they contain is correct, we are left only with manipulating the way Maya
interpolates between those keyframes. As mentioned earlier, this is done through the
manipulation of keyframe tangent handles.

4. In the Graph Editor's outliner, select the Translate Y attribute so that we can focus only on
this animation curve in the graph view.

5. In the Graph view, marquee-select the four keyframes at the bottom of the curve (see
FIGURE 23.9).

FIGURE 23.9 Select the four bottom keyframes.

--- -~-----~--~--~--------._--~---
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TIP
It will be easier if you marquee-select each tangent
handle that you are trying to add to the selection.

6. In this step, we are going to change the in- and out-tangents of each keyframe to linear.
Linear tangents provide a direct interpolation in and out of keyframes, depending on which
tangent is set. By setting all of the tangents on the bottom keyframes to linear, we will
create a distinct impact when the ball hits the ground.

With the four keyframes selected, choose Tangents> Linear. Play back the animation.
Although the motion is still not 100% perfect, it is starting to look better. The curve now
produces a more direct change when the ball hits the ground.

7. We can fine-tune this curve even further by manipulating the keyframe tangents directly. As
mentioned previously, you can see the tangent handles by simply selecting a keyframe. By
default these handles are tied together so that if one is moved, the other would move in
the opposite direction, in a see-saw fashion. In our case, we need to break this connection
so that we can move each handle independently of the other.

With the four keyframes still selected, choose Keys> Break Tangents. You will notice that
all of the tangent handles on the left side of their associated keyframe (the in-tangents)
have turned blue. The color change indicates that the tangent handles have been broken
and can now be freely manipulated independently of one another.

8. Select all of the in-tangents (the tangeQt handles to the left of each key). You will need to
hold down the Shift key while selecting the handles.

9. Activate the Move tool from the tool
box. Move the mouse over one of the
selected tangent handles and drag
with the middle mouse button to move
the tangent handles upward (see
FIGURE 23.10).

FIGURE 23.10 The in-tangent handles have been moved up.
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10. Repeat step 9, but this time select

and manipulate the out-tangents

instead of the in-tangents (aee
FIGURE 23.11).

TIP'
If you lose your selection, it is easy to find the tangent
handles again. All you need to do is select the associ
ated keyframe and the handles will again be visible.

23

FIGURE 23.11 The curve is starting to take shape.

11. Play back the animation. You will notice that the ball slows down as it approaches the
apex of each bounce. This is due to the way the animation curve has been edited. Take a

minute to study the curve and its relationship to time versus change. With a little practice,

editing curves to achieve the desired animation is very easy.

END TUTORIAL 23.2

Reactive Animation

Reactive animation is more of an indirect approach to achieving an attribute change over time.

But in this case, instead of time being the driving factor of the attribute's change, the attribute

responds in reaction to another attribute. This method of animation may seem a bit confusing at

first, but when you've mastered the concept, its application is a breeze.

In a reactive animation scenario, there is always one Driving attribute. This is the attribute that is

responsible for causing change to occur in some other' attribute. The attribute that is changed by

the driver is referred to as a Driven attribute. It is important to note that you may have one Driver

attribute controlling several Driven attributes, even on multiple objects! However, each Driven

attribute can only have one Driver attribute.

In Maya, reactive animation is defined through the Set Driven Key (SDK), which is simply the

recording of attribute relationships. The recordings are stored in keyframes, and as with regular

keyframe animation, Maya will interpolate between them. But in the case of reactive animation,
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manipulating the Time Slider will not have an effect on the animated object. Instead, you would

need to manipulate the Driver attribute, which will in turn alter the value of the Driven attribute.

In TUTORIAL 23.3, we are going to create a very simple reactive animation. Our goal is to have

a sphere appear to shrink when another sphere is moved up in the Y-axis. We will name these two

objects sDriver and sDriven to help better demonstrate the relationship between the two.

TUTORIAL 23.3: Using Maya's Set Driven Key (SDK)

1. Create two NURBS spheres. Name the first object sDriver and the second sDriven.
Position them in the X-axis so that they are not on top of one another. Do not move them
in the V-axis. (See FIGURE 23.12.)

FIGURE 23.12 Two spheres will be used to demonstrate the Set Driven Key ability of Maya. The
sphere on the left will "drive" the scale of the sphere on the right.

2. From the Animation menu, choose Animate> Set Driven Key> Set> Options Group [Q].
The Set Driven Key dialog opens (see FIGURE 23.13).

The Set Driven Key dialog is divided into four key areas: the menu bar, the Driver group,
the Driven group, and then buttons at the bottom. When the dialog is first opened, the
Driver group will be empty, but the Driven group will have information loaded if any object
was selected before the dialog was open. If any of the boxes do contain data, do not worry
about it; it's about to be overwritten anyway.

793
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FIGURE 23.13 The Set Driven Key dialog.

3. Select the sphere named sDriver
and click the Load Driver button in
the SDK dialog. You will notice that
sDriver appears in the left box in
the Driver group section (see
FIGURE 23.14). The right box will
contain all of sDriver's properties.
Repeat this process for the driven
object: Select sDriven and click the
Load Driven button.

4. Now that we have determined the
driver and driven objects, it is time
to specify which attributes will be
involved in the relationship.

In the Set Driven Key dialog. select
Translate Y in the Driver group and
Scale X, Y, and Z in the Driven
group.
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FIGURE 23.14 The sDriver and sDriven objects
have been loaded into the SDK dialog.



You can hold the Ctrl key down while selecting multi
ple attributes, or you can click and drag with the
mouse if the attributes are all stacked atop one
another, as in this case.

You must be very careful when placing the keys of a
reactive animation. It is sometimes easy to get con
fused as to which attribute should be doing what. Also
you must remember that you have to change the value
of the Driver object first, adjust the value of the Driven
object, and then click the Key button. If this pattern is
not followed, the animation will not work properly.

795
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TIP'~

• When sDriver's Translate Y
attribute value is 5, sDriven's
SCale X, Y, and Z values are all
at 0.25.

5. You are now ready to start setting
keys, or if you prefer, recording relation
ships between the two attributes. But
before we begin, you should always
have a clear understanding of what it
is you are trying to achieve. In our
case, we are looking to set up the
following two relationships:

• When sDriver's Translate Y
attribute value is at 0, sDriven's
Scale X, Y, and Z values will all
be at 1.

"",""""oZ
rolotoX
rd,otoY
rol...z
sc.IoX
=«.Y
.caloZ

_._----l •

FIGURE 23.15 Set up the second relationship
and record the values with the Key button,

The effect of this reactive animation would be as follows: As the driving sphere is moved
up, the driven sphere will progressively get smaller. The driven sphere will continue to uni
formly scale down until the driving sphere reaches 5 units. At this point the driven sphere
will have a Scale X, Y, and Z value of 0.25. If the driving sphere is moved above 5 units,
no further scaling action will occur to the driven sphere.

Let's begin by recording the first
relationship. Currently, the driving
sphere is still at a Translate Y value
of 0 and the driven sphere has a
Scale of 1 (we will be referring to
Scale X, Y, and Z simply as Scale
throughout the rest of this tutorial).

7. Select sDriver and move it up and
down. Watch what happens to the
driven sphere. This is a reactive ani·
mation; as one attribute is changed,
another attribute is directly changed.

Click the Key button in the SDK
dialog.

6. Move sDriver 5 units up in Y. Select
sDriven and set its Scale to .25 (see
FIGURE 23.15). Click the Key
button to record the relationship.

END TUTORIAL 23.3

- ---- -- ---------



23

796 Chapter 23 Character Animation

Animation Choices-FK Versus IK
Before a character can be animated, there is generally a great deal of preplanning involved. One

of the most important decisions that an animator must make involves simply figuring out how

the character will be animated. There are three main ways to animate the joints of a character.

These are Forward Kinematics, Inverse Kinematics, or a combination of both.

Forward Kinematics, also known simply as FK, is the name given to the method of rotating a parent

joint in a hierarchy. As the parent is rotated, the children revolve around the parent joint while

maintaining their distance from one another. This can be both good and bad. FK allows complete

freedom when animating because you are not hindered by the inability to rotate any specific joint.

It's also easier to achieve fluid arcing motions, such as arms swinging. Conversely, however, this ani

mation method can be rather slow, and it can be very tedious to achieve decent results this way.

Inverse Kinematics, called IK for short, is a method of joint animation in which the user does not

directly rotate the joints. The term inverse comes from the fact that rather than rotating a parent joint,

the animator indirectly moves the children with an IK handle, and the parent joints automatically

rotate to accommodate the movement. As~ example, consider grasping your friend's wrist and mov

ing it about. You would see their shoulder and elbow rotate to allow for the movement of the wrist.

To be more technical, IK involves the use of an Inverse Kinematic Solver, which calculates a rota

tional solution for the involved joints, based on the position of an IK handle. This may sound very

confusing at first, but after you use IK a few times, you will see that there's really nothing to it. In

TUTORIAL 23.4, you will see how to animate a simple skeletal arm using both FK and IK.

TUTORIAL 23.4: Animating Joints with FK

1. Launch Maya, and start a new scene. Make sure that you are in the Animation menu set,
or press F2 to go there.

2. In the Side viewport, create a series of three joints in the configuration of an arm. Name
the joints Shoulder, Elbow, and Wrist.

Now, create a cylinder, and place it a few units in front of the arm (see FIGURE 23.16).
Name the cylinder Grip. Imagine this as a handhold that the character will grasp and use
to pull itself forward.

3. In the Range Slider, set your animation range from Frame 1 to Frame 30. When finished,
save the file as FK_IKstart.

4. Because we're animating with FK, we will be rotating each of the joints by hand. Therefore,
we must place keyframes on the joints that require animation, in this case the Shoulder
and Elbow joints.

Set the Time Slider to Frame 1. Make sure that the Caps Lock key is not active. Select the
Shoulder and the Elbow joints, and press Shift+E. This will place a keyframe on only the
rotational attributes of the joints. This is a great way to help prevent creating a vast
excess of static channels as we would with the S key.
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FIGURE 23.16 A simple joint chain for a basic arm.

5. Set the Time Slider to Frame 15. Rotate the Shoulder and Elbow so that the wrist joint is
resting on the Grip cylinder, as shown in FIGURE 23.17. When finished, select the
Shoulder and Elbow joints, and press Shift+E again, in order to place a new keyframe.

FIGURE 23.17 Arm is rotated so that wrist is grabbing the cylinder.

At this point, you can drag the Time Slider back and forth and you will see that the arm is
now animated.

8. Now, between Frames 15 and 30, we want the Shoulder to move forward, but for the wrist
to remain planted on the Grip, as if the character was pulling itself forward. This will be a
little more difficult than it seems.

~- ~--- --~--- ------------------~---
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Select the Shoulder joint, and verify
that you are still at Frame 15. Press
Shift+W, which will place a keyframe
on all of the translate attributes of
the shoulder.

7. Drag the Time Slider to Frame 30,
and use the Move tool to move the
Shoulder joint forward. Move it
about half the distance to the Grip
cylinder. Notice the problem that
occurs: The Wrist joint does not stay
planted on the Grip cylinder (see
FIGURE 23.18). Instead, it moves
forward in tandem with the shoulder,
due to the nature of parenting sys
tems in Maya and animating with FK.

----~--- -----------------------

FIGURE 23.18 The forearm and wrist move
through the cylinder.

Verify that the Shoulder joint is still selected and that you are at Frame 30, and press
Shift+W. Drag the Time Slider back and forth between Frames 1 and 30. Notice that the
rotation is nice between Frames 1 and 15, but the translation disrupts the effect between
Frames 15 and 30.

8. Challenge: Using the skills you have learned, rotate the elbow and shoulder joints between
Frames 15 and 30 so that the Wrist joint stays in the same location after Frame 15. This
is not as easy as it may seem. You are only allowed to fix this through rotating the joints;
you may not move them. When you are finished, make sure that you do not save over your
existing file.

END TUTORIAL 23.4

You have now seen how to animate the joints using Forward Kinematics, along with the benefits

and drawbacks to an FK system. In TUTORIAL 23.5, you will animate the same scenario using

an Inverse Kinematic setup.

TUTORIAL 23.5: Animating Joints with IK

1. Reopen the FK_IKstart file that you saved earlier in the last tutorial. We will now attempt
the same exercise using Inverse Kinematics rather than Forward Kinematics.

2. From the main menu, choose Skeleton> IK Handle Tool> Options Group. In the Tool
Settings dialog, set the Current Solver to ikSCsolver. This will create a Single Chain IK
Solver, which is the simplest of the available IK solvers in Maya. We will discuss the
available solver types shortly.

------------
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3. We need to select the start joint for the IK Solver. In this case, we will use the Shoulder
joint. Click on it to select it, and notice that the entire joint chain becomes highlighted in
green.

Now, click on the Wrist joint, and notice that a small green handle appears at the location
of the wrist, and that this handle is automatically selected. Also, note that the joint chain
has turned a shade of bright purple (see FIGURE 23.19). Often in Maya, this color is
used to designate which objects are being influenced by the selected object. In our case.
the joints of the chain are being influenced by the IK handle, and so they turn purple when
the IK handle is selected.

,
I,

,.--'

Move the IK handle around a bit, and
see how the arm responds. Undo the
movements with the Z key when
finished.

4. Make sure you are at Frame 1. With
the IK handle selected, press Shift+W.
Remember that animating with IK
requires that you animate the position

of an IK handle, rather than the rota
tion of selected joints. as in FK.

Go to Frame 15, and move the IK
handle so that the wrist is on the
Grip cylinder. Press Shift+W again to
set a second keyframe. If you drag
the Time Slider back and forth now
between Frames 1 and 15, you will
see an animation in which the arm
reaches for the Grip cylinder.

5. At Frame 15, select the Shoulder
joint and press Shift+W. Advance
the Time Slider to Frame 30. and
move the shoulder forward, about
half the distance to the Grip cylin
der. Notice that the wrist stays in its
exact same location throughout the
movement. This is because the
Wrist joint will always match the
location of the IK handle. and the
other joints of the chain must rotate
to allow this to take place, as seen
in FIGURE 23.20.

END TUTORIAL 23.5

FIGURE 23.19 The IK Solver has now been
created for the arm.

FIGURE 23.20 For this situation, the arm is
much easier to animate using IK.

... - - -- --- ----------
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IK Solvers
When animating in Maya, you have a choice of three different IK solvers. These are the Single

Chain IK Solver, the Rotate Plane IK Solver, and the Spline IK Solver. Each of these solvers has its

own individual functionality, and each can be applied in a variety of ways.

Single Chain IK Solvers

Single Chain IK is the simplest type of IK available by default in Maya. A Single Chain IK Solver
will solve the rotation of at least two joints based on the location of its IK handle, and the pre

ferred angle of the given joints. A joint's preferred angle is the angle that is used to tell the direc
tion in which a joint should bend when affected by IK. Without this, the joint chain will fail to

rotate properly, or may simply not rotate at all. In TUTORIAL 23.6, you will see how the pre

ferred angle is used to control rotation in a simple Single Chain IK scenario.

TUTORIAL 23.6: Setting Preferred Angle on Joints

-~-

1. Start a new scene in Maya, and ver-.
ify that you are in the Animation
menu set. Switch to the Side view.

2. Activate the Joint tool. Then, holding
down the Shift key, click three times
to create three joints in a vertical
configuration, starting at the top and
moving down. Notice that the Shift
key has caused the joints to be cre
ated in a perfectly straight line (see
FIGURE 23.21).

3. Using the IK Handle tool, create a
Single Chain IK Solver that runs
from the first joint created to the
last. As demonstrated earlier in
TUTORIAL 23.5, this creates the
IK Solver.

4. Try to move the solver's handle
about, and notice that the joint
chain does not bend. This is
because the joints have no preferred
angle. To fix this, first delete the IK
Solver, and then in the Side view,
select the second joint, and rotate it
in the Z-axis. You may rotate it in
either direction; just keep in mind

. - --------- - ---------------- ---

FIGURE 23.21 The Shift key allows you to
constrain the creation of joints to a straight line.

NOTE
For the sake of controlling the direction the arm bends
when using the solver, you do not need to worry about
how far you rotate the joint. Any rotation whatsoever In
a given axis will determine how the IK Solver will
rotate the joints.



that your choice will determine
which way the joint chain will bend
when you move the IK handle.

5. Hold down the right mouse button
on the second joint. From the con
text menu, choose Set Preferred
Angle. This will record the direction
that you bent the joint, and with
this, the IK Solver knows the direc
tion to bend the chain. Set the
Rotate Z attribute back to 0 to
straighten the joint chain. Add the
Single Chain IK Solver back in.
FIGURE 23.22 shows the setting
of the preferred angle.

6. Now that you have set the preferred
angle for the joint and added the IK
Solver, select and move the IK han
dle again. Notice that you can now
see the joints bending to accommo
date this new angle, rather than
staying perfectly straight.

END TUTORIAL 23.6

Rotate Plane IK Solvers
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FIGURE 23.22 Setting the preferred angle is
critical when joints have been created in a straight
line.

NOTE
When creating a joint chain, any bend in the chain's
direction will result in a preferred angle automatically
being set. In most cases, you will only need to manu
ally set the preferred angle when you create the joints
in a perfectly straight line.

The other main IK system available in Maya is the Rotate Plane IK Solver. It is different from the

Single Chain IK Solver in one major respect: You can alter the rotation of the plane upon which

the joints are solved. To fully grasp this concept, try to imagine all of the joints in an IK system

rotating so that they always exist on the same plane. Take the joints at your shoulder, elbow, and

wrist, for example. As you move your arm around, those three joints are always on the same plane.

If you were to rotate that plane from your shoulder, you would, in effect, be wagging your elbow

back and forth. This is exactly the same type of control available with the Rotate Plane IK Solver.

In TUTORIAL 23.7) we will take a look at how we can apply and manipulate a Rotate Plane IK

Solver.
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TUTORIAL 23.7: Creating a Rotate Plane IK Solver
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1. Start a new scene in Maya, and cre
ate a three-joint chain to represent
an arm. Name the joints Shoulder,
Elbow, and Wrist. For now, do this in
one of the orthographic views. Make
sure there is a slight bend at the
elbow to accommodate an auto
matic preferred angle.

2. From the Skeleton menu, choose IK
Handle Tool> Options Group. In the
settings for the tool, set the Current
Solver to ikRPsolver. Click on the
Shoulder joint, and then on the Wrist.
Just as with the SC Solver, an IK han
dle has now been created. You will
notice, however, that it looks a bit dif
ferent (see FIGURE 23.23). There'
is a ring at the top, with a white
arrow. This shows the location of the
current plane and is often referred to
as the Joint Chain plane indicator.

3. To edit the location of the rotation
plane, press the T key to invoke the
Show Manipulator tool. You will see a
new Move manipulator appear near
the shoulder (see FIGURE 23.24).
This is the Pole Vector handle. As you
move the handle, notice that the
joints rotate from the shoulder in
such a way that the elbow always
points to the pole vector manipulator.
In this way, you can adjust the orien
tation of the solver's rotate plane.

FIGURE 23.23 The Rotate Plane IK Solver looks
a bit different than the Single Chain IK Solver
because of the Joint Chain plane indicator located at
the starting joint of the IK Solver.

FIGURE 23.24 Moving the Pole Vector handle
causes the plane that the IK Solver solves on to
rotate.

4. At the bottom of the IK handle, near the wrist, you will see the Twist disc, a ring-like manip
ulator. This allows you to control the Twist of the solver, which acts like an offset from the
plane rotation provided by the pole vector. It also provides you with a way to move the
rotate plane while only animating a single value, rather than three, as you must with the
pole vector.

This type of IK is perfectly suited for creating control systems for areas of a character
such as arms and legs. The control it offers is very similar to wagging your elbow or knee.

END TUTORIAL 23.7

!--- - - -- ._---.
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IK Spline Solvers

The third kind of solver available in Maya is the IK Spline Solver. Compared to the other two, this

solver is unique in that rather than the joint rotations being calculated from the position of an IK

handle, the joint chain for the solver is influenced by a NURBS curve. As the control vertices

(CVs) of the curve are moved, the curve changes shape, which will cause the joints to try to fol

low the shape of the curve as best they can. This kind of IK is perfectly suited for character spines,

tentacles, tails, whips, chains, and any other ropelike object. In TUTORIAL 23.8, we will demon

strate how to apply this kind of IK to a simple joint chain.

TUTORIAL 23.8: Using Spline IKI
I:

1. Start a new scene in Maya, and
switch to a Side view.

2. Using the Joint tool, hold the Shift
key and create a vertical column of
about 8 to 10 joints. Start at the
bottom and work your way up, and
space them out as evenly as you
can.

3. From the Skeleton menu, choose IK
Spline Handle Tool. Click on the first
joint you created, and then click on
the end joint. You will see what
appears to be an IK handle, though
you will not be able to move the IK
handle directly_

FIGURE 23.25 A curve is created when an IK
Spline Solver is used. The joints will rotate in such a
way that their chain matches the shape of the curve
as best it can.

~-~---

4. In the Status Line at the top of the UI, click on the Joints selection type so that joints are
no longer selectable. Switch to Component mode, and make CVs selectable.

5. Marquee-select over some of the joints. You will see that a NURBS curve has been created
within the joint chain. Select and move the CVs of the curve. You will notice that as the
shape of the curve changes, the joints will rotate to approximate the curve's shape. Using a
variety of different animation methods, you could animate the location of these CVs and
thereby animate the joint chain. You can see an IK Spline Solver in FIGURE 23.25.

END TUTORIAL 23.8
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Constraints
Constraints provide a way to bind the translation, rotation, or scale of one object to another. The

relationship created is similar to parenting, but the differences become quite obvious when you

begin working with them. As discussed previously, with a parenting relationship, the child object's

Transform node is influenced by the parent's Transform node. When the parent is transformed,

the child is transformed as well. Translations, rotations, and even scales will have an effect on all

child objects. Also, although a child is affected by its parent, the child can still be moved, rotated,

and scaled independently.

Constraining objects has a more direct effect on specific attributes. The child object is con

strained so that it cannot be directly affected by the user without special operations. The

Constraint node ensures that the constrained object will only receive data from the object it is

constrained to.

Although Maya provides several types of constraints, six of them are very helpful when setting up

a character control system, or rig. TABLE 23.1 describes these constraints.

TABLE 23.1 Maya's Constraints

Point

Aim

Orient

Scale

Parent

Pole Vector

Point constraints lock the translation of one object to another.

Aim constraints allow for an object to be constrained in such a way that it
will always rotate to point toward the object it is constrained to.

Orient constraints will lock the orientation of one object to another.

Scale constraints will lock the scale of one object to another.

Parent constraints serve as a combination of both Point and Orient
constraints mixed.

A Pole Vector constraint is a special constraint used in conjunction with
Rotate Plane IK Solvers. In essence, it provides the IK handle with a target
that controls the orientation of the plane upon which the joints are rotating.

In TUTORIAL 23.9, you will see how you can apply constraints to objects in Maya to exert

specific controls over objects as you animate them.

TUTORIAL 23.9: Applying Constraints to Objects

1. Start a new scene in Maya.

2. Create two objects:

NURBS Cone (Name: Locked_Child)

NURBS Sphere (Name: Parent)

Position the objects so that they can be viewed in the Front viewport (see FIGURE 23.26).



FIGURE 23.26 Using two objects to
demonstrate Point and Orient constraints.

FIGURE 23.27 The results of the Point and
Orient constraints.

l
3. When constraining one object to

another, the object that is being con
strained to is always selected first. In
our case, we are constraining the cone
to the sphere. Because the sphere will
act similarly to the parent in a parent
ing scenario, it must be selected first.
Select the sphere. Shift-select the
cone. From the main menu, choose
Constrain > Point. Notice the Translate
attributes in the Channel Box. The
color of the channels has changed
from white to a light sky-blue. This indi
cates that translation data is being
sent to the cone's translation chan
nels. FIGURE 23.27 shows the
result of this constraint.

After the constraint is applied, the
cone snaps to the sphere. To be
more precise, the cone's pivot snaps
to the sphere's pivot.

4. Select the cone and move it. It
appears to move without a problem,
but see what happens when you move
the sphere. When the sphere is
moved, the cone snaps back to its con
strained location and moves along with
the sphere.

5. So what happens if we need to offset
an object that has been constrained?
This is not a problem, as all that needs
to be done is adjust the pivot point of
the constrained object. Select the
cone. Press the Insert key and move
the cone's pivot down in the Y-axis.
Because the pivot of the cone is con
strained to the pivot of the sphere, the
pivot will not be seen moving. Instead,
the cone will move in the opposite
direction. Continue to move the pivot
point until the cone is sitting on top of
the sphere as if it were a hat. Press
the Insert key again to exit pivot-modifi
cation mode (see FIGURE 23.28).

Constraints 805

FIGURE 23.28 Manipulating the pivot point for
the cone allows an offset to be created between the
two objects.

'------_. ------------- - --- --' .-
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6. As the sphere is moved, the cone
will maintain its offset although
moving along with it. Try rotating
the sphere. Notice that the cone
stays in place. This is because
we are not sending any sort of
rotation data to the cone. To
have this happen, we need to
orient-constrain the cone to the
sphere.

Select the Sphere. Shift-select the
cone. From the main menu,
choose Constrain> Orient. Notice
the Rotation attributes in the
Channel Box. The color has again
changed to the light blue.

7. Rotate only the sphere and
observe the cone. Notice the rela
tionship between their rotations,
as shown in FIGURE 23.29.

END TUTORIAL 23.9

Selection Handles

NOT~ .. c....u ...

If you look in the Shapes area of the Channel Box, you can
actually see the node created by the constraint If you click
this, three attributes will become visible: Offset X, Y, and Z. You
can use these as a way to create an offset between two con
strained objects without having to change their pivot points.

FIGURE 23.29 With the cone oriented to the sphere,
all rotations applied to the sphere will affect the cone.

A selection handle is a transform component visible as an icon that can be used to simplify the

process of selecting an object that may be hard to locate. For example, it can be difficult to select

specific objects due to Maya's selection priority system when higher-priority objects are located

in the same space, such as an IK handle in the same location as a joint. A selection handle is sort

of an alias to an object. When the user clicks on a selection handle, the associated object is

selected. Best of all, selection handles have the highest selection priority, making them the easiest

thing to select in the viewport.

Every object in Maya has a selection handle. By default, however, these selection handles are hid

den. TUTORIAL 23.10 will demonstrate how to make selection handles visible as well as how to

relocate them.
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TUTORIAL 23.10: Using Selection Handles

1. Start a new scene in Maya.

2. Create a sphere.

3. With the sphere selected, from the
main menu, choose Display>
Component Display> Selection
Handles. Look closely at the center
of the sphere (this may require that

you rotate the Perspective view so
that the sphere's wireframe is not
hiding the icon). You will see that a
new icon is visible at the center of

the sphere. The default location is
at the object's pivot point and
because the pivot point was at the
center of the sphere, that's where
the selection handle is. You can
see the selection handle in
FIGURE 23.30.

4. Now let's take a look at how you can
move the selection handle. With the
sphere selected, press F8 to switch
to a Component mode. Click the
Selection Handle filter icon a- and
select the selection handle. The
selection handle will turn yellow indi

cating that it has been selected.

5. Activate the Move tool and move the
selection handle above the sphere
(see FIGURE 23.31).

6. Press F8 to return to Object mode.
Deselect the sphere. Marquee-select
the selection handle and take note
that it is the same thing as if you
had selected the sphere directly. By
strategically positioning selection
handles, an animator can always
select specific objects quickly.

END TUTORIAL 23.10

Selected Handle

FIGURE 23.30 Selection handles ease the
selection of objects that may be difficult to reach.

FIGURE 23.31 The Selection handle has been
relocated above the sphere.

OTE
Many beginners will confuse a selection handle and a

pivot. Keep in mind that moving a selection handle
does not alter the pivot information of an object

whatsoever.
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Character Rigs: What They Are and Why We Need
Them
Character rigs are special control systems that are set up throughout a character to ease the

process of animation. Rigs range in complexity from simple to sophisticated depending on the

animator's needs. For instance, a very simple rig might consist of a few custom attributes that

control set-driven key scenarios, making it easier for an animator to manipulate hard-to-reach

objects such a finger joints. A complex rig, on the other hand, might provide an animator with

numerous controls for positioning limbs, driving various facial features, along with custom

expressions used to automate elements of the character, such as breathing, pupil dilation, skin

stretching, and so on.

To better understand the need for a rig, let's take a look at a real-world example. Picture a mari

onette puppet. This type of puppet has numerous strings connected to various parts of its body,

which are used by the puppeteer in order to control the action it is performing. These strings

make up a rig that eases the process of bringing the puppet to life. Now, try to imagine how dif

ficult it would be to manipulate the puppet without this rig. In the 3D world, character rigs are

equally important. Although it is possible to animate the character without such a rig, the time

to do so will become significantly longer.

Character rigs require planning. You must first determine the type of animation required for the

character. Is the character simply going to be walking forward, or will the character need to be

able to perform a variety of nimble acrobatic moves as well? Next, the animator needs to decide

which controls would be required to drive the necessary joints or IK handles, as well as which

parts of the character should be automated to ease complex animation processes.

In TUTORIALS 23.11 through 23.13, we will explore various rig setups that will allow us to

easily control our character for animating the cycles needed by Unreal. The rigs are divided into

different categories: the legs, the arms, and the back. Keep in mind that there are many steps to

creating character rigs, so each step of the tutorial will be centered on a specific goal, and will

include several substeps.

Creating the Character Rig

To start, begin with creating the legs. The objective with the leg rig is to set up a central point of

control for each leg. This control object will be used to position the leg as well as rotate the vari

ous articulated parts of the foot.
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TUTORIAL 23.11: The Legs

1. Open the file LegRig_Start. mb.

2. The character rigging process generally begins after the character"s model is complete. To
prevent accidental geometry selection while developing the rig, it is good workflow to add
the character to a layer and save it as a template:

~ Select the character.

~ In the Layer Editor, click the Create a New Layer icon.

~ Double-dick on the new layer to open the Edit Layers dialog. Set the name to
UTGuy_Geometry and click Save.

~ Right-click on the layer and select Add Selected Object from the menu.

~ Template the layer by clicking the second check box in the layer. The letter "T"
should appear when the layer is templated.

~ Deselect the character and then try reselecting it. You will find that you are no
longer able to select the character. You will further note that the character ;s being
displayed as a light gray wireframe, even in a shaded view. This will make adding the
joints easier to do as we are now able to see through the geometry.

3. Before the rig can exist, we will need to create the leg joints. Because we will be creating
a reverse foot leg setup, we will need to set the Auto Joint Orient options of the Joint tool
to None.

~ From the main menu, choose
Skeleton> Joint Tool>
Options Group.

~ Set Auto Joint Orient to None
(see FIGURE 23.32).

~ Switch to a Side view and cre
ate the following joints: Hip,
Knee, Ankle, Ball, and Toe.
Make sure to name each of
the joints as they are shown
here. See FIGURE 23.33 for
placement.

~ When you have created the leg
skeleton, press the Enter key
to finalize the joint chain and
close the Tool Settings dialog
box. FIGURE 23.32 Setting Auto Joint Orient to None

for this particular joint chain.
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4. We will control this leg indirectly
through three Single Chain IK
Solvers:

~ From the main menu, choose
Skeleton> IK Handle Tool>
Options Group.

~ Set the Current Solver to
ikSCsolver.

~ Create the following IK solvers
(see FIGURE 23.34):

IK from Hip to Ankle. IK
handle name: ikAnkle

IK from Ankle to Ball. IK
handle name: ikBall

IK from Ball to Toe. IK
handle name: ikToe

5. Now that we have IK handles in our
leg, we need a way of controlling
them in such a way that their gener
ated solutions will provide a useful
result. We will use a second skele
ton chain for this control:

~ Activate the Joint tool. Verify
that the Auto Joint Orient
option is still set to None.

FIGURE 23.33 Creating the joints for the leg.
Note the placement of the joints.

FIGURE 23.34 Creating the three IK handles.

~ Hold down the V key on your keyboard. This will temporarily toggle the point snap option
on. Click near the Ankle joint you created earlier. Be very careful not to click on the
Ankle joint as you do not want to branch off the old skeleton. Instead, you are creating a
new hierarchy.

~ Create the next joint at the heel of the foot. Try to align this joint with the Ball and Toe
joints. Continue creating three additional joints snapped to the following: Toe, Ball, and
finally the Ankle.

~ Click the Enter button to complete the hierarchy. You can see the final result in
FIGURE 23.35.

6. Now that the control hierarchy of joints has been created, we need to parent each of the
IK handles to their respective inverse joint (see FIGURE 23.36):

Parent ikAnkle to iAnkle joint

Parent ikBall to iBall joint

Parent ikToe to iToe joint
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7. Although adding the inverse foot cre
ates a way for us to be able to con
trol the foot, it is not the most
intuitive way. We would need to
select iMain if we wanted to move
the foot around, and we would need
to select any of the remaining
inverse joints if we wanted to rotate
the foot joints in any way. In this
step, we are going to simplify the
process of controlling our foot by
creating a foot controller:

FIGURE 23.35 Creating the inverse foot skele
ton chain. The order of creation for the joints is very
important for this rig to function properly,

FIGURE 23.36 Parenting the IK handles to their
respective'joints. The Hypergraph shows the new
relationships.

~ With the FooCControl curve
selected, press the Insert key.
This will allow you to move the
pivot point of the curve. Hold
down the V key, move the
mouse over the Ankle joint, press the middle mouse button, gesture the mouse in
any direction, and the pivot point will snap to the Ankle joint.

~ From the main menu, choose
Create> CV Curve Tool>
Options Group.

~ From the Tool Settings dialog,
set the Curve Degree to 1
Linear.

~ In the Side view, draw an L
shaped outline that appears
to be connected to the bottom
of the shoe_ The actual shape
is not that important; some
thing that resembles a shoe
works great. The idea is to
create a control object that
can be quickly identified as a
foot control. Press Enter when
you are done outlining the
control. You can see an exam·
pie curve in FIGURE 23.37.

~ Rename the new curve:
Foot_Control.

~ Press the Insert key again to exit pivot-editing mode.

~ With FooCControl selected, Shift-select iMain joint.



23

812 Chapter 23 Character Animation------------------------------

~ From the main menu, choose Constrain> Parent.

~ Select only FooCControl and move it around to see how it affects the rest of the
leg. Undo all movements when you have completed testing it.

I!tvan.rlrlS:JCY__ -
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FIGURE 23.37 Using Curves as control objects makes it easier for an animator to determine
what control object controls what.

8. In this step, we are going to create three attributes (HeeIRX, BaIlRX, and ToeRX) that will
make it easier to rotate the joints in the inverse skeleton:

~ Verify that only FooCControl is selected.

~ From the main menu, choose Modify> Add Attribute.

~ From the Add Attribute dialog, add the following attributes (see FIGURE 23.38):

HeelRX (Type: float)

BallRX (Type: float)

ToeRX (Type: float)

9. In this step, we will use'the Connection Editor to make direct connections from the new
attributes we added in the last step to the various joints in the inverse foot chain:

~ From the main menu, choose Window> General Editors> Connection Editor,

~ Verify that FooCControl is still selected, and click the Reload Left button in the
Connection Editor. You will see that the list box will become populated with many dif
ferent parameters. You can verify that the FooCControl object was loaded by looking
at the bottom of the Connection Editor under the left-side properties box.

~ Select the iHeel joint and click the Reload Right button in the Connection Editor. You
are now ready to make the connection,

~ Scroll down on the outputs side until you locate the HeelRX property. Click on it to
select it as the origin of the connection.
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~ Scroll down on the inputs side until you see the Rotate property, Expand the
Rotate property so that you can see the three subentries, Click Rotate X to com
plete the connection. This means that whatever data is input into HeelRX will be
sent directly to the Rotate X of the iHeel joint, as shown in FIGURE 23.39.

- ,. ....- ...
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~ Make the remaining
connections:

,',

~OTE

You will only need to reload the Inputs side with the
iBali and iToe joints.

Adding attributes to Foot~Control to make it easier to control the InverseFIGURE 23.38
hierarchy.

BallRX > iBall.RotateX
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FIGURE 23.39 Connecting Foot_Cont rol.
HeelRX to iHeel. RotateX in the Connection
Editor.

~ Test the new attributes to make
sure they work by selecting them
one at a time in the Channel
Box, and then using the virtual
slider (middle mouse button
in the view panel) to see the
response, as shown in
FIGURE 23.40.

ToeRX > iToe.RotateX

When you are done making the
required connections, close the
Connection Editor,

~ You will find that some values
are simply not desirable; for
instance, it is possible to rotate
the joint too far. You can easily
correct for this by editing the
attributes. From the main menu,
choose Modify> Edit Attributes.

-------._- --------------- ------------- ------
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~ Select HeelRX in the Edit
Attribute dialog. Check the
Has Maximum check box. We
have done this because
HeelRX will need to rotate in
a negative direction. A posi
tive number for Hee lRX will
give undesired results. By
setting the Has Maximum
check box and leaving the
Max value at 0, we can pre
vent this attribute from ever
going positive.

Set the other attributes as fol
lows (see FIGURE 23.41):

BaIIRX: Has Minimum
(checked)

ToeRX: Has Minimum
(checked)

~ Retest the foot. If you like, set
extreme limits for each of the
attributes. Use the Edit
Attributes dialog to accom
plish this by adding a
maximum value as well.

10. At this point, we have only one leg.
Now that the leg is completely
rigged. we can move it into place
and duplicate it for the other side.
We will need to align the leg skele
ton inside our character's leg
geometry:

~ Select the Hip joint and the
FooCControl objects.

~ In the Front viewport, move
the two selected objects in
the X-axis so that the Hip joint
is aligned as in FIGURE
23.42.

~ Select only the FooCControl
object and move it into place
(see FIGURE 23.43).

FIGURE 23.40 Testing the HeelRX property
should reveal the rotation of the foot at the heel.
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FIGURE 23.41 Editing the attributes to prevent
undesired rotations.

FIGURE 23.42 Moving the Hip joint into place.
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FIGURE 23.43 Move the Foot_Control object
to complete the alignment.

FIGURE 23.45 Two independently set up legs.

FIGURE 23.44 Select the root nodes involved in the
leg rig.

~ In the Duplicate Options dialog,
check the Duplicate Input Graph
check box and click Duplicate.
This will create another leg rig
that is completely indepen-
dent of the first one.

~ Select Hipl and
FoocControll and position
them on the character's
opposite side. You will
then have two separate
legs, as shown in
FIGURE 23.45.

~ From the main menu, choose
Edit> Duplicate> Options
Group.

~ From the main menu, choose
Modify> Prefix Hierarchy
Names.

~ Enter Left in the Prefix
Hierarchy dialog and click OK.
Confirm that the names now
have the word "Left_"
appended to the beginning of
each joint name.

~ Open the Hypergraph.

~ Select the three top-level
nodes that make up the leg
(Hip, iMain, and Foot_Control),
as shown in FIGURE 23.44.

11. Now you need to duplicate and
position the leg:

12. There are now a series of things
that can be done to "clean up"
the rig. These things include
renaming all of the objects to
include a Lefe and RighC nam
ing convention, as well as lock
ing and hiding attributes that
will not be keyframed:

~ Select the original Hip joint.

----------~
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~ Repeat this process for the right leg and each of the inverse foot hierarchies, as
shown in FIGURE 23.46.

FIGURE 23.46 All of the naming has been corrected so that it is easy to identify each side of the
character's rig.

END TUTORIAL 23.11

The rig for the arms does not need to be complex. The goal will be to apply a Rotate Plane IK

Solver from shouJder to wrist. The solver will be constrained to a control object similar to the

foot. We will use an additional control object for positioning the elbow.

TUTORIAL 23.12: The Arms

1. Open the file ArmRig_Start. mb or continue from TUTORIAL 23.11.

2. First you need to create and name the arm joints. There are numerous ways to set up the
skeleton in the arm. In a game rig, there is no need for significant levels of control. so we
are going to use a simpler setup. Open the Tools Settings dialog for the Joint tool by using
the Options Box, and set Auto Joint Orient to XYZ.

3. In the Front viewport, create a total of six joints, outlining the Clavicle, Shoulder, Elbow,
Wrist, Hand. and Finger. It is important to follow FIGURE 23.47. Note that the joints
after the Clavicle are created in a straight horizontal line, rather than in the direction of the
arm. After creating the Shoulder joint, hold down the Shift key as you click.



4. Select the Shoulder joint, and rotate
it downward so that it is at the
same angle as the arm geometry.

5. Scale the joints in their local X-axis,
in order to make them fit properly
into the arm. Use FIGURE 23.48
for help.

6. Set the Preferred Angle for the joint.
Select the Elbow joint, and rotate it
forward on the Y-axis. Hold the right
mouse button over the joint, and
choose Set Preferred Angle from
the Marking menu, as in
FIGURE 23.49.

7. In the Channel Box, set Rotate Y
back to O.

8. Now you need to add IK to the arm.
From the main menu, choose
Skeleton> IK Handle Tool> Options
Group, and set the Current Solver to
ikRPsolver.

9. Click on the Shoulder for the start
point of the IK chain, and then click
on the Wrist joint as the end point.
A new IK handle is created, as
shown in the FIGURE 23.50.
Name this handle ikArm.

10. Now create the Pole Vector loca-
tor to control the elbow. From the
main menu, choose Create>
Locator. A new locator is created
at the center of the scene. Name
this locator pvArm.

11. Press Ctrl+G to group the locator
unto itself. Name this group
pvArmBuffer.

12. With the pvArmBuffer group still
selected, use the techniques you
have learned thus far to point-
snap the locator to the elbow
joint, and then move the group
straight back in the Z-axis.

FIGURE 23.47 The joints of the arm have been
created, but are stili straight out from the shoulder.

FIGURE 23.48 The joints of the arm have now
been rotated and scaled to fit into the arm's geometry.

FIGURE 23.49 Setting the preferred angle of the
Elbow joint.

----- -- -------~--
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13. Marquee-select over the locator, and
notice that you now have the pvArm
locator selected, rather than the
group itself. You can also press the
down-arrow key to step down the
hierarchy from pvArmBuffer to
pvArm.

14. Shift-select the ikArm IK handle, and
from the main menu, choose

23 Constrain> Pole Vector. You can see
the result in FIGURE 23.51.

The purpose of the buffer group we
added is to prevent undesired rota-
tion from occurring to the pole vec-
tor when it is parented back into the
skeleton later. It also allows us to
select the pvArm locator at any time
and return it to its original position '
by setting its translation in X, Y, and
Z back to O.

15. Now set up the Wrist control. From
the main menu, choose Create>
Polygon Primitives> Cube. Name
the cube Arm_Control.

16. Point-snap the cube to the Wrist
joint.

17. Scale up to an appropriate size to
encompass the joint at the wrist
without being inordinately large.

FIGURE 23.50 IK has been added to the arm
system.

FIGURE 23.51 The arm's elbow joint can now be
adjusted with the pole vector locator.

18. We do not want the cube to be shaded in the viewport. To fix this, open the Hypershade by
selecting Window> Hypershade from the main menu. Make sure the cube is selected, and
from the Hypershade's menu choose Graph> Input and Output Connections. Select the
connection between the Arm_ControlShape and the initialShadingGroup nodes. The line.
will highlight yellow when properly selected. Press the Delete key to remove the connec
tion. Ignore any warnings you may get at the bottom of the screen. This will force the cube
to always show in wireframe. Close the Hypershade when done.

19. Select the Arm_Control cube, and from the main menu choose Modify> Freeze
Transformations. This will force all of the translations, rotations, and scales to 0 at the
current location.

20. Select Arm_Control, and then Shift-select the ikArm IK handle. From the main menu,
choose Constrain> Point. This will point-constrain the IK handle to the cube so that as
the cube moves, the IK handle will move with it.
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21. Select the Wrist joint and then Shift
select the Arm_Control cube. From
the main menu, choose Constrain>
Orient. This will force the cube's
rotation to match the rotation of the
wrist joint. Test this out by selecting
and moving the cube. Feel free to
test out the pole vector as well, as
shown in FIGURE 23.52.

Now that you have moved the two
controllers around, you can put both
the pole vector and the arm-<::ontrol
ling cube back into their original
positions by selecting them and set
ting their translations back to 0 in
all three axes.

22. Controlling the wrist rotation is as
important as controlling the location
of the arm. Select the Arm_Control
cube, and from the main menu,
choose Modify> Add Attribute. In
the Add Attribute dialog, enter the
attribute name WristTwist and
click OK (see FIGURE 23.53).

23. From the main menu, choose
Window> General Editor>
Connection Editor. Verify that
Arm_Control is still selected and
from the Connection Editor dialog,
click Reload Left. You will see the
left side of the dialog become popu
lated with attributes from the
Arm_Control. Scroll down to the bot
tom of the list and select WristTwist,
as shown in FIGURE 23.54.

FIGURE 23.52 The arm in motion. Notice the
use of the Arm_Control and the pole vector.
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FIGURE 23.53 Adding custom attributes
can make it easier to control various parts of the
character.

24. In the Perspective view, select the Left_Wrist joint' and then click the Reload Right button
in the Connection Editor. The right side of the dialog becomes populated with the
Left_Wrist's attributes. In the attribute list on the right side, locate the Rotate attribute
and click the plus symbol next to it. Select the Rotate X property. You will see the attrib
utes become highlighted, as shown in FIGURE 23.55.

---- -- _.. ._--_. ------------------ .. -------_ ...---
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FIGURE 23.54 The Connection Editor is used to make direct attribute connections between nodes.

25. Select the Clavicle, and from the main
menu, choose Modify> Prefix Hierarchy
Names. Enter the prefix Left_ (include
the underscore), and click the OK button
when finished.

26. Repeat this step to add the prefix LefC to
the Arm_Control cube, as well as the ikArm
IK handle, the pvArm locator, and the
pvArmBuffer group.

27. Now duplicate and re-create the arm rig.
Select the Clavicle joint and from the
main menu, choose Skeleton> Mirror
Joint> Options Group. Set the Mirror
Across setting to YZ. Click the Mirror but
ton when finished. You can see the result
in FIGURE 23.56.
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28. Create a new layer in the Layer Editor. FIGURE 23.55 When the attributes on both

Don't worry about the name, as this is the left and right sides are highlighted, there is a
only a temporary layer and will be removed connection between these two attributes and data
momentarily. Select the mirrored Claviclel will flow from one side to the other.
joint, and add the mirrored joint chain to
the layer. Click the square next to the V icon in the layer until the letter R appears. This indi
cates that the layer has been referenced, meaning that we can snap to it, but not select it.
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FIGURE 23.56 A new joint chain has been mirrored over to the other side.

29. Switch to the Front viewport. Activate the Joint
tool. Holding down the V key, click on each of
the mirrored joints, starting at the Clavi.cle
and moving down to the Wrist. This will create
a new joint chain at the exact same location
as the mirrored original. You can see the new
joint chain in FIGURE 23.57.

This is done so that the local rotation axes of
the right arm will not be disrupted. If you were

to look closely at the rotations of the mirrored
arm joints, you would notice that their rotation

axis information was not correct.

30. Under the Layer Editor, right-dick on the new
layer you just created and choose Select
Objects. Press the Delete key to remove the
mirrored joints. Right-dick the layer again and
choose Delete to remove the layer entirely.

31. Rename these joints Clavicle, Shoulder,
Elbow, Wrist, Hand, and Finger.

32. Repeat the steps used earlier to add an IK
handle, pole vector locator and buffer group,

and a new arm control cube to the right arm.
When finished, use the Prefix Hierarchy Names
command to add the prefix Right_ (underscore
included) to all relevant objects in the right
arm, just as you did for the left. The completed
arms can be seen in FIGURE 23.58.

END TUTORIAL 23.12

--_._----~.- -~- ~--

FIGURE 23.57 A new joint chain has
been created with the Joint tool by snapping
to the referenced mirrored joint chain.

FIGURE 23.58 Both of the arms are now
completed.
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With the arms and legs done, we are now ready to create the spinal joints for our character, as well

as attach the arms and hips to the spine.

TUTORIAL 23.13: Creating the Spine and Finishing the Rig

23

1. To begin, switch to the Side view
port. and create a series of seven
joints for the spine, neck, and head.
Use FIGURE 23.59 to assist in
joint placement. Name these joints
Character_Root. Spine_i, Spine_2,
Spine_3, Neck_i, Neck_2, and

Head.

2. From the main menu, choose
Skeleton> IK Spline Handle Tool.
Click Spline_i to start the IK chain.
Click Spline_3 to end the chain. We
did not start the IK chain at the
character's root joint because of the
possibility of undesired effects due
to the root branching to the hips. In
many cases, a joint is created close
to the root to serve as the starting
point of the IK Spline Solver. This
allows the solver to mimic starting
at the root. In our particular case,
we have a very simple setup that
does not require this action. In
FIGURE 23.60, you can see the IK
Spline Solver setup we will be using_

3. From the Status Line, set the Pick
Mask option to All Objects Off. Turn
the Curves pick mask on. Marquee
select over Spine_2. You have now
selected the new curve that was
created by the IK Spline Solver, as
shown in FIGURE 23.61. Name
this curve BackCurve.

FIGURE 23.59 The joints of the spine have now
been created.

FIGURE 23.60 An IK Spline Solver has been
added from Spine_1 to Spine_2.

4. With the BackCurve still selected, press F8 to switch to Component mode. Make sure the
Component mode pick mask only has Points active. Select the CV at the top of the curve.
From the main menu, choose Deform> Create Cluster> Options Group. In the Cluster
Options dialog, check the Relative check box. Click Create_ The result is shown in
FIGURE 23.62.

- - ---- - ----- -- --- - -----
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5. Select the BackCurve again and

then marquee-select the next CV
down. Press G to create another

Cluster. Repeat this operation for

the next CV down as well. You
should have now created a total of

three clusters, starting at the top
most CV and the two beneath it.

6. Press F8 to toggle back to Object

mode. Set the pick masks so that

only the Deformations icon is active.

Select each cluster one at a time
from the bottom and name them:

BackControl_l, BackControl_2, and
BackControl_3 respectively.

FIGURE 23.61 The curve created by the IK
Spline Solver has been selected. In the Status Line,
the Curve pick mask is hte only object type active.

"

FIGURE 23.62 Creating a cluster with relative mode active for the top three CVs of the curve.

7. To make it easier to select the clusters, we will make their selection handles visible and
move them behind the character. Select all three clusters. From the main menu, choose

Display> Component Display> Selection Handles. Switch to Component mode. From
the pick masks, right-click on the plus sign icon and choose Selection Handles. Select
and move the three selection handles straight back in the Z Axis, as shown in

FIGURE 23.63. Switch back to Object mode.

----~._. - -_..._~_.__.- - ...
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8. All three clusters should still be
selected. From the Object pick masks,
activate the Curve icon. Shift-select the
BackCurve and press P to parent the
clusters to the BackCurve.

9. Make the Selection Handles for the neck
and Character_Root joints visible and
move them directly behind the character
the same as you did for the clusters.

10. Finally, select the Character_Root joint
and add a BackTwist custom attribute.
No minimum or maximum values are
required. Open the Connection Editor
and load the Character_Root on the
Left side and the Back_IK handle on
the Right side. Connect BackTwist to
Twist (see FIGURE 23.64).

FIGURE 23.63 Moving the selection handles
behind the character and making them visible will
make manipulating the BackCurve much easier.
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FIGURE 23.64 BackTwist has been connected to the Twist attribute on the Back_IK handle.

11. Now you need to connect the hierarchies. Select Left_Hip, then Shift-select RighCHip, and
finally Character_Root. Press the P key, and notice that bones now connect the
Character_Root to the two hips.
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12. In this order, select Left_Clavicle,
RighCClavicle, and Spine_3, and
press P. This will create bones in
between these joints, as shown in
FIGURE 23.65.

13. Select the Left_pvArmBuffer group
and the Right_pvArmBuffer group.
Shift-select Spine_3, and press P to
parent.

14. Save your work. Your rig is now com
plete, and you are ready to skin your
character.

END TUTORIAL 23.13

Skinning the Character

FIGURE 23.65 The hips and clavicles have
now been added to the skeleton.

'.

As mentioned in the preceding chapter, we now need to attach the character's geometry to the rig

we just finished. This requires the process of skinning. RegarclJess of whether you are attaching the

geometry to a simple skeleton or a completed character rig, the techniques for this process are

identical. Refer back to the preceding chapter, and follow the techniques outlined there in order to

attach the character's polygons to our new rig. This will finalize the process of turning our char

acter into a digital puppet that we can animate in our scene. Be sure to adjust your weighting prop

erly so that the character's joint areas, such as the elbows and knees, maintain their appropriate

volume as the skeleton bends and flexes. Of special concern will be the area at the wrist. As the

wrist joint rotates, you will want the skin of the entire forearm to rotate as well. Because of this,

you wilJ want the weighting from the wrist to smoothJy bleed back into the forearm.

Animating the Character
When creating custom animations for a character in Unreal, we have quite a bit of freedom in

how we animate and the animations we create. There are, however, some rules that need to be fol

lowed. First, you must understand how Unreal handles character animation in the game. When
the character is performing various tasks, Unreal will attempt to play specific animations. These

animations are identified by hard-coded names. For example, when a character is running for

ward, the Unreal Engine looks for an animation cycle named RunE If the cycle is found, it is

played over and over until the character performs some other action, such as jumping, stopping,

and so on. At that point, the animation is blended from the RunF cycle to the new cycle that must

be played. The end result is a smooth animation from one cycle to another. If an animation cycle

is not found, the character will continue to use that last cycle and an error will be generated in

~~ the log explaining that the specific cycle that the engine was looking for couJd not be found.

'-_. --- - - --_.-
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Because the animation cycles within the game are called by specific names, we will need to make

sure that our custom animations use the same names; otherwise, the animation would not be used.

In this section, we are going to take a look at creating two specific cycles: the RunF and the

Idle_Rest. Both of these cycles are used heavily in-game. Please keep in mind that the focus of this

book is not solely on Maya and the many techniques associated with it. Entire books have been

dedicated to both Maya and the world of animation. Instead, we will focus on the generation of

very simple cycles, so that we can quickly get our character with a custom rig and animation into

the game. With the knowledge acquired from creating these two cycles, you will have everything

23 you need to create the numerous cycles required for a fuUy functionaJ character inside Unreal.

Pose-to-Pose Animation

There are many techniques that you can use when animating a character. It is important to under

stand that there is no right or wrong way to do it. In the end, it reaUy comes down to the anima

tor's preference for animation. If you are new to animation, it is recommended that you try a few

different techniques so that you can find what works best for getting the job done.

In this chapter, we will be using a technique known as pose-to-pose animation. This animation

method is straightforward and quite popular among animators. We will be creating key poses for a

character at specific frames. By doing this, we will be able to block in our animation quickly. This

technique provides quick results, which in return alJows us to get a feel for the overall timing.

Because of this, it is easier to adjust the timing without having to deaJ with so many keyframes.

From there, we can quickly achieve our desired animation through adding additional keys and

adjusting the animation curves generated by Maya.

Creating Custom Animation Cycles

In TUTORIALS 23.14 through 23.17, we will demonstrate how you can create two basic char

acter animations. One of these will be a simple run cycle, and the other will be a basic stand

ing/breathing cycle that the character will use when not in motion.

Keep in mind that animation is more of an art form than a technical skU!. Creating convincing

animation requires a strong understanding of several key elements. The animator must have a

strong feel for timing, weight, skeletaJ movement, and more. If you are a beginner, do not become

discouraged if you are unable to create the animations you visualize-a good animator is one

who has spent countless hours practicing.

In the preceding chapter, we had to use a Character Set so that the Unreal Exporter plug-in would

recognize our character. Although we still need the Character Set for the exporting process to

work, creating our own animation allows us to use Character Sets for what they were originally

intended for in Maya-capturing poses with a single Set Key operation.

As previously explained, a Character Set is a collection of attributes. This in itself is not that big of

a deaJ. Character Sets become powerful when they are activated during the animation process and



FIGURE 23.66 A floor will help in the animation
process as it takes the guesswork out of figuring out
where the feet need to contact the ground.

I

~
I

Animating the Character

an animator sets a key. Instead of a single keyframe being added to the currently selected object,

every attribute found within a Character Set receives keys. This saves the animator a tremendous

amount of time as he or she no longer has to select each and every control to set keyframes.

Character Sets are best used to block animation quickly. In TUTORIAL 23.14, we will create a
single character set for creating our animation.

TUTORIAL 23.14: Preparing for Animation

1. Begin creating the Character Set by selecting all of the control objects and selection
handles for our character.

2. From the main menu, choose Character> Create Character Set> Options Group.

3. From the Create Character Set Options dialog, set the Name to UTCharacter.

4. Click Create Character Set.

5. Now create a floor for the character. Create a polygon cube. Scale and position the cube
so that it resembles a floor for our character to stand on. We won't actually send this
object into Unreal. Rather, it is merely a reference object that will help make animation
easier as we will not be guessing where the ground will be.

6. In TUTORIAL 23.11, you created a UTGuy-Geometry layer for our character's geometry.
We then saved this layer as a template so that the character could not be accidentally
selected although working with the skeleton or rig. We will take a similar approach with the
floor as you would not want to select it while animating the character.

Create a new Layer and name it Floor.
Set the layer's mode to Reference
(click the third box twice so that the
letter R appears in it.) This is similar
to the Template mode we used with
the character with the exception of
being able to see the floor shaded
instead of in a wireframe mode (see
FIGURE 23.66).

7. Now set the animation ranges. Many of
the animation cycles that need to be
created for Unreal will have different
animation ranges. In the end, the length
of an animation cycle is up to the ani
mator. We will begin with only the range
required to animate a run cycle:

Set the Start Time to 1.

Set the End Time to 16.

Verify that the Start Range is at frame 1 and that the End Range is at frame 16.

827
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I
8. To make it easier to select the character's control system, turn all pick masks off and then

activate only Selection Handles (requires right-clicking on the Handles pick mask) and
NURBS curves.

END TUTORIAL 23.14

In TUTORIAL 23.15, we will be creating a very basic run cycle in order to acquaint you with the var

ious methods employed to animate a character in Maya. Later, you can edit this cycle, improve it, and

add more cycles to your characters so that they will have access to aU available animations in Unreal.

TUTORIAL 23.15: Creating a Run Cycle

1. Set the Time Slider to Frame 1.

2. Verify that the UTCharacter Character Set is active.

3. Select the LeftJooCControl and move it forward along the Z-axis.

4. Rotate the LeftJoot_Control around ,the X-axis. Set it so that the character is landing on
the heel of the left foot.

5. Move the RightJooCControl back along the Z-axis and move it up in the Y-axis.

6. Rotate the RighCRooCControl around the X-axis.

7. Select the Character_Root and move it down slightly. Rotate it around X so that the hips
are turned into the forward left leg.

8. Adjust the BackTwist attribute on the Character_Root so that the character's shoulder is
leaning a bit more into the left hip. We are doing this because the character is holding a
heavy gun.

9. Position the hands so that the left hand is supporting the bottom side of a gun and the
right hand is holding the gun's handle. Add a polygonal cylinder into the scene as a stand
in object for the gun. Do not forget
to move the pole vector locators to
help make the positioning look nat·
ural and to adjust the left hand's
WristTwist attribute so that the hand
is rotated properly for supporting the
bottom of the gun.

10. Rotate the Neck joints so that the
head is looking forward.

11. Press S to keyframe. The pose can
be seen from two angles in
FIGURES 23.67 and 23.68.

FIGURE 23.67 The pose as seen in the
Perspective viewport.
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12. Copy this pose to frame 16 so that
our character will cycle properly.
Hold down the middle mouse button
and drag the time slider to frame
16. Manipulating the time slider like
this allows us to change our current
frame without evaluating time. This
is an easy approach to copying
poses or keyframes in general.

13. Press S to record the pose.

14. Now set the opposite pose-right
leg forward. First. set the active
Character Set to None.

Animating the Character 829-----

FIGURE 23.68 The pose as seen in the Side
viewport.

15. Hold down the middle mouse button and drag the time slider to frame 8.

16. Select the LeftJooCControl and in the Side viewport. position it so that the left leg
matches the right leg. You will need to, rotate the Left_FooCControl as well (see
FIGURE 23.69).

FIGURE 23.69 Matching the left leg to the right leg.

17. In the Channel Box, click and drag over all of the translate and rotate channels. Ctrl+click
and add Heel RX. Ball RX, and Toe RX to the channel selection. Right-click and choose Key
Selected.

18. Click Frame 1 on the time slider.

19. Hold down the middle mouse button and drag the time slider to frame 8.

20. Select the RightJooCControl and match its position to the forward left foot. As before,
manually key all of the translate. rotate. and custom attributes on this foot control (see
FIGURE 23.70).
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21. Fix the hip rotation at frame 8 by
selecting the Character_Root. Make
sure the time slider is at frame 8. In
the Channel Box, remove the nega-
tive sign in the Rotate X Attribute.
Right-elick on that attribute and
choose Key Selected.

22. Rotate and keyframe the Neck joints
so that the head continues to look

23 straight at frame 8, as shown in
FIGURE 23.71.

23. If you play back the animation, you
can see the cycle starting to take
shape. But although the animation
is cycling, it does not look much like
a run. The main reason is that our
feet never really plant. Now you will ,
fix that here. Go to frame 4.

24. Select the LeftJooCControl and
move it so that it is directly under
the character. Rotate the control so
that the foot is flat.

25. Activate the UTCharacter character
set.

26. Set a keyframe. You can see the
pose in FIGURE 23.72.

27. Move the time slider to frame 12.
Now repeat these steps for the
right leg.

28. Play back the animation: Things are
starting to look a bit better, but
there are still issues with the
legs/feet. Set the Character Set to
None.

29. Go to frame 2 and select the
LeftJooCControl.

30. Rotate the foot control around the
X-axis so that the foot is flat, as
shown in FIGURE 23.73.

- . ---- .... -- "- --- .- ---------- ..... -----_._-----

FIGURE 23.70 Matching the right leg to the left
leg.

FIGURE 23.71 The character at frame 8. The
pose is opposite from frame 1 and 16.

FIGURE 23.72 Plant the left foot at frame 4.
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FIGURE 23.73 Rotating the foot until it is flat.
This helps give the appearance of the foot helping
hold the character's weight.

31. Go to frame 5.

32. Adjust the Ball RX and Toe RX cus
tom attributes to give the appear
ance of the character pushing off
with his foot. as shown in
FIGURE 23.74. You will need to
adjust the translate attributes as
well. Keyframe all translate and
custom attributes.

33. Repeat these steps for the right leg.
The target frames are 9 and 13.
Play through the animation and
make any tweaks necessary.

36. Fix the arms so that they accommo-
date the root change.

37. Keyframe all changed attributes.

38. Adjust hands and neck as needed.

39. The steps provided have helped you
rough in a character run cycle. It is
up to you to fine-tune the animation
so that the cycle looks good. Don't
forget to use the Graph Editor to
finesse the in-between motion
generated by Maya.

34. Now you need to enhance the
Character_Root motion. Select the
CharactecRoot and go to frame 4.

35. Move the root down in the Y-axis. It
is important to create the effect of a

.r character pushing off when running.
When one foot is passing the other,
often referred to as the passing
stage. the character should be at
his lowest point. As the foot kicks
off the ground, the character should
then reach his highest point and
begin to fall with gravity within a
frame or two as the foot leaves the
ground (see FIGURE 23.75).

I
'
._------------------ - ---. . -..__ .

r
I
I

END TUTORIAL 23.15

FIGURE 23.75 As the foot kicks off the ground,
the character is at his highest point.

.~-_._._ ....._--
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The second cycle that we are going to create is the Idle_Rest animation. This animation is played

when a character stops moving for a second or two. There are several idle cycles that need to be

created for the character to look natural in-game, but as mentioned in the beginning of this sec

tion, our focus is on only two cycles, and from these foundations you shouJd be able to create any

cycle you need for your character. In TUTORIAL 23.16, we will create this idle cycle.

TUTORIAL 23.16: Creating an Idle Cycle

1. Open the file Animation Cycles Idle Start.mb or continue from TUTORIAL 23.15.

2. For the Idle_Rest cycle, we need a larger number of frames. This will allow us to create a
smoother animation. We will be using 24 frames:

Set End Time to 41.

Set Start Playback Time to 17.

Set End Playback Time to 41.

3. Set the time slider to frame 17.

4. Activate the UTCharacter Character Set.

5. Create a resting pose:

~ Move the left leg forward.

~ Move the right leg back and
rotate it outward.

~ Make sure the feet are flat on
the ground.

~ Rotate the Character_Root so
that it splits the difference
between the left and right
feet.

~ Adjust the arms accordingly so
that the gun is held slightly
downward (remember, this is a
resting pose).

~ Rotate the head so that the
character is looking forward.

~ Set a keyframe. You can see
the result of this pose in
FIGURE 23.76.

FIGURE 23.76 The Idle_Rest pose should
have the character with the left leg forward with the
hips rotated toward the right leg.

6. Using the techniques demonstrated in step 12 of TUTORIAL 23.15, copy this pose to
frame 41. Again, this will make a perfect cycle.
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7. Create the breathing effect:

~ Move the time slider to frame 29.

~ Move the Character_Root in the X-axis a small amount.

~ Move the BackControl_3 cluster back in the Z-axis a very smarr amount.

~ Adjust the hands so that the character is still holding the gun properly.

~ Set a keyframe.

8. Fine-tune the cycle:

~ Set the Character Set to None.

.. Play back through the animation and look for problem areas. The goal is to achieve
a very subtle swayingjbreathing effect.

.. You will most likely find that the animation is a bit jerky as it loops from the last
frame to the first frame of the cycle. This can be fixed by changing the ta(\gents at
frame 17 and frame 41 so that they are flat. This will allow an ease-in and ease-out
effect that will make the blending much smoother. Tweak the animation as needed.

END TUTORIAL 23.16

Before we can export the animation to UnrealEd, we need to put each of the animation cycles into

a dip. We will then need to place the clips into the Trax Editor. The exporter plug-in wilJ sample

the animation from these clips during the exporting phase. [n TUTORIAL 23.17, we use the Trax

Editor to create <lnimation dips from our cycles.

TUTORIAL 23.17: Creating Clips for the Animation Cycles

1. Activate the UTCharacter Character Set.

2. Select the Character_Root

3. From the main menu. choose Window> Animation Editors> Trax Editor. The Trax Editor is

Maya's nonlinear animation editor, which enables animators to package their animation
into clips. Clips can then be reused. sped up, slowed down, split, merged. and so on. You
can see the Trax Editor in FIGURE 23.77.

4. From the Trax Editor's menu bar, choose Create >. Clip> Options Group.

5. In the Create Clip Options dialog, set the following settings and then click Create Clip
(see FIGURE 23.78):

833

Name: RunF

Check the Leave Keys in Timeline
check box.

Time Range: Start/End

Start Time: 1

End Time: 15

",-_.._-- ---- --_._- - -_._--"-- - ------_.- . _.. ------_.....- ....._.. _--_._-_.- - ------ _. ---
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FIGURE 23.77 The Trax Editor is used to create nonlinear animation.

6. Create another clip setting the
following options:

Name: RunF

UNCHECK the Leave Keys in
Timeline check box.

Time Range: Start/End

Start Time: 17

End Time: 41

7. From the Trax Editor's menu bar,
choose File> Visor. From within the
Visor dialog, click the Character
Clips tab. This is where you will find
the two clips that were just created,
as shown in FIGURE 23.79.

FIGURE 23.78 Creating the clip for the Run
Forward animation cycle.

"

FIGURE 23.79 The Visor contains all clips that have been created along with other assets
available for Maya.

... -- .. ---- _ ..-- -------- --------- ~. __..~ ..-._-_...._------_.._----
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8. From the Visor dialog, hold down the middle mouse button and drag each clip to the Trax
Editor's timeline. You can navigate the timeline in Trax the same way you do all other
panels in Maya. This may be necessary to see all of the clips.

9. Select each clip in the Visor and move them left or right so that they start at the appropri
ate place. The RunF clip should start at frame 1 and the Idle_Rest clip should start at
frame 16. In FIGURE 23.80, you see both clips in the Trax Editor.

FIGURE 23.80 The two clips have been added to the Trax Editor.

10. Close the Trax Editor. You are now ready to export the character and the animation cycles
to UnrealEd.

END TUTORIAL 23.1T

Exporting Custom Animations into UnrealEd
In this section, we will discuss how to take your custom animation clips into Unreal. We wiJJ be

focusing on doing this with the plug-in included with Unreal Tournament 2004. Also, we will

mention a few considerations you must keep in mind when implementing your own animations

in UnrealEd.

In TUTORIALS 23.18 and 23.19, we will assume that you have completed the various export

ing tutorials in the last chapter. In TUTORIAL 23.18, we will take the animation from Maya and

export it into UnreaJEd.

835



23

836 Chapter 23 Character Animation

TUTORIAL 23.18: Exporting Custom Animation into UnrealEd

1. Continue from TUTORIAL 23.17.

2. Make sure UnrealEd is open and that Maya and UnrealEd are synched.

3. Select and delete the cylinder that was used as a weapon stand-in.

4. Select Character_Root.

5. Click the Skeletal Mesh Export Window icon from the Shelf. The dialog looks a bit different
than it did in the last chapter. With custom animation in place, the dialog now shows a list
of cycles that are available for export.

6. Create a new package named UTCustomGuy.

7. Now that we are using our own custom animations, we no longer need to check the
Underscore to Space check box. In the last chapter, this was necessary because we were
using names from within other characters from Unreal.

8. Select both sequences in the list and click the Export button. The Command Feedback line
should say: Result: Export Complete,.

9. Save your Maya scene.

END TUTORIAL 23.18

Now that the character and his animation have been successfully exported to UnrealEd, several

properties need to be adjusted for the character to work properly in the game. We will address

this in TUTORIAL 23.19.

TUTORIAL 23.19: Adjusting the Custom Character's Properties in UnrealEd

1. Continue from TUTORIAL 23.18.

2. Switch to UnrealEd.

3. Open the Animations browser and switch to the UTCustomGuy package, as shown in
FIGURE 23.81.

4. As you did in the last chapter, import the head. body. and portrait textures into a package
named UTGuyTextures, and save this textures package.

5. Assign the body and head textures to the character.

6. Look in the Animation Sequences list. You will see that both animations have been
imported from Maya. You will also notice that the Idle_Rest animation name has been
messed up. This is because the plug-in has a problem with underscores in the name. We
have left this in to demonstrate how to rename sequences when they have been imported.

7. In the Properties section, click the Sequence tab.

8. Select the rest of the animation in the sequence list.

--------------- -------
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It

9. Under the SequenceProperties category, change the SequenceName to Idle_Rest and press
Enter. Note that the name changes in the sequence list, as shown in FIGURE 23.82.

FIGURE 23.81 The Animations browser shows the character has been successfully imported into
UnrealEd.

I
I
i.

I

I

r-~--
i
I

FIGURE 23.82 You can change sequence names in the SequenceProperties category under the
Sequence tab.
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10. The Scale of the Character needs to be adjusted. Switch back to the Mesh tab and
expand the Mesh property category.

11. Expand the Scale property and set Scale X, Y, and Z to 1. It will always be at 10 by default.
A size of 1 will match the typical size of an Unreal character, as shown in FIGURE 23.83.

23

FIGURE 23.83 Scaling the character to 1 so that its size matches a typical Unreal character.

LooNOTE II ~', o,t, ~

If your character is not in the center of the world, you
will need to adjust the Translation properties to center
the character there. Our character was never moved,
so his alignment is perfect.15. Set the AttachAlias to righthand.

16. Set the BoneName to RighCHand.

12. Now you are going to align the weapon to his hand. To do this we will need to create a
socket. In the last chapter, we only had to adjust sockets because we borrowed them from
another character. But because this is our own character, we will need to create a few.
Remember, sockets are how we can identify specific bones for the Unreal Engine to use to
attach weapons, flags, and so on to during gameplay.

Before we add the socket, let's load all of the weapons into memory. To do this, switch
over to the Weapons package and click the Load Entire Package icon. If you click on the
Mesh dro~own list, you will see a listing of all weapons available in this package. Switch
back to the UTCustomGuy package.

13. Expand the Attach category.

14. Click the plus symbol next to Sockets
to reveal the Add button. Click the Add
button to add a new socket.
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17. To load a test model to help with alignment, enter AssaultRifle_3rd into the TestMesh
property and press Enter. You will not see the weapon by default. Set the
ContinuousUpdate property to True. This will cause the editor to continuously update all
entries made to sockets in real time. When this property is set to True, you can see in
FIGURE 23.84 that the position, orientation, and scale are way off.

--- '-

FIGURE 23.84 The test weapon has been imported. As you can see, the positioning and
orientation are way off.

18. Set the TestScale to 0.3. We are using 0.3 because this is the DrawScale size that is
used for this weapon internally in Unreal. Now the gun is a normal size, but the orientation
is still way off.

19. Expand A_Rotation and set the following:

Pitch: -2000

Roll: 32768

Yaw: -32768

20. Expand A_Translation and set the following:

X: -2

Y: -1

z: 0

The weapon should now be properly positioned and oriented. as shown in
FIGURE 23.85.
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FIGURE 23.85 The test weapon has now been properly positioned,

20. Next we need to add a socket for the Flag attachment. Add another socket.

21. Set the following properties (see FIGURE 23.86):

AttachAlias: RagHand

BoneName: RighCHand

TestMesh: VertMesh'XGame_rc.FlagMesh'

A Rotation:

Pitch: 0

Roll: 4000

Yaw: 0

A Translation:

X: 2

Y: -1

z: 0

- ----- --------
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FIGURE 23.86 Using sockets to align the flag.

22. For good measure, set ApplyNewSockets to True to make 100% sure that the socket's
settings have been accepted. Save the animation package.

23. Create the UPL file as shown in the last chapter and test your character in-game.

END TUTORIAL 23.19

Summary
In this chapter, we have introduced you to a vast number of new concepts concerning animation

in Maya. We have covered the basics of animation, keyframes, and reactive animation scenarios,

as well as the many animation constraints available. We also discussed Inverse and Forward

Kinematics animation methods, as well as the three IK solvers available in Maya. From there, we

demonstrated the creation of a complete character control system, or rig, to control your charac

ter's animation in a fluid and intuitive manner. Finally, we discussed how this rig can be used to

animate cycles, how these cycles can be transferred to Trax clips, and how that animation can then

be sent into Unreal for use with your game character.

..--. --------------_._-.----~---- -- - -
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With the completion of this chapter, you are now ready to create your own Unreal characters

completely from scratch, and make them fully compatible with Unreal Tournament 2004.

Combining this information with the many other chapters found in this book, you now know

how to greatly expand the Unreal universe by re-creating the game in your own image. We sin

cerely hope that you have enjoyed reading this book, and that you are successful in all future pro

jects and endeavors you may encounter with the Unreal Engine. Thanks, and good luck!
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Welcome to Appendix A. The purpose of this Appendix IS to act as
a reference point for using Unreal&!. You wW find .3 complete
overview of the program, along with many detaiJed descriptions of
its components, in this Appendix, Keep in mind tn:lt as the Unreal
Engine has grown and progressed. certain parts of the editor's func
tionality have been changed or removed altogether, This Appendix
has been created using UnrealCd build version 3236. FIGURE A.l

shows the full user interface (or UnreaJErl,
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A

FIGURE A.1 The UnreelEd User Interface.

The Main Menu Bar
This area is common to many computer application&' and in UnrealEd il is very similar (0 whal
ym/ve come (0 expect. There Me seven menus across Ihe menu bar (see FIGURE A.2), and the

funcl ions of each one Me covered in TA BlE A, 1,

FIGURE A.2 The maIn menu bar.

TABLE A.l The UnrealEd Menus

File This menu is typical to most modem t)fograms. and funCllons the same way. Here.

you have acce~s to opening files arod saving lhem, as weI( as importing and expolI

ing files. The bott<:lm of the menu C()niains an area for opening recently used nle~.

Edit ThiS menu allows for access to Un<kl and Redo, as wen as a vadety of selection
mathods. It also holds the Search fOf Actors command, used to locate any Actor in

your level. D'.e menu Includes the Cut, Copy, and Paste commaoOs, which will wort<
wilh any Aetors in the level, as well as the Duplicate and Delete commands. At (he

bottom. lhe menu gives access to a wide variety of selectKln methods, such as

Select All Actors, Select All Surfaces, and also several conditions for surface selec·

tJons, such as Select All Surfaces with Matchl()g Groups or with Matching Textures,
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TABLE A.l Continued

View

Brush

Build

ToolS

Help

The View menu offers a tentative list of all of the windows available in UnrealEd.
along 'J>Iith some options for Ihe viewports in the program itself. Here you can
access all of the browser windows, as wen as aU of the pmperlies aod options wlrr
dows (0/ the objects in your level, rnchJdrng the overall properties for lhe level itself.
The menu also has an area where you can flaa! 0( fix your viewpons, as well as
adj us1 their configura tions. or their placement on the in1erface. You may also create
a new viewport from this meOl). as -well as import background images {or the vIew
porLs.

Thi s menu cor.taiM a wide variety of optioos for your brushes. USing Ihe chOices ()()

ihe Brush menu, you may edll your bwshes by chpping or al~e(/()g lhelr (\()/'mals.
open, SENe. import. Md export different brushes thai '100 create. and add a wide
variety of brushes Into your level. Among these are additive and subtractive brushes,
movers, AnllpO(\als. and mOle. The menu also allows you \0 intersect and deinle(

secl brushes. These adkins are covefed in detail tn Chapl~{s 3 and 4.

The BUild menu allows you io rebUild SpeG((lC ilspecLs o( your level, in order 10

update Ihem II changes hcwe been made. Among the obJecls you can rebuild are
geometry. lights, and Al paths. You may also establish settings to le\)uHd these 001}'

if changes have Men made, as well as adjusl rebuildmg opnons. The menu also I

allows for yoo to play-test your level within lhe game ilsel f,

The Tools men u cantaiI'lS a varlety of utililies io help you as you con s(ruct your lev·
els. Among these are tools for scaling the map, scaling lights, removing any particles
that exist if) your lev~( (this, In effect Will reset a partICle emme,), and a rotalion

1001 fOi (Otatlng Actors.

ThiS menu cootcllns access to toggling on and off the lip of Ihe Day fealute. as well
as a link to the Unreal Develope/'s Network sHe (_. vdn. epicga£/les. COQl). fL also
coniains a coniexlual hel~ system. which. al the IJme o( thiS wriling, is non
lunctJOnal.

The Toolbar
Undernealh the main menu baT, you will find (he toolbar (see fiGURE A.3), This contains sev

eral buttons for quick access to many of the commands found in Ihe menus. The buttons are

divided inlo groups, and the following seclions describe each of these grou ps,

FIGURE 0\,3 The tcolbar,
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Fila Optiona

Ooell File

FIQURE A.4 File Qptians ~le:a.

A

The lint u,ra buttons auau the toolbar

COlllain Ihe File 0pllons (su FIGURE A.4).

Going (rom kh 10 right. Ihe.!e allow the

u..sN 10 cre;lle a new fik. open an uisling
rIle. and ~.wc Ike c.urr~nt fiJe. Theit worK

exactly like Ike ,orre~pondin& commands

(ound in Ike Fue menu.

Undo and Redo

The ncx( (IA'6 bUUOIB on Ihe t60lbaT al1o\..

you 10 undo ;:lnd redll aC1ions in yllur level
Ute FIGURE 04.5). Y6U have many levels
6t lind o~ in Un Ie-al Ed, and nu m~rous

R('rlo~ a! weD. Theu commands can also

be (ound in the £<lil menu.

Search fl>r Actor

NeoN F,le

Undo

FIGURE A.S

Save File

Ulido an<:! Red 0 'Ilea.

Thi~ lool (set FIGURE A.El) is dc~igntd 10

help you (Lnd ,pee ilic ACl01S wilh in your FIG UAE A,8 Se..arch for Ac10r but1on.
SUne i.rI a faSI and t,Hy maMcr. For more

,n(ornlall"" on ,hiS 1001 and how 10 LL,c it

go (0 tr.e ,s.«:lio" c.illcd "~arch (or Acrors"

fle;)r tnt end or Ihis ap~lldil(.

BrowlI.e,.a
Sound SUllie

Till' bro •.,,~er~ H~ .a ~(ics Q( di"log~ lh~l

g'v~ J.£C~H II'> most o( UnrcaJEd's (uncI ion·

altly (set FIGURE A.7). Th.!}' <... ill och be

Q)VCTed In more depfh Uo the "Browsers"

seclion laleT in this .oppendix

Tht browser bUllOfl$, frorn left 10 righI, arc

Ado( Clau

FIGURE A..1 Elrowsert area.

Al\ilT\3t ion

.. Ac(O( OB,H Browser

.. Group Brow~r

.. Music Browser

.. Saund BrllW~

.. Te'(1U res Orowser

.. Mc~h Browser

.. Prcf..b Browsu

.. Stalic Mesh Br6WSe.r
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Editors

The editors are covered in the "Editor
Windows" seclion of Ihis appendix. The

bullOfi on Ihe lef! in FIGURE A.8 is (or

Ihe 2D ~ripl Edjlor; (he bunon on the

righ I is (or the UnrealScripl Ediior.

Properties

These windows Jllow you (0 view and

adjust many 0 r Ihe pOl rameters (or yoor

Ac(ors. We will go into more depth on

Ihem in the "Property Windows" seclion
later in this Appendi.x. The button on the

left in FIGURE A.9 is for the Actor

Properlies window; the bulton on the right

is for the Sllrface Propeflies window.

BuildIng

This area allows (or the updaliTlg o[ many

aspects of Ihe level when Ihey are changed.

TABLE A,2 describes the buttons in Ihe

BuildIng area shown in FIGURE A.I0

(rom left to right

TABLE .4.2 The Build Commands

20 $cOp! Edtlor Unreal Scnpl EdHor

F'IGURE A.S Editors a/ea.

AclQf Properlles 5urlace Properlies

FI CO URf A. 9 Properties a/ea.

BuIld Geomelty Build Oplio<lS

Boikt Cnanged Lights

BUIld Changed Palhs

FIGURE A.I0 Building Area

Build Geometry Building the geomelJy of your level will allow the Un(eal Engine to con
s\.ruct the actual geomeLry 01 your level using the daia creaLed (mm
yoor BSP brushes.

Build Ughls This recalculates aU of lhe lights and shadows casl in your level. This
must be dooe whenever new geometry IS added, and whenever light
p.'operties are changed,

Build Charlged Lights

Build Paths

Build Changed Paths

This alternative to the BuIld Lightmg button allows you to only retxilld
the lights thaI have been added or altered tn your level. This can
greatly speed up rebuild time. especIally on larger levels,

This command Will allow you to construc' Ihe paths that AI~ntrolled
creatu(es and bots use to naVigate the leveL Paths ca I) be~
structed {rom a variety of Actors, and II is the 10caLion of these Ihat \s
used io calculate the p.olh.

Just like Build Changed Lights, this will on ty bUIld Ine paths that have
been modi11ed or had an ActOl added (0 them.
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TABLE A.2 Continued

Build All This bullOIl rebuilds Geometry, Ughls, and AI Navigation paths in the

level Thi" can lake C(}(\SI(:lerable lime oe,OeMing on system speed
aM lhe sile C>f your leve I.

BUild Optl()ns Thi$ 00IIon 1I'1,tialires the BUild OptlOI\S Window, within which you cali

chaAg':: a variety of opuons on how levels are rebuilL You can tl\en
use Itll; BUild bullon at Ine Mnom to rebuild the level inslantly, or
use the sel1ings laler when you click the Build All bUllon.

A

Play Level

This bUllon (sec FIGURE A.il) will launch yuUT map

inside Unreal. so that it .:an be pI3y·le~ted.This ",-ill becomt'

one of rOUT (;lvorite buttons on the interface. FIGURE A.l1 Play Level bunon.

Help

This button (SEE FIGURE A.12) 3cas~cl the contextual

help. which. 3t rhe time of this writjng. is oon-functional.

The Toolbox
The (oolbolC (see FIGURE A.13) contains a huge selection

of necessary tools for constructing levels inside UnrealEd.

Many or these you wjJl u~e numerous limes throughout lhe

level design prOcess. In lhis section, we will cover each of
the buttons on the toolbox, and their various uses and para

meters. The loolbox is broken up into live sections, and

each section is expandable and collapsible. Also note chat
along the right side of the toolbox is a very thin green 5croll

bar for moving through the list of tools if your window is

nat big enough to see them all.

The (oUollliJ'lg sections will walk you through the nu merous

tools and lllilities available in each section or the toolbox.

FIGURE A.12 Help burton.

FIGURE A.13 The loolbox.
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Camera and Utilities Area

FrwhaMI PoIygoo Oraww>g

Tella.... Edrhng

Camera aod Utilities area.

BNShC~9

Faee O'il9

M.1lj~

FIGURE A.1.4

CMT\6(a at>d MovemeM ~I.=.liMl-\lefIe~EOiIog

AcIOf Sc.all~ Aclor R<>t31e

TelO\1fe Pal) Te~k"e FlOl31e

This nea of (he molbox: conlains ,c.~veral

fOols (or controlling YOllr camera and
other U,i1ili~5 (hat ar~ used for 3 variety of

functions wjthin UnrealEd. See FIGURE

A.14. Each of these tools Clnd their seTtings
will be cover~d in the following sections.

Camera and Movement

Thj~ fool is designed (or manipulating the camera. At first. this may seem a bit <Urious, as you can
always manipulare the camerJ with the proper mouse controls. However, aside from aJlowing you
to move the camera as all mod~s do, this is a general editing mode, which aUows you 10 p13ce,
move, select, edit. and delete actors and brushes.

Vertex Editing

Activating this tool wiU aUow you to manipul.Jte the verlias on 3 brush by selecting Ihe vertices,

holding the Ctr! key. and left-drJgging I

Actor Scaling

As the name suggesls. lhis lool allows you to scale AClors. To use the tQ{)l, simply aCljv3t~ iI, and

select a brush or other ACIor. Then. hold down Ctrl and the fight or left mouse bUllon, and drag

10 adjust SCdIe. Dragging with the left mOuse will sulc in the X ax.is. right wiU sc:ak III Y, and left
and right together will scale- in Z. In this way. you GIn quidcly and easily scale Yl}ur Aclors in the

3D and lD views_

Actor Rotate

Thi~ tool allows you to rOlate your Actors. It may be u~ed in the 2D or 3D views, :wd works in a

very similar fashioo to the Actor Saling (001, in thaI it allows for transformation on aU r1uee axes.
To use it, activate AClor Rot3tc, hold down Ctrl, Jnd (hen drag ",·irh the mouse )mlfons. Left

mouse allows you [() rotate in Y, righl mouse allo~ you to rolat~ in Z. 3f1d left and righltogether
allow (Ot rotation in X. You can rotate AClors without this tool by using Ctrl+right-drag, but (hat

only allo",,'o5 (or rotation in onC' axis.

Te-xtu re Pan

This lool allows (or panning of textures across the surface of a brush, It <:an only be used in the

3D view, as that is the only viewport in which rextures can be seen. To use me (001, activ.ue It III

Ihe toolbox. and select a texture by len.-clicking on the surface LO which it has been applied. Then.
holding down uri, drag with the left. or right mouse burroo to slide rhe texture. Holding the lefr
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mOLl~ blllton ",ill pan lhe lCxlLlrt:: in Ihe U direction, and Ihe righl mouSt bunon ""ill p.ln il in

Ihe V direction. lfyou have' mulliple tfxlure5 sdecud, you can p311 lhe.m simuluneously.

Texture Rotate

A

Wi,h 1his 1001 you an change Ihe oriel)latiOD

o( le-\'Llrcs auow 1 surfdC~. !=Ul\Clioll~lJy, ;(

war)cs much like Ihe Texrure Pan 1001. Simply

invoke lhe 100[, self" any number 0 f leXl l.l res

by left-clicking them in Ih~ 3D view

(Clrt+cl.ic.\c:ing if you walll more than one)

ar>d thef\ holdlll~ Cu[ lnd dragging witn

either It:f( ()r rig"l mO\l~ 10 rOlalt the texture,

I NOIE
II Whtn you rotate a t~Urt, you als.o rolale its Wi. ThIs
. me all! lh <?ol, (0 I ttample, Ii you rola1e a Ie:rture 45

ldevees 10 the ngh!, WhH you use Ihe Te:rlure P-ao
lool, tnal le.x'Iure will ~a~ at \J'lol &I\gla and Ml In ltla
~me direction It dID prior to mtatlon.

Brush ClippIng

'[his lool can be used 10 dram~(ic.aHy c)unge Ihe shape o( a blUsh by clipping iI, or, in effecl,

cuning oR' one end o( it. For mOre in[orTn.lliol1 on this LaO\' ~ce Chapler 4.

Freehand Polygon Dr~wing

Wah Ihis 1001, you C<lll creale more complex bl"\.llhes by pl~clng ~ series ot verlices to create lhe

ourline O( 3 .'.hape, and then ex1rudillg i( oucw.ard, or adding deplh (thickl\ess) to il. For more

ifl(ormalion on lhis (001, see Chapler 4.

F.ace Drag

This loal allows yau (0 pull Ihe (acc~ o( a brush,.'.o lh3( you can sculpt (he shape of YOllr brush

quickly. For more irdonnlllon an lhi~ 1001 s~ Chapler 4.

Tefra/n EdIting

This bU\[()f\ bringj up Ihe Tcrraill Edilor window, which will allow you 10 crcale various rype~ o(

f\31 U r"I· \ooki ng I~d ii\5 by CJf.'.1ling 1D ml)))Ochromalic heigh I m.aps. Th i.'. wi ndow and all of i ($

(ur.c:\ional.ilY are c:ovcrtd in Chapler s.

Matinee

ThIs bUllon IlWOKt'S the Malina Window, which allows for the creal ion of animaled maVlcs and
Cl.)lsc.en~ USing lhe UnreaJ Engine. Mariner is c:ovtrtd thorollghly in C'r-aplcr tl
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Brush Clipping Area

This area (see FI GURE A.15) contains a

few tools to control how brushes can be
manipulated lhrough chppmg. Chpping
brushes can be a great way to create unique

simple shapes (or your level quickJy, with

out having to resort to a Slati, mesh. The
tOols jf) this are3 3re covered thoroughly in

Chapta 4.

Clip 5elecie<l elushes S91r1 St!<KIe</ erlJ~S

F~p Chppll'lg Normal Delele Cllpporlg Mat1<(lr$

FIGURE A.1S Brush Clipping area.

Bru&h Primitives Area

Tetrahedrofl (Spllerel

Sheel

Cuba

Cyl,ndel

Volumelric Shape

This ar~a (see FIGURE A.16) contains all
o( the primilive shapes thaI can be applied

10 the Builder brush in ord",,. 10 add or

sublraCI malTer and thereby shape YQur

level. In this seclion, we will cover all of C/!.&le BSF> Terroll\ -;'(s'~<JJ

Ihese primilivC5 In derail. Right-cliclung

on any o( Ihe buttons In this areJ will bring

up ;l dialog from which you C.1n adjust (he

parameters for Ih3l specific primilive FIGURE A•.16 Brush Primitives area.

shapt'. After a description of each of the

primitives, Iheir respective paramele-rs wiU be explained. If a parameter is repealed on anolher
primItive, II will only be expl.a.ined once, r,\lher (han repealing a definition.

Cube

Tht' Cube bulton will change rhe Builder brlLSh inlo a cube (or you 10 use to cr~a(e your level.

Cubes wiU usually l:x: one of the most frequently used shapes in your level-blJllding arsenal. In

TABLE A ..3 you an sec Ihe construclion parameters for (he cube, available in the CubeBuilder

window.

TABLE A.J CubeBuilder Parameters

Height Nalurally. this controls the height of the cube from which the Builder
bfush will be created. ThiS heighl is defined in the direction of the Z-axis.

WLdtl1 ThiS controls the width of the brush thaI will be created. The width is

defined in t~ direction of the V-axis.

8read lh This controls the breadth of the resulting Builder brUSh. Breadth is

defined by the direction of the X-axis.



Apptmdl)( The Un rearEd Manual

TABLE A.3 Continued

WJllThic'ltnass This controls lhe Ihickl'\ess 0/ each of (he sides 0/ (he C:ush. The value

o( Wa 11 Tt-, l clcnes s is Ol\ly relevant I( (he HalloVi ;)3rameler is set to

True.

GrOUpNBllle Thfs OPIIOfI allows you 10 olace your brush IOto a grouo.

HO 1 \ ow ThiS pa rame Ie r works in Iande m wi lh \h~ Wa 11Ttl i cknes s set1.(ng. When

Ihis parameter is acllvated, ar set I~ True. your cube will be consuvcled

like an empty box, r.3lr.er I"an a oonSlanl OOJ&L

A

Tessellated

Cur ...ed Staircase

This divides each of the {aces <>1 Ule objecl "tr,to triangles ralher Ihan

Quadrangles. Tessellaling your brush IS a key step Ii you ))Ian \0 do ver·
lex editing. as such actions can cause Ihe (aces 0' your ol>jecl 10 .oossi·
bly become nonplanu. resulting in !.he Hall o{ Mirro's eHeCl. I( each (ace
is three-sided, and not lour, il becomes impossible 10 ~enerale a 110n·

plMar tace.

The Ctlrvcd 51 airc,lsc i.s a scI o( .sIal rs !.hal run aU rht: way up From the Door. As such, It should i'l01

be used 10 cre.."lle SI;llrGues Lhat spiral upward and wrap over \h~mukc~ nurner()~ times. For
&uch staircases, uu rhe Spica..! St2irLa~ brush described in TAB L.E A.4. Also, keep in mind lllal

t..hi.{ paruculu brush 1.,.;11 c.rea Ie a large DU mba of RSP I~Udl ION, which '-'In quickJr slow down

your [eYel. Ai, such, <his brush is {Mely uud in modern Unfe.'ll game~, .and a Slali, mesh i5 used

whenever such ~n 0 bjC<"t is needed.

TABLE A.4 CurvedStar raull der Pa ra meters

11111 BrRadi,LJ s ThIS cOIl(rDIs the illslde radius o( the CUNed Slaircase. II musl have a

value (J{ al least 1. YOLI would wanl this 10 be large il you wanled yellr
staIrcase \0 lr.=lVel aroul1d an ~bje~\ Of area,

St~pHHlll\t Tills value Cllnt/ols (ne helgl'lt 01 each step. ThiS value, mutllpJled by ll"le

!lumber of steps, is /he total hetght of the staircase,

SttpWldth ThIS YaJue is used ID determine the width of each step. Adding Ih,s value

ID lJ\e Il\I\erAadius will give you the total radIUS D( the slalrcase, For

LlIstance. if you had afl I nnl!rR ad LOS value of 12B, and a S\ epWld t h

yalue of 2SS, Ihe lo.l2ll radius, or radiUS (rom the center a{ the sIaHc.ase.

would be 3SA lH\llS.

An 91eOnul' v a As Ihe name st21 eS, I hIS gives you concral over the curve aogle o( Ihe

S1airCilse. Because the ,,!.D\lS are solid and ertend up (rom the ground

le...el, a e.urve angle grea\.er than 270 degrees would cause the stairs to

WlOp C!\ler lhemselves.
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YABl[ A.4 Continued

NumSteps Thjs value controls the total number of stairs on the staircase,

Multiplying this value by the height ot each steD will give you the total
height of the staircase.

AddToFirstStep This parameter basically offsets the entire staircase by the number of
units entered. For example, if you need your staircase to begin 256 units

in the air, YOu can enter that value here, and It will be added to the

height of the first step and co every step thereafter.

GroLJpName See Table A.3.

CounterClockwise

Spiral Staircase

When thIS value is set to True, your staircase will wind in a counterclock·

wise direction. If this value is set to False, your stairs will wind clock

wise instead.

This primitive is similar to the Curved Staircase described in the prec.eding sectioo, but does not
extend from the noor. Rather, each section of the staircase is only as thick as each individual stair.,
meaning that you can create a staircase that wraps over itself numerous Limes. rotating greater
than 360 degrees. As with the Curved Staircase. you will usua Ily want to use a static mesh when

ever you need such a shape. In TABLE A.5 you can see the parameters for creating the Spiral
Stairc.ase.

TABLE A.S SpiralStairBuilder Parameters

IMerRadius See Table A.4.

StepWidth See Table A.4.

StepHeight See Table A.4.

StepThickness This value will define how thick each step will be. Th;s does not have any
effect on the height of the staircase, only on the way the staircase

appeals. For instance, i( the StepHe ight value is 16, and the

Stepfhickness value IS set to 8, each o( the steps would be 8 units

thIck, and there would be an 8-unit gap between each step.

NumStepsPer360 This value controls the number of steps in a Single 36Q-degree revolu

tion. For example, if this value IS set to 60, it would take exactly 60

steps to complete one full 360-degree revolution.
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TABLE A.6 Continued

NumSteps See Table A.S.

AddToFirstStep

GroupName

See Table AA.

See Table A.3.

Create SSP Terrain

This will allow you to create a basic terrain, or many other possible objects. The brush itself is

essentially a cube in which one side has been tessellated so that you may safely and easily edit its

vertices to form an object. Keep in mind that it will almost always be a better idea to use the actual

terrain system to create landforms. For more information on UnrealEd's terrain system, please

refer to Chapter 5. TABLE A.7 lists the parameters for the Terrain Builder.

TAStE A.'7 TerrainBuilder Parameters

Height See Table A.3.

See Table A.3.

This value controls the number of divisions that are tessellated along the
width of the brush.

Width

Breadth

WidthSegments

See Table A.3. ,

DepthSegments

GroupName

Sheet

This value controls the number of divisions that are tessellated along the
breadth of the brush.

See Table A.3.

This command changes the Builder brush into a single plane, or four-sided polygon. Itwill be cre

ated as a rectangle, but its vertices can be edited later. This brush can never block a player. TABLE

A.S shows the parameters for this brush.

TABLE A.S SheetBuilder Parameters

Height See Table A.3.

Width See Table A.3.

HorizBreaks This value controls the number of divisions In the surface along its width.
For instance, setting this to 3 would divide the plane into four equal seg
ments along its width.
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TABLE A.8 Continued

Vert8reaks This parameler is exaclly like Hori28rea\(s. excePllhal il adds divisions
along the heIgl'll of Ihe plane inslead o( the width.

Ads ThIS setting conlrols the orien\alion of lhe brush al the lime of its

crealion.

GrollpNane See Table A.3.

Cylinder

This will generate a cylindrical Builder brush, good for pillars. pipes. soda cans, raised daises, and
jllS! about anything else (hat is, .. well" ,cylindric'll. In most modern Unreal games, however, it

win be used moslly for cylindrically shaped rooms, and objects like pipes, pulars, soda cans, and
so rOrlh will be created with static meshes. TAB LE A. 9 shows the parameters for the Cylinder

brush,

TABLE A.9 CylinderBu\lder Parameters
----------=----------------------------~

Height

OutarAadlus

Innarl1adlos

Sides

GroupName

AlignToSide

I-iollow

Cone

See Table A.3.

ThiS is the overall radius of the cylinder, calculated from its center.

ThIS setting is slml~r to WaJ.l.fhickness on the Cube pllm\tlve, except
that thIS will I)()t cap oH the ends. The effect is a pipe-like object, This
setting is only relevant if Hollow is set 10 True.

This comro}s the number of polygons that wiH be created around Ihe

cylinder. I( mUSl have a value of alleast 3.

See Table A.3,

If thiS selling is Troe, the cylinder will ~ ollenled so Ihat the bottom
most 1~e is parallel to Ihe XY plane, whIch mea()$ lhat the boflom of

the bfU sh would essentially be a flat (ace. If Ihe \lalue IS Fa1se, however,

lhe bottom of the brush will be a corner.

See Table A.3.

You can chink of this primitive as a cylinder in which all of the (aces at one end have been

collapsed down to a single poine TABLE A.I0 shows the Cone brush's creation parameters,
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TABLE A.l0 Cone Brush Creation Parameters

Height See Table A.3.

capHeight This setting is only valid if Hollow is set to True. This controls how high
the inside cap of the brush is. For example, if you were creating a cone·
shaped room from a hollow cone, this setting would control the thickness
of the floor.

OuterRadius This is the total radius of the cone, as calculated from the center.

I nnerRadius This value is equal to the distance in units from the center of the cone to
the inside edge of the cone. Naturally, this is only valid if Hollow is set
to True.

Sides See Table A.9.

GroupName See Table A.3.

AlignToSide See Table A.9.

Hollow See Table A.3.

Volumetric Shape

This primitive is a great tool for creating various texture effects, such as fire, smoke, plasma, trees,

and chains, where perfect three-dimensional detail is not necessary or the excess geometric detail

would become suboptimal. It actually consists of a number of sheet brushes rotated about their

pivot point in the Z-axis. TABLE 1\.11 shows the creation parameters for the Volumetric Shape.

TABLE A.i1 VolumetricBuilder Parameters

Height See Table A.3.

Radius This setting controls the distance each sheet will extend from the center
of the brush.

NumSheets This is the number of actual sheet brushes used to generate the
volumetric shape.

GroupName See Table A.3.

Tetrahedron (Sphere)

This is the closest object to a sphere that you can achieve with a brush. It is a spherical brush com

posed completely of triangles. As such, it can potentially form a very dense surface, geometrically

speaking, but provides very smooth results. TABLE A.12 shows the creation parameters for the

Tetrahedron.
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'TABLE A.12 TetrahedronBuilder Parameters

Rad lus Su Tabl~ A.l1.

SpllereE, crapo18t ~OI\ This senv'g c.onuals how smOOlh Il'Ie s~ere will ~ cy adjusting ~he

site 01 the ((langles tnat it is c.omposed 01. The higher me number,
the mOre (riangles are i(\ Itle sphere, and Ihe smaller those triangles

will t>e. You coul£l (hill\( oi OleS as the resolUlion o( I/'Ie leuahedron.

Thls sellmg raises Ihe £lenslCY ol the lelrahedra",'" geomellY ex-pone,,·

I lally, so VOu WIll (lAd Ihat a V<llue 01 7 will give you a ridiculously
CSer.se spl'\ere,

(jrOllpHame Sea fable A.3.

A CSG Operations A.rea

The 100[s in ,11 is .<ire;'! (s-te FI GU REA.1 7)

arc Qcsigned 16 a1Jow yO'l 10 cOflSLrua YOIlJ

level through {he volumttric. mo.dding
melhod of ConstT acl ive Sol id Geomel r y

(eSC). In e·S-~eIlce, ,"is is where you go 10

add, S\J bt r;le!. i.nlcl ~ecr, or cJcinleHetl your

brusnes from Ihe world of mass IhH WSIS

wilhin YO\Jf level. IJso in !.his area, yO'l will

fi nd coO'm~"ds for addi ng 3 variety 0 ( spe'

da[-puf!>()"C brushes and s12lic tnesl',es. For

marc Informalion on CSG,~ Chaplcr 4.

Add

Add SuosllOCl

InlelS&et Qelnlersecl

A.Od Speclel Brush Add Sialic Mash'

Add Movet Brusn Add Af\li·Ponai

FIGURE A.17 esc Operallon!. area,

This comm:lnd will creal~ an addilive brush in/he world,basiuUy insu<ing m.u~ back jn/o a !leg

ative space fhat you h:we c.r<!:llcd, The /'It'''' bru.sh \V11l be genualcd IR (he ().';l«(.umC [ocallon and

shape as the Builder brush. .Also, Ihe ftXlurc /.hal you have .<eleG(ed if) <he TO:lurc.s brow<.ier will
be applied 10 Ihc new brush, The ctSuhing additive brush will have a leU·(;lle blue -.rirdrame,.so

<.hal yO<J <lrf able 10 idenlify il as additivc in a 2D vicw.

Subtract

Thi.. command is cS5entiaUy the invene- o( Add, ({ather than inseTling volume inlo your level, It'lis

command will lala il away, This command is lypiCAlly Inc rlrsl ont used 10 crole a 1~<,1, as you
nfe-cllO remol'c ....olume from the solid mass o( (he Unr~1 ur.iverse 10 oe:lle ~ sp.<ce wilhin which

10 build A ) eve) , As. wilh Add, the new brush will be inlhe ~;Jme pOJi(ion and shape ~s Ihe Buildu

brLlsh, DUI will have a yeUow wirerrame l.Il the 2D vit'W (0 d~ril)gui-sh if as a sublradive brush.

AlSo. 1\1 f seleae d ltl;lu re within the Tcx{ures browser will be applied to Ihe inside 0 (1 he objecl.
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Intersect

The Intersect command only al{ect£. Ihe Builder brush. It checks the BSP geometry within your
level 10 see where the brush is intersec.ting, or passing (rHO another brush. The command Ihen
perfor IDS a Boolean operation on the RuiLder brush, based on whether the brush thai is inter
secting with the Builder brush is add ilive OJ subt raaive.

r( the Bu ilder br ush is intersec ling with an ad dilive brush at Ihe tim I' or the comma nd, 0 nly the

area o( the Builder brush that is actually passing Into the additive brush will remain. The rest of
the Bu Ilder brush, or the area of the brush that elCisted outside Ihe additive brush, will be deleted.

If, instead. the brush Inat is in[erSecling with

Ihe Builder brush is subtractive, Ihe resuJt
will be exactly the opposite, The area of the
Bui Ider brush that falls wi thin the in lert.ect

iog subtracti ...e brush will be deleted, and
only !.he area that was outside of the subtrac
live brush will remain. For lutorials involving
thiS function, see Chapter 4,

NOTE
Yoor Butlcler brusJ1 can be IMersecting both an addi
live aoo sublradrve brush slrnultaneoosly when 'jilu !
perform lI'lis co-mmaoo, This cqn yield .wme very inter- II.
esting results. Experiment. and see what you can come

up wltn. I__________ .J

Dei ntersect

This command is, in e((ect, the exact opJXlsite of Intersect. It essentially performs the same checks
on the geometry surrounding the Builder brush, bu\ performs <In opposite Boolean oper<llion
than Intersect. This means that when the Builder brush IS passing into a subtractive brosh, only
the area of the Builder brush thaI falls within lhe subtraclive brush wifJ be kepI, and lhe area that

(aJls ()u lside the su btracli ve br\l sh wi II be deleled.

Conversely, if the Builder brush is inlersecl ing an add jtlve brush, the area of the Buildel' brush
that falls outside of the addi(lve shape will be kept, and the area of actual intefsection will be

dele led.

Add Special dialog.

-Rbr--~-~-T------=--"""",-~""I

l'lo!~l Ill::

rt\o~ ~
I~

r 1400
r~

r ~......!Gd

FIGURE A.1fiI

Add Special Brush

This command will bring up Ihe Add
Special dialog (see FIGURE A.18). From
here, you can C(t'<!ole a variety of brushes
(or specific eHect and oplimization pur

poses, Because these types of brushes are
not used very often, they have all been

groupt'd within this singJe command)
rather than each having a separate com
mand of their own.
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A variely of special brus~s can be created from this dialog by either selecting one or more check
boxes and a radio button for solidity, or selecting a Prefab from the drop-down llsl. TABLE A.13

shows the options found under the Add Special dialog.

TABLE A.13 Add Special Options

Check Boxes

A

Anti·Porla!

Portal

Mmor

Invisible

Two Sided

This option Lurns yoor Special brush mto an AnllporlaL An Antrportal speeds

up the rendering of a level by occluding geo.melry thai fans behind it. This

works to speed up ~'our level II) that objects In yOO( scene may stlll be reno

dering, even though they are not Visible in your vrew. As long as an Acto{

falls 0(\ the opposite side of an Antlportal. it WIll not render at aiL

You wIll not want these to be wlttlin the open space of your level, but hidden

within another objecL For example. if you have two bases that are bullt on
opposite side s of a hill in your level, the rende ring engine Will st ill be render

ing those objects, even Ihough you are on the oppOsite side or the hill and

cannot see them. II you were to place an Antj-Portal sheet iMlele the hill,

the base on the opposite skte oi the hili Will (\ot render. aM '10Uf level Will

move faster, For more information see Chapter 15. ~

Having ttllS option selected win allow you to create a portal. Portafs are

used for zorw~g levels into separate areas \0 optimize the speed of render

mg. or to designate certain ateas of the map. Essent18JJy, If no part 01 the

portal is viSible (whether the lnvisible setting is Checked or not). whal IS

located behind il will not render As such, il is a good idea [0 place these in
corridors lhaL separate rooms, so that the room at the other end of lhe co{·

ridor Will not render if you do oot see Ihe portal. These are covered In finer

detail ((l Chapter 15.

This makes it so that all faces oi a b.'ush are tagged as Mirror, DOing thIS

lvill cause all the faces to reflect the envircnmef'lt like a mirror

Simply put, this setting WIll diszble Vls(bility for your selected Special brush,

Several of the prefabs use thiS feature. The wrreframe tor brushes created

WIth Ihis setting alo1)6 win be pink

fhls setting Will cause your Special brush to be double-Sided. which means

it will have a front and back side. This will cause the effect of your Special
brusn 10 be visible rega rdless of on which side you 8(e f}{)S itioned,

For example, rf yoo create a sheet brush wrthout checking Two Sided, yoo

win only be able to see one side of the btu sh, the poSItive SIde oi the
potygons. If you check Two Sld~, both sides wili be visible.
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Solidity

Solidity for brushes does not immediately mean exactly what you may assume, in that it does not

only specify whether an Actor can interact or pass through an object. It also deals with the way

your BSP is divided in your level. Because the standard brushes created in your level are solid by

default, a solid brush created from the Add Special window will work exactly like a normal added

brush. For more information on brush solidity, see Chapter 4.

Prefabs

Prefabs are predesigned combinations of various settings from the Add Special dialog that are

commonly used together. TABLE A.14 lists the Prefabs in the Add Special window with a brief

description, as well as the settings that are activated to create each one. You can then review the

setting descriptions in TABLE A.13 to get a thorough explanation of how each brush works.

TABLE A.14 Add Special Prefabs

Invisible Collision Hull

Zone Portal

Anti-Portal

Regular Brush

Semi-Solid Brush

Non-Solid Brush

This brush is used to either create a surface over a non-collidable
object to serve as a basis for collisions, or to simplify the collisions
of a complex object, such as a static mesh. Note: These are overly •
complicated and can cause SSP problems; therefore, use Blocking
Volumes instead.

Settings: Invisible, Semi-Solid

This is a portal specially designed to help zone your levels for opti
mization or to designate certain areas (such as the Blue Base}. For
more information see Chapter 15.

Settings: Portal, Invisible, Non-Solid

As mentioned in TABLE A.t3, these Will obscure any Actors that fall
behind them. For more information see Chapter 15.

Settings: Anti-Portal, Invisible, Non-Solid

Using this brush is the same as creating a normal additive brush.

Settings: Solid

As the name suggests, this simply creates a regular semi-solid brush
with no other speCial attributes.

Settings: Semi-Solid

This generates a NOll-Solid brush with no other special attributes.

Settings: Non-Solid



M..{ Appendix A The UntestEd Manual

Add Static Mesh

Thi~ CAn be used 10 convert a brush into 3 ,<Iollic Jl\e~h. lo llU II, jU11 dick an • orush or Sialic.

mesh. and a dialog appears so that you may choo~(' Ihe p~ckJge. group, and name (Dr your new

st:Hic mesh. Keep in mind that this i.s a r3Ther in~((j(,ier\l wny lei creolle .n.aUe meshes, and in no

way should ~ use<J \0 replace a 3D applic3 ri 0 I).s uch :\..S Al.\a.! Maya.

Add Mover Brush

Although rhe name of this 1001 suggest5th.al you are ,reallf\R.l br\.l.ih, Add MOiler actually CTeatts

a specitll k.ind of slMic mesh that can move rhroug.h6UI YOllT Hent, TI\e:s.e ,an ~ a wk::le lI.riely

of objects in your level: doors, t1e1l310rs, mov)ns p). I (OT 111\, and 10 on. The~e OD}fCl! and !.he
methods (or using tbem are covered in Ch;)PIU 9.

A Add Anti-Portal

This 1001 generait's an AnliponaJ aclor. This .)(lelf gives you if\crt-ase"a (DnuD) Dllef the An Iij)'l rlzi.

,,110,\!ing you 10 toggle it on and 0(( as wdl as a,sDciulf\8 il Willi M6vers, Olh.erwise. it w()Tb

much Ihe same as th(: Arl1iporta] brush described if\ TABLE A,14. The wirdnnne (or these

objects IS orange. For more in(ormilrion see ChapiN IS.

Add V61ume

this tool.allo\lls you to Clate :l volume. "h~f: :He ustd 10 specify Ihree-climensi onal areas h'i Ihin

the levd ,-,'here environmtntal conditions D.r1 bt allcred, such 3.S u ndfrw~!ler areas. These are '-0"

~rtd in del'th in Chapter 6.

Selections; and Movement Area

This itr<-..l. has a v:lrlcry o( commands rhill you can IJse 10 control what you see in the lIiewpon, a~

well as ch~nge the ~havjor of the Cilmera. See FIGURE A.iB.

Show Selected Actors Only

ThIS operation illow$ you 10 hide <111 aClors

thaI are not <:urre'Hly ~1~led. Tne BSP

brushes wjthin the k..,d will ~ hidden in

Ihe 10 vie\\!~ but wJI remain visible in the

30 vi,,\!. This (orm o( i~laled lIie,\!i.Dg is

good (or 6oc-tuning specific areas \~ithou(

navu-.g to deal with Ihe clutier o( sur

rounding .actors,

sr.o.... Scle<:r~d AClO~ Only

Srl(>oll,u AClOf'S

FIGUREA.!.9 Sel ectlons an d Movement area,
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Hide Selected Actors

This wLlI hIde only rho~ Acto~ that are s(!rcted in 2 b'el. This is convenit'nl i( you :lrt finished

lw~king lh~ loeJtions. settings, lex lUres. and to on of ~ sel (I( AClon dnd need 10 move Oil to

aoolher .area. You can hide lhe AClors you are finished wilh. and ",ove on 10 ocher:< -vilna,,' (Ll].

ifl& YQur \,icw needlcs.5ly. A5 with the Show Selected Aoors Only cOnlOlllnd. the BSP brusncs

wir"in the kvd wtll ~ull be visible I,.. the .3D vic\v.

Show All Aeto(s

Thi~ co",m~r.dwill UIlhidc all ACIOrs i.Tl your level. If you have bee" hidil'lS AClors. and s~ern LO

h:lve mispbCC'd one. or lWO. be sure you click t hi~ hutton 'odon you rtpl4ce t h.. m.

Invert Selection

This is anolher o( those specIal com mands ....·h~re: the ""me really ~cl1'\! 10 ."-ly II All. This ....·ill dt'~·

elect ~ny curru\lly Seli'Clod aClOni. and instead seleCl all ~':;10rs lhJt "'cre 1'\01 ,nc:luded j", Ihe orig

inlll selection.

Change Camera Speed

This bUllon gives you direct COJilfcl over Ihe .peed .<If \"hic:h YO\JT Garne.T~ mows through Ihi.

viewport!. It has thre-e stpdlJle St'lIi"ST, ,,,11 ic.h yeu em s....·i"h fhrough by click ing the bUlion

repeilledly. The .\ccond, or middle speed. is lhe default selling.

Mirroring and MiKelianeolJ s Are.

The cornJnands in, kis ar('3 arc de~igned lCl

allO'\", rou to )T\irror your brushe~ vong Ill)

lhree :lXI'S 10 J en ieve SyT1I '" el ry in you r

level. AIso wit hin I his are;l aft somt 1001s

10 si mplify Ihe Se.lf'C'IIOli of severaJ differenl

Ob)tels ~s you \"ork. See FIGURE A.20.

Mirror X

Mvlo.D Mirror Y

MirtO' Z Sel~ct All Ins.ioe

Clip 2 i" Wirerrarne Align View 011 AClor

FIGURE 4.20 Mlrronng and MI~ctllal\~ous olea,

ThIS 1001 will mirror your Builder bru~h in the X-a...'{is.

MIrror 'II

This 1001 wl!1 mirror your Builder brush in (he. Y·.d1'is.

Mirror Z

You guessed it! This mirrors your Builda brwh if) Ikc 2-4.>:>5. (Never .13'" Ihl1/ coming. did you~)
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applied to Ihe Actors within the level. The 3D view, however, does have a weakness: [t is very dif·

ficult (if not impossible) to gauge the precise location o( specj ItC objecls. such as brushes and sta·
tic meshes, within this viewport.

It is for this reason that the 2D views exist. They do not display depth of any kind, nor do thcy

display any of the texwres applied to your level. So, although your level will appear very mLlch as

if it were in blueprint form, you will have very precise cont rol over exaclly where each obJect IS

IOGated within your level. These views display from three different angles: Top, Front, and Side.

You will notice that in the lower-left corner of each o( the viewpoas you see a small icon repre

senting the direction of the world coordinate axes. These will display the direction that each axis

is pointing at all times, which will become very important as yOll work. This is especially' true in

the perspective window, in which you are constantly moving and rotating the camera.

Viewport Controls

There are many places within the editor that

you can control [he viewpom. One of the fim
of these is within the View menu. Tn this
menu, you will see the Viewports submenu

near the bottom (see FIGURE A.22). From

this submenu you can access a few commands

to control various aspects of your viewporls.
These are described in TABLE A.15.

FIQUF~E •. 22 Viewport confJols.

TABLE A.16 Viewports Submenu Options

Float,ng This command turns each of the viewoorts Into separate windows that can
be mow~d (lnywhere on tM $creeo. This can be very handy if you want to
maXlml2,e a particular viewport to Iitt your screen, Of just need to move the

viewpOrlS out of your way when working.

Fixed This IS the opposite of (Ioatlng. 'This locks your viewports back into their
original position~.

New Viewport This command is only accessible when the viewports are floating_ It allows
you to create a new vi~wpo(t. and set its display p(o~(\ies just as you

Would any other. In this way. you may have as many Vlewports as you feel
you need.

Configure Thi~ brings up the Viewport Configuration win(1ow. Here. YOl) can adjllst the
layout of your viewports in the manner illustrated (){\ each bUl1.on. This WIll

worK whether your "iewports are floating or h~ed.

Close All You (,al) use thiS to close all of the "iewpOtIS... if. {O( some reason. you
Shollid feel the need to do that.
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Just below the View po ns su bmenu, you will find one of the less practical (bur still prelly cool)
(eatures in UnrealEd. This is the Background Image submenu. This allows you to insert a bitmap
inlO UnrealCd thai aClUally displays behl'nd the viewports. If you've got all of your viewports
opened up or maximized, you won't gee to see it, bUI it can slill be a neat way 10 personalize your
workspace a Ii nle.

Viewport Control Bar

Each 0( Ihe viewporl.~ has a bar across the lap with a selection ofbuuons. These invoke differenl
view modes and options (or each viewport, The following is a list of each or these available con

trols and what Iheir uses are.

From leN to righI, the lirst Ihing you will see in the Viewport Control bar IS the currenl mode of
the viewpon you're looking al. Examples would be Dynamic Lighting. lighling Only, Tex(ure
Usage, and so on, You can read more about each of these view modes in the following sections.
FIGURE A.23 shows this bac and various modes avauable from il.

DISlll2Y Modes Tex1ured

Te)llure UssQe

DynaIl'\\C LIQhllrrg

FIG URE A..2 3 VIewport Conlrol bar.

RealtIme Preview

This bullOIl will allow you to view any animated effecls and texture-s in motion, as they will
appear in rhe g?me. Th is only has a dramal ~( effect in the 3D view.

Display Modes

The flrsl IhJt:e Di~play Mode bUIt01\5 conlrol the type of 2D view you w()uld like to use. The T, F,
and S icons represen! Top, Front, and Side, respectively. The-se ,vill allow yOLl 10 SWllch qUlCkly

between Ihese three modes.

The nex t severa I bunons across the Viewport Control bar control a variety of display modes,
which work specifically (or the 3D View.



Perspective

This display mode will show your level in a three-dimensional wireframe. The brushes in your

scene will be color-coded as they are in the 2D views. Tile hotkey combination for enabling this

mode is Alt+1.

Texture Usage

This display mode will remove all lighting and show a different color for each individual texture

displayed in your level. It has no effect on static meshes. This can be a good way to diagnose

whether there are areas of the map that have perhaps too many textures, which could possibly be

making high demands on the graphics engine. The hotkey for this display mode is Alt+3.

BSP Cuts

In previous versions of UnrealEd, this was used to display the locations in your map where cuts

or tessellations in the BSP had been made. This mode is no longer completely functional, and will

only display your ESP in white. The hotkey for this mode is Alt+4.

Textured

This display mode will show only the textures on your objects, not the lighting. This is a good way

to ascertain texture placement without having to worry about how lights are affecting your scene.

You must be careful. however, as many textures will look dramatically different when lighting is

applied to them. The hotkey for this is Alt+6.

Lighting Only

This display mode will strip away all textures on your level and show only how light is playing on

each surface. All surfaces, BSP or otherwise, will be rendered in white, and are only affected by the

color and type of light that is striking them. This is especially useful for controlling the exact

effect of shadows in your level. The hotkey for this is Alt+O.

Dynamic Lighting

This is the default display mode for the 3D view. It displays aU lighting and texturing within the

level. This is exactly how you would see the level within the game while you play. Despite the

name, however, this will not show dynamic lighting effects, such as triggered flashes. 10 see these

kinds of effects, you need to enable Realtime Preview, explained under "Realtime Preview." The

horkey to enable this mode is A1t+S.

869
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Zone/Portal

Ti"li.e. display rn~t \~ill sho\\1 ca.::h wnt o( your k\'~1 ina di (fatnl coklr. Th 1£ I.e. an invilu3bk
fTK:)ck (or kvd opomi 2.:ll iOll, and \~ discuill'd I~roughly jn Chapur 1S, l~idtn lally, Ihis mode
will aho display any BSP rulS in your level In va rying shades o( Ine oolor m wh ich the curre.tl r

wnt \~ rtndering. "1l\ere(ore, i(yo.Ll need loue C\lIS in your BSP, \)e-<.ure 10 uS( Ihi-s m~ ralher

Ih:!" BSP ems m()l!e. The ~r.k.:y (or Ihis display mo<::k i.e. A11+2.

De ptn Co mplexlty

When \Ising the Depth GJrnplexilY~ you .see how many re.xtwe-S are being draW1\ over a

givUl par! o( t.k sUe£J). This is useful when delec mj ni.ng where rernin layers, de.co laye~, pasli

cI "0$. and so on have b.ec.o~ tOll dense. Airer you switch over to this mode, a bas appe.ars on Ihe

righl side o( {},e \liewporr wil h a gr ad ient from green 10 red. Green areas. of the vie"'p,or! repre-

A sent areas !.hal ha\lc 001 one LtXlwe. When an are.a is c.ove.red wich mOle an<:! more lexl\l res, thaL

ar...~ \<JilJ &hill rowards rell. If I he area gQe"!; beyond rell, ir simply loops back throug.h Iht gradient

10 .sIan again. I( rbis. hap~j)s, you may wanl 10 consKkr de.u~ing the arIWllfl\ ofle~ c.ov·

er ing lhe &a_me area.

l.ocK to Seleeted Acto,

The ncot bUI tM in Lhe Viewport GJn I ro.l ba r is no.r a dis.~ay ~; ral~ r, i( li d very handy rool

10 relo<:al~ OO)ccts in your level. This 1001 snaps the c.a~ra to the 1lX.a10n o( Ihe uk<.led obje-Cl,

3M then iltldches thaI objat 10 the camera. In effecl, ir's a IOL 1ike dragging your Actor around

wi!h ~ tow I ruck. To use (he UK\< to &kcteo AClor funct~n, click on it 10 enable iI, and I hen leff

,IX!< on an aClor within your level. You r camera w~1 jump to I be WHtn ( Ioc.a lion and ()ritl)(31 ion

()[ Ike Actor that you selected. Then, m()Vl: your c.amera around using you r .e.tandard viewp<:>r(

enn I rols. lNhen your camera is in (he ~ire<l ooliOJ\ (or you r AClor, dlsable UKk 10 SelCc.fed
Ac(or, aM move your camera. You willue thal the Actor Ls now in lhe (>Oiition tht carner.. was

w~n Lock 10 &kcled Aclor wa.e. d~abled.

Show urge Vertices

Th.is will display the venias of a selected object as 12rge, white; Lwo·dimensiOIkl[ SqUilIes, ma k·

ing l heir sdeclKln very easy. This is .. very co·rwenlent Opl ion (or verte-r editing.

\liewport Contr-ol Bar Context Menu

If ~'ou righ t· cI id<: on any of Ihe (ont[<)1 bars o( .. ny vi~lXlrl, you WIll ite a fT"Knu lXlP up (ha ( has.

a WIde range of toots (or controlling the behavW:lr o( you r viewp.ort. Sec FIIi UREA. ~ 4. Be<:ause

some of Iheu hall~ already been covered in Ibe bolloM des.:: rihed in the preceding ~ectkln, we Will

onJ)' ck.scribt (hose lIu I are entirely new.
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Mode

This will set the current display mode for

the viewport. These are (he same as their

corresponding bultons. described in the

"Vie""'P¢rt Conlrol B3r" section.

View

FIGURE A.24 Viewport Control Bar contelrt
menu.

This will (On(rol vi$ibility for a variel yof obje~ts Within your level. TABLE A.18 lists :and briefly

describes each one of the options found in the View subm<"nu.

TABLE A.18 View Submenu Options

Show Active Brush Sh6ws or hides th~ BUlldt:r brush.

Show Static Meshes Shows or hld~s static meshes.

Show MOVIng Blushes Sh6ws 01 hiQes Movers.

Show Vol:.xnes Shows Volume brushes such as waLers and ladders.

Show Backdrop CCl1ttols the visihility of the SkyMl(. Skybllxes are C()vered III

Chaj)le{ 5.

Show Coordit\ates This optlOrl is fIOl currenlly funCiiot\af.

Show Paths Shows Al Navigation paths.

Show Event Lines Displays lines that CMMet Actors together who have matching Tag

and Event prope,rles.

Show SelectiOi\ Highlight ActIVates the effect Of'\ selected surfaces and Actors. which high·
lights them when selected. Surfaces are blue when selected, and
ACtc>rs are gleen.

ShOw Tenain Controls visibility of Terrain actors.

Show Dlslance fog ACtivates vIsibility fer disLance fog. provide-d you have generated it

withlll your scene.

Matinee Rota\iOl\~ At the time of this Writing. thIS menu Item is non-functional.

MalJnee Paths AC\lvaleS visibility for Malinee interpolation paths.

Show FlUid Surfaces Shows and hides Fluid Surfaces, which are tessellated planes tnat

ripple like liquid.

Show Karma Primitives Conuols viSibility of Karma ObJeclS. which are influenced by 'he

Karma Physics engine.

Show Collision Displays the cl)jllsion wireframe around static meshes.
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Actors

The context menu also offers an AClors submen LI, Wilhin chis submenu, you will fi nd the options
shown in TABLE 4.17.

TABLE 4.17 Actors Submenu OptIons

Full Actor View This resets the view to ilS default setting, deactivating any of the fonowlng
options,

In/ormation ThiS shows each ActOl"s name, as well as the values of their Event and Tag

properties.

Iwn View This places an Eagle icoo at the location of all Actors.

A
Radli View

Hide ActOfS

Window

For IlghlS, this shows lhe LightRaclius as a circle or sphere depefldlng on
whether you're In an OI'thographic viewport 0( perspective viewport respec·
tively. for other colliding aClors, it will show the collision height and radius as
a cylinder.

This hides all Actors, including sIalic meshes, from ~he viewport.

This submenu allows you to switch rhe viewPDrt between 16- and 32-bil color. As the editor
requires 32-bit color 10 nm, this setting is irrelevant, and will not change,

The Console Bar

The final parI of Ihe Unrc.aIEd user in tefface is the console bar (see FIG UREA. 25). This strip
across the bottom or the Ut contains several tools for controlling Unre.aIE.d's behavior, and meth

ods to speed up level construction workflow.

Ver1ex Snap DrawSc.aJe 3D
Log Window Rotation Orid

Maximize Viewpor1

FIG UREA. 2 5 The console bar.
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The Text Field

The text field (see FIGURE A.26) aUows

you 10 input console commands directly
into UnrealEd. There are many o( these, FIGURE ",26 The!.e)'t field.

and they accomplish a wide variety of
tasks. including returning feedback in the log or directly in the viewport. The prompt also \\Iorh

as a drop-down menu so that you may access command.. thaI have been previou..(y enleted Wilh

out having to rewrite them.

The Log Window

The Log window provides you wilh constant feedback [rom what )s actually going on inside the

editor as you work. There are many commands and queries in UnreJ]Ed Ihat only return dala 10

the log.

Lock Selections

When this button is enabled, all Actors that were selected will remain selected and nothing else

call be adJed or removed from Ihe selection. When you are ..electing surfaces with this bUlI.n

enabled. surface selection will behave as though you were holding down the C,rl key.

Vertex. Snap

In recent versions o(Unreal. this is no longer used.

Drag Grid

This setting will snap entire brushes to points on the grid as [hey are moved around Ihe level. This
selting is dependenl on tne current Grid Size. which controls the distance that objects wJI snap
when being moved. This is a very imporlant option [0 have aetivaled \yoen coClstructing your level.

MiniscuJe (or even imperceptible) distances that occur when alignmg objects will have the same

effect as tremendous distances. For example. if you ~re trying (0 conneCt Iwo sub( ractive brushes to

form a corridor, and there is a space berween them thal is even a fraction of a unil wide. the dis

lance will still renMr as a waU, and will be completely impassible. Corwersdy, iryour cwo subtrac

rive brllshes were ifllersectirlg into each other. you run the nsk of crealing BSP holes in your level.

Rotation Grid

This is another vital seTting when crealing your level. This selling will soap all rotations to a rota
[iona) grid composed of 64 grid divisions. Th is means (na( rotating onf grid unit IS eqllal to

exacrly 5.625 degrees (360/64 =5.625). This is an invaluable tool when rotating objeCl5 in your
level. as freely rOlating lO exact values is likely to be almost impossible. Even Ihough you r mla

tions might seem correct. there could oe minor differences thaI would cause errors.



A

814 Appendix A The Unreal£.d Manual

Maximize \liewpori

This bo Ifon w~l maxim iu I~ currently selected vicw-porL. and it will reSlllrc a .... iewp.on fo regu·

lar ,~11e i( II )s :.llre:ldy maxim\2cd. This bullon is non·fu~fmnal (Of older bui.J<h o( UnrtaL

DrawSc.ale.3D

Th ls tool proviMs Y<lU w ilh a simple melhocl ()( obiect sc..31 ing. Each o( fhe th ree numeric fields

provi(.~ puc.enlage·based 1C<1ling in lhe x.. 'I., ;and Z~ respeCLively. The percentage system

works such fhal 1.00 is eq II af 1.0 1000/0\ O.S woo!d be equal fo S~, and S<l on.

Browsers

The :.l~l.i n~eJ (0 con~trua Jf\ Unreal kvel can all be :.lccesse<l wn hin lhe browsers. In (h.is Sf<'

l'ion you will ~ 3 d~ripLiOl\ of t"3,h (){~ b-rowsel"S. a.long with (~ir ft'sp« I we functionality.

The Acior C18A!l Brow8er

The AdM da~ browser s~wn in FII] UIf EA.:.l7 I~fs aU o( fhe ACIM c1<ill~ available within

UnrQ1. TI\tie Actor cJ~i arc~ u~d as :l methocl of inserring AC1Q.l'S inlo your level. To do ttis,

merely sekCl tht Iypc o( AClof you W3nt (rom rhe IlsI (){ c1asus. and then righl" lick in you r vielll·

~Tl w~re you '\lanl Ihe A(.Ior ro be placed. Then, from Ihe ~PIJP me f'l\J , ch~e rhe lhird

Op.liM, ..m'Kh will be "Add <yow s.eltded Acror> HUL"

.......
• t.,.,...
:~~~T~Dodc
~ ,,,,," Status
"' ,,---'"....,:

• #'--

'-..-... "'I".....-..~

• ~>~,~~.~

.,u.r.........(c.MM

'rrill"...

• .:'1#'
~""""'-:.~

·u~·.,

.....~~.......
... -~...r.J.'6,I;.o

-.......
~W-I-rJl.:r

FrGUAEA. :l7 The AetQ.l' C.lass broW-ie.'.

Edit Default
Prop&f1ks
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The browser also has interface buttons and check boxes across the top. TABLE A.18 lists each ot

these buttons and check boxes. and their funclionalily.

TABLE A.i8 Actor Class Browser Options

Toggle Dock Status

Open Package

Save Selected

Packages

New Script

Edit Script

Edit Default
Properties

Use Actor as Parent

check box

Placeable Classes

0011' check !:lOx

This docks and undocks the browser (rom the Browser window. If
undocked, the browser becomes a free-floating window that can be

placed anywhere on the interface, and the browser's tal) is removed

from the main Browser Window.

This allows you to open packages of Actors so that you can insert their

contents into your level. For more info on packages, please see the
corresponding section in Chapter 1.

This allows you to save packages if you have made any changes (0

their contents. To select a package for saving, you must first turn on
Show Packages (rom the View menu at the top of the browser.

This allows you to create a new class using the UnrealScript Ed~tor.

This allows you to access the source code for specific Actors and

classes. This is 'he same as double-clicking the item in the list.

This brings up the Properties window, and allows you to adjust what

the settings of a specific Actor will be by default when it is added into
your level.

This displays the head of the hierarchy tree as Actor, instead of Object.

This displays only classes containing Actors that can be placed in the

scene.

Across the top of the browser is also a menu bar. TABLE A.19 gives a comprehensive list of the
menus and their functions. Any comm4J1ds that were already covered in the interface buttons in

TABLE A.18 will be skipped.

TABLE A.19 Actor Class Browser Menus

file Menu

Open Package

Save Selected

Packages

Export Changed
Scripts

Export Ail SCripts

Same as button described in Table A.1.8.

Same as button described in Table A.iS.

Exports any class or Actor scripts that you might have changed to a
folder containing .uc tiles so that they can be edited and rebUilt later.

Exports all Actor and class scripts to a series of folders and .uc files,

so that you may edit them and rebuild them later.
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TABLE A.19 Continued

VIew Menu

.~

Docked (Toggle)

Shaw Poc.kages

Class Menu

New

New from Selwi6n

fOil SCriPl

Default Propenies

Sarna as Toggle D-ock Status bulton described In Tabla A,1.8.

Displays a check bo~ \lsI 0( aW of the available p.ocl<agM. Yoo must

selecl. .a package ~ checlMg ils bO)( if yoo wan.! 10 save il.

$.ame as New Satpl b-ulton des.c,lbed In Table A.iS.

Creales a new class within a selected package.

Same as button d~lIhed In Table A.. 1.8.

s.ame as Edfl Oetsull Ploperfl~ OOl1on "~/lb-ed In Tab~ A..lS.

A

------ --------------------------------

You may also dQ-llbk-click any Acwr or dass within Ihe." browser 10 aca.u it~ S<)urce code. Thli is

wry handy if you need 10 l)u iddy edit pan o( lhe prQ&r ~ mming c:Me (or a speci& Aa& or cJ~.

This is a great way LQ~~behi.nd the =es"" of cerl~in ACLOrs.a~Cj,11se~ in order 10 see wh,l[ makes

t./vln tide ft's also <I g60d way to see MW undocumented prQ-Perlie1 o( an Actor or Chll worle.

The Groul3 Brow&er

The Grou)) bwwur (.see FI GU AEA. 2S) alklw... YQll (() creale an<l manage group... ()( ACI6r... in

your ~cefH:, Th~ an grear:y Increa..e;e Ihe e«((ciency ()( your kV('l ai YQU wor!<, as these gc().(Jp.s can

~ h)Jacn (rom wirhin Inu bmw-SeL After y()u make a group, ynu on add <:>bjew; iOl() LI, lake
!hem back ou I again, and edn the properties of <:>bje<:l~ wilhin ,he group,

~=-------_IIU"i'J:""'::::;:::==':'":;--~il

~ Sal&c\ AClors In G-ioup(s)

D&\e Selecled AdM.s "om C?Iovp(s)

FIGURE A.28 TheGlOup b-roWs.el.
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TABLE A.20 lists the buttons across the top of the browser.

TABLE A.20 Group Browser Buttons

Toggle Dock Status

New Group

Delete

Add Selected Actors
to Group(s)

Delete Selected Actors
from Group(s)

Refresh Group List

Select Actors in Group(s)

Deselect Actors in Group(s)

This docks and undocks the browser from the Browser window.
If undocked, the browser becomes a free-floating window that
can be placed anywhere on the interface, and the browser's tab
is removed from the main browser window.

This creates a new group that you can add Actors into, remove
them from, edit, and so forth. A dialog appears that allows you
to name the group. You may have one or several objects
selected when you click this, and all will be added to the group.

This clears the selected group from the list.

As the name suggests, this allows you to add selected objects
into the group.

Once again. the name says it all here. This will remove any
selected objects from the Group or Groups.

This button is intended to allow you to refresh the groups as
you make changes in them. However, in more recent versions ·of
the editor, this button is superfluous as the groups will update
automatically as you perform actions upon them.

This selects Actors in the selected group.

Naturally, this deselects all Actors in the selected group.

Above these buttons on the browser is also a menu bar. TABLE A.21 is an overview of those

menus. Any commands that were already covered in the interface buttons in TAB LE A.20 will be

skipped.

TABLE A.21 Group Browser Menus

Edit Menu

New Group

Rename Group

Delete Group

Add Selected Actors
to Group

Delete Selected Actors
from Group

Same as button described in Table A.20.

Changes the name of the selected group.

Removes the selected group.

Same as button described in Table A.20.

Same as button described in Table A.20.
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TABLE 4.21 Continued

Edit Menu

Selected Act0l5

Deselect Actors

VIew Menu

Relre~

Same 8S Selul AC.IO-fS In Gr6Up(s) bullon o6Sulbed In
Table A.20.

same as De:!.elecl ACIO-fS In G,~s) bUllon described In
Table A.20.

See Toggle Dock Stall../'ii In Table A,20.

Re(re~s the group ~SL.

Within the group list iMide the browsa, you will see che.::k M',(C'.s nal (0 ach group. CM-dcing

A Lh.::sc Mil aclivalc visibilil'y (or I~ c.orr~p<:lndlng gr().Uj). 111 this WJy, you can quickly hide JI14
show grouped AcLors in your scene, in order 10 sj)eed LIp Ik ViC'Wp<HI, or jU~1 10 ~Iay organiud.

1l\e maj<)r cxCtplion 10 this, however, is BSP brushes, Th<-u de Mr Nrn invisible in lk 3D view,

but will be hidden in lhe 2D VK-w.

Selecting all Actors wilhin a group al1 be quile bendiciaf 10 spud or worKrlow. For example, leIs
SIIY yOll have a series o( lighrs in y().Ur sane thai all require lhe ,ume effect. You c..an gr().Up them

all together, .l.dect aU Ac..tors wi I hin the group. and maXe. YOllr c.hanges 10 aU o( Ihe' lighl1 SLmul

lMIl'Ollily, rather than having to go light by ligh I.

ACIOH c.an be membe'n or more than ()nt group a/ a lime, In fa"l, a single Ac lor can erul Within
any number ()( group~. The' main rulc thai musl be' ke'j>l in mi~. however, i~ Inal i( an AClor is a

member ()( numerOll~ gmu p~, i( Ilny o( Ih61e group~ art hidden, Ihal ACI()f will be hiJden as well,

regardless or "-hether or n(}\ Ihe Olhcr g(oop.s 10 whom Ihe AClor bcklngs He hidden. Ltl'.\ ~y,

(or enmple, Ihal y().U have an AClor lhal has been addtd 10 GroupOne, GfOupT\~o.. an<l

GroupThru. ]( you hide GfoLlpOne, the ACI().(' will also be h\J<kn, even I( GroupTw() and

Gmu pThree are \'i~ibIe.

The Mua.ic Brow&er

This brol'J~er is Mt used l:l\ Unreal Tournament 200) or UIHtaJ Tourflarn<nt 1004. This wi~w

.allows you loa ccess mu~ ic pacbgC'$, as well as pl.ry mllii" (see F ICi UREA. ~ g). i I Wll llied ill Ihe

original Unreal T().Urn~nr (Lrr99) .an<:! Uk original Unreal giUn<'.



FIGURE A.:19 The Music browser.

The Sound Browaer

Th~ SOl.lod bro\~ser (~e FICURE 4.30) a.1Iows you to access sOUJ\d p~c.'k3ge!. and umpl~ Iheir

cont<:nts. You may als.<> S<4ve new sound p.lCluge:s th.al on be made up of your own sounu drCC/l.

Th( top of {he bro\~srr c.ontains lhe (0110\";1)& in ICr{3<C bUllons and menus.

Propertl&S

Open package Play

Toggle Dod< Stop
Status

Seve PackaGe locpin.g

Load Enlilll Pllckage

FI Q U "E A. 30 The Sound btows.er.
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TABLE A.22 describes the imerf"ce butrons of [he Sound browser.

TABLE A.22 Sound Browser Buttons

A

Toggle Dock Status

Open Package

Save Package

Properties

Load Entire Package

Play

Looping

Stop

This docks and undoCkS the browser from the Browser window. If
undecked. the browser becomes a free-floating window that can be

placed anywhere on the interface, and the browser's Window is

removed from the main browser window.

Tnis allows you to open packages of sounds and access their

contents.

This allows you to save new packages and packages that you have

edited.

This bunon will display the Properties window for the selected sound,

and allow you to edit those properties.

This bUnon allows you [0 load the enure package of a selected sound

effect. An example would be If you open up a level that you have

been working on. or have already completed. The level contains three

sounds that came out 01 a package. You will only see those three

sounds in the browser when you open the windOw, but perhaps yoJ

wanted to see what other sounds were available In thiS package. ThiS

button will bring in all of the other sounds that are incluced in the

package from which the first three sounds originated.

This plays the selected sound effect.

This activates looping for the specific sound effect.

This button stops playback.

Next., TABLE A.23 rakes a look ar the menus across the top of the browser. Again. any commands

that have been covered in Table A.22 wil.l be mentioned but not described.

TABLE 04.23 Sound Browser Menus

File Menu

Open

L08d Entire Package

Save

Imporl

Export

New Sound Group

New Proce<1ural Sound

Same as Open PackClge button described In Table A.22.

Loads in the rest of a package to which a specific sound belongs.

Same as Save Package button described In Table A..22.

Allows you to Import .wav files as sound effects.

Allows for exporting Unreal souoo effects out as .WilY tiles.

Allows you to create a new group to organize your sounds within a

package.

This is not being used in the cu({ent \/ersion of UMeal.
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TABLE A.23 Continued

Edit Menu

Properties

Delete

Play

LooPIng

Stop

View Menu

same as button de~crjbed in Table A.22.

Deleles .he currenlly selecled sound effect.

Same a~ button de!';vibed In Table A.2.2.

Same as button described In Table A.22.

Same as b ulion dese-ritJ.ed in Ta ble A-22,

Oo<)ked (toggle) See Toggle Dock Status in A.22.

The re are two drop-down menus underneath the toolbar are.a on this browser. The first of these
is the P.acbge Selection menu. From here, you (an access aU of the packages loaded in.o Unreal.
Beneath that is the Groups menu, which displays aU of Ihe groups contained wilhin the specific
package. To the len of lhe Group menus is lhe AJI bunon. This overrides Ihe Grou p menu by dis
playi ng all sounds in Ihe package, regardless o( what grou p they're in.

The Textures Browser

Unreal already contains a wide variety of teXltlreS, and Ihe Textures browser gives you access to

them all (~e FIGURE A.31). From here, you C<ln open packages of textures, sorllhrough them,
add textures to new packages, and select texWres to be applied 10 surfaces in the level.

Tarlure Properties

PreviOllS and
Nexl Group

Ope.n
package

save Pe:d<.3ge

Toggle Doc\( Load Enlife
Slslus Pacl<aqe--------,-;---

FIGURE A.31 The Textures browser.

TABLE A.24 Hm the bultons and menus for this browser's interface.
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TABLE A.24 Textures Browser Buttons

Open Package

Save Package

Texture Properties

TDggle ()()ck Stalus

Load Enlire Pacl<age

This d()CKS and ul1dod<s the browser from the main browser window.

II undocked, the browger becomes a frae-f1oaling window that can t>e
placed anywhere on the interface, and the browser's lab is removed

(rom lhe main browser window.

ThlS allows you to open and access packages o( te:dures for brows·

Ing. relocal\ng into other packages, and placing on surfaces.

This allows you to save new packages, and to save any changes you

might have made to the current package.

Thi s brings up the Proper tie s wmd()W for the se(ecte-d lexlure. From

this window, you can create various shoders (Of yOU( surfaces.

If yoo have a lexture Lhat ca me oot of a specific package. and want

10 see the other telllures available \1' lhal package. just c/icx this

lxmon.

Previous and Next Group These buttons switch between Groups of telctures WIthin packages.

A

The menL.l bar across the top of the browser contains the menus descrIbed in TABLE A.2S .•

TABLE A.25 Textures Browser Menus

File Menu

New

Open

Save

Import

Expo1\

Edit Menu

Allows you to create a new material, and create shao'ers for it. For
more information 011 this, tum to Chapter B.

Same as Open Package button described in Table A.24,

Same as Save Package butto" described in Table A.24.

Imports textures into the browser from any of the following formats:

.bmp, .pcx, .tga, .dds, .upt, or .dxL

Allows lor exporting oot individual textures.

Properties

Duplicate

Rename

R~ove from Level

Cull Unused Textures

load Entire Package

Same as Texture Properties buttol1 d~lrbed In Table A,24.

Duplicates the selected lexture to another teXlure and group, and

under the name you specify.

Allows you to rename a selected texture,

Removes a selected telcture from a level.

lntended 10 remove textures from the list that are not cuaently in

your level. AI the time of this writlng, however, this feature IS not

completely functional.

Same as DuHon described in Table A.24.
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TABLE A.25 Continued

Edit Menu

Detail Hack

Replace Textures

Prev and Next Group

Delete

View Menu

OoCkeo (Toggle)

Zooms

Tools Menu

Compress

Filters Menu

Replaces U'le texture's mipmap Wilh one that gradually lades OLlt 10

gray.

Allows you to find certain textures wil./lln your level. and replace lhem

with any other texture. Essentially, it wot1<s just like the find and

replace commands found ill mosl word ptllCessing p((~grams.

Allows you to son: through lhe gcoups ot texlures within your

selected package.

Removes selected texture.

See Toggle Dock Status In Table A.24.

The other options within this menu offer various levels 01 sile and

detail for which to view the textures in lhe btowser.

Offers three different compression modes. These will be covered in

more depth In Chapter 8.

ThiS menu includes a variety of filters for including or excluding several different objects In the

texture browser window. The filters inolude the following:

Textures

Modifiers

Combiners

Final Blends

Show All

Show None

"In Use" Filter

ThiS menu offefS several vISibility filters for the In Use Lab 01 the o{owser:

Actors

SpriteS

Brushes

Static Meshes

Sf\OwA11

Show None
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The brow~r aho con\ains three different tabs for accessing celetu res Ihat you have already been

working with. The first tab IS the Full tab. ThIs contains all of the textures available based on the

seuings you have established within the tab. The first drop-down of the Full cab is che Package

menLl. from which you can select any o( the texture packages chat are loaded in to Unreal. Beneath

Ihat is ano(her drop-down (or selecting any groups of Cextu res thac might be within that package.

To the lefl of thaI drop-down are two buttons. The All button will override the Group menu by
allowmg you access to all textures within a package, regardless of their group. The ,,! .. bulton

allo.....s you to see a realtime prev iew of any tC'xtu res tha t are animated.

The next tJb is 'he InUse lab. This allows you 10 see I...hich lexture you co rrcotly have selected. At
fim. that might nol sound vcry handy, bUl when you «)nsider lhat a texture list can be quile

extensive and irregular. it can be very nice nol to have to dig throllgh a massive list of lextures 10

see .....hich one is curren\.

The MRU tab, which stands for Most Recently Used, aUows you to view and sdeCi only the most

recenrly acce~d texlures. This is very useful if you need to st"e which texl ure you appl ied 10 a spe
ci(j( surface a few commands prior.

The Mesh Browser •
The objects displayed in this browser (see FIGU~E A.32) art" known as "vertex meshes" Jl1a arc

caUed such because they are driven by vertex animation. In ocher words. each vertex. can trans~

(orm over time as opposed to being driven by bones as in skC'letaJ meshes.

FIGURE A.32 The Mesh browser.
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These can consist of many things, such as characters, flags, and more. A vertex mesh is a mood.
typically used (or decoration, which is usually animated. Vertex meshes are not used as frequently
as they were in the original Unreal and Unreal Tournament. They have almosl completely been

replaced by static meshes and skeletal meshes.

The Prefab Browser

This brings up the Prefab browser (see FIGURE A.33), which allows you to place prcbuUt G6m·

binations of Actors. A Prefab can consist of just about anything: brushes, mesh~, static meshes,

lights. and so on. For example. you could build a crashed sp.a<:ecraft, complete with particle emit
ters. lights. sound Actors, and so on. save that out as a Prefab. and then caU it into the scene when
ever you happened to need one. Inserting Prefabs causes no eXlr<l overhead. as rhe operation is

internally recorded as j[ you had called in all of the objecis md ividually. So, ill effect. it's nO dil

-{erent than just rebuilding a specific object again. onl y faster. This also means that i (you bring a

prefab into a level, adjusting one of the Actors in that Prefab wiJl have no effecl on the other

Actors within tke Prefab.

Compile Ifllo
Salle Packa~ TeJllOl"ed P'eview

Toggle 0«1< Insell PraJa!>
SlalU$ inlo Love!

Cteale Prelab fcom
SeJecle-d A<;IOJS

FIGURE A.33 The Prefab browser.

TABLE A.26 lists the inlerface bUlfons along rhe ~op of the browseJ, and their respective

functionalittes.
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TABLE A.2E1 Prefab Browser Buttons

A

Toggle Dock Status

Open Package

S2Ne Package

eleate Prefab trom
$elected Actors

Insert Prefab

Into Level

Previous and

Next Group

Compile imo

Texlured Preview

ThiS docks and undocks the browser from Ihe main browser window, If

undockecl, the browser becomes a free-floatIng window that can be

placed anywhere 00 the interlace, and the browser's lab is removed from

the main browser window.

This opens packages of Prefabs thal yoo have created.

This allows you to save a new package of Prefabs, or 10 save changes
you have made to a prefab.

ThiS IS another ooe of those buttons where the name really says It all.

Use thiS to create a new prefab from any number of AC10fS that are

currently selected in your level.

Again. sort of a no-brainer. ThIs !>rings a selected prefab into your level.

These bul\ons allow you to sarI through the groups of Prefabs within

the selected package.

This was noo-functional at the lIme of this wriling.

j

TABL.E 1\.27 lists the menus across the browser's menu bar, and the. commands within theCll' As

before, any command bearing the same name as its corresponding buILan will be skipped.

TABLE A.27

File Menu

Open

Save

Import

Export

Edit Menu

Prefab 8rowser Menus

Opens a package of Prefabs far you to browse.

Allows you to save new packages Q( save any changes you've made to a
specrt7c package,

Allows you to Import from a .13<1 file. which is essentially a text file

containing information for Unreal levels, Actors, or just brushes,

Allows you to expOfI yow current Prefab out to a .t3d file.

Delete Removes the selected Prefab,

Rename Allows you 10 change the name of a selected prefab.

Prev and Ne)(t Group Same as the Pre~ious ana Next Group buttons,

Add to Level same as Inserl Prefab into level button.

Creale from Same as Create Prefab from selected Actors button.

Selections

Compile Into Same as button described in Tab-le 4.26,

lextured Preview
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TABLE A.27 Continued

View Menu-------._------------------------------'-
Docked (Toggle) See Toggre Ooc~ Status in Table A.26.

By default, UnceaJ TOLlwamen( 2004 installs wiTh no Prefabs. Don't let this make you think that

they aren't useful, lh olJgh. Prefabs can be a grea t tool in speedi ng up level co nS{TUC rio n, es pecially
if you're buildIng a level Ihat ha.s many simdar areas. For instance, you could build a Prefab of

meshes. brushes, and Lights for a compUTer workstalion, and inserl that Prefab wherever you hap
pened (0 need another workstalion in <he level.

The Static Mesh Browser

The Stalic Mesh browser (see FIG UREA. 3 4) gives you access to all Jvailable static meshes on

youe computer. rust as with the mesh browser, you mJy view Ihe slatic mesh in the bmwser just

-as you would in a viewport. As with aU browsers, the static mesh selected in this window wiU be

the one placed if you right-dick in your scene and choose Add Slatic Mt'sh,

~ save Pad<age

Toggle Dock Cre&le SIalic ~sh
Stalus from selectlon

Frame
Currenl

Open Insert SloliG
package Mesh \1110 Level

Load Enlire Package

FIGURE A.34 The Static Mesh browser.

TA BLEA. 28 lists the interface bu lions along the top of the browser, and their respective

fu net ionaJ J( ies,
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TABLE A.28 Static Mesh Browser Buttons

A

Toggle Dock Status

Open Package

Save PClckage

load En\!re Package

Create Stallc Mesh

(rom Selection

Insert Static Mesh
into level

Frame Currenl

This docks and undocks the browser (rom the main browser window. If

undecked. the browser becomes a free·floating window that cal) be
OIaced anywhere on the interface, and the browser's tab IS removed

from the main browser window,

This allOws you to open a package of static meshes and browse its

contents.

With thiS button. you can save new packages, or save changes to a
pattJcu1at package.

ThIS loads in lhe test of a package from Which a particular static mesh

ollgln3ted. This IS useful j( you find a static mesh within a level that you

parltcular1y like. and want to see I( there are any more that look similar.

ThiS lakes the selected stalic meshes or SSP brushes and makes them

into a srngle static mesh. However. converting a asp brUSh 111(0 a stalic

mesh will often cause undeSired results, and is not recommended.

ThiS allows you to place the selected static mesh into your level.

ThiS causes Ihe viewport to (rame up On the currently selected statie

mesh.

A!"Iove the toolo3T on toe browser is also a menu bar. TABLE A.29 lists each of the menus and

Their respective commands. As usual, any commands dlready covered in the buttons will not be
covered.

TABLE A.29 Static Mesh Browser Menus

File Menu

Open Same as Open Package bUllon.

Save Same as Salle Package button.

Import Allows you to import a model into the Stalic Mesh browser. You can

import models in either the .ase file format, which originates trom 3ds

max or the ActorX tOT Maya plug·in. It al so accepts Lightwave's .Iwo file
forrr"l8L

Edll Menu

Delete

Rename

load Entire Package

Add To level

Removes the selected stattc mesh from the package.

Renames thE: selected staTic mesh.

Same as btJtton described in Table A.28.

Adds the selected statIC mesh to (he level.
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TABLE A.29 Continued

Edit Menu

Create From Selection

Prev and Next Group

Copy Karma
Properties to
Clipboard

View Menu

Docked (Toggle)

Show Collision

Show Karma
Primitives

Show Karma
Mass Primitives

Auto Frame Selection

Collision Tools Menu

Fit 6-DOP (Box)

Fit lO-DOP

Fit 18·DOP

Fit 26-DOP

Fit Auto·OBB

Import .ASE As
Collision

Same as Create Static Mesh from Selection button.

Allows you to navigate through the available groups inside the package,

Copies the KlnertiaTensor and KCOMOffset properties to the
clipboard, You can then paste this Information into your favorite text
editor, You may want to use this as a starting point to adjust these
properties after placing the object in the level. For more information on
these properties go to Chapter 11,

See Toggle Dock Status in Table A.28.

Toggling this on Will display the collision geometry for the selected static
mesh,

When this is toggled, the Karma primitives for the selected static mesh
will be displayed, For more information on Karma primitives, go to
Chapter 11.

When this is toggled, the Karma Mass primitives for the selected staliS
mesh will be displayed,

When this is on, selecting a static mesh will cause the viewport to auto
matically frame up on the static mesh, Note: This feature is only imple
mented in later versions of Unreal Tournament 2004.

This fits a box around the static mesh to be used as the collision
geometry.

This creates a box with four beveled edges to be used as the collision
geometry. The axis projected from will depend on whether you select X,
Y, or Z.

This creates a box where every edge ;s beveled to better fit around the
static mesh to be used as the collision geometry.

This creates a box where not only every edge, but also every corner, is
beveled to better fit around the static mesh to be used as the collision
geometry. This often works better for static meshes with sharp edges.

This fits a box around the static mesh, If necessary, it will rotate the
box to better fit the mesh, unlike the Fit 6·DOP (Sox) command,

This feature is non·functional.
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lABLE A.29 Continued

--------------------,-----_._----

A

Collision Tools Menu

Fit Karma Primitive

RefreSh Karma

Pnmltives

Clear Kaana
Pllm'Lives

This modifies the Karma primitive. The (cllowing are the available

submenus:

Sphere

Cylinder·X

Cylinder.Y

Cy1lnder·Z

Sphele will HI a sphere around the static mesh (Of a Karma orimilive.
and so on.

This duplicates the colhSlon geometry and uses II as the Karma
pI ~1 tives.

Thrs removes all Karma primitIves.

for information On how to create stalic meshes and impon them inco UnrealEd. go to
#

Chapter 20.

The Animation Browser

The Anlnl3.lion browser (see FIGURE A.35) is by far the most complex browser in lhe editor. It
allows you to preview animated meshes and chllraeter~,a~ wdlllS import skeletal animated char

acler, (rom lhird-pany software packages. and adjust character settings.

l. Toggle Deck. Status
2 Open Animallon f>&ckage
3. Salle Animation Package
4. Load Entire Paekag6
5. Import SI<£:lelal Mesh
6. Imparl Skelt:tal Anlmalion
7. Imparl Addilional An,malion CalOl
8. Link Animation 10 Mesh
9 In10

to View Bounds
, 1. View Bones

FIGUR£ A.3S The Animation browser.

12. View Bones Names
1j. View Reference Pose
14. View Inlluences
15. Toggle Raw OHsel Display
16. View Wlre/rame
17, Copy Mesh Properries
lB. Pasl Mesh Properties
19. Cycle Thlough LOD Mesh Levels
20, Ir1lDO"l a Single LOO Mesn
21 Redigest LOO Levels
22. Forced Synchronous In-Level Animalion

As. with the previous browsers, lhere's 3 menu along the lOp and a toolbar below thaL Undernealh

that are three comb-o boxes: Package, M~sh. and Animation Sel. Package shows you a list of the

currently loaded Jnim~l ion packages. Mesh will show the list o( meshes that are localed inside the
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selected package. The Animation Set list will show all of the animations sets that are avaiJable in

the package,

Below that on Ihe left, there's a sequences list containing all animations for the objecl.ln the mid

dle, there's a perspective viewport that displays lhe skeletal mesh currently selected. And finally.

On the right, you see a properties window that lets you change a series of properties of the cur

renrly selected skeleral mesh.

TABLE A.30 lisls the tooJbar buttons and the functions of each.

TABLE A.30 Animation Browser Buttons

Toggle Dock Status

Open Animation Package

Save An imation Package

Load EntIre Package

Import Skeletal Mesh

Import Skeletal Anima1ion

Import Additional

AnimatIOn data

Link Animation To Mesh

Info

View Bounds

View Bones

View Bone Names

ThiS docks and undocks the browser from the main browser win·

dow. If undocked, the browser becomes a rree-noaling window that
can be placed anywhere on the interlace, and the browser's tab is
removed from the main bfOwser Window,

This allows you to open a package of Skeletal Meshes and browse

its contents.

With this button, you can save new packages. or save changes to
a particular package. ~

ThiS loads in the rest of a I>Clckage from whiCh a 1>3rUcular skeletal

mesh originated. This is useful if you find a skeletal mesh within a
level that you particularly like, and War\t to see if there are any

more that look similar.

This allows you to import a .psk file as a skeletal mesh.

This allows you to import animation from a .psa tile.

ThiS imports animation as well, but all new animation is appended

to the existing ones.

When this bunon is clIcked. the currently selected mesh will be

connected to the current set of animations.

This button will open a window full ot useful information about the

currently selected mesh and its animation. Everything from the

number of faces, vertices. and uvs, to the number of joints is dis

played in this window.

This displays the visibility boundary of the currently selected mesh.
As long as some part of this boundary is within the player's field

of view and isn't completely blocked by an Antiportaf. thiS mesh

will be rendered.

This toggles between three different display modes: bones of the
skeletal mesh along with the mesh,just the bones. or just the

mesh.

ThiS displays the bone names of the skeletal mesh.
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TABLE A.31lisrs the menus across the browser's menu bar, and the commands within them. As

before, any command bearing the same name as its corresponding button will be skipped,

TABLE A.31 Animation Browser Manus

File Menu

Open

Save

Mesh Import

Animation Import

Animation Append

Mesh LOD Import

View Menu

Animation Set Info

Bones

Influences

Bounds

BackFace

Wireframe

RefPose

Raw Offset

BoneNames

Collision

Karma

Sync Level Actors

Refresh

Edit Menu

linkup Anim and Mesh

Unlink Animation
and Mesh

Load Entire Package

Apply

Undo

Copy Karma Properties
To Clipboard

Same as Open Animation Package button.

Same as Salle Animation Package button.

Same as Import Skeletal Mesh button.

Same as Import Skeletal Animation button.

Same as Import Additional Animation data button.

Same as Import a Single LOD Mesh button.

Same as Info button.

Same as View Bones button.

Same as View influences button.

"Same as View bounds button.

This is here for debugging purposes only and is non-functional in the
retail build of Unreal Tournament 2004.

Same as View Wlreframe button.

Same as View Reference Pose button.

Same as Toggle Raw Offset Display button.

Same as View Bone Names button.

This shows the collision geometry of the selected skeletal mesh.

This shows the karma primitives of the selected skeletal mesh.

Same as Forced Synchronous In-Level Animation button.

This refreshes the animation browser and the controls within.

Same as Lin k Animation to Mesh button.

This removes the link between the animation and currently selected
mesh.

Same as Load Entire Package button.

At the time of this writing, this menu item was non-functional.

At the time of this writing, this menu item was non-functional.

This copies the KI nertiaTensor and KCOMOffset properties to
the clipboard. You can then paste this information into your favorite text

editor. For more information on these properties go to Chapter 11.
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Editor Windows

The editor wjndo\..... provide you wirh two very differenl yet extremely use(ull~ols for working
on your kvels. These are the Search for Actors ediLor window and 'he 2D Shape Editor.

Search for Actors

The Search for Actors command
allows you to filld and select a spe
cific Actor in your level. The com

mand initiates a dialog conlaining a
lisl of all the Actors that currenlly
exisl in your level, .and you may tiJ·
Ltc lhat list by entering leXl ;nto ..my

of' he Ihree lext fields on 'he righL of
lhe window. The lisl of Actors wi])

be filtered .as you type. ror ex.ample,

leI's ~JY you Ivant to find ~n AClor FIG UAE A.:I 8 Search fOr Actors.
named DrighLligh'S.lf you jusILype I

lhe firsl IWO lellers inlo Ihe name leXI field, Ihe lisl will aUlomatically shorten to include ACIOr.S

lhal have names starting with "br." In this CdSI'. you would probably get a lisl containing most of
your brushe-s (as their default name tends to be "bru~h~ and 3 number), 3r'ld your BrighrLightS
object would also be listed. If. however, you continued to type t~e nam..: out completely, only
Actors with that name would be listed, ill Ihis case, the desired object. FIGURE A.38 shows rhe
Search (or Actors window.

This rool call also be accessed from
the Edit menu.

The 2D Shape Editor

The 2D Shape Editor (see FIGURE

A. 31) allows you to creale shapes
out oj linear and Bezier curves. It

cannor create highly complex
shapes. but does .lUOW for objeCls
thaI are more inleresting than stan
dard primitives. You can read morC'
information about this editor In

Chapter 4.

0--------/----

FIGURE A ..17 The 20 Shape Editor.
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FI GUR E A.39 Actor ~perties window.

>116 Surf,)(l!!i . -,Surface Properties

ThIs accesses the Surface Properties win
dow, which is used \0 control how textures
are placed 01) surfaces (see FI Q URE A." 0).

From here, you C2n pan your te:..'tures in
the U and V direo ions, as we(J as rotale

them. The followillg seclions show the
options found under each of the (our tabs

(ound in Lhe window: Flags, Pan/Rol/$cak
Alignment, and Scale. Fl Q UDE A.4 0 Surface Properties window.

Flags Tab

The Flags lab provides a series of Boolean options you can activate (or given surfaces. Each of
these is described in TABlE A.32.

TABLE A.32 Surlace Properties Flags

Option Desc/lption

Invisible The surlace Mil not show il'l-game.

Two-Skied The surface can be seen from both sides. though colliSIOns will only occur

()(\ the positive side of the surface.

Special Ut This allows the surface \0 receive lighting from lights \n which the

bSpec i a II it Drope rty is set to Tro e,

Unlit The surface WIll 1'\01 receive light lOf any reason.

Fake Backdrop This w)1I cause lhe surface to show the outside of the level; a vital setting

(or using skyboxes.
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TABLE A.32 Continued

Option Description

MitrOi This C3USes the surfaces 10 be minOled, meanit\g thal lhey ,e-neGI lhelr
envirooment. Keep In mlrod, thaogh, lhat ill a (irst-penon \Hew, your playel

CMloct&' wli n<ll rer.der. fn oalel 10 see \.he effect, you mugl l1I'S{ change

ooe of the reMer\ng seUlrlgs. "kl 00 INs, OJ)en Lh.e UT2Q1l4. inl. n~ u-Mel

lhe S'fSLem f()/~r 01 your Unreal Tournament 2004 tJ)s~l.9llon,go 10 \.he
DJOOrv.03DAenderDevice S.e-cliDtl, aM ~t useStencU-=1rue. You can

also sel lhis Ple>pertv {rom within the game. To do tNs, use Ihe console
commafld preferences, Urlder lhe Rendering CDl.ego.ry, sel 1M

UseStellc.il sel1(~ 10 True.

Po.I1ill This lurns. the sunace In!O a po.riDI. whicl\ is ~(u1 I7\l)stfy WMtI appl~d

10 a s.~ brush (()llhe porpases of 10n4r1g a level.

ThiS /.u{t1S \.he surlace INO on AAllpa.rt.a.I, wNch wiW ocC-ft>& a-nyth.ing lound

on Its. ~ite side,

?an/~otjS~<lleTab

ThLs area provi<le~ you wim a series o( 1000ls (or panning (IT\<lvjng), rolating, and scaling your le.r

lures on iI surface to help yOll alig.n them pm-perly,

The Pa n group CQ-nlalnS butlons for p:lnning, whxh aUow you (0 J1){)ve the teYlure in inuemenl-<;

of 1, 4, 16.. m~ 64 )n eilh-a du U or V direclion_ Clid<ing on<' 0-£ lh< b-utr()n~ will move (he ItX

ture in (hill dlrec riM t~ g1wn nomba o( unilJ _Sh if\.· c1Kking the bUllon ,... iU IT\<lve l~ le':(l ure

In the ~po~ile difecl~n.

The ROUI io.n g/ou P will rotate the leXl u re ei~r 4S or 90 deg.ree.s, ~ well a~ allow you (0 fli p the

lexlore in tilhe r U CIt V.

The Scaling group llllow~ !wo differeot mtt~~ (or sc..ating. The liw i~ a simple melhM lhal is
applied II niforml y10 the entire slld-ace in belh n:-es, ~nd you can ch-o.ose a number (r6m Ihe amp

down box_ The secolld 11110WS you co specify YOll r own vaflle.s for sc..ali ng in each a.ris. T~ Rebl iye

check Dol( aUow~ yOll (0 toggle beIWeen eil hcr absolwe sc..ali ng or rdative. scaling basw on the Ie l(

1UIt"'& previou.s. sole. For el<:lmp-le, if Rd:lt ive i~ checked and yOll en ter .a val~ of 1 into the U and

V tiekls, the lal u re will Mts~ regMdleH of MW il h;u b-een previously saJed.

The Lighl Map ~e<:rion allows yoo 10 conlrol how delailed (he ~haMw& in yoor level wul he.
Rememb.:r Ihal il lower selling will lig.h(C'n your sha&W;\. giving (hem more detail, \'1~rus Iowa

y;rl~ will sone n you r sha&ws. O...ecslurpening yo\! r light maps on larger kl/els c..a n kul \0 sklw
down on ~Of1\e sy~lern.s, ~ lht leX1ure;<; (or rhe light maps get larger.
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Alignment

This section allows you to control how the textures are projected onto each surface. The Default

system simply allows you to control how the textures will tile (repeal) in the U and V directions.

The Planar method will project the texture onto aU selected faces fTom the Same direction. which

can lead to stretching on some surfaces. The Box method wiJl project the texture from six sides,

such as a cube. FinaJly) the Face method will produce a separate projection of the texture on to

each face of the surface.

Stats

The properties avaJable in this tab are non-functional at the time of this writing.
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Symbols

2D clipping brushes, 118-1.22

2D gilds versus 3D grids,

55-56

2D paint applications

Corel Palf1ter, 25

Pho(oshop, 25

20 Snape Editor

3D brushes, creating,

133-135

Creaung a Column (lUlOflal

4.12},137-138

CreatHlg a Level wllh the

20 Shaoe EdItor (tutorial

4.11}.136-137

shap€ componen\5

Bezler segmenls.

131-132

Cerller po\nlS. 129

delal'ls, lJO

Dfigltl, 129

VelliCeS, 129

Index

shape generatiol\,

127·128

shape processes. 133

Revolve, 1.3 4-135

Sheet 134

user in leriaee

meou oal, 128

100lba r, 128

VIewPO/' (s. 128

3D apphColl()(l.'i

3ds max, 22

Maya, 22

cnline IIaillll1g 5Jle s. :2 3

30 br~hes, creatIng via 20

ShaP8 Editor, 133.--135

J D ctlpplng brushes, 122-125

3 D drawmgs. UHlrac.le r mode l

Ing preJ\aratlon stage,

72fr733



3D grids

axes sYSlem

nega\lve c!lTeCllons.

56-57

positIVe dlreChons.

56-57

versus 20 grids, 55-56

3D paint applications

Deeo Char-acle,. 25

Deep Paint 30,25

3D vlewpari, hgnlli\g, 241

3DBV:z::l_com website, 23

3~ max

package (sialic meshes I.
20

trial verSIon dowliloads,

22

B-bll terlures, crealing, 275

A

Actions

camera paths, IOle/pola·

llOti ()OII'\\S. 470--471

Mallnee

Interpola\lon POlnls,

469

managemenl of, 469

Scene Manage,s, color

IfldlCal()(, 472

Sub Acl'MS, 469

propenles, <:173

Sub kloos. clo-oing, .1\ n

AClfons IISI, 5crlple d

seque"ces. 506

latent. 506. 511-514

logIcal Condilions,

519-520

I'\or>-la\er.l, 506--514

random COnditiOll s,

520--S2l

Us \I'\g I( Coru:lil,ons (tUlori

al 14 4), 519-520

Usmg RDfldom Conditions

(tulerial 14.5), 520-521

Actklns lllb (Matinee), 473

acllvatlng

MoverS,31B

Tnggers, 322

Actor Class browser. 874

menus, 875-876

options. 875

Aclol Properlies wIndow

(UrHeaIEd), 54. 849. S9£

ACIOrs

DeCOia/ionUs!, volume

usage. 208- 211

KActor, object (eaCI ion,

402-<104

I(arm::l ccnslralntS. 411

I<BSJoinl. 411·415

KCOf'Ieumit, 415--417

KHtrlge. 41B-J.l23

level5

moving. 65-66

IlQl\otaceable. 51-52

placeable, 51·52

lighling effects, duplicallon

of,81-8-4

moving (Matinee).

.t:94·496

Moving Actors with

Mallflee (Iv(OI'l3! 13.71.

494-496

nO/",-placeable. 51,52

Sp<Hlight. 239-240

Sunlight. 235-236

Iypes

FluidSurlacell\fo.

221·223

fluioSurfaceOsciltalor,

224

addll\g

distance fog 10 auldoor

maps. 5.1.3·534

texlures 10 rooms. 69-71

Adding a Surlace to the Waler

(llllolial 6.6),221·223

Addl(lg a View$heker (1IIIo,\al

9,8),334-3.36

Adding Animation to Ihe Door

(iuloi/el 9.2 l, 31s.320

Adding Final Touches 10 {he

Sleam (lutorl&1 1031. 369

Adding Smoke 10 lhe fire

(lolorlal 10.7), 380-382

Adding Teleport ?ads In

On~lallgl\l (Iulorlal 16.15}.

566

Addlnfi! the Bridge (wlorlal

3.10).96, 98. 100

Addll\g the Control RlXlm

Window (Iulorlal 3.~}. 94-95



How can we make Ihis Index more vsefvP Email us a r il1dexes@samspvNisnJII8·com

Adding the Fillal Tol>d1es \0

l!)e Te lep<>r ter EHeei. (tutorial

10,5),374-377

AddIng TUllets In Onslaughl

(tutorial 16.13),564

Ackling Weapoo Lockers in

Onslsughl (tulorial 16.14),

564-565

addnive brush~, 63

additive level creation, 48

Ad/lISting Ught Map Siles

(tutorial 7.S}, 247-248

AdjustIng PiayerStarts Actor

for eTF (tutOflal 16.4). 550

Al (arlWclal inleUlgence), con

'lolled 001 navigalion,

441-445

aim constraints, 804

A~as_com website, 22

Aligning Images in Pt\oloshop

(tutori4l1 21.1), 728·730

alp~ c~nnels, textures, 270

alpha lesllng In games dellel

OJ)ment., 42·43

ambIent Kghllng, 253·254

exceSSIve, 265

an/rna led light effects, 245

llnil1Hltlon

AcljOSling the COS10m

Character's Propeltles in

Uf\realEd (lulOiIaI

23.19), 836-841

chuacler5

Character Sets,

826-835

cycles, creaul\g,

826-835

Fofflard Kinematics

(FK) , 796-798

Inverse Kinematics

(lK), 7%-803

f'Il()6ellOg 1551Ies.

734-735

pose·l~se.826

rigs, 808·825

classical definition. 783

dynamic slmulatKlf\S, 401

Exporling Custom

Animation into UnrealEd

(tllioria I 23.1B), 835-841

"~ames, playbock rales,

784

keyframe mell'lOO,

785-788

animation corves,

784-786

B.asic Keyframe

Ammallon !tutorIal

23.1),786-788

Usmg the Graph Editor

(tulorial 23.2L

78&792

objects, COOSlramlS,

804-806

packages (.ukx tHe exlet\

slon). 21

reactive melhod

Dnven atlnlXlles, 792

Set Dtrven Key (SDK).

792-795

\imelfnes, scrubbing,

603-604

arms In character modeling 903

Animation blowser, 89<>-891

buttons, 891-892

menus, 8.93-894

An.lmaUan Ultegory. Texture

Prl>j)e7Ijes window, 279-280

Anirrultion menu set (Maya).

596

animalolS, team member

responslbllJUM, 37

AntiporlBls

The AntlpO«Bl Tag (Iutorlal

15.3), 531·532

COOC2l1e objeets, 529

coovex objects. 529

rer.dering optimizalioo

(unclJons, 528·531

Using Antiportals (lvlorial

15.2), 529-531

when to use, 528-529

Appell<l to Polygon 1001

(Maya), 630-632

EnsOIe Planarity option,

632

llml! POInts To OPUM, 632

Operation oplion, 632

Rotation Angle opllOn, 632

SubdMsiOlls Ojltion, 632

rexli.xe optMJn, 63 2

Using the APf}er.d to

Polygon Tool ({ulorial

18.3). 630-632

Applying Boolean Op.erallons

{lutarial1B.S),634--635

arms In charaeter modeling,

744-745

Modeling the Arms (luton·

al 21.10). 744· 745



!lO4 Assault gametype

Assault g.ametype

Creaung lM

De stroyable()oJectM!

(tutOrial 16.19), 575-576

Creating the HoldOtlJecllve

(tutorral 16.18), 573-57-4

Creallllg tne

ProximityObjectlve ({Ulori·

al 16,20). 576

Establisl\ing Player Spawn

F'61nts (WIOllal 16.22),

578

Hoo\{mg It An Up (lutM2l

16,24). 5-8().S82

mao conflglK8tlOfl,

572·S73

cbjective creaho(1.

572·576

objectives

crea(ion of, 572·576

Des troyableOb)eclive.

570,575-576

HoIdObjeClJve.570,

573-574

Oldel 0(. 577

player spawn man

agers. 578-582

player soawn points,

578

ProximltyObjecttve.

570,576

TriggeredQblecttve,

57().S73

player spawn

managers. 578-582

O()jflls. 578

our(lOSe cf game. 569

serul'og

PlayerSpaw<)Managers

(tutorial 16.23). 578-579

Seumg t/'le Objeclrve Order

(Morial 16.21), 577

selling Up an Assault Map

aiId Cfellllng aft

ObJec{Ne (tulOfia(

16171.572·573

sewp process objectives,

569·571

AssaullPaths Actor

bOI l\3V..galJon, 461-464

properties, 463-464

assets

animatloll P<lck8ges. 21

Creating a Simple I<arma

Asset. Pari l (lutorlal

11.8),427-429

Creating a Simple Karma

Asset Pari 0 (tI>\orial

11.9), 429-432

Creating a Simpfe Karma

Assel, ParI 01 (lutorial

11 10). 432-433

creation of [KAT). .Q 27·4:;> 9

gama dellelopmenl,ll'Ile

grll\(on o( elements,

41·42

impOfting (KAT), 429- 433

management of (KAT), 426

map~, is
(lOckages, 17 ·18

lools

3D applications. 22

Bodlo, 25

p.alnl appllC,Hlons, 25

Unreal execulion envi

rCllmMI (UCC), 22

Attribute Editor (Meyal. S02

USing lhe "nrlDOle Edilor

(tI>\of)al 17.5). 602 603

attlihutes In keyframe anIma·

110ft. eurlle Int8 rj)OJa I/OI',

784-785

'ludlo (lie to/mals. 25

a\lolo lool&, 25

AUle>-Cakutate Mass

Proj>erlles dialog 00)( (KAT),

skeletons, 439

Au10LBddel ActOl, 460461

automatlc mappIng (U\ls), 663
•8l1eragJ"g vertices (polygons),

639

axes

2D systems versus 3D

sySlems. 55056

3D system

negatIVe dlJectlons,

5£-57

positive dirccl,ons,

0&57

B

back(aee modeling, 623

bose calwelks. stallc. m&~hes.

clea\lng, 685-702

bS!>e geometry, leve Is, rebuild

Ing PIOC~, 50



bOitecl Lonal o-/Q.Pe/ty. ~3.s

s{lO(~, 2~240

sooliglK 235-236

BeamEmlluI,361

CrealWlg Eleclric BoAs

(lLH(){ial 10.11), ~1·392

FioiSNng rhe Ugnwng

(lulori31 10.12),~~5

prope11Ies , 38:9·3900

bera IElSlll\g In games devel

6j)nlenl, <I.)

evaluarlng (~k,

4,3-44

when rc cease, d4

aevel /661 (Maya).. Cl\Qm!erlrtg

aJ\d Beverlng (/(J(c.rIaI

"La. 11), e.~g

Be2le r c.amera \XlI hs, 48.2--4&9

Bellel 50 eg,nenls. s l'Iape.s, ve

BIIn I:' (2 D Sha~ E.dRQ./).

1.31·132

8in ary Sj)Dc.e Pa,lillorling

(ElSP) bJustle!a

aoowrve, 51

levels, SO

SOOHadrve, S1

BiNl.ry Spou Pa.t litionll\g. se.e
asP

!>leMing p.T()f>ellles (shDders),

l&8

BlockingV()o/ll~ type, 206

proper1\e.s, 212·115

~kAclQ{,1n

I>ekleJd{arma, 212

bBlockZero.fxlefll.Traces,

2.12

Using a BkleklO.g Volome

(lLAc.rial 6.2), 21.1·215

aIue.Stloots p6l ACl Q.I, &i>m l:Hng

Run garneiype, sss
aMP (W\tI~W'5 Bkmllp) (Q.I.

mal,270

Bo.mNng Run gamelype

BfoeSMalSp.ot Ad().l;, SS5

design coosfderollorts,

sse
map~{)ls,

5S4.-SSS

po.rpose. of game, SS4

R~~ AcIOf, SSS

Se\1~ Up A~~

Mal) (tlM>riaJ 16.8).

SSS-SSS

~Wery ~()(, 5S4

bon&i lil i~let6~ 7SS. 7S 7

8<>olean ~/811<l1\S

~irlg Boo.Iea.tl

0p.er<H klns (Wl!>t lal

18.5),634-635

po!ygoos, crearirlg,

634-635

b<lts

ahaek bfe<lS,

SNpl/'ogVoIome type, 206

cU(el\~ I}OiMs, 464-465

doors.

Comple'.c: Bcl·i)o,o(

We/oclion {Iutorial

12.6),4SB

naviga(f().f\ (to.rcog;.,

4.SS-4SB

Simplf Door Selup

WI/\) a Door ACiOf

(hJic.rial 12.5),

457-4SB

S~ 1)0.()( Sel uo
'MIhool Door A.ctiY

(lLJle.tial 12,4),

4505-457

i<Jmj) s~

)umping OOI<l ;, $Ieej)

Ledge (luIoOal 12.2), ,

451·453

Trans.louling' Thlwgh .3

Small~ (lllloOo(

12,3). 454-455

Jum\)CeSL kle.t pl()per,

lieS. 451

.lumpSpol ActCI picpef'

ties, 451

lackie,s

AtAcLMde' Acl&,

460-4&1

dimbirlg, 46().4&1

lifu

Cte;uillg a 8<>\

Naviga~e llH (llJM{13/

12,7). 4~60

NMgaLklon \fvO\.JCl,

4SB..460
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navlgali()(l, 441-442 browsers (UnrealE.d), 848 Sheel8uild8l, 857 -BS8

easlc PalhNodes (Iutor· Aclor Class, 874 SplralSta ir Builder, 855-856

ia( 12.1), 445-447 men\Js, 87s.8 76 Terra\n8\1(lder, 857

l)ath ~or COOmg. 44.3 opllonS, 875 TetlaneoronBullcler.

PalhNode Ac\Of, Aflimalion. 890-891 85~MO

442-447 buttons, 89Hl92 VolumelncBwlder, 859

\)Olnts.442 menus. 893·894 brushes

pOlnts. placing, 447 Group, 876 odditive,63

navlga\lon problems, lrou- buttons, 877 81Mry Space Paninonmg
blshooting, 448-45()

menus, 877·878
(BSP)

palhs
Mesh,884-8B5 add'>live, 51

odvancecl Mvlgal\oo,
Music, 878 eHiclenl use of.

461-464 105-106
Pre(ah.885

jump spots, 4S0-d55 SUOlraCltve, Sl
hut1<:>t\S, 8850886

USing AssaultPaths BUIlder
(t\Jtonal 12.8), mfflUS, 88i>887

(unc{1()() of. 62-6.3
462-464 Sound. 879

Dutlons.880
shape seleetlOll, 62

sniping \)Oints. 464-465
clipping maker s. 118-125

vehicle nevigatKlIl. 466 menus. 880-881
creatmg (freehand Polygon

bottomless pits SialIC Mesh, 887
DrawIng 100)), 125-127

(alling. velOCity cootre/s tlunons, 887·888
expol1JClg, 145

(tu\O(lal 6.4), 217·21 B ffieoos.888-890
Importing, 145

XfaU\ngVolurne type, 207 TeX1\Jre, 6~71. 881
~evels. positioning. 55-66

damage properhes. buhons, 881-.982
(\On·solld. ,lllllbule s of,

226 menvs, 882-884 143·144
boonclng ball anlmellon WI<> user intet1ace (UI), 53 order. 64

rials
Br~h Clipping ares (toolboX:),

OiVOlS,6J
8aslc Keyframe Anlrnallcn 853

(23.1). 7Sf>. 788 oolygons
8 rllSh ~r\mltl ...es area {tool-

Using Ihe G,aph Editor box),8.53
edges, 115

(23.2}. 788-792 Cone Brush CreatIon.
(ace dragging, 118

~x rrn>dellng, 624 858-859 fates, 115

\:lIldges CubeBullder. 853-854 vertex edltvlg. 116

Creallng 8 Oy/)3fniC Bridge CubeStallBuikler, a54-855 velllCes. 115

(\UlOllall1.4). 41~21
Cyliflder8UIld~r,858 saVH~, 144

stallC meshes. OOdlflg. l \l'IearSlair8uilde r, seml-sohd, atlflootes of.

9&100 85&-857 142·143
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cameras 907
----- --- - --- .--------

clipping planes, 683

(ade etlects, creating,

493-494

FadIng In and OUt (ILIlorial

13.6),493·494

Moving Actols wilh

Matinee (totorial 13.7).

494-496

orientation, wntroillng

(Malinee), 491·492

linear, 482-488

Camera Pr(>perUes wind-ow

(UrveaIEd), S4

Camera Shake Sub Action,

490

cameras

camera cuts, creating

(Matinee), 488-489

Camera Effect Sub Aclkln,

490

camera focus, Perspective

viewport (Maya), 595

Camara Path Enhancement

(WloriaI13.3), 482-488

camera paths

Belier, 482-488

Camera Path

Ennancement (tutonal

133). 4B2-488

controlling (Matinee!.

482·488

creatmg (MatInee!.

470-471

face drag options, 852

(reehand polygon drawing

options, 852

Malinee optkms, 852

rrIO\Iement opt IMS, 851

.errain edIting OpllooS,

852

lexture pan oplions, 8S1

\exlure rotate optIons, BS2

vertex ediling 00"11005,851

8uild menu (maIn meN! bar),

847

Build Op.flons dialog 00'1:

(UnreaIEd), 55

Bullde r Bru!m

De-lntersect tool modlfiC2,

lions. 1i3-115

function of. 62-63

Intersect 1001 modifica

tions, 111-112

shape selection, 62

BuildIng area (toolbar) c0m

mands, B49-850

c

Cakewal1< aud\{) tool, 25

Camera and Utilities area

(tooloox)

actor roratiOfl optJons, 851

actor scaling options, 851

o<ush clippmg optlDnS,

852

rooms

eX~lting, 145

impu1trlg, 145

Mn-sl)jid, 143·144

saving, 144

sem~solkl, 142·143

solKl, 139, 141

polyg<lI1S

IIr'.es (r.ormalsl.

109-HO

negallve side, 107

origin, 1OB-109

pas/live skle. 107

trees, creating,

107·110

crossbeams, 105-106

pillars, 105-1.06

(henry, 107·109

solid

creating BSP culs,

139-141

pmperhes of, 139

SUblractive, 63

Zone POllals

dimensIOns, 527

Ievel/)J:\tim\2f1Lioo,

524·525

Sheet8vil<jer dialog

Oox,525

surface lextures, 525

lMe coIorahon, 526

SSP (Binary SpaeQ

ParliHoningl,105

blushes

effidenl use of,

105·106
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pauses

ueililng (Mallroee\.

4aB-4B9

P3\JsiIlg and Cufl~

(I ul.Ori3/ 1-1.4),

4.B&-489

Coj)./lJ.Ie Ihe FlDg g3me!ype

Adjostioig P1ilyerSla.rI S

klCYS 101 CH (I1.>1(){ial

16.4), S50

Creating;} CTf Map (11.>1 OIS'

a/16.3), 5-49

Cleal'on. S4S

design coos\defa110M,

SS1

map com~~hy, 548

piayel Clea.tJl).(\, SSO

PtJipose of game. 548

Se\1ir.g Up (or VIeW

Sueens to! CTF (loloosl

16.5),550-551

view sueeM. S5c.sS1

UJnva8<.s

~ the BtMeS ~ me
AAchol (hJlOOa{ 20.6),

694-6906

A~g the P1acehokler

Telr:lUfes LO 1M

51 roigJll.Ca Iwalk (lulOfial

20.12). 704.-105

Applying lex\JJres ro Stalk

Meshes (lU\OI\a{ 20.22),

121-723

base Iype, crea{ing,

685.-102

~ lhe Hand/asls.

(Iu/Olia,/ 20.'1), 600-6S2

BoOlding 1M Supporr

A~ (11.>1 01wi La.5).

692-894

coUisiorl models. CfeOong,

118-7 La

Crealillg ;} CoIision Model

(0( lhe $fIdigNCatwaff<

(lol().{lal 20. ~O). 118- 720

C/ealing lhe ft)or·Way

~Iels~(ioo (Il){ooal

20.19),71:1

Crealing lhe F>l.a~

TexllJf8S (I lJ(oria I 20.10).

101·102

Crei>l.lng lhe Rae

SIJPi)Ol'Ls, Pari I (IolOfiaI

20.7).697-698

Cteal/rog the R311

SVj)pO! IS. Pall • ((I)\or\a!

20.8).6M-100

Cieaflng lhe RameCa\WOK(

(lIROl/al 20.14). 7Ob-7M

Crealing lhe

SI raighlCatwatl< (WiotiaJ

20.11),703

CreOiing fhe l-WersectiOl'l

(lulOtial 20.18). 714--716

b-po.r'l IIlg SfalIG Meshes

uom Maya II)l.O l.JlvealEd

(WIO/Ia/ 20.21), no 721

e'tJ}O{tJrtg 10 On/ealE:d,

720-721

f<}ul-way inlersec\iofI Iyp.e,

Clealing', 717

ModeBi'\g the 90-0egree

Tum.. PorI I (lolooal

20.151. 708-710

Modelsl'g (he OO-Qe.greE'

lum, Pan II (Iu1().rlal

20.18). 71t>-713

Modeling !.he 9O-Degree

bn. Pan IIr (luJOlial

20.1 7). ?1~ 714

Modeling me floo.t of lhe

C<l\WOft< (lul0ri.9l 20.3).

OBS-M9

Prepanog the

SVaig~CMWilll<({)(

Expa.n (1ul.ortDI 20.1~),

700

ramp lype, crullng,

7Ob-708

stll'>l~ lype. Cleallrlg,

70.1·706

T-WerseClloll I~. Cleal·

1fIt, 714-716

10m rype. Clealing,

708-714

Using CooSI..rOCOoo HLsIOlY

10 rr.t \.he~16 (lula

naJ La,S). 700 701

uf\lel pol(l~ shope CO/1'\j>()

fle,fIl (~O Sha~ EcUI or), 129

Cham/al Veller 1001 (Maya).,

6~9

Chamlerirlg 2>Nl Beve(1Og

(L()[0ri2l 1B.1..1), 648-649

chamfering veri iu..s , M~4a

Cf\8Mal Box (MHy1l)., S9S

~ slkl.ers, S~OO

Using Cflai'lnef SWdefs

(Il.JWial 17 ..1), S9S-600



Cha,a ete, Sels 909
---------------------

chaMel S-Ilders (Maye), Rolate PiaN! Chain Loading Image PIar)eS

599-600 $olver, BO1-802 in Maya (tllt()(lal

Ch.3nne~ paletle (Photoshop), SH-.gJe Cl>a In Solver. 21.4),732·733

274 800-801 Lowering the Image

chsracter aninl Btion pQSe-<o-pose, 826 Plane Brigtttness

Adjllsllng the Cllstom ngs.808·825
(tulorial 21.2). 731

Character's Properties in Creating the SpUle ana scanning, 728-730

UnrealEd (lulonal Finishing the Rig legs, MOdeling (he Legs

23.191.836·841 (tulorial 23.131. (tutorial 21.91, 741-744

Character sets, 826-835 822·825 overView, 725-726

Preparing f()( Animation The Arms (Iutotial prelXlratioos

«(ulonal 23,14), 23.12). 816-822 corw:ept arL 726
827-328 The legs (tu/orial Image planes, 726-73-3

cycles, 825-82£ 23_11}.808-81£ process overview, 734
Creating a Run Cycle charader modeling ske(eloos

«(U\()(la I 23.151. arum3lion ISSUes, Importing, 767-7M
828-B31 734-735 ~

Creating an )dle Cycle
sl((onmg. 7B8-772

arms, Wlooehng the Arms
(WtMal 23.16), (tU\()(ia\ 21,10). 744-745

torsos, 735-741

832-833 (eet. Modeling the Feet
Beginning the Torso

Creating Clips to( lhe (ll>IO(ial 21.11), 745-747
(tutooal 21.5),

AnjMation Cycle (lull>- 735-737
hands, ModelIng the Hand

lial 23.17), 833-B35 (lut()(lal 21.12\, 748
C<lmpletlog Ihe Torso

Forward K\l1em31\cS (FK),
(lulonal 21.8),

heads, Modeling the Head 740-741796 (111(01131 21-13). 749--75()
AnImating JOints wlth

Re(ming 1he T()(so
image p(anes (tutonal 21- 7).FK (Morlal 23.4),

79&798
Afi€fI\ng Images in 739--740

Pnotoshop (tutorial RoogNr>g \n t))e Tors 0Inverse KII)8matlcs (IK), 21.1), 728-730
796 (tutorIal 21.6),

C()nflguung, 728-730 737-738
AOlrnaLJng jojfllS wi\h

Creatmg a PTo~t 10
II< (tlltorlal 23.5),

Charatle, Sets

798-799
Maya (lotorial 21.3),

char;:~cler animcllon.
731·732 826-B35

II< Spline Solver. 803
darXening, 731 PreparIng fOf Animatloo
importmg, 731-732 (tulorial 23,14), 827-828

Ioadlflg, 732· 733
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charactar.!l-----

characters

animation proper\les. set·

ling prior to gameplay.

772-777

Creating the Character's

Portrait (tutorial 22.10l.

777-779

exporting. 771-772

Exporting the ChaiOcter

(tUl.orial 22.8), 771-772

gpmeplay preparations.

772-775, 777

GeTtlllg the Character

Ready (or Gameplay

(tutonal 22.9). 772-777

lIl-game testing, 779-781

mesh orooertles. setting

pflor to gameplay,

772·777

nodes

composition of (Maya).

S86-~8

construction tl'StOI)'

(Mlly.!l). S,QQ..S92

oortl.8ib. cre.8ting.

777·77Q

~aiCloIiS. configurinf

(KAT). <l33-d3~

SoC.8le &4stf\etics. 59·60

Se1tir'li up a Ch,a(J!lcter in

!<AT (tLJl.oria l 11..11).

<133-.439

sl<eletOl1s

function o( 754

joint influence.

76).766

joints. 754-761

rotBtiO-f\ paiN s. 7 S-4

skinnin€, 754, 761· 763

skinf1ing. 7SS

weight acjuSlment5.,

769-770

UPL files

creating, 779-781

propenies, 781

UV layouts. 672-673-

Laying Out 1M lNs of a

Character's ShIn

(\utorl2>l 1~. 7),

673-676

leg layout examok.

677-678

shin leyoII\ ex"m(lIe.

873-676

USIII! a Cyli Mflcal Map

lor Si UV Laye-ul (liJlOI'

lal ~9.B>. 677-678

cln,matles. Su m.Elc-h11\lm1i

clamPed tangent l(ll<~me

anln'tltIOJ\.7SS

cla~s_ tomllyOCS. 542·54.3

cl.eenlng up polyiofl ~ at\er

madltllnll_ 64Q.q402

CleenuD cOMMand (McYll\

.llenera1oj)I;()l"l$

COf\SlrVClion HiSlory

optloo. 6-10

Opereflan 1>l)-tIOIl. 640

S~lecl All POlygonal

Objects option. 640

ie ss~ltale Geo.me\1'(

~I()(IS

4-Sided Foc.es OphOO,

641

c.oncave Foc.es ~ioo,

641

Faces wrlh Kales
CJi)oI}on,641

Faces Wllh Mole Tharl

4-S~s ()pIioo, 641

NOl1~Ul2>l Faus

oplioo, 641

clIef'\l-serve, co-m~Lng, nej.

wo,Ke.d g'om<!p.lay (Unreal

EngI.nl!l), 14

cllmblilg ac:tloM,

lffd<lerVulu ITI e type:. 2<>5

cr~al~ (IUtollal 6.8),

226-229

cl~p((Jg p-Ia ne$., UJ

dorJn~ SUD ActlollL 473

c;~el"S. leern mtmt>el tespon-

,lbMlllu. 37

oolI15io-n alea5.

BlocklnlC'l0kJme l'fP't. 206.
212·2j.,S

oBlockActors P/operty.

212

bBlockKarm6 ~OP<2rTy.

212

be!ockZe'oE~I<!nlsTla~s

propertY. 212

colllsioll ~omelry. skelelO/\5

(K.An.438

c;l>IlI.slon ptlmilives, ~armll

physics eng\lle. 41Q-411
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Constru ~lve s.c.tld GbO TMtIY 0 pe rat! oo..!I Ii lea 91 f

CoII~o~He19111 i>'o.p;erty,

e:su>blshlng 5COle 01 levels,

sa
CoIlI!.IOIIRadivs r>1~'rt,

enab'~h1n,g ~Ie 01 level';;,

58

Cllllf.kl.ns

Cre&llrog a C6HisiM Model

(0./ U\e Slf9I~fCatw3&

(llJlOOal 20.20). 718- 720

rllew()(ks eff&ts,~

meflUrlg', .sss.-3a6
~ Salenu dJalog boy

(PMlQ!,Mp), )7.)

~ (f'lb!kS In leualn"

197·199

Co-kl.I ~H~, (male-lUlls).

~88-289

Co-kl.I Ta bIe &1I!<)g {)or

(Pha:lM~). 27S

eo~~ lo.nes, 525

colu.nvl.5., cre al~t (20 Sh ape

£D(lo.t). 137·138

Coml:>Ine oomm.a.nd (Maya),

632·6.)3

~nel MMltleJ, mDlerl2>l~

II"IlelwlOon r>-!6I')8n1M,

29.4-296

~f\lng objtcls In polygon

al m«lellng, 632-63.3

«>rnp.II~g ~vels, 48

oompIeled ~lIe~ appelllanu

0(,47

Componuol. ffi<)($e (Maya),

otliiU'l ma1lIlW'la1I6n,

6~9

CQ./llponenLS (Un1e81 f"~e)

game launch s.tage, 16-17

gameplay slage, 16-17

groj)hk'i engine

drow calculations, 12

level speeds, 13

/e.OOerir>g ~,12

lfitfial\2A11on S(lige, 1/H7

jl'l()O( maflageI, 14

ilWeracllon OVefViE!!N, 1S-1 7

netw()(1c In traslrocl ute, 14

physics UlgVle, 1.3

SOOI'Ilf en~, 13

UrveilJ&i~, 14

conca.te otl~Cl.S, Am \oo.rtel

lequiJernents, S~

Co.IIGe p.l a II, chal 3Cl el mOode I

il\t, dlawlngs 01. n5
Cl'>ncep.l alllsl"", learn membel

le:s~~l'llei,3S

Cone BI=h Cleallo-n (Blush

f'11ml(l"t'S a1ea), a.s.s..859

C<>fls.ol e a.a I (Urveal EO). 53,

en
Q.rag Glid, 873

{)rnwScale30, 874

lOCk Sele.clk)ns, 873

Log o,.MOOw, B7j

Mal(mle V~w~l,874

Ro\atioo Grid, 873

teXT field, a73

OC)fIs.DoI~ earn mao<I~ 001 p.n»
lerns., Ir6lJbles.~lng,

U~O

e<)nsl/B~15

App.Iying COfIS I/a.irIIs 10

Objecl S (llJ(ortDI 23,9),

804--a06

Kuma OOiecls, 411

Ke~oInl, 411-415

KCanelimtl, 41S-417

KlWIge. 418-423

~ aoirnali().n, 804-806

aim, B04

0I1el'.l,804

parMl.,804

~,aC4

pole ~()C, B04

s.c.aIe, 804

c.o.n..sll\.u:llo.n hlslQ./Y (nOodei)

bel'oefi LS (Maya), 590-592

cre-a(j~ (~), S88-S90

Otawtlacks (Mayli).

500.S92

C6nsl1\Iclkle~ C,e.omtllY

(CSG) O-pelallou alea (1001

box), SCh5l., eM

Add AnI\-PO{ LAls CNl\ffii)OO,

a~

Add commal\d, 660

Add Mllvu Ell ust> com

matld,B6.4

A6d Speciol 8fUs.h corn
maM,861-&2

Prefabs. ~Ii().n, 863

Solidify ~iOn, a6.3



Sl2 Coostru-ctlve Solid Geometry (CSG) Opera-tlons area

Add StallC Mesn com

marx!. 864

Add Volume command,

B64

Oelnlersec( command,

a61

Intersect commaoo. 861

SliOtJact commalid. 860

conlrast levels In Ilgnting. 255

COI1(JDI bar (vlewport€>l. 8B8

asp Cuts. B6S

COn(e'i( menu. 870

Aclors submenu, 872

MDde submenu. 871

View submenu, a71

Wir.dow submenu, B72

Oept/'l Comple'illy, BfO

Display MOOe. 868

Oynamll: Llgl1lmg, 869

LIg)'\\ing Ooly, 869

Locl<ed 10 Selecled Actor,

870

Pers p.eclive, B69

Realtime PreView, 868

Show Large Veni~s. B70

Texlure Usage. 869

TelCl\JreCl.869

Zone/Porlal. 870

£:o"Irol devlte-s. Input manag

er fUMeal Englne). 14

conlrol room

bridges. Bdding, 9&100

stalic meshes

adding, 94-100

decorallve Ireatments,

101-103

control room passageways,

/\angars. Cleating, 85-93

can tlolled bots (A I)

Basic PainNodes (tutorial

12. i), 445-447

OOOIS. 455-458

Jumping onto a Steep

Ledge (tutorial 12.2\,

451-453

ledders. 450-461

lifts, 458-460

Mv/galion.441-442

path color coding. 443

PaihNode Actor,

442-447

points, 442

points. placing. 447

j)(oolems, troubleshoot·

Ing.448-450

palhs. ,ump SpolS.

450-455

Transi(>cat,ng Through a

Small Hole (tulorial

12.3). 454-455

vehicle nCll/igatiofl, 466

coniroillng camelS pflths

fMa!inee), 482-488

Coni/oiling the MalerialSwllcll

(Wtorial 9.1.2).3.41·344

CoMrolling Yotil AnirnlltlOf\

lUlollal (9.3), 320-321

coJ)vex Objects, AMIpor la I

re~ui rem eMS. 529

cooldloa Ie syste m (UV), 6S7

UntealEd versus Maya,
586

Co,el P1;i"Ier, 21) palnler

appl\~t1on, 2S

COIDnas (lIgttl/ngl. 25fr257

Create Polygon 1001 (Maya},

62U25, 62S-f>30

Ensure Planarily option.

630

I<eep Faces logether

option, 625-626

\(eep New Fa~s Planar

opticn. 625-626

Umil Points To opnon, 630

OperaliQfl Opllon. 630

SlIbdil/lSIOnS OC\lon, 630

Te\(\Ure OOllon. 630

Usirtg the Creale Polygon
#

Tool (Monal 18.2).

628-630

cresting

camera cuts (Ma\lfleel.

488-489

camera pauses IMatiflee).

4BB-489

levels. S7

addlllve method, 48

oruSh tyoes. 62-63

scale issues, 58-62

subtraclive methoO.

4.8-49

lights

3D IIle""90n. 241

duplication melhod.

241

L ~ey, 241



cutseenes 9~J------_.-_." "

rooms. 57 Creating NOI'l-SqLlBre Cubemaps (tlJblc en'Jiron~nt

aruS/) ()(der, 64 Projectors (tutorial 7.14), ~ps), 271

brush pivot. 63 262-264 Creating the CllOemap

brush types, 62-63 Creating the Passageway ThaI (tl)\()(lal 8. ill, 303

1I3vigati&. coni rot
Co-nnects Hangar to Ule refle-ctive surfaces, creal·

f>M:>S
Cootrol Room (tutorial 3.8), ing.29&303
85-93 Resiling Screensholsscale Issues, 58-62

Creating Ragdolls {tutorial (llllonal 8.10). 301-302
seqller)Ces (Matir'lee),

11.7). 423-425
474-480 Taking \he CI/bemap

Creating and Setting Up Your Screel'lSh<lts (lulO(la I
C, ea ling Alte rnative Link Emtlte-t (tlltorial iO.i), B.9), 298.-300

SelUpS lor OnS-l.aught {tutori· 362-365
al 16.11), %1.-562 lextores, DDS 10(1nal, 271

Creating a Simple I(atma cubesCreating Bhier Segments Actor (lu torlal i1,l),
(lulorlal 4.B). 1..31-132

403-404
00)( modeling, 624

Creating asp eLl1s with Solid Creetfng a Simple PTojaetor
Examining UV Layou(s

Sr ushes (lulMal 4.13). (lutO/lal 7.13}, 261-262
(1010rial 19.1). 05&659

139-141 UV layolJl
~

Creating the Steam (tutorial
Cleating <I CofIveyor Se(t with 10.2),365-388 overlapping, 671-672

Barre Is (t utorral 10.10).
Creilling a TelepOIter E.Hecl slatlc mesh creallon.

387-388 665--66B(lulorlal 10.4),309-373
CreatJl\g a Cn: Map (tulorial

Crelll~g iJ Trigg'erLigh\ (tUlo-ri- Vlewl1lg, 65-B·659
16.3),549

al 7.i2}, 2S7-~SO CubeStair8uilder (arush
Creating Electric Solts (tutorial

Crealing Water (tlltolial 6.5), PTimiuves ar6a). 8-S4-8SS

1.0.11). 391.·392
220-221 Curves diaklg MX

Creating Fire (lutorlal 10.B),
Creating a Window (tutorial (Pholosnop). 272

377-380
3.8), 7~ CuSlom Polygon Display

Cleatlng Fireworks tutorial
Creallng 8 Win<Sowpane (tuIOl'

Op-tions dialog OO;{. 627
(10.B),383-385

lal 4.9), 134 Cut Faces tO<>l (Maya), Using
Creatlng Letterboxes (tulorial

uossbeams for rooms, con- tt\e Cui Faces Tool (tutorial
13,10),499-500

strUtting. 105-106 18.1.2), &49-050

Creall ng the Link Designer
Cubeaulkler (Blush PrimItives cui mooeling, 623

Picture fOi Your Level (tutori-
area),85J-854 cutscenes. 468

at 1.6.1&). SSB-56£l
e\lo'ution of, 468-469subvacllve brl/st\ seltirlgs.

Creahng MonKor So/eens for
68 leXl, adding (Mallnee).

Double Domlnalkln (tulorlal
496--499

16.7),553

l10w can we make Illis Index more Llse/u/? Email LlSillindexes@sams!>ublishing.com



'} (4 ~llbc4tn6s- --,. -_.- --.- . _. --_.-,-_.-------- --------- - -------------.

Ie-'l Ciearlort, Pall l (1010fi'

a.I 1-3.8). 4%-497

Iert Cie<llfO{\, Parr'll (11Jl./)/

i<ll 13.9), 497-4~

cVI{In: IUJe:!.. 6-0\ So&SO

cycles in chD,oclel al\lmall6n,

1U5-.826

Cre3UI'lg <I Run Cycle (lIJlO

mIl 23,1.S). B2B-831

Ciealiog an k*e Cycle

(ILR/)/iol 23.16), S32--833

Crea I109 Clips (f}( lhe

AIlimalKln Cycles (lVIon

a( 23.17), &llA3S

Cyl)nder13l>11&r (e,us h

PTlmll fve:s illu), e.s.a
eylh'odtkal ffibpping

Using a Cy/iMncal MaO (Of

a UV loyoot «(lXOflaJ

19.8), 6 77-{5 78

UVs, f>&4

D

dancenlng image p.Ii1ne-L Chill'

ade' ~Ilng, 731

DOS (Dolleer Claw Sllrlac.e) I~·

ma{. ml(lmaj)S. 271

()e.ll'\te~ lool /UNe&IEd)

Builder Brush rTW:lodi (IW '

Iion. li.3-i.1S

usirlg the De-~els.ecl Tool

(4.2),1H-liS

U&lh s.eQUence.s k), Ragd<>l

c.nil'Ule,s., Xarma physics

englne, 401, 42.3

[).oaUlmaIcl1 ,gameIY~

~ Weapons aro.d

~k~ (lul.Ofial 16.1),

544-546

aes.1grl consl<lerol ions,

547,548

(r&g kmits. 54-3

~allhChargel" class

(rl' icl<lJp8.ase). 54 4-

mop ueall()fl. 543

pickups

adding, 54 4-546

»'k{(uoaase classes,
544-545

~po~ of game. 5-43

Shie~gel c.lass

(~\(up8ase). S44

Su~aQ~gerciass

(xP~\«()-()8ese).544

SUj)erShle"'Cha,tgel class
('.(?iclN~se). 54S

UCilmageCha,tge, class

('(PjcI<up8ase). S.4S

l..l'iiflg rhe W\Jdc.ard Sase

(IU/orial 16.2),54 7

~s,~.54~547

'w\Idc.aId Base c.loss

('tPICK0j)8ase\. 5.45-547

xWea.p006ase class

(~op&se),545

cIelwggll'lg

hoi. naYigbl~ problems

C6T\so!e commands,

4<19-450

MOj) ct.ecl< di2l6g 00-'.

448-4<19

reDdelll'fg speeds.

535-S39

Q.e=Uyers

~ Del:onuions

TIvough Decol..2.ye.'s

(IOfOO.al 5.9), 194--197

c.arving' eases lNo TelTaln

(uxori.al 5.11), 2CJO. LO 1

j}(~rlies, 201·L(}4

(erroins. 00je.e.l ~ace I7IeIW .

151. 192-204 •

Usi'.g~~ps f<)

Adjost Deootayel CAl.Iors

(WIO/iaIS.10),197·1sg

~r.aOonUS1 AcI~, vOolume

lJS<l/!:e.. 208- 211

De-e9 ChaJaCleJ, 2S

Deep P'airll 30. ~S

l)efDvM Phys ic:~.vo.lume ruope'.

tV, ~06

defense ~l:S

boI.s, 4.0 4.-465

Creating Deiense Poinls

(LUlOlial 12.9), 46S

designing

~ Roo gamelype,

~

CapWre me Flag g.8/l\e

('y't)e, 551

DeaLhmaI£1l game.rype,

5.47-548



----------, -- --------- ----- . Do~bJe Domlnatl~n_~~ 9lS

DoL6le D.orNtlalion, 554 cIiIwl<}/ODl Ig.tlng, 235 Com.pIu BOI--Doot

OnSl1lughl game~, s~X', S lJf\ligf){ ue11I ion , wern.ction (ll.>lclla)

568--569 237·239 12,0), 45-8

deLDIIs s~s,23~240 cre-.al.llIg (M<w.ers),

piopertie:s (shade/s), LB7 &uol\gN, ns-236 318-.322

stlzpes ~l( crea\\()(l. erlCloaci'omer\\ ().kNel s).

addillg (2-0 Shape 2.36--237
321-322

fdtlUj. HO D-/sc.ree.Loom we bs1Ie, 12 keys

moving (:>D SM pe dkplsy f'rI<)d~ (Perspullve posi(iooal valUes,

£diIOl1, HO W~Il)
319320

develo1)rnenl (game<;,) Dep/il COffiI)Ie'iily. debug- I()./D~ values,

pi~plOWc\.i(){I slOge, 30 ging reMeling speeds, 319-320

ideas rerlnCme~,
S36 onsveen \e'l:l rness.age

3-9-40 Zo.oe/PorLallliew, S3.5 ueaiJrlg

o-Laye(s ~rspedive. O~playlng SurlaDe Nrmrrals ~ (Mess.age11 igger).

32·3.4 Maya (lul6llal iB.l)., 322-.325

sales pMCh, 34
627-618 E..srz,blishlng a

stkdole uellilon, .cIO cJlsl.allu ~
Mes~gelri{>£e r (1ul.0f-

slo.ries. 3032 od<J<ng, S3J.-SS4
raj 9.4).322-325

leW'! (Offl\Ouoo. 35-39
vs.eS, 532

placing (MovelS). 318--.319

p.rododioo S lage
(}()o{)( A.clo-r

~ Door $elop 'WWh £l

Door Aelor (11.)l {)(Ial

assel lrIlegraHoo, COMplex Bol'Door 12.50). 457-45-8

41-42
JMeracl ion (11.)\ C>I ial

12.6),45-8
~ple Door Se Iuo

sc~ dela'r.' . .cl1 ~ Door AClOI (llJLOI-

~duIe maiN.enanu,
prope-rlies. 45&-457 Ioi 12,4), 4S5-457

41 S~ Door selup Men a
Dou~ Qo.mInatloll ga.rnelyp.e

release Sloge. 44
Door AcICf (I(xOIia)

12.5). 457-4sa
Cre~ a Double

testing sLOge DomlIlDiiOO Map (Lu{OI~

~s

a\()Nl resting, 42-43 16.6),552-553

bela les ling. 43- 4..
aflimatioo cof\Irols. Cleallog MonIIOI ScIeens

319-321
fd edbade', 4" 2

({)( Double Do<n.iI\&I ja,o

behLNiors. coout:llling (Iu(o.ricJ 16. f), SS3
O~e map, sha6e~ ~r(lng, (Movers). 320-321

2.8J.28-'
deSign consideta\.i6ns.

Dllecl a,»w SurfaGe Io.r mal
~s, II.<lviga\kln Ifvoogh, 554

455-45-8
(.OOS). m!pmap.s, 271

map ueallOO, 5S2·~

H(J'W Call we make /his JllneX' more useful:> fmall us al Jnderes~samslltlbJjshillg.C<l-m



9lS Oouble Domination gametype

mMllol soeen Cteatlon.

553

purpose (j( game. 551

drag gods. oejec! ~Ie, 60-62

dtaw order of SSP Irees,

107·108

drawings, use III cha~er

mo<leling, 726

Orillen attributes, reactive ani·

mallon, 792

duplicating Acto,s, lighting

effects. 81-s4

duplication melhod, light Cle

ation, 241

Dynamic light mcde

(F's/speetJve v,swpar I}.

241·242

dynam'c lights, 233

laCk o( shadows, 234

procesSClI Vsage, 23.4

proper use 01. 267

dynamic Simulations (anima

tklnS),401

Dynamics menu set (Maya),

596

E

edge modeling, 622

Edge Turn 1001 (Terra In

Genera lor), 177

edges (polygons), 115

belleJJI)g, 648-649

Ed!' menu (main menu bar}.

8-46

Ed/l ?clygons menu (Maya)

CharMer VerIer tMl.

648-649

CuI Faces 10<>1, &4~CSO

Extr"Jde Face 1001,

64~647

LxlJude Vellex 1001, 648

flip Triangle Edge tool.

653

Merge Venex toOl,

652-653

NO/mals 1001, 654-656

Spht Polygon \001,

64~644

SUbd'Vide loci, 642·6-43

Wedge Faces 1001,

650-651

editing

terrams. 166, 177·18-5

Adding Terrain 10 Ihe

Skybox (tulo/lal 5.7),

184-185

....a Edge Turn 1001

rierra>l'\ Generalor),

177

lila Halle n 10Dl (Terrain

Generotor), 176

helghl maps, 170-172

via Noise tool (TeHilin

Ger.eralof), 175

via Pain\ too' (Te rrain

Genero\Of), 174

Stlaping YoOJ Own

LaMscapeS (lulOlial

5.6).1"77-183

via Selecl too( (Terrain

Genelalor), 173

via SmoOlhing tool

(Tellal11 GeneratOiI.

174

via Terrain Editing user

interface, 167-170

tex\Ures, 188-192

via Visibility loa(

(Terrain General Dr),

176

lexlure layers, 186

NOise 1001. 187

PalOl 1001, 186

Smoolhif\g tool. 187

Tel{ Pan 1001, 187
•

Tel( ROlale \00), ia7

Tex Scale loci, IBB

edllor windows (URrealEd}

Search It)( ActOlS, 8'35

UNeolSCripl Edilor. 896

effeels (lIghllrtg). 24S

ambie'lL 253-254

coronas. 256.-257

emlulflg. 254·255

falloff, 243-244

Scale Lignls 1001, 251·252

SpecialLit properly,

252-253

TliggerUghl s. 257·2M



- - -._------- Eterrull EJcodus 911

electrlc bolt ~Necls. creating.

391·395

elevators

BUilding the Elevator

ltutollal 9.5). 325-327

color hunons

(Male"aIT,i€ller).

33&-341

COlor progress i"dicator

MlllerialSwilch.

341-3AA

Tel~flr.erTr,ggered.

345. 348-349

c.ompie.. be!'l4vl01S

($cnotedTrigger).

329-334

conuOl parlel (UseTngger).

3J7-nB

ci/tallng (UseTngger).

325-327

doors (SeI1PteaT"iiel).

~36-337

jerking behaViors

(VlewShJlkef). 334.-.336

player CPC!~(lcn

(U~e1rUet1. 327·) 29

Sellll'g uP the UseTrJuer
(tutO<'1al 9.6). 327·329

(miner Actors. P3/l1cle

tHee/s. JS9

creat;Of1 process. 360·36j,

DrawStyle teJ.!LJles.

364·365

eminer ~s. 361·397

ume prOPf"ie!. 367·368

Unreel Toufl1&mellt "2004.

360

emitter types

Beam. 361

Creahng Electric BollS

(tulOliel lO.ti).

391·392

Fin IShing the Ligtrtl\irlg

(tutorial 10.12).

39~395

proper\ies. 38~

Mesh. 301

Sparll.361

Creating ;,C~

8ell with Barrels

(tulMal to.10).

3-87·388

Creating Firew~

(tutorial 10.8),

383--.1B5

Making the Part.itJes

Respond (0 Collisi()l\S

/tutorial lQ.91.

JaS--3a8

ptollertles. 3B2·383.
387

Sonle.361

Ad<Mg Fif\81 Tovches to

!.he Steam IlulOifal

:l0.3).369

Adding the Fil'lel

Touches 10 Vle

Telep<lfler Erteel.

(lutOtlbl 10.5\.

374-~77

Adding Smoke TO the

Fire (tutorial lO.7t
38c-3B2

CJe8ting Fire (hAOllal

10.61. .)'77·).80

Cie&ling ano Setlil'lg"

Up YOlK Emmer (hIlO(·

la' 10.1). )62·,365

CrealJ(-,g the Steam

(lulOfiaI .1.0.2)

365-368

Creali~ a l"eleponew

ittecl (M()li.>1 10.4).

369-373

Trait,361

properties. 39f>

Uslng Inc Tr.lil[miller

(lullllial 10.13). 397

lmtetlng Light horn an AelGl

(UJlollel 7 .10). 2S.4-~S5

Ens4Jre. Plena rlry o~ 10/\

(Cleale Polyg<1n l(WI!). &30

envlr(l(lrnenlaJ unlrols.

Physlc.s\lolu~Iyp~. 206.

215-217

envlronmenlal maps to/

feflectlve s Urf8et:S. cIllallilS.

2%-305

Es1atlll.$lIln, /I Tt1iiel (/vlo,let

:13_2). 481~2

tst6ollshC"£ lll~

Malerl.JITIl~~'and

MeIB,IBISwUc.1I (llJloilel

9.11), 339-341

Eternal &odus.. game develop-

ment elAlmpl.e

()Iaye,'s ~rspective. 32·3.4

plot 1/\II000cUO". 3o-n
sales pilch. 3-4

How ca" we mcwc Iflls IfldcJr more useful:' Emsll us a. jfl(lereS@SbmSplJOJlsl\!/\g.com



918 Exp<lMntlsl algorithm

8~onenll81 algorllnm, lading leXI In Intra mOvle1, flnJsh/flg 'he LlgI'\tJ1Iflg (tu lorl-

St'f'I()Olh command. 637-638 Clealing (Mali~e), 497499 091 10,1.2). 393-395

e(porling failing plls. veloc!ly CCI\trols 'ire ef1ec1.s

a~matlQ{\s 10 UnlealE:d, ('ulorlal 6.4).217·218 AddIng Smoke 10 Ihe Fire

835-841 falioH flliVlllng) (Morial 10.7), .180-382

Dl'uslleS. lA5 radius, 243-244 CreatIng Fire {tu,ol'lal

charaClers, fUlly s~iMed rales, 244 10.6).377-380

slatus. 771 772 fans. CrealJr.g a fan (tulorlal parllcle spm properties,

statIC meShes (catwalk 11.5), 421 379-380

models examples). feel, Modeling the Fe-et «(ulorl· flreworks effects

720-721 1I1 21,11). 745-747 Cleal trig. 383-3-85

uperllng' Your UVs Inlo (lie format 101 texlu rss. pall \ele will sklns,
PMIOShop lIulorl81 19.4). :270·271 3B5-3B6
£69 BMP (Windows BiLmap), fltllng lextures 10 rooms.

Ext rude face tool (Maya). 270 72·74
MakIng Face E)(tn>s\ons DOS (DHect Draw Fining Ihe Textures (Iu/orlal
(Iulorlal lS.9). 645-&4 7 Surface). 271 3.4), 72-74 ~

t.xllude Verlex 1001 (Maya). PCX,270 flat langen' In key/rame anI·
Vellex htrl/SiOIlS (tutorIal

TGA (Targa). 270 mallon, 785
18,10).648

UPT (UPaJnt}. 270 Flallen tool (Terrain
eXlrudlng l}Olygo/ls. £.4~48 GeneraIOf), 176File menu (main menu bar},
et1ruslon mo-dellng. 622

846 Flip Triangle Edge 1001 (Maya).

File options (loolbar}. 848 BS3

F/l'lal Blend matellal, proper· flipping triangle edgei. 653

lies. 305 llo<lrs, ;;llppe ry, creallng (tu lor-

F AlpMTesL 305 ial 6.3), 21£>.217

F8_AIOha8Ieno. 306 FluldSurlacelnio Aclor

face mo<lellng, 622 FB_AJph aMMulale _Mighl N properties. 223

faces (polygons), 115 OlfogConectiy. 306 walel surface Iext ure.

FB_8nghlen. 307 221-223
cuml'lg, 64g.650

FB_Darker.. .107 f luid511 ria ceOselllBt OJ Actor
weaging.65o-€Sl

facle effects In camel liS. creal· f8_lnvislble.307 propellies, 224

Ing. 493-494 FB_Modul'He. 306 waler surface ripples. 224

Fade SUb Action. 490. FS_Translucent, 306 flyingPall\Nod es. 001 ve hicl es.

493-494 -466
FrameBuH"er8IeMlng.306

Fading In and Oul (lulorlal Hes!. 307
fog, adding, 219

13,6}.493-4S4 ZWlI{e.307



larced pain!>, MI naYlgallon,

443-444

Forw-ard I(lnemaocs (FI(). char

acter 8111maUon, 796

A",mating Joints wlltl FK

(tutonal 23.4), 795-79B

(our-way Inlers<lCllon OUWilI~,

sra lie mashes, crea(lng, 717

(r:am£lS (anlrr..2ltlon), playba<:k

rates

motion pl~tures, 784

NTSC Standard, 784

Unreal ;;tsndard. 784

Fleehand ~Iygon Dlawlng

tGol, Inegutal blushes, cleat

Ing, 1.25-1..2 7

lrustum culling, level opllml26'

tll,n, 52::ui24

G

!fllme loop~, ~\Ie'lt handline,

15-1.6

Gllme Speed Sub Action, 490

~8mety~

at>brevlal'O/ls. S42

Assault

map COlI/lgwation.

572·573

oI)jectlve ,'ealion,

572·576

objective Ot~I, 577

OIayel S08wt'l man·

age(s, 57S-5a2

player Sjl8WO points.

578

purpOse 0/ game, S~

selup proceu ~ec

lives, 569-571

Bombing Run

design consIClef'l\iOilS.

556

map comP01\6nlS.

554-555

map configuration.

555-556

purpOse of game. 554

Capture tTl! Flag

design conSideratIons.

551

map comoallbilily, 548

map creation. 549

player c("allol'l. 550

IWfpose 01 lI~me. 54B

vleWl 50C 'ee "S. 550-551.

ch&/BCte r cre 08 fbliof\S,

772·777

classes. 542,543

l)eal1\matcl'>

".Oding ~6PonS ilr.o
Picl<u[)s (tulonel

16.1). ~4.d·5d6

desl!", cOr'\~lderatl()tIS.

547·548

lrag lorn;' s. 54:)

map Cleatlofl. 54.3

P/cku[)S. addillg,

~4.4-S46

l)U/OOSe 01 game. 543

~tlPOn.s. ad4i.-.g.
5.44-5047

ga~!'yp.e:s 919
----------=---

demonilffillllfl maps,

541·5.42

dC\l6'apmel\r

p<e·pu);jucIIM :I..age.,

~40

release srage. 44

lasllng sl.a~. 42·44

Dooole Do.minaloo

~sigrl COI\Slae,alJ6Ils.

554

map crearion. 552-5.S3

mOflil()l SCl<'le(\ ue-,

3'11011.553

fiU/po.s.e (){ game, 551

l~lon. ptj{POse of

game, 5.4 4

l..1ls1 MDn SlandiAg. put.

po.st Gf game. 543

level pr<>Pellies, ~njng.

542-543

~. ~41·Stl2

MUl.llI)L OVfJ)OSe o( game.
5-44

OIlS Iaugl'It

allernlll",e 11\80 linkS.

56.l·~2

Oesigr. CMSIOel7lliMS.

56a-~9

mao co~n's,
5~557

!)invre Gf level (Llilk

CeSigneJl.556-568

powel core placemef\!.

SSS-SS9



920 gametype.s

powet nOde l\nl<s.

559-561

pawet node placement.

558-559

purpose 01 game. 555

leleporl ~d 2ldditiens.

566

turret additions, 564

vehicle placement.

562-564

weapof\ lOCKer add~

[IMS, 564-565

?layerStarts ACIOf, 543

Team Dealhmatch

trag limits. 5.43

DLlrpose of game, 543

geometry of leuains, general-

ing (Terrainlnfo ActoI'). 149

graphics engine (Unreal

Eng'1/1 e)

data-lrHmage lransflYma·

tJon.12

dr<fW calcUlations. 12

lellels, speeds, 13

rendellr.g fur.cl)()ns. 12

grayscale Images, alplla chan

nel5, .270

grids

resolution centrcl. drag·

ging.60-62

scale, management of,

6o-n2

static meshes

a"usting. 6&2·68.3

Serting Up the Gnd

(Iu{ollal 20.1).

682-683

GIOUp l)rowser, 876

Qullons. 877

menus, B77-a78

H

Hall of Miuors <HOM) effect,

10£

levels errors. 48-49

lroobleshoollng. 49

hands, MOOeling the Hand

(tulo-rial 21.1.2). 748

hangars

conrrol room j)assage

ways, creating. 85·93

lighting effeclS, creating,

81·84

hard edges. 623

adjusting. 65-4-656

heads. Modeling the Head

(1lltO/lal 21.1.3), 749-75{)

heads-up dISplay (HUO), 52

HeallnChslger cl-ass:

(xf'ickupBase claS$),

Oulhmalctl gamelype, 544

height maps in IElualns

convoJling (Terrainlnlo

Actor). 149

s\2e calculations

(Terrainln(o AttN),

149-150

Help l)ullon (UnreaIEd). 8SO

Help menu (main menu bar).

8-47

hinges, Cleating' a.Dynamlc

Bridge (tutellal 11.4),

419-421

HHScan810Lkingvelume type.

207

lololdObjectlve. Assault geme

type. 570, 573-574

Hotbox (Maya), 605-605

Hover?alhNodes. oot vehicles,

466

Hyp-ergJaph (Maya)

(onclion 0(, 6O~10

Introduchon {6 the

Hypergraph (\utonal

17,1). 609-610

Hypecshade (Maya}

Create bar. 606

Cteallllg' a Basic Matetial

and Texlure "ularial

1 7.6), 606-600

funetlon of, 606

materials creation,

600-609

Too area. 606

Work Olea, 606

Mjeas for game development,

refinement prlOl to proouc

tion, 39-40

IX S~ne Solvels

joitlt animaliM, B03

Usi(\g Spline IK (totorial

23.B},803



Image O~Il~

Alit.~ Lmar,es in

PhoIosMp (Lutoiial

21-1), 72IP.30

cMrnoer modeling,.30

OlawlngS. 726-7.33

Creallng D Project ill Maya

(Ivk)MJ 21.3), 7J 1- 73 2

clOlke~, 7.31

~ling: inl.o M.aya.

731-732

~ Lmog'e Planes. In

Maya (llJolcwiai 2.1.4).

732· 7.33

1000wg ~Q Maya,

132·7.33

Lowering ltle Image Plane

BflghlMss «( ulOliol.

21.2), 731

lmolemel\lll\{ 8

Selfpl edTrlggel (luion?>! 9.7),

J.3~34

Imp.o.ll TU'll/If. d.lblog boll"

(felliu/e bHI~el)., 27&277

~fl plQ.perly. 277

Genelole Mipmaps. PtOj}ef

'Y. 277

Masl<e<J piopeny, n6

\mjxl.rl(~

D.tus.nes, 145

image plMes. chotacter

modelio',g.731-7.32

ske(e{<)/\S. 767 768

(el.1.Ufe5. 2 70-') 71 ,

27'0-277

Imp.lOllir.g Ine ~lt C>1lhe

Ruins (11No.rI2J 4.S), 1.2 2·1.25

lIIdexed Cookl, dialog box

(PM-Loshop), 275

\n(luenus few ~~~ a6Ju~liIg,

7&3-76&

lnp.ul man age r (Urlle 1>1

Eng-roe). 14

Inp.oc nOOe (Mayo)., 587

(nse,t~Sub Aellolli (luiewl1>J

13.5). 4.91-49~

I~e/acti\le ele~~s

e~rors

MDl.erio\Swi\~t\.

341-.344

MaleriolT/lgg'e/,

3.1B.-341

Scr\p(edltigge~

329--3)7

~'Xf>aDI\elTngge'e<l.

345, 34a-349

U~Trigg&', .3 25-329,

.337-338

~e~ .334-33S

iom1=l pads. foocloo of,

349--)52

'Movers

DdlV3Mg, .31a

OOo.'s, allirnaUng',

31~JW

doors. coM I oliIIing,
32()"321

dooIs. Cfe3llng.

31a-322

doors. ~/oaclImefll,

.321-.3n

liltro mov1&s ~r

doOlS., placiTl(l,

)1a-.119

keys, 317

uses . .317

lelep61lers

'oneI\oil of. .3S,3,.3:.4

13000m.3S4-.1SS

7riggers

aCllValiflg. 322

MeSos.ogeTrigge r,

.32~·3~S

uses . .3~:>

Infe/polal!<lo l>O~,Mal~

~/le M3I\age~, 469

In Iuseel roo! (lkve aJ Ed), ll.1

SoII1e, Brush modifICa

tion. 111·112

hJI)Won 0(, 111

USIng \he \{llelsecl 10<>1

(4.1),112

Il\l.er~C1~ In wQ.l14g~

l~ 1n6

W,O IMYi~

SCli(lled seQOeflC.es. ueal·

109 (Marinee). S17-51Ei

Ie'("l, C>dd.-of (Maur>ee).,

4%-4~

fe:<\ Creation, Pari 1 (Mori

al 13.8), 496497

Te,)(\ Crea/jon. F'an. I( (IOlCW

lal 1,3,9).497-499

Using Marinee w((h

Scnpl eo'se{jUe/IUS (n."'1>

';3114 ..3),517·518



922 Invasion gametype--_._- . -- ------_._-"-----~---~--~

InvaSion gamelype. purpose 01

game, 544

Inverse I<ine m alles (I K)

charaCler arllfna\lon, 796

Animating Joints wilh

II( (lulonal 23.5),

79&- 799

II< Spline Solver. B03

Relale Plarle Solver.

801-802

Single Chain Solver,

800-801

Creating <I ROlal~ Plane II<

Solver (Iv(Qual 23.7),

8OU302

Seiling Angle on ]QjnIS

(Iutonal 23.6), 800-a01

Using Spline IK (tulollal

23.8),803

irregular brusiles, tleallng

(Freehand Polygon drawing

tool), 125-127

J

JoInt fool. 7SB-7S9

}oinlS

AdJlJshng Jelllls ThrC>lJgh

Moving flutolial 22.2).

76().761

ForwarD I<lnemaucs

(Fl<). 796·798

Invel~ I<loemallcs

(\1<), 79f>.803

Crealing )oinls with the

Joint Tool (Iulorial 22.1),

75-8-759

Painr Skin Weighls tocl,

In(f08!'oCe &dluslmenl~.

763·766

s\{elel<lns

creatlOg (JoII"II 1(01),

758-759

innuer.ces. 763-766

leCBI r(){atlOn axes.

757-759

movlflg, 7M- 7£ 1

parenllng hlerarclly,

7~-7S7

sC21hng. 76i

Us109 the Pamt Skrn

Weights 1001 ltutonal

22.4), 765-766

jump j)ads

A(jjlllg a Jump Pzd to {he

Hangar (lutonal 9.1-4).

349-352

functlon ot. 349·352

Jump SPQ{~

001 paths. 450.4 5S

Jumpit'lg onto a Steep

Ledge (tulonal 12.2),

451-453

Transioc.allng ThrOUgh 0

Small Hole (lUtonal

12 .3), 454-455

JumpDe-st Act ()I propenles.

£lSi

Jurn l\Sp.a1 Acto r properlles.

451

K

KAelor

CleBllng a Simple Karma

Actor (tutooal 11.1),

403-404

object (eactlon, 402-404

propel'1leS, 404·410

Ragdol)s, creatlng,

423-425

Karma Authoring Tool (KAT)

AOl!X:::alCl/late Mass

PlOpertres dialog oox.
439

eh..(aelers. Ragdoll COfIftg

vratlon, 432.-439 •

Creallng a Slmple Kalma

Asset, Part I (lUlorral

11.8),427-429

Creatmg a Slmole Karma

Assel, Part II (Iutorial

11.91, 4£9·432

Crea1.U1g a Simole l<allTl3

Assel, Part III (tvtCf/al

11.10). 432-433

features. 425

Interlace appearance, 425

Mass Clamping Opllons

dialog oox, 439

MVlgal100 Mtkeys. 427

Part GraphIC Hler;ycOY dia

log box. 433-435

Ragdell skeletons

CUStom creallen 01.

423

effects. 402



How can we make ,hiS /Ilde'l: mOle useful' EmaIl LIS ar Inde~es@SlJmspubl)sll!llgC<lm

sewng op a Character In

KAT (tulon3) 11.11\.

433·439

skelelo.ns

colliS/(ln ge<lmetry. 438

jOI''',\ hrrwts, 438

JCIl"l\ types, 437

worksaace assels

creaLJcn of. 427-429

Impor ling. <12&-433

managemen( o( 426

Karma ColliSion Pr\rrlltlveS,

410-411

Karma p/')y~cs engme

cl""nl server Cl)mmunlca·

lJon, repllca:,on, 402

collislcn Dllm(ilves. pref,x·

es.411)...411

CO<'\SIlaint s. 411

Creahng a Lamp luloo-

al (11.2).411-415

KBSJo\nt. 411-415

KConeUm/\. 41!).41 7

l<Hlnge. AIB-d 23

ModIfying the Lamp

Syslem W\Olial

(1 L3), 415-417

Crealing a SImple Karma

Actor ftUtOIl3l11.1),

403-404

KAeloe propettleS,

<Ul4-41O

Karma Alilhoring Tool

<KAT), RagClo[( effects,

402

Ragdolls

creahng. 423-425

deaV'l effects, 401,

42.3

skelelO<'\s, 423

weapons. 402

sing(e--pl8Ye~ ve rsus mulll-

player gaming. 402

KBSJc\nt ron$ttalnt (Karma

Ball 5.oekel Joinl), 411-415

Crea\lng a la~ lulorial

(11 2\,411-415

properties. 415

KConeUmit conSlralnt,

415-417

MOdll)'lng the Lamp

System tUlorial (11.3).

415-417

st,ffness/damping proper.

lies, 417

Keep Faces Togelher optlOf\,

Create Polygon tool (Maya).

625-<>26

Keep New Faces Planer

ollllon, Cleele Polygon 1001

(Maya), 625-626

key(rllme animation, 785-788

arl\rna\IOfl curves

m\eljXllat\on 01.

784-785

tangen\s, 785· 786

BaSIC. Keyframe Anlmal100

(lu(orial 23.1), 786·788

Using the Graph Editor

(lu(orral 23.2), 788-792

latent actions g~J

keys (MO'IIers), 317

door va(ues. 319-320

)(Hil\ge co-nstlamI, 419-423

Creal1l'\g a calaoull (tulori

al 11.6),422-423

Creating a DynamiC Bridge
(tutorial 11 .41. 419-421

Creallng a Fan (ll.J{Clial

11.51. 421

mode beha\l1ors. 418

tnggering modes, 41 8-419

K?arams p,nperty (KAelM},

404-410

L

L key, lighting, creating. 241

ladders

Au\oLad6er AClor, 46C>-461

boiS, chmblng, 460-461

LadderVohlme type, 208

uumalJI)Il properlies, 229

Creating a LDcklerVolume

(1010nal 6 8), 226-229

OlreetlMaI properlies, 227

landscapes- See terrains

Ia5et frail eHeets

creallng. 397

prOj)e(lIes, 396

Last Man Slandlnt;: gametype,

PUrllO!>e of game, 543

laten[ actions. scripted

seQuenC85. 506, 511-514



924 launching

lau"et'tlng layou IS (l.lVs) ~vel opl1m/z3lion

Ma\lnee. 471-472 Applying the N~ Te~\UI'e f,l.lsllXn culling, 523...524

movies. aUlomaloc selling (tuiOlla( 195), 670-671 rel"\Cleling s~e(js

(Maonee). 500-501 characters. 672-673 checking, 535-539

seouer.ces (Matinee). leg \ay<lut example, <:lebuggjng.535-S39
480-482 677-678 zooing. 524-527

(ava, lIamage units, settIng, shIrl layout example. levels
224-225 6f3.676

Act()(s. IT"\l)ving, 65-66
LwoVolume type. 206 creating, 664-668

ADding a Jump Pad 10 'he
plOperlJeS, 224-225 Creating a MeSh and Hangar (Iulorlal 9,14).
Using a lavaVollll),e (lvto,· Preparing (()( IN Layout

3.49·352
la( 6 7), 224-225 (1u11Ylal 19_2),665-666

An\(portals
layer Editor (Maya), 5'3~ Creating a UV Layoot (or

The Ar\\lponal Tag
Using Layers (luIOfla( tM Sialic MeSh (lutonal

(lulonaI15,31.
17,dl,600-601 19 3). 666-66-8

531-532

layers creahon gUidelines,
USing Anh»Of1ajs l1utor-

678-680
terrains lal 15,2), 529-531

blending, 150
ExPOrting Yeor UVs into

when 10 use. S28-5~
PhOloshop (tu,orlal

decoration object
19.4>.669

base geomelry, rebUlldmg

placement
Laying OUt the UVs of a

process. SO

(De<:c<. ilye(5). 151,
Characler's Shilt (lulollal Binary Space Pat!lllOf\lng

192-204 IBSP) brushes, SO19,7).673·676
dennIng, 150

OverlaPt:>\ng UVs (Iutor(al changing (Matinee).

edlllng (oels. 186-188
19.6),671.Q72 501-504

fUrlGIK>n of, 150
te~tures, Cleating from,

compiling, 48

maxunum number ef. 661M72 compleled. appearaoce of.

150 Usu'og a CylmdricaI MaD 101' 47

le:.:lvrB Dloperties. a UV Layoul (tlllerial consilllC\(Ve solid geame-

191·192 19,8).677·678 Cry (eSG), 50-51

wyers palelle (?holcsnap). legs, Modell"g ,he Legs (IUIOr- creallng (2D Shape

273-274 laI21.9). 741·744 Edllor). 136-137

Layers lab (lellal" Eolilng dla- lenerbox effect. creating' Creating a Random

log bOX). 168 (Mallnee), 49%00 Telepcrter (tu,ollal 9,16),

l.ayoul SeJeclion (Maya). 605 354-355



levels g25------_._------------------------------------

cceaUCfl process., 57 \1aU 01 Minors (HOM) !>ealing lights, 251·252.

additIVe methcd, 48 effect. 48-49. 106 SGnpled seQuences

brush (leoec, 64 JUmp Dads. (unCliOO 0(. ACl!MS list. 506-514,

brush JlrVClI. 63 349-352 519-521

brush lyPes. 62-63 Jump spots, 001 n8ll1ga- creatlor> overVIew.

navigation contrOl,
llDf\. 45().455 50'>506

64-&5 IlgIlt maps. 232 Seiling u)) a Simple

scale Issues. ~2 lighting. placement 01. 233 Teleoorte r (lutonal 9.15).

~ublractJve method. mes~. lighting surlace. 353-354

4S-49 249 Selling up Levell (totOlial

de~(gning prior to Movecs 13,12).501·503

UflfealEd IntrocluCllon. ac<rvallng. 318 Selur,g uo Levet2 (lulOfial

48 ooC>Js. i:\fumatll'€. 13.13). 503- 504

details. effICient \)rusl1 319-320 speeds. !!Jap.'lics engine

use. 10S-106 doi)rs. controlling. rer.derir>g. 13

dlslan~e ~og 32Q-.321 slatic meshes

uses, 532 doors, cre.aring. addu,€. 93-100

USll'Ig DlStance Foi;! 318-322 decOfative trealmenls.

lOloflal (15,4). do~rs. ef\Cr03chment. 101·103

533-534 321·322 lighll'lg surl1K.e. 249

elevators doors. pl3Ctr'lg. Ie lelX>rters

color progress mdlCa· 318-319 funclion of. 353·354

tor. 33&-349 keys. 317 rarxlom. 354-355

control panel p\a(e- Ilghllng sur/ace. 249 lellaill. lighting sllr(ace.

men\. 337-338 uses, 3~7 249

cr~almg (UseTrlggec), lXlslaug/"l1 gamelype. pic- Triggels

325-327 lure ot fLlrlk Designer). actIvating. 322

doors, 336-337 566-568 MessageTligge r.

jerking behavlOrs. psrttcles. I~htlng surtace. 322-325

334-336 250 uses. ~22

Dlayel (lpe rahl)() scale UnreelEd developmental
(UseT"gger). 327-329 aesthetic issues, hislory.48

(uf\CtiOllal4ly. Implemen\ 59-60 w<)lld ge~try, 50-51
IrIg,74·77 grid sna~plr.g, 60-62 Actors. 51·52

gamelype plooerltes. sel· ligt1ling surface. 248
(ing. 542·543

Haw can we make Ih,s Index more vseflJI? £mBI( us al Inde)(BS@Samspub!lshJng.com



926 LE_Di'sco setting
----- ---

LE_Disco selllnll (UghtEHecl

propelry), 245

LE_None setllng (LlgtttE~cl

properly), 244

LE_Nonlf\Cld ef\ce f>elt1ng

(LlglllEffeci properly). 244

LE_QuadralicNonlncidef\u

setting (Lig\1IEffect proper

ty).244

LCRolor f>elllf\g (UghlEtfeet

property), HS

1E_Wa rp f>eltlng (Ugh/EHeel

property). 245

Ut1Cenler Ac(or

Cleating a Bot,Navrgable

LIft (iulcria) 12 7).

459-46Q

properties. 458-459

I.if'tExit Actor

Cleating a 801-N311igab1e

lift (tulonal 12,7 J,

459-460

properlles. 458.-459

lilts

bOIs. (\,lVIga(IOn it'olOOg/'l.

45&--460

Cleallng a BOI,Navlgable

Lin (lulO<',al 12.7).

459--460

light m3ps. 232

combimng wilh shadows,

232

I}latemenl 01. 233

Reouildlng Changed Lighls

(lolon81 7.5). 246247

RebUIlding Ughlmg «(ulon

III 7.4). 24S-246

Sizes. changillg. 247-248

stalle lighlfllg. 233

LIghl Propel lies dialog box,

7£

UgtllCQlor properly

Qrightness seltJngs.

234·235

hue senlligs. 234-235

sawrallon senlllgs.

234·235

lighlEHecl properly

falioH setling. ~<:l3·244

LE_Dlsco setting. 245

lE_NMe selling. 244

LE_NonlnCldence set1lng.

244

lCQIJadrallcNonlnCldellCe

5el'ling.244

lCRolOf sening. 245

LE_warp senu'\g. 245

lighting

amblenl. 253-254

e~cessjve. 265

animalM eHec(s. 245

Cl'Ianged senirlgs, (ebulld

Ing.24&247

CO/7VTlOf\ m)sUll<~s. iNoid'

",g,265-267

COl\Irast levels. 265

coronas. 256-257

clea{mg

3D viewoort. 241

dupllCOIIQfI melhOO.

:241

l key. 2dl

design. 2~

d'f'lamlC,233

lack of shadows. 234

ptocessor usage. 234

p.'O()e1 use of. 267

effects

ambient, 253·254

COlOf'laS. 256-257

em,(1;n~. 254-255

nangu. crealoflg. 81-B<!

fooms. adding, 74-76

Scale LrghlS 1001.

251-252

SpeccaRI( propetly.

252·25.3

Tn,gge(ligl'lls. 2511 ·260

emi\lif\g. 254 255

excessive. 266

falloff

radiUs. 243-244

f'81eS, 2<:l<:l

Import<lt\ce o( source. 265

light maps. 232

combtn/flg wllh shad·

ows.232

Slle cNlnges, 247·248

MIl'SQuare Pllljectors. cre-
atlng.262'264

olacemclit of. 233

ProjeClors

creating. 261-262

(unction of. 260

uses, 260
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92B Making the Lavel FunctIonal
- ---- --~ -------~~-

MakIng the Level Functll>nal gametypes , 541·543 shodefs, 269 '

{tutorial J.S}, 74-77 Onslaoght gametype Addiflg the Specular

Maklrtg the Particles Re~poJl<l allemative links, Map {totoria] 8,61.

to Collisions (tutorial 10.S}, 561-562 2M-2aS

385·386 compollefltS. 556·557 blooding proper(~s,

Map Check dialog bax, bol shadels. 282 288

prl>blems, lloubleshoollng,
Mass ClampJng Options dIalog color selectKlon,

448-449 283.-284box (KAn, ske~lons, 439
mapping LN5, 663

MastetlngLln leal.com webslIe , Cleating. 282·283

automatIC methOd, 663 3D applicatk>n training, .23 C,ea\lng a Shader

cylindrical method, 064 Mate/Lal categOly, Texlllle (lotortal 8.4).

planar method, 664 Properties window, 280
282-283

maps (levels), i8 male/lois detail properties, 287

Assault gametyoe environmental maps. maps, 282

configuring, 572-573 /e lie ctive slirfaces, Dpacity map, 287

selling Up an ASSDUh 2%305 Self-Olum((l31100 maps,

287 •
Map aM Crea1rng an Frnal Ble rid properUes,

Otl.teetJlle (tutorial 305-307 Sening Up the DiHuse

16.17),572-573 modiflets, 269 Map (lu(Mal 8.5).

assels. 18 cO-ior seloctlon, 283.-284

Bombing RUfI gamelype 288-289 side PiO(lerlJes. 287

COlT\(lOnenls. 554·555 combming, 294·296 specolarity. 282-287

con fig Uling, SSS-S56 Creahng and Using lhe Taking Advantage of

Settmg Up 3 Bomtllng Color ModifIer (lUll)(i- the SpecolalilyMask

RlXI Map (1u1ooal al 8.8), 288289 Property (lULQ/iat

16.8),555-556 runctioo 01, 288 B,7l. 2B5·287

Caplu/e the Flag game- pan direcuoo, 291·292 le'i<'tures, 269

(y~, Creating a CTF Map /epeating motIOns, 8-tliL 275

(1ulooal 16.3), 549 290-291 Creating a Texlu/e In

Double Dominatkln game· rQtalion dlf&UOfl.
POOtQshop {llJtooal

type, Creatmg a DoUble 292-293 8.11.271-274

DominallOn Map (wtorial scales, 2'93 Creauflg an 8--OIt

1£.6),552-553
objects, applying to

Texlure (tutorial 8.2),

(Hyperst'laoe), 606-6M
275

/ener;Uve surfaces, ueat-
creaOOn ovefVIeIN.

lng, 296-305
270-271

ScuptedTe:dure, 307-316



Laooching ltle Mwie as Sub N:/jonsImpor(ing, 270-271

the Level Begins (tl.l1Oilal Camera Effecl. 490(mportmg and USing a
13.11). 5O().501 Camera Shake. 490Simple Texture (tulori-

al 8.3}, 276·277 lellerbo~ effect. crealJng, Fade, 490, 493-494
MalerialSwilch, elevaI (}{S. 499-500

Game Speed. 490
c.ol£H' prog,ess Indlcalor, levels, ctlang\ng, 501-504

Orlentation, 49C>-492
341·..144 mactunima

POV. 490
MalerlalTrluer, elevalors, culscenes, 468

Scene Speed. 490
color p/o€ress indiC<:lIOl, evolution 01, 46~469

Trigger, 490338-341
overview. 46 7·469

Unreal ChampionshIp, 10Math Englne, 13
typical uses. 468

Using Matlnee \IJIthMatinee
movies, 2luto-laOf'lCl1ing, SCripteo$equeflCesA Basic Matinee sequence 500-501 (tulolla( 14.3). 517-518(tulona) 1.3.1). 475·479
SCene Managers MeyaAcIOfS, moving, 494-496

Acllons, interpolation Apper4 10 Polygon 1004,
cam~a CUIS, creating. points. 469 630-632

#488-489
Actions, management Applying the New Texture

camera paths 01,469 (lulOflal 19.5), 67()'671
Camera Path Actions, Sub Actions. Chamfer Vertex 1001,

Enhancement (Iulonal 469 648-&49
13.3},482·488

camero ~ths. 470-471 cootdinate systems If~rsus
controlling. 482·488

properties. 479-480 UrveillEd, 5&6
Pausing and Cl/lting

se<J.uence overview, Cleale Polygon lool,
flulonal 1.3.4).

469 624-625.628·630488-489
Sc.riflted sequences, inlro Keep Faces TogeU1er

camera pauses, creating,
movie Clea{~, 517·518 opllon, 625-626488-489

sequences Keep New Faces Planarinlerface, 467-468,
camera palhs. 482-488 option, 625-62£

471·472
camera pauses, Cut Faces tool. 649-650Actions tal:>, 473

4B8-489 Extrude Face tool,
ScefleS lab. 472

crealfng . 474-4-80 645·647
SUO ACI(o.ns tab, 473

Establishing a Trigger E~trode Vertex tool, 648
IDols tab, 474

(tutorlal L3.2). Alp Triangle Edge tool.
inlro moVlI:S. lext creatIOn, 481-482 653

496-499
l.:Iu()Ching. 480·482

)aunchi~, 471·472
lriggers, 480-482

h de ~ more useful? Email US8rlrJde(eS@SamspubIiShing.comHow Cdll we make I IS III ,
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930 Mays

Hy'pergrapl1

f1XlClloo of. 609-610

lnuodoclion to the

\-typergraph {tu\ona I

17_7),609,610

Hypershaoe

CrealH'!!, a B<lslc

Malerlal 3M Texture

(lu(orial 17,6).

606·609

fvnction of, 606

m<'lteri8Is crealiCfl.

606-609

keyframe all/malion,

785-78.8

C\)/"ve i(\[erpotallDO.

1M-7BS

curve langents.

785-786

USIng the Gtaph Edill)(

(Iutorlal 23.21.

78B-792

Merge Velie\( 1001.

652-653

Modeling menu, Combine

command,632·633

Normols tool, 654-656

ob}ecls

GO(\s~ruC\lon hlslory.

588-592

HOlkeys and Marking

Menu s f()( selec~ioo

(Morial 17.12),

016·617

Making Selections

(tutorial 17 .13).

618-619

mamPIJlation lila

Component mode,

615--619

mamJ)ulallOl'\ lila ()bjecl

mode, 611·614

Moving Obiet:ts in Maya

(tutorial 17_8),

611-612

node Ulmpcsiuon,

SB&58B

Rotating Dtljects in

Maya (tIIlOfial 17.9),

613

Scaling Objects \n

Maya (tutorial 17,10),

614

Using the Status Line

(tutorial 17,11),

£15-616

readlve an\malfoo, Set

Driven Hey (SDK),

792·795

Split Polygon 1001.

543-644

static mest1es

e-':DOrtlf\g to UnrealEd,

72().721

prOject crealion. 6-84

Subdivide tool, 642-643

surface models, display

ing, 627-628

lnal versk>rt downloadS.

22

user interlace

Atlribtrle Editor,

602-603

Channel80t,599H&OO

Hotbox, 605-606

Layer [dilor. 599-601

lLlyov\ SelecLlon, 605

main menu bar, 595

menu sets. 595-59:6

overvlew,592

Range Slider, 604

Shelf. 598-599

Slaws Line, 597-598

tear-oH menus, 596

Time Shder. 603

Too100-':, 60S

Transport controls. 604

viewoorls, 59.3-595

UV Layool, 657

IN Te'lClure Editor, '

Examining UV Layouts

(lulOllal 19.1), 658- 659

Wedge Faces tool,

650-651

Maya pacKage (static mesh

es),20

menu bar (Maya). organiulllon

of,595

menu sets (Maya)

Mtkeys, S96

organizalian of, 595-596

menus (UV Texture EdUor)

Help. 659

Image, 659

Polygons, 659

$elecl, 659

S~bdlVS. 659

View, 659



________________________________'!M~o~v~e~rE~n~croa~hTypeproperty

merge modeling. 623 1l3l'Kls. 748 ~pli\, 622

Merge Velte. IMI (Ma~), heads. 749-750 surface r.ormals. 623

Using the Merge VerteX' joinl /n(loence,
Comman<l (tol.olial 18_14),

lIl3f1gular. 622

7£3·766
852-653

vertex normals. 623

merging vertices, 652-653
legs, 741-744 venices, 622

overview, 725-726 Mooeling menu (Maya}
Mesh tllawser, 884-885

MeshEmillel,361

preparalio!1 stage, Combine command,
72B·733

Cle.ating a COrNey<lr Bell
632-633

Wllh Barrels {lutonal
process overview. 734 MirrDl' Geometry com-

10.10),3B7-388
skinning met1'.od. mand, 6&5-636

761·763 MOll<!!lIng menu sel (Maya),
properties. 387 lors<>s, 735- 741 596

meshes as light wrlace, 249
Col, 623

MessageT/Igger. ueallng,
modlflers, 26B

322-325
edge. £22 color selecLlon. 2M·289

mlpmaps, te;r1ures (DDS for-
elClrusion, 622 rombinmg, 294-296

mat). 271
(ace. 622 Creating and Using the

Mirror G~met/y comman-d
hard edges, 623 ColOr Modlfrer {tutonal

(Maya). Mirroring Geometry merge. 623 8_S}, 28&-289

(iutOflal 18.6). 635-636 polygonal, 622 (ur.ction 0(. 28.8

mlrronng ~IS, &35-636 appendage method. pal) direclion. 291-292

Minoring and Misce((ar.eoos 630-632 repealIng motlof\S.

area (toolbal<'). 865-866 ave/aging vertices. 639 290-291

Mim>,I"g' Geometry (wtom.l Boole3f\ operations. rotalion direeuon, 292-293

18.6). 635-63B 6Y\-635 scales, 293

mod makers. B combiAAtian melhOd, Modl(ytng lne laMp .syslem

modelers, teem member
632-633 (lulorl.!ll 11,3). 415-417

res~sIDlIlUes,36 creation method, monitor screens. creating (ar

modeNng
624-625. 62&630 Dooble DomInation, 553

ba~(ace. 623 euor cleallup. 640.<142 motors, Creal/ng a Fan flutcll-

bolt. method, 624 mirroring, 635-636 alll..5). 421

character smoothing. 637-638
Mllver£ocroac.hType property.

animaliM issues,
triangulation, 639

3.21·322

]3..4·735 PflmlLIIIe, 622

arms, 744-745 Quad,622

ieeL 745-747 S<ltl edges. 623

flaw can we make tillS inde)' more usefu!? Email usatinde)(es(QsamspubJiShing.com



Movers

Movers

activating. 318

dOOlS

animation controls.

319-321

conlrolln'tg. 320·321

creating. 318-322

encroachment.

321·322

key va(l'e5, 319-320

placIng. 318·319

keys, 317

as hght sur1ace, 249

MoverE rIC roachType prop-

erty.321·322

uses.31?

movies, See also mllchinima

aUIQ-laoncl'\lng (Matlflee\,

500-501

moving

AC[DI"S

Matinee. 494-496

on levels, 65·66

Joints. 760-761

Mus,c browser. 878

MulaM .gal7'l€type. purp<>se or
game. 544

N

navigaliOll controls

OrtllographlC lliewooTt

(Maya), 594

Perspective v.ewpoll

(Maya), 594

\llewpods

Orthographic. 65

Perspeclrve. 64--65

navigation Mtkeys (KAT). 427

navlga llon ~\n IS (Of bots

placement of. 447

troubleshooting. 44B-45()

negative cj.jrectlons on 30

axes, 5£-57

negalive sides of po{ygons

(BSP),107

networked gamepJay. cHent

server computiflg (Unreal

Engine). 14

New dialog box (Ph<>foshop).

:272

nodes

Hyperg,aph (Mayal. (unc

\100 0(, 60%10

Maya

COMeChOOS, 586·588

construction history,

588-592

Inpot node. 587

Shaclm€ Group node,

587

Sharp node, 587

Transform node. 587

Noise 1001, lextlJle.layers, edit·

ing, 187

No.Ise tool (Terraifl Generator).

175

non-lalenl actions in ~p'ed

sequences. 506-514

no-n-placeaOle Actors, 51

exam~les. 52

verws placeable Aclors,

5L

/\On-player character.; (NPCs)

conlrolling, 514-51£

Controlling <I Pawn (ll/IO/ial

14.2).51.4'51£

!:.cripted seQuences, ere

allon overVIew, 505-506

non-solid brush~. altrl~U1es

of- 143-144

nOfl-Squ3re ?roje-ctors, Cleat

itIg,2&2-264

nQ.l\i)Jayer characlers (NPCs).

10

~rmals. polygons (SSP), tree

UfIe!l., :109-1.10

Normals tool (Maya), 6S~56

Controfl1ng Hard Edges

(tutorial 18,16),65£

Cont rolling SlinO{:e

Nolmafs (IU(orI31 18.15).

65-4-655



0 obJeds ~s

arumaIi6n Cl).{l S llair\ls . Cllf1\O(:) S iOOn (Maya I,

objut 0JUrr\1l1~. e<>ns.llalol.s.
804-&)6 sas-SBB

eo 4-806
edges,~,64~9 Ul(IsModion ~Io.ry

oOIecf de(lecc Ion.
~keys and Matldl'tg' (Maya). 5aB.-S9£

Umltah<:>l'tVolume type, 107
Menus (0( Se\eclion physical. eMOi'\fOeOUI

Object mOOe (Maya}, o.b~1
(lolCiial 17.12), 616-617 lespons.es (}{alma),

~l'Iip.ulallol\611-614
l(}>.etOl"S Pl~nies, 402-404

~cU\les ((}/ A.ss8u11 ga~
404-410 Rolall\g OOjeLls in Maya

lyj>e
Kat rna CoI'ision Pf\/l\W tveS • (llJlooal 1 7.9).. 613

creallOg. S72·5 76
prefIXes. 410-411 Scaiflg~s lfI Maya

CIeaIiilg (he
Katma COi\SllolNS (lutOllal 17.10). £1 d

DesVoy<\{).Ieobjec live
KflSJoUlI (Ka.rrrt D Bat sele.c lion Mndles,

(tutorial 16.19), S7S576
Socl<.el ~\), flQ6...807

Creillirlg Ille ~Iive
411-415 slTlOOlhillg, ID?-6J8

(10(0(181 16.18). 573-S 74
KCooeL \mi(, 415-41 7 lfrtains

Cre.at \l\g Ihe
S<HIng'e. 418-423 Ack/Illg' ~31.Iof\S

Prorimil~live (lulM
MoI<~ sekdioos (IUIO/lo( lhroogtl DeG()l~(s

~ 1£.2(0),576 17.13).. 618.-619 (Iulorial 5.9),

De.slroyaOteObjeclive, 570, m~alionmelhods 194-1.97

575-576 C~~ I1'106e
pl&i:ing (Deco.l.aye.os),

~llve.S70.
(~). 615-619 151. 192-201

57J.S74 Ob./e£.1 mode (~a),
l/ia.rlgulaii.rtg. 639

or(J.e1 01.577 611-614 USlfl.g 1he Slalus u.-.e

Pro-rirrlilyC)Ote<.l \ve, 5 70 , rnb(e/ials, applying 10
(l~Clial 17.11), 615-616

576 (Kype/sha&).606-600 velllces, averagillg, 639

settW)g' (he ~Ne Oakr
~fO(ing, 6..35-636 O<iG (OG G Vo.rbls) ((Jes, 2S

(l\.Slorial 16.21). S77 ~Mg errO/s. clcan.irlg O-NSAIUci<C,a tlFulory cl,)50S.

SeUIng Up an Ass.ouI( Mati UP. 6-4 ()..64 2 veh Ie Ie type. S 6.2

and Crealing a.tI mll\{emeN Ulol\l. rol via Q.NS~acl(}/ yfado.ry

CtlIectrve (Ivlooa) pnys ics engil'le, 13 clas.s, velolde type, 56~

16.17),Sn573 MovUlg OOjec.ls III Maya Q.NS tk>verCratl facIo ry cIas.s,

Trigge(~clive. (Wlonal 17 .8).611-612 venlcle Iyj)e, 562

570-573

H{}w can we make lhis lode)! more usefUl? fmail os .Ill Inde)(eo,@,samspubl,shing.CDffi



934

Onslaught gamatype. 10 vehfCle placement. oUldoor trill PS. dl~lance log.

Adding felepo,{ Pods 562·564 addlng.S33-S:}4

(IutOflal 1&_15).566 weapon locke, <X1d/llons. Ovetlapplng UVS (tuto,1 BI

Adding furrets (tutonal 56-4·565 19.6}.671-67'.2

16.13). 564 ONSMASFactolY class. vehicle

Adding Weapon lockers type, Sl)3

(lul{)roal 16_11\), 564-565 ONS?RVFactory class, vehicle

alternallVe map links., l)'j)e,563 P
561·562 ONSSRIJFaclo-ry class, vehicle

Creallng Alternative Unk lype, SS3

Setups (lutonal 16.11), ONSTankFactory class, vehicle packages

561·562 type, 563 animation. 21

Creal"'! '''e Link Designer Opacity map (shaders). 287 ilssets, 17-1,9

(or Yoor Level (tutorie I Operation option (Appena 10 s.oundS, 1~

16_16), 566-568 Polygon tool), 632 sUltie meshes. 101-103

aesogn cons,derat,ons, Operation option (Create 3e1s mall.. 20
568·569 Polygon tool). 630 Maya. 20

#

Linklf\g Power Nodes optimizing terrains, selecting (SialIC Mesh
(tulorLtlI 16_10). 559-561 TerrainSeetorSlze properr". browser). 93

map comOOr'lents. 534-535
_UkJt file elC\enslon. 17-18

556-557 orient conslrail\l!>. 804 paint appll~riol\S

picture of level (link Orientation Sub Action, 2D
Des.gner). 566-568 4900492

Corel ~ll\ler. 25
PlaCing Power Cores and Inserting Sub AClions

Power Nodes (tutollal (tlllorial 13.5). 491-492
f'howsr.op, 25

16.9).558-559 3D
methods

Plac,ng VehICles (tulonal Dolly. 491
Deep C/'Iaf3cter. 25

16.121.562-564 Deep ~if\{ 30. 25
f'ace?i'lth. 491

power cOle placement,
Inleroolate. 491

Ptllnt Skin Weights 1001. Joints.

558-559 Influence adJu~fmen!S.

LOOkA<AClOI. 491 76j...7615power node

links. 559-561
origin polygol\S (SS?). dlSw f'alnt 1001 (Terra,n Genelalor),

ordel, 106-109 174
placemenl, 558-559

orlglns. shl9»E' comf>Qnen' (20 te>:tu/e laye/s, e<tll,'ng, 18B
purpDse of game. 556

Sh3~ Edlto/). 129
lelepor ( pad acld" ;OflS,

PanDlreC1lon ptOpei't)'.
Ollnoglaphlc ."Iewporl (Maya). 291·292S66 navigation 0l>6lallon5. 65.

IU"el, 3d<J1';()f\s. 56A 594
Panlbte property, 292



Photoshop

parent constreints, 804 s{artlng shapes, ()ynamlc Ligh' mode.

parenting skeletal systems, 371-372 241-242

754-756 lexlure SUbdlVision lightIng Only mode, 242

loot JClrll s. 756· 757 Plcceilles, 375·377 n<Mgatloo C04"\IrOls, 64-65.

Pelrtkle eHecls. 359 lime properties, 367 358 594

Cleatlon Pfocess, 36<J.361 Unreal Tournamenl 2004 Radii View mode. 242-243

emiller \'tPes e'l:21mple. 3uO TelCtured mode, 242

Beam, 361, .189-395 parllc.ll!-Si a~ lighl surlue, 250 PhatOSMp

DrawStyle Ie'l: tUfeS, passageways lor hangars, 2D painting. 25

3&-4-365 85-93 Bellil lex/O(es. cleating,

Mesh, 361, .J8 7-38-8 P~HhNode Actor, bot navLga- 275

Spark, 361, 382·386
lion. 442-447 AJlgniog Images in

Sprite, 361-382
palhs Poolcshop {or Character

Trail, 361, 3~6·397
OOIS Modeling (lOlOl'ial 21..1),

adVanceOl\C'Vlgation, 728·730
lire effects

461-464 Ch<lnnels paletie. 274
Adding Smoke 10 the

jump sPOtS, 450-455 Calcr 8-alance dialog bo)(, ~

File ItulOrial 10.7),

J80-382 .lumpc(lg 0010 a Sleep 2B

Cleating Fire (lutorial
Ledge (tuletial 12.2), CalC( Table dialog ooll,

10,6),377·380
451-453 275

spin prcperl\es,
Using ASs.:\ullPaths Curves dialog 00'1., 272

379-380
(tulollal 12.8). E)(portJrtg Yoor l.Ns inlo
462-464 Pholcshop (WIO/'ial

sleam effects, Cl'eaWIg

(SpriLeEmitter), 365-369
vehicle n3vlg3ticn, 466 19.4).669

leleporlec effects
colC/' coded Ilavlgation, 11"\Cle)(e<:\ Colol dialog box,

443 275
Add lhe Fmal Touches

to the Teleporle(
Pausing and Cutting tutoria I Layers palene, 273·27"

Effec\ (Iutotial 10,5),
(13.4). 4B8-489 New dialog 00'1., 272

374-377 PC-x formM, t"'~lurP Irnport lextores

colQ.(s.373-374
lonnal. 270 creating, 271·274

creallng ($prileEmlt1er),
Perspec\l\Ie viewport (Maya), soorces, 19

369·373
593

speed of. 374
camera locus, 595

Slartlng locotiOfls, 371
diSplay modes

Depth C<lmplexlty. 536

Zone/Portal view, 535

How cafl we make Ihis ifldel( more useful? Email usalindex-es@samspublrsfllng.com
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936 physics engine

- -- - --

ptlyslcs engi ne. fu nction of, 13

Physlcs\lolume ly~e. 206

Creal\t'\g a $hppery Roor

illJlorial 6, 3). ~15-217

~roperlias, 215-217

TemllnaNelOClt'l. 217-218

wafer·related.21&219

USing the TerminaIVe)oclly

Propeny ([1)10/131 6.4 l.

217-218

pICkUps in Dalchmillch game

rype

adding, 544·546

xPicl(upBase classes,

544-545

pillars

ere aling (2 () Sllape Edllor),

137-138

rooms. cons IrUCtli"\g.

105·106

pla~ahle AClOrs, 51

examples. 52

versus non-pl3ceabl€

Actors. 52

Placlng Power Cores 3r'1d

Power N~es for Onslaughl

<lUiorlar 16.9}, 5580559

Placing the Dc.or (Iulorlal 9.1),

318-319

Placing lh e Ne \\I Ele vator

Control Panel (tutorIal 9.10).

337-338

PLaclng Vehlc\e~ fo, Onslaught

(lutorlal 16.12). 562-&64

plansr mapping (Ws), 664

Play Level button (UnlellIEd).

850

players

Assault gametype

Eslabhshll"lg Player

Spawfl Pe>I/1tS (Iutorial

16.22).578

Hooking It All Up (WIDr

ral 16,24). 580-582

Set1ll'lg Up

P~~al\agers

(IvIMal 16 23),

578-579

SJ)awn managers.

578-582

spawn pQu"lIS. 578

jump jXlds. adding 10 lev

els, 349·352

oelspecilVe de\lelopmenl.

32·34

SL'lfl arlows in rooms.

adoHlg,7&-77

teleoort ers

adding 10 I~vels.

353-354

random, crealing.

354-355

PlayerSpawnManagels AClC>l.

Assaull gametype. 578-579

P1ayerSiarts Actol. Captore

lhe flag garnerype, 543

Ad)IJSlrl'lg Player$lalls

Aclor fer CiF [Iulorlal

16.4).550

playIng tl<ln~Ilon81 movies

dunng level ctlanges

(MaUnee), 501·504

poInt COl\5lrlllnlS, a04

pole vedor conslralnls. 804

Poly Coonl system, polygonlll

mooellng.626

Polygon Cleanup OptIons dIa

log box, 640

lion mani(e>\c/ geometry

option, 641

remove geomelry e>pllon.

642

Tess.elJa!e Geomel;y

OJ)IIOr'\. 64 ()...6 41

pOlyg'Ol1 treal16fl meltlod.

624-625. 6.28-630

~olygQ{l modeling, 622

3veraglng verOces. 639

B-oolean operations.

6).4.635

box method. 624 '

Ch,3mlerlflg aM Beveling

(tulollal 18 11). 648-649

Co.ntfoll(ng Hard Eeges

((Ulorlal 18.16).656

Controlling Surlace

Normals (luI ()Hal 18,151,

654-655

Create Polygon 1001 {Maya}

Keep Faces logelhef

OpliOfl. 625--626

Keep New faUls PI3nar

e>pliol). 62~26

erliimg tools (Maya)

Chamfer Verlex,

648-649

CUi faces. 649--650

E)(ulXle face. 645-647

bulXle Vertex, 648

Flip lrll:lngte Edge. 653

Merge Ver1eK, 652~53



How Ci!Jn we moke /hls in£1ey m~;{e useful? Emol/us al inde'J'es@sofns(jubJl5,r.lng.C6m

Nounols. 65 4-6S6 P<>IYg()llS Fteehand Polygoo Dr&wl.ng

S~ ~0fI.. 64J.64 4 2D Shape £d/\Of Looi, blU~h ue&1 i().n,

SuMNid.e. 6-42-643 Bezi~ segmel'll.s. DS-127

Wedge Faces. 6SO-6S1 131·132 rnD~ook,creDlV'lg

errOfS. deMW'tg 0\), brush crea\lon, via ~an aoeraOoos.,

640-642 127·128 634-635

M1lkiog ~oe Ext/usions meoo hal, 128 oOfUlS

(IlJla.nal 18.9), 645-64 7 st\ape~s,
averog"'og vellices. 6.19

ilWrMng.6.3S-6.3S 12<J comblINng,632-633

PUy Coonl system, 626 shape d.elB-Ms, 130 eI/Of cle;l00j). 64 (}.64 .2

potygoos shape processes, rrWlOilng. 635-£36

~ la e'risIilIg. 1.33-135 smoolhing, 63 7-6Ja

63()..632 (~a.r, .128 lriangv~j()(l, 639

~OOjeC1s, VseI inler1"ace OVeNIeW. sp~lf~, 6-43-64 4

632·6~ 128 .s~&,642-M3

ereal iorl me.th<:x1. II'iewpor1s,128 venices.115

624-625, 6.2e..6.)() a.d6Ing 1.0 exisIir.g po«f- edWlrlg', 116

sm6Ol.hlng, 63 7-63a g~, 630.632
P~go.n3 menu (Maya)

S()Wn ir>g Polygotl So (Iuto-ri a-I Brush elij.)j)U\,!! mode. Average Venices rom-
~B.e), 64~4-4 118-125 rN\M,6.19

surla.c e 1\Cl(ma!s, di So play SSP Cleanup convn.Md.
k\g (Maya), 627-628 llt\es (1\o()I ~fs)., 64()-642

lfia.rIgu(e(io.n. 6.19 109-110
Mi)--{f)8\"\Wold ge.o.meIry

Usiflg 1M Cut Faces Tool negatIVe side. 107 ~Ioos. 641

(Lo.LQria) 18.12),64~ Of1gir., loa-1M T6ffiQVe gellrne\ ry

Using the Mei'ge V~\e~ poSll.ive sloe, 107 £>.PI1a.ns, &4.2

Coovrul/'ld (L uto.riaJ trees, 107·.108 lessellele Geomeuy
18.14), 652-653 llees, creating, CJi)1 iOOs. 64<)..641

Using the SubdMOe Tool 108-110 Smoolh COOVMf)£l",

(LVW!a-I 18.7), &42-643 edges. 115 637-6..3.B

Usirlg the~e Face. e:.1 fUdj,og. &45--64-B &pon.em~ D-Ig'on<tvn,
CooYnand (lulOliaf

(ace GIOggiI'og, 11a 637-63fl
18.1.3).650-651 Lil\Ul algGriltvn. 6.38(DeeS,11S

Velte\( Erl rvsJoos (WI Of1al Tloogulate comrM-rod, 6.J9
18.10). 6-4B

..---------------------------------,--
Pa\ygon8 menu 937
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portra"s 01 cnalaClel~. cleal·

iog.777·779

pobe-tD-ilose MI malton, 8"26

f>o~ltlonll)g Slusll~ aM

AC101S In 20 an<l 3D (Iutorlal

3.1).~6

positive dfle-<:l/Ons on 3D axes.,

5&57

posl\lve sides 101 polygons

(SSP). 107

POV Sub Actlon, 490

power Calef> (01 Onsla ugh(

gamelype, plaument of,

558·559

pawel nodes 101 o/IS10 ugtll

gemetype

linking. 559·561

placement 01, 558-:>59

pre-production stage of game

development, 30

Ideas re(lnement 39-40

player's pe:rspecuve, 32·34

sales C)ltch, ~4

scheClvle creaLion, 40

stOiles, 30-32

leam (orma\ion, 35-.39

Prefab bro~er, 885

bunons, 885-886

menus, 8B6-BB7

prellle~. K.:lrrn a C<llll~ Ion

Primitives. 41Q...411

primilil/e modeling. 622

prImitives (palygo/'lsl

Examl/'llng UV layouts

(tutorial 19.11. 658-559

UV layouts

CleatiO/'l gUidelines,

678-£80

VIeWing, 658-659

PII>CeSS loolnar (2D S1'lape

Editor). 133

Revolve, 134·135

Shee\. 134

produclJon stage of game

development

asse! integration, 41-42

sche1:lule Delays, 41

schedule maintenance, 41

plogrammels, team mernl>ef

respOI'ISlbnilles, 37

The "rogre~ Bar (lutor/al

9.D), 345, 348-349

pro~ct managelS, leem mem

bel le5po/lslbililles. 37

projectiles.

HltSunS(ocklngVolume type,

207

ProJectors, 235

creatJrlg. 261·262

(unC\lon ai, 260

non-square. creilllng,

262·264

uses, 260

plOpenies

g.amelype leve Is. se \tm!il,

542·543

KAclOl. 404 -t\ 10

hghUfIg. 23.4

bDlrew0f\3l, 235-236,

239-240

ligh\Cokll. 234-235

llghtRad'us, 235

L'ghlType, 235

Propellies for Plimilives win·

dow (UnreaIEd), 55

properlV windows (Unreel Ed),

896

AcIOf' }>rO()el\IeS, 896

Svrface Properlies. 897

Ahgnmen\ lab. 899

Flags lab. 897898

Pan/RoV~ale lab,

898

UwealEd usel Interface

(UI)

Actor Properties. 54

Build OptIOns, 55

Camera Properties, 54

PrQPeI\les (or

Pnmltives, 55

Su rface ProoertH~s, 54,

72-74

ploSCIl~d paths lor bot navl·

gatlon, 443-444

ProxJmltyOb~tJve,Assault

gametype, 570,576



RoadP<rlhN()(\es 939

Q-R rebuilding li~LS, :245-246 lender mode cof\Soole com-

ch anged seuJf\gs, mands, 538

246-247 rendering
Quad modeling, 622

rebuilding process tor lel/el~ ophmlzanoo via

bese geomelry, 50 AnlJponals. 528·531
RadII View mode (Pe r~IIYe rec!ultlng team members s~ee~s, check/debug

vlewpor!). 242·243
capablhly evaluallon, 38 mooes, 535-539

Ragdalls
com"ahbil\\y cnlena, 39 Rendering menu set (Maya).

rilaraclers, con(lgunng
compensation cnleria. 39 5%

(KAT). 4.13-439
employee handling. 39 replic.alion, client server com-

Creaung Ragdo((s lufo·ltal munlc.allon (I(3rma physIcs

(11 7). 423-425 prC(le r atlllooes, 38
engine), 402

I<arma Aulhormg Tool role oounoanes, 38
,~Iullon of drag grIds. COll-

(KAT), 425·426 schedules, 39 1,01 poInts. 60-62

I<arma physICS engitle selectlOl) wl.eri<l, 3B Rev/ewJu mpSpot.s commatld

treaUl)g, 423-425 Redo opllons [looIDaI}, 8409 (console), 449

deaV'l effecls, 401, RedSlloot$pol Aclor, Bombing ReI/ollie process (Process

423 Run gamelype, 555 Toolbar). 134-135

Skeletons, 423 reflective sur1aces Revolving wilh lhe 20 Shalla

weapons, 402 Cooemaps Edllor (lUlo/ial 4.10),

Sethng up a Chorocler in Creallng lhe Col>emap 134-135

KAT (lutMal 11.111. <h>lonol 8.11),303 Algid Bind. skeleton ~\dI'\5,

433-439 Resizing Screensnols 7f>1

ramp catwalks, sIalic meshes, (tlllOOa) B,10\. rigs (ellarecter al'llmallon),

cre Bllng, 706-708 301·302 808

random conditions, aello1lS Taking the Cubemap Crealing Ihe Splr.e and

(Sc/lOleoSeQuence Actor), SCfeenshots (tutorial FinisNng the Rig

52Q.S21 8.9),298-.300 (23.13). 822-825

randOO'lIZed lerralllS, Cteal'l\g matenals, creating, lhe Arms (23.12),

(Terrain Generator). 156-157 ~6-30S 81f>.B22

Range SHdet (Maya). B04 TexEnvMaps. Cleating Ine The legs (23 11).

reactive a"imallo11
TexEnvMap (totonal 808-816

D'iver. anrlbl)les, 792
8.12).304-305 ripples 111 water areas. adding,

Set Driven Key (SDK),
releas.e stage of game devel· 224

USing Maya's Sel Drwen
opmen!.44 rmode command, 5JS

Key (SOl<) (lolooal 23.3). RememllcrSpol command Roadf'aIItNodes, b<lt venicles,

193·795 (ccl\Wle), 450 466

HllW ea'l we make [niS Index more useful? EmaIl us al tfIdexes@samspu"(lsr,lng.eom



rooms _

r~

cleallng (2D Shape

Editer), 136-137

CIe<lhOfl process,S7

bruSh order. 64

brush pwat, 63

brush lyceS, 62-63

naviga lion coolrol,

64-65

scale issues. 58·62

levels. Implementing func

tionality, 74·77

lighting etfeC{s, adding,

74-76

plllars, Cfealing 120 Shape

EOllor).137·138

player start arrows,

adding, 76·77

5ublracling aul. 58

textlJres

adding. 69, 71

fltling, 72-7-4

wmdOws, creating. 78-79,

81

rool joints in skelelolls. par·

enllng hierarchy, 750.757

Ratille Plane It< Solvers

Creallng a Rotale Plane lK

Solver (Iutorial 23.7).

801·802

loinl 3 I"Ilmatioo, B01·802

ROlation Angle option

(Append \0 Polygon \~I),

&32

rotation points

joints, local axes. 757-759

sl<eleIOl'ls. 754

s

s..al~ pllth tor game develop.

ment, 34

savlng btu!ohes, i44

scale

aes\/letlCS 01, 59- 50

Callis\onHeighl P(Opefty,

58

Collis lOI\ROOlliS p<operty,

58

gnds. snapping to. 60-62

perspective establish-

men\. 58

scale constralnls. 804

stellng joints. 761

Scaling L1gllLS In a level

(tUlonel 7_7), 251-252

scanl\log Image planes. thar·

acle/ modeling, 728-730

SCene Managvs (lI1atlnee)

Aclions

coIf)( indica tOfs. 472

interpolatioo points,

469

monaging. 469

Sub AClfOns, 469

Attors, moving. 494·496

camera paths, <170-471

Ofdenng of scenes. 472

DfOperties, 472, 479-480

sequence overview. 469

Scenes tab (Matinee)

Actions, colO! \ttdicalOiS.

472

arDe/lng 01 s.cenes, 472

properties, 472

schedu les fO( game develo-l>-

ment

creating. 40

delays, 41

mainlLlining, 41

scripted seQuences

AClions lisi. 506, 519-521

lalent, 506, 511-514

flon·l<!lent. 506·51<1

crealion overview,

505-506 ~

InLra ITIlMeS, CfeaLlI'lg

(Matmee).517·518

oon-player characters

(N~s)

COfllrolltflg, 514·516

Controlling a Pawn

(tulorial 14.2),

514-516

Using a $cllpledTrigger

(lutortal 14.1). 51.2-514

Scripted~quel\(e ActO(,

505-506

ACllons list. 506

latent, 506,511·512

logical condl\I()f)S.

519-520

non-latent, 506-511

random Con<.liI\OIlS,

52Q.S21
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Using If Cono,tlo1\S (tU{Otl- Selections and Mo...emenl Cleatong a Shader (Iutonal

al 14.4). 519-520 area (toolbox), 864 8.4). 282·283

USing RllOOom COMIl)oos C\l311ge Camera Speed. detaIL propertIes. 287

(Monal 14 .5}. 52l>-S21 865 maps. 282

X?3WflS. 514-516 Hide Selected Actors. 865 Opacity map. 287

Scllpted'Tek!\ue materlal, Invell $eleCl!(){\, 865 Self·lllumlnatlOn maps,

3D7·318 Show All ~tors, 865 287

Cieal'lIfl a Sewnry Show selected Actors Setting U0 the Dlfluse
Camera {tulollal 8.14J. ()(It)'. 864 Mao (Iutor,al 8.5).

308-311 SeIt·lIlumlna1lon maps 2tl3-284

Improving (jIf: Secunty (shadeIS). 287 Sloe Plope,LJes. 287

Camela (tuIO"al 8.15). seml-SOllCl brushes, aUnbul~ specular\ry. 282- 285
311-316 of,142·143 mask OiDPelly.

Seripted"l'rigger Actor sequences 285-287
ACIIOOS IIS1

A BasIC Mallnee 5eQuer>ee lal<mg Advantage of the
lalenl. 512-514 (tutollal 13 1). 475-479 Speculal\tyMask f'loperry

non-laler,\, 512·514 ~reallng (Mall/',ee), (1u10I\af B.7), 285-287

Assault gametype 474-480 ShadIng Group node (Maya),

r,eces sa ry aCllons . Estatlll Sl\lflg a Tligger 587

580-582 (lute/lal 13.2}, 481-482 shadOWS

player spawr, 1oc311(){\ lauflchlng (Mallnee}. comt)ln,ng with fighl maos,

switCl'uflg. S8l>-S82 480-482 232

elevalors Matinee r:Nervlf:w. 469 Plecalculated nil/ute of,

complex behaVIors, Set OrlW!fl Key {Sffi<), reaC1tve 232

329-334 animation (lulDllal 23_3), snarp, overuse of, 266

door behaviors, 792·795 shapes (20 Shape Edilor}

336-337 Setting Up the Elevator Door 8tlZler segmenls, 131·)32

movies, auto-faooching, (lutorllli 9.9), 336-337 cDffipone nts. 129
500501 Setting Up View Screens lor delalls. 130

scwbblng IImellnes. 6a~4 crt (llIIorlal 18.5). 550-551
ger.erat\ng.127-128

Search (or Actors WIndow shaders, 269
Shaping Vour Own Landscapes

rUn/eaIEd), 895 Adding the Specular Map (tulortal 5.B), 177·183
~Iectlon handles (objects). (W[ollal 8.6). 284-285

Sharp node (Maya). 587
8{)6.807 bler.ding propefl\es, 288

Sheet plocess (Proces5
colors, selec1ing, 283-284 Tooloar), 134
creating. 282·283

----------
Sheet process-- -----------------



Sheel80ilder (87l1sh Primitives oones,756-757 Smoolh Binding a

area), a57...aS8 coUisloo geometry (KAT), Simple Model (tutorial

SheelSvilder dia~g box (Zone 438 22_3), 761·76-3

Portals brushh S~S fl.lnclioo of. 75 .. weight adjustments,

Shelf (Maya) importing, 767· 7DB 769-770

Creallng and Editing Importing 3 Skeletol\ (lute- Skinning a Character (lute-

Shelves (tutorial 17,2), rial 22.5), 7£7·768 rfal 22.6), 768

598-599 joml hffi4'IS (KAT), 438 sS<IMiflg

labs,59B ,jolnl tyoes (KAT), 437 Adjusting the Sl<if\ Weights

StlieldCharger dass,
jolfl\S

(Morral 22,7), 769-770

DeaOlmateh gBmetyp.e, 544
Adjusting Joinls

skeletons, 754, 768

SllowAI command {co.nsole}, Through MOiling (tutl>- character exports,

449 ,;al 22.2), 760-761 771-772

ShowOebug commend (eof\- creating (Joint tool), Paint Skin Welghls

sole), 449 758-759 tool, 7£3-766

sh,inkil1g sp.here anlmalion Creatmg Joints with the RIgId 8irxl, 761

Iulorlal. 79~-79S Joinl Tool flulO1ial Smooth Blnding~a

side p/operUes (~aders), 2B7 22.1), 758-759 Simple MoDel (tutorial

Single Chain IX S<>tvers influences, 703· 7BO 22.3), 761-763

joln\ animaUon, 800-801 local ,o/alion axes, weigtlt adjustments,

Setting Angle CI1 Joints 757·759 76~770

(1U1Maf 23,6), B0Q.801 moving, 760-761 SkyOOx~

sl21ng te"ains, heighl maps patenting hierarchy, Enhancing the Look of Our

(Terrain Info Actor), 149-j.50 754-757 Terrain by Adding 11

SkaarJ, LISe of Unreal £nglne, scaling, 761
Sl<ybox (Monal 5 _5),

8 162·166
Using the Paint Skio

sunlightskeletons Weights tool (tuloriaI

arm joinl animation 22.4), 765-766 adding, 236-237

Animating Joints With Ragdolfs (Karma), custom creating, 237·239

f}( (tutorial 23.4), creation, 423 terrains

796·798 lol.ation points, 754 creation methods.

Ammating jOints with skinning. 754, 768 160-166

IK (tulorial 23.5), Character exports, example of, 159-160

798-799 771·772 tunclloo 01, 159

Rigid 8\n<!, 761

Smoolfl Bino, 7£1-76-3

9d2 SlleetBulide r
----- -------------
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Sl<y2011elnfo Actor, 16G-16f>

slippely floors, creating (lVlon

al 6_3),215-217

Smooth 81nd

seiling'S. 762· 763

skelelon Skms, 761

Smoolh Binding a Simple

Model f!uI()rtal 22.3).

761-763

Smooln Shaded view mode

(Maya\, 593

smOOlhing objects, 637-638

Smoothing lool (Terrain

Genetal or), 174

\e~\ure layers, edlling. 187

snapping g,\1I. scale ronlrols.

60-€2

sniping points (boIS), 4S4-46S

SnlplngVolume rype. 206

SoakB;J{s command (console),

4.50

soft edges. 623

solid brushes

crea\'ng SSP cuts.

139·141

properties of. 139

Sound bto\YSet. 879

buttcns. 880

menus, 880-881

sound engme (Unreal Engine}.

13

Sound FOtge audio {oof. 25

sounds, ,wax file extension. 19

------... _... _._-

Sp.arKEmlttel,361

Creating Fireworks (lutonal

108), 383-385

Making the ~rt,des

RespoM (D Cclhsions

j;utonal lO.9}, 385-386

properlles, 382·383

spawn POints. ASSClul! game

rype, 578

SpeCtllar map, shader~

adding. 284-285

spectJlarily {sheders), 282

SpacularltyMask properry.

285-287

spheres

hata edges, 623

soft edges. 623

SolralSI all Bullde r (Srusl'>

Primitives area). 855-856

spline langent in keyframe

anlmallof\. 785

Sp-li{ Polygon 1001

Ma~e{ Tolerance ootion.
644

Number of Magnets

(1)\'01'1,644

Snap 10 Edge oPliM, 644

Snap II) MagnelS ODliM.

644

SubdiviSIOns oplion, 644

Spill Polygon lool (Maya).

643-644

splllllng mO<leling. 622

splllting polygon~ 643-644

spolUghls, UsIng Spolllgtus

luta-rlal (7.3), 23~240

Static Mesh blowser

sptln~ C,ealJng a Calapoll

(Iulorial ii,S). 422423

Sp/lleEmlner, 361

Addmg Final T<}uches to

llle Sleam (lulO/ral

10.31.369

Adding lhe F,nal Touches

10 lhe Telepoller Effeci

([uIOnal 10 S). 374 377

Adding Smoke 10 lhe fire

(lIJIOn<l1 10.7). 3.80·382

Creating F"e pUlarial

10.6). 377-380

Cleating and Selll,,€ Up

YOO( Emitter (luIOlial

10,1),362·365

Ctealing lhe Sleam (luIOIi. ,

0110.2),365·368

Crealing a lelePO/ler

(Heel (Monal 10.4>.

369-373

sIal I allow In looms. addlf)g.

76-77

slat all command. 539

Sial hardware command. 539

Slat none rommand. 539

SliH relloel commancl, 539

sf at/t: lights. Shadow behavlol.

233

Slatlc Mesh browser. 887

bUllonS,8-87-B88

mef)us.8BB-B90

meSh p.acl<ages. 93

meshes

decorating, 101-103

packages. 93

placing, 94-100

943



944 statIc meahes
-- ----..-----

static meshes Creating Ihe Placeholder Modeling the OOOegree

3ds max package. 20 Tex\Ures (lUloria) 20,10). TUIn, Pari iii (tUlorlal

Addlflg Braces to the 701-702 20.1n 713-714

Anchor (tuterial 20,6). Creatl{\g lhe Rail Supports Modeling the floor o{ lhe

694-696 for Ca\wall<, Part I (lutOfi- Catwalk (tul()(jal 20.3).

Applying Texlures to Stalle al 20-7), £97--698 685·689

Mesl"les (I111()(\a( 20.22), Creating the Rail Supports particles as hghllng SOl-

721-723 for catwalk, Part II (lutor- (ace. 250

Applying the Placeholder lal 20,8). £98-700 Prepallng lhe

Textures \0 lhe Crealing /:t)e RampCatwalk StraightCalwalk {or

StraightCatwalk (tutortal (lvtorial 20.14), 706- 708 Exoor{ (lulOl'lal 20_13),

20,12). 704-705 Clealing the 706

8uildir-,g the Handrails for Slr31g/)tCatwalk (lulorial Dfojecls. creating. f>84

Catwalk (lU\OIla( 20.41. 20.11).703 Setting Up /:t)e Glid (hJt()(i-

690-692 Cleating the T~ntelsec{fon a( 20.1). 6.82-6.83

BUIlding the Support Catwalk (Monal 20.18). Setting Up ¥wr Project. (or

Anchor fOf Calwalk (Iut()(- 714-716 Stallc Meshes (tlItol1aI

ial 20.5),692-694 dice mOdel 20,2),684

calwalk models overlapping UVs. l.eXlures. applying,

base lype, 685-702 671-672 721-723

coliiSIO/'lS, 718-720 UV layout. 6£5-668 USIng C<>nslruction History

e~porting to UnrelllEd, E~portlng Static Meshes 10 FIX the SUppOrts

720-721 {(om Maya into UnrealEl! (tL>\()(Ial 20.9). 7()()'701

four-way intersection flulorlal 20.21). 720- 721 versus world geomel/y.

type, 717 function of, 681-682 computer Over'l\eOd, 682

ramp t~, 706-708 gods. odjust1ng, 6.82,M3 vertex locations, slorage

Slralght type. 703·706 levels of,681-682

T-1l)lers~tiOI1 Iype, adding. 93-100 stalistics console commands

714-716 oecorallve lreatmeots. Slat aU, 539

turn type, 708· 714 101-103 slat hardware, 539

computer performance 1XIpolat ion. 10 Slat none. 539

Issues, 20 Maya package, 20 slat render, 539

Creating a ColiisiO/'l Model Model\ng Ihe 9O-Degree Slatus Line (Maya)

for the StraightCalWalk lur11. Part I (Morial Ulmponents. 597

(lI.l1011al 20.20), 718·720 20.15),708·710 COOStructfon History

Creahf\g the foor-Way Modeling the SO-Degree OOllons. 597

lnterseclloo Catwalk lLYn. ParI [) (LOIOIial rile tlUlIons, 597
(tutorial 20.191. 717 20.16).710-713 Inpot box, 597
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Menu Set drop-doWTl

lise 597

Rendering options, 597

~echon Mas!<, 597

Selection Mode, 597

SIdebar buttons, 597

SnapillOg buttons, 597

expanding,tcollapsing

options, 598

steam eHeets, creating

(SpriteEmitler). 365-359

stepped tangent In keyframe

animatioo, 785

stolles, plot development.

Jo-J.2

stralgJlt calwalks, stallc mesh

es

collisioo models, 718-720

creal/{'ll, 703-706

Sub Actions

Inserting Sub Acllons

(MOllal 13.5), 491·492

Matinee, <1.90

Camera Effec:. 490

Camera Shake, 490

Fade, 490, 493-494

Game Speed, 490

Orlentallon, 490·492

POV, 490

SCene Speed, 490

Trigger, 490

properties, 4 73

Subdivide tOD-! (Maya), Using

t/le Subdivide Tool (tulorial

lB,7},842..643

sulxl-iv1<jlng polygons, 642~-4 J

SubdIVisions opHon (Create

Polygon t~ll, &30

subtr8ciing room~ 68

Subtracting a Simple Room

(lulorlal J.2), 68

StJ blractive blUstles, 63

CllbeBuiloer Dialog box

opllons, 68

(UfIC(1Q.I) 01, 63

subt ractive level c,eatk)n,

48-49

sunlight

skyboxes

creating (t\JIOlial 7.1),

236-237

creatmg (tl,)\orial 7,2),

237·239

terraIr\S, adding (Svnhght

Actor), 157·159

velSllS normal lighl scene,

235·236

SuperHeaHItChalgel claAS,

Dealhmatcn gametype, 544

SuperShieldChargel class,
Oeathmatch gllmelype, 545

~ur1ace nermals, 623

controllillg, 654-656

di6j.)laylng (Maya),

627-628

DIsplayIng Surlace
Normals in Maya (lutorial

18.1),627-628

Surface Plo~ltleswindow,

897

Alignment tab, 899

Rags tab, 8~7-B98

Pan/Rot/Scale tab, 898

team..!l lor game dell 91 open ant 945

Surface PropertIes window

(UnleaIEd), S4

texture htling, 72·74

surfaces

adJuS1lng. 654-655

IlIumi(\ation options.

252-253

IighlH'og

meshes. 249

Movers, 249

panicles, 250

static meshes, 24$

tert3ln. 249

world geornelry, 248

water areas, adding,

221-223

T

T-lntersecHon catwalks, sIalic

meshes, creeti ng, 714-716

tangents, al\imahon eurlles,

7B5-7fl6

Targa 100mat (.TGA). texture

lmj)Ollallon, .270

Team Deathmatch gametype

flag limits, 543

pVrpose of game, 543

teams (or game development,

35

animatols,37

concept artists, 35

creature seluo lechn~

Clans, 37



te&m.6 to, game development

level designe<s. 36

member recruitment

38-39

modelers, 36

IXogrammers/cOOers.37

IXOjecl managers, 37

texture arusts, 36

web designels, 37

lear<lH menus (Maya), Using

Tear-ofj Menus (tutorial

i7.il.596

telepoll pads. adding in

Ons(aug~ gametype, 566

relepollelS

Creating a Rar.dom

Telepo.rle< (lulcrial 9.16).

354-355

effects

Add the final Touches

to the Teleponer

Eifecl (tuiOfial 10.5),

374-377

colors, 373.-374

cleahng (SpriteEmitter).

36~373

speed 0(, 374

st<lIling locations. 371

starling shapes.

371·372

teIClure subd\visioo

properties, 375-377

(Ur.cIlOIl el, 353-3511

pads, adding in Of'ls)augtll

gametype, 566

random. 354-355

Setllng up a Simple

Teleporter (tutorial 9.15),

353-354

TermlnalVek>G.!ty propelf}(

Physic.sVe>lume type,

217-218

Terrain Editing brush, 169

adjust valoos, 170

IgMre InviSible (luads.

170

mirroring, 170

Per Tool check box, 169

IMIOS lock, 169

radius sliders, 169

sliellglh, 170

lellatn edIting dialog oox
Brusl'l ophons, 169

adJuSl values, 170

Ignore ,tMscble Quads.

170

mirrOfing, 170

Per tool check box,

169

radius lOCk. 169

radius sliders, 169

strength. 170

Creating a Basic Terrain

Using the Terrain Editing

Dialog (lutorial 5.2),

153·156

edilJJ\g tools, 168-169

height maps options,

Vertex Editing tool,

170-172

Miscellaneous panel, 152

te17ain alteration tools.

151·152

Tools panel, 152

li~ interface. 167

Layers tab. 168

Terrains tab. 167-168

Terrain Generator

Edge fum tool, 177

Flatlen 1001, 176

NOise tool. 175

Paint tool, i 74

Select tool, 173

Smoothing tool, 174

lerralns, randoml2l:·d gen·

eration. 156-157

Visibility 1001, 176 ,

TenalnButider <arush
Prlmilives area}. 857

Terrainlnfo Actor

height map le)(ture.

149-150

foyers, maximum nurroer

of. 150

properties. 185-186

terrain goometry, 149

I~"ajns

20 Texture, heIght maps,

148

Adding Deccratlons

Through DecoLayers

(tutorial 5.9), 194-197

Adding SUnlight {tulorial

5.4).157·159

Adding Tel/olll te Ihe

Skybox (tutorialS. 7),

184·1B5



Tax~ tool 947

area prep.arelioos, EMant iog (he lLlol< C>I Oor S~\, addio'\g($~

152·153 lena.ln t1( AdOWIg a Actor). 157·159

bask: uealiort. 153.-156 $kytlo'i (lu~1 5.5). Tellaootll MAor propef-

C1l1Vil'lg Bases Irw 0 "Ie Ifal{l
162·160 lies. 18.5-1B6

(flJW.Oal 5.11), 200-201 ~1Jk: lesse13l~ 148 le),IUfes

~s layel e<liIlOg (ooIs, 186 editing, 188-192

telroiNr'J<l Actor: Nooe \t)Ol, 187 rnOOIfyIng, iSl·1S2

14&-1SO P'2.in\ 1001, 186 Te:t\Of jog 'lbor Tefl.<) in (hJl.o--

2c:lru!~ fa ActC>l. 14 B SmooU-..itlg 1001, 1B7 rial 5.8). 188,191

Cre.olng .<) 8asic Terrain Te'i F>on lool, 187 Using Co.IC>I Mbps [0

Us iog the Terra (I' ELlil ing le'i ROL'lle ~~, 187 Aajusl Dec.&ayer COOrs

I)jalog (llnorial S.2), Te'i Scale lcol, 188 (llJlor lol 5.10). 197-1~

153.-156 USll'og llIe Terrailllayers
e6\l.Illg, 166. 1 n1BS

~,lSO
6er">era[or (M0ri4/ 5.3).

MigttL maps, 1 7~1 72 1S6-1S7
c!eOO(3\iC>!l objed

vta Edge TIXn 100 plMemell I
Tetralns lab (Terral" fdillng

(!errll'" G.e floe 1"81 or), «()ewLoyvs), 151.
6lalog l)or). 167·1&8

177 192-2-0-4 Te"ainSeCl6rS\le pto.perty. ley·

Ilia FIoHeft I001 (krra\0 deVooing. 1SO
",In ~~lIo.n., 534-S35

GeneralJY), 176
RJnc..00n 0(, 1SO

(e;; ling chanet elS. In-~me

via Noise (00/ (terrain slDl~, 779. 781
ffi2'iimom ntHl'Ihel 01.

GeneraLor), 175
1SO

1~llng nate (t>t ~me devel-

w PllJ(',( 1001 (Te.r raJ,,; I>j)meM

Ge rIef.<)Lor), 174
pmpe~s, 191-192

a\pl\a lesUog, 42·43

IAll Sel=t too/ (Te rrairl
Prepanog' an Area f<)(

beta lesli."og. 4-3.-44
Terra'" (LOl.oriol S.1),

G.ene/llio/j, 173
152-153 leedbac\<",42

via~(ool
rat>domi.le6, C(elll~ Telrahedr6neull4er(a/~

(TefTO-in Geroe /Ol.o(~
(Terraill Genel"8{or). P~ives a/ea), 859.860

174
1S6-157 Tex ?all (601. (e'!'\ure layers,

ilia 1elraMl fdotlng Usel
Sh~YoorOwn

e-dking, 1.B 7
in/er1"bLe, .i67·170

~(l.LJl.()(fal TeI Rolble 100.1, lerfure 13yel~

iiia Visibiloiry 1001 5.6), 177·1A3 eowlng'. 1.87

ITer I'2in Gene rDI or'l.
s~'!'es Telt 5.l:81e 1001, lexlul8 lllye~.

176 ed"1//I'g, aaoreario.n melhods,

160-180

el(ll-InpIe of, tS~160

roocl~ of, 159



948 Tell'En\lMaps . _

TelfEnvMaps Sw1ace category, 280 wbic environment maps

Crealtn,g the TelfEn\lMap Telflure category, (DOS format). 271

(tutorial 8.12), 304-305 280-281 file formats, 27Q.271

reflective sunaces. creal· Texture Opl~fl (Create Polygon 8MP (Windows

ing, 304-305 iool},830 Bitmap), 270

TexOScHlator Modifier, maleri- TelCture PIOpe/tieS wlnd<lw DDS (Direel Draw

als, animatiOft PI~rlies, (Texture ~rowser), 278-279 Surface), 271
29<)·2S1 Animation category, PCX, 270

TexF'anner Modiffer, materials. 279-2BD TGA fTarga) , 270
panning propertie5. 291·292 Matel'lal categOly, 280 UPT (UPaint), 270

TexPan nerTriggere<:t. elevators, Material display bottons. height maps
co.k>r Plogress indicatl>f, 278-279 file (crmals, 149
345.348-349 Surface category, 280 size fOfmula, 149-150

TuRotstOi Mooifiel. mslerisls. TeXlure category. 2Bo-2S1 impoflmg, 270-271,
rotation properties. 292-293

Textured mlKle (Perspective 276-277
TexSClller Modi/ief, melerieLs, Vlewp<llt), 242 ImllOl'ting and U51Ji~ ascale p/opertlcs. 293

Tenured view mode (Maya~ Simple Texture (Iutonal
lext in intra mo~ies, creating 593 8.3), 276-277

(Matinee). 4%-499
telrtUfe5,269 light maps, 232

texture artists. team member
8-bit, creating, 275 mipmaps (ODS format).

responsil>llilles, 36
alpha cMMels. 270 271

Textule browser, B9-71, aa:\.
A~yrng TelClUleS to Stallc Overlapping LNs (Iutollal

bol\ons, 821·882
Meshes itutOfial 20.22). 19.6), £71-672

ImpoH Texture dialog box, 721·723 Preparing an Area for
276--277

Creahng an 8-Oit Texture Terrain (tutorial 5.1),
Alpha properly, 277 (tulcwial 8.2), 275 152·153
Generate Mipmaps Crealing Non-Square rooms

proper ty, 277 Projecto/s (llJl<Xial 7.14). aOding.69-71
Masked properly. 276 262·264 filling. 72· 74

menus. 882--8&4 Creating a Simple WptedTexture material.
Texture PrQpertfes window, Projector (lutorial 7.13), 307·316

278·279 261·262
Creating a Security

Animation categcwy, Creating a Texture In Camera (tlJ\orial
279-280 Photoshop (tutorral 8.1). B.14}. 308.-311

Material category, 2BO 271·274
ImprOVing the security

Matenal DISplay but· creation overview, camera (tulcwlal
Ioos. 278-279 27D-271 8.1S), 311·3:16



too lbo lC 949

seurees Te)(\unllg tne Room (luI on'll SpllarStailBulklel,

PI'IOIDShOP, 19 3,3), 6~71 855-856

UPaiflC 19 TGA torma! (TaIga), tell'ture Tertain8ullder. 857

SlalJC meshes Imporl formal. 270 Tel rahedroo8uikler,

ape\ymg.721-723 Time Slider (Maya), 603 85~860

Applymg Ule time values fOI parllde Volvmel"c8uilde(.859

Placel)olde, Tel(1.[)leS effects, 367-368 Camera afld UlIlIlIes area,

to the StraighlCatwalk t\mellnes 851

(tulOflal 2012), AalonSo, white bal mellea- aQor rolatlon OpllOflS

7G4--70S lor. 473 851

CreatVlg the scrubbing, 6<l3-604 actor scaling Opll005,

Placehoklet Te).wres ,oolbar 851

(lulQ.(lal 20,10\, 20 Sha~ Editor, 128 brush ciiplling options,
701-702 852UnrealEd

surface s. lraflSl1l1 'clng 0lI
browsels, 848 face drag OpllOflS, B52

(PIOjecIOfs), 260 freehand pelygOfl dr;yw.eclllors, 849
terrains log opl!<lns. 852

rIle oplions. 848
area plepara(lons, Mahr.ee DilllOfiS. 852

152-153 Redo options. 848

5ealch fer Actl)(S
movement opliO(\S,

baSlC creaLIOfl. 153·156 851

ecl llll\g.188-192
oPtIOns. 848

terrain editIng OprlOf\S,

mod.lylng. 151-152
Undo OpllcnS. 848

852

Texture Properties wtndow
user II'twiace {U1I. 53

lexture pan ojltions.

(Texlure browser)
IN Te)({ure EdilOJ, 660-662 851

Mlmalion c<'llegcry.
ToolbDI (Maya), 605

1exl ure rot ale opliol',S.

279·280 toolbol (Unreal Ed). &50 852

Matenal calegoty, 280 B,ush Clipping area. 853 venel editing OOlIO/lS,

Surface category, 280 Brush Pnmllives illea, 853 851

Texture calegory, Cone 8 'osh C,ealiQl'l, COOSlluclive SOlid

280·281 85B-B59 Geometry ICSG)

Te~LUlIttg Yo-ur Tellaln Cube8ullder.853·854 Ooelallc>ns area. 860

(IUIOI'la l 5.8), 188-191 CubeS'airBuildel. Add Anti·Pollals com--

,ulX (lie e~er.slon, 19 854-.855 mand,864

UV lay<lulS, creating ('0m, CylindelBuilOeI. 858 Add cc>mmand. 860

668-672 L'nearSI alr8ulldef. Add Mover Brush corn·

Wllume textures (DDS 856-.857 rnal\d. 864

form.at), 271 Sheel8ulloec, 857-858

How Cbf\ we make 1/)/S Index more userul? Email US 31 Jll(1ei<es@SiJms/)ubllslllnll,com



950 toolb<:J x

Add Special 8rush com- Tools menu (main menu tlar~ trlengulatlon 01 P<llygortS. 639

mofld, 861-862 847 Trigger Sub Actlon. 490

Prefabs lXI/IOn. as3 Tool:s tab [Matinee) Triggere-dOblectl~e,~ult

Solidity opoon. 863 LookTargelS. -474 gametype. 5 7ChS 73

A6<1 StatiC Mesh com· Unreal Toumamenl TrlggerUg)'tls, creallng' (tulorlal

mane, B64 ;x)0.3/2004 CNeNleW, 7.12). 257·260

Add VQlume command. 474 Triggers

854 torsos In charaClel mGdeffng. aeuvating . .322

Deintersecl. command, 735-741 Establishing a
861. 8eg,MlfIg the TOIS<) (Iuton· MessageTlrgger (Iutollal

Intersect commarxl, 861 al 21.5). 735-737 9.4). 322-325

Subtract comm.3f1d. 860 Completll'lg \he Torso Malenal$wtlch, elevator CclOl

MlrrOllng anD (lulon,,1 21. B). 740-741 Pfogress jJ)(j\ca tor. 3A1-344

Miscellaneous area. Relining the Torso (tulQnal MalenaITnggel. elevalOf ColI)(

86&-866 21 7), 739-740 p/ogress indicator. :n8-341

SeleClIQIIS and Movement Roughing In lhe Torso MessageTrigger, 322·325

uea, 854 (turoru~1 21.6). 737-738 •
movies, auto·(aur.chlClg

Change Camera Speed. TraliEmiller. 361 (Ma1lr1ee).500S{)1

865 preper(les, 396 ScrlOledTllgger

Hide Selected AClors, USing the !raIIEmine. elevator dools. 136-.13 7
86S (Wtonal 10 13). 397 elevator ODef3I1<1fl.

Irwee{ seli~cllO,i. 865 TransforM node (Maya), 587 329-33d

Show All Actors. B6S trans.Hlona I movle 5 seQuellces. £let IVa ling

Show Selected Actors playing Wllh chan.gmg lev- (Mallne.el, 480-4B2

Only,864 els (Malil'\ee), 501-504 TexP"nnerTriggerecl. elevator

tools settmg up Levet1 (lutor\01 colnr progress Indlc310r,

adding to Shelf (Maya), 13.12).501-503 345. 348-349

59&-599 Settmg up Level2 (l:.Jtnrial UserTr\f',ge,. elevator centrel

assets 13.13), 503-504 panel,337-338

3D appllcaOons. 22 Transport COlIllOls (Maya), 604 uses, J~2

audio. 25 trees, lIolygons (aSP) UseTrlgger

pam! Bpphcaliens. 25 creating, 10&-1.10 eleva! or creat 00.

Unreal execution ellVl- draw OHler. 107·10a 325-327

ronmeot (UCC). 22 Mrrnals.109-110 eJeva(Cl operal/on.

UrvealEd. 21 D<lgln, 10&-109 327-329

removing (rern Shelf (Maya), Illangles. edges. flipping, 653 VlewShal<er, elevatnr

Sg8-S99 tria ngu lar modeling, 6:2:2
je,k\ng, 334-336



______________________________~oria(~

uoublY.il\o<llmg AcJ<jlng a Sunace 10 the APolylng Boolean

00\ oavlgallOf\ Wzler (6,6). 2.21·223 Operal,ol"ls f18.5).

console commands, Adding Tetepon Pads 634-635

449·450 (16.15).566 Apptyil"lg ConSlra'nts 10

Map Chetk clalog box. Adding Terram 10 the OtlJ~LS /2.3.9), 804-806

448-449 SkyOOx (5.7), 184-185 Applying 1M New lexlure

Hall of Murors (HOM) Adding Turrets (16.13), (19.5], 67()'671

el'fecl,49 564 APOly\ng the P1aceholdel

tUin clltwalks, sIalic meshes, Adding Weapoo Loc~ers Textures 10 (fie

ereatlng, 70a. 714 ()6.14},564-565 Sl/3lgl)ICalwall< (20.12).

tUllels. Onslaught gametype, Aading Weapons and 70-4·705

adding, 5£4 Pickups (16.1), 544·546 A~ying TaXlu/es (0 StalIC

tuto/iels Adding a lIiewShel<er
Meshes (20.22),

Adding Animation II) the (9.8), 3.34-336 721·72,)

OOOf (9.2), 319-320 Adjusting JOints Thiough 8asK: Keyframe Al'lImallM

Adding eraces 10 Ihe
Moving (22.2), 760- 761 123.1), 786-788

Anchor (20.n), 694-696 Adjusting Ugh! Map Sizes A 8aslc MatJnee SeQUence.

Adding the Blldge (3.10), (7.6),247-248 (13.1), 475-479

96·:100 Adjusting Player's(a.-ls
Bask PathNodes (12.1),

Adding the COrl!101 Aoom
Actors tor eTF (16.4). 445--447

Window (.1.9), 94-95 550 8egH~(,lIng the Torso

Adding Deco/altOnS AdlUSlJRg [he Custom
(21.5),735-737

Tl'lrougn OecoLayers
Ch(l(acte,'s Prope riles lfl BUIlding (he Elevator (951,

(5,9),194·197 UMealEd (23.191. 325-327

Mdll"l& final Touches to
836-a41 Bolldlng the Handra.ls lor

the Steam (lO.3), 3S9 AdjustIng the Skin WeigtllS Catwal!< 00.4), 690-692

Adding, the final Tauches
(22.7),769-770 Bulldlng Ihe SUPPOI!

10 lfie le!eponer ENecl
AI,gr\lng Images 11'\ AnehO' (or Catwalk

(10.5),374·377 PhOloshop (2:1,1), (20,5),692'694

AdOVlg a Jump Pad \0 ,he
728-730 Camera Path

t-/aI\gar 19.14), 349·352 Arilffi3hflg Joints w,lh FK Enhancernenl (13.3}.

A<:klilll1. Smoke 10 the FV'e
(23.4), 79& 798 482--4BS

(10.7).380-382 Arilffi3l1ng JOlnlS WIth 1)( Camera Pausing and

AddYlg the SpeculDr Map
(235),7%-799 Cohing (13.4), 488-4.89

(a.6).2B4-28S The An(lportal Tag (15. 3}, CaNIng 8ases inlO Terraln

Ad6",g Sunl,giH (5,4),
531·532 {S.1l), 200-201

157-159
Chamfering and 8~{jng

{lS.ll), 648-M9

How tal') we make IlllS tndex more us£:(u/' Email 05al •.tderes@samSDUOlisn;lIl!..com
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9S2 Morl3ls._---- ._--------------------------- _.- ---'-"---'--- --. -- - - _ ..

choalOCler rig~ 1.39- 14"1 CreaHng fledlic BollS

The Arms (23.12), Crealiog a BoL-Nal.1gable (10.11). 391·392

81&822 lift (D, 7). 4S~60 elea/lng a Fa/\ (11.S), 421

Cre<>l.1IIg the Sp.Ihe Mel Cr$allrEg a Ca\aPl-J1 (11.6), Cre~ln.g Fire (10.6),

Fiflish.i.flg me Rig 422'423 ')77~ao

(23.1.3), 822-82S Cle2>l\ont (he Ch&Jule"s Creallng lila fooI·Way

The legs 123.11), P"OtIID-i( (22.10), IrW useelion C3twa-lk

BOB--a16 777·779 (20.19), 717

CA:J(n,ple Ifl\{( the T(){S 0 CreaUng CU~s «)I lhe Crealw-.g lM ~ediVe

(21.8), 74()-7 41 Ar.imariM, Cycle (23.17), (16.l.8),573-574

Coo>plex Bof--Ooo.r 833-a3S Creallng' atI kle O{cIe

lllteiaClioo (12 6), 45-8 CfeO-llrg a ~is~ M<ldel (2.3.16), 8.32-833

~~ing ¥l\U( Anim.aLion lor rhe Sllaigl)(CBl'W8l1< CreDI~ ~s 'MIn lhe

(9.3~. 320-321 (2O.2O),71B-nO Joinl Tool (22.1),

C<:lNIoi/ing HMd Edges Credl~ a CoKunl1 (4.12), 7SB-759

(18.16\, f>56 137·1.1a Crealiog a l.bOdeNoIume

Conl/~ing lhe CreaUng" a ~yor 8eK (6.B), 22-6--n9 •
MaterialSWllcil (9.12), 'Ntl" Borrels (10.10), Creal long a Lofl\l) (11. 2),

.341-344 387.J88 411·417

Controlling a f>aw(, (1.4. 2), Creating a CTf Map Cleatlng' tellerOOxes

514--516 (16.3).549 (1.3.10)., 499-500

Conlrolling Sorface Creating the Cobemap C'ea/ing e level w\lt> \I\e

N~s (lB.1S). (8.11).303 2D Shooe fdi\()I (4U),

6S-4--6.55 Crei'lllflg rhe link Des~r 1.36-1.37

Creaflog an B~ Te'lt.tlJre P'ic\urf tOl~ Level Crealirlg a Mesh and

(8.2), ',)75 (16.16), S66--S68 Prep.ar~ (or IN l2yool

Crearillg AILerl\<llrve Unk Cie3tiro;g De..fense Polo{ s (19,2), 66~

Setups (16.1.1), 5Oj-S6~ (12.91,465 C/e2llr.g MOlWl.DI Screens

Creollog a Basic Malerial CreaUng LI\e 101 DcU>le~I~

006 lel1U/e (n 6). De..srrCJ-{ableObtecl ive (16.7), S5.3

606--609 (16.19), 575-576 Creamg /Ikl.n-Squ;:l re

Creating a B-asic Terroit\ CreaLio\g a Dou\}/e Plojec\ot'i (7, 1-4),

Using \he lerram Editing l)o,minall<l-ll Ma~ (16.6)_ 262-264

Dialog (5.2), 153-156 552-55.3 Cre-aliog the P-assageway

Creal~ Beliel Segments CreaMg a Dyfl2>/l\6C Bridge 1M\ Conoe-cls HangGl 10

(4.8t 131-1.32 (11. -4). 419---421 LJ\e Conuor Room (3.B).

C'ealJr\g BSP CuIS wilh Creating and Eoiling &5-93

Solid Bwshes (4.13), Shelves (17 .2), 5~599



t U'l ot! als
,----------------

Crea fillg Ihe P1acet\<)ldej Creating ;, S\~ Karma CreiMlog a Wind<lw (3.6),

Te)(lure;. 00.10), Asse.L Pan II (i1.9), 7&-a1

701·70';1 42~32 CrealJ,()f il Windowpane

Creal ing a P10fU1 in Moy2l Crealing a Simple K.!lHna (4.~). 13.4

(21.3). 73j·732 A.ssel. j:>zn III (11.10), ()isplayit\g Sorfa.c.e

Creal itl.g the 432..4.)3 Norm..1lJs ill M<'l'r-! (lB.l),

Prox~uve Clefllioog a~ sn-S2B

(1&ZO).576 Proiec\or (7.13), Emlll\rIg U&\"ll (rom 0lI

CreatiTIg R;,gOOlls (11. 7), 261-262 Ador (7.10), 254-255

423---425 Cre~lrJf{ fl SImj)\e SkyOOx £r./'l.a.nclng Ihe. Look C14 Our

Creal~ (he R.ai( Sup()OI1S (7.1).236-2)7 Tetraifl til AddiTIg a

lot C;,~, Par( r pO.7\- Creal.iI'If a s.1ij)pe ry AooI S~l( (5.5).162-166

697-69-8 (6.3). 21S,217 £Slabilstllog (he

Cieaoog the Rail~s Creating the Sleam (10.2), MaleriailriggeJ and

for Calwa»<.. Pan • 3&s.36B M;'lellDtSwircl\ (9.11),

(20.B), 69B- 700 Creating lhe .l3B-341

Creating ,he fb~etw8l1< SlraigNCalwall< (20,11). £S (ablisllirlg a

(20.14), 7Q6. 70B 70.3 Me.s~Triggef (9.4),

Creallng aR~ Cle.aliflg a Soo.Itghl (7.2), 322-325

Tcle(>orl~ (9.16), 217·23~ EHab-llshing Player~

)S4.3SS Ct2alM\g a Tele.poner j)~s (16.22),578

Creahllg <'l ROlble f>fane IK fNed (10..4). 36~37..3 ESlDcushir>g a Trigger

Solver (23.7), B01-8Q 2 Cteating /1)e Te:Q rNM.a j) (13.2\. 481-4B2

Ciesllrog a RuI\ Cycle (B. 11) . .30 4-.3OS ExarnWn,g 1.)V l..a/OOlS
(23.15), 828-831 Ctealli\g a relit ure Ir, (19.1), 65.8-659

CreaJ.~ a ~i\y POOlosnoo (B.l), upotlLr.g \~ ChalaCiei

Comera (814), J08-311 271-274 (22.8). 771· 77 2

Crealjr,g and Sening Up CreiltW'lg thoe T-lnle£SE!Clion Expor1~ Cu~om

Your Emlt1er (10. t), eatwa& (2-0.181. ANmalion IhlO Urvealfd

362-365 714-716 (2).18), B3S-&36

Crealillg a S-tlader (8.4). Cre.oting a T~erUgN b:po.r(~ Sfa(}c Meshes

282·283 (7.12),2S7·2f>() from M8'(3 Wo UMe-alEd

Cte.atiog a~ Karma CrwiTIg 8-I'Id UsIng Ine (20.21). 720721

WClJ (11.1), 4()3.404 Co\o( Mod/(\er (BoA), £'ip.o.rfIng YOtY INs iTIlo

Ctei)/ilIg a Simple KArma ';188-289 f>OO(os~ (19.4). 669

Assel. Pen l (11.B). CreaJ.llIg Water (6-5). fa<)ing'1n oM Oul (13.61,

427-42'9 22(}.2n 493.-494
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9S4 t uta'Jals-------------------------

Finishing the Ligtllrlll1g Ugnl.ll1g the Hangar (3.7), Mowtg Aclors with Matinee

(10.12),393-395 81-&4 (13.7). 494-496

Fitting the Textures (3.4\, linking Power Nodes Moving Objects 111 Maya

72-74 (16.10),559-561 (17.8), 611-612

Getting the Character Loading Image Planes In Overlapping UVs (19.6),

Ready for Gameplay Maya (2L4l, 732-733 671-672

(22.9),772-777 Lowering the Image Plane Placing the Door (9.1),

Hooking It All Up (16.24), Brightness (21.2), 731 318·319

SSo-582 Making Face ExtrUSICflS Placing the New Elevat()(

l-Iolkeys and Marking (18.9),645-647 Control Panel (9.10),

Menus tor selection Maklr!€ the Level 337·338

(17.12).616-017 Functional (3.5), 74-77 Placing Power Cores ano

Implementing a Making Selections P~ NIXIes (16.9).

Sui~edTligger (9.7). (17.13), 618·619 55&-5S9

330-334 Mirroring Geometry (18.6), Placulg Vehicles (16.12),

Importing and Exporting 635-636 562-564

Broshes (4.17), 145 Made)jng the ro-Degree PositIOning Brushes ~ rK!

Importing a Skeleton Turn, Part. I (20.15), Actors in 20 arK! 3D (3.1),

(22.S). 767-768 70a-710 65-66

Importing and Usil'lg a Mode)jng the 90·Degree Preparing (or Animation

Simple Texture (B.3), Turn, Part II (20,16), (23.14).827-828

276-277 71().713 Prepdlil'l/:( lHl Aiel:! (01 Telll1ill

Improving the Look at the Modeling the 9O-Degree (5.1), 152·153

RLlIns (4,5), 122·125 Turn, Port HI (20.17), Preparir.g the

Improviflg the secority 713-714 SLraLghtCatwall< for Export

Camera (8.15).311·316 Modeling the Aims (20.131. 706

In5ening SUb Acli<ms (21.101. 744-7 <i5 The Progress Bar (9.13),

(13.5), 491-492 Modeling the Feet (21.11). 345. 348-349

Inuoductian to tne 745-747 Reoolkllng Changed lights

Hypergraph (17 .7). Modeling the floor of the (7.5), 246-247

609-610 Calwalk (20.3), 685~ Rebt>Jlding LJghllng (7.4),

Jumping onto a Sleep o'.M:>&ling \he Hand 245-246

Ledge (12.2). 451-453 (2L12), 748 Refining the Torso (21. 7).

aunching the Movie as the Modeling the Head 739-740

Level Begms (13.11), (21.13), 749--7 50 Resizing Scl'eenshDls
500-501 Modeling the Legs (21.9), (8,10). 301·302

Layrng OU1 the lNs of a ]41·]44 Revolving with Ihe 20 Shape
Character's Shirl 09.7), EdItor (4.10). 134-135
673-67£



t LrtOMB Is 955

Rotallng Objec(S In Maya Se\lmg Up the UseTngger Transloc.ating Through a

(17.9),613 (9_0),327·329 Small Hole (12.3).

ROUgtllflg In the Torso SeOing Up View Screens 454-455

(21.6), /37·73-8 lor OF (16.5), 550-551 UPl fIle ar><l resling the

Saving Brushes (4.16). Setting Up Your Project (or Ctlarac1er In-game

144 StatIc Meshes (20.2), (22.11), 779- 781

Scaling lights m a Level 684 USI(\g lhe 20 Shape Edllor

(7. n 251·252 ShaPJ()g Your OW(\ (4.71. 130

Scahng OOJecls In Maya Lallosc3peS (5.61- Using Amble(\t lighllng

(17.10),614 17].183 (7.9), 25.3-25-4

Selllng Angle on JOlI\l.s Simple Door Selup With .a Us ing Allliponals (15.2),

(23.6), B00-801 Door Actor (12.5). 529-531

Selling me Obj~llve Order 4S7~5B Using lhe Append \0

(16.21). S77 Simple Door SeluP wilhoul Polygon Tool (18.3).

Sell>ng Up an Assault Map Door Actor (12 4), 6.30-632

and Creating an Ob!ective 455-457 USing AssavllPaI/lS (12.8),

(16. 17l. 572-573 SklnrHng a Character 462-454

Selling Up a Bomblng Run (22.6),768 Using Ihe Allr\bule Ediior

Map (16.8),555-556 SmOOI\) 8u10lng a SImple (17 5). 602·603

Selling Up a CNIracler i(\ Model (22.3). 761· 763 Us Ing BrusIi CliDping (4.4).

KAT (11.111. 432.-439 Solilling Polygons (18.8). 118-122

Seiling Uo the Diffuse Map M3-S44 Using a Blod<\ngVcllJme

for Shaders f8.5), Subtrawng a SImple (6.2), 213--215

283·284 Room (3.2). 68 USlI'lg Channel Shders

Sel:lllg Up Ihe Elevator TakIng Advantage of the (17.3). 599-600

Dool (99), 336-337 Specul.a(ltyMask Properly Usi~ ColO( Maps to

Selling Up the Grid (20.1), (8 7). 285-287 Adjust Decolayer Colors

682·683 Taking the Cubemap (510),197·199

Selting Up Levell (13.12). ScreenshQts (8.9), Using the Comb41'\e

501-503 298·300 Command (18,Al),

Selting Up Level2 (13.13), Texl CreallOil, Pan I 632·633

5<12.-504 (13.8), 496-497 Using COOSITl>CllOn Hlslory

Setling Up Texl Creal \On. ParI I( to FDI l/'le Supporls

Pt2fYerSoawnManage(s 113.9l, 497499 (20.9), 700-701

(16.23), 578-579 TexlUflng lhe Room (3 3>. Using Coronas (7.11>,

Settmg Up a Simple 69, 71 256-257

Telepoder (9.15), Texluring Your Te !"faIn Using the Creale Polygon

353-354 (5.8),188-191- Tool (18.2), 628-630

How CiJn we make {h,S index mOle usefUl? Email usallll(Jexes@samspuOlIshlllg.com



956 tutorIals

Using lhe Glit Faces Tool USing a SCllple<:lTrlggel U
(18.12), 649·650 (14.1). 512-514

USing a Cylindrical Map 101 USing $eleC\JOIl Handles
.uu /lie extension (~unds).a UV l~YOUl 119.B). (23.10), 807

19677-678 USing Semi-Solid Elrusl')es

USII,g Ihe Qe·lr.lersecl Tool (4.14), 142·143 UOarnageCnarger class,

(4.2), 113115 Using tile Sl)eC 13lLll
Dea/hmanh game1ype. 545

Properly (7 8). 252·253 .ulo: file exte~lonUS((\(1 the DecDllSI

Pmpeny 16.1), 209-211 USIng Spline (I( (n.B\. animation, 21

USing Dislonce Fog (15.4), 803 OCickages. 17·18

533·534 USIng Spotflgl'llS (7.3), Undo optiOllS (toofoar), 8-48

USing the Freehand 239·240 Unreal :2 ~ The Awakening

Polygon D'3vMg lccl USIng lJie Status L\lIe inlroduclion of, 10
(4 6}. 125-127 (17.11).615-616 nonplayer characlers

USing the Graph EOllor USIng Ihe SubdlVlde Tool (NPCsl. 10
(232). 788-792 (18.7). 642-643 Unreal Championship

USing If CondlilMS (14.4), USing Tear·OH Menus IntrOduction 01. 9
519-520 (17.1),596 Malinee, 10

USing lne Imersect Tool Usmg lhe TermlnaIVeloclty mullipJaye( gameplay, 9
(4.1), 112 Properly (6.4). 217·218

SIalic meshes. level popu-
USing a LavaVolume (6.7), USI~ the Tellalfl {ation, 10

224-225 Generator (5.3), 156·157
XOQX, 9

Using Layers In Maya USIng the Trail£rr"ftN
Unreal ()evelope, Nelwofll

(17.4).60D-601 (10.13).397
(UDN) website, 9,847

USlOllJ.ialinee Wl(h 115'SlAtt"t\"I.VJ:<!e~hbe~
Uoreal e: ngloe, 1.1SCllpleCl5eQuences Command (18.13).

(14 3), 517-518 650-651 ability 10 customize, B

Using tile Merge \lerlex USlflg tne WilOcard Base comP&leOIS, 11

(18 l4), 652-053 (16.2).547 game la01"1Ch slage,

Using IW:>n Solid Brushes Vertex EO.lfflg In UnrealE:.d 16·17

(4.15),143.-144 (4.3). 116 garneplay slage. 16-17

USlI'€1 the Palnl Skin Vellex Extrusloos (18.10), gJapt\\cs engme. 12-1.3

weights 1001 (22.4), 648 Il'litializa [fen stage.
765-766

Zoning a Level (15.1), 16-17

Using RatW:lDm ConditionS 525-527 Inpul manager. 14
(14S),520-521

Interaclion overview,

1517
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Un,ea IEd 9S?------------------------

l\e1lW}rk m(ras((uC!.ure,

14

ohysics engll'\e, 13

sound engine. 13

UnrealScfipt, 14

data mappll,g. 11

game loops, even\ hand-

hng. 15-16

ililrOOUC\(on 0(, B

modular deSign of. B

Skaar). B

Soor.d packages, 19

UnreaIScrill[s. 8

Ufllea) Teet-Mlogy. develop

menl l\lstolY, B

Unreal 2 - The Awal<erung,

10

Unreal Championship, 9

Unreal Develo(ler Ne\wor\{

(UDN) website, 9

Unreal Engine, 8

Uflleal lourNlmen{, 9

Urveal' Too((\~ment 200 4,

10

Unreal TOLlr nam ent

Introduction 01,9

mll/hpje plat(olms, 9

U"real Tour namen! 2003, 474

U/lIesl Tourn arne", 2004

(UT2004), 47

lnuodUClI<ln oC 10

Matinee Tools tab

CNerVlew. 47 <I

Ol\Slaug)'lt game tyee, 10

particle eHects example,

360

vehicles, Actor class IIs[·

Ing.562·563

UniealEd

animations, exoortlng,

835-8-41

browsers

AClor Class. 874-876

Al\lmatll)n, 890-894

Group. 87 6-S78

Mesh,884·885

Music, 878

Pre(ab,885-887

SOUM, B79-8Bl

Slatic Mesh. 887-890

Texlure, 881..B84

Brosh Clipping 1NXIe,

11&-125

Console Bar. 872

Drag Grid. 873

DrowSc.ale3D. 874

loci< SeJections. 87.3

log WII\doW, 873

Maximize Viewport.

874

l101ahon Qrld, B73

text field. 873

ClYltent control loncliorls,

21

coordInate systems versus

Maya, 586

development hislory. 48

editor wlnoows

~rch (or Actors, 895

lJnrea/Seflpr Edllor,

896

face Drag mode, 11B

In lei sect 1001, 111

Builder Brush modifica

lion. 111·112

functllXl aI, 111

main menu bar

Budd menu, B4 7

Edit menu, 8-46

File mellU, 846

Help menu, 847

Tools menu. 8-47

View menu, 8-47

PI'~peny wii'\OOW5

AClor Plooernes. 896

Surface Properl Ie 5,

897·800

statle meshes, Imponln.g

from Maya, 720-721

10011>,11

Ac\Of ProperHes. 849

browsels, 848

BuIlding area, 84S-850

editors, 849

file options. B48

Help boHon, 850

Play Level butlon, 8M

Reck> options, 848

St!ucl\ lor Actors

opllon~, 848

Surface Properties,

849

Undo oot\Ons. 848



958 U"'&21lfd

loobox.850

Blush Ch~ area,

~

Brosh ~ives Olea,

as.l-B6()

Came/a 000 U!1Iii(ies

area, 85i-852

Conslrucwe~

Geo.melry (CSG)

OtIeraI ion So area,

8~4

MUroMg aM

MI~aneous area.

86S-866

Selec.lioos. aM

~mel\l. area,

a6.4..965

lJset' iMer(~ (Ul), 21, 53

appe.a.ranc.e ~, MS

btowsers. 53. 69

conSDle baI, S3

malrl ffieOO hOI. S.3

piOlXI1Y~s.

54-65, 72074

looIh.ar, 53

1()o()l)ox.,S3

w'#Ip(Yls, SJ

Ve/le~ fdtli.ng mo6e. 116

~.866-867

~(ot (>at, 86a-87 2

Sub.rnenu Clj)I iofIs.

867·868

UIVeaIS£J lp.l

Ed/IO(. 896

lDngua~e (eblures, 14

Un /ealSu\j)le65.eque/\Ce Ac.( C>I,

bols, defe~ poIn£s.

4&4-465

lJOs.<: lIalk>nAm p.lilu&- P/opet/·

tv. ~O
lJOsc,.aUo.nPh~ p.I~I \y,

290

l)()sclIIa IJ<>.r\R &l a PIo.p~ I l)< J90

OOsclllllli~Type pl6pe.rly, 291

Ui>'alill fo.tmal (.Uf>T)

lelClUie ~Olioo. 210

leJ:1ure SOOIC:eS, 19

UPL IIIe~ cl\.ataders

creating. 71~781

pr~lies, 781

Uf>l File a.nd les I ir.g Ihe

CharaQeI In-gLlme (L(}l()Ii

al n.ll), 77~781

~el ltIlerlaoe

2Q Shilpe £dIlQ./

roof.u h.a l, 1.28

loolbor. 128

~wpo{\S,12B

wir.dow tNerview, 12B

Maya

At1 OOole [dllQ./,

602-603

Char\r.ef Bo't, 5~OO

H~x, 605-606

Layef EowO',~01

~ Selectloo, 60S

(Min mefIl.J bar, SS5

rrleflU ~ls. 595-596

overview, 592

~a.rrge S~, 604

SheW", 598-SOO

SlAws line. S9 7-5M

[e.iJI-of( rneJ)Us. 596

'Ime Si6e/, 603

To~x,6()S

TfOf\Sport CD!\l.lois, 604

~(s.,5~95

LltveaiEd, 53

appearaoce C>f, 845

browsers. S3

console h.a~ S3

fn'Iin meNJ nat; 53

p./OI)erty vMOOWS. 54

(008:1<I(, 53

(ooQ)ox, 53

~,S3'

Us.eT/lggel, e~\falors

cent/ol p.3f1el• .33 7·33.8

ueolirlg. 325-32?

~;weI opernuoo. 327-329

lklng AmOle~ Ugtlling (Morl·

al 7.9). 25.l-2S4

lkIIIg e.rush ClfppIng (IIJIC>ll.a f

4.4)., 11a-122

UsIIIg Uron.a~ (/I)(O/lat 7.11).

25&257

U~ng Dkt,HlGe Fog hu.61lel

(15.4), 533-534

Us.!n& No IrS0.11/1 e.r usJ\es

(lul bIIa I .(. is). 10-144

Using' Sem.i-&Iid Blushes

(lulonal 4.14). 142·143

u~lIlg Spolllg1'lls wLOnal (7.3).

2.19-240
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1.-------------

llilng lhe 20 Shape Edllor

(tutorial 4.7), 130

USIng the ComOlne Command

(tutorial 18.4), &32-633

Using the De-lnlerS&t Tool

(tutorial 4.2), ii3-iiS

Using Ihe DecoLlst PTO~lty

(tulorlal 6.1). 209-2:1.1

UsIng lhe freetlanll Pol~gon

Orawing Tool (tutorial 4.6),

1.25-1.27

USIng the Intersect TOOl [tutor·

ial 4.1). 11.2.

UsIng lhe SpecialUt Pr~lty

(tutorial 7.8), 252·253

.usx (lte eXlenslon (slalk

mesheS),20

.utx fWe extension (textures),

19

UV Text lire Editor

tayOOIS

creating, 664-668

\il ewil'€.6SB-659

mapping (uoctions

automatic, 663

cylindr\c.al, 664

planar, 664

menu bar

Help, 659

Image, 659

Polygons, 659

select. 659

Subdivs, 659

View. 659

loofoar options, 660-662

UV layOUIS, eteatlor\ gUIde

hnes, 678-680

Vlewoort, Quadlan, grid,

663

Ws (potygMal Objects~ 657

Applying the New Texlure

(tulorial 1~.5), 67()..6 71

coordinale syste m. 657

CrMUIlg a MeSh 8f\d

Preparing tor UV Layoot

(tulorlal 19.2),665666

Crealtng a UV Layovt for

the Static Mesh (tutonal

lS.3\, 666·6&8

£:xj)O(ung Your UVs Into

PMtosho.o (\urOiLaI

19.4),669

function of, 657

Laying Out the UVs of a

Character's stlin (tutorial

19. h 673-676

\ay¢uts

characters, 672·678

creating, 6644i68

cre<ltion guidelines,

67B-S80

le~tuTes. cerallng (ram,

66B-672

lI1ewlng, 658-659

mapping methods, 663

automatic, 6.63

cylindrical. 664

planar, 664

view SCfeens

Overtapping UVs (LUtorial

19.6), 671-672

Using a Cylindrical Map tor

a LN layout (tulorial

1.9.B},677·678

v

vehlcle&

Acto! class lisling,

562·563

bDl. navigalion. 466

Onslaught gamelype,

placemenl 0(, 562·564 •

Verte~ EdIting in UnrealEd

(tuloriel 4.3). 116

Verlex EdIting lool (Tell3in

Editing dialog box), 170-i7 2

\/erte~ norma~, 623

ve rtices, 1.:1.5

chamfering. 648-649

merging, 652-653

modeling, 622

shape component (20

Shape Editor). 129

video cards, Sl atic mesh s10f'·

age, 682

View menu (maIn menu bar),

&.47

view weer.s.. Carxure lhe Flag

gamelype, Sett)ng Up Vlew

SCreens (01 CTF (tulOl'ial

16.5), 5~S1

959



%ll \l16w8ot~~comman~~~d~ _

V~ wmmaNl (co.n.iOle).,

H9

VLeWcJass ~mman<l (oons.ole).,,,,g
V\ewflag COI"lVnOM (coos.ol/l).,

4A9

viewing lights. 241

D)ruImk lighl m<lde

(perspective~).

241-242

Ligl)OOg 00Iy ll'oClOe

(P~ viewporlj,

242

Aadii VIeW mode

(Pet"Specllve ~\).

242-243

Te:tlured mode

(petscectNe~).

242

'.kW\XW'l:S

20 ShAJ)e £OWl).(; 128

1igN.s

I)ynomic Ughl mode,

241-242

Lighling 0Ny mo6e.

2.42

~affil VieW I7l().de ,

242-.243

k'dored mode, 242

Maya

Orl!\oglDphic, navlga

'k:ln O(lera1ioo1.s. S94

F>e.'s~e, SSJ

Per.;peelive, e.e.me I a

focus. S95

I"etspe.c t ive. NlvigaI ioo

CoPe lDlions, 594

simllof,{y L.O UlW"eal,

593

~modes.S~

navtgal}on h61keys (KAT),

427

l..J.Ive.a!fd usel in rertac.e

(Vt),53

vI_JloO-Il:s (UNeatEd), 8.6(,...Q61

Coouol b.a~ B6S

asp DA..s. ft6~

CofIIe'la mel'll). 870

WOIS s.obmeMJ, 872

Mode submeoo, 871

View sol>menu, 8/1

W~ subrnei\U. B72

Dej)ltl ~'1'ity, 870

D1s~ay Mode. Boa

DynoI1\lG Lighlil\g. 869

Li~CWy,869

L.oc~ L.O SeIea.e6

M10l, B7D

PerSI)eC1Ne,~

Reellime Pleview. a6£i

Show~e VeT1lces.

870

le':llLJ./e USDg'e. 869

1e'r:l(J{ed, 869

2o.nejf'Ml2>l, 870

SLJbmeIlO ~()(IS,

U7-B68

(.IV le'tl.lIfe £d_OI, QOaMN

gtld.663

\lle~a\(eT, ele\la/or~ jetl<lng

be!\a'll!~IS. .1.).4..J36

..." (til It) cycle-l, p.arl~

l!lffects, 367-368

\il~.lIy ({)Ol (Te TTIlIn

G&I\/l1810l)., 175

vo.k.a~ l..4lYaVOoIume IY~,

206

pmpenies. 224- 225
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